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Warranty & License

Copyrights
Copyright ©1987-2004 EI Technology Group, LLC. All rights reserved.

The Electric Image Animation System software and documentation are Copyright 
©1987-2004 EI Technology Group, LLC. All rights reserved. This document may 
not, in whole or in any part, be copied, photocopied, reproduced, translated, or 
reduced to any electronic medium or machine readable format without prior con-
sent, in writing, from EI Technology Group, LLC. 

Trademarks
Electric Image Animation System, EIAS Animator, Camera, Renderama and their 
logos are trademarks of EI Technology Group, LLC. Windows is a trademark of 
Microsoft Corporation. Macintosh is a trademark of Apple Computer, Inc. All other 
trademarks are the property of their respective holders.    

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND 

CONDITIONS BEFORE INSTALLING THE ELECTRIC IMAGE ANIMA-

TION SYSTEM SOFTWARE. THE OPENING OF THE SOFTWARE PACK-

AGES AND/OR INSTALLATION OF THE SOFTWARE INDICATES 

YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. IF YOU 

DO NOT AGREE WITH THEM, YOU SHOULD RETURN THE ENTIRE 

PRODUCT IN NEW CONDITION TO THE PLACE OF PURCHASE, AND 

YOUR MONEY WILL BE REFUNDED.

Except as otherwise specifically provided, EI Technology Group, LLC. is the 

“Licensor” of the Electric Image Animation System software and accompa-

nying documentation. The Electric Image Animation System software pro-

gram is referred to in this License Agreement as the “Program”. The 

Licensor grants to you, the original end user licensee, a nonexclusive 

license to use the Program for your own personal use and not for subli-



       
cense, subject to the terms and conditions stated in this License Agreement. 

You assume responsibility for the selection of the Program to achieve your 

intended results.

LICENSE
You may: (i) use the Program on a single machine; (ii) copy the Program into any 
machine-readable form only for necessary backup or modification purposes in sup-
port of your use of the Program on a single machine; and (iii) transfer the Program 
and license to another party if the other party agrees to accept all terms and condi-
tions of this Agreement. If you transfer the Program, You must at the same time 
either transfer all copies, whether in printed or machine-readable form, to the same 
party or destroy any copies not transferred. You may not sublicense or lease the 
Program or accompanying documentation. You may not assign or transfer the 
license to the Program or accompanying documentation except as expressly pro-
vided in this Agreement. Except as expressly permitted above, any attempt to lease, 
sublicense, assign or transfer any of the rights, duties or obligations hereunder is 
void.

Upgrades and Updates

If this Software is being licensed to you as an upgrade or update to soft-

ware previously licensed to you, you must destroy the software previously 

licensed to you, including all copies resident on your hard-disk drive, 

within sixty (60) days of the purchase of the license to use the upgrade or 

update.

RESTRICTIONS 

You may not distribute copies of the Program to others or electronically 

transfer the Program or accompanying documentation from one computer 

to another over a network. The Program contains trade secrets, and in 

order to protect them, You may not decompile, reverse engineer or disas-

semble the Program, or otherwise reduce the Program to a human perceiv-

able form. You may not modify, adapt, translate, rent, lease, loan, resell for 



       
profit, distribute, network or create derivative works based on all or any 

part of the Program or accompanying documentation. You may not circum-

vent operation of the accompanying hardware key device or “dongle” or 

any other form of copy protection employed by the Program. You may not 

copy, clone or emulate or otherwise duplicate the functions of the hardware 

key in any manner, or allow the Program or hardware key to be so copied.

Disclaimer

Computer-Aided Design Software and other technical software are not 

substitutes for your professional judgement. Computer-Aided Design Soft-

ware and other technical software are intended to assist with product 

design and are not substitutes for independent testing of product stress, 

safety, and utility. due to the large variety of potential applications for the 

software, the software has not been tested in all situations under which it 

may be used. EI Technology Group, LLC shall not be liable in any manner 

whatsoever for the results obtained through the use of the software. Per-

sons using the software are responsible for the supervision, management, 

and control of the software. This responsibility includes, but is not limited 

to, the determination of appropriate uses for the software and the selection 

of the software and other programs to achieve intended results. Persons 

using the software are also responsible for establishing the adequacy of 

independent procedures for testing the reliability and accuracy of any pro-

gram output, including all items designed by using the software.

TITLE 

The original and any copies of the Program and accompanying documenta-

tion, in whole and in part, including translations, compilations, partial cop-

ies, modifications, and updates are the property of Licensor or its suppliers. 



           
You have only the limited rights granted by this license. You are not an 

owner of a copy of the Program, and therefore 17 U.S.C. Section 117 does 

not apply. You must reproduce and include the proprietary rights notices 

on any copy of the Program and accompanying documentation.

LIMITATIONS

This license does not include any rights to reproduce, copy, commercialize 

or otherwise use or make use of the sounds, music, pictures, effects or other 

content contained in the Program except in connection with your personal 

use of the Program as permitted hereunder.

TERMINATION 

You may terminate your license to the Program at any time by destroying 

the Program and accompanying documentation together with all copies, 

modifications and merged portions in any form. The license also will termi-

nate as set forth elsewhere in this Agreement if you fail to comply with any 

term or condition of this Agreement. You agree upon such termination to 

destroy the Program and accompanying documentation, together with all 

copies, modifications and merged portions, in any form.

LIMITED WARRANTY.
EI Technology Group, LLC. (“Licensor”) warrants to the purchaser of Electric Imag-
eAnimation System from an authorized dealer(“End User”) that the CD-ROM(s) 
media on which the Electric Image Animation System software program (“Pro-
gram”) are furnished are free from defects in materials and workmanship under 
normal use for a period of ninety (90) days from the date of delivery to End User as 
evidenced by a copy of End User’s receipt (“Program Warranty”). Licensor does not 
warrant that the documentation or the functions contained in the Program will 
meet End User’s requirements or that the operation of the Program will be uninter-
rupted or error free. Licensor’s entire liability and End User’s exclusive remedy 
with respect to breach of the Program Warranty will be the replacement of any CD-



             
ROM media not meeting the Program Warranty if returned to the Licensor for the 
particular nonconforming Program within the Program’s Warranty period with a 
copy of the applicable receipt(s). End User is responsible for any costs, expenses, 
customs, duties, taxes, and other similar charges arising with regard to return ship-
ment of the Program to the place of purchase and Licensor’s return of the Program 
under the Software Warranty. End user must pay all such costs upon invoice.

NO OTHER WARRANTY.   
EXCEPT FOR THE LIMITED WARRANTY STATED ABOVE, THE ELECTRIC 
IMAGE ANIMATION SYSTEM PROGRAM AND ACCOMPANYING DOCUMEN-
TATION ARE PROVIDED “AS IS” WITHOUT WARRANTY OR CONDITION OF 
ANY KIND, EITHER EXPRESSED OR IMPLIED AND THE IMPLIED WARRAN-
TIES AND CONDITIONS OF MERCHANTABILITY, TITLE AND FITNESS FOR A 
PARTICULAR PURPOSE ARE SPECIFICALLY DISCLAIMED. THE ENTIRE RISK 
AS TO THE QUALITY AND PERFORMANCE OF THE ELECTRIC IMAGEANI-
MATION SYSTEM PROGRAM AND ACCOMPANYING DOCUMENTATION IS 
WITH END USER. SHOULD THE PROGRAM PROVE DEFECTIVE, END USER 
(AND NOT THE LICENSOR OR ANY AUTHORIZED DEALER) ASSUMES THE 
ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. No 
oral or written information or advice given by Licensor, its dealers, distributors, 
agents or employees will create a warranty or in any way increase the scope of the 
limited warranties set forth herein, and End User may not rely on any such infor-
mation or advice. SOME STATES MAY NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY. THIS 
WARRANTY PROVIDES SPECIFIC LEGAL RIGHTS AND THE END USER MAY 
ALSO HAVE OTHER RIGHTS THAT VARY FROM STATE TO STATE. 

Remedies

The entire liability of EI Technology Group, LLC. and your exclusive remedy 

under the warranty provided herein will be, at the option of EI Technology 

Group, LLC. to attempt to correct or work around errors, to replace the 

media, or to refund the purchase price and terminate this Agreement. This 

remedy is subject to return of the Software to EI Technology Group, LLC. or to 

the Authorized EI Technology Group, LLC. Dealer from whom it was 

obtained with a copy of your receipt.



      
LIMITATION OF LIABILITY.
IN NO EVENT WILL LICENSOR OR ANYONE ELSE WHO HAS BEEN 
INVOLVED IN THE CREATION, PRODUCTION OR DELIVERY OF THE PRO-
GRAM, OR ANY OR ALL OF THE ELECTRIC IMAGE ANIMATION SYSTEM 
CONTENT BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, 
INDIRECT OR SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS OR LOST 
SAVINGS ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM, 
ACCOMPANYING DOCUMENTATION OR CONTENT, EVEN IF LICENSOR 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. The foregoing 
limitations of liability shall apply notwithstanding any failure of essential purpose 
of any limited remedy or any claim by any other party. Licensor’s liability to the 
End User or any third party arising out of or related to this Agreement however 
caused and on any theory of liability, whether in contract, tort (including negli-
gence), or otherwise will not exceed the fee paid by the End User for the Program, 
as applicable. The Program was not developed and is not licensed for use in any 
nuclear, aviation, mass transit, life support or medical application, or any other 
inherently dangerous applications. SOME STATES MAY NOT ALLOW THE LIMI-
TATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUEN-
TIAL DAMAGES SO ALL OR A PORTION OF THE ABOVE LIMITATION OR 
EXCLUSION MAY NOT APPLY.

General

This Agreement shall not be governed by the UN Convention on Contracts 

for the Sale of Goods; rather this Agreement shall be governed by the laws 

of the State of California, including its Uniform Commercial Code without 

reference to conflict-of-laws principles. This Agreement is the entire agree-

ment between us and supersedes any other communications or advertising 

with respect to the Software and Documentation. If you have any ques-

tions, please contact in writing: EI Technology Group, LLC., Customer Ser-

vice, 20770 Hwy 281 North, Suite 108-414. San Antonio TX 78258-7500
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Chapter 1  EIAS Concepts — Introduction

        
EIAS Concepts

The Electric Image Animation System (EIAS) is a powerful suite of pro-

grams that you can use to create fully rendered, motion picture quality 

computer generated 3D animated movies. It consists of three applications, 

Transporter for importing models, EIAS Animator for animation and sur-

facing, and Camera for rendering and raytracing. EIAS Animator also 

includes the Renderama™ network rendering utility.

EIAS  is a multi-platform application suite. You can operate just as easily on 

Macintosh OS 9 and X, Windows NT, 2000 and XP computers. You can ani-

mate on one platform and render on another if you so choose.

1.0 EIAS Introduction

EIAS is a suite of applications which you use to create models, animate 

them, and finally render them into pictures or movies. The applications 

included within EIAS are:

EIAS Animator

You can use EIAS Animator to apply surface materials and textures, set up 

scene lights, and then animate your models. EIAS Animator has been used 

in most of the Hollywood summer blockbusters since 1991, when it was 

first introduced as ElectricImage Animation System. 
EIAS Animator        1
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Camera™

Rendering is the process of converting your animation, model and surface 

data into finished pictures and movies. The rendering process is effectively 

a standalone process: once you assign a rendering job, you take a break 

until its complete. Depending upon how many frames are in your anima-

tion, and what rendering levels you have chosen, your job could take a few 

minutes to many hours.

Camera is the rendering component of EIAS. Long known as the “world’s 

fastest renderer,” EIAS Camera is capable of rendering over 30,000,000 

polygons, and an effectively unlimited amount of lights, texture maps, pro-

cedural shaders, and so on. The image quality and rendering speed of EIAS 

Camera are unsurpassed, as demonstrated by its continuos use in Holly-

wood’s biggest effects films. 

Under all operating systems (except Mac OS 9), you must manually set the 

memory allocation for EIAS Camera within the application itself. This is 

done in Camera using the Set Memory Usage in the File menu (File > Set 

Memory Usage). 

Make sure there is no Camera.ccn file in the same folder with Camera (or 

Camera will begin rendering), launch Camera, and choose File > Set Mem-

ory Usage. A dialog box will open, allowing you to set Camera’s memory 

partition. Set it to a number between 40 (40MB) and 2000 (2 GB). If, during 

rendering, Camera launches and immediately quits, you have assigned 

more memory than your operating system will provide. Throw away the 

Camera.ccn file, launch Camera and lower the memory allocation.
2       EIAS Animator    



 

Chapter 1  EIAS Concepts — Terms and Definitions

                     
Renderama™

EIAS Camera can be controlled by Renderama, the network rendering 

server utility that ships with EIAS Animator. With Renderama, you can 

render to a local network, or across the internet! Renderama is a very sim-

ple utility, with very few bells and whistles.

1.1 Terms and Definitions

Before reading any further, it is necessary for you to understand the 

nomenclature of EIAS Animator. These terms will become important in the 

following sections:

Project. The project file is the main work file used by EIAS Animator. it 

stores all references to objects, materials, maps, procedural shaders, and 

any other files used in the scene.

Scene. A rendered sequence, like a scene in a movie. 

Object. Any of several object types: camera, light, model, plugin, effector, 

and smoke object.

Camera (Scene Object). The camera is a scene object which is used to 
record the events of the scene over a period of time, just like a real camera. 

Light (Scene Object). A scene object that can be any of several sub-types 

which is used to illuminate a scene.

Model File. A model is an object type that contains a geometric description 

of the shape of the object. A model is made up of collection of “groups.”

Group. A member of a model file, a group is a single container of point, 

line and/or polygon data that is used to describe the shape of an object. A 

model file can have but a single group, but it must have at least one. 
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Groups can be linked to one another or other scene objects hierarchically, 

can be animated, and can contain shading information.

Polygon. A polygon is an enclosed, flat shape that, as part of a mesh of 

other polygons, defines a more complex shape.

Vertices. Points which define the corners of a polygon.

Attribute. An aspect of an object which can be set to a value or animated. 

Objects typically have many attributes.

Map. Refers to attribute maps, such as bump, clip, diffuse, transparency 

and so on, and projection maps.

1.2 Starting Up EIAS Animator

When you first start EIAS Animator, you will be asked to create a project. A 

project is the main file that EIAS Animator uses to store and organize ani-

mated scenes.

After you create your project, you will be asked to choose a model to 

import into the scene. If you cancel, an empty scene containing a single 

camera and light will be created. You can import objects and create 3D text 

at any time.

A new project will always start with four windows, a camera, a radial light, 

any models that you may have imported, and the main menu bar. Three of 

the windows represent your working space, or “world space.” They are 

titled “top view,” “front view,” and “side view.” The fourth window is your 

camera view. The camera’s start position is on the Z axis, looking towards 

the origin (0,0,0 in world space coordinates.) The origin is the center of the 

world, and of your project.
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1.3 Moving in Space

We all exist in space. We organize our space with units of measurement, 

such as feet or meters. 3D programs need to work within a space just like 

we do. Fortunately, a 3D program is not limited to just one space, and it can 

easily work at the atomic or astronomic level. 

3D space is represented as a cube, and divided into three “axes” called X, Y 

and Z. Remember in school when a geometry exercise required you to plot 

a curve on graph paper? Chances are, the graph paper grid was divided up 

into X and Y space. Now, imagine three pieces of graph paper, running 

through the centers of the other in a perpendicular direction. Each of the 

sheets of paper would be labeled XY, XZ and YZ. 3D space is described in 

the exact same fashion. Three coordinate pairs are used to describe the loca-

tion of an object in 3D space, such as 20,10,0. In this example, the object is 

located 20 units on the X axis, up 10 units on the Y axis, with no change on 

the Z axis, putting the object on the XY plane of the 3D space. Values for 3D 

space can be both positive and negative. The direction that you travel will 

dictate whether or not your are in the positive or negative coordinates of a 

spatial region. The meeting point of all three planes is referred to as the 

“origin,” and located at coordinates 0,0,0.

Different 3D packages use different ways to look at the coordinates of the 

3D cube space. Although it doesn’t really matter how a particular package 

may view 3D space, it can be a concern if you are interchanging data from 

one program to another program from a different manufacturer. The most 

important thing to note in your program of choice is “which end is up?”

In EIAS Animator, world space is “Y up,” that is, the positive Y axis is 

pointing up. The positive X axis points to the right, and the positive Z axis 

points to the rear. This is called the “left-handed coordinate system.” All 
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objects in a EIAS Animator scene will move within this coordinate system. 

Another kind of space in EIAS Animator is “object space” or “local space.” 

Object space is localized to each object in the scene, and refers to the rota-

tion or orientation components of an object, as well as material properties 

such as texture maps. This sounds more complicated than it is, really. As 

you work with EIAS Animator, you will be exposed to these concepts in 

more detail.

Depending upon how your model was made, you may see its rear end fac-

ing you in the front view, or you might see the front pointing at you in the 

top view. This is easy to correct with object axis editor (Hierarchy>Axis 

Editor).

1.4 Looking at Your World

EIAS Animator offers you a set of tools for you to communicate what you 

want the program to do. The most basic tool is the window. Windows in 

EIAS Animator present you with information and allow you to edit and 

manipulate that information so that you can animate. There are several 

types of windows in EIAS Animator:

• 3D Windows
• Information Windows
• Editing Windows
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Each of these types of windows offers different methods for animating 

your objects. In the 3D windows, you interact with objects directly: you 

select them, move them, rotate them, and so on. You can also control the 

level of drawing and shading, choosing the method which offers you the 

best compromise of performance and presentation.

In any active orthographic window (that is, not the Camera View), you can 

switch from that specific view to any other orthographic projection.

Alt (Option on Macintosh) 1 for Top

Alt (Option on Macintosh) 2 for Side (right)

Alt (Option on Macintosh) 3 for Front

Alt (Option on Macintosh) 4 for Bottom

Alt (Option on Macintosh) 5 for Back

Figure 1.1 — Default EIAS Animator interface (four view windows.)

Camera
View
Window

Side
View

Top
View

Front
View
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Alt (Option on Macintosh) 6 for Left

] for Zooming in

[ for Zooming out

= for Fit to view

This is useful if you operate with only one orthographic window to 

improve drawing speed.

The information windows provide you with data that is current to the time 

in which your scene is currently residing. You can control all of the 

attributes available to an object with its information window, and you can 

even animate these attributes by changing the values at the current time.

The editing windows offer a more detailed view of your scene and the 

objects inside of it. The project window presents this data numerically, and 

is also used to control hierarchy and other functions. The function curve 

editor presents its data in curve form, allowing you change the shape of 

data as it progresses through time. This in turn translates to actual motion 

or attribute behavior. Once you get the hang of the function curve editor, it 

is likely that you will favor this editor as you animate. The morph editor 

offers a slider-based method of animating morph targets. Morph targets are 

most commonly used for facial animation, but can be used for a variety of 

other animated tricks as well. The joint editor is used to set up the orienta-

tion of joints in your hierarchies and skeletons. The axis editor lets you eas-

ily change the orientation of your model, without having to resort to 

rotating the model into place. The deformation editor is used to bend, twist 

and otherwise distort your objects into the performance that you require.
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3D Environment Windows

3D environment windows are used to draw your scene in 3D. You interact 

within 3D space in these windows only. Other windows allow you to inter-

act with your project in data or curve form. The 3D environment in EIAS 

consist of the following windows:

• World Windows
• Camera Window
• Light Windows
• Texture Map Alignment Windows
• Morph Editor
• Joint Editor
• Model Information Window 

Projects in EIAS Animator can often get very complex, and it is not unusual 

to have model counts of a million or more polygons in a scene. You can 

imagine that constantly drawing and redrawing this much information can 

be difficult for your computer, and it is. EIAS Animator uses Open GL for 

drawing by default (you can also switch to a software drawing engine). 

Open GL is an open drawing architecture used by 3D cards to speed up the 

drawing of 3D scenes and objects.

In addition to Open GL, EIAS Animator also uses a variety of drawing 

modes that you choose, so that you can tailor the amount of drawing with 

the performance that you want to work with when you animate.

Drawing Modes

Drawing modes allow you to control detail vs. performance. You choose 

which one works the best for you and your setup. Drawing modes are set 
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with the Window Display menu. This menu is located in the little blue ball 

at the bottom of each 3D window. The available drawing modes are:

• None
• Point
• Outline
• Wireframe
• Point Shaded
• Outline Shaded
• Wireframe Shaded
• Flat Shaded
• Gouraud Shaded
• Phong Shaded

Display None. This mode will draw nothing in the view. Hey, you never 

know.

Point. This mode draws points for each corner of every polygon in the 

scene. It can give you a fast volumetric feedback.

Outline. This mode draws a “cartoon-style” outline for each group in the 

scene, including silhouettes and contours. It offers more clarity than wire-

frame drawing, and is much faster, as it has to draw much less. Outline 

mode provides very good feedback and response time. 

Wireframe. This traditional mode draws all of the polygons in the scene as 

wires that you can see through. This is the most clichéd drawing mode ever 

used in computer graphics. It is also slow when large numbers of polygons 

are present in the scene.

Point Shaded. This mode is the same as the point mode, except that the 

points are shaded by the lights within the scene. This mode can actually 
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provide a combination of good speed and good feedback, as the shading of 

the points can remove the abstract curse of Point only drawing.

Outline Shaded. This mode is the same as Outline mode, except that the 

outlines are shaded by the lights within the scene. It is tempting to use this 

mode, but if you have objects with complex geometries, it can start to bog 

down when shading. You might find that you prefer Outline mode overall.

Wireframe Shaded. This mode is the same as Wireframe mode, except that 

the wireframes are shaded by the lights within the scene. It is very sexy to 

look at, but there is a time penalty to shade all of those wires.

Flat Shaded. This mode will shade each polygon in the scene giving a fac-

eted or jeweled appearance. It is a very fast shading mode, but does not 

adequately show spotlights, highlights, or texture maps.

Gouraud Shaded. This mode will smooth shade across each polygon in the 

scene, although spotlights and highlights will not look as good as they do 

when the Phong Shaded mode is active. Texture Maps will be visible when 

this mode is on, and the Display Textures option is set in the group info 

window, on an object-by-object basis.

Phong Shaded. This mode is the superior shading method, and the results 

will match the results when you are rendering with the ElectricImage ren-

dering engine, Camera. Spotlights, highlights and texture maps will all dis-

play correctly. 

To view textures require that the Display Textures option is set in the group info 

window.

Engine. Underneath the drawing mode list in the menu is the Engine pop-

up menu. This menu allows you to select Open GL (hardware) or the EIAS 

drawing engine (software.) It is rare that you would want to choose the 
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software engine over Open GL, and it is offered as a choice primarily out of 

convenience. If you notice that the performance that you are getting from 

Open GL is less than what you would expect, try switching to the software 

engine and see if you notice any improvement. If you do, please call tech 

support.

Note If you are using Open GL, you should not be using the ruler bars feature. Ruler 

bar drawing significantly negates Open GL performance and should be avoided 

unless absolutely necessary. If you need the ruler bars, use them just to determine 

the measurements you need, and then deactivate them.

Following the Engine menu item are two other menu items:

• Show Extents
• Cull Back Faces

Show Extents. Selecting this mode draws the historically familiar cubic 

extent for each group. This is the fastest setting, but offers the least in feed-

back.

Cull Back Faces. This mode will speed up drawing by as much as two 

times, as the polygons which do not face the viewer are removed 

(“culled”.)

Display Elements. Brings up a small dialog that lets you stop classes of 

objects from being displayed in the window. Each window stores its own 

Display Elements settings.

Interaction Sub Menu (Texture Window)

The following menu items appear only when in the texture window. The 

Interaction sub menu allows you to fine tune the performance of the inter-

face drawing engine for maximum results and throughput. 
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There are four items in the Interaction Sub Menu:

• Update Time…
• Full Monty
• Drop Data
• Drop Quality

Update Time… This option brings forth a dialog which will allow you to 

set the amount of time that the Drop Data and Drop Quality modes use as 

their threshold values.

Full Monty. This mode will draw everything, regardless of the setting 

found in the Update Time value. Hey, what you see is what you get.

Drop Data. This mode will skip parts of the object in order to keep up with 

your interaction with the program. Depending on the speed of your com-

puter, you may not notice this too much.

Drop Quality. This mode will continue to drop the drawing quality of the 

model, until it can keep up with you. This mode can be somewhat discon-

certing to start with, but you get used to it. 

Options Sub Menu (Texture Window)

The options sub menu allows you to select aides which can help in the 

application of your texture maps. 

There are four items listed in the Options sub menu:

• Cull Back Faces
• Use Lights
• Show Normals
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• Texture Shading

Cull Back Faces. This mode will speed up drawing by as much as two 

times, as the polygons which do not face the viewer are removed 

(“culled”.)

Use Lights. This mode is active only when the Shaded options are selected. 

This mode allows you to view the texture with normal scene lighting.

Show Normals. This mode will draw lines along the direction that each 

polygon is pointing. If there is a problem with the normals of a particular 

polygon, it will be evident when examined with this feature, and appear as 

a normal pointing in a direction opposite that of the neighboring polygons.

Texture Shading. The default presentation of the texture map on the sur-

face of the model is “fully lit,” as if you were viewing the texture in a paint 

program. The default method can hide detail at times, so we created this 

option for you to use when you need to see some surface definition when 

you are applying your texture map.

In addition to the items covered in the Texture Window version of these 

menus, there are three other options that are found in the World and Cam-

era View versions of these menus. These options are:

• Display None
• Display Lights
• Display Paths

Display None. This mode will draw nothing in the view. Hey, you never 

know.
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Display Lights. This mode will draw the lights in the view. You can turn 

off the lights to hide the clutter, or speed up the shading performance of the 

view.

Display Paths. This option will toggle the display of motion paths in the 

view.

1.5 The Camera Scene Object

The camera is what records the scene. It is actually three connected pieces, 

as shown in Figure 1.2: the body, which is the focal plane; the view vector, 

which is a line indicating the view direction; and the reference point, which 

determines the actual point at which the camera is looking.

• Dragging on the body changes the position of the camera, but not 
where it is looking.

• Dragging the reference point changes where the camera is looking but 
not its position.

• Dragging the view vector keeps the orientation of the camera the same, 
but changes the camera’s position and where it is looking.

• Dragging on the body while holding down the Control key moves the 
camera long its reference vector.

• Dragging on the constraint widget moves the body along the constraint 
axis.

• Dragging on the constraint widget while holding down the control key 
moves the body and reference along the constraint axis.
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One of the most common mistakes of new EIAS Animator users is employing too 

much camera motion. This is due to the fact that the camera is so easy to animate. 

Camera moves should be slow and deliberate. Otherwise, a “digital whiplash” 

effect occurs, the main result being that all your friends and associates will know 

that you are not a professional camera operator.

Aspect Ratio

The aspect ratio is the shape of the rendered image, expressed as width 

over height. The clear rectangle represents the area of the image which will 

be rendered; the grayed out portion of the view is just outside the camera’s 

rendering area (which is how motion picture and television cameras actu-

ally operate).

In the movie industry, there are many different aspect ratios in use. EIAS 

Animator has menu items for the most popular aspect ratios used for pro-

duction. You can also enter your own.

Figure 1.2 — The camera icon
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Focal Length and Field of View

Directly influenced by the aspect ratio is the focal length, also known as the 

field of view. The focal length works the same in EIAS Animator as it does 

for an actual camera. It can represent any lens type. There are two differ-

ences between EIAS Animator and a real camera: You do not have keystone 

problems (which are vertical line distortions due to the spherical nature of 

the real lens), and you do not have fisheye distortion problems at extremely 

wide focal lengths.

You may also use the field of view feature if that suits your needs. The field 

of view is expressed as an angle. For instance, a 35˚ field of view with the 

aspect ratio set to 35mm slide would equate to a 60mm lens on your slide 

camera.

Yaw, Pitch and Roll

As mentioned previously, all objects in EIAS Animator have an orientation. 

When referring to the camera, this orientation is called yaw, pitch and roll, 

which work the same for the camera as they do for the rest of the object 

classes in EIAS Animator. Yaw equates to the Y axis, pitch equates to the X 

axis, and roll equates to the Z axis.

1.6 Light Objects

Lights are the class of objects which illuminate a scene. EIAS Animator 

always adds a 100% white light with an intensity of 1.00 to your project as a 

default every time you create a new project, and any new light that you 

add has these same values. Lights have no physical properties as a model 

would have.
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It is important to remember that the use of too many bright lights can overexpose 

the scene, in the same manner as when photographing a scene for film or video. If 

you experience this, you can drop the intensity of some of the lights. It is a common 

practice for only one or two lights (called the “keylights” in the production indus-

try) to be near full brightness. The other lights are usually adjusted to set a mood 

in the scene.

Lights in EIAS Animator can be set to any one of 16.8 million colors. You 

can also animate the color of a light, and, depending on the particular type 

of light, you can even adjust the effective range of the light, called the 

“dropoff,” and the inner and outer cone angles of the light. Wherever lights 

overlap each other, their colors will add together, producing a different 

color, just as with their real world counterparts.

There are six light types in EIAS Animator:

• Radial
• Parallel
• Spot
• Tube
• Ambient
• Camera

These light types can be mixed and matched together in order to achieve 

dramatic lighting effects.

Radial Lights. Radial lights cast light rays out from their centers in all 

directions. These rays act like the spokes of a bicycle wheel, but in a spheri-

cal area. Radial lights most closely resemble artificial lights, like those 

found in your home.
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Parallel Lights. Parallel lights cast parallel rays. Parallel lights are analo-

gous to stars (such as the sun). There is no real beginning to a parallel light. 

Objects lit by parallel lights will be evenly lit, unlike the other light types.

Spot Lights. Spot lights work just like real spotlights. You can adjust the 

inner and outer cone of the spotlight, as well as the dropoff distance. You 

can also animate these attributes. Spot lights are great mood enhancers for 

a scene and offer the greatest amount of control.

Tube Lights. Tube lights are basically elongated radial lights. You can 

adjust the length of the tube and, by enabling fog or glow special effects (as 

explained on the next page), create such visual elements as fluorescent 

bulbs, laser beams, etc.

Ambient Lights. Ambient lights add an overall brightness to a scene 

regardless of the orientation of the surface relative to the other lights. 

Experimenting with ambient lights will give you the best indication of their 

usefulness to you. 

Camera Lights. Camera lights are radial lights which are attached to the 

front of the camera, always illuminating the area in front of the camera.
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Animating in EIAS

To successfully create 3D animation in EIAS Animator, you must learn a 

few basic concepts about how 3D animation works, about the animation 

tools included with EIAS Animator and the EIAS workflow between EIAS 

Animator and EIAS Camera. 

EIAS allows you to animate objects over time: model object files (and their 

groups or layers), cameras and lights. The following discussion applies to 

all of these object types.

1.7 What is an Object?

An object is any item which is an independent entity in the scene. An object 

can be a model file that you import, a scene camera and a scene light. 

Model files consist of a collection of sub-objects called groups in EIAS Ani-

mator (some programs refer to them as layers).

Scene cameras and scene lights are system objects. They exist in 3D space, 

but contain no real volume, with some lighting effects as exceptions to this.

Model files and groups are a collection of points, lines and polygons, and 

are combined with shading and material information at render time. These 

points, lines and polygons make up the overall shape that you perceive the 

model to have.
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1.8 What Can You Do with Objects?

Objects are what you animate in EIAS. The type of animation allowed 

depends upon the particular object, but here is a general list of ways to 

interact with (and animate) objects: 

• Import Model Files into the project
• Select (implicitly)
• Move (translate)
• Rotate
• Scale (models only)
• Animate
• Create Hierarchies
• Deform (models only)
• Morph (models only)

1.9 Importing Models into EIAS Animator

A “model” is an object file on disk which uses polygons to describe its 

shape. Models can be created in  3D programs (EIAS Animator does not 

create models directly, with the exception of 3D text). EIAS Animator 

requires that all of its models be imported into the FACT format, which is 

the Electric Image model format. EIAS Animator can import the following 

model types:

• Lightwave (.lwo I & II)
• 3-D Studio (.3ds)
• Autocad (.dxf)
• Maya (.obj)
• ElectricImage (fact)
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To import a model into EIAS Animator:

1. Choose Object>Import Object from the main menu bar
2. Pick the file you wish to import from the file list

The file will be imported into the scene. Once that is complete, the 

import dialog will appear again, prompting you for any additional 

model files to import.

3. Choose any additional models, or press the Done button to close the 
dialog

3D Text Models

Although you cannot create models in EIAS Animator, you can create 3D 

text from PostScript type one and True Type fonts, which is the type of font 

that you use with a laser printer or typesetter. You can create text with 

depth, bevels and separate face groups for material mapping.

1.10 Selecting Objects Implicitly

In EIAS Animator, objects are selected by the particular tool that you have 

chosen. In other words, you pick the tool, and then you pick the object.

1.11 Moving (Translating) Objects

The translate tool is the default animation tool in EIAS Animator. When 

you select an object to translate with the translation tool, the translate 

manipulator will be activated. The T key can be used as a quick shortcut to 

switch into translate mode.
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Translate Manipulator. The translate manipulator is used move objects in 

the world. The manipulator can limit motion to just one axis, or all axes at a 

time. The manipulator is constructed of a yellow wireframe box at the ori-

gin of the manipulator (which is placed at the pivot point of the object) and 

three axis lines, radiating from the center outwards, each capped by a cone. 

The X axis is drawn as a red line. The Y axis is drawn as a green line. The Z 

axis is drawn as a blue line. Selecting any of these axes will cause motion to 

be limited to that axis. The selected axis will be drawn in yellow to indicate 

that it has been selected. 

1.12 Rotating Objects

To rotate objects in EIAS Animator, select the rotate tool. Then, select the 

object to rotate. If you select the parent object of a hierarchy, then all of the 

objects will rotate along with the parent (assuming the objects have their 

inherit rotate attributes active, which is the default). If you select multiple, 

separate objects (that do not share a hierarchical relationship), each object 

will rotate about its own center. The R key can be used as a quick shortcut 

to switch into rotate mode.

Rotate Manipulator. The rotate manipulator is used to rotate objects. Rota-

tions for objects always occur in the local space of the object. The rotate 

manipulator is an “arc ball” and drawn as a series of offset spheres or arcs, 

each axis a different color. Unlike the translate and scale manipulators 

which have only three axes, the rotate manipulator has four. The X axis is 

drawn as a red arc. The Y axis is drawn as a green arc. The Z axis is drawn 

as a blue arc. The view planar axis is drawn as a cyan circle. Selecting any 

of these axes will cause rotations to be limited to that axis. The view planar 

axis will always rotate the selected objects along the depth axis of the win-
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dow plane. The selected axis will be drawn in yellow to indicate that it has 

been selected.

1.13 Scaling Objects

To scale objects in EIAS Animator, select the scale tool. Then, select the 

object to scale. If you select the parent object of a hierarchy, then all of the 

objects will be scaled along with the parent (assuming the objects have 

their inherit scale attributes active), maintaining the scaled distance 

between children. If you select multiple, separate objects (that do not share 

a hierarchical relationship), each object will scale to its own center point. 

The S key can be used as a quick shortcut to switch into scale mode.

Scale Manipulators. The scale manipulator is used scale objects in the 

world. The manipulator can limit scale to just one axis (non-uniform scal-

ing), or all axes at a time (uniform scale). The manipulator is constructed of 

a yellow wireframe box at the origin of the manipulator (which is placed at 

the pivot point of the object) and three axis lines, radiating from the center 

outwards, each capped with shaded balls. The X axis is drawn as a red line. 

The Y axis is drawn as a green line. The Z axis is drawn as a blue line. 

Selecting any of these axes will cause motion to be limited to that axis. The 

selected axis will be drawn in yellow to indicate that it has been selected. 

1.14 Configuring Manipulators

The size of the manipulator is not related to the size of the object which is 

using it. This allows you to scale the manipulator to the working size that 

you prefer. All manipulators use the same size value, so when you change 

the size of the translate manipulator, you are also changing the size of the 

rotate and scale manipulators.
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The manipulator’s display can be controlled from the Edit>Display>Con-

troller menu item in the main menu bar. You can control the size of the ele-

ments that control the origin (yellow wireframe box) and the end caps 

(shaded cones for translate, and shaded balls for scale). You can also control 

the line thickness of all line elements (vectors for translate and scale, and 

arcs for rotate).

1.15 Animating Objects

Animation is what EIAS Animator is all about. You can choose to do simple 

little animations, or complex creations that rival blockbuster movie effects. 

What you get out of it is based on what you decide to put into it. EIAS 

operates under some important core concepts. These core concepts, when 

understood, will help you to apply the best approach to the animation that 

you are creating. 

Remember, you are always animating objects. Animation is a record of the 

changes to an object that occurs over a period of time. These objects have 

attributes that can be animated. Objects can be joined together to form 

more complex assemblies. Objects can be modified by deformations and 

morphs. Once you understand these basic concepts, animating in EIAS will 

become easier:

• Time is used to control when something happens
• Keyframe events are used to control where something happens
• Animation channels are used to control the rate at which something 

happens
• Object hierarchies are used to control how many objects will be ani-

mated, and what attributes may be animated
• Deformations are used to control other aspects of how something hap-

pens
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• Morphing is used to blend different model files of the same basic data

Time Line

To create an animation, you use the tools EIAS Animator supplies tools to 

move, rotate, scale, deform, or otherwise move or change an object over 

time. EIAS Animator uses a combination of time and events to animate 

your objects. EIAS Animator uses the time line to sample “snapshots” in 

time called “frames” and then uses these frames to render final images and 

movies. 

The time line is a scale of time that you set for the duration of your project. 

The time line is available in either the project window, or the time palette. 

Within the time line is the time slider. To change the scene time, you just 

drag the thumb (slider) to the desired time. You can go forward or back-

ward at any time.

You are in control of the amount of frames that are sampled over a period 

of time. This control is called “frames per second.” You can think of this as 

sort of a “level of detail,” as you can resample the time line into a different 

amount of frames per second as needed. As you create events, you advance 

the time slider to the next moment in time that you want something to hap-

pen. You then create the next event.

Key Frames

These events are called “key frames.” EIAS Animator then “interpolates” 

these key frames, adding extra information between each key frame that 

you set. When you playback your animation, you see a combination of 

your key frames and interpolated frames. Key frame events are the rough 

points of a motion or attribute change. You do not need to set a key frame 
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for every frame in your scene, nor should you. Instead, you want to “rough 

in” your performance, refining keyframes and adding new ones as neces-

sary to get what you want.

Creating

Keyframes

Key frames can be created automatically whenever you change something 

that hasn’t been changed before, or you can create them yourself by hand.

To create automatic key frames in EIAS Animator:

1. Select the object you wish to animate
2. Choose Animation>Enable Animation from the menu bar

This will activate the animation channel for the object (see the follow-

ing section for an explanation of animation channels.)

3. Drag the time slider to a different time
4. Move the object (or rotate, scale or otherwise change an attribute of the 

object)

A key frame will be created. 

5. Advance the time again
6. Move the object again

Additional key frames will be added to the project.

To check your work, press the preview button, or open the project window 

and note that a new keyframe has been placed in the data panel of the win-

dow.

Animation Channels

If you don’t set a key frame, you will not see any change in motion. If you 

change an object’s attributes without activating the animation channel for 
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the object, you will not see any change in motion. Instead, the last change 

you made on the object will be all that you see.

Animation channels are used to hold the information that you create when 

you animate. They are effectively “motion containers.” To save space and 

speed the performance of a project, animation channels are typically turned 

off. You can easily turn them on, just by selecting the object you wish to ani-

mate, and then choosing Animation>Enable Animation in the main menu 

bar.

1.16 Motion Path Curves

When you animate the position of objects in EIAS Animator, you will see a 

motion path curve appear. This is the path of motion that the object will fol-

low. There are two classes of motion paths, implicit and explicit.

Implicit Keyframe Paths

If your object is set to animate its position with an implicit curve, the curve 

will run through each position key frame that you have set for the object. If 

you click on any keyframe point along the motion path, the scene time will 

be set to the time of the keyframe that you selected, and you will be editing 

that keyframe.

There are four different spline types available for implicit motion paths: lin-

ear, natural cubic, Hermite and Bezier.

Linear Splines. These are not actually splines, but rather a simple line. All 

motion using linear interpolation results in a very mechanical (sometimes 

awkward) motion.
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Natural Cubic. These splines give a very fluid motion, and are the best to 

use if you do not care about the precision of object placement, since editing 

one keyframe along the spline will change the whole curvature of the 

spline.

Hermite Splines. These splines are more versatile to use but require 

greater effort to control. Unlike the natural cubic spline, editing one key-

frame along the spline will not change the whole curvature of the spline, 

and thus the curve can be manipulated with greater precision.

Bezier Splines. These splines are the same splines used by popular Macin-

tosh drawing programs such as Adobe Illustrator®, however EIAS Anima-

tor Bezier splines are 3-dimensional.

Spline paths can be edited at any time. You can also edit the tension, bias, and con-

tinuity attributes of Hermite splines.

Explicit Motion Curves

Explicit motion curves are different than implicit curves. These curves are 

combined plots of separate X, Y and Z position data curves. There is no 

provision to edit the shape of the curve in the 3D views. Instead, you must 

edit explicit curves in the function curve editor.

To set an object to use explicit translation curves:

1. Select the object
2. Choose Object>Group Info (command or control “i”) from the main 

menu bar

The object information window will appear

3. Choose the X-form tab in the window if it is not already visible
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4. Under the position heading, choose “Explicit” from the key popup 
menu

The curve is now changed to an explicit motion curve. The path curve will 

be drawn without any form of keyframe markers.

Note Explicit path curve shapes are harder to control than implicit path curves, as you 

can edit those directly. If the shape of the path is important, try using implicit 

curves set to bezier, and make adjustments as needed. Then, you can convert to an 

explicit curve and finish the editing in the function curve editor.

1.17 Object Hierarchies

Object hierarchies are used to control what objects are connected together, 

and what objects are animated within that relationship. The hierarchical 

relationship between objects is often expressed as parent/child. To under-

stand what a hierarchy is, just examine you own hand. Each finger joint is 

attached to the next one, as the chain that is a single finger heads toward 

the wrist. Each finger travels through the palm area and forms a nexus with 

the other fingers at the wrist. The root of the hierarchy, forming the base, is 

the wrist/palm. The root, or parent, has the fingers attached to it, joint by 

joint. The fingers are said to be the children, grandchildren, and so on for 

each joint, down to the finger tips. This is a basic hierarchy.

Object hierarchies can be animated directly, using what is called “forward 

kinematics” or they can be attached to skeletons and animated in a fashion 

more like human motion, using what is called “inverse kinematics,” which 

is covered in the following section.
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Forward Kinematics

Using the typical swing arm lamp as an example of a hierarchy containing 

five joints (base, arm 1, arm 2, lamp shade), animating this hierarchy one 

joint at a time to make the arm swing around is how forward kinematics is 

applied. You are responsible for animating each joint to get the perfor-

mance you require. Forward kinematics are great for straightforward ani-

mation of fairly simple hierarchies.

1.18 Inverse Kinematics

Using the swing arm lamp example again, you can imagine the same hier-

archy as a simple “IK chain,” which is just a fancy way of controlling the 

hierarchy as a single unit. With an IK chain, you merely adjust the end of 

the chain, in this case, the lamp shade, and the rest of the joints will move 

accordingly. Of course, IK chains can be applied to more complex hierar-

chies, such as organic characters like animals, humans and even aliens!

IK chains are actually a series of bones, with an IK handle applied to con-

trol them. An IK handle is a special controller that manages the motion of 

the chain to which it is attached. You move and animate the IK handle, not 

the bones or skeleton joints directly. 

IK handles are scene objects, as such they do not render. IK handles have 

their own information window, which is activated in the following ways:

• Selecting the IK handle and then choosing Object>IK Handle info

• Double-clicking on the IK handle
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The IK Handle information window has three tabs:

• X-form
• Properties
• Chain

X-form tab. The x-form tab contains all of the transform information for the 

IK handle. You can use this tab to reset the position of the IK handle during 

an animation, especially if you “parked” the IK handle prior to animating.

Note You can only apply object parking (Hierarchy>Park) to objects that are con-

tained within a hierarchy. If you attempt to apply the Park command to 

objects outside of a hierarchy, strange things can happen...

The x-form tab contains numeric entry edit boxes for translation, rotation, 

and scale. The translation and rotation edit boxes are applied in a manner 

similar to all other objects. 

Figure 1.3 — IK Handle Information window, Properties tab
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Tip The scale attribute is applied to the size of the selection handle for the IK 

handle. If you are having trouble selecting the IK handle, change the scale 

value to suit your needs.

Properties Tab. The properties tab controls the attributes of the IK handle. 

You can choose what type of IK solver is applied to the handle; set the pre-

ferred angle, pole vector location and twist of the handle; and choose 

which type of goal will be used by the IK solver.

There are three types of IK solvers in EIAS Animator:

• Pseudo
• Minimizer
• 2 Bone

In a character set up, your skeleton rig will have many separate chains. In a 

human, for example, you will have chains for each arm and leg, each finger 

and the spine. You can also add chains for the head and mouth, and the 

feet. These chains are typically (although not always) controlled by an IK 

handle, and that IK handle will use a solver to produce a result.

An IK solver is a method to determine how the IK solution will be calcu-

lated for the specific chain that you are working with. Which solver works 

the best is a matter of choice on your part. A solver works by finding the 

best IK solution to apply to a chain within the parameters that you specify. 

Typically, most of the chains used for a human character would be planar; 

that is, the motion of the bones in the chain would tend to lie on a plane. 

For example, the human arm consists of several bones: the humerus, which 

extends from the shoulder to the elbow and comprises the “upper arm”; 

and the ulna and radius bones, which extend from the elbow to the wrist, 

comprising the “fore arm.” The direction of travel for the arm is led by the 
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wrist/palm. If you were to “connect the dots” from the tip of the humerus 

through the elbow, on to the end of the ulna/radius, and back to the tip of 

the humerus at any point of motion for the arm, you would have a planar 

triangle. The IK solvers know that, and can limit the amount of work that 

they have to do to allow only planar solutions for the motion generated by 

the IK handle.

Each solver attempts to find a solution in a slightly different way. The 

pseudo solver uses linear approximation to quickly find an IK solution. The 

minimizer solver will minimize the amount of unacceptable solutions pos-

sible, and then pick a result. The 2 bone solver with apply geometric analy-

sis to find a solution. It only works with chains of two bones in length, and 

will lock any additional joints.

You will find that you have the best results with either the pseudo or 2 bone 

solvers (any chains consisting of only 2 bones will automatically use the 2 

bone solver). The minimizer solver can sometimes cause the end effector to 

be in a position other than the explicit endpoint defined by the IK handle.

Preferred

Angle

The preferred angle indicates the desired direction preference of the IK 

chain. This value will help the solver to find an accurate solution quickly. 

To improve the results, the preferred angle should be clear and non-ambig-

uous. This is accomplished by creating or manipulating the shape of the 

chain to clearly show an angle, such as an elbow or knee bend. To set the 

preferred angle for the IK handle, click the Preferred Angle button.

Chain. The chain tab contains a list of all of the joints and bones under the 

control of the IK handle. You can access the bone or joint directly by double 

clicking on the name of the joint in the chain list.
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To apply an IK handle to a bone or joint chain:

1. Select the end of the chain (if you want to apply an IK handle to the 
entire chain) or choose the beginning and end joint to be controlled by 
the IK handle (if you want to apply the handle to a subset of the chain)

2. Choose Character>Add IK Handle from the main menu bar

The IK handle will be added from the end of the chain to the beginning 

of the chain (called the “root.”) The handle will be listed as an object at 

the end of the object/channel list in the project window.

Once you have create an IK handle, you can use that handle to manipulate 

the chain underneath. If you happen to make any change to the chain that 

would affect the rotation axes (used by the IK handle) directly to the bone 

or joint, those changes will be lost the next time you use the IK handle.

In order to animate the IK handle, you must select the handle and choose 

Animation>Enable Animation from the main menu bar. Once you enable 

the animation record for an IK handle, the handle will maintain its position 

in space, as opposed to moving with the rest of the hierarchy. That is 

because the handles are located in global space by default. If you require a 

handle to move with the rest of the skeleton, you can imbed the handle into 

the hierarchy at the appropriate location. 

Pole Vector and Twist Disc

The pole vector controls the direction in which the IK reference plane is ori-

ented, and is used to keep the IK chain from flipping 180˚ on its axis. This 

happens when the pole vector has crossed the IK handle vector, or is point-

ing in the opposite direction (which can happen frequently). To control axis 

flip, you must activate the pole vector (enable the Show Pole Vector check 

box), and make sure that it doesn’t cross the IK handle vector, or point in 
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the opposite direction of the IK handle vector. To change the position of the 

pole vector, click and drag on the box at then end of the vector.

The twist disc control is used to control the orientation of the IK joint plane, 

which is separate from the reference plane controlled by the pole vector, 

even though the end result appears to be the same. While the pole vector is 

used to keep the IK solution under control, the twist control is used for the 

purposes of performance. To keep things simple, use the pole vector to con-

trol axis flip, use the twist disc for everything else that requires orientation 

of the IK joint plane.

Hierarchies or No Hierarchies?

Do you need to create hierarchies to animate? Of course not. Whether or 

not you need a hierarchy depends entirely on what you are trying to ani-

mate. However, as you gain more experience in animation, you will likely 

apply a hierarchy to almost anything you animate with more than one 

component.

Figure 1.4 — Bone chain, with IK handle parts illustrated
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1.19 Deformations

Hierarchical animation will allow you to create complex assemblies and 

animate them easily, but you are limited to “rigid bodies” with hierarchical 

animation alone. You could not have a single arm model bend at the elbow 

without some additional help. That’s where deformations come in.

Deformations are volumetric regions attached to objects which allow you 

to distort the shape of an object in a variety of ways. They can be applied, 

singly or in combination, to specific regions within a group, individual 

groups within a model, and can optionally affect other groups within the 

model. Deformations can also be animated. For example, you could take a 

model rectangle and ripple it like a flag in the wind. Or you could make a 

figure’s body parts bend and twist to simulate natural arm, leg and head 

movement.

Deformations can be used with inverse kinematics to automatically create 

deformable skins. Using what is called a “bone deformation,” the skins that 

are parented to the same root as the bone skeleton can bend the skin along 

with the bone skeleton as the skeleton is animated (this works with inverse 

or forward kinematics.)

In EIAS Animator, deformations can be applied in layers, in a hierarchical, 

cascading fashion. The order in which a deformation is applied to an ani-

mation is important, and EIAS Animator will let you adjust the order of 

deformations to get the proper effect.

Deformations are a group-based tool. They are applied as a group attribute, 

although they can affect children groups if the children of the parent to 

which the deformation is applied are set to inherit deformations. 
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Deformation Regions

Deformations are applied to groups and are bound by regions. Regions are 

boxes which surround the group. The group portions within the region will 

be affected by the deformation. Those portions outside of the region will 

not be. This behavior will allow you to put a small-radius bend into a cylin-

der, or bend the entire cylinder.

Regions can be animated, and then can be attached to null effectors as well 

as geometry. This allows for some very powerful effects. For example, if 

you create a null effector (a placeholder object that does not show up in 

rendered imagery) and attach a deformation region to it, parent a cylinder 

object to the null and set inherit deformation for the cylinder, then drag the 

cylinder through the null effector, you will see the cylinder deform as it 

passes through the null. As the cylinder passes outside of the null’s influ-

ence, its normal shape will return. 

Types of Deformations

There are twelve different deformation types available. Each of these defor-

mations is suited to a particular task. In order, they are:

• Scale
• Shear
• Twist
• Taper
• Bend
• Bulge
• Linear wave
• Circular Wave
• Stretch
• Bezier
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• Bezier II
• Bones

To apply a deformation to a group:

1. Select the group, by either clicking on it in the world views or selecting 
its name in the Project window.

2. Choose Animation>Deformation Editor from the main menu bar

The Deformation Editor opens.

3. In the Region section, click on the Add button

A new deformation region will be added to the group.

4. In the Deformation section, click on the Add button
5. Choose the type of deformation from the Type menu.

The deformation will be added to the group.

Different deformations have different controls. Some deformations have 

special options, which are available in via the Options... button. All defor-

mations require that you set the direction axis (or axes) and the deforma-

tion axis (or axes). You can interactively set the strength of the deformation 

in the 3D views, or you can enter a value for the deformation strength in 

the amount edit box.

You can limit the effective area of deformations by enabling the check 

boxes in the minimum and maximum sections. This controls the deforma-

tion region to which the deformation is applied. You can choose to limit just 

a few axes, or all axes, based upon which check boxes you enable. If no 

check boxes are enabled, the deformation will not be constrained.

Note While the deformation editor is active, no other functions will be available. 

In order to set a new rotation or translation on the group, you will need to 
EIAS Animator        39



Chapter 1  Animating in EIAS — Morphing
close the editor before you proceed (placing the editor in the background 

will have no effect). Deformation editing can be accomplished only when 

the editor is open.

1.19 Morphing Model Poses

Deformations change the actual geometry of the model, but morphing uses 

model poses to create new, in-between poses. What technique to use is 

based largely upon the task at hand. For facial animation, it is hard to beat 

morphing. In fact, it has been the favored method of facial animation for 

some time now. The upside to morphing is that it is very easy to under-

stand and learn to use. The downside is that you must create different vari-

ations of the model, typically called poses, in order to use morphing. 

Depending upon your modeling skills and your patience, you will have 

more or less success with morphing.

Morphing models is very similar to “replacement animation,” a technique 

often used by claymation animators (and a technique offered by EIAS Ani-

mator). These models must have the same amount of polygons in order for 

the process to work properly. Morph models are actually separate disk-

based model files. These model files are loaded into the morph editor. From 

there, you use slider bars that has the morph editor blends the different 

model poses together, creating a new pose altogether. 

Facial animation is the most common use for morphing, but you can use it 

for any model that you wish to morph. For example, you could animate a 

bird flapping its wings, or perhaps a pair or “rabbit ears” (an old fashion 

set top TV antenna) reacting with anthropomorphic character. Whatever 

you choose to morph, make sure that you have enough in between poses 

created. Unlike deformations, a morph target will tend to progress in a lin-

ear fashion. You can control the timing of the morph with a spline curve, 
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but the morph itself will be direct (that is, linear.) So, it you are morphing 

things other than facial features, be sure to include an additional pose or 

two for extreme motion, to help make the motion appear more realistic.

1.20 Modifying Values in Edit Boxes and Cells

When animating in EIAS, you can interact with the program numerically or 

directly in 3D. Working numerically, which you will do from time to time, 

EIAS Animator allows you to enter relative values and percentage changes 

based upon the existing value in an edit box or cell.

Edit boxes support two types of value changes: relative offset and percent-

age. 

Relative Offset Value Changes

Relative offset value changes alter each selected item by adding, subtract-

ing, multiplying, dividing or taking to a power. A change of +25 would add 

25 to the current value in the edit box or cell.

Percentage Value Changes

Percentage value changes alter the selected item by computing a specified 

percentage to each value individually. A percentage change of 150% would 

make the value 1.5 times its current value.

Applying Value Modification

Relative offset and percentage changes are applied by entering simple for-

mulas in data cells or edit boxes. The syntax of the formula is:

@ symbol amount
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where @ means the current value of the cell, and symbol indicates an opera-

tion to be performed, and amount is the numeric offset or percentage. For 

example, @*7.6 results in the cell’s current value being multiplied by seven 

point six.

The formulas you enter are not retained by EIAS Animator. They are immediately 

processed, and the result is placed in the edit box or data cell.

The following symbols are supported:+,-, *, /,^and%. In addition, two 

other symbols,! (for negating the value of the edit box) and # (to set the 

absolute value).

1.21 Surface Attributes

Surface attributes (which apply only to models) define the color, diffuse, 

specular, reflectivity, transparency, luminosity, and edge density of the 

model’s groups. Surface attributes, taken together with texture, reflection, 

bump, and transparency maps, make up the overall appearance of the ren-

dered model. The Material Editor is used to set the surface attributes of 

your models. 

1.22 Sound Synchronization

EIAS Animator allows you to import an unlimited number of sound tracks 

from the many different popular sound editing programs, or record 

directly from the microphone. Sound frequency import range is from 5KHz 

to 64KHz, and sound track wave forms are displayed directly in the Project 

window. The sound tracks are automatically parsed and sounds are 
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assigned to every frame. Synced animations can be previewed in real time 

and saved in Quicktime format. EIAS will add sound only to the Quicktime 

format.

1.23 Tool Palette

The tool palette contains a collection of tools that give you access to most of 

the object manipulation functions in EIAS Animator, as well as motion path 

and grid control. All of the selections in the tool palette are available in the 

main menu bar, as well as several other locations.

Figure 1.5 — The Tool Palette
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1.24 The Project Window

Recognizing that different animators work in different ways, EIAS Anima-

tor allows you to animate in an event-based time system and/or by an 

explicit frame-based system. Both approaches use the keyframe paradigm, 

which harkens back to the days of traditional cel-based 2D animation. You 

can animate in either system or both, and each has its strengths and weak-

nesses. Taken as a combined whole, however, this approach provides you 

with the most powerful and flexible tools available in any animation sys-

tem.

The Project window is where you set the animation modes (e.g., Time, Key-

frame, etc.), and where you can observe and animate all of the attributes 

within the project file. In Time mode it provides a graphic time scale on 

which to set events.

Events can also be synchronized to sound tracks, which are represented in 

graphic form.

In the other modes, such as Keyframe mode, it provides a complete over-

view of the project in a format resembling a spreadsheet, and you could 

specify and animate virtually all attributes of the scene from this one win-

dow if you wished to.

Because there can be a very large amount of information in a project file, 

the Project window is programmable. It is broken down into several sec-

tions and each section can be collapsed to shrink the size of the window for 

convenience.

Groups and lights can be renamed in the Project window and frame data 

can be edited by directly keying in values.
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The Project window also contains a palette with tools and pop-up menus 

for performing various operations on frame data such as cycling a range of 

frames and creating a blend between two frames (many options are avail-

able).

The Joint Editor

This window is where you can assign joint types for a model’s groups’ hier-

archy (controlling how the model’s groups move in relation to each other).

There are many options for setting how a group can move (i.e., rotate, 

swivel, etc.), by itself and in relation to other groups in the same model. 

The data contained in the edit boxes are in local coordinate space.

The Render Information Window

This window is where you specify how your animation or image is to be 

rendered, such as how many and which frames to render, how large your 

rendering should be, and the level of quality you wish your rendering to 

have.

The window’s check boxes are used to selectively enable or disable render-

ing effects for controlling the efficiency of the rendering process (i.e., it may 

not be necessary to perform a full rendering if you are testing a single ele-

ment of a scene).
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1.25 File Management

EIAS Animator and you are responsible for managing the many different 

kinds of files that you will use to create your work. The types of files that 

EIAS uses are:

• Project Files
• Model Files
• Material Files
• Texture Files
• Sound Files
• Channel Envelope Files
• Plug-in Files

EIAS Animator maintains a directory structure for the most common files 

that it uses. After you install EIAS Animator, several directories are placed 

within the directory that EIAS Animator has been installed into. These 

directories are:

• EI Material
• EI Resources
• EI Shaders
• EI Snapshots
• EI Sockets
• Renderama Jobs

EI Material. This folder contains material descriptions that you create, save 

and load.

EI Resources. This folder contains resources that EIAS Animator needs in 

order to operate. Do not remove this folder, or change its location.

EI Shaders. This folder contains all of the shaders that you have installed. 

Place any third party shaders into this directory.
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EI Snapshots. This folder is used to hold any snapshot renderings that you 

create during a session with the program. Once you exit the program, the 

snapshots in this folder will be deleted, freeing up disk space. If you wish 

to keep your snapshot renderings, you will need to set the preference. 

Choose Edit>Preferences>Preview & Render tab, snapshot section, and 

enable the Make Image Permanent check box. If this check box is enabled, 

snapshot images are then placed within the home directory of EIAS Ani-

mator, and not within the EI Snapshots directory.

EI Sockets. This folder contains all of the plug-ins that you have installed. 

Any plug-in not installed into this folder will not be available to the pro-

gram.

Renderama Jobs. This folder contains the job information for any network 

rendering that you have initiated.

Any other files not covered by these categories can be placed anywhere, 

although it is recommended that you follow a logical structure. You may 

wish to keep all of your bitmaps in the same directory, or you may wish to 

place them within directories that are specific to the project you are work-

ing on. The same holds true for model files.

Note Should you need to gather files used by a project together, you can use 

File>Collect Files... from the main menu bar. This command will collect all 

files that your project is referencing, and place them where you direct.
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Rendering and Raytracing

1.26 Introduction

Rendering and raytracing creates two dimensional pictures from the 3D 

information contained in the project file. When you set up your models, 

lights, and the camera, you are supplying the rendering engine with a three 

dimensional data set. That data set is fed to the rendering engine to be ren-

dered and raytraced as you have determined. The output of the rendering 

engine is either a single picture or a movie file.

Rendering and raytracing perform imaging tasks in different ways. Ren-

dering is like an artist or illustrator, capturing an impression of a composi-

tion. Rendering can easily produce photorealistic results, but you may be 

able to see that reflections and transparencies are not the same as those you 

would see in the real world. The benefit that rendering gives you is speed 

and image quality (in terms of anti-aliasing—see below.) The detriment to 

rendering is the setup time for simple things such as shadows, and the 

requirement that you plan ahead in order to optimize your speed benefits 

even further.

Raytracing is more like photography, in the sense that the raytracing engine 

will take a more accurate approach to imaging the scene, actually following 

beams of light as they exit the camera and voyage into the world (which is 

the exact opposite of what happens in the real world.) The images pro-

duced by raytracing can be nearly perfect, in terms of reflections, transpar-

encies and refraction, and more accurate (and easier to use) shadows. 

Unfortunately, as you can imagine, raytracing is a slow process, and can get 

much, much slower when dealing with very large scenes (in terms of poly-

gon counts.) Also, anti-aliasing can suffer, as a lower quality of filtering 
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must be used in order to keep imaging times within the realm of practical-

ity.

Hybrid Imaging

EIAS Camera is a hybrid renderer/raytracer. Depending upon the material 

and shadow settings that you specify, either the renderer or the raytracer 

will be used. This test is applied on a channel-by-channel basis, so that ray-

tracing is used only where it is needed. As raytracing is very time consum-

ing, this discretion is mandatory to make it practical for legitimate 

production.

The raytracer inside of EIAS Camera benefits from the legendary speed, 

efficiency and image quality of the renderer that preceded it. In the same 

amount of time as other raytracers, it can produce a higher quality image. It 

can also produce higher quality images is less time as other raytracers, and 

you may find this result is typical for your use.

1.27 Shading

Renderers and raytracers produce images by a process called shading. 

Shading determines what color a particular pixel in an image will be.

Before a pixel can be shaded, it must first be mapped to a polygon. And 

before the pixel is mapped to the polygon, the polygons must be tested to 

determine which part of the polygon is visible (if at all). Shading only the 

visible portions of polygons reduces actual rendering times quite a bit, 

since the renderer is not shading what is not visible and is not wasting any 

time.

Each polygon contains at least one shading normal (a normal is a line or 

vector which indicates the direction that a polygon or vertex is oriented 
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towards). Vertexes which border polygons can also contain normals. These 

normals are used by the rendering and raytracing engines to properly 

shade the object. Without these normals, the objects would not be recogniz-

able.

Polygons can be shaded in several different manners, called algorithms. 

EIAS Animator offers a choice of flat (also called “constant”), Gouraud, 

Phong and raytracing.

Flat Shading

Flat shading creates evenly filled polygons. It uses the single normal in the 

center of the polygon to determine a shade for the whole polygon. There 

would be no change of colors across the surface of a flat shaded polygon.

Gouraud Shading

Gouraud shading creates a graduated shade across the surface of the poly-

gon. It uses the normals located at the corners, or vertices of the polygon 

with which to shade.

This results in a very fast, smooth shade, but the highlights (reflections of 

the lights illuminating the polygon) look awful, so Gouraud is usually not 

used when rendering shiny objects.

Phong Shading

Phong shading also graduates the shading across the surface of the poly-

gon, but in a superior manner to Gouraud. It uses the normals at the verti-

ces of the polygon, but creates new normals in between the existing 

normals, creating a much more precise shade across the surface of the poly-

gon.
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Raytracing

Raytracing is a very precise shading algorithm. It uses polygon normals as 

do the other methods, but it precisely tracks rays from the viewer to the 

object (and any reflections), and ultimately to the light source. As a result, 

raytracing takes much longer to image a scene than Phong or any of the 

other methods. It will give you accurate reflections, refractions and shad-

ows, and should be used when you need those things. If not, use Phong.

1.28 Resolution

EIAS Animator will let you render your images in resolutions up to 32,000 

pixels by 32,000 lines. You can even adjust the aspect ratio of the pixels in 

the image so that they better conform to video systems, or older graphics 

systems. The default resolution is set to the resolution of the monitor on 

which you start up EIAS Animator.

1.29 Color Depth

EIAS Animator renders in 48-bit color space and then reduces it down to 32 

bit color space. That means that every image you render can have any one 

of 16.8 million colors per pixel, plus any one of 256 values of transparency 

per pixel. This is often referred to as true color. There are also some black 

and white rendering modes available, which resemble the old black and 

white paint programs from the early days of computer graphics.

1.30 Anti-Aliasing

Anti-aliasing creates an image which appears to be a much higher resolu-

tion image than was actually rendered. It does this by creating “in-

between” colors for every pixel, by rendering the image at a higher resolu-
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tion and then shrinking it. Instead of throwing away pixels which don’t fit 

in the smaller space, these pixels are sampled together, and a new single 

pixel is derived. It may sound complicated, but all you need to know is that 

it significantly improves image quality, especially in animations. EIAS has 

superior anti-aliasing, and produces higher quality results without the time 

penalty of other programs. 

EIAS Animator offers scene and object anti-aliasing, and can be adjust to 

whatever sampling levels are required. EIAS can anti-alias with an over-

sample method, which produces images that are better suited to motion 

and film, and an adaptive method, which offers more clarity and detail at 

lower resolutions than oversample.

1.31 Motion Blur

Motion blur occurs whenever the subject or the camera moves faster than 

film can record an image. Since motion blur does not occur in computer 

graphics, computer animation often lacks an element of reality (we expect 

to see motion blur). EIAS Animator allows you to add motion blur so that 

the final image looks more like the real world.

EIAS Animator offers two different types of motion blur which can be 

intermixed for maximum benefit: 2D motion blur (motion vector) and 3D 

motion blur (multi-frame.) Electric Image developed 2D motion vector blur 

in the early ‘90’s as an answer to the less that appropriate look of 3D blur. 

As both methods have their uses, EIAS Animator offers both. In fact, you 

can have 3D blur set, and use 2D blur to smooth the results a bit (with just a 

little extra rendering time!)
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1.32 View Image

Once you have rendered your still image or animation, you will want to 

review it. The View Image interface allows you to do this. Rendered snap-

shots come up automatically, but for reviewing texture maps or older, ren-

dered files, use the File Menu>View Image command.

The left side of the window has a toolbar for manipulating the image. There 

is a scroll bar at the bottom that tells you the current frame and allows you 

to view any frame in the animation.

There toolbar shown above is for a standard Image or QuickTime file. The 

toolbar has a few extra controls when viewing a lightprobe file.

Figure 1.6 — View Image
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Image Information. This button pops up a small window that displays 

basic data about the file being displayed including frame size, number of 

frames, frame rate and color depth.

Color Channels. This pop-up menu allows you to display individual color 

channels or just the alpha channel. 

Color Background. This allows the background color of the Image file to 

be changed. 

Save Image. This allows you to save the still image or animation to the 

Image file format or to QuickTIme. This can be used to convert files 

between Image and QuickTime and visa versa.

Figure 1.7 — View Image Tool Bar – Lightprobe (left)    Standard (right)

Image Information
Color Channels
Color Background
Save Image
Convert Lightprobe
Standard Picker
Zoom Image Mode
Drag Image Mode
Color Picker
Gamma Control
Spot Meter

Exposure Control

Play QuickTime
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Convert Lightprobe. Animator’s display engine can view files in the 

RADIANCE .hdr  file format. Camera can not render these files directly, but 

the Convert Lightprobe pop-up menu can be used to save the files in a for-

mat that can be used by Animator (for Illuminator Gels) and for Camera.

Lightprobes generally come in two styles. Angular and Spherical. The vast 

majority of lightprobe .hdr files are Angular. This style creates less distor-

tion at the edges. Convert Lightprobe allows you to select Angular or 

Spherical before exporting.

Three export formats are included under the Convert Lightprobe pop-up. 

Convert to Longitude/Latitude   This is the format to use when saving out 

images for use in Illuminator Gels (See “Gel Tab” on page 227.) The format 

spreads the image out, flattening it.

Convert to Cubic Environment   This writes out a 6 frame Image file that 

can be used as a cubic reflection map.

Convert to Cubic QuickTime VR   Writes out a cubic QTVR movies. This 

feature does not currently have a use in Animator or Camera but may pro-

vide an interesting view of the lightprobe. Note that after rendering our the 

QTVR, Animator will open it in a Display window that cannot properly 

handle panning. Please close that window and open the QTVR directly 

using Apple’s MoviePlayer.

Standard Mode. This is the default mode. As you move the mouse over the 

image, you will see the pixel location and RGBA color and values dis-

played at the top of the window. Clicking the mouse in the image will have 

no effect when you are in this mode.
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Zoom Image Mode. This button selects the zoom mode. Clicking in the 

window when in this mode zooms in. Right-button mouse click (Control-

Key mouse click on Macintosh) zooms out.

Drag Image Mode. This button selects drag mode. This is used to pan an 

image that is larger than the display. The spacebar is a shortcut key for this 

mode.

Color Pick Mode. This button copies the color where the mouse is clicked 

to the scrap book. More importantly, it enables color dragging to any of he 

color chips in EIAS Animator.

Click and hold the mouse down on the pixel that you want to copy. Then 

drag this color onto one of the color chips. When the mouse moves over the 

color chip, it will highlight. At this point, release the mouse button. The 

color chip will now be the color of the pixel.

 

Figure 1.8 — Color Pick Dragging
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Gamma Control. This Pop-up menu allows you to view the image in a 

variety of standard gamma settings, no gamma at all, or a custom value for 

gamma that you select.

Spot Meter. This control is available only when viewing lightprobes. Light-

probes are made my taking multiple photographs at different exposures. 

Animator (and Camera) can only deal with a single exposure setting. The 

spot meter and the Exposure control (discussed below) are used for this 

purpose.

Choosing the Spot Meter will change the cursor and the behavior of the 

display window when you click or drag in the image. Clicking on a dark 

region will brighten the exposure. Clicking on a light region will darken it.

Full Range, Mid Range and Center Weight are quick ways to select some 

generally useful exposure values.

Exposure Control. This control is available only when viewing lightprobes. 

Drag the small yellow triangle up and down to adjust the contrast of the 

image. Hold the shift key and drag to adjust the exposure.

Play QuickTime Movie. This button opens the movie in a QuickTime 

player window. This allows you to play the movie instead of just scrubbing 

it with the scroll bar.
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1.33 OS X

EIAS runs natively under Mac OS X —it also runs under Mac OS 9. Run-

ning in the Classic environment is not supported. 

Warning Do not run EIAS with the Classic environment running in the background. Clas-

sic, even when idle, takes a lot of CPU cycles. It also has its own driver for the don-

gle. This can cause corruption of your projects. A warning dialog box appears if 

you attempt to launch Animator when Classic is running. Shut down Classic 

using the Classic Control panel in the Mac OS X System Preferences.

After installing the applications under OS X, launch the Camera and set its 

memory allocation as described on page 2.

Under OS X, the Quit and Preferences menu items have been moved to the 

“EIAS Animator” menu.

Warning Do not run EIAS if Norton Anti-Virus is installed on the computer. Norton pre-

vents Camera from operating properly.
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World View Windows

2.0 Introduction

The World View windows are the drawing windows of the ElectricImage 

workspace. It is in these windows that objects (models, lights and the cam-

era) are represented by icons which can be selected and dragged with the 

mouse. Also, the paths that objects travel (if animated) are visible as lines 

which can be edited in much the same way as lines are edited in most pop-

ular Macintosh drawing programs.

There are four World View windows, showing three views of EIAS:

• Top (from the top looking down)
• Side (from the right side looking across to the left side)
• Front (from the front looking to the back)
• Camera (perspective view)

In addition the three non perspective windows can also look from the Bot-

tom, Left Side, or Back.

Each view can be changed to any of the other views. The figure below 

shows a Front World View window.
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2.1 View Window Controls

Close Window

Clicking this box closes the View Window. Windows may be reopened 

using the commands located under the Window menu.

Min/Max Window

Clicking this box causes the window to fill the screen. Clicking a second 

time returns the window to its former size.

Figure 2.0 — World View Window
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Zoom

Click and hold the mouse button then drag from side to side. The window 

will interactively zoom in and out. You can fit the scene to the window by 

holding down the F-key and clicking in one of the three Orthogonal View 

windows. Shift-F-key and clicking will fit the selected objects to the win-

dow.

Pan

Hold down the spacebar and drag with the mouse button down to pan the 

Orthogonal View windows up/down, left/right. Hold down Spacebar and 

the X key to constrain the pan to left/right. Hold down the Spacebar and 

the Y key to constrain the pan to up/down.

Grow

Click and drag on the grow button to increase or decrease the size of the 

window interactively.

Shade Mode

Clicking on this button brings up a menu that allows you to set the draw-

ing level of the window. Drawing modes are discussed in “Drawing 

Modes” on page 9.

Projection

This displays the two orthogonal axis of the window. Clicking on the pro-

jection button brings up a menu that lets you switch the view to Top, Front, 

or Side.

Snapshot 
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Causes Camera to be launched and a rendering made of the non-perspec-

tive view. Renderings can be made at the Window size or Render control 

size.

Note Certain rendering features require perspective including Sky/Ground, volumetric 

lighting and lens flares. These feature will not be rendered from non-perspective 

views.

Resize Window

This brings up a dialog that lets you set the view to the exact X and Y 

dimensions of your choice.

Preview

Clicking on the Preview button starts the preview process. The animation is 

previewed to the screen or to a file. When previewing to the screen, the pre-

view continues looping until it is stopped by pressing the mouse button.

Right Mouse Button clicking (Ctrl-Key clicking on Macintosh) on the Pre-

view button brings up the Preview Options dialog. There is one set of Pre-

view Options for all windows.

Output. A pop-up menu that directs the preview to the screen, to an Image 

file, or to a QuickTime file.
62       EIAS Animator   



Chapter 2  World View Windows — View Window Controls
Background. A pop-up menu that controls how the rotoscope background 

images are used during previews. None prevents the backgrounds from 

being used, Still causes the first frame of an animated background to be 

used in every frame of the preview. Animated increments the animated 

background as the preview plays. Preview performance will be highest 

when the None or Still options are used.

Engine. When rendering to Image or QuickTime you can select which 

drawing engine is used. Choices are Native (the software engine) or Hard-

ware (OpenGL). 

Detail. Selects the shading mode for the preview. Options are the same as 

those discussed in “Drawing Modes” on page 9.

Drop Frames. Used during preview to screen mode only. Causes the draw-

ing engine to skip frames in order to maintain the project frame rate.

Playback Immediately. Used when rendering to Image or QuickTime. 

Causes the preview file to open and begin playing as soon as all of the pre-

view frames are written out.

Figure 2.1 — Preview Options Dialog
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Object. Allows you to prevent classes of objects from being drawn during 

the preview. 

Preview. Begins the preview process.

Cancel. Closes the dialog box without making any changes.

Save. Closes the dialog box and remembers the changes you have made.

Output Options. Brings up the QuickTime options dialog box where you 

can set the CODEC and quality for previews to QuickTime.

2.2 Grid, Rulers and Paths

The World View windows contain grids and rulers to help you align and 

manage the positions of the objects in your project. 

Figure 2.2 — Rulers, Grids and Paths

Rulers

Grid

Bezier Handle

Motion Path

Keyframes
64       EIAS Animator   



Chapter 2  World View Windows — Grid, Rulers and Paths
Visible Grid

The Visible Grid can be used to align objects to one another. The Hide 

Grid/Show Grid command under the Windows menu is used to control 

the display of the grid.

The Grid & Scale tab of the Preferences dialog box has controls that you can 

use to alter the scale of the Visible Grid. 

Snapping Grid

In addition to the visual grid, there is also an invisible snapping grid to 

which object will “snap” when placed. Grid snap can be toggled on and off 

using either the Snapping Grid tool on the Tool Palette or by turning on 

the Caps Lock Key.

The Grid & Scale tab of the Preferences dialog box has controls that you can 

use to alter the scale of the Snapping Grid.

Rulers

Rulers are not displayed by default by can be toggled on and off using the 

shortcut key Ctrl-M (Cmd-M on the Macintosh). Alternately, you can use 

the Hide Rulers/Show Rulers command under the Windows menu.

The Grid & Scale tab of the Preferences dialog box has controls that you can 

use to alter the scale and display of the rulers.

Paths

Motion paths are drawn in the View windows to indicate the path of ani-

mated objects. Keyframe markers are drawn along the paths that corre-

spond to the keyframes shown in the Project window. If the path type is 
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Bezier, control handles are shown on the path if the keyframe sits at the 

current time set by the time thumb in the Project window.

You can hide paths by using the Hide Path/Show Path command under the 

Windows menu.

2.3 Camera View Window

The Camera View window has several controls that are unique. These 

include Rotoscope display, Field Chart, Snapshot rendering, and view 

movement controls.

Figure 2.2 — Camera View Window
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Snapshot

Click and hold on this button to bring up a menu with options for quick, 

snapshot, renderings. A snapshot is a single frame rendering to Camera. 

Upon completion of the rendering, the rendered image will be displayed.

The menu options are:

Window Size. Renders the Camera View window at the size of the win-

dow in Animator.

Full Size. Renders the Camera View window at the resolution set in the 

Render Control window.

Cropped Size. Renders the Camera View window at the resolution set by 

the cropping options in the Render Control window.

Selected Window Size. Prompts you to drag a marquee in the Camera 

View window. Camera renders the region you select at the size of the win-

dow.

Selected Full Size. Prompts you to drag a marquee in the Camera View 

window. Camera renders the region you select at the resolution set in the 

Render Control window.

Selected Cropped Size. Prompts you to drag a marquee in the Camera 

View window. Camera renders the region you select at the resolution set by 

the cropping options in the Render Control window.
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Field chart

Clicking this button turns off and on the field chart display. Right-clicking 

the button (Ctrl-Key clicking on Macintosh) displays the field chart options 

pulldown menu.

Grid. This check box turns on the field grid which appears in the Camera 

View window.

Title Safe. This check box turns on a frame within which is considered to 

be the safe area to display titles (with no risk of cropping).

Action Safe. This check box turns on a frame within which is considered to 
be the safe are to display action (with no risk of cropping). 

Cross Line. This check box turns on a pair of crossed lines in the center of 

the Camera View window.

Hatch Line. This check box turns on a pair of diagonal crossed lines in the 

center of the Camera View window.

Rotoscope

Brings up a pulldown menu that lets you select which foreground or back-

ground images are displayed in the Camera View window. Rotoscope 

images are added to the Camera itself using the Camera Info window. Once 

you choose to display an rotoscope in the Camera View window, a scroll 

bar appears which allows you to choose any frame for displays. 

View Manipulate

Unlike the three orthogonal view windows which have only pan and zoom 

as controls, the Camera View window has a variety of view manipulation 
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tools. Click on the View Manipulate button to bring up a menu of manipu-

lation modes.

None. This is the default mode. You can pick and drag objects in this mode. 

Orbit. In this mode, dragging the mouse in the Camera View window will 

orbit the camera around its reference vector.

Pan. In this mode, dragging the mouse in the Camera View window will 

move the Camera’s reference vector leaving the camera body in place.

Dolly. In this mode, dragging the mouse in the Camera View window will 

move the camera body in and out along its reference vector.

Track. In this mode, dragging the mouse in the Camera View window pans 

the view plane, moving the Camera and its reference vector up/down, 

left/right.

Zoom. Dragging the mouse in the Camera View window will interactively 

alter the Field-Of-View setting in the Camera Info window. 

Note Don’t confuse Zoom with Dolly. Zoom changes the camera’s FOV. This is rarely 

done in computer graphics unless you are implementing a depth of field blur or 

other specialized effect. 

2.4 Selecting the Camera View Object

The Camera View window can be set to “look through” any camera or light 

in the scene. The selected camera will be the one that is rendered. If the 

Camera View is set to look through a light, you will not be able to render. A 

dialog box will pop-up telling you that rendering cannot take place. 
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To change the Camera View object, Click on the Camera Select icon at the 

bottom of the Camera View window. A pop-up menu will appear listing all 

valid objects you can look through.

Selecting a spotlight cone is a great way to aim the spotlight exactly where 

you want it. You can see exactly where the inner and outer cones of the 

light will strike the groups in your scene.

Figure 2.2 — Looking Through a Spotlight
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Main Menu Bar

This section will give a brief overview of each of the menus in the main 

menu bar, and their options.

3.0 File Menu

The file menu is used to open, save and create new projects, merge project 

files together, view images and animation files, collect files together that are 

used by the current project (so that they can be transferred to another 

machine or animator), view project statisticsand quit the EIAS Animator 

application. The menu items are:

• New
• Open
• Merge
• Close Project
• View Image
• Save
• Save Project As
• Save Copy of Project As
• Collect Files
• Project Statistics
• Quit

New. Creates a new project. 

(Cmd + N Mac, Ctrl + N PC)

Open. Opens an existing project. 

(Cmd + O Mac, Ctrl + O PC)
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Merge. Project... Merges another project into the current project.

Close Project. Closes the current project.

View Image. Displays image or animation in a separate window. 

(Cmd + B Mac, Ctrl + B PC)

Save. Saves the current project under the same name. 

(Cmd + S Mac, Ctrl + S PC)

Save Project As... Saves the current project under a different name and 

switches the working project to the one that was just saved.

(Cmd + Shift + S Mac, Ctrl + Shift +S PC)

Save Copy of Project As... Saves a copy of the current project under a dif-

ferent name. The current project is retained.

Collect Files... Collects all of the referenced files together in one location, 

and saves the project file to that location as well. Options include the ability 

to create separate folders for project elements. The project file is remapped 

so that it can be easily opened once a directory location is established.

Project Statistics. Brings forward a dialog box which provides all of the 

statistics for the project file.

Quit. Quits the EIAS Animator. 

(Cmd + Q Mac, Ctrl + Q PC)
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3.1 Edit Menu

The edit menu is used for undos, cutting, copying and pasting, clearing 

selections from the project, duplicating items, accessing EIAS Animator 

preferences and setting the display attributes of controllers, manipulators 

and so forth. The menu items are:

• Undo
• Cut
• Copy
• Paste
• Clear
• Duplicate
• Preferences
• Display
• Default Preferences

Undo. Undoes the previous action. Only one level of undo is supported. If 

Undo is not supported for that action, Undo will be greyed out. 

(Cmd + Z Mac, Ctrl + Z PC)

Cut. Removes the selection and places it in the clipboard. It can then be 

pasted if desired into a target location. 

(Cmd + X Mac, Ctrl + X PC)

Copy. Copies the selected item for pasting purposes. 

(Cmd + C Mac, Ctrl + C PC)

Paste. Pastes the item in the clipboard to the selected destination. 

(Cmd + V Mac, Ctrl + V PC)
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Clear. Clears the selection from the project.

Duplicate. Duplicates the selected items. To have copies of objects or 

groups in the project window, this command is used. 

(Cmd + D Mac, Ctrl + D PC)

Preferences... Brings forward the preferences dialog.

(Cmd + Y Mac, Ctrl + Y PC)

Display. Brings forward separate dialog boxes for each menu item. Con-

trols the various display preferences for these items (Controllers, Lights, 

Cameras, Effectors, and IK Handles).

Default Preferences. Resets all preferences to their factory settings

3.2 Tool Menu

The tool menu contains control for the translate, rotate, and scale tool used 

to manipulate objects in the View windows.

• Translate
• Translate Local X Only
• Translate Local Y Only
• Translate Local Z Only
• Rotate
• Rotate Local X Only
• Rotate Local Y Only
• Rotate Local Z Only
• Scale
• Match Move
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• Grid Snap

Translate. Puts tool in translate mode. Objects can be freely moved in the 

View windows.

Translate X/Y/Z Only. Puts tool in translate mode. Objects can be moved in 

the View windows only along the specified direction.

Translate. Puts tool in rotate mode. Objects can be freely rotated in the 

View windows using the arcball controller.

Translate X/Y/Z Only. Puts tool in rotate mode. Objects can be rotated in 

the View windows only along the specified axis.

Scale. Puts tool in scale mode. Objects can be freely scaled in the View win-

dows.

Match Move. Causes a single frame to be matched. The Camera must be 

selected before this command is issued.

Grid Snap. Causes objects to be constrained to the grid when translated. 

Note The Caps Lock key is an overriding shortcut for this feature. Regardless of other 

settings in Animator, you will be in Grid Snap mode if your Caps Lock key is 

down.
EIAS Animator        75



Chapter 3  Main Menu Bar — Object Menu
3.3 Object Menu

The object menu is used for any function that deals with objects as disk files 

(such as importing and exporting objects to and from the project), adding 

system objects (such as cameras, lights and nulls), adding 3D text, import-

ing and recording sound files, locking and unlocking objects, hiding and 

showing objects, and accessing the object info window for the selected 

object or group. The menu items are:

• Import Object
• Export Object
• Export Parked FACT Object
• Add Camera
• Add Light
• Add Illuminator
• Add Null
• Add Smoke
• Add 3D Text
• Import Sound
• Record Sound
• Lock Selected
• Unlock Selected
• Hide Selected
• Show Selected
• Group Info

Import Object... Imports a model file into the scene. FACT format is 

default, but EIAS does import a variety of other formats.

(Cmd + Shift + I Mac, Ctrl + Shift + I PC)

Export Object. Exports an object to a desired format. FACT format is 

default, but EIAS does export a multitude of other formats.
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Export Parked FACT Object. This export option will zero out rotation, 

position and scale data for a FACT file, and then saves it to disk.

Add Camera. Adds a camera into the scene.

(Cmd + Shift + C Mac, Ctrl + Shift + C PC)

Add Light. Adds a light to the scene.

(Cmd + Shift + L Mac, Ctrl + Shift + L PC)

Add Illuminator. Adds an illuminator to the scene.

Add Null. Adds a null object to the scene. Nulls are drawn as three stroked 

objects like the IK handle goals.

(Cmd + Shift + N Mac, Ctrl + Shift + N PC)

Add Smoke. Places a smoke object in the scene

Add 3D Text. Creates a 3D font from a PostScript or TrueType font file.

Import Sound... Imports a sound file into the project.

Record Sound... Records a sound into the project.

Lock Selected. Locks object from the selection. It also sets the object lock 

flag to on in the project window.

(Cmd + Shift + F Mac, Ctrl + Shift + F PC)

Unlock Selected. Makes object selectable, sets object lock flag to off in the 

project window.

Hide Selected. Makes object invisible. This also makes it unselectable in 

the world views.
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(Cmd + Shift + G Mac, Ctrl + Shift + G PC)

Show Selected. Makes object visible in the world views, selection depends 

upon the lock flag.

Group Info. Brings the info window up for the group selected 

(Cmd + I Mac, Ctrl + I PC)

3.4 Plugin Menu

This menu lists all the plugins that are installed for EIAS. Many 3rd Party 

developers have created Plugins and shaders to extend the capabilities of 

EIAS. Some plugins such as “Light Flare” are special interface plugins, 

which are accessible in other areas of the program. As a result, they are not 

listed in the plug-ins menu. 

Note All EIAS Animator plugins listed are cross-platform, and will operate consis-

tently. You can use these plugins, and the aforementioned lens flare plugins (Lens 

Flare and Light Flare) when rendering across the network on various machine 

types (Macs and PCs). Be sure not to rename these plugins.

The following menu items are contained in the plugin menu, though the 

contents of the menu will change depending upon the 3rd party plugins 

you may have installed:

• Dicer.plm
• Flag.plm
• Mesh.plm
• Mr. Blobby.plm
• Mr. Nitro.plm
• Power Particles Basic.plm
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• Pixel Grains.plm
• UberShape.plm

Dicer. Adds the Dicer polygon decimator plugin to the project.

Flag. Adds the flag generator plugin to the project.

Mesh. Adds the mesh generator plugin to the project.

Mr. Blobby. Adds the Mr. Blobby metaballs plugin to the project.

Mr. Nitro. Adds the Mr. Nitro polygon-based explosion plugin to the 

project.

Power Particles Basic. Adds the Power Particles particle generator plugin 

to the project.

Pixel Grains. Adds the Pixel Grains plugin to the project.

UberShape. Adds the UberShape shape generator plugin to the project.

3.5 Material Menu

The material menu is used to add master materials and master lights to a 

project, to assign and remove master materials and master lights, and to 

access the material editor. The menu items are:

• Add Master Material
• Add Master Light
• Assign Master Material
• Remove from Master Material
• Assign Master Light
• Remove from Master Light
• Reload Material from File
• Material Editor
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• Material Palette
• Shader Palette
• Shader Variance Editor

Add Master Material. Adds a Master Material to the project window list. 

Note this only adds the material to the project, it does not assign the mate-

rial to any objects; use Material>Assign Master Material to do that.

Add Master Light. Adds a light to the scene. The light can be used as a 

standard light, or as a master light. This option will not assign subscriber 

lights; use Material>Assign Master Light to do that.

Assign Master Material. Assigns a master material to a selected object, 

group or series of objects or groups.

Remove from Master Material. Removes the selected object or group from 

the master material subscription list.

Assign Master Light. Assigns a master light to a selected light or series of 

lights.

Remove from Master Light. Removes the selected light or series of lights 

from the master light subscription list.

Reload Material from File. Reloads the original material settings from the 

object file on disk. If you want to restore the original settings after you have 

experimented and start over, use this menu option.

Material Editor. Activates the material editor for the selected group or 

master material.

(Cmd + E Mac, Ctrl + E PC)

Material Palette. Opens the Material palette. This palette displays all the 

materials stored in the EI Material folder.
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(Cmd + Shift + E Mac, Ctrl + Shift + E PC)

Shader Palette. Opens the Shader palette. This palette displays all the 

shaders stored in the EI Shader folder.

(Cmd + [ Mac, Ctrl + [ PC)

Shader Variance Editor. Opens the Shader Variance editor. This editor 

allows you to create custom settings for your shaders.

(Cmd + ] Mac, Ctrl + ] PC)

3.6 Hierarchy Menu

The hierarchy menu is used to add and remove objects and groups from a 

hierarchy, freeze transformations to an object, and call up the joint and axis 

editor. The menu items are:

• Parent
• Remove Parent
• Park
• Show/Hide Children
• Joint Editor
• Axis Editor

Parent. This option prompts you to choose a parent for the object or group 

that you have selected.

(Cmd + P Mac, Ctrl + P PC)

Remove Parent. This option removes the selected object from the hierar-

chy, and place it at the root level. Note that if you select children as well as 

parents, all objects will be placed at the root level, regardless of their previ-

ous standing in the hierarchy. If you wish to keep a portion of the hierarchy 
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intact, then select only the parent object at the level you wish to maintain, 

and then choose Remove Parent.

(Cmd + Shift + P Mac, Ctrl + Shift + P PC)

Park. This option will freeze all transformations applied to an object at the 

current values, and then reset those values to zero (the position, rotation 

and scale operations you applied previously will be maintained, but their 

values will bet set to zero). This is referred to as “baking” in other pro-

grams.

Show/Hide Children. This option hides or reveals the children of the 

selected parents as shown in the Project window. Handy way to reduce 

clutter in Project window. Parents with hidden children are shown with a 

small red arrow next to their names.

(Cmd + Shift + H Mac, Ctrl + Shift + H PC)

Joint Editor. Brings up the Joint Editor window for the selected object.

(Cmd + Shift + J Mac, Ctrl + Shift + J PC)

Axis Editor. Brings up the Modify Axis window for the selected object.

(Cmd + Shift + A Mac, Ctrl + Shift + A PC)
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3.7 Character Menu

The Character menu is used to create skeleton hierarchies, bones deforma-

tions and to add IK handles to either bone or skeleton hierarchies. The 

menu items are:

• Create Bones
• Split Bone
• Add IK Handle
• Go To Rest Position
• Bind Skin to Skeleton
• Bind Skin to Selected Bones
• Detach Skin
• Skin Editor

Create Bones. This option will enable the creation of hierarchical bones in 

any 3D view window. 

(Cmd + Shift + B Mac, Ctrl + Shift + B PC)

To terminate the operation, press the Cancel button in the floating alert dia-

log, or the keyboard shortcut.

Cmd “.” (Mac), Esc (PC)

Split Bone. Divides the selected bone into two separate bones, maintaining 

the hierarchy.

Add IK Handle. This option will add an IK handle to a skeleton or bones 

chain. If you select the end effector of the chain only, an IK handle will be 

automatically applied from the root on down. If you select to joints, and 
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then choose Add IK Handle, the IK handle will be applied only to those 

joints; the rest of the chain will be unaffected.

(Cmd + Shift + O Mac, Ctrl + Shift + O PC)

Go To Rest Position. Select an IK Handle in your project, then choose this 

menu item. The rotation of the bones being controlled by the IK Handle 

will be reset to their rest orientations.

Bind Skin to Skeleton. Binds the entire bone hierarchy of the selected 

bone to the skin. The operation will ask you to select the skins (geometry 

groups) to be bound. To terminate the operation, press the Cancel button in 

the floating alert dialog, or the keyboard shortcut.

Cmd “.” (Mac) | Esc (PC)

Bind Skin to Selected Bones. binds the selected bones to the skin. The 

operation will ask you to select the skins (geometry groups) to be bound. 

To terminate the operation, press the Cancel button in the floating alert dia-

log, or the keyboard shortcut.

Detach Skin. Removes the relationship between the selected skin and the 

bones that control it. 

Skin Editor. Opens the Skin Editor window. 

(Cmd + Shift + V Mac, Ctrl + Shift + V PC)
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3.8 Animation Menu

The Animation menu is used to control all of the animation options that 

any object can have. You use the menu to: enable animation channels; 

import and export animation channel envelopes; import and export motion 

capture files; add, delete and clear key frames; manage motion paths of 

objects; recalculate custom frames; fit frames and objects to curves; and 

access the offset editor, function curve editor, morph editor and deforma-

tion editor. The menu items are:

• Enable Animation
• Import Envelope
• Import Motion
• Export Envelope
• Export Motion
• Add Keyframe
• Delete Keyframe
• Clear All Key frames
• Make Path Explicit
• Make Path Implicit
• Set Path to (Linear, Natural Cubic, Hermite and F-Curve)
• Show Path
• Hide Path
• Recalculate Selected Frames
• Recalculate All Object Frames
• Fit Selected Frames to Curve
• Fit Selected Objects to Curve
• Offset Editor
• Time Marker Editor
• Function Curve Editor
• Morph Editor
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• Deformation Editor

Enable Animation. Enables the animation channel for the selected object, 

group or series of objects or groups. The animation channel must be 

enabled in order to animate the group.

Import Envelope. Imports a motion envelope into the motion channel that 

is selected in the function curve editor.

Import Motion. Imports a motion capture file into the project. A skeleton 

will be automatically created, with the motion mapped to it from the 

motion capture file. 

Export Envelope. Exports a disk file that contains the animation data for a 

specific channel selected in the function curve editor.

Export Motion. Exports a Biovision-format motion file, in either flat or 

hierarchical form. Also exports an ElectricImage format motion file, which 

can be imported into another EIAS Animator project.

You can also select a Camera and export its motion in the Maya “.ma” file 

format. This file can then be imported into Maya or Adobe After Effects.

Add Keyframe. Adds a keyframe to all channels of the selected object at 

the current scene time. This command will create key frames for all chan-

nels, which is not efficient or necessarily desirable. Automatic keyframe 

generation will likely be preferable to you.

(Cmd + K Mac, Ctrl + K PC)

Delete Keyframe. Deletes the current keyframe from the selected object. If 

more than one keyframe is present for the object at the current time, all will 

be deleted.
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(Cmd + Shift + K Mac, Ctrl + Shift + K PC)

Clear All Key frames. Clears all key frames for the selected object. The cur-

rent position and orientation will be set as the beginning state of the object.

Make Path Explicit. Sets the motion path of the selected object to explicit 

(applies only to translation channels). The motion path curve will not be 

editable in the interface beyond setting a new position for the keyframe. 

Three curves, for X, Y and Z, will be placed in the function curve editor on 

demand, for editing purposes. While this choice limits the path shape edit-

ing in the 3D views, it adds much more control within the function curve 

editor. Most professional animators prefer to animate in the function curve 

editor because of this.

Make Path Implicit. Sets the motion path of the selected object to implicit 

(applies only to translation channels.) The motion path will be fully edit-

able in the 3D views, in any of four formats (linear, natural cubic, hermite 

and bezier). The motion channel data will not be editable as three separate 

curves in the function curve editor. Instead, only the velocity channel can 

be edited in the editor when the motion path is set to implicit.

Set Path to (Linear, Natural Cubic, Hermite and F-Curve). Sets the motion 

path type to any of the four choices listed. This applies only to motion 

paths that are implicit.

Show Path. Causes the animation paths of the selected objects to be shown 

in the View windows.

Hide Path. Causes the animation paths of the selected objects to be hidden 

in the View windows.

Recalculate Selected Frames. Recalculates frames that are selected in any 

of the spreadsheet-based project window views (keyframe, frame, index). 
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This feature is available only when the data in the frames deviates from the 

selected motion path curve type (custom frame data, indicated in under-

lined text.)

Recalculate All Object Frames. Recalculates frames for any selected object 

in the project. This feature is available only when the data in the frames 

deviates from the selected motion path curve type (custom frame data, 

indicated in underlined text.)

Fit Selected Frames to Curve. This feature will fit imported motion cap-

ture data frames that are selected in the project window to a curve (motion 

capture data is frame based, and custom frames are created when motion 

capture data is imported.) This feature effectively lets you convert the 

motion capture frame data to curve data.

Fit Selected Objects to Curve. This feature will fit imported motion cap-

ture data frames for a selected object to a curve (motion capture data is 

frame based, and custom frames are created when motion capture data is 

imported.) This feature effectively lets you convert the motion capture 

frame data to curve data

Offset Editor. The Offset Key frames editor is activated by this menu item. 

The Offset Key frames editor enables you to offset or scale the time values 

of selected key frames, or the values of selected key frames.

Time Marker Editor. The Time Marker editor lets you copy ranges of key-

frames that lie between selected Time Markers.

(Cmd + Shift + T Mac, Ctrl + Shift + T PC)

Function Curve Editor. The Function Curve Editor is activated by this 

menu item. The function curve editor allows you to edit animation channel 

data in curve form, relative to other curves displayed in the graph. Profes-
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sional animators prefer to animate with this tool over others, as this tool 

offers the most control of the animation data overall.

(Cmd + ‘ Mac, Ctrl + ‘ PC

Morph Editor. The morph editor is activated by this menu item. The 

morph editor allows you to create animation by blending together different 

model files of similar complexity. This technique is used most often for 

facial animation, although it can be used for any animation where the 

shapes of one object can be effectively blended with another (they have the 

same polygon and vertex count.)

(Cmd + Shift + W Mac, Ctrl + Shift + W PC

Deformation Editor. The deformation editor is activated for the selected 

object by this menu item. Deformations are used to physically warp and 

distort object geometry, and operate on the group level.

(Cmd + Shift + X Mac, Ctrl + Shift + X PC

3.9 Constraint Menu

The constraint menu is used to set up dependency relationships between 

objects. In all cases, first an object to be constrained (“constraint object) is 

selected, then the menu item is chosen, then the target(s) are chosen. The 

operation is terminated by pressing the Cancel button in the floating alert 

dialog, or the keyboard shortcut.

Cmd “.” (Mac) | Esc (PC)

 The menu items are:
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• Auto Look
• Auto Bank
• Aim
• Position
• Rotate
• Scale
• Normal
• Geometry
• Pole Vector
• Constraint Editor

Auto Look. causes the constraint object to point toward the target(s) and 

can blend in rotation/reference data from the constraint object itself.

Auto Bank. Allows an object’s orientation to be animated while the object 

is moving along a curved path.

Aim. Aim is a multi-purpose aiming constraint that allows you to specify 

which direction to aim at and to set an up-direction to keep the object 

upright.

Position. Moves the constraint object to the target point.

Rotate. Rotates the constraint object in global space as the result of the 

weighted average of the global rotations of its target(s).

Scale. Scales the constraint object based on the weighted average of the 

scales of the targets.

Normal. Keeps the constraint object oriented normal (perpendicular) to the 

target.

Geometry. Keeps the constraint object at the position of the target point 

and normal (perpendicular) to the target point.
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Pole Vector. Rotates the Pole Vector toward the target point.

Constraint Editor. Brings up the Constraint Editor window for the selected 

Constraint Object.

3.10 Render Menu

The render menu is used to control render settings, edit any cropping that 

has been applied, and to send off rendering jobs. The menu items are:

• Render Settings
• Radiosity Settings
• ShockWave Settings
• Render Flags Off
• Render Flags On
• Edit Cropping
• Render Project
• Render Window
• Render Frame
• Render Window Selection
• Render Frame Selection
• Preview Settings
• Preview Window...
• Preview Blur Settings
• Preview Blur Window...

Render Settings. This option activates the render information window.

(Cmd + R Mac, Ctrl + R PC

Radiosity Settings. This option opens the Radiosity Settings dialog.
EIAS Animator        91



Chapter 3  Main Menu Bar — Render Menu
(Cmd + Shift + R Mac, Ctrl + Shift + R PC

ShockWave Settings. This option opens the ShockWave Settings dialog.

Render Flags Off. This option sets all of the render flags in the Render tab 

of the render information window to off. Use this item if you intend to acti-

vate just a few flags, instead of turning off the undesired flags manually.

Render Flags On. This option sets all of the render flags in the Render tab 

of the render information window to on. Use this item to quickly activate 

all of the render flags.

Edit Cropping. This option will allow you to interactively edit the crop-

ping rectangle in the camera view window. You must first activate cropped 

rendering by enabling the Enable Cropped check box in the Resolution tab 

of the render information window. 

Render Project. This option will render the project, using the current set-

tings in the render information window. An image or animation save dia-

log will appear, prompting you to name the file. A save project dialog will 

follow. EIAS Animator will then launch the rendering job, and shut down 

to allow more system resources to be allocated to the rendering.

Render Window. This option will render a “snapshot” image the size of the 

camera view window. Only the current frame will be rendered, regardless 

of the settings in the render control window. After rendering, the image 

will be automatically displayed in an image view window.

Render Frame. This option will render a full sized image of the scene. Only 

the current frame will be rendered, regardless of the settings in the render 

control window. After rendering, the image will be automatically displayed 

in an image view window.
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Render Window Selection. This option will render the contents of a mar-

quee selection that you are prompted to make, in “snapshot” resolution. 

Only the current frame will be rendered, regardless of the settings in the 

render control window. After rendering, the image will be automatically 

displayed in an image view window.

Render Frame Selection. This option will render the contents of a marquee 

selection that you are prompted to make, in full frame resolution. Only the 

current frame will be rendered, regardless of the settings in the render con-

trol window. After rendering, the image will be automatically displayed in 

an image view window.

Preview Settings... This opens a dialog box that controls the behavior of 

the View window animation preview options.

Preview Window. Causes animation previewing to begin in the front most 

View window.

Preview Blur Settings... This opens the dialog box that controls the blur 

preview options.

Preview Blur Window. Causes a blur preview to be calculated in the front 

most View window.

3.11 Select Menu

The select menu is used to make selections in a scene, set filters which 

allow you to select certain types of objects only, and select objects by 

attribute, type, model file, hierarchy, label or selection set. The menu items 

are:

• Groups Only
• Cameras Only
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• Lights Only
• IK Handles Only
• All
• None
• Inverse
• Find
• Find Again
• Find All
• By Attribute
• By Type
• By Model
• By Hierarchy
• By Label
• By Set

Groups Only. This option sets the selection filter to allow the selection of 

groups only. No other items can be selected. If you have difficulty selection 

other objects, make sure you check the selection filter settings.

Cameras Only. This option sets the selection filter to allow the selection of 

camera scene objects only. No other items can be selected. If you have diffi-

culty selection other objects, make sure you check the selection filter set-

tings.

Lights Only. This option sets the selection filter to allow the selection of 

light scene objects only. No other items can be selected. If you have diffi-

culty selection other objects, make sure you check the selection filter set-

tings.

IK Handles Only. This option sets the selection filter to allow the selection 

of IK Handles only. No other items can be selected. If you have difficulty 

selection other objects, make sure you check the selection filter settings.
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All. This option will select all objects in the scene that are not filtered from 

selection.

None. This option will deselect any selected objects.

Inverse. This option will invert the selection, releasing the selected objects 

and selecting those that were previously unselected.

Find. This option will search the project for any object by name, and fitting 

the criteria that you specify.

Find Again. This option will continue to find the next object that meets the 

criteria specified by the find command.

Find All. This option will find all objects in the project that meet the criteria 

that you specify.

By Attribute. This option will select all objects that are not filtered, and that 

fulfill the selected attribute: Visible, locked or hidden. 

By Type. This option will select all objects that are not filtered, and that are 

of the type you specify: Camera, light, group, effector, sound, world, mate-

rial model file, IK handle, smoke object.

By Model. This option will select all groups contained within the specified 

model file, regardless of the filter settings.

By Hierarchy. This option is used to select a hierarchy, or portions of a hier-

archy, based upon the following criteria that you specify: root of selected, 

parent of selected, children of selected.

By Label. This option is used to select any object with a specific label 

attached to it. Labels are assigned to objects in the project window. You can 

also use Select>By Label>Edit... to change the label names.
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By Set. This option is used to select any previously created selection set. 

Whatever is contained within the selection set will be selectable by this 

item. You can also use Select>By Set> Edit... to create new selection sets, 

and manage existing selection sets.

3.12 Window Menu

The window menu is used to open the tool palette, time palette and loca-

tion palette; manage the 3D view windows; access the project window; 

close and reset windows; show and hide rulers, scene grid and motion 

paths. The menu items are:

• Tool Palette
• Location Palette
• Time Palette
• Top View
• Side View
• Front View
• Camera View
• Project Window
• Close Window
• Reset Windows
• Show/Hide Rulers
• Show/Hide Grid
• Show/Hide Path

Tool Palette. This option activates the tool palette. The tool palette contains 

tools for: translating, rotating and scaling objects; panning the 3D views; 

showing and hiding the grid; activating and deactivating the snapping 

grid; editing the cropping rectangle; activating deformations, morph editor, 
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joint editor or axis editor for the selected object; showing or hiding the 

motion path for the selected object; parenting and unparenting the selected 

object; assigning constraints, master materials and master lights; and park-

ing the selected object (freezing its transforms.) The tool palette is a floating 

palette, and can be oriented horizontally or vertically.

(Cmd + T Mac, Ctrl + T PC)

Location Palette. This option activates the location palette. The location 

palette displays the location of the mouse position in world space, specific 

to each of the Orthogonal View windows.

(Cmd + Shift + Y Mac, Ctrl + Shift + Y PC)

Time Palette. This option activates the time palette. The time palette is a 

simple timeline, which you can use to set the new scene time. Key frames 

are not displayed in the time palette.

(Cmd + - Mac, Ctrl + - PC)

Top View. This option toggles the display of the top view window.

(Cmd + 1 Mac, Ctrl + 1 PC)

Side View. This option toggles the display of the side view window.

(Cmd + 2 Mac, Ctrl + 2 PC)

Front View. This option toggles the display of the front view window.

(Cmd + 3 Mac, Ctrl + 3 PC)

Camera View. This option toggles the display of the camera view window.

(Cmd + 4 Mac, Ctrl + 4 PC)
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Project Window. This option toggles the display of the project window.

(Cmd + L Mac, Ctrl + L PC)

Close Window. This option will close the currently selected window.

(Cmd + W Mac, Ctrl + WPC)

Reset Windows. This option will reset all windows, placing them in their 

factory determined locations and sizes.

Show/Hide Rulers. This option will toggle the display of the ruler bars.

(Cmd + M Mac, Ctrl + M PC)

Show/Hide Grid. This option will toggle the display of the scene grid.

(Cmd + Shift + M Mac, Ctrl + Shift + M PC)

Show/Hide Path. This option will toggle the display of all object motion 

paths.
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Assigning and Using Cameras

4.0 Introduction

There are two basic points of view in EIAS Animator, world views and 

camera views. The world views present the project environment from a 

“creator’s” perspective. You see everything in the project through these 

views. They assist you in the creative process, allowing you a variety of 

perspectives in which to view and work within your project. Camera views 

are used to actually record the results of your animation. It is the camera 

through which your audience sees your work.

4.1 Camera Anatomy

Cameras in EIAS Animator follow the “source/target” metaphor. Cameras 

do not have a “yaw, pitch and roll” but instead use the target control as a 

pointing mechanism.

Figure 4.1 — Camera control with field of view (FOV) active

Camera Body

View Vector

Reference
Point
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Figure 4.1 shows an illustration of the camera control. It has three separate 

components that you can manipulate:

• Camera Body (source)
• View Vector
• Reference Point (target)

Camera Body. Camera controls are actually drawn as a real motion picture 

camera. Looking at the control as illustrated below, note the film magazine 

on top of the camera, and the matte box to the front where the lens is. The 

actual focal (nodal) point of the camera exists where the view vector inter-

sects with the camera body. All of the position data for the camera body ref-

erences this location.

View Vector. The view vector is the line drawn between the camera and the 

reference point. You can drag the entire camera control by this vector, leav-

ing the orientation of the camera intact (a great time saver!) The distance 

between the camera body and the reference point, as represented by the 

view vector, is pertinent only when depth of field rendering settings are 

used.

Reference Point. Also called the target in other programs, the reference 

point is the actual point of interest for the camera body. You can easily see 

and control the direction in which the camera is pointing by dragging the 

reference point to the desired position.

Adding Cameras to Scenes

You can have as many cameras as you want in EIAS Animator. Each of the 

cameras can have independent settings, although the resolution and image 
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filtering settings are global for all cameras, as covered in the Render Infor-

mation Window chapter. 

There are two ways to add cameras into your projects:

• Choose Object>Add Camera

• Duplicate an existing camera by selecting it and choosing Edit>Dupli-

cate from the menu bar

Translating Cameras

Moving cameras in EIAS Animator is very easy. Cameras can be moved 

either by the camera body, view vector or by the reference point. There are 

actually two ways to move the camera body:

• Move
• Rotate

Both of these methods use manipulators.

To move the camera body:

1. Choose Tool>Translate from the menu bar
2. Select the desired camera

The translate manipulator will appear.

3. Drag the camera to the desired location

The camera reference point will stay fixed on its target as you drag the cam-

era. If you wish to move the camera along a particular axis, click on the 

desired axis of the translate manipulator and drag. The target will move 

with the camera when the camera is moved along a specific axis.
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To move the reference point of the camera:

1. Select the camera
2. Click on the reference point and drag

You can move the reference point at any time, regardless of manipulator selected for 

the camera. The reference point cannot be rotated, it can only be translated, there-

fore, only that motion is passed along to the reference point.

Both the camera body and the reference point have their own motion paths, 

and can be animated independently. This might cause you to “over-ani-

mate” the camera, resulting in “digital whiplash.” The best way to animate 

the camera is either to animate only one of the controls, camera body or ref-

erence point (not always practical) or insure that the motion paths for each 

point roughly match, both in keyframe times, velocity, and path shape. You 

can use the function curve editor to further adjust these factors (see the 

Project Window/Function Curve chapter for more information.) Of course, there 

are far more controls for cameras than just the control icon. Like all objects 

in EIAS Animator, cameras have their own “info windows.” 

Summary of Camera dragging options:

• Dragging on the body changes the position of the camera, but not 
where it is looking.

• Dragging the reference point changes where the camera is looking but 
not its position.

• Dragging the view vector keeps the orientation of the camera the same, 
but changes the camera’s position and where it is looking.

• Dragging on the body while holding down the Control key moves the 
camera long its reference vector.
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• Dragging on the constraint widget moves the body along the constraint 
axis.

• Dragging on the constraint widget while holding down the control key 
moves the body and reference along the constraint axis.

Looking through the Camera

The camera view window shows the view from a camera that you select. 

You can also look through shadow casting lights in this view.

To look through a camera:

1. Depress the control key
2. Click in the title bar of the camera view window

A pop-up menu will appear, listing any available cameras and lights that 

can be used to view the scene.

3. Choose the desired camera to view through

The camera view will now be switched to the camera that you selected. If 

that camera has any images attached to it, such as rotoscope or camera map 

images, they can now appear in the window.

4.2 Camera Information Window Overview

The camera info window contains all of the settings required to manipulate 

a camera in EIAS Animator, as well as view its current attributes. Each cam-

era in a project maintains a separate set of parameters, found in its camera 

info window. There are two ways to access the Camera Info Window:

• Select the Camera and choose Object>Camera Info (command or con-
trol “i”)
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• Double Click on the Camera Icon in either the world views or project 
window

General Camera Settings

In EIAS Animator the camera window is divided into 5 folder tabs. On the 

left side are check boxes used for enabling additional camera options in the 

view windows. The X-form tab displays the position of the camera and it’s 

reference point, as well as its current angle. The FOV tab is used for setting 

the focal length and field of view of the camera, as well as its shutter, and 

depth of field settings. The Roto/Comp tab is used for adding rotoscoping 

and compositing layers. The stereo tab allows for the rendering of stereo-

scopic images. Finally, the Projection Map tab is where camera maps are 

applied, allowing for the projection of custom images onto geometry from 

a camera’s perspective.

Figure 4.2 — Camera Info Window
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Camera Display Options

On the left side of the camera window info are additional display options 

for the camera will be seen in the world view windows. These options are:

• Show Angle
• Show Fog
• Show Stereo
• Show Roto
• Show Map
• Color

Show Angle. This check box toggles the display of the camera’s field of 

view (FOV) angle in the world views. When enabled, it will project a pyra-

mid outward from the center of the camera to the reference point, as illus-

trated in Figure 4.1. The area inside these lines represents the field of view 

of the camera. This is what will be “seen” by the camera and rendered. The 

size of this area is changed by altering either the Focal Length in the FOV 

window, or by changing the aspect ratio in the Render window. Refer to the 

Focal Length section that follows for more information on changing the 

camera’s field of view.

This display mode is very helpful for determining exactly which objects are within 

the field of view as you move the camera through the world view windows. 

Show Fog. This check box displays a projection of the fog radius used by 

the camera. The fog region is an attribute the World object, which is listed 

in the project window. If the fog region has not been activated, this check 

box will have no effect. The fog region is a spherical volume which ema-

nates from the center of any camera in the scene.
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Show Stereo. When the Stereo rendering option is enabled, this check box 

provides a graphic display of the stereo separation parameters. Stereo-

scopic rendering creates two images for each frame in an animation, one for 

the left eye, and one for the right.

Show Roto. This check box will cause any loaded background or fore-

ground images to be drawn in the camera view window. These images are 

added to a camera via the Roto/Comp tab.

Show Map. This check-box will cause any foreground image to be dis-

played in the camera view window.

Color. This sets the color of the camera icon as shown in the View win-

dows.

Virtual

Turning this check box on disables the undo buffer for the camera. This fea-

ture can come in handy when you are trying to adjust the position of 

objects or bones in the scene while preserving the ability to undo the last 

operation. For example, if you are trying to get the exact position of a char-

acters arm, you can set the camera to Virtual and then orbit in the Camera 

View window after making the change to the arm. After moving the cam-

era all around, you can still undo the last change you made to the arm.
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4.3 Camera X-Form Tab

This tab is broken down into four sections:

• Camera Section
• Reference Section
• Roll, Pitch and Yaw Angles Section
• Roll Control

Camera Section. The camera section contains the Key popup menu (for 

controlling motion interpolation) and three position edit boxes. These edit 

boxes list the current position of the camera, in X, Y, and Z coordinates, 

which can be changed by you at any time.

Reference Section. The reference section contains the Key popup menu 

(for controlling reference point interpolation) and three position edit boxes. 

These edit boxes list the current position of the reference point, in X, Y, and 

Z coordinates. You can also expressly set the camera to reference distance 

in the edit box.

Roll, Pitch, and Yaw Angles Section. The camera can also be controlled 

through more traditional roll, pitch and yaw edit boxes, and are expressed 

in degrees. The order of the boxes is actually presented as Yaw (X), Pitch (Y) 

and Roll (Z), and equates directly to X, Y, and Z.

Roll Control. The roll control is interactive, and can be dragged to create 

roll angles. Its presentation is reminiscent of the roll indicator found in air-

craft avionics.
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All of the numeric values presented in the edit boxes are dependent upon 

the editing mode set in the project window, and if the animate flag has been 

set for the camera object or a particular channel for the camera object.

In Index mode, changing the values updates the value for the current key-

frame you are editing. Index mode only allows for the editing of previously 

generated key frames, rather than for creating new ones, so it is only possi-

ble to alter an existing keyframe while in index mode.

In Frame mode, changing the values in the x-form window creates a cus-

tom frame with those new values. Custom frames have an underline mark 

below their values in the project window. Custom frames are not affected 

by the interpolation and velocity of the frames around them. They are fixed 

values which will be implemented without regard to any other key frames. 

If you can picture a smooth curve, custom frames are like spikes jutting out 

from the curve. They have no regard for the curve itself, or its shape (veloc-

ity). They simply pop to their value, and then return back to the curve 

when done. 

Figure 4.3 — Camera X-Form Tab
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In Keyframe and Time modes, changing the values in the x-form window 

either creates a new keyframe (if none exists at the current frame), or 

updates the values of an existing keyframe.

EIAS Animator can display keyframe values in either Implicit, or Explicit 

values. Implicit is the way that EIAS Animator has always displayed vec-

torized quantities. When the camera is set to implicit, dragging the camera 

in a window controls two of its positional measurements. The velocity is 

computed as a composite of these two vectors. For instance, by dragging a 

camera in the top view window, the X & Z coordinates will change, in the 

Front View the Y&X, and the Side View the Y&Z coordinates. Implicit con-

trols always function on all axes simultaneously.

When a camera or object is set to explicit positioning, it is possible to con-

trol the values and velocity for all 3 components of motion (X,Y,Z) indepen-

dently in the function curve editor.
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4.4 FOV Tab

This tab controls the camera focal length, shutter angle, and depth of field 

options. It is divided into three sections:

• Focal Length Section
• Shutter Section
• Depth of Field
• View
• Resolution

Focal Length Section

In photography, an image is exposed onto film or captured on video. Light 

is collected through the camera’s lens, and projected onto the focal plane. In 

film cameras, the focal plane is actually inscribed on the camera body, typi-

cally denoted by a circle with a slash running down the middle.   The dis-

tance between the first lens element in the lens body to the focal plane is 

referred to as focal length. 

Figure 4.4 — Camera FOV Tab
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EIAS Animator provides many controls to manage the lens characteristics 

of a camera. These controls are affected by the aspect ratio settings in the 

Render Information Window. The focal length section consists of the fol-

lowing three items:

• Focal Length Edit Box
• Field of View Edit Box
• Focal Mode Popup Menu

Focal Length Edit box. This edit box allows you to explicitly define the 

camera lens focal length. The number will change depending upon the 

aspect ratio setting in the Render Info Window. The default for that setting 

is “computer,” so the number that you are most likely to see is a floating 

point number, such as “1.0.” Changing the aspect ratio setting will result in 

a conversion of the number in the edit box to a new number. With the 

exception of the custom and computer aspect ratio settings, the number in 

this box will be expressed in millimeters. This allows you to match real 

world lens types to real world photography formats. 

Note that if you do change the aspect ratio, the focal length will be adjusted to the 

new number, but the image in the viewing rectangle will appear relatively 

unchanged. Only the cropping areas will be affected, the image distortion will not.

The smaller the focal length, the wider the field of view. The larger the focal 

length, the narrower the field of view. Lenses with small focal lengths 

(6mm to 12mm) are called wide angle lenses, lenses with large focal lengths 

(75mm to 135mm) are called narrow or telephoto lenses, and those in 

between (16mm to 50mm) are considered normal lenses. Focal length is 

directly proportional to the size any object will appear in the frame. If the 

distance to the object remains constant, and the focal length is doubled, the 

object will appear twice as large in the frame.
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Field of View Edit Box. Field of View (FOV) determines how much of the 

scene when viewed through the camera lens is visible to the lens. This 

value is expressed in degrees. The FOV is directly related to the focal length 

of the lens, the focal mode popup menu (discussed following) and the 

selected aspect ratio. 

Many single lens reflex cameras (SLRs) include a 50mm lens. This lens most 

closely mimics the human eye for this 8 perf 35mm format (8 perf is also called 

“Vista - Vision” format when applied to motion picture cameras.) The field of view 

for this lens is approximately 40˚ in the real world (depending upon differing spec-

ifications by camera and lens manufacturers.) It should be noted that EIAS Anima-

tor presents these values in true mathematical space, while real world cameras and 

lenses are incapable of meeting these tolerances, and will often vary by one or two 

degrees.

Perspective distortion is also driven by both the focal length and Field of 

View. The smaller the FOV, the more distortion will appear, creating a wide 

angle effect. The larger the FOV, the less distortion will appear creating a 

telephoto effect. You can use extremely large focal lengths if you wish to 

negate the effects of perspective altogether. For example, you may wish to 

render a view with no perspective in order to create the basis for a texture 

map the closely conforms to the shape of the group.

Focal Mode Popup Menu

This menu determines how the focal length and field of view calculations 

are performed. There are three choices:

• Horizontal
• Vertical
• Diagonal
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Horizontal Focal Mode. This mode uses the sides of the frame to calculate 

the focal length and field of view. This is the default mode, and is the typi-

cal method for making such calculations in most motion picture camera 

systems.

Vertical Focal Mode. This mode uses the top and bottom of the frame as a 

basis to calculate focal length and field of view. Some computer imaging 

systems use this mode, but it is unlikely that you would need to.

Diagonal Focal Mode. This mode uses the frame diagonal as a basis to cal-

culate the focal length and field of view. Many SLR cameras use this 

method.

Shutter Angle Section. All real world cameras have a shutter system. Film 

cameras have a physical shutter, and video cameras have electronic shut-

ters. A shutter is used to create discreet frames, otherwise all we would see 

would be smearings of color. Discreet frames are necessary for our percep-

tion of imagery in motion, made possible by a phenomenon called “persis-

tence of vision.” It is this phenomenon that enables us to see the discreet 

frames on film (or video fields) as a continuous motion. 

Shutters actually keep parts of the film from exposing, rendering them 

black. A shutter is typically very fast, covering the focal plane for about half 

of the total exposure time. For example, in a 24 frames per second shot, the 

shutter will be closed for about 1/48 of a second, and open for the same 

amount. During the time that the shutter is closed, the world is still mov-

ing. When the next frame is exposed, the subject matter will not necessarily 

be in the same place, and thus, its motion is imparted to the film.
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This section contains two controls:

• Enable Shutter Check Box
• Shutter Angle Edit Box

Enable Shutter Check Box. Use this check box to override the global shut-

ter settings in the Render Info Window. If this box is enabled, the value in 

the Shutter Angle Edit Box for this camera will be used instead of the global 

value.

Shutter Angle Edit Box. Use this edit box to set the angle of the open shut-

ter in degrees. In the real world, the shutter angle would max out at far less 

than 360˚, otherwise the images recorded would not make any sense to us. 

However, EIAS Animator provides a “virtual shutter” that can be far 

greater than 360˚. You can still view an image, because EIAS Animator does 

not actually use a shutter to render the discreet frames, it does so automati-

cally (one of the benefits of a synthetic camera!) As such, the shutter angle 

can be used for some really cool effects, such as ultra high speed motion 

(like a space warp drive.)

Instead, shutter angle is a major component of the motion blur effect. The 

size of the shutter angle will dictate the amount of perceived motion blur 

along the following rules:

• Larger shutter angles produce longer blur streaks
• Shorter shutter angles produce shorter blur streaks

Note that shutter angle has no apparent effect on the Depth of Field function. It is 

included in this section as an animateable control for motion blur only.
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Depth of Field Section

3D programs like EIAS Animator are all designed to mimic real world cam-

eras, up to a certain point. The focal length section is used to approximate 

what a real world camera would see if the scene existed in our world. The 

basic physics are the same, with some added bonuses (such as, everything 

is always in focus.) Sometimes, however, that’s not what you want. EIAS 

Animator is capable of performing depth of field rendering. Depth of field 

mimics a real camera, whereby images are blurred according to the focal 

settings of the camera. Depth of field is defined as the distance from the 

nearest object in sharp focus to the farthest object in sharp focus.   

Depth of field rendering is a multi-frame technique that requires the multi-frame 

button to be set in the Motion Blur tab of the Render window. For best results the 

number of Blur Frames should be set to 5 or higher. Do not use raytracing with 

depth of field, the render times will be prohibitive.

The Depth of Field section contains five items used to control the options 

for this feature:

• Enable Focus Check Box
• F-Stop Edit box
• Focus Distance Edit box
• Distance Popup Menu
• Multi-frame Pixel Offset

Enable Focus Check Box. This check box enables the depth of field feature. 

It must be selected in order for the effect to be created.
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F-Stop Edit Box. Use this edit box to set the f-stop for the camera lens. In 

real world terms, the light gathering power of a lens is called the speed of 

the lens. The more light that is available to a lens, the larger the area it is 

able to keep in focus (the depth of field). This is expressed as an f-number, 

or f-stop. This number is the ratio between the focal length of the lens and 

its diameter (the aperture):

As the lens diameter increases, so does the amount of light that passes 

through. As the focal length increases, the light is dispersed over a greater 

area and the amount of light available decreases. This is often expressed as 

a faster lens allowing more light through, and a slower lens allowing less 

light. Lenses of about f/2 and lower are considered fast. 

Additionally, inside the lens is an iris diaphragm which can open or close 

to change the amount of available light. Thus, the actual term, f-stop, is 

determined by a series of “stops” along the lens aperture:

The standard series of stops is: 1, 1.4, 2, 2.8, 4, 5.6, 8, 11, 16, 22, 32. Each stop 

represents the halving (or doubling) of the amount of light that the lens 

passes. At low f-numbers, the diaphragm is open wider and more light 

enters the lens.

As in actual photography, smaller f-stops result in a shorter depth of field. 

Objects outside of the focus distance will appear soft and out of focus. 

Larger f-stops will result in a longer depth of field. Objects outside of the 

focus distance will be in sharper focus. Unlike real world cameras, the 

f-stop=
focal length

lens diameter

f-stop=
focal length

diameter of lens aperture
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actual amount of light required to illuminate the scene will not change. 

Only the depth of field will be affected, not exposure.

Focus Distance Edit Box. This edit box determines the distance from the 

camera in which the object will be in sharp focus. Objects not in the area of 

the focus distance will appear out of focus, depending upon the f-stop set-

ting. The focus distance can also be set to use the reference point of the 

camera. This is controlled by the distance popup menu, covered below. If 

the reference point method is used, the value in the Focus Distance Edit 

Box is ignored.

Distance Popup Menu. The two options in this popup menu selects the 

method for calculating the depth of field:

• By Channel
• By Reference

By Channel. When setting the focus distance by channel, the focal target is 

determined by the value entered in the Focus Distance edit box. This value 

emanates from the center of the camera, and is expressed in world units. 

For instance, a number of 50 would focus the lens on an object 50 units 

from the focal plane of the camera.

By Reference. When setting the focus distance by reference, the focal target 

is the end point of the reference vector. This provides an easy way to deter-

mine exactly what the focal object is. Just drag the reference vector out or in 

until it is sitting over your target object. This is the default method.

Multi-frame Pixel Offset. This value represents what is known as the cir-

cle of confusion. The point at which the focus distance is set, is said to be 

the area of critical focus. Everything on this plane is in focus. Objects that 

are nearer and farther from this point are said to be in the circle of confu-
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sion. Depending on the f-stop and focal length, many of these objects will 

also be in variable states of focus even though they aren’t located at the 

exact focus distance. 

For example, when the focus distance is set at 15 units, we might find that 

the depth of field where objects remain in focus ranges from 12 units to 20 

units. Thus, the total depth of field here would be 8 units. Since “being in 

focus” is a subjective judgment, in order to determine what is defined as in 

focus, a permissible circle of confusion must be set; the circle of least confu-

sion. In EIAS Animator, this value is the multi-frame pixel offset, and it 

uses this number to determine the acceptable range of sharpness when per-

forming depth of field calculations. 

The following rules apply:

• Smaller offset values produce sharper images
• Larger offset values produce blurrier images

Effectively, the offset is an additional control to determine how blurry the 

objects in the scene will appear.

View Section

In order to facilitate architectural rendering and add the ability to correct 

perspective distortions, view camera controls have been included.

These controls work by moving the lens of the camera parallel to the film 

plane. The result is that you can view objects which fall outside of the nor-

mal lens coverage. Think of this as scrolling the view.

The most common reason for using the View Camera controls is to correct 

perspective. With a standard camera, in order to capture a tall building in 
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one image, you have to use a wide angle lens and tilt the camera upward. 

this results in “keystoning”. The bottom of the building will appear to be a 

lot wider that the top of the building due to perspective distortion.

There are two way to prevent this type of distortion:

Move. Move the camera away from the building until you do not need to 

tilt the camera upwards. This will produce the desired result but only the 

upper half of the frame will contain the building. The horizon line (base of 

the building) will cut right through the center of the frame.

Shift. Leave the camera level but shift the lens upwards. This will produce 

the desired result and use the entire frame. You are effectively scrolling the 

horizon line downward to the bottom of the frame.

There are two controls in the FOV tab of the Camera Info window, “Rise/

Fall” and “Shift”. Rise/Fall moves scrolls the lens up and down. Shift 

scrolls it left and right.

A value of 0 means no Rise/Fall or Shift. A value of 0.5 in the Rise/Fall con-

trol scrolls the horizon to the bottom of the frame. A value of -0.5 scrolls the 

horizon to the top of the frame. Shift works similarly in that it scrolls the 

center of the frame to the right if the value is set to 0.5 and scrolls it to the 

left if the value is set to -0.5.

These controls are not bound by the range -0.5 to 0.5. They may also be ani-

mated.
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Perspective

The normal camera parameters in EIAS yield a 3-point perspective. There 

is foreshortening on all 3 axis.

Figure 4.5 — 3-Point Perspective
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2-point perspective has foreshortening on only two axis.

For 2-point perspective, make sure that the camera is parallel to one side of 

the object(s) by moving and rotating the camera. Using the Rise/Fall OR 

Shift you can then fix the view to show you foreshortening on two axis 

only.

Figure 4.6 — 2-Point Perspective
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For a 1-point perspective, make sure that the camera is perpendicular to 

one side of the object(s). Using the Rise/Fall AND Shift you can then fix the 

view to show you foreshortening on one axis only.

Note Holding down the v-key on your keyboard and dragging in the Camera View win-

dow will interactively scroll the view by altering the Rise/Fall and Shift values.

Resolution Section

The FOV tab of the Camera Info window has its own copy of the resolution 

information found in the Resolution tab of the Render Control window. 

When the Enable Resolution check box is turned on, the resolution set-

tings in the Camera Info window override the settings in the Render Con-

trol window.

The purpose in having the information in both places is to allow a camera 

that projects a map to have a different aspect ratio from the camera that is 

Figure 4.7 — 1-Point Perspective
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rendering the scene. This is valuable when using multiple camera maps of 

different aspect ratios to build up a complex 2-1/2 D environment.

Typically, the camera rendering the scene will use the settings in the Render 

Control window (the Enable Resolution check box will be off for this cam-

era). The cameras projecting textures will have the check box turned on 

with their aspect ratios being set in their respective Camera Info windows.

4.5 Roto/Comp Tab

Rotoscoping (“roto”) is a term used to describe the process of incorporating 

information from previously exposed (or rendered) footage into a shot. 

One might wish to match the camera movements or other objects from live 

action footage, or have a rendered model follow the movements of an actor. 

Compositing (“comp”) is a process of including foreground or background 

images or movies into your rendered scene. Composite layers are added 

above the 3D action you create in EIAS Animator, and background layers 

appear behind your renderings in the final image or movie. In order for 

compositing to work properly, the images or movies that you use will need 

to contain an alpha channel mask. 

Your roto and comp footage can be any resolution, but it is best to match 

the final resolution to which you are rendering. If your background or fore-

ground maps are smaller than your target render resolution, then they will 

be enlarged. This will reduce the quality of the images used for composit-

ing. If the footage is a greater resolution, then the footage will be down 

sampled to fit in the image rectangle. This will not decrease the quality of 
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the imagery used for compositing, but will add somewhat to the render 

time.

The Roto/Comp tab contains controls which allow for background and 

foreground image compositing within a rendering, and display of these 

images in the camera view window. There are several items in this tab:

• Render Rotoscope/Composite Check Box
• Background Map List
• Foreground Map List
• X-Form Tab
• Properties Tab
• Info Tab
• Crop Tab

Render Rotoscope/Composite Check Box. This check box enables the 

images in the background and foreground map lists to be rendered and/or 

composited into the final image. (Maps can also be individually enabled or 

disabled within the map lists.)

Figure 4.8 — Camera Roto/Comp Tab
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Background Map List. This list contains all of the images used as back-

grounds for the active camera. Each camera renders its own map lists sepa-

rately — what appears in the background list for one camera will not be 

present for another, unless you insure that the lists are the same for each 

camera. Each image can be enabled or disabled by clicking the active icon 

next to the name of the map. The background maps will appear in the final 

rendered image only if the active icon next to the image name in the list is 

present, and the Render Rotoscope/Composite check box is enabled. Back-

ground images can be animated and scaled in XY screen space with the X-

form tab next to the map list.

To add a background image to the list:

1. Click the Add button
2. Choose an image or movie from the file list
3. Click the Open button

The background image you selected will now appear in the list.

To delete a background image from the list:

1. Select the image
2. Click the Delete button

The image will be removed from the list.

You can reorder the maps in the list by dragging the map to its desired loca-

tion. You can Edit>Copy (command or control “c”) and paste maps 

between lists by selecting the map and choosing copy, then selecting the 

destination map list, and choosing Edit>Paste (command or control “v”). 
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Maps will be layered by the order in which they appear in the list. If the 

maps do not have alpha channel masks, then the top-most map will be the 

only map that will appear as a background image for this camera. 

Foreground Map List. This list contains all of the images used as fore-

grounds for the active camera. Each camera renders its own map lists sepa-

rately — what appears in the foreground list for one camera will not be 

present for another, unless you insure that the lists are the same for each 

camera. Each image can be enabled or disabled by clicking the active icon 

next to the name of the map. The foreground maps will appear in the final 

rendered image only if the active icon next to the image name in the list is 

present, and the Render Rotoscope/Composite check box is enabled. Fore-

ground images can be animated and scaled in XY screen space with the X-

form tab next to the map list.

To add a foreground image to the list:

1. Click the Add button
2. Choose an image or movie from the file list
3. Click the Open button

The foreground image you selected will now appear in the list.

To delete a foreground image from the list:

1. Select the image
2. Click the Delete button

The image will be removed from the list.

You can reorder the maps in the list by dragging the map to its desired loca-

tion. You can Edit>Copy (command or control “c”) and paste maps 
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between lists by selecting the map and choosing copy, then selecting the 

destination map list, and choosing Edit>Paste (command or control “v”). 

Maps will be layered by the order in which they appear in the list. If the 

maps do not have alpha channel masks, then the top-most map will be the 

only map that will appear as a rendered image for this camera, hiding any 

3D objects that you intended to render. 

Note To view any image in the background of the Camera window, the option to show 

the image must be on (found in the Roto/Comp Properties Tab, Show in Camera 

View check box) and the Paint Image button must be set to the image name desired.

The following illustration indicates the roto/comp controls that are dis-

played in the camera view window. These controls are visible only when 

the option to display an image in the camera view is active.

Paint Image Icon. This icon will draw the foreground/background image 

in the camera view. To use click on the button. A popup menu will appear, 

with the names of the loaded images listed. Choose the image that you 

wish to view. You cannot preview composites in this window. You must 

perform a window size rendering or full size rendering to do so.
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Frame Number. This box displays the current frame number. If the Sync 

with Time option is selected in the Roto/Comp Properties Tab, then this 

number will match the current frame number of the project.

Scroll Bar. The scroll bar allows you to scroll through the movie file to find 

the appropriate frame for use. This bar will have no effect on a single frame 

image.

Roto/Comp X-form Tab

This tab provides position, scale and alignment information used by the 

currently selected map in either list. Each map in each list can be posi-

Paint Image Icon Frame Number Scroll Bar

Figure 4.9 — Camera View Roto/Comp View Tools indicated
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tioned, scaled and aligned independently from the others. These functions 

are presented in 3 areas in the X-form tab:

• Position Edit Boxes
• Scale Edit Boxes
• Alignment Popup Menu

Position Edit Boxes. These boxes control the position of the selected image 

in either of the foreground or background map lists. Maps can be posi-

tioned in X and Y space only (acting as flat layers.) The default value of 0.0 

will place the map in the center of the frame. X and Y values of 1.0 or 

greater for each position attribute will place the map offscreen (Values may 

may vary depending upon the aspect ratio of the map as it relates to the 

rendered image.)

Scale Edit Boxes. These boxes control the scale of the selected image in 

either the foreground or background map lists. The default scale of 1.0 fits 

the map to the extents of the rendered image rectangle. The alignment 

popup, covered below, governs which axis is used as the “fit” axis, that is, 

which axis is used to fit correctly into the frame at a scale of 1.0. Values of 

Figure 4.10 — Roto/Comp Tab Foreground/Background Image X-form Tab
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less than 1.0 in will reduce the size and values greater than 1.0 will increase 

the size of the image.

Align Popup Menu. This menu is used to determine how the map will fit 

into the rectangle of the rendered image. There are three choices:

• Both
• Horizontal only
• Vertical only

Both. This option will fit both axes of the image into the aspect ratio of the 

rendered image rectangle. If the aspect ratio of the image does not match 

the aspect ratio of the rendered image rectangle, the image will appear 

stretched or squeezed.

Horizontal Only. This option will fit just the horizontal axis of the back-

ground or foreground image into the rendered image rectangle. The verti-

cal axis may extend past the rendered image extents or end within view of 

the frame if the aspect ratios of the foreground/background image doesn’t 

match the rendered image rectangle.

Vertical Only. This option will fit just the vertical axis of the background or 

foreground image into the rendered image rectangle. The horizontal axis 

may extend past the rendered image extents or end within view of the 

frame if the aspect ratios of the foreground/background image doesn’t 

match the rendered image rectangle.

Figure 4.11 — Align Pop Up Menu
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Roto/Comp Properties Tab

This tab is used to control the foreground/background image rendering 

and display properties. This tab is comprised of several items:

• Camera View Section
• Image Tiling Section
• Anti-Alias Check Box
• Invert RGB Check box
• Invert Alpha Check Box
• Samples Edit box
• Blur Edit Box
• Opacity Edit Box

Camera View Section

This section contains controls which govern the display of the foreground/

background image in the camera view window. There are three sub items 

listed in this section:

Figure 4.12 — Roto/Comp Properties Tab
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• Show In Camera View Check Box
• Synchronize with Time Check Box
• Display Mode Popup Menu

Show in Camera View Check Box. This control enables the display of the 

image in the camera view window.

Synchronize with Time Check Box. This control insures that the fore-

ground/background images will match the time reference of the project 

scene time.

Display Mode Popup Menu. This popup menu determines which chan-

nels of the image will be displayed in the camera view window. This fea-

ture does not affect the rendering quality of the foreground/background 

images. There are four choices:

• RGB Only
• Alpha Only
• RGB + Alpha
• RGB + Color

RGB Only. Displays only the RGB channel of the foreground/background 

image in the camera view window. If the image has an alpha channel, then 

the display of the image in this mode will appear to have ragged edges (the 

anti-aliasing information is in the alpha channel).

Alpha Only. Displays only the Alpha (mask) channel of the foreground/

background image in the camera view window.

RGB + Alpha. Displays a properly anti-aliased foreground/background 

image in the camera view window. (Uses the alpha channel information to 

mask in the RGB channel.)
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RGB + Color. Displays the RGB channel of the image with the selected 

background color (set in the World Info Window).

Image Tiling Section

This section contains two popup menus which control the way the fore-

ground/background images are tiled when viewed or rendered (one for 

the X axis and one for the Y axis). There are four choices:

• None
• Hold
• Repeat
• Mirror

None. Disables mirroring of the image on the specified map axis. Choosing 

None for both axes will cause the image to be displayed only where you 

positioned it, nowhere else.

Hold. Applies the colors found at the image edges outside of the actual 

image rectangle. (The image will appear once as positioned, with the bor-

der colors of the image extending beyond the image rectangle, covering the 

frame.)

Repeat. Repeats the image along the specified axis. Choosing Repeat for 

both axes will cause the image to repeat continuously.

Mirror. Mirrors the image along the specified axis. Choosing Mirror for 

both axes will cause the image to flip flop about both axes.

Anti-Alias Check Box. This check box enables foreground/background fil-

tering. If you are not scaling your foreground/background images, and if 

they match the aspect ratio of the rendered image rectangle, then this set-

ting can be disabled.
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Invert RGB Check Box. This option will negate the RGB color space of the 

image.

Invert Alpha Check Box. This option will negate the alpha channel of the 

image. This is useful if you decide that you need to mask the area opposite 

of that represented by the alpha channel.

Samples Edit Box. This edit box lets you determine the sampling quality of 

the image. The default is 5.0. Numbers greater than 5 will cause the image 

to be sampled more often, slowing down render time, but increasing the 

quality of the image. Numbers less than 5 will cause the image to be sam-

pled less often, speeding up render time, but decreasing the quality of the 

image. Numbers greater than 10 might be prohibitively slow. 5 is a good 

default, and you will likely not need to deviate from that amount.

Blur Edit Box. This edit box lets you blur the image. The default is 1.0. This 

value will present the image as is. Values of greater than 1.0 will blur the 

image. For example, a value of 2.0 will produce a blur of two pixels for 

every one encountered in the image. Values less than 1.0 will sharpen the 

image, although it will also introduce aliasing (jagginess) into the image.

Opacity Edit Box. This edit box controls the opacity of the foreground/

background image. The default is 1.0, where the image is completely 

opaque. Values of less than 1.0 will make the image more transparent, end-

ing at 0.0 where the image will be invisible. Values of greater than 1.0 are 

ignored.
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4.6 Stereo Tab

The stereo tab is used to set up stereo image rendering in EIAS Animator. 

This technique lets you create true “3D” images, when properly assembled 

and viewed through polarized glasses. (EIAS Animator does not support 

the anaglyph (red/blue) stereo effect, just “right eye/left eye” stereo.) To 

accomplish this, EIAS Animator creates separate image files for each eye. 

You will need a third party program to assemble the images into viewable 

3D imagery or movies.

The stereo tab consists of a few simple controls to accomplish the stereo 

effect:

• Enable Check Box
• Stereo Separation Edit Box
• Stereo Convergence Edit Box
• Convergence Popup Menu
• Render Popup Menu

Figure 4.13 — Stereo Tab
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Enable Check Box. This box enables the stereo effect. You can play with 

settings without actually rendering them by disabling this check box.

Stereo Separation Edit Box. This edit box controls the distance between 

the two cameras. (If you would like to see the distance indicated on the 

camera, enable the “Show Stereo” check box in the Camera Info Window’s 

Camera display control area to the left of the window.) The default value is 

1.0. This may or may not be appropriate for your needs. Essentially this 

control is attempting to duplicate the distance between the human eyes. 

How much scale you want something to have will depend upon the size of 

this value. Unfortunately, the relevance of this number is directly related to 

the scale of the objects in your scene, so we can offer little guidance here.

Stereo Convergence Edit Box. This edit box controls to focus point of the 

stereo effect. Beyond this point, no depth will be perceived. This value is 

used only if the Convergence Popup Menu is set to “By Channel.”

Convergence Popup Menu. This menu controls the type of convergence 

that will be used when the scene is rendered. There are three choices:

• By Channel
• By Reference
• In Infinity

By Channel. Causes the stereo effect to use the value found in the Stereo 

Convergence Edit Box.

By Reference. Causes the stereo effect to use the reference point as the 

point of convergence.

Figure 4.14 — Convergence Popup Menu
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In Infinity. The perception of depth will extend into infinity.

Render Popup Menu

This menu controls what image files are created at render time (if any) for 

the stereo effect. There are four choices:

• Normal
• Left Only
• Right Only
• Left & Right
• Interlace Odd
• Interlace Even

Normal. This option will render the scene normally, producing only one, 

“flat” image file.

Left Only. This option will render an image file for the left eye position 

only.

Right Only. This option will render an image file for the right eye position 

only.

Left & Right. This option will render two image files, one for each eye. In 

this instance, render times will be twice as long, as complete scenes for each 

eye must be rendered.

Figure 4.15 — Stereo Render Popup Menu
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Interlace Odd. Causes a single, interlaced file to be rendered. The left eye 

in the odd field and the right eye in the even field.

Interlace Even. Causes a single, interlaced file to be rendered. The left eye 

in the even field and the right eye in the odd field.

There are video systems that can decode an interlaced video stream and 

send the streams to two separate video projectors. In this way, a 3D video 

presentation can be encoded on an ordinary video tape or DVD. One such 

system can be seen at www.3dimagetek.com another at www.razor3d.com.

4.7 Projection Tab

This tab is used to control map projections from the camera position. A pro-

jection map is a texture than can be projected onto many groups at once 

from the same location in space. Both lights and cameras can project maps. 

Lights project maps exactly like a slide or movie projector. Camera projec-

tion maps work a little differently. These maps are typically projected onto 

objects which are fully self-illuminated (meaning that the objects are 

always at full brightness, as are any maps applied to them.

Here’s a real world analogy to this process — imagine that you have a pho-

tograph of a building. The camera is inside of an alcove, with walls on the 

sides, and an arch to the rear. Now, imagine that you have a model that is 

roughly scaled to the objects in the photograph. In essence, you have walls 

and then an arch at the end of the walls. The model is painted white to 

accept the slide of the photo. Now, setup a slide projector that can project 

the photo onto the model. Position the projector so that it approximates the 

position of the camera that took the original photograph. As you bend 

down and look at the model from the same point as the slide projector (or 
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as close as you can get to the lens) what you would see would appear to be 

very close to the original photo. However, the farther away from the projec-

tor that you move — either side to side, up or down, or in and out — you 

would notice that what you are seeing is almost a true 3D representation of 

the original photo! This is a special effects technique that has been used for 

many years.

The first known use of this technique on a computer was performed by Mr. 

Yusei Uesugi, an extremely talented matte painter, on the film “Hook.” He 

painted an overhead view of the Neverland Island, and had the computer 

department create a rough model of the island and ocean. As the map was 

project from his point of view created in the painting, as soon as the record-

ing camera moved off axis, the painting suddenly appeared to have a three 

dimensional feel. Since then Mr. Uesugi and a variety of very talented arti-

sans have used this technique to great effect in such films as “Spawn,” 

“Star Wars Trilogy Special Edition,” “101 Dalamations,” and so on.

The true benefit of camera projection maps is that in many cases what 

would have required complex models before can now use rather simple 

models. The complexity instead is found within the details of the painting 

— a process many find easier than modeling.

Projection Map Process

Camera projection maps are applied to either all groups in a scene or 

groups within selection sets. (See the Selection Sets chapter for more informa-

tion on selection sets.) Each map in the list can be set to project in different 

manners (“applied as”), and each map can be set to project to a different 

selection set (“applied to”). Typically, camera projection maps are applied 

as “luminance” maps (the default), so that the map appears at full bright-

ness. This method allows the scene that is rendered and the original map 
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image to have the same brightness levels. In other words, the rendered 

scene would look like the photograph of the map. It is not uncommon to 

also use clip and transparency map methods to isolate elements in the map 

image, such as people, trees, or other details.

After applying a camera map and aligning the projecting camera, you 

should lock the projecting camera, so that registration is maintained.

The Projection Map tab consists of three items:

• Camera Map List and Controls
• Camera Map Applied As pop up menu
• Camera Map Applied To pop up menu

Camera Map List and Controls. The camera maps list is where you add 

camera projection maps. You can put as many maps as you like in this list. 

Maps can be single frames or movie files, and can be any bit depth desired.

Figure 4.16 — Camera Info Window Projection Map Tab
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To add a camera projection map to the list:

1. Click the Add button next to the Camera Map list
2. Select a map from the file list
3. Double click the map, or press the Open button

The camera map will be added to the list. To configure the map, double 

click on the map name in the list. To reorder the map in the list, just drag it 

to its new location. 

To delete a camera projection map from the list:

1. Select the map from the file list
2. Click the Delete button next to the Camera Map list

The map will be removed from the list.

Camera Map Apply As Pop Up Menu

This menu allows you to set the method in which the map will be applied 

to items in the selection set. All map channel methods described in the 

Materials and Textures chapter are found here. You can use any of the 

methods that you wish, although in practice you may find just the few 

described above to be of any real use in the map projection process.
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There are eleven methods in the list in which the map can be applied. 

Applying camera maps to any of these channels acts as if the map has been 

applied to that group’s corresponding material channel:

• Bump/Displace
• Clip
• Diffuse
• Specular
• Ambient
• Reflection
• Reflectivity
• Transparency
• Luminance
• Glow
• Transmission

Figure 4.17 — Camera Map Apply As Pop Up Menu
142       EIAS Animator   



Chapter 4  Assigning and Using Cameras — Projection Tab
Bump/Displace. The projected map will act as a bump/displacement map 

for the items listed in the Applied To pop up menu. This option is not typi-

cally used as a camera projection map.

Clip. The projected map will act as a clip map for the items listed in the 

Applied To pop up menu. This is option is great for isolating elements eas-

ily by masks.

Diffuse. The projected map will act as a diffuse map for the items listed in 

the Applied To pop up menu. This option is not typically used as a camera 

projection map, as the groups receiving a camera map from this method 

would shade normally, without self-illumination. (in other words, requir-

ing standard scene lighting) 

Specular. The projected map will act as a specular map for the items listed 

in the Applied To pop up menu. This option is not typically used as a cam-

era projection map.

Ambient. The projected map will act as a ambient map for the items listed 

in the Applied To pop up menu. This option is not typically used as a cam-

era projection map.

Reflection. The projected map will act as a reflection map for the items 

listed in the Applied To pop up menu. This option is not typically used as a 

camera projection map.

Reflectivity. The projected map will act as a reflectivity map for the items 

listed in the Applied To pop up menu. This option is not typically used as a 

camera projection map.

Transparency. The projected map will act as a transparency map for the 

items listed in the Applied To pop up menu. This option might be useful 

for some effects, or to isolate some elements of target groups.
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Luminance. The projected map will act as a luminance map for the items 

listed in the Applied To pop up menu. This is the default setting, as it 

allows for the projection map and the original image to have the same 

brightness (in other words, the rendered image will appear virtually identi-

cal to the original map image in terms of brightness). 

Note The groups receiving maps from this method do not accept shadows when this set-

ting is used. Self-illumination means that the groups are effectively not shaded, 

rather presented at full brightness levels. If you wish to cast shadows from other 

scene groups upon a projection mapped group with this method, you will be 

required to render an additional image, with the same groups, but with the map 

projections disabled, and the group shadow settings for the projection mapped 

groups (found in the group info window, shadow tab) set to “generate shadow 

mask.” You would then need to composite the two images together, using the pro-

jection mapped image as the background, and the shadow mask image as the fore-

ground.

Glow. The projected map will act as a glow map for the items listed in the 

Applied To pop up menu. This option is not typically used as a camera pro-

jection map.

Transmission. The projected map will act as a transmission map for the 

items listed in the Applied To pop up menu. This option is not typically 

used as a camera projection map.

Camera Map Applied To Pop Up Menu

This menu determines which groups in the scene will receive the selected 

camera projection map. There are three choices for this menu:

• None
• All
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• “Set List”

None. No groups in the scene will receive the selected camera projection 

map.

All. All groups in the scene will receive the camera projection map. This 

option should be used if you will not be introducing items that are not 

intended to be components of the map, as every group in the scene will 

receive the map projection.

“Set List” . Actually, after the All menu item, you will see the entire list of 

selection sets that exist within the project. If no selection sets exist, then 

there will be no items presented after the All menu item. Selection sets are 

the most controllable way of using camera projection maps. By use of a set 

or series of sets, you can determine exactly which groups will receive the 

selected camera projection map. Using sets, you can mix and match groups 

which do and do not receive projection map effects.

Camera Map Info Window

Double-clicking on the map in the map list brings up its Camera Map Info 

window. This window has the same controls found in the Texture Info win-

dow. For example, the Special tab contains the Displacement and Bump 

edit boxes when you are applying the map to these channels. The Clip Fac-

tor edit box is shown in the Special tab when the camera map is applied to 

the clip channel.

The special tab contains an one extra check box, “Map Visible Surfaces 

Only”. 
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Map Visible Surface Only

When this check box is on, the map is only applied to the visible surfaces of 

the groups in the selection set. Visibility is determined by rendering a 

shadow pass and then applying the resulting file as a mask.

Buffer Size. This is the maximum dimension of the shadow buffer in pix-

els. Unlike the shadow buffers for light sources, this shadow buffer does 

not have separate controls for the X and Y dimension. You enter in one 

dimension and the other is calculated for you based on the aspect ratio of 

the camera. 

Calculate Buffer Once. Turning the check box on causes the renderer to 

calculate the buffer once and then use it for every frame of the animation. 

This is useful if the projecting camera and the objects receiving the projec-

tions aren’t animated.

Figure 4.18 — Camera Map Info — Special Tab
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The Map Visible Surface Only feature is extremely powerful. You can add 

many projecting cameras to your scene. Each of which projects onto a con-

trolled portion of the geometry. Feathering the maps at their edges using a 

circular gradient in Photoshop will allow you to blend the maps together. 

The overall effect is to create an integrated 3D environment from a series of 

pictures (or paintings) and some simple geometry.

Projection Order

Camera maps are applied from each of the projecting cameras in the order 

the cameras appear in the Project window (hierarchy view). You can reor-

der the cameras in the Project window to alter the order the maps are 

applied.

Match Move Tab

The Match Move features are covered fully in the next chapter.
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Match Move

5.0 Introduction

To insert computer generated imagery into an existing film or video 

sequence, the original camera parameters must be known for each frame.

The Match Move system makes it possible to extract the original parame-

ters from a “locked-down” camera (pan, tilt, and roll only) given a digi-

tized video or film sequence and apply them to the internal camera 

mathematics in EIAS. This allows you to match your animations with a 

previously shot scene.

Match Move is a two-step process. You begin with 2D tracking. That is, you 

select a series of points in the sequence (or “Master”) and use the 2D auto 

tracking interface to locate these points in every frame.

The second step is the Match Look. In this step, the camera parameters are 

derived and automatically copied to the animation channels of your scene 

camera in EIAS.

5.1 Loading the Master

To match a video or film sequence (“Master”) you must first specify it in 

the scene camera. The animation data that is generated by the Match 

Mover will be added to the scene camera that has the Master.
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The Match Mover supports the Image file format and any QuickTime file 

formats as well.

The Master is loaded into the scene camera using the Camera Info window. 

Specifically, the Match Move tab > Master sub-tab as shown in Figure 5.0. 

Add/Del. Click on the Add button to add a Master to the scene camera. 

Click on Del to remove a Master. 

After loading the Master, go to the Camera View window and make sure 

that it is set to the scene camera you have loaded the Master into. The Roto-

scope pull-down icon at the bottom of the Camera View window will now 

contain a new entry, Match Move “Master”, where “Master” is the name of 

the file you have loaded. 

Pixel Aspect. It is important to select the proper pixel aspect ratio (pixel 

height divided by width) for the Master. The Pixel Aspect pull-down gives 

you a list of common aspect ratios to choose from. There is a custom setting 

Figure 5.0 — Match Move Tab
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available as well. The match will not be accurate if an incorrect pixel aspect 

ratio is chosen.

Start/Stop. Sets the starting and ending frames in the Master sequence to 

be used for Tracking and Matching.

Enable. The Enable button turns off and on the display of the 2D targets in 

the Camera View window.

Display. These options control the display of the targets in the Camera 

View window. You can change the color of the targets, “Color”, turn off the 

target names, “Show Labels”, and change the size of the square around the 

tracking point, “Size”.

Match Look. The Match button executes the match. See “Making The 

Match” on page 161 for a full description of the process.

5.2 Video Quality

It may be necessary to preprocess the video sequence using a third-party 

application to remove the interlace artifacts. Interlace artifacts are common 

in video footage because each frame of video contains two half-sized 

images called fields. These fields are shown in alternating scanlines. When 

you capture a frame of video, you are actually capturing both fields at the 

same time. Closer examination of the video will reveal slight offsets 

between scanlines depending on motion. These offsets are called interlace 

artifacts and will cause the automatic 2D tracker to produce unacceptable 

results. By processing the video frames to remove the interlace artifacts, the 

2D tracker will produce better results. Most common image processing 

applications have features that allow you to remove interlace artifacts.
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5.3 Managing Targets

Targets are managed using the Target sub-tab of the Match Move tab in the 

Camera Info window. 

When you choose Targets, you need to think about their quality. “Good” 

Targets are features which have a high contrast such as window corners, 

table corners, knobs, intersecting painted lines on street, etc.   “Bad” Targets 

are feature such as walls, grass, trees, road surfaces, and other large 

expanses with few repeating patterns. 

Add/Del. Click on the Add button to add new targets to the Target list. The 

Targets are numbered sequentially, but you can change the name of the Tar-

get by double-clicking on it in the Target List.

Once a Target has been added, it appears in both the Camera View window 

(if the Enable button is on) and in the Target Editor. The initial position of 

the Target is X=100, Y=100, where 0,0 is the upper left-hand corner of the 

Master.

Figure 5.1 — Targets Sub-Tab

Target List
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Reset 2D. This button deletes the 2D tracking information for the selected 

Target and repositions the Target back to (100,100).

Template Size. Specifies the size of the square (in pixels) that selects the 

image feature point to be searched. A value of 0 will select the auto-track-

ing template size.

Search Radius. Specifies how far to look around the estimated 2D position 

of the tracking point to find the match with its template.

Target Editor. This button opens the 2D tracking editor.
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5.4 Target Editor

2D tracking is accomplished using the Target Editor. This window has 

much in common with the window used to display images. The differences 

are in the Toolbar and the Track List. 

Figure 5.2 — Target Editor
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154       EIAS Animator    



Chapter 5  Match Move — Target Editor
Target Editor Toolbar

Image Information

This button brings up a window that displays basic information about the 

Master: width, height, number of frames, frame rate, color bit-depth, alpha 

bit-depth, and file size.

Color Channels

Allows you to change the image display. You can display just a single color 

channel, just the Alpha, or view the image as grey scale. The tracker actu-

ally uses the color channel selected. It is quite possible that one of the chan-

nels will yield a higher image contrast, and hence, produce better results.

Figure 5.3 — Target Editor Toolbar

Image Information
Color Channels
Color Background
Standard Mode (pick targets)
Zoom
Track Targets
Smooth Target Tracks
Track Options
Toggle Track Path
Toggle Track Label
Toggle Track Template
Toggle Track Search Region
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Color Background

Allows you to override the background color with a color of your choosing. 

Standard Mode

When highlighted, you can drag the targets around the Master. Hold down 

the Alt Key (Option Key on Macintosh) and drag to view a magnified area 

as you drag.

 Zoom

When highlighted, clicking in the window zooms in. Clicking with the 

right mouse button (hold Control-key and clicking on the Macintosh) 

zooms out. 

Track Targets

Clicking this button begins the 2D tracking process. All frames of the mas-

ter will be tracked from the current frame to the end of the sequence using 

the active Targets in the Target Editor.

Smooth Target Tracks

Applies a cubic filtering algorithm (selected in Track Options) to the 2D 

tracks that have already been computed. Each click reapplies the filter. The 

target's path curve will be smoother if you use more data points but will 

less likely stay on the feature it is supposed to track.
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Note Excessive use of the filter will make the 2D tracking drift from its intended match 

in the 2D image, so use sparingly.

Track Options

This button opens a dialog box that allows you to modify parameters for 

the Template, the 2D Smoothing filter, and the Magnifier.

Default Template Size. Sets the default Template size. A square region 

around the Target used for matching from frame to frame.

Method. Controls the number of data points used in the filter algorithm. 

You can choose to filter using either 5 or 7 points.

X/Y Axis. Determines if the filter is applied to the X-Axis, Y-Axis or both.

Size. X and Y dimension of the magnifying region in pixels. The magnifier 

is activated by holding down the Alt-key (Option-Key on Macintosh) while 

dragging the targets. 

Pixels. X and Y dimension of the region of the Master that is magnified. If 

Size is 63 and Region is 15, a square 15 by 15 pixels will be blown up into a 

magnified region of 63 by 63 pixels.

Toggle Track Path

Makes the 2D tracks of the Targets visible. The tracks are drawn in the same 

color as the targets and are visible after you have executed your first 2D 

tracking.
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Toggle Track Label

Makes the Track label visible in the Target Editor.

Toggle Track Template

Makes the Target Template squares visible in the Target Editor.

Toggle Track Search Region

Makes the Target Search Region circles visible in the Target Editor.

Target Editor Track List

The Track List shows all of the Targets and provides status for each Target 

in every frame that has been tracked. The status is shown using the square 

Frame Boxes in the Track List. Figure 5.2 shows a track list before any Tar-

gets have been tracked. The circles inside the Frame Boxes indicate that the 

targets have been manually positioned for that frame (the frame is 

“locked”). Since you must always manually position the targets for the first 

frame, the Frame Boxes for that frame always contain a circle.

The Frame boxes for the current frame (the frame set by the Shuttle Bar and 

shown to the left of the bar) are highlighted in Red.

In Figure 5.4 below, you can see that a whole series of frames have been 

tracked for the two Targets. 
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When a Target goes out of view of the Master, you must tell the tracker to 

disregard it. This is done by holding down the Control-key (Command-

Key on Macintosh) and clicking on the Frame Box where the Target first 

disappears. The Frame Box and all Frame Boxes to the right will become 

invisible, telling the tracker to ignore the Target during the ghosted period. 

Control-key (Command-key on Macintosh) click again further down the 

sequence to reactivate the Target if it becomes visible.

You can deactivate the Track by clicking on its name in the Track List. This 

allows you to track just one (or a few) tracks at a time. If you wish to dis-

able all the tracks except for one, hold down the Control-key (Command-

key on the Macintosh) and click on the track name.

Figure 5.4 — Target Editor Track List
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5.5 Match Options

These controls enable filtering of the data that is generated during the 

Match Look. The filter will be applied to the data after the match is com-

puted but before that data is copied to the animation channels of the scene 

camera.

The smoothing process works by looking at 5 or 7 data points around the 

current point and deriving a curve to best fit the data. The target's curve 

will be smoother if you use more data points but will less likely stay on the 

feature it is supposed to track. In situations were the camera movement is 

slow and steady and only the video noise contributed to the error in auto-

tracking, you may use the linear smoothing method to remove any noise or 

jitter. In hand-held video sequences, you are best served by the cubic 

smoothing method since the movement is less likely to be linear.

Use Filter. Enables the filter. If this button is off, no 3D filtering will be 

done.

Figure 5.5 — Options Sub-Tab
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Filter Type. Choose either a Cubic or Linear filter.

Filter Cycles. This determines the number of times the filtering algorithm 

is applied to the data. 

Match Roll. This enables computation of camera roll when the Match Look 

button is pressed.

5.6 Making The Match

Match Look computes only pan, tilt, and roll. It requires you to supply the 

original FOV of the camera that created the master. 

Add the Master

Open the Group Info window for the scene camera that you wish to add 

the match move data to. Bring the Match Move tab forward and click on 

the “Add” button to choose the Master sequence. 

Note Select the proper aspect ratio using the Pixel Aspect pull-down menu. Fail-

ure to choose the proper aspect ratio will cause severe errors in the Match 

Mover.

You will likely want to view the Master in the Camera View window. Use 

the Rotoscope button on the bottom of the window to select the Master.

Choose Your Targets

To get a good Match Move you are going to need to pick at least two fea-

tures (Targets) in the Master to track. Actually, if you only intend to derive 

pan and tilt, only one Target need be tracked. Select features that have 
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high-contrast characteristics and are visible for most or all of the sequence. 

Good candidates include building corners, table corners, knobs, lines 

painted on the street, etc.

Go to the Targets sub-tab and click on the Add button to create the Targets. 

The Targets will be numbered sequentially from 0. You can change the 

names of the Targets by double-clicking on them in the list and entering a 

new name. The Targets are initially placed at position (100,100) on the Mas-

ter where (0,0) is the upper right-hand corner of the image.

You will see the Targets sitting one on top of the other in the Camera View 

window (this assumes the Enable button is on in the Match Move tab). 

Make sure the Time Thumb or Shuttle Bar is set to 0.0 then you can drag the 

Targets to their initial positions in this window or go ahead and open the 

Target Editor and position them there.

Track the Targets

2D tracking is done in the Target Editor. The Editor lists all of the Target 

tracks and provides control for each track in every frame of the Master 

sequence. 

After you have moved the Targets to their initial positions and made sure 

that the Shuttle Bar is at 0, hit the “Track Targets” button in the toolbar. A 

status bar will pop-up telling that the tracks are being generated. You will 

see the Master play, frame-by-frame and the Targets move along with the 

imagery. When the tracking is complete, you will see that Frame Boxes 

have been created for each Track in every frame. As you scroll the Shuttle 

Bar, you will see the Master sequence play, the Targets move along their 
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Tracks, and the Frame Boxes light up in red as they become the current 

frame. 

Note A magnifier tool is available to aid you in placing your Targets at the most 

optimal position on the Master. Hold down the Alt-key (Option-key on the 

Macintosh) and drag the Target. The pixels under the Target will be magni-

fied making it easier to position the Target at an exact location. Options that 

control the magnifier are available using the “Track Options” button in the 

toolbar.

If a Target moves off of the selected feature in the Master at a particular 

frame, you can position the Shuttle Bar at that frame and then manually 

move the Target back into position. This will create a “Stop Frame” for that 

track at that particular frame. This is denoted by a solid circle inside the 

Frame Box. A Stop Frame tells the tracker that Target must reach that exact 

point on the Master at that frame. Once you have repositioned it, go ahead 

and hit the “Track Targets” button again. Tracking will proceed from the 

current frame (the frame set by the Shuttle Bar) to the end of the sequence.

If a Target moves completely out of the frame (the original film or video 

camera panned off of it), you need to make the Target invisible. Hold down 

the Control-key (Command-key on the Macintosh) and click on the Frame 

Box at the point in time where the Target disappears. The Frame Boxes 

from this point on are shown in a ghosted form and the tracker will ignore 

them. If the feature moves back in frame at a later time, you can enable it 

again by using the Control-key (Command-key on the Macintosh) at the 

frame where it reappears.
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It may be easier for you to work on one Track at a time. You can click on the 

Target name in the Track List to enable or disable the target. Holding down 

the Control-key (Command-key on the Macintosh) and clicking on the Tar-

get name will disable all the targets except the one you clicked on.

The goal is to track every Target during each frame of the Master sequence. 

You may have to repeat the cycle of manually positioning an errant Target 

and Tracking several times for each of the separate Tracks.

After you have tracked your Targets, you can smooth out the paths using 

“Smooth Target Tracks” button in the toolbar. This button will apply a fil-

tering algorithm to the Tracks every time it is pressed. Options that control 

the filter behavior are available using the “Track Options” button in the 

toolbar. 

How the Tracker Works

Tracking is accomplished by using “Templates” and comparing them to the 

“Master” image. Templates are square images taken around the 2D feature 

being tracked and then used in the subsequent frames for matches to com-

pute the next 2D location. You may specify how large these “Templates” 

can be by setting the Template Size (in pixels) in the Camera Info window > 

Match Move tab > Targets sub-tab. Highlight the Target name in the Target 

List and its Template Size is shown on the right. See Figure 5.1

The auto tracker has a default template size which it will use if the tracking 

point template has not been specified (set to 0). You may access that default 

by using the “Track Options” button in the Target Editor toolbar.

The larger the Template the slower the algorithm will be. Good sizes are 9 

to 25 pixels which are fast and accurate. Also, the auto tracker will estimate 
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by the previous 2D position where the 2D position in the next frame will 

be. However, it will still use the Template to search around that point to 

find the correct position. 

To aid the search, a Search Radius has been provided to restrict the search 

within that area. The larger the search area, the slower the algorithm will 

be. Good radii are 10 to 20 pixels. Of course, these numbers depend on how 

“wild” the camera movements are. A locked-off camera requires almost no 

user intervention and a hand-held camera will require some experimenta-

tion and a lot of user intervention. 

The Match Look

The Match Look requires you to set the proper FOV in the Camera Info 

window, FOV tab. The results will be incorrect if you have not set the FOV 

ahead of time. You will also need to place the scene camera in the approxi-

mate position represented in the Master. 

Make sure that the scene camera is animatable. Hit the “Match Look” but-

ton in the Camera Info window > Match Move tab. You will see a dialog 

asking you which frames to track. Set the frames and click “OK”. After the 

Match Look has been computed, the scene camera will update with the 

new information.

Note Remember to turn on the Match Roll button in the Options sub tab if you 

want the camera roll computed.
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5.7 Match Move File Import

Electric Image EIAS can now read the match move data from Realviz's 

MatchMover (regular and Professional) and 2D3's Boujou directly. Previ-

ously, match move data could only be imported via the LightWave scene 

import option. 

From Realviz's MatchMover, export the camera matched data as a .rz3 text 

file. From 2D3's Boujou, export the camera matched data as a Boujou ani-

mation file (.ban)

In EIAS, go to the Animation Menu->Import Motion..., and select the 

matched moved file (.rz3 or .ban). After the file is read, you will see a new 

scene camera and nulls (effectors) representing the 3D reference points 

(original targets). Camera position, direction, roll and focal length anima-

tion channels are imported. This data is saved as custom frames in the 

newly created scene camera.
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Lights in EIAS Animator

6.0 Introduction

As with real world photography, 3D computer graphics programs need 

light to properly render an image. It is in lighting that one truly sets the 

mood of the composition. EIAS Animator offers a variety of different light 

types and lighting effects to help you set the mood you envision. You can 

animate all of a light’s characteristics — there are over 450 channels to 

work with for a single light (including all of the special effects). The inter-

face is very straightforward, to the point that you don’t realize just how 

much control you have over the light.

Like groups, lights can exist individually or as part of a hierarchy, although 

they are best placed at the end of a chain or strange results will occur. 

Sometimes you will want to add lights into a hierarchy for scene illumina-

tion, other times you may wish to add them for visual effects. Some of the 

many visual lighting effects available are lens flares, visible lights and light 

rays, and light projections (where you load an image or movie and it is then 

“projected” into a scene.) You can also tell lights to include or ignore 

groups in a scene with selection sets. And you can even tell a light to remove 

light from a scene, by setting its intensity to a negative value.
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6.1 Light Types

By default, all projects in EIAS Animator start out with one radial light so 

that you won’t be left in the dark. There are six types of lights available in 

EIAS Animator:

• Camera
• Parallel
• Radial
• Ambient
• Spot
• Tube

Camera. This type of light simulates a point light that is attached to the 

camera itself. It is radial in nature (in that all beams of light from this source 

emanate from it’s center).

Parallel. This type of light simulates a light placed an infinite distance 

away. The light rays are parallel, providing an even illumination. Use this 

type for sunlight, stars, etc. This is the best light source for illuminating flat 

shaded scenes.

Radial. This type of light (the default) simulates artificial lights, by nature 

of the way the rays emanate radially, like the spokes of a wheel, from the 

center of the light. The light has no sense of direction, just location and 

dropoff.

Radial lights can also be set to be dark lights. When a dropoff other than zero is 

specified in the Dropoff edit box (see below), a negative intensity can be used in the 

intensity box to create a subtractive lighting effect. Whatever color is specified in 

the Color Button (see below) will be subtracted from the scene.
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Ambient. This type of light simulates a non-directional, overall illumina-

tion, much like you would see on a cloudy day. It is normally used so that 

objects don’t shade to absolute black.

An ambient light, as with all lights (except for dark lights), adds more light to the 

scene. This can result in images appearing to be overexposed. To compensate for a 

strong ambient light, drop the intensity value of your other lights accordingly. It 

takes some practice, but the ambient light can add tremendous realism to a scene 

when used properly.

Spot. This type of light simulates a directional, limited area light, placing a 

pool of light over a specified area. The pool is circular in nature, and the 

lights contain several different variables, such as an inner and outer cone 

size (note that the inner cone is always smaller than the outer cone), which 

controls the umbra and penumbra of the light. The dropoff distance of the 

spotlight can also be set, as well as whether or not the effective drop-offs 

are calculated linearly or logarithmically.

Spotlights can also be set to be dark lights. When a dropoff other than zero is speci-

fied in the Dropoff edit box (see below), a negative intensity can be used in the 

intensity box to create a subtractive lighting effect. Whatever color is specified in 

the Color Button (see below) will be subtracted from the scene.

Tube. This type of light simulates artificial lights from a tube-like source. A 

tube light is basically an elongated radial light (its length can be adjusted) 

which, when used as a fog or glow light, can create visual effects such as 

fluorescent bulbs or laser beams.

Adding Lights

Typically you will use many lights in a scene to achieve a desired effect. 

There are two ways to create new lights in a project:
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• Lights can be added by choosing Object>Add Light

• Existing lights in a scene can be duplicated

To add a light to a project from the Object menu:

1. Choose Object>Add Light 
2. Click and place the light into the scene
3. Drag the light into the desired position

To duplicate an existing light:

1. Select the light to be duplicated in either the project window or world 
windows

2. Choose Edit>Duplicate (command-D)
3. Drag the duplicate to the desired position

6.2 Light Information Window Anatomy

Like all Info windows in EIAS Animator, the Light Info Window can be 

accessed using any of the following methods:

• Double click on the light in the World View or Camera Windows
• Double click on the light name in the Project Window
• Choose “Light Info” from the Object menu, with the light previously 

selected

Figure 6.1 shows an illustration of the Light Info Window. To the left of the 

Light Info Window is the Light Type pulldown menu and a series of check 

boxes. To the right are a series of named configuration tabs, each containing 

the controls and functions indicated by the name of the tab. To select a tab, 

just click on it to bring it forward.
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The Light Type popup menu allows you to select the type of light you want 

this light to be, and the eight check boxes activate interface representations 

of specific attributes within the world view and camera view windows. The 

checkboxes allow the user to have quick visual feedback regarding the 

parameters of the lights sources without having to render out scenes. You 

can use the checkboxes while setting up a scene but only activate those 

attributes needed, as turning on too many at the same time can clutter up 

your view windows.

Figure 6.1 — Light Info Window

Light Interface Attributes

Light Type Pop-up Menu Configuration Tabs

Tab Control Area
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Light Display Options

The following light interface attributes are available:

• SHOW ANGLE

• SHOW DROPOFF

• SHOW FOG RADIUS

• SHOW GLOW RADIUS

• SHOW FLARE

• SHOW SIZE

• SHOW ILLUMINATION

• SHOW FLARE DROPOFF

• SHOW VOLUME DROPOFF

Show Angle. This check box option enables the display of the light’s spot-

light and/or shadow cone angle in the World View windows. The cone 

angle projection emanates from the center of the light toward the direction 

indicated by the reference point of the light. It will project four lines which 

define the maximum area of the cone as indicated in the Inner Cone and 

Outer Cone edit boxes, discussed below.

Show Dropoff. This check box option enables the display of the light’s 

dropoff value when the light is selected. A simple wireframe sphere primi-

tive will be used to represent the area of the dropoff of radial lights. Spot-

lights will show a clipped disc primitive inside the area of the spotlight 

cone, regardless if the SHOW ANGLE checkbox is active. Tube lights will 

show a tube-shaped primitive surrounding the light controls. Parallel 

lights do not support dropoff. Dropoff will not be shown for camera lights.
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Show Fog Radius and Show Glow Radius. These check boxes enable the 

display of the light’s fog and glow radii when the light is selected. The dis-

play primitive is the same as for SHOW DROPOFF.

Show Flare. This check box option enables the display of the light’s flare in 

the Camera View window if the lens flare is active for the light. Display of 

the flare in the interface is not affected by the FLARE DROPOFF value.

Show Size. This check box option enables the display of the light’s size 

when the light is selected. The same primitives will be used as SHOW 

DROPOFF.

Show Illumination. Show Illumination (defaults on) can be used to control 

which lights in your scene are used during OpenGL drawing. When this 

check-box is turned off, the light will no longer be used to shade in the 

View window. However, Camera will still use the light when it renders. 

You can create light sets and turn their Show Illumination check-boxes on 

and off in groups to manage your drawing speed. OpenGL can only use 

eight lights at a time. It renders the scene with the first eight lights, if there 

are more than eight, the scene must be re-rendered and added to the first 

rendering. Each of these rendering passes eats up a lot of time. The Show 

Illumination check-box can be used to determine which lights and how 

many lights get used by OpenGL. Please keep in mind that one light is 

always reserved by the drawing engine for lighting the light and camera 

widgets. Therefore, the first OpenGL pass really consists of the first seven 

lights in your scene.

Show Flare Dropoff. This checkbox draws the Flare dropoff primitive in 

the world view and camera view windows when the light is selected, and 

represents the furthest distance from the light that the lens flare effect will 
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be visible. You can access installed lens flares through the Flare tab in the 

Light Info Window.

Show Volume Dropoff. This checkbox draws the volume dropoff primi-

tive in the world view and camera view windows when selected. The vol-

ume dropoff compensation will occur inside of the dropoff extent. The 

volume drop off setting is an edit box located in the properties tab of the 

Light Info Window.

Light X-Form Tab

The light x-form tab contains transform information for the light. This tab is 

broken down into four sections:

• Light Section
• Reference Section
• Roll, Pitch and Yaw Angles Section
• Roll Control
• Animated Visibility

Figure 6.2 — X-Form Tab
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Light Section. The light section contains the Key popup menu (for control-

ling motion interpolation) and three position edit boxes. These edit boxes 

list the current position of the light, in X, Y, and Z coordinates, which can be 

changed by you at any time.

Reference Section. The reference section contains the Key popup menu 

(for controlling reference point interpolation) and three position edit boxes. 

These edit boxes list the current position of the reference point, in X, Y, and 

Z coordinates. You can also expressly set the camera to reference distance 

in the edit box.

Roll, Pitch, and Yaw Angles Section. The light can also be controlled 

through more traditional roll, pitch and yaw edit boxes, and are expressed 

in degrees. The order of the boxes is actually presented as Yaw (X), Pitch (Y) 

and Roll (Z), and equates directly to X, Y, and Z.

Roll Control. The roll control is interactive, and can be dragged to create 

roll angles. Its presentation is reminiscent of the roll indicator found in air-

craft avionics.

All of the numeric values presented in the edit boxes are dependent upon 

the editing mode set in the project window, and if the animate flag has been 

set for the camera object or a particular channel for the camera object.

In Index mode, changing the values updates the value for the current key-

frame you are editing. Index mode only allows for the editing of previously 

generated key frames, rather than for creating new ones, so it is only possi-

ble to alter an existing keyframe while in index mode.

In Frame mode, changing the values in the x-form window creates a cus-

tom frame with those new values. Custom frames have an underline mark 

below their values in the project window. Custom frames are not affected 
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by the interpolation and velocity of the frames around them. They are fixed 

values which will be implemented without regard to any other key frames. 

If you can picture a smooth curve, custom frames are like spikes jutting out 

from the curve. They have no regard for the curve itself, or its shape (veloc-

ity). They simply pop to their value, and then return back to the curve 

when done. 

In Keyframe and Time modes, changing the values in the x-form window 

either creates a new keyframe (if none exists at the current frame), or 

updates the values of an existing keyframe.

EIAS Animator can display keyframe values in either Implicit, or Explicit 

values. Implicit is the way that EIAS Animator has always displayed vec-

torized quantities. When the camera is set to implicit, dragging the light in 

a window controls two of its positional measurements. The velocity is com-

puted as a composite of these two vectors. For instance, by dragging a cam-

era in the top view window, the X & Z coordinates will change, in the Front 

View the Y&X, and the Side View the Y&Z coordinates. Implicit controls 

always function on all axes simultaneously.

When a light is set to explicit positioning, it is possible to control the values 

and velocity for all 3 components of motion (X,Y,Z) independently in the 

function curve editor. 

Animated Visibility. This checkbox controls the existence of the light for 

every frame of the animation. For more information see “Animated Visibil-

ity” on page 331.
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Properties Tab

The Properties tab contains the basic illumination features of the light. This 

tab is broken down into a variety of sections, depending upon which light 

type is selected.

Common Attributes to All Lights:

• Light Color Swatch
• Intensity Edit Box
• Size Edit Box
• Volume Dropoff Edit Box
• Enable Highlight Check Box
• Enable Illumination Check Box
• Illumination List

Light Color Swatch. This swatch selects the color of the light at the current 

keyframe, frame or point in time (depending on the editing mode in effect). 

When the color button is clicked, the Color Picker comes forward for color 

selection. The color button will then change to the color of the light, and the 

light icon will change to the new color in the world view windows.

Intensity Edit Box. This edit box contains a value for the brightness of the 

light at the current keyframe, frame or point in time (depending on the 

editing mode in effect). The default intensity is 1. If it is necessary to 

increase the brightness of the light, then the Intensity value should be 

greater than 1. If a “dark light” effect is required (where light is subtractive 

rather than additive), then a negative value should be entered into the box.

Size Edit Box. This edit box contains the value for the size of the light (in 

world units) at the current keyframe, frame or point in time (depending on 
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the editing mode in effect). The default is 0.0, which means that the light is 

infinitely small (effectively, a point.) The size value can be used by lens 

flares for scale control, and for soft ray-traced area shadows, where the size 

of the light is used for the area shadow calculation.

Volume Dropoff Edit Box. The Volume Dropoff setting is used to improve 

the look of both glow and fog lights. The purpose of this feature is to pre-

vent spotlight beams from washing out surfaces which they intersect. The 

illustration below clearly shows the benefits of using volume dropoff. Most 

would argue that the image on the right appears more natural than the one 

on the left. With the exception of enabling the volume dropoff feature for 

the image on the right, both images use identical values. There is no signif-

icant render time penalty to use the volume dropoff feature.

Smaller values set the dropoff towards the light source, larger values set the 

dropoff closer to the illuminated object. The Volume Dropoff value repre-

sent distance in scene units. Using the ruler bars (command-m) will help to 

choose the best distances.

Figure 6.3 — To the left, Volume Dropoff is disabled, to the right image Volume 
Dropoff is enabled. All other values are the same.
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Dropoff values visible inside of the glow or fog regions will appear as a 

parabolic mach band within the region. This effect is similar to seeing a 

spotlight beam focused in smoke. If this effect is undesirable, increase the 

dropoff value beyond the range of the glow or fog region. The effect will no 

longer be visible.

Enable Highlight Check Box. This check box will enable the light to cast a 

highlight reflection, or specular on any object in the scene, unless the object 

is on the exclude illumination list, or not present on the include illumina-

tion list.

Enable Illumination Check Box. This check box will enable the light to 

illuminate any object in the scene, unless the object is on the exclude illumi-

nation list, or not present on the include illumination list.

Additional attributes of Camera, Radial, Spot and Tube Lights:

• Dropoff Edit Box
• Dropoff Enable Check Box

Figure 6.4 — Properties Tab
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Dropoff Edit Box. This edit box contains a value for the dropoff distance of 

a light at the current keyframe, frame or point in time (depending on the 

editing mode in effect). Dropoff is not available for parallel lights or ambi-

ent lights. You can use the rulers (command or control “m”) to see the 

actual scale of your scene, and to determine the dropoff distance you 

would like to use. To view the dropoff in the world view windows, click the 

Show Dropoff check box in the Light Interface Attributes section.

Dropoff Enable Check Box. This check box will enable the dropoff shad-

ing feature for the light. If this checkbox is off, but the show dropoff check 

box in the interface attributes section is on, no dropoff will be shown in the 

interface.

Additional attributes of Spotlights:

• Inner Cone is Offset Check Box
• Factor Edit Box
• Outer Cone Edit Box
• Inner Cone Edit Box

Inner Cone is Offset Check Box. This check box lets you create a great 

looking spot light cone by typing in just one value instead of two. When 

you enable this option, an edit box will appear to set the offset distance. 5 ˚ 

is a good value for starters, but feel free to experiment. Once enabled, 

whenever you set the outer cone of the spotlight, the inner cone will adjust 

to its new value based upon the offset that you provide.

Factor Edit Box. This edit box contains a value for the rate at which the 

spot light falls off between the inner and outer cones. The default is 1.0, 

which provides an even transition. A higher number creates a sharper tran-

sition.
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Outer Cone Edit Box. This edit box contains a value for the outermost 

diameter of the area illuminated by the spot light. The area outside the 

outer cone will not be illuminated by the light. The area between the outer 

and inner cones is a transition area between full illumination and none.

Inner Cone Edit Box. This edit box contains a value for the diameter of the 

area receiving the full illumination of the spot light. The light falls off 

between the inner and outer cones.

6.3 Illumination Lists

Illumination lists provide a way to control which objects receive light from 

a particular light source. They are common to all light types. Which objects 

receive or are excluded from the illumination of a particular light source 

are determined by selection sets. 

Adding Illumination Lists
To add an illumination list to the light, use the following method:

1. Click the Add button
2. Select the set from the list window that appears
3. Click the Add button in the list window

You will now see the name of this selection set listed in the Illumination 

List window.

Enabling/Disabling Illumination Lists

Sets in the Illumination lists are enabled or disabled by clicking on the solid 

circles to the left of their names (defaults to enabled.) Once clicked, the cir-

cle becomes hollow, indicating that the set member will be ignored. This 
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feature works in the same manner as the checkboxes to the left of each 

group name in the project window.

Illumination Lists and Light Behavior

Once you assign an illumination list to a light, the light “sees” only those 

items contained within the selection sets listed for the specified behavior. If 

the Illumination List is set to be excluding, then those selection sets in the 

illumination list are not lit by the lightsource. All other objects in the scene 

will be lit normally. If the Illumination List is set to be including, then only 

those items contained within the selection sets will receive illumination 

from the lightsource. All other objects in the scene will be ignored by the 

light.

Lights can only offer include or exclude behavior, regardless of the number 

of selection sets within the illumination list. Behaviors cannot be mixed and 

Figure 6.5 — Light exclusion example

Normal Render Object Excluded from illumination
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matched. If such is desired, you would need to create a new light with the 

corresponding selection sets and settings.

Flare Tab

The flare tab contains all of the parameters to control lens flares for the 

lightsource. Installed lens flares are available from the popup Flare menu 

(flares are plug ins and need to be installed into the EI Sockets folder to be 

available to a project.) 

There are several options which relate to all lens flare plug-ins, regardless 

of the manufacturer:

• Flare Selection Pop-up Menu
• Plug-in Options Button
• Enable Object Obscuration
• Enable Cone Obscuration
• Enable Offscreen
• Enable Distance

Figure 6.6 — Flare Tab
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• Enable Background
• Enable Fog
• Enable Intensity
• Flare Dropoff Edit Box

Flare Selection Pop-up Menu. This menu allows you to choose the desired 

lens flare plug-in for the light. Only one lens flare per light is allowed. 

Lens flare plug-ins will be available only when properly installed in the EI Sockets 

directory.

Plug-in Options Button. This button will activate the configuration dialog 

for the selected lens flare.

Enable Object Obscuration. Causes flare to dim as the light is covered by a 

group. Light size is determined by the Size: edit box in the Light Info win-

dow.

Enable Cone Obscuration. Causes the flare brightness to change as the 

spotlight cone moves through the camera’s view. Takes into account the 

brightness of the inner and outer cone of the spotlight.

Enable Offscreen. This checkbox enables the flare to gradually diminish as 

the origin of the flare moves off screen. With this option on the flare 

behaves as the real photographic artifact behaves. The lightsize setting in 

the Properties tab is used to control the effect.

Enable Distance. This checkbox enables the flare to diminish over distance. 

The lightsize setting in the Properties tab is used to control the effect.

Enable Background. Allows the lens flare to “glow behind” all objects in 

the shot. As such, this feature ignores the Enable Obscuration setting. You 

can add some dramatic backlighting effects to your scene with this feature.
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Enable Fog. Causes the flare intensity to diminish as the flare moves into 

the fog (the fog feature is available in the World Info Window.)

Enable Intensity. Uses the Light intensity setting to calculate the flare 

intensity. The Light intensity setting is available in the Properties tab. The 

Dropoff setting for the light will effect the lensflare if this setting is active.

6.4 Shadows

The shadow tab is used to control the shadow properties for the light. All 

lights can cast shadows. There are two different types of shadows offered 

in EIAS Animator:

• Depth Buffer Shadows
• Raytraced Shadows

Depth Buffer Shadows

Depth buffer shadows are very fast to calculate and render. They are soft 

and less defined along the edges than raytraced shadows. Depth buffer 

shadows required much more setup effort than raytraced shadows, and are 

also less accurate. As such, numerous controls are implemented to allow 

you to “fine tune” the depth buffer shadows for better results.

Raytraced Shadows

Raytraced shadows are very slow to calculate and render. They are very 

sharp along the edges, unless the soft shadow option is enabled (which 

adds even more render time.) Raytraced shadows are very accurate, and 

are very easy to setup and use. Essentially, there is no setup involved, with 

the exception of activating them. For soft raytraced shadows, just a little 

more effort involved, as will be discussed in a following section.
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Note Neither shadow type will motion blur with the motion vector blur setting enabled. 

If you need your shadows to be properly blurred, you will need to use the multi-

frame blur setting, or a combination of multi-frame and motion vector.

Depth Buffer Shadow Tab

The shadow tab contents will change depending upon the setting of the 

shadow type pop-up menu. This section will cover depth buffer shadow 

settings. The following attributes are available to depth buffer shadows:

• Enable Shadow
• Outside Buffer Area in Shadow
• Calculate Shadow Only Once
• Buffer X Resolution
• Buffer Y Resolution
• Shadow Color
• Gap
• Softness
• Samples
• Transition
• Smoothing
• Darkness
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Enable Shadow. This check box option enables the light to cast shadows.

Outside Buffer Area in Shadow. This check box option, when enabled, 

causes the entire area of the image outside the outer cone angle (specified 

in the Outer Cone edit box) to be rendered in shadow (simulating the effect 

of a real spotlight).

Calculate Shadow Only Once. This check box option, when enabled, 

causes the shadow image to be calculated only once, as it appears in the ini-

tial frame of an animation. This feature saves rendering time when the 

shadow image does not change during an animation (such as when only 

the camera is moved).

Buffer X Resolution. This edit box contains a value for the shadow buffer 

X resolution. The larger the buffer size, the greater the rendering detail for 

the shadow, however greater memory is required to render the shadow. 

The default is set to 1280 pixels square, which creates good looking shad-

ows. This setting uses 6.5 mb of RAM.

Figure 6.7 — Shadow Tab showing depth buffer shadow attributes
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Buffer Y Resolution. This edit box contains the Y buffer resolution for the 

depth buffer shadow. You can create non-square shadow buffers to suit 

your needs. Often, too much space is wasted in a shadow buffer. By allow-

ing a non-square shadow buffer, you can orient the light position to maxi-

mize the buffer usage.

Shadow Color. This swatch allows you to use the color picker to set the 

color of the shadow. Shadows on earth are rarely black, unless induced by 

artificial lighting.

Gap. This edit box contains a value for the minimum distance between a 

surface casting a shadow and the point at which a shadow first appears.

Softness. This edit box contains a value affecting how the shadow’s edge 

appears. The larger the value, the softer or fuzzier the shadow’s edge will 

appear. A value of 1 creates fairly crisp shadows.

Samples. This edit box contains a value for the number of shadow samples 

per pixel. A larger value reduces the noise around the edge of a shadow but 

takes longer to render.

Transition. This edit box contains a value for the fade-in distance between 

a surface casting a shadow and the surface upon which the shadow 

appears.

Smoothing. This edit box contains a value for the softness of shadow edges 

when viewed up close. Longer values can reduce the stair step of shadow 

edges, but can also cause shadows to appear further away from the sur-

faces which cast them.
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Raytraced Shadow Tab

The shadow tab contents will change depending upon the setting of the 

shadow type pop-up menu. This section will cover Raytraced shadow set-

tings. The following attributes are available to raytraced shadows:

• Enable Shadow
• Dropoff Section
• Soft Shadow Section
• Optimize Shadow Generation

Enable Shadow. This check box option enables the light to cast shadows.

Dropoff Section. This section contains controls to enable the dropoff value 

of the raytraced shadow. There are two controls, the Enable check box, and 

the distance edit box. To activate dropoff, click in the enable check box. Add 

a dropoff distance in scene units.

Soft Edge Shadow Section. This section contains controls to enable the soft 

area shadow effect. To enable soft shadows, click in the enable box. The 

Figure 6.8 — Shadow Tab showing raytraced shadow attributes
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samples edit box allows you to set the number of samples that will be 

applied to the shadow. Higher numbers in this edit box will result in signif-

icantly longer raytrace times, as the number of samples is then squared and 

scattered over the area of the light (as determined by the light size attribute 

in the Properties tab.) 

There is a direct relationship between the Lightsize attribute and the sam-

ples edit box in this section. Larger lights may require higher samples for 

accurate shadows. Smaller sample values may produce artifacts such as 

noise, and can be especially noticeable around the edges of the shadow 

boundary.

To improve the performance of the soft shadows, we suggest that you 

always use a spot light just large enough to capture the shadow casting 

objects. If you need the look of a radial light, use a duplicated spot light 

with a negative light intensity (and no shadows enabled) to cancel out the 

illumination of the shadow casting spot light. Then use the radial light with 

shadows disabled.

Turn down the samples value from their defaults. Try 6 or 7 on smooth sur-

faces. If your surfaces have some bump then the samples can be turned 

down even further as the bump will cover up any sample grain.

Turn off Cast Shadow for any ground plane. Turn off Receive Shadow for 

any glass objects.

If you are using mirrors or chrome (100% reflective) surfaces, disable 

Receive Shadows. Anything 100% reflective will not show any shadows. 

While this may not be “photorealistic” it can improve performance without 

changing the look of the scene very much.
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Note Parallel lights cannot be used to create soft-edged raytraced shadows. They simu-

late a light that is infinitely small and infinitely far away. Therefore, there is no 

area from which to calculate the ray distribution.

Optimize Shadow Generation. This check box enables soft, raytraced 

shadows to calculate sixteen times faster while producing indentical visual 

results. However, using this feature may produce artifacts such as small 

squares which are different than the surrounding pixels in the image. If you 

encounter artifacts, then disable this feature.

Soft shadows are very effective, but they extract a tremendous time penalty, espe-

cially when you consider just how fast the rendering engine really is. Should you 

need soft shadows, depth buffer shadows may be a better choice, especially if you 

are creating a long animation sequence.

6.5 Special Lighting Effects

EIAS Animator offers an impressive array of special lighting effects. These 

lighting effects can be used to convey a variety of different moods in your 

scenes. They can also be used for specific effects such as laser beams or 

streak effects. Available special lighting effects are:

• Glows
• Fog
• Volume Shadows
• Light Rays
• Smoke Effects
• Projector Light Effects

Glows. Effectively, the glow properties enable your light to be visible in the 

scene. With this feature, you are not required to create a model of your 
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light, as you are creating an actual glowing light, When combined with lens 

flares, this effect is especially powerful. 

Important

Rendering

Note

The glow property of a light is not compatible with transparent objects, or 

material attributes which use the transparency pipeline, such as clip maps. 

Do not use effects which rely on the glow light, such as those effects in this 

section (except for projector lights without light rays) when the scene also 

includes transparent object or material effects.

Fog. Fog is essentially the glow feature, but instead of the light being added 

to the scene, it is averaged into the scene instead. Light-based fog is differ-

ent from the environmental fog found in the World object. Environmental 

fog is global, and does not produce volume shadow effects.

Important

Rendering

Note

The fog property of a light is not compatible with transparent objects, or 

material attributes which use the transparency pipeline, such as clip maps. 

Do not use effects which rely on the fog light, such as those effects in this 

section (except for projector lights without light rays) when the scene also 

includes transparent object or material effects.

Volume Shadows. Volume shadows are shadows that are cast through a 

glow or fog light region, or through a smoke object. Volume shadows 

resemble beams of sunlight shining through the clouds. 

Volume shadows rely on the glow and fog properties of lights to produce results. 

Transparent objects, and material attributes which use the transparency pipeline 

(such as clip maps) may not be compatible with volume shadows.

Light Rays. Light rays are like volume shadows, except that instead of cast-

ing shadows, light is cast instead. This makes the object appear to be gener-

ating shafts of light.
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Light rays, like volume shadows, rely on the glow and fog properties of lights to 

produce results. Transparent objects, and material attributes which use the trans-

parency pipeline (such as clip maps) may not be compatible with light rays.

Smoke Effects. Smoke effects take advantage of a smoke object volume. 

Smoke effects are best used if you need to see smoke billows and tendrils. If 

you prefer more of a blanket of smoke, to where the amount of smoke is 

even and you do not see definition to the smoke, then stick with glow or 

fog lights alone, as they will render significantly faster. 

Smoke effects are visible only inside the cone of a spotlight with the glow or fog 

properties enabled.

Projector Light Effects. Projector lights are similar to volume shadows, 

except that instead of a streaked volume shadow, the image loaded into the 

projector light is substituted. This is great for simulating a movie projector 

in a theatre, or stain glass windows in a cathedral. Simpler effects can also 

be accomplished, such as the pattern of a flashlight beam.

Projector lights which are set up to use volume shadows or light rays rely on the 

glow and fog properties of lights to produce results. Transparent objects, and mate-

rial attributes which use the transparency pipeline (such as clip maps) may not be 

compatible with projector lights using volume shadows.
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Important Glow and Fog Rendering Note

All of the visible lighting effects, that is, effects which rely on glow or 

fog properties of lights to produce their results, should not be used with 

transparent or clip mapped objects. Volumetric glow effects and transpar-

ency materials and effects (clip maps use the transparency pipeline in the 

rendering engine) are not compatible for a variety of technical reasons, and 

can cause strange artifacts to occur. 

Some alternatives to these limitations are:

• Render your scene in layers, inserting the glow effects on a layer other 
than transparent objects and objects with transparency or clip maps

• Use material glow effects (which is an image processing effect) instead 
of glow lights, which are volumetric. Material glow effects are applied 
after the image is rendered, and thus bypass the incompatibility 
(although these glows will not be visible in raytraced reflections or mir-
ror maps)

• Use lens flare effects (which is an image processing effect) instead. 
These effects are also applied after the image is rendered, and like 
material glow effects are not visible in ray traced reflections or mirror 
maps

• Use geometry and transparency edge settings, along with luminance 
channel settings, to simulate glows with actual models in the shape of 
the desired glow. This method is a bit “old fashioned” but works well.
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Glow Tab

This tab contains all the information to control the glow properties of your 

light source. 

The following attributes are available on the light glow tab:

• Enable Glow
• Volume Falloff
• Invert Glow & Fog
• Interpolate RGB
• Enable Glow Blend
• Enable Ray
• Outside Glow Color
• Inside Glow Color
• Inner Radius
• Outer Radius
• Factor
• Intensity

Figure 6.9 — Glow Tab
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• Ray Factor
• Ray Sample
• Smoke Volume Selector

Enable Glow. This check box option enables the glow effects for the light.

Volume Falloff. The Volume Falloff checkbox enables the volume dropoff 

value in the Properties tab to be used when shading the glow region. For 

more information, see “Additional attributes of Camera, Radial, Spot and Tube 

Lights:” on page 179.

Invert Glow & Fog. This feature will invert your light rays and other glow 

and fog light effects. For example, instead of your logo casting shadows 

within your light beam, you can have the logo actually cast the light beam 

for streak effects.

Interpolate RGB. The default color interpolation method for the glow 

attribute is HSV color space (hue, saturation and value.) This option will 

allow you to change the interpolation method to RGB color space (red, 

green and blue). HSV is a more natural form of interpolation, and will 

maintain the brightness of the colors in the glow region as the glow is ren-

dered. RGB is a more linear form of interpolation. When a glow region is 

calculated with RGB interpolation, the color values will dim and get 

muddy, and the brightness factor will decrease in this space. HSV bright-

ness values will remain constant throughout the region.

Enable Glow Blend. As glows are an additive process, when one glow 

region intrudes into another, the area of intersection will be brighter than 

the areas of glow outside of the intersection. While physically accurate, this 

look may not be what you are after. The Enable Glow Blend feature will not 
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brighten the area of intersection, but rather just blend them together (as 

would occur in an averaged process.)

Enable Ray. This check box activates the light ray feature.

Outside Glow Color. This swatch opens the color editor to select the color 

at the edge of the glow. If the outside color is different than the inside color, 

a blend will occur between the two.

Inside Glow Color. This swatch opens the color editor to select the color at 

the center of the glow. If the inside color is different than the outside color, 

a blend will occur between the two.

Inner and Outer Radius. These edit boxes contain values for the size of the 

effect. Within the inner radius it is opaque; the outer radius is where it 

becomes clear. To see these radii in the World View windows, enable the 

Show Glow Radius check box in the interface attributes section of the light 

info window.

Factor. This edit box indicates the rate (default is 1) at which the glow will 

drop off between opacity at the inner radius and transparency at the outer 

radius. It is an exponential function, and the higher the value, the greater 

the rate of drop off to the outer glow radius. 

Intensity. Intensity controls the density of the inner glow radius. A value of 

0.5 in this edit box will result in a glow of 50%.

Ray Factor. To decrease the darkness of the rays, enter a value between 

0 and 1 in the Ray Factor edit box—the smaller the number, the lighter (or 

with less contrast) the rays. The Ray Factor value defaults to 1.0, which pro-

duces very dark (high contrast) rays.
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Ray Sample. This attribute controls the grain present in the rays, enter a 

value in The Ray Sample edit box. The value in this edit box determines 

how many samples are taken to calculate the streak intensity through the 

cross-section of the spotlight cone. Increasing the value reduces grain in the 

rays (at the expense of processing speed, however).

Smoke Volume Selector Pop-up Menu. The Smoke pop-up menu is used 

to assign a smoke object to the light for creating smoke within the cone of 

the spotlight. It will list all smoke objects in the scene, from which you can 

choose one.

Creating Glow Effects

Glow lights must be configured before they can be used. The following 

steps represent the typical steps involved in configuring glow attributes for 

a light.

To configure a glow attribute for a light:

1. Select the desired light to add the glow effect
2. Open the Light Info Window for the selected light (command or con-

trol “i”)

The light info window will now open.

3. Click on the Show Glow Radius check box. This will allow you to see 
the area occupied by the glow region once you have entered the sizes 
for the inner and outer glow areas

4. Choose the Glow tab
5. Click on Enable Glow to activate the glow feature
6. Set the size of the outer glow region by typing in the desired size in 

scene units
7. Set the inner glow region by entering the desired size in scene units
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8. Click on the outer glow color swatch

The color picker will appear.

9. Select the desired color for the outer glow. Click the OK button to 
accept the color

10. Do the same for the inner glow
11. Set the glow intensity. For subtle glow effects, try numbers that are less 

than 0.25 intensity. Numbers greater than 0.50 will appear more styl-
ized or cartoon-like

12. Set the ray factor to determine the look of the glow transition from 
inner to outer radius (optional). 

Once the glow attribute for a light is configured, it is ready to be used in the 

scene and rendered. 

Creating a Volume Shadow with a Glow Light

Once you have created and configured a glow light, you can add a volume 

shadow or light ray to the light effect. Glow or fog attributes for a light 

must be enabled in order for the ray effect to be visible.

Volume shadows can be used to create natural shafts of light when applied 

to a glow or fog effect on a spotlight. When light rays are applied, the shaft 

of light will be partially blocked when it is interrupted by groups in your 

project. Since the shaft can be partially blocked, you can place cut-outs in 

front of the shaft to create shaped shadows and spots. In theatrical lighting 

terms, you can create gobos, cucoloris, and dingles.

Light rays do not pass through transparent groups or groups with transparency 

maps. This can be used to some advantage, however. A transparent (invisible) 

plane may be animated to cause the end point of the rays to move through space, 

creating exciting effects for logo work.
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To create volume shadows:

1. Select the light and open the Light Info window.
2. Choose Spotlight from the Light Type pop-up menu.

This sets the light type to spotlight.

Because the light streak effect uses the shadow buffer of spotlights to function, the 

light mode must be set to Spot and shadows must be enabled.

3. Follow the previous steps to configure the light for a glow effect
4. Click the Enable Ray check box to enable the volume shadow effect
5. Choose a smoke object from the Smoke pop-up menu (optional)

Volume shadows will now be rendered for any object which passes 

through the shadow cone of the light. If you choose a smoke object, you 

will notice significantly longer render times.

Creating Light Rays

Light rays are volume shadows with the invert Glow & Fog checkbox 

enabled. When enabled, this checkbox will convert the shadow into a lumi-

nous volume, as if streaks were emanating from the object (instead of a 

shadow.)
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Fog Tab

This tab contains all the information to set the fog properties of your light 

source.

The following attributes are available on the light fog tab:

• Enable Fog
• Volume Falloff
• Invert Glow & Fog
• Interpolate RGB
• Enable Ray
• Outside Glow Color
• Inside Fog Color
• Inner Radius
• Outer Radius
• Factor
• Intensity
• Ray Factor
• Ray Sample
• Smoke Volume Selector

Figure 6.10 —  Fog Tab
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Enable Fog. This check box option enables the fog effects for the light.

Volume Falloff. The Volume Falloff checkbox enables the volume dropoff 

value in the Properties tab to be used when shading the fog region. For more 

information, see “Additional attributes of Camera, Radial, Spot and Tube Lights:” 

on page 179.

Invert Glow & Fog. This feature will invert your light rays and other glow 

and fog light effects. For example, instead of your logo casting shadows 

within your light beam, you can have the logo actually cast the light beam 

for streak effects.

Interpolate RGB. The default color interpolation method for the glow 

attribute is HSV color space (hue, saturation and value.) This option will 

allow you to change the interpolation method to RGB color space (red, 

green and blue). HSV is a more natural form of interpolation, and will 

maintain the brightness of the colors in the glow region as the glow is ren-

dered. RGB is a more linear form of interpolation. When a glow region is 

calculated with RGB interpolation, the color values will dim and get 

muddy, and the brightness factor will decrease in this space. HSV bright-

ness values will remain constant throughout the region.

Enable Ray. This check box activates the light ray feature.

Outside Fog Color. This swatch opens the color editor to select the color at 

the edge of the fog. If the outside color is different than the inside color, a 

blend will occur between the two.

Inside Fog Color. This swatch opens the color editor to select the color at 

the center of the fog. If the inside color is different than the outside color, a 

blend will occur between the two.
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Inner and Outer Radius. These edit boxes contain values for the size of the 

effect. Within the inner radius it is opaque; the outer radius is where it 

becomes clear. To see these radii in the World View windows, enable the 

Show Fog Radius check box in the interface attributes section of the light 

info window.

Factor. This edit box indicates the rate (default is 1) at which the fog will 

drop off between opacity at the inner radius and transparency at the outer 

radius. The higher the value, the greater the rate of drop off.

Intensity. Intensity controls the density of the inner glow radius. A value of 

0.5 in this edit box will result in a glow of 50%.

Ray Factor. To decrease the darkness of the rays, enter a value between 

0 and 1 in the ray Factor edit box—the smaller the number, the lighter (or 

with less contrast) the rays. The Ray Factor value defaults to 1.0, which pro-

duces very dark (high contrast) rays.

Ray Sample. This attribute controls the grain present in the rays, enter a 

value in the Ray Sample edit box. The value in this edit box determines 

how many samples are taken to calculate the streak intensity through the 

cross-section of the spotlight cone. Increasing the value reduces grain in the 

rays (at the expense of processing speed, however).

Smoke Volume Selector Pop-up Menu. The Smoke pop-up menu is used 

to assign a smoke object to the light for creating smoke within the cone of 

the spotlight. 
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Creating a Volume Shadow with a Fog Light

The procedure to creating volume shadow effects with fog lights is exactly 

the same with glow lights, with the exception that you are working in the 

fog tab. Please see the discussion topic in the Glow section.

Projection (Map) Tab

Projection maps are controlled from this tab. Projection maps are single or 

multiple frame image files, which are projected along the a light’s direction 

vector. Any light that can cast a shadow can cast a projection map. Each 

shadow casting light is allowed one projection map only.

Light projection maps are simpler than camera projection maps. Light pro-

jection maps can be used to simulate movie or slide projectors, bulb pat-

terns that are common with flashlights, and so on. In fact, you can think of 

them as texture maps for lights. Some of the texture map controls are also 

used in the projection map sub-tabs, covered below.   

This tab contains buttons to add and delete projection maps, and small 

thumbnail representation of the RGB and Alpha channels of the loaded 

map. This tab also contains several sub tabs:

• X-form
• Properties
• Info
• Crop
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Projection Map: X-Form Tab

The Projection Map X-Form (Transformation) tab is used to control the 

position of the map in the light’s local space. The position edit boxes con-

trol the X and Y position of the map. The scale edit boxes control the X and 

Y scale of the map. The Align popup menu (shown extended in the figure 

below) eases map alignment and fitting. They are discussed below.

• Fit Outer Cone (Default)
• Fit Within Inner Cone
• Fit Without Inner Cone
• Fit Within Outer Cone
• Fit Within Outer Cone

Fit Outer Cone (Default). This option distorts the projection map to fit 

inside of the outer cone of the spotlight. Do not use this option if you wish 

to maintain the map’s aspect ratio.

Figure 6.11 — Projection (Map) Tab: X-Form Tab
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Fit Within Inner Cone. This option fits the rectangular extent of the projec-

tion map to the inside of the inner cone of the spotlight. The map’s aspect 

ratio is presented without distortion.

Fit Without Inner Cone. This option fits the rectangular extent of the pro-

jection map to the outside of the inner cone of the spotlight. The map’s 

aspect ratio is presented without distortion.

Fit Within Outer Cone

This option fits the rectangular extent of the projection map to the inside of 

the outer cone of the spotlight. The map’s aspect ratio is presented without 

distortion.

Fit Without Outer Cone. This option fits the rectangular extent of the pro-

jection map to the outside of the outer cone of the spotlight. The map’s 

aspect ratio is presented without distortion.

Projection Map: Properties Tab

The Projection Map: Properties tab is used to control the properties of the 

projection map. Illustrated below, the tab is divided up into several compo-

nents: Tiling popup menus; Samples edit box; Blur edit box; and a series of 

checkboxes.
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Tiling Popup Menus. The tiling section controls the repeat functions of the 

map if it is scaled at less than 1.0 (scale functions are found in the Projection 

Map: X-Form tab.) There are four options for each popup menu: 

• None
• Hold
• Repeat
• Mirror

None. Disables mirroring of the map on the specified map axis. Choosing 

None for both axes will cause the map to be displayed only where you 

positioned it, nowhere else.

Hold. Applies the colors found at the map edges outside of the actual 

image rectangle. (The map will appear once as positioned, with the border 

colors of the image extending beyond the image rectangle, covering the 

frame.)

Figure 6.12 — Projection (Map) Tab: Properties Tab
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Repeat. Repeats the map along the specified axis. Choosing Repeat for both 

axes will cause the map to repeat continuously within the cone of the light, 

depending upon the scale of the map.

Mirror. Mirrors the map along the specified axis. Choosing Mirror for both 

axes will cause the map to flip flop about both axes.

Samples Edit box. This edit box lets you determine the sampling quality of 

the map. The default is 5.0. Numbers greater than 5 will cause the map to 

be sampled more often, slowing down render time, but increasing the qual-

ity of the map. Numbers less than 5 will cause the map to be sampled less 

often, speeding up render time, but decreasing the quality of the map. 

Numbers greater than 10 might be prohibitively slow. 5 is a good default, 

and you will likely not need to deviate from that amount.

Blur Edit Box. This edit box lets you blur the map. The default is 1.0. This 

value will present the map as is. Values of greater than 1.0 will blur the 

map. For example, a value of 2.0 will produce a blur of two pixels for every 

one encountered in the map. Values less than 1.0 will sharpen the map, 

although it will also introduce aliasing (jagginess) into the map.

Quality Control Check Boxes

There are four check boxes which let you control the quality of the map:

• Interpolate
• Anti-Alias
• Invert RGB
• Invert Alpha
208       EIAS Animator   



Chapter 6  Lights in EIAS Animator — Projection (Map): Info Tab
Interpolate. Enables map filtering. Necessary to avoid moire patterns in 

the map as it rotates off axis.

Anti-Alias. An additional level of filtering for image quality. Not always 

necessary, and can soften the look of the map.

Invert RGB. Negates the RGB channels of the map for special effects.

Invert Alpha. Negates the Alpha channel of the map. This feature comes in 

handy when you aren’t sure how to design the alpha channel of the map.

Projection (Map): Info Tab

The info tab contains information about the projection map, as well as any 

cropping that you may have performed on the map.

Figure 6.13 — Projector (Map): Info Tab
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Projection (Map): Crop Tab

The crop tab displays a reduced version of the map and allows you to crop 

within it, so you can use just a section of the map. To crop, click anywhere 

on the “crawling ants” border around the edge of the map in the rectangle. 

Clicking on the edges of the map will drag the entire side of the map. Click-

ing on the corners of the map drags the corner inward. To reset the map, 

drag the borders to the extents of the image. 

Adding Projection Maps

The process of adding projection maps to a light is straightforward. There 

are two different looks that you may wish to achieve, as illustrated:

• Projection maps with no additional effects
• Projection maps with volume shadows or light rays

To add a projector map with no additional effects:

1. Click on the Add button
2. Select an image file
3. Double click the file or click on the Open button

The map is now ready for use. The light will now project the loaded image, 

as you have configured in the previous sections.

To add a projection map with volume shadows or light rays:

1. Follow the previous steps to add an image to a light for projection
2. Configure the glow or fog sections as described in previous steps, mak-

ing sure that shadows are enabled
3. Determine the effect type to use (volume shadow or streaks) and set 

the Invert Glow & Fog check box accordingly
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These settings will allow the projected map to generate colored streaks 

across the scene.

6.6 Smoke

Smoke is a mathematical function generator that adds noise patterns to 

light rays. The noise patterns will appear to create smoke within the cone of 

a spotlight. To use this feature, light rays must be configured for the spot-

light, as described in the previous section.

To create smoke:

1. Add a smoke object to the project.

From the Object menu choose Add Smoke.

2. Click and drag in one of the World View windows to place the smoke 

object.

The smoke object appears as a box in the View windows. The size of the 

box is determined by the size of the rectangle you drag when you place it. 

The first smoke object added to a project has a default name of “Smoker 1”. 

Subsequent smoke objects are numbered 2, 3, etc.

You do not need to place the smoke object in front of a light in order for the 

smoke effect to be seen in that light. you can therefore use the same smoke 

object for multiple lights. When you animate the smoke object’s position 

and rotation, the smoke within the cones of all spotlights to which the 

smoke object is assigned will appear to shift.
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3. Select the light to be configured for the smoke effect and open it’s Light 

Info window.

4. Configure the light for light rays.

• Choose Spot from the Light Type pull-down menu.
• Enable Buffer shadows from the Shadow tab.
• Choose Enable Glow or Enable Fog from the Glow/Fog tabs and con-

figure the glow/fog fro color, radii, factor and intensity.
• Choose Enable Ray from the Glow/Fog tab.

5. Select the smoke object from the Smoke pull-down menu in the Glow/

Fog tab.

The Smoke Info window, as shown below, opens.

6. Use the controls of the window to configure the smoke to your liking. 

Figure 6.13 — Smoke info Window X-Form Tab
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Show Extent. This check-box option, enabled by default, toggles the dis-

play of the smoke object in the World View windows

Scale. This edit box contains a value that determines the scale at which the 

visible portion of the smoke effect is rendered. The greater the value, the 

smaller the “blobs” of smoke.

Position, Rotation and Size. These edit boxes contain values that define 

the smoke object’s position rotation (orientation) and size in world space.

Mist. This edit box contains a value in the range of 0 to 1 that sets the ambi-

ent smoke level. A value of 0 is no ambient (rays will not show at all). A 

value of 1 creates a solid white smoke volume.

Contrast. This edit box contains a value that controls the contrast between 

the light and dark regions of the smoke.

Density. This edit box contains a value that controls how much smoke is in 

the unit volume. A value of 0 is a completely smokeless volume. A value of 

1 causes the smoke function to be enabled throughout the volume.

Figure 6.13 — Smoke info Window Properties Tab
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Noise. This edit box contains a value of 0 to 1 that controls the detail in the 

smoke. Values below 0.5 give a smoother effect. Values above 0.5 add more 

detail to the smoke. If you increase the noise value past 0.5, try increasing 

the Linear Detail value (discussed below) as well.

Samples. This edit box contains a value that determines whether the 

smoke is 2-dimensional (value 1) or 3-dimensional (value>1). 2D smoke 

will render much faster than 3d, but if you need to move the camera 

through the scene, 2D smoke will appear flat.

Limit. This edit box contains a value that applies only if the Samples value 

is greater than 1. It limits the maximum number of depth samples to be 

evaluated for the smoke. Setting the value above 200 will increase the ren-

dering time.

Bicubic Detail. This edit box contains a value that controls how many frac-

tal levels are created using bicubic computation. Bicubic computation pro-

duces smoother areas of smoke, but at the expense of slower rendering 

times. The higher the value, the greater the detail in the smoke. Both bicu-

bic and linear computation (below) can be used together.

Linear Detail. This edit box contains a value that controls how many frac-

tal levels are created using linear computation. Linear computation pro-

duces ridge-like, horizontal and vertical areas of smoke, less “realistic” 

than bicubic detail but faster to render. The higher the value, the greater the 

detail in the smoke. Both linear and bicubic computation (above) can be 

used together.

Octave. This edit box contains a value that controls how many layers of 

turbulence appear within the unit cube of smoke. The layers default paral-

lel the XZ axis. Changing the Rotation value will change this orientation.
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Drift. This edit box contains a value that moves the layers through the tur-

bulence. The range of possible values is dependent on the number of layers 

you create using the Octave setting. Plus 1.5 will move one and a half lay-

ers through the turbulence.

Turbulence. This check-box option and edit box enables a turbulence func-

tion that mixes the layers of smoke into each other. The edit box contains a 

value from 0 to 1 that controls how much the layers are folded into each 

other. A value of 0 keeps the layers separated. A value of 1 completely 

mixes the layers together.

Preview Window. This window is used to obtain a preview of the smoke 

effect that will appear in the smoke object. If the smoke is 3D, as set in the 

Samples edit box, the view will represent a slice of the smoke.

Offset. These edit boxes contain values that offset the image in the preview 

window. Values of 0 for the X, Y, and Z edit boxes center the image in the 

preview window. Scrolling the preview window will change the values in 

the edit boxes. Offsetting the Z value changes the depth at which the view-

ing slice is take.

Depth. This edit box contains a value that corresponds to the depth of the 

slice shown in the preview window for a 3D smoke effect.
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6.7 Master Lights

Master lights are lights which control the illumination properties of other 

lights. Think of a master light as a light switch. Turn on the master lights, 

and the other lights in the “circuit” are also turned on. Dim the master 

light, and the other lights in the circuit dim by the same amount.

You decide which properties you want a light to inherit from a master light. 

The properties available for inheritance are:

• Inherit Visibility
• Inherit Intensity
• Inherit Dropoff
• Inherit Color
• Inherit Attributes
• Inherit Shadow
• Inherit Glow
• Inherit Fog
• Inherit Flare
• Inherit Projection
• Inherit Caustics

Figure 6.14 — Master Light Tab
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Inherit Visibility. This setting allows the master light to control the visibil-

ity of the subscriber lights. If the master light is made invisible, then the 

subscriber light will also be invisible.

Inherit Intensity. This setting allows the master light to control the inten-

sity of the subscriber lights. If the master light’s intensity attribute is modi-

fied, then the subscriber light will also be modified.

Inherit Dropoff. This setting allows the master light to control the dropoff 

of the subscriber lights. If the dropoff of the master light is made changed, 

then the subscriber light will also be changed.

Inherit Color. This setting allows the master light to control the color of the 

subscriber lights. If the master light is made red, then the subscriber light 

will also be red.

Inherit Attributes. This setting allows the master light to control the light 

size and dropoff factor of the subscriber lights. If the dropoff factor or the 

size of the light is changed on the master light is made invisible, then the 

subscriber light attributes will also be changed.

If you need only the dropoff factor attribute, make sure that the light size of the 

master light is 0.0. If you need only the lightsize attribute, make sure that the 

dropoff factor is 0.0 for the master light.

Inherit Shadow. This setting allows the master light to control the shadow 

attributes of the subscriber lights.

Inherit Glow. This setting allows the master light to control the glow 

attributes of the subscriber lights. 

Inherit Fog. This setting allows the master light to control the fog attributes 

of the subscriber lights.
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Inherit Flare. This setting allows the master light to control the lens flare 

attributes of the subscriber lights. 

Inherit Projection. This setting allows the master light to control the light 

projection map attributes of the subscriber lights.

Inherit Caustics. This setting allows the master light to control the caustics 

attributes of the subscriber lights.

Creating a Master Light

Creating a master light is different than adding or creating a master mate-

rial in a project. While master materials can be loaded from external files, 

master lights cannot. Instead, they must be created from an existing light. 

That light is still used to add illumination to a scene, but it can also pass 

along its functions to subscriber lights. Subscriber lights can determine 

which attributes they wish to inherit from master lights.

Master light attributes that are passed to subscriber lights are light attribute data 

only. No transformations or rotations are passed within this relationship (the same 

as master materials). If you wish to pass along transformation information to sub-

scriber lights, you must use the hierarchy tools to assign that relationship.

To create a master light in a scene:

1. Open the project window (command or control “l”)
2. Pick a light to designate as a master light
3. Set the light’s attributes as desired (optional, this can be done at any 

time)
4. Name the light appropriately (such as “dining room master”)
5. Using the label function in the project window, assign a color to the 

light’s name. This and the above step will help to identify the master 
light in the various view methods of the project window
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Follow the next few steps to complete the process.

Assigning a Subscriber Light to a Master Light

Once a master light is created from an existing light in the scene, you are 

able to add subscriber lights to the master light. Subscriber lights can deter-

mine which attributes they wish to inherit from master lights.

To add a subscriber light to a master light:

1. Open the project window (command or control “l”)
2. Choose the subscriber light
3. Pick the “Assign Master” icon in the project window menu bar
4. Select the desired master light from the object list in the project win-

dow
5. Open the light info window for the subscriber light, and choose the 

master tab
6. Choose which attributes you wish to inherit from the master light

The master/subscriber relationship is established between the lights. Sub-

scriber lights can be assigned to only one master light. Master lights cannot 

be assigned to other master lights.

Viewing the Master Light Hierarchy

When you assign a master light, you will not see the relationship indicated 

in the project window, unless you have previously set the window to 

“View Master lights.” If you need to see a visual confirmation of the rela-

tionship, then use this option. Remember, the master/subscriber relation-

ship exists outside of the normal scene hierarchy, which allows you to 

parent the light to a completely different object, and still maintain the mas-

ter/subscriber relationship.
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6.8 Radiosity Tab

This tab contains the settings for the Radiosity intensity of the light. For 

radiosity information please see “Light Info Window, Radiosity Tab” on 

page 305.

6.9 Caustics Tab

Caustics are created when light is focused on a surface. Light can be 

focused by refractive (transparent) objects - wind blown water on the sur-

face of a pool causing light ripples on the pool’s bottom. Caustics can also 

be caused by purely reflective objects - a metal ring casts a unique caustic 

on the surface upon which it sits. 

Figure 6.15 — (a)Refraction Caustics  and   (b)Reflection Caustics 

a                                                      b
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Light sources cast caustics on to objects in the scene. Objects have separate 

material settings for casting and receiving both refraction and reflection 

caustics. For more information on the material property settings see“Mate-

rials and Texture Maps” on page 431. 

Parallel, Radial and Spot lights can cast caustics. The Caustics tab contains 

the interface elements that enable and control the creation of caustics maps 

(also called photon maps). 

Generate Caustics Map. Turn this checkbox when you want the light to 

create caustics. Parallel, Radial and Spot lights can generate caustics.

Photon Density. This is the number of photons that will emitted by the 

light per square scene unit. 

Control Distance. By default (value = 0) the caustics engine automatically 

disperses the photons to match the size of the overall scene. One way it 

does this is to keep the density of photons constant throughout. In the real 

world, the photon density would fall off with the square of the distance 

Figure 6.16 — Caustics Tab 
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from the light source. Thus, in reality caustics fade with distance from the 

light source. To get this ‘real world’ effect you must set a scene distance 

from the light source to the point where you want the caustics effect (the 

photon density) to be greatest. Note: This control is available for Radial and 

Spot lights only. 

Caustics Tips

Refraction caustics are very sensitive to the index of refraction of the gener-

ating group.For example, the index of refraction of water varies with tem-

perature and salinity. Water may have an index of 1.3 or 1.35, and the 

rendered results will show significant differences. You might wish to ren-

der a a test animation where you vary the index of refraction over time. 

This will give you a better idea of how the index is going to affect your 

scene.

The caustics use the light’s color multiplied by the diffuse color (for reflec-

tive caustics) or by the transparency color (for refractive caustics).

Because caustics are a ‘magnified lens’ effect, small defects in your models 

can translate into dramatic caustic effects. Sometimes you may want to use 

this to generate more interesting caustics. A little bump map may also 

make the caustics more impressive.

Objects that have materials set to generate raytraced transparency will 

always receive caustics. 

To create caustics in your scene make sure at least one of the lights has 

caustics enabled and enable at least one of your objects to cast reflection or 

refraction caustics in its Material Info window.

Default material settings are set to receive refraction and reflection caustics.
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6.10 Illuminators

An Illuminator is an array of lights in a Dome-like or Box-like pattern. It 

can be used to create natural, day-lit lighting effects. 

Illuminators are added by selecting Add Illuminator from the Object menu 

(Object > Add Illuminator). Click in one of the World View windows to 

define the center and then drag out the desired stage radius. Release the 

mouse button to complete the operation. A Dome Illuminator is added to 

the Project window and the World View windows.

Note Illuminators are drawn using the light color parameter. The default light color is 

white. If the background color of the World View windows is also white, you won’t 

see the Illuminators in the windows. We suggest setting the background color of 

your World View windows to a light gray.

Illuminator Light Info Window

Double clicking on an Illuminator to open up its Info window. Comparing 

the Light Info window for an Illuminator to one for a regular light source 

you’ll notice that the Flare, Glow, Fog, and Projection tabs are missing. Illu-

minators are do not support these options. 

Figure 6.17 — Illuminator in Project Window
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Samples Illuminators are arrays of radial or parallel lights. The lights are distributed 

on the dome or the rectangle (depending on the Stage Type) in a random 

pattern. The number of individual lights that are distributed is controlled 

using the Samples parameter in the Properties tab of the Info window.

Stage

Radius

The Stage Radius controls the overall size of the Z-buffer shadow that is 

optionally cast by the Illuminator. You can go into the Shadow tab and set 

the usual shadow parameters. We suggest softening the overall effect of the 

shadows. This makes for a more pleasing effect. 

You can also set the Illuminator to cast raytraced shadows. Please keep in 

mind that, for 20 samples, you would be adding 20 raytraced shadows to 

your scene. This will have an adverse effect on render times.

Each shadow cast by a sampled light falls on the center of the Illuminator 

stage because each of the sampled lights is pointed from their positions on 

the dome or box toward the center of the stage. 

Figure 6.18 — Illuminator Light Info Window
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Light Type You can choose to have either Radial lights or Parallel lights distributed 

across the surface of the Illuminator

Stage

Type

The Stage Type: pull-down menu to changes the Illuminator type from 

Dome to Box. Box lights have Height, Width, and Length dimensions that 

define the outer shell that the lights are distributed on. They behave in all 

other respects just like the Dome Illuminators.

Figure 6.19 — Dome Illuminator—As Shown in World View Windows

Stage
Radius

Radius
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Figure 6.20 — Box Illuminator—As Shown in World View Windows

Stage
Radius

Height

Length

Width
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Gel Tab

As discussed above, Illuminators are arrays of lights. The Gel tab allows 

you to automatically assign colors to the lights based on the colors in a tex-

ture map. The map itself is never passed to the renderer. Instead,. the vari-

ous lights in the array are given colors based on the texture.

The Gels are shown in the view windows projected onto the stage of the 

illuminator. This can aid in remembering which illuminator is casting 

which gel.

Enable This checkbox can be used to disable the Gel.

Add/Del Click the Add button to open a file dialog box and select the texture map, 

animated texture map or numbered texture sequence to use for the Gel. 

Figure 6.21 — Illuminator Light Info Window - Gel Tab
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You can also pick a lightprobe (.hdr) file directly. When you do this, the 

Center Weight exposure will be used ( See “Spot Meter” on page 57.).

Fisheye This causes the Gel system to choose colors from a photograph taken with a 

fisheye lens.

Skydome Use this option if you have a flat map that you want to apply as a Gel.

Light-

probe Top

and Bot-

tom

You can hit the Add button and select a lightprobe (.hdr) file directly. If you 

do this the Center Weight exposure setting will be used ( See “Spot Meter” 

on page 57.) However, if you want to choose your own exposure setting, 

open the .hdr file using the View Image command (CMD-B on Macintosh   

CTRL-B on Windows), pick an exposure, and save the image as Longitude/

Latitude (See “Convert Lightprobe” on page 55.) Then apply that map to 

the Gel. 

Since the Illuminator is a hemisphere and the lightprobe is a full sphere, 

you must choose to apply the top or the bottom half of the image as a Gel. 

Sequenc-

ing

You can use an animated texture map or a numbered sequence of texture 

files as a Gel. Animator will recolor the lights in the array each frame of the 

animation to match the changing colors in the textures. For information on 

using the Start Frame, Frame Range, and Frame rate edit boxes, please See 

“Start Frame” on page 496.

Cropping You can select to use a portion of the map as a Gel. You can type numbers in 

the edit boxes or interactively drag the cropping rectangle from the edges 

of the image.
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Using Illuminators

Because Illuminators focus their attention on a single point in your scene, 

the center of the stage, they are best suited for lighting a discrete object or 

region. One rewarding technique has been to use two Illuminators, one 

pointing down from above and one underneath pointing upwards. The 

Illuminator underneath acts to ‘reflect’ light back up from the stage. This 

Illuminator is given a lower light intensity value and a color in keeping 

with the object on the stage.
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Backdrops, Fog and the World Info Window

7.0 Introduction

Backdrops and fog help to create a variety of locations, times of day and 

weather conditions. Used in conjunction with other rendering features, 

backdrops and fog can produce striking results. EIAS Animator puts these 

controls in the World object, along with background image color, scene 

ambient values, and global reflection maps. Unlike other objects in EIAS 

Animator, the world object is more like a “meta object.” Rather than occu-

pying a particular location, the world objects exists everywhere in the 

scene. Like other object classes in EIAS Animator, the attributes in the 

world object can be animated. There are more than 100 potential animation 

channels for the world object, and even more when you add global reflec-

tions.

The world object does not officially occupy a space. It cannot be included in 

a hierarchy. It has no groups included within it. The world object is listed 

only in the Project Window.

7.1 World Info Window Overview

The World object is included in every project, and is presented at the top of 

the Project Window List. Like other objects and groups in EIAS Animator, 

the world object has its own information window.

Figure 7.0 — The World icon in the Project window
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There are two ways to access the World Info Window: 

• Double click the World icon in the Project Window
• Select the World Icon in the Project Window and choose Object>World 

Info (Mac, command-I) (PC, Control-I)

7.2 Fog/Ambient/BG Tab

The Fog/Ambient/BG window contains three sections:

• Fog controls
• Ambient Color control
• Background Color control

Figure 7.1 — World info window
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The Fog Controls

Fog, or Fog Projection, simulates atmospheric depth cuing. Atmosphere 

has depth because of particles contained within it, which gives Fog the 

appearance of being more dense the further away it is from the Camera. 

While it can simulate distant haze or fog in a landscape, it does not induce 

atmospheric effects such as visible light shafts or shadows.

There are a number of items in the Fog Controls section:

The Enable checkbox

This checkbox enables the Fog effect. It defaults to off.

Color

Clicking this box will bring up the EIAS Color Picker. There, you can select 

a color for your fog.

Mode

This menu determines the type of transition that will occur between the 

region in which the fog effect starts, and the region in which the fog reaches 

its maximum density. (The fog region starts at the center of the active cam-

Figure 7.2 — Fog control window
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era body and extends outward in all directions by the specified distance.) 

There are four choices under this menu:

• Linear
• Exponential
• Non Linear 1
• Non Linear 2

Linear. Linear gives an even increase in the density of the fog region. The 

rate in which density increase will be constant throughout the length of the 

fog region, as defined by the Radius boxes (below.)

Exponential. Exponential will calculate the density of the fog in a more 

realistic, non-linear fashion. This option renders results similar to Pixar’s 

RenderMan® fog shader. 

Non Linear 1. Non Linear 1 will calculate a gradual slope in fog density, 

topping out to a sharp curve. This choice amounts to a significant accumu-

lation of fog towards the end of the fog region.

Non Linear 2. Non Linear 2 will calculate a sharper curve flowing towards 

the top, and then flattening out (in an arc-like fashion). The change in fog 

density will be greater at the beginning of the region, and change less 

towards the end of the region to the maximum value.

Fog To

This menu determines the type of fogging technique to be used. There are 

three choices under this menu:

• Color
• Alpha
• Background
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Color. Color will calculate fog to the color specified in the Fog Color box. 

As the fog gets further and further away from the Camera, it will become 

closer and closer to the specified color. This is exactly the same as doing a 

gradient fill in a paint program, where the gradient tool is set to fade from 

transparent to a color. No matter what color you may have selected for a 

Background Color, the fog will calculate to the designated fog color.

Alpha. Alpha will calculate the fog to an alpha value of 0, which is totally 

transparent. When this is digitally composited over a background image, 

the objects enveloped by the fog will eventually fade out to the composited 

background.

Background. Background calculates the fog to the background color, as set 

in the Background Color box.

This is essentially the same as the first option, Color. The difference, how-

ever, is that while Color calculates the fog to the color designated in the fog 

color box, Background calculates the fog to the designated Background 

Color.

Radius

These edit boxes contain values that define the inner and outer fog radii of 

the camera. The first box represents the point where the fog will begin, and 

the second box designates where the fog will end. These two values are 

known respectively as the Inner Radius and Outer Radius.

The inner and outer fog radii are drawn in the world view windows as two 

discs which appear in the camera view frustrum (visible when “show 

angle” is selected for the camera). These discs are only visible if the camera 

is selected, and if Show Fog is checked in the Camera Info window.
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Amount

These boxes function in essentially the same way as the fog radius boxes. 

However, instead of determining the start and stop points of the fog radius, 

they determine the opacity value of the fog at the start and stop points. 

These values in these boxes range from 0 to 1, with 0 being 100% transpar-

ent and 1 being 100% translucent.

While it is possible for you to enter a higher value than 1, you will not ever 

get a value higher than 100%, so make sure you don’t enter a value of any-

thing other than numbers between 0 and 1 in these boxes.

The first box shows the fog opacity value between the camera and the inner 

radius. The second number designates the opacity value at the outer radius 

and beyond.

The Ambient Color Controls

The Ambient Color Controls set the color of global ambient light in a scene. 

There are two items in this section:

Enable

This checkbox enables the ambient light effect. The default is off.

Figure 7.3 — The Ambient Light Control
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Color

Clicking this box will bring up the EIAS color picker. There, you can select 

a color for your ambient light.

The Background Color Controls

The Background Color Controls set the color of the background in a scene. 

When unchecked, the default black background will be rendered in your 

scene. 

Note The background color is actually colorizing the alpha channel of the image. If you 

import a 32 bit EIAS Animator file into an application such as Adobe ®Photo-

shop®, the background will appear black, regardless of the color you have set. This 

occurs because Photoshop does not support colorized alpha channels. 

There are two items in this section:

Enable

This checkbox enables the background color. The default is off, which pro-

duces a background color of black.

Color

Clicking this box will bring up the EIAS color picker. There, you can select 

a color for your background.

Figure 7.4 — Ground Color Controls
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7.3 Backdrop Tab

The World Info Window contains features under the backdrop tab that pro-

cedurally generate ramped color sky and ground planes. This feature can 

be used while initially setting up your project to give your test renderings a 

better sense of scale.

There are two main sections in this window:

• The Sky Controls
• The Ground Controls

Sky

The Sky Controls give you the ability to designate custom background col-

ors sky. There are four items in this window:

• The Enable Check Box 
• The Horizon Color Box
• The Zenith Color Box 
• The Transition Box 

Figure 7.5 — The Backdrop Tab
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The Enable Check Box. This check box enables the sky color effect. The 

default is off.

The Horizon Color Box. Clicking this box will being up the EIAS color 

picker. There, you can select a color for the sky at the horizon line.

The Zenith Color Box. Click this box to enter a color value for the sky at 

the Zenith line.

Note The Horizon is the point at which the sky meets the ground. The Zenith is the 

upper region of the sky that is positioned directly above the camera.

The Transition Box. This value sets the midpoint of the transition between 

the Horizon Color and the Zenith Color. Higher values move the midpoint 

closer to the horizon, thus showing more of the zenith color. Lower values, 

such as the default 1, will show more of the horizon color.

  

The default sky colors The sky colors with a transition of 3

Figure 7.6 — Setting sky color transitions
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Ground 

The Ground Controls function in exactly the same manner as the Sky con-

trols do. There are four items in this window:

• The Enable Check Box 
• The Horizon Color Box 
• The Nadir Color Box 
• The Transition Box 

The Enable Check Box. This check box enables the ground color effect. The 

default is off.

The Horizon Color Box. Clicking this box will being up the EIAS color 

picker. There, you can select a color for the ground at the horizon line.

The Nadir Color Box. Click this box to enter a color value for the ground at 

the Zenith line.

Note The Horizon is the point at which the ground meets the sky. The Nadir is the lower 

region of the ground that is positioned directly below the camera. The Nadir is dia-

metrically opposed to the Zenith.

The Transition Box. This functions in exactly the same manner as the sky 

transition box. Higher values move the midpoint closer to the horizon, thus 

showing more of the nadir color. Lower values, such as the default 1, will 

show more of the horizon color.
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Note When both items are enabled at the same time, the following image appears when 

rendered:

The default ground colors The ground colors with a transition of 6

Figure 7.7 — Setting Ground Color transitions

Figure 7.8 — A rendering with the default settings
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7.4 The Global Reflection Tab

The third tab contains a list of Global Reflection maps that are accessible in 

each group's material interface.

To add a reflection map to this window, click the Add button. A standard 

Open dialog will appear. Simply navigate through your computer, find the 

map you wish to add, and select Open.

When setting an object’s reflectivity value in the material editor, you will 

notice a check box called Use Global Reflections. Any object that has this 

item checked will reflect the reflection maps added to this window.

7.5 The Raytrace Tab

The raytrace tab is used to set the global refraction index for the scene. The 

global refraction index covers all space that is not assigned with a refrac-

tion index. The default is 1.0, which is the index of refraction for air on the 

earth’s surface.

The global index of refraction value is necessary when you are dealing with 

non-earth atmospheres. For example, if you are raytracing an underwater 

scene, you would want to set the global index of refraction to roughly 1.33, 

which is the index of refraction for water (not allowing for different levels 

of seawater salinity around the world.)

Figure 7.9 — The Global Reflection Tab
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The global index of refraction is used only when raytracing, and again, 

only in those volumes that do not have an index of refraction that is speci-

fied in the object’s material definition (transparency tab of the material edi-

tor.)

7.6 The Glow Layer Tab

Any group can be given a gaussian glow that emanates outward from that 

object. Additionally, groups of layers can be defined, each with its own 

glow radius and intensity. 

Figure 7.10 — The Raytrace Tab

Figure 7.11 — The Glow Layer Window
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There are three sections in the glow tab:

• Glow Layer List
• Glow Layer Members List
• Configuration Section
•
Glow Layer List. A glow layer contains glow attributes which apply only 

to members of that layer. To add a glow layer:

1. Click the Add Button Next to the Glow Layer list
2. Name the layer
3. Click OK

A new glow layer is added to the list.

Glow Layer Members List. Glow layer members are selection sets. In 

order for groups to use their glow effects (applied as a material), the groups 

need to be in a selection set contained within a glow layer. To add a selec-

tion set to a glow layer:

1. Select a glow layer
2. Click the Add button next to the glow layer member list
3. Pick a selection set form the list
4. Click the Add button

The selection set is now added to the glow layer.
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Glow Configuration Section. The appearance of the glow layer is a combi-

nation of the material attributes of the glow, as well as the settings in the 

Glow Radius and Glow Intensity edit boxes, shown below. 

Glow Radius. The pixel area of the glow. This is the area of the image that 

will have a glow effect applied to it. Smaller values are good for objects that 

you wish to appear brighter in a scene, while larger values are better for 

simulating effects such as glare.

Glow Intensity. This value controls the brightness of the glow. Glows are 

added on top of the rendered scene, therefore a value of 1.0 would produce 

a glow that is twice as bright as the original image without glow.

Although glow layers and sets may seem a bit complex at first, once you 

get the hang of it you will begin to understand the potential. Rather than 

having to manually tweak settings for each separate glow effect you can 

simply define a series of standard effects and apply those to the appropri-

ate sets at render time. For instance, you could come up with a set of glow 

layers to simulate fire, candles, tv monitors, spaceship exhausts, light 

bulbs, etc. Once you have a series of defined glow layers they can easily be 

assigned to any set of objects you’ve created. Additionally, since Glow 

Figure 7.12 — The Glow Layer Window with Glow Layers and Layer Members
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radius and intensity can vary by layer, a series of complex effects and lay-

ered glows can be created.
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Rendering

8.0 Introduction

Rendering is the process in which all of the elements in a scene (models, 

lights, cameras, textures, etc.) are combined, and used to generate a final 

picture or movie. It is analogous to the photographic exposure of a scene 

recorded by the film in a camera. EIAS is known to have the world’s fastest 

3D rendering engine. That is not an idle boast. From time to time we often 

compare the variety of 3D software programs with our own, comparing 

features and timings. In most cases with the most popular of our competi-

tors, ElectricImage EIAS is typically 6 to 15 times faster to create the same 

image. Often our image quality is superior, as faster render times let us per-

form better anti-aliasing.

The EIAS rendering engine, EIAS Camera, was designed from the ground 

up as a motion picture production rendering system. It can handle an 

incredible amount of data (currently topping out at 30,000,000 polygons, 

although this is an artificial limit) in a very short amount of time. 

EIAS Camera is a hybrid render/raytracer. Wherever possible, the stan-

dard rendering engine will be used. However, if you specify a material 

attribute that requires raytracing, and the Camera format is set to Raytrace 

(Render information window, Render tab), then raytracing will be used.

Rendering is very different from ray tracing. Rendering requires more 

hands on attention than ray tracing, especially when dealing with shad-

ows, and to a lesser degree, reflections. The approximate results that you 

achieve through these methods are good, and have been production-

proven. That said, the raytracing engine in EIAS Camera is fast, and gener-

ates beautiful imagery. You may find that you begin to favor raytraced 
EIAS Animator        247



Chapter 8  Rendering — Render Information Window
options over time, as they are far easier to deal with. This will be especially 

true as computers improve in their processing power, and thus produce 

images more quickly.

Note Motion vector blur, also known as “2D blur” will provide inconsistent results 

when raytracing. Reflected objects in motion will not be properly motion blurred, 

for example. The best solution to this is to use the Multi-frame blur (also known as 

“3D blur”), or a combination of the two methods. Be warned, however, render 

times will be longer...

When rendering and raytracing imagery, EIAS Camera transforms the 

models into optimal segments for rendering speed, caches the texture maps 

to RAM (or the hard drive), generates shadow maps and color buffers, and 

then applies the desired shading algorithm and render settings to the 

geometry in the scene. It is also during this stage that effects like anti-alias-

ing, motion blur, and glow are applied. All of these complex processes take 

place transparently to you after clicking on Go to launch the render. It is in 

the Render Information Window that the settings which control all these 

various rendering parameters are applied.

8.1 Render Information Window

In order to give the user maximum control over all aspects of the rendering 

process, the Render Information window in EIAS Animator is divided into 

folder tabs. This chapter will explore each of these sections and explain 

what their functions are, as well as how these settings affect other group 

and object settings.
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There are two ways to access the Render Info Window:

• Choose Render> Render Settings from the main menu bar 
• Type command-r (PC control-r)

The Render Info Window will then appear.

This is the window where general rendering parameters are set, such as the 

global shading level, color depth, and the image format. This is also where 

global rendering flags are set, allowing the user to enable and disable spe-

cific parameters on a per-render basis. Each of these areas is explained in 

depth in this section.

8.1 The Render Tab

The render tab in the Render Information Window contains global shading 

level attributes for shading method, image quality, format, activation flags 

and gamma control.

Figure 8.0 — The Render Info Window
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The Camera Menu

This menu sets the maximum shading level for the rendering. The default 

is Raytrace, and this will provide the highest quality rendering. If this glo-

bal shading level is set to a lower quality than an individual group or 

object’s shading level, the global setting will override the objects’ setting. 

For instance, if an object is set for Phong shading and the global is set for 

Flat shading, the object will be rendered using flat shading. This allows the 

user to render an entire scene quickly using a lower quality shading level 

for motion tests and other previews. However, if the global is set to a 

higher quality shading level, individual objects in the scene can still be set 

to render at any of the other lower shading levels on a per object basis. This 

allows for a mixture of shading methods (i.e., wireframe objects with 

Phong rendered objects) in the same scene.

There are five basic shading algorithms currently available in EIAS Anima-

tor. Listed by increasing quality and render time they are:

• Wireframe
• Flat
• Gouraud
• Phong
• Raytrace

Wireframe. Wireframe rendering is the fastest of the five rendering meth-

ods, and renders out a simple wireframe mesh image. This option will 

override any of the other shading methods set at the group/object level.   

To control line thickness enter a value in the Point/Line thickness box. 

Higher numbers result in thicker mesh lines. Here are examples of Wire-

frame shading using various Point/Line Thickness settings:
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Flat. Flat shading is fast, but lowest quality, solid rendering algorithm. 

Solid rendering allows for full hidden surface elimination, which is helpful 

for quick test renders in order to make sure objects aren’t intersecting with 

each other improperly. Flat shading, also known as constant shading, 

applies a light source to only one point on each face of a model. This can 

give a rendered image a faceted, blocky appearance. Using this global set-

ting, individual objects can use both flat, and wireframe shading, at the 

group/object level. It will however, override the shading level for any 

group/object that is set for Gouraud, Phong, or Raytracing.

Gouraud. Gouraud shading results in a higher quality solid rendering than 

Flat Shading, but is slightly slower. Rather than applying a light source to 

only one point on each face of a model, Gouraud shading calculates the 

light source based on the vertexes of the polygons that make up a face. 

These values are then interpolated to give a slightly smoother appearance 

than flat shading. The net result is that for a slight increase in render time, 

objects appear smoother and more naturally shaded than they do with Flat 

Shading. With this global setting, individual objects can use wireframe, flat, 

and Gouraud shading at the group/object level. This global setting will 

however, override the shading level for any group/object that is set for 

Phong shading and Raytracing.

Figure 8.1 — P/L Thickness    

P/L Thickness1.0 P/L Thickness 3.0 P/L Thickness 5.0 
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Phong. Phong shading uses an algorithm that creates natural, smooth 

shaded images. Phong shading calculates the light sources from multiple 

points across the surface of a model, instead of just at the vertexes of the 

component polygons. The result is more realistic specular highlights on 

surfaces as well as the most natural shadowing and light sourcing of any of 

the shading methods. This global shading level allows for all shading types 

to be active at the group/object level for the maximum amount of control.

Raytrace. Raytracing is the highest quality imaging level available in EIAS. 

It produces accurate reflections, refractions and shadows, The raytracing 

technology is channel-based, that is, only channels which are specifically 

assigned to raytrace will be imaged with the raytracer. In all other cases, 

the remaining channels will be imaged by the traditional rendering engine. 

This implementation promotes the fastest speed possible for a final 

image.The ray trace engine inside of EIAS Camera understands whether or 

not you are inside or outside of an object, so objects such as goblets etc. will 

render with the proper refraction effects out-of-the-box, with no need for 

special tricks (such as “air volumes” in other packages).

Selecting this option will raytrace every object that is set to raytrace in its 

group properties. If no objects use raytrace properties, then the scene will 

not be raytraced.

The Image Menu

The Image popup menu determines the final bit depth of the rendered 

image. Bit depth represents the number of colors used in the palette of an 

image. Black and white images are 1-bit (black or white), 256 Color and 

grayscale images are 8-bit, thousands of colors are 16-bit, millions are 24-

bit, and millions + alpha are 32-bit. These color depths are all processed as a 

post-rendering effect, as all EIAS rendering algorithms are initially com-
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puted in 64-bit color and then down-converted to the selected image for-

mat, which is typically 32-bit (Millions+Alpha). It is important to note that 

there will be NO savings in render time or speed by rendering in less than 

24-bit color. It may actually take longer to render in one of the other modes, 

as there is an extra step which takes place after the render is complete. 

The options for this pop-up are:

• BW Lines
• BW Filled
• BW Dithered
• BW Summation
• 256 Shades
• 256 Colors
• Thousands
• Millions
• Millions + Alpha

BW Lines. Renders an image with lines only, in black and white only.

BW Filled. Renders an image with filled polygons, in black and white 

mode, similar to flat shading. 

BW Dithered. Simulates a smooth shaded image using a fixed dither pat-

tern, in black and white.

BW Summation. Renders a black and white image using summation dith-

ering, a higher quality dithering. This dither uses randomly placed dots to 

make the image appear to be more smoothly shaded. From a distance, the 

image appears as a continuous tone.

256 Shades. This option converts the image to 256 shades of gray (8-bit). 

No histogramming is required for 256 Shades as it is converted directly to 
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gray scale from the original 32-bit palette. Therefore, there is no rendering 

time penalty for this option.

256 Colors. This option coverts the image to an optimized 8-bit color pal-

ette. 256 Color animation’s are histogrammed from the original 64-bit 

image file, resulting in a consistent frame-to-frame color palette. This 

means that a 256 color animation will maintain the same color palette 

throughout the entire animation. There will be a time penalty for the histo-

gram process to occur, and the amount of time required is directly related 

to the amount of frames in the movie file.

Thousands. This option converts the image to a 16-bit color palette (32,768 

colors) after rendering. As noted above, this does not speed up render time 

as the image is initially created in 64-bit.

Millions. This option renders the image in 64-bit color, adds noise and dis-

cards the alpha channel, resulting in a final 24-bit image.

Millions +Alpha. This option renders the image in 64-bit color, and adds 

noise, creating a 24-bit RGB image with an embedded 8-bit alpha channel.

The Format Menu

The Format pop-up menu determines the file format for the final, rendered 

image. The five menu items are:

• Image
• Quicktime
• PICT
• GlobeCaster
• GrangerFX
• Planar Z-Depth
• Spherical Z-Depth
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• Environment

Image. The original file format, used since the origin of Electric Image. The 

Image format is a robust, 32-bit color format. It is natively supported by 

many other, high-end graphics packages such as Adobe Photoshop® and 

After Effects®. Files stored in the Image format can be displayed within 

EIAS Animator choosing File>View Image.

Note Camera can Render out Image files larger than 2GB. However, After Effects cannot 

handle any non-QuickTime files larger than 2GB. If your Image file is larger than 

2GB and you need to import it into After Effects, open it in the QuickTime movie 

player and export it as Animation Codec, Millions+Alpha, Highest Quality. Then 

import the QuickTime movie into After Effects.

QuickTime. QuickTime™ is a digital movie format that has become a stan-

dard across multiple platforms. Choosing the QuickTime format brings up 

a dialogue that offers the choice of any installed hardware or software com-

pression CODEC’s.

Note Settings made in the CODEC window will override both the frames per second, 

and the Image Depth, settings in the Render window. For instance, even if you set 

the Image Depth to Millions+Alpha in the Render window, if you choose millions 

only in a QuickTime CODEC the image will be stored in millions of colors, WITH-

OUT the alpha channel. Also note that any slave machines used for rendering 

must have the same QuickTime CODEC installed as selected on the host machine.

Note There is a 2GB file size limit on QuickTime movies rendered by Camera. If you 

exceed this size, you will get an error message.
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PICT. PICT format is used for single frame images, rather than animations. 

If PICT is chosen for a multi-frame render, a series of sequentially num-

bered PICT files will be saved. PICT files have the same CODEC options as 

a QuickTime movie.

Note Camera can not render out PICT files larger than 2GB.

Planar Z-Depth. Causes Camera to render out a “.eiz” file. This variation 

of the Image file format contains 32-bits of depth information at every 

pixel. The depth is from the object to the camera plane.

Spherical Z-Depth. Causes Camera to render out a “.eiz” file. This varia-

tion of the Image file format contains 32-bits of depth information at every 

pixel. The depth is the length of the vector connecting the camera to the 

object.

Note This file format is not viewable by any standard means. It is meant to be imported 

as a layer in a compositing application. The.eiz file can contain stills or animation.

 Environment. Causes a 6-frame animation file to be rendered out, analo-

gous to an environment reflection map. The purpose of this feature is to 

create files that can be used as Cubic Reflection Maps. 

The scene camera is automatically oriented and the frames are written out 

in the following order:

1. Front
2. Back
3. Left
4. Right
5. Top
6. Bottom

Note Regardless of the number of frames selected for rendering, only six frames will be 

written if “Environment” is selected in the Format pull down menu.
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Render Flags

Render flags are check boxes that are used to turn on and off various effects 

for rendering. Any box that is checked enables that function. This has no 

effect on the settings of a given group or object, but simply turns off that 

function temporarily during the render. Any objects that use these effects 

(i.e., reflections or shadows) will still maintain their settings, and will ren-

der properly when the appropriate flag is re-enabled. This allows the user 

to enable and disable specific effects and functions on a global, per render 

basis. For instance, while doing a test render it might not be necessary to 

calculate shadows, so the Shadows box can be unchecked to save time until 

a final render is needed.

At many professional effects houses a trick that is often employed is to ren-

der out the same image using multiple passes, and then compositing the 

different passes together to form the final image. One render will be made 

just for the reflections, while another will be done for the diffuse light, 

another for glows, and so on. Then, in a post-processing program these lay-

ers can be combined with the utmost accuracy and flexibility, even chang-

ing over time.

The Flags control the following functions:

Clip. This check box controls whether or not clip maps are rendered. This 

option defaults to on.

Bump Displace. This check box controls whether or not bump and dis-

placement maps will be rendered. This option defaults to on. 
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Diffuse. This checkbox controls whether or not the Diffuse channel will be 

used during rendering. This option defaults to on. 

Specular. This check box controls whether or not specular maps will be 

used in the rendering process. This option defaults to on.

Transparency. This check box controls whether or not transparencies or 

transparency effects will be rendered. This option defaults to on.

Transmission. This check box controls whether or not transmission effects 

and maps will be rendered. This option defaults to on. 

Textures. This check box controls whether or not any texture maps will be 

rendered. This option defaults to on. 

Reflections. This check box controls whether or not any reflection maps 

will be rendered. This option defaults to on. 

Shaders. This check box controls whether or not procedural shaders will be 

rendered. This option defaults to on.

Luminance. This checkbox controls whether or not Luminance effects will 

be rendered. This option defaults to on. 

Glows. This check box controls whether or not glow effects are applied to 

the render. This option defaults to on.

Outlines. This check box controls whether or not the Cel/Outline shader 

functions are enabled. It defaults to on. By enabling this check box, and by 

also activating the Cel/Outline shader options in a groups’ material win-

dow, a variety of effects can be achieved. The Cel/Outline shader allows 

for separate color and thickness to be assigned to polygons, edges, and sil-

houettes of models.
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Lens Flares. This check box controls whether or not lens flare effects will be 

rendered. This option defaults to on.

Shadows. This check box controls whether or not shadows will be calcu-

lated and rendered for an image. This option defaults to on. 

Add Noise. This check box adds random noise to rendered images to 

reduce mach banding (very discernible differences in what should be 

smooth color transitions), especially prevalent in darker colors of the 32-bit 

color space. This option defaults to on.

Raytrace Shadows. With this checkbox marked, Raytraced Shadows will 

be rendered, if there are any in the scene. If unchecked, the Raytraced Shad-

ows will not be rendered.

Raytrace Reflections. This option will render Raytraced Reflections, when 

there are any in the scene. 

Raytrace Transparency. This options will render any Raytrace Transparen-

cies in the scene.

Raytrace Caustics. This options will render any Caustics in the scene.

Raytrace Recursion

This edit box controls how many bounces a raytrace solution will make. 

The more bounces the more accurate the render, but it will also take much 

longer.

Point/Line Thickness

When a scene is rendered in wireframe, the Point/Line Thickness edit box 

allows the user to specify the thickness of points and lines in pixels. The 
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default is 1 pixel. Higher numbers will give the wireframe mesh thicker 

lines.

Output Gamma

Gamma is a technical term used to describe the intensity of different levels 

of gray as they appear on an output device; usually either a computer mon-

itor or video screen. Standard gamma settings range from 1.0, up to 2.2 

depending on the output device. 

8.2 The Resolution Tab

The Resolution Settings tab is where all of the parameters for the resolution 

of the final rendered image are set. In this window there are options for set-

ting the aspect ratio, resolution, cropping, and VR rendering functions. 

The Aspect Ratio Menu

The Aspect Ratio popup menu defines the relationship between the x and y 

pixels of the image. This relationship is known in technical terms as the 

aspect ratio. This ratio is commonly stated as “x resolution in pixels: y reso-

lution in pixels”, simplified to the lowest common denominator. Therefore, 

Figure 8.2 —  The Resolution Tab
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a standard Macintosh screen with a resolution of 640 pixels horizontally (x) 

and 480 pixels vertically (y) has an aspect ratio of 4:3. Usually, when dis-

cussing film resolutions, the aspect ratio is specified as a ratio with y 

always equal to 1. For instance, IMAX film requires a very square 1.22:1 

ratio, while 70mm uses an ultra wide 2.20:1 ratio. There are a number of 

preset aspect ratios defined in EIAS Animator, or the user may choose to 

enter their own Custom aspect ratio. What aspect ratio you choose depends 

solely on the final format required for output. By choosing one of the pre-

defined aspect ratios, the rendered image will be constrained to the proper 

pixel ratio for that format.

An important consideration when using one of the preset aspect ratio’s is 

how it affects the field of view of the camera. Not only does film stock vary 

in aspect ratio, it also correspondingly varies in the amount of information 

it can record, or the Field of View. One way to consider how the field of 

view relates to the aspect ratio is to visualize a physical piece of film stock. 

When you look at it, it has a tangible measurement of x inches horizontally, 

and y inches vertically. One factor is the relationship of these two measure-

ments to each other. Those measurements will give you the aspect ratio, 

and determine how wide or square an image will appear when projected. 

The other factor is the physical size of the film stock itself. Although both 

Super 8mm film, and 35mm Full format film have the same aspect ratio 

(1.33:1), you can see a lot more on 35mm film, shooting the same subject at 

the same distance, and using the same lenses. In other words, if you put the 

exact same lenses on both cameras, say 25mm, and shoot from the exact 

same distance, the 35mm film will have a significantly wider field of view 

and you will see more information recorded on the film. Why? Because 

35mm film is physically larger and has about 4 times the surface area of 

Super 8mm film on which to record an image. So it is very important to 

remember that you are determining not only the width, or aspect ratio, of 
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an image, but also it’s relative field of view. Of course, in 3D you can use 

any lens, regardless of the aspect ratio, in order to create a specific field of 

view, but the film stock is an important factor in this equation.

Note The aspect ratio is locked to the X resolution. Any number entered in the X box 

will automatically calculate the proper Y resolution based on the currently selected 

aspect ratio. However, numbers can be entered manually in the y resolution and do 

not automatically convert the x value to the correct aspect ratio. Therefore, if you 

want the aspect ratio to be automatically calculated, always enter your resolution 

in the X edit box, and let ElectricImage EIAS calculate the proper Y resolution.

The aspect ratio choices are as follows:

• Custom
• Computer
• Super 8mm
• 16mm
• Super 16mm
• 35mm Spherical
• 35mm Full
• Vista Vision
• 65mm
• IMAX
• 70mm
• Techniscope
• 6x45 (medium format)
• 6x6 (medium format)
• 6x7 (medium format)
• 6x8 (medium format)
• 6x9 (medium format)
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• 6x12 (medium format)
• 4x5 (large format)
• 5x7 (large format)
• 4x10 (large format)
• 8x10 (large format)
• 1/3 In. Video Pickup
• 1/2 in. Video Pickup
• 2/3 in. Video Pickup
• HD 16:9 Non-Switchable
• HD 4:3 Switchable
• HD 4:3 

Custom. This option brings up a dialogue box for entering a custom aspect 

ratio. The pop-up menu on the right allows the user to specify the measure-

ment system in millimeters, centimeters, or inches. Then, simply enter the 

specific film gauge measurements in both x and y dimensions, or enter an 

aspect ratio in the Frame Aspect edit box. 

This dialogue box is very useful for entering custom measurements when 

you are trying to match a film stock that is not one of the presets, or you 

need to match a particular aspect ratio from another 3D package, or to suit 

a specific programming need. 

Computer. This option (the default) specifies the 4:3 aspect ratio of a stan-

dard 640x480 computer screen. The horizontal field of view using a 25 mm 

lens is 3.0 degrees.

If you are doing multimedia work for a standard computer screen, this is 

the setting that you would use most often.

Super 8mm. This option specifies the 1.33:1 aspect ratio of Super 8mm film. 

The horizontal field of view using a 25 mm lens is 12.1 degrees.
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16mm. This option specifies the 1:38:1 aspect ratio of standard 16mm film. 

The horizontal field of view using a 25mm lens is 23.2 degrees.

Super 16mm. This option specifies the 1.7:1 aspect ratio of Super 16mm 

film. The horizontal field of view using a 25mm lens is 28.1 degrees.

35mm Spherical. This option specifies the 1.37:1 aspect ratio of standard 

35mm film. The horizontal field of view using a 25mm lens is 47.4 degrees.

35mm Full. This option specifies the 1.33:1 aspect ratio of 35mm Full for-

mat film, also known as Academy Aperture or “four perf,” for the amount 

of sprocket perforations used per frame as the film runs vertically through 

the camera. The horizontal field of view using a 25mm lens is 52.9 degrees.

VistaVision. This option specifies the 1.5:1 aspect ratio of VistaVision for-

mat, with 8 horizontal perforations per frame. The horizontal field of view 

using a 25mm lens is 74.1 degrees.

65mm. This option specifies the 2.28:1 aspect ratio of 65mm vertical 5 perf 

film. The horizontal field of view using a 25mm lens is 92.8 degrees.

IMAX. This option specifies the 1.22:1 aspect ratio of 65mm horizontal 15 

perf IMAX film. The horizontal field of view using a 25mm lens is 109.25 

degrees.

70mm. This option specifies the 2.20:1 aspect ratio of 70mm film running 

vertically through a motion picture camera. The horizontal field of view 

using a 25mm lens is 88.3 degrees.

TechniScope. This option specifies the 2.35:1 aspect ratio of TechniScope 

film. (TechniScope is also referred to as “two perf,” as it divides the verti-

cally oriented 4 perf standard 35 mm frame into two frames, each using 
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two sprocket perforations.) The horizontal field of view using a 25mm lens 

is 88.3 degrees.

Image Resolution Menu

The Resolution popup menu determines the final number of pixels to ren-

der for an image. This resolution will be constrained by the chosen Aspect 

Ratio. 

The resolution of an image has little effect on the amount of memory 

required to render, but does increase the number of passes needed, due to 

the additional pixels, and increases render time.

You should note that the resolution has no effect on the field of view. You 

won’t be able to see twice as much of a scene by doubling the resolution. In 

order for the camera to “see” more of a scene, it is necessary to either 

change the aspect ratio and/or the focal length of the camera. The resolu-

tion setting merely renders more or less pixels in a given image. The 

amount of information seen by the camera is the same, regardless of the 

resolution.

The choices for image resolution, based on a Computer aspect ratio of 4:3, 

are:

• 260x200
• 320x240
• 640x480
• 1024x768
• 1280x960
• 2048x2048
• 4096x4096
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• Main Screen (the default): This setting uses the resolution of the pri-
mary monitor.

• NTSC: (720x486) The standard television resolution used in North 
America and Japan. Pixel ratio =.9 (See below for explanation of Pixel 
ratio)

• PAL: (768x576) The standard television resolution used in many Euro-
pean countries, including England, and Germany.

• HDTV: (1920x1280) The mythical, high definition television format that 
may appear in the United States one day, but most likely not at this res-
olution and no longer called HDTV.

• Abekas NTSC: (720x486) Resolution used by Abekas direct disk record-
ers at NTSC resolution. Pixel ratio=0.9.

• Abekas PAL:   (720x576) Resolution used by Abekas direct disk record-
ers at PAL resolution. Pixel ratio= 1.0667.

• Trinity

X and Y Edit Boxes

These edit boxes allow the user to directly enter values for resolution rather 

than choosing from the resolution pop-up menu. The X value will automat-

ically constrain the Y value to the chosen aspect ratio, but not vice-versa. 

The maximum theoretical resolution is 32,760 pixels by 32,760 pixels.

 

Pixel Aspect Ratio

This edit box allows the user to control the aspect ratio of each rendered 

pixel. Most computer screens display square pixels, at a pixel ratio of 1.0. 

However, broadcast television signals, including NTSC, PAL, and HDTV 

Figure 8.3 — The X and Y Edit Boxes
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do not use square pixels. Therefore, by altering the pixel aspect ratio, non-

square pixels can be rendered. The value in this box will automatically 

change when specifying a resolution in the resolution popup.

 

Rendering with rectangular pixels will tend to make images look stretched 

out when viewed on a computer screen, but after being properly processed 

and sent to video tape they should appear normal.

Draft Mode 

Draft provides an easy way to render out to fractional resolutions. The 

default is “Full” which provides the resolution displayed in the X and Y 

edit boxes. Changing Draft to a fractional setting won’t alter the resolutions 

displayed in the edit box, but Camera will render to the fractional size. 

 The setting is ignored by window-sized and cropped snapshot renderings.

Note It’s easy to forget the setting of Draft. Make sure you set it back to Full before you 

begin your final rendering.

Image Cropping

The image cropping function allows for only a portion of an image to be 

rendered. There are two ways to use the new cropping feature. First, the 

enable cropping check box must be checked in the Render window. Next, 

values from 0 to 1 can be entered directly in the text boxes in the cropping 

area, where 0 represents left/top, and 1 represents right/bottom. When the 

image is sent to render, only the area within the cropping guidelines will be 

rendered.

Figure 8.4 — The Pixel Ratio box
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More usefully, the crop region can be seen and interactively set. By first 

selecting Render >Render Settings, Resolution tab, Enable Crop and sec-

ond choosing Render>Edit Cropping from the menu. A visual guide will 

appear in the camera window. This region can now be interactively resized 

by dragging the safe title edges. When the render is sent, only the area 

within the visual cropping guides will be rendered.

Rather than just a temporary selection, like the method of rendering 

Selected Size, the Crop region can be saved and easily moved and resized. 

This kind of selective rendering option can be extremely useful when you 

have a scene set up, and you need to preview specific areas of the scene, but 

don’t want to wait while the computer renders everything in the scene. 

Rather than turning a bunch of objects off and on, or setting up multiple 

cameras, you can selectively set a cropping region around the object you 

wish to and render. There is also a shortcut under the preview render icon, 

Cropped Size, that allows you to instantly render the cropped selection, or 

to render a selection within the cropped area, Selected Cropped Size.

QTVR

Quicktime VR (QTVR) is a “virtual reality” format, presented via Quick-

time. It offers two different VR modes, panoramic and object. Panoramas 

are created by warping the rendered image, which places the viewer in the 

middle of the image. The image is processed by Quicktime to give the 

Figure 8.5 — The Image Cropping options
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viewer the apparent ability to pan around an environment, looking up and 

down, and zooming in and out. 

An object is a Quicktime VR movie that tracks a single object around a 360 

degree axis. Rather than the viewer panning and tilting across a panorama, 

an object movie allows the viewer to spin and rotate a single object around 

it’s own axis. Other tricks include the ability to have portions of the object 

animate instead of a complete 360˚ spherical orbit (or as part of a complete 

360˚ orbit.)

None. This option disables the QTVR features. This is the default option.

Panoramic. This option will create a self-contained panorama, as long as 

Quicktime is installed on your computer. (This option is not available on 

Sun machines.) You can save the output of the file as a warped image for 

use with VR methods other than Quicktime, by choosing the desired for-

mat from the Format menu in the Render tab. If you choose the Quicktime 

option from that menu, you will be prompted to select a CODEC for com-

pressing the QTVR movie.

QTVR has several rules regarding output resolutions. The X dimension 

must be evenly be divisible by 96 and the Y dimension evenly divisible by 

4. Common output resolutions include 2496 by 768 and 1248 by 384.

Camera renders QTVR panoramas in four panes, each with a 90 degree 

horizontal field-of-view (FOV). Make sure that the horizontal FOV is set to 

90 degrees in the Camera Info window. One of these panes will be dis-

played in the Camera View window when QTVR is enabled.

During rendering, all four views will be automatically rendered, rotated 

and properly warped.
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It should be noted that EIAS Animator can only generate single node mov-

ies. You will need to obtain additional tools, either from Apple or a third 

party, in order to create multi-node, or other special QTVR movies.

Object. Place the object you want to rotate at 0,0,0 on the global axis. Then, 

select Object from the VR popup menu in the Resolution tab of the Render 

Information Window. This will bring up an additional dialog box allowing 

you to set the number and angle of Horizontal (Latitude) and Vertical (Lon-

gitude) samples needed. By default an object movie will utilize a 360 

degree axial rotation, starting at 90 degrees Latitude, 0 degrees Longitude 

and rotating to -90 degrees Latitude, and 360 degrees Longitude. To create a 

smoother object movie, more samples can be created per rotation, by enter-

ing a value in the Sample edit box.

Unlike QTVR Panoramas, QTVR Object movies do not have set require-

ments for FOV or Resolution. These are left up to the user.

For more information, please visit Apple Computer’s Quicktime VR web 

page at: www.apple.com/quicktime/qtvr/
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8.3 The Anti-Alias Tab

Anti-aliasing is the filtering process used to remove “jaggies” and moire 

patterns from rendered images. The anti-alias tab contains all of the set-

tings through which you control anti-aliasing quality.

The Anti-Aliasing Menu

The Anti-Aliasing popup menu determines the type of anti-aliasing used 

when rendering. 

The choices are:

• None
• Adaptive
• Oversample

None. This option specifies that no anti-aliasing will be used on the image. 

Edges and outlines may have a jagged, rough appearance.

Adaptive. This option specifies that adaptive anti-aliasing be performed on 

the render. This produces a softer image than None, and a sharper image 

than the Oversample. Thin, sharp lines may cause artifacting when render-

ing for video output, and using Oversampling may be more effective in 

these cases.

Figure 8.6 — The Anti-Alias tab
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Oversample. This option (the default) specifies that Oversampling be per-

formed on the render. This produces the softest images with the smoothest 

edges, and significantly reduces video artifacting caused by jagged edges.

The Anti-Aliasing Levels Menu

This menu controls the amount of sampling that will be performed on the 

image. The menu items are:

• 4x4
• 8x8
• 16x16
• 32x32
• 64x64

4x4. (The default) This setting is generally sufficient for most images. Lines 

and edges maintain a sharp, detailed appearance. High contrast vertical 

and horizontal edges can cause artifacts, and moire patterns, for which the 

8x8 setting may work better.

8x8. This setting is useful when a slightly smoother, softer look is required. 

Lines and edges will appear less crisp than when using the default, and 

may reduce moire patterns and artifacts. Be aware, however, that this set-

ting may slow down rendering time significantly over the default 4x4.

16x16 (and higher). These settings should only be used in specific instances 

where a very high level of anti-aliasing is needed. For the vast majority of 

renders, these sampling levels will produce an image that is indistinguish-

able from one rendered at a 4x4 or 8x8 level. However, rendering time goes 

up dramatically when using these levels.
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The Sampling Levels Menu

Object sampling levels are set in the group info window for each object. 

The values in the sampling level menu are used to determine the maximum 

amount of sampling allowed at render time. If some of your groups are set 

to 4x4 sampling, and the sampling menu is set to 2x2, sampling will be lim-

ited to up to 2x2 maximum as the image is rendered. The menu items are:

• 1x1
• 2x2
• 4x4
• 8x8
• 16x16
• 32x32
• 64x64

1x1. (The default) This setting is sufficient for lower detail objects, or mod-

els that appear at a moderate distance from the camera. However, when 

viewing images rendered at this setting up close, jagged edges may be 

apparent. This is also not a good setting for high resolution images.

2x2. This is a good, general setting for most objects and groups. Render 

time compared to 1x1 sampling may be only slightly higher, and the extra 

detail is generally worth the time, especially with high detail texture maps.   

This setting may also help animations that exhibit flashing, or stair step 

patterns on playback.

4x4. This setting, although slower than 2x2, is useful for objects which 

require a high amount of sampling detail. This includes objects with intri-

cate texture maps that are in close proximity to the camera, or that involve 

complex effects passes (smoke, fog, glow). Very high resolution images 

may also benefit from this sampling level.
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16x16 (and higher). Like anti-aliasing levels, these setting should only be 

used in specific instances where a very high sampling level is required. 

Render time at these levels increases by a huge amount, and for the major-

ity of renders will show no noticeable improvement.

When rendering at any typical resolutions (720x486 and less), leave your 

anti-aliasing level at 4x4. Unless you see a problem in the render this set-

ting will be more than adequate and allow you to render as quickly as pos-

sible. For sampling levels, consider using a global maximum sampling 

level of 4x4, and individually setting the sampling levels on a per object 

basis. Therefore, if you have an object with a complex texture map very 

close to the camera you can set it’s sampling level to 4x4, while objects that 

only appear in the distance can be set for 1x1. This approach gives you the 

maximum control over the 2 major issues in a production setting; quality 

and render time.

Adaptive Sampling Threshold

The Min and Max edit boxes contain values that control the type of adap-

tive comparison filtering to be performed between adjacent pixels of differ-

ent color values. If the difference in the pixels is less than the minimum 

value, the image is sharper (less filtering, more jaggy). If the difference in 

the levels is greater than the maximum value, the image is softer (more fil-

tering, less jaggy). If the difference falls between the minimum and maxi-

mum values, adaptive anti-aliasing is performed. The higher the difference, 

the softer the image; the lower the difference, the sharper the image.

Figure 8.7 — The Sampling Threshold boxes
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High contrast vertical edges next to horizontal edges can cause aliasing 

artifacts. On occasion, high-frequency details, such as an edge with a high-

light, will have a stair-step pattern or will flash off and on. Higher sam-

pling levels will reduce this noise and improve the sharpness of texture 

maps. But using a higher sampling level will have a dramatic impact on 

rendering time. Rendering your whole project at 2x2 sampling instead of 

1x1 can quadruple rendering time. That is why we have provided the abil-

ity to set the sampling level on a group-by-group basis.

As a general rule, make the Anti-Alias level two four times the highest 

Sampling Level used on any of your groups. If you need to increase the 

Sampling Level of a particular group to 2x2, increase the Anti-Alias level to 

8x8.

Setting the Sampling Level higher than the Anti-Alias Level will not 

improve the quality and slows down rendering.

8.4 The Motion Blur Tab

Figure 8.8 — The Motion Blur Tab
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This section of the Render window is used to control the motion blur fea-

tures of EIAS Animator. Motion blur is the simulation of the kind of effect 

that occurs when recording a moving object on film. As an object moves 

across a frame of film it naturally blurs, depending on the speed of the film, 

and the object’s velocity. These controls allow you to mimic that behavior 

in EIAS Animator. Note that in order for blur effects to be rendered, it is 

also necessary to set the blur mode for each object/group that you wish to 

blur under that object’s group info window.   

Note This setting defaults to no motion blur. You will need to change the blur mode to 

the desired setting per object blur or motion blur will not be rendered.

Shutter Angle

This edit box contains a value in degrees that represents the circular angle 

at which a camera shutter is open. A value of 360 degrees simulates a shut-

ter that is always open, whereby all moving objects leave a continuous 

streak across the frame. A value of 180 degrees (the default) simulates a 

shutter that is open for half a frame, mimicking a motion picture camera. 

The higher the angle, the longer the shutter will stay open, creating longer 

streaks and more blur. Note that only moving objects create blur, or streaks, 

as the streak length is computed by the distance an object moves within the 

field of view from frame to frame. Hence, objects that are far away from the 

camera will streak very little regardless of their velocity, while very close 

objects will streak dramatically with very slight movement. Values higher 

than 360 ˚ will create dramatic streaking, even on slow moving objects. 

Great for that “warp speed” effect.

Figure 8.9 — The Shutter Angle Box
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Blur Intensity

This edit box is used in conjunction with the Point/Line blurring technique 

(see below). This value controls the brightness of the streaks left behind by 

points and lines. A value of 0.0 (the default) imparts a constant value 

regardless of the length of the streaks. Larger values produce brighter 

streaks, while smaller values produce dimmer streaks. A separate blur 

intensity can be set for each individual object/group in that group’s info 

window. This edit box automatically appears after selecting the Point/Line 

blur mode.

Blur Noise

This edit box is used in conjunction with the Motion Vector blurring tech-

nique (see below). This value controls the number of blur samples per 

pixel. The higher the number, the less visible noise in the streak. By using a 

value of 0, EIAS will automatically compute the optimal number of sam-

ples for a streak based on its length. A value of 4 (the default) renders 

quickly and produces high quality results. Values over 10 are unproduc-

tive, and will drastically slow the rendering process.

Blur Frames

This edit box is used in conjunction with Multi-frame motion blur (3D 

blur). This value represents the number of individual frames that are ren-

dered prior to averaging the frames together to generate a single frame. For 

instance, if this value is set to 3, for each frame of an animation, EIAS gen-

Figure 8.10 — The Blur Intensity checkbox

Figure 8.11 — The Blur Noise checkbox
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erates 3 images, the frame ahead of the current frame, the current frame, 

and the frame behind. It then averages these images together to make a sin-

gle frame, with blurring based on the distance moved between all 3 frames. 

If this value is set to 2, EIAS calculates two frames for averaging; the cur-

rent frame, and one after the current frame.

Point/Line Blurring

This check box, when enabled, activates the point/line motion blur tech-

nique at the global level. Individual objects still need to be set for this type 

of blurring at the group/object level. In this mode, only points and lines 

leave streaks behind. This is most useful for the motion blur of star streaks 

and particle systems. Normal polygonal models will not streak using this 

method.

Motion Vector

This check box, when enabled, turns on Motion Vector motion blur (2D 

blur) at the global level. Unlike the point/line method which only blurs 

points and lines, this method induces blur on all objects which have been 

set for motion vector blurring. This includes points, lines, and polygons. It 

should be noted that blurred lines are always linear, and are never curved 

when seen in a single frame. This is a fast and versatile technique which 

works for most objects.

Figure 8.12 — The Point/Line Blurring checkbox

Figure 8.13 — The Motion Vector checkbox
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Multi-Frame

This check box, when enabled, allows for multi-frame sampling for motion 

blur. It can be used in conjunction with the other blur techniques (point/

line or motion vector). The number of frames to be sampled is set in the 

Blur Frame check box. Strobe like effects are produced if too few sample 

frames are used with this option alone. It is best applied to a section of an 

animation where there is complex or rapid motion (like spinning fan 

blades, or the tires of a quickly moving car). Combining this technique (set 

to 2 sample frames) with Motion Vector blur produces great results for 

those times when Motion Vector isn’t quite enough.

8.5 The Timing Tab

The timing tab contains start and stop information, and playback informa-

tion.

Figure 8.14 — The Motion Vector checkbox

Figure 8.15 — The Timing Window
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Start and Stop Times

This edit box defines the start and end times for a project, in seconds. These 

settings are also represented visually in the project window by the green 

(start) and red (end) arrows, and can be changed by dragging them interac-

tively. Any changes made in the project window will be reflected here, and 

vice versa. These boxes define the total range of frames for a given project. 

Animation keyframes can still exist outside of the range of frames for a 

project, but will not be rendered. 

Note: It is possible to set the start time to a negative number. This can be very helpful if 

you’ve already created a complex animation starting at 0.0 seconds, and you later 

realize you need to add a sequence prior to the start of the animation. Rather than 

attempting to drag all of your keyframes to the right, simply use a negative number 

as your start time. Be aware, however that while this works in most cases, negative 

frame numbers may not work with simulation plug ins such as particle systems.

Total Frames

This edit box displays the total number of frames in an animation. This 

number is generated automatically based on multiplying the delta (differ-

ence) of the start and stop times by the number of frames per second and 

adding 1. For instance, if a project is set for 10 seconds, and the frame rate is 

30 frames per second, the total number of frames rendered will be 301. This 

extra frame is due to the fact that EIAS Animator counts frame zero as the 

first frame in an animation. This number is displayed primarily for refer-

Figure 8.16 — The Start and Stop Boxes

Figure 8.17 — The Total Frames box
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ence, although by setting the Total number of frames directly in the edit 

box, the Stop Time will be updated accordingly in both the Stop edit box 

and the project window.

Nth Frame

This edit box is used to specify that an animation is only rendered out with 

every nth frame. In other words, if this box is set to 2, then every 2nd frame 

will be rendered. If the start frame is 0, the following frames will be ren-

dered: 0, 2, 4, 6, 8...etc. In order for this to work, the Enable Nth frame 

checkbox must be checked. This setting works independently of the Render 

frames pop-up. The Nth frame is always used if selected, whether an ani-

mation is rendering all frames, or a selected range of frames. For instance, if 

a render is set for a range of frames from 100 to 150, and Nth frame is set to 

3, then the following frames will be rendered: 100, 103, 106, 109...etc.

The Nth frame box is extremely useful for doing test renders. Instead of 

having to render out every single frame of an animation, it is often suffi-

cient for a rough motion test to only render out every 2nd or 3rd frame.

FPS Menu

This edit box is used to specify the number of frames per second (fps) to be 

rendered for an animation. This figure determines the total number of 

images that are drawn per second. Note that it is important to set this num-

ber prior to doing any animation in a project, as all animation keyframes 

that are created will be based on this number of frames per second. By 

changing this value later, velocities and keyframe attributes may be thrown 

off. 

Figure 8.18 — The Nth Frame box and checkbox
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The pop-up menu contains the following choices:

• Custom
• NSTC 30
• NTSC 30i
• Pal 25
• Pal 25i
• Film 24

Custom. The Custom setting allows the user to enter any number of frames 

per second, as well as choose whether or not the image will be interlaced. 

Interlaced rendering splits each frame into two fields, with the odd field 

dominant unless the Even Field check box is enabled. Interlaced fields are 

necessary for some broadcast video output cards. You should consult with 

your video output devices manuals to determine if interlaced fields are 

necessary.

NTSC: 30, 30i. This setting specifies the NTSC video standard of 30fps. 

This is what all broadcast television in the US is shown using, and consists 

of a 60Hz signal, being shown in 2 fields. Combining both fields into 1 

frame results in a frame rate of 30fps. NTSC: 30i is output as interlaced 

frames, with the odd field dominant.

PAL: 25, 25i. This setting specifies the PAL video standard of 25fps. This is 

most common for European broadcast television, and differs from the US 

in that it operates at 50Hz, shown in 2 fields. Combining both fields into 1 

frame results in a frame rate of 25fps. Pal:25i is output as interlaced frames, 

with the odd field dominant.

Film: 24. This setting specifies the motion picture standard of 24fps.
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8.6 The Render Menu

This pop-up menu is used to select the range of frames that are to be ren-

dered. The choices are:

Current Frame. This option (the default for single frame projects) causes 

only the current frame in the animation to be rendered. The current frame 

is defined as whatever frame is currently displayed in the camera window. 

This is selected by moving the time slider in the project window.

All Frames. This option (the default for multi-frame projects) causes all 

frames in an animation to be rendered. The total number of frames is 

defined by the Start and Stop times, mentioned above.

Range of Frames. This option opens a dialogue box which allows for set-

ting specific frame numbers to be rendered. Using this tab, any portion of 

an animation within the Start and Stop times can be rendered. This is very 

helpful when working in a large project, with multiple animation 

sequences. Using this setting, only a specific range of frames needs to be 

rendered. You can also use Range of Frames to render your animation in 

reverse order, by typing reverse values in the edit boxes.

Even Field. This checkbox specifies that when rendering interlaced anima-

tion files, the Even field will be rendered out as the dominant field. This 

defaults to off, because the RS-170A specification for NTSC calls for odd 

field dominance. Some video cards break this rule (programmers always 

start on even numbers, such as zero, instead of odd numbers like one) and 

this option is present for those conditions. 

Note Be warned, even if your setup is even field dominant, most production houses are 

odd field dominant — you might need to re-render!
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8.7 Network Rendering Tab

You can render to as many computers as you wish (assuming they meet mini-

mum performance requirements.) Renderama, the EIAS network rendering 

application, must be available in the same folder as EIAS, and properly 

configured. See “Network Rendering with Renderama” on page 287.

8.8 How To Render a Project

To initiate a render, make sure that all of your parameters are set the way 

you want them. You can then launch the rendering process in one of several 

ways:

• Render>Window from the main menu bar
• Render>Frame from the main menu bar
• Render>Window Selection from the main menu bar
• Render>Frame Selection from the main menu bar
• Render>Render Project... from the main menu bar
• The “Go” button from the Render Information Window

The Render>Window (and selection) and Render>Frame (and selection) 

will render the current frame only. You cannot initiate a complete project 

render from these menu items. Only Render>Project and the “Go” button 

from the main menu bar can initiate a complete project render. For more 

information on rendering single frames, please See “Render Menu” on 

page 91.

Launching a Render from the Menu Bar

The Render Project... menu option will render all frames of an entire 

project, unless you have selected otherwise, with the Render popup menu 

in the Timing tab of the Render Information window. Once you select Ren-
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der>Render Project..., a save dialog will appear, prompting you for the 

name of the image or movie that you wish to render, and for the location 

where the file is to be placed upon completion. Afterwards, a Save Project 

dialog will appear. If you choose not to save the project, all of the work that 

you had completed after your previous project save will be lost.

Launching a Render with the Go Button

To simply begin rendering a project, click the Go button. If you haven’t 

saved, you will be prompted to do so. Following that, EIAS Animator will 

quit, launch the camera application, and begin rendering. 
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Network Rendering with Renderama

9.0 Introduction

Rendering is typically the longest process in computer animation produc-

tion. Even with the “world’s fastest renderer,” rendering still takes too 

long. In recent years, a method has appeared to allow the work of the ren-

dering engine to be split up into smaller tasks, and distributed over a com-

puter network of suitable machines and rendered remotely. This is called 

“network rendering.” 

Network rendering requires a robust computer network, computers with 

large hard drive capacities, generous amounts of RAM, and modern CPUs, 

such as Intel PIII or P4s, Athlons, or Power PC G4s or. You can use older 

machines, but of course, your render times will be longer.

The network rendering process involves a great deal of file transferring of 

data back and forth, and any noise on the network will affect data transfer 

throughput. Mixed protocol networks can sometimes create grief, and 

older routers can often be the culprit of slow network performance. Which, 

of course, leads to poor network rendering performance. Therefore, in a 

perfect world, these are things that you should avoid.

As you can imagine, with this much data traveling back and forth across 

the network, tracking model files, texture maps, plug-ins and so on can get 

rather complicated. A management system needs to be in control of the sit-

uation in order to produce satisfactory results. Network rendering in EIAS 

is managed by the included Renderama utility.
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Renderama

Renderama can be used to schedule batch rendering on a single computer, 

as well as to distribute renderings among many networked computers. 

Each time that you send a file to be rendered via Renderama, you are creat-

ing a rendering job. Renderama will manage each job separately for you.

Note Renderama jobs can only be distributed across TCP/IP local and wide area net-

works. No other network protocol is supported.

Renderama can distribute rendering jobs transparently among multiple 

computer platforms including Macintosh, NT, and UNIX-based computers. 

However, if you do choose to render in a multi-platform environment, it is 

a good idea to confine specific shots to a specific class of computers. This is 

due to the fact that different computer classes use different math proces-

sors. As each rendered frame is very math intensive, small differences 

maybe noticeable frame-to-frame across different CPU types. Most of the 

time, these differences are not noticeable. Sometimes, however, they are 

glaring.

Renderama acts as a middle-man in-between EIAS Animator and one or 

more EIAS Camera rendering engines. It coordinates all rendering activity, 

automatically distributing jobs across the network, or queuing several jobs 

for subsequent batch rendering, in the case of a single machine configura-

tion. 

Renderama is actually a very simple-minded program. It does not offer 

many bells and whistles. Instead, it doles out single frame renders to each 

active machine on the network, and waits to see if the machine successfully 

completed the frame. If the rendering was successful, it is sent back to the 

master machine to be stored until all of the frames in the animation have 
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been completed. Once all the frames are completed, the Renderama master 

application will stitch the frames together in the proper order.

If for some reason a machine fails to successfully complete a rendered 

frame, Renderama will remove the machine from the active list, and take it 

offline. In the status section, an error message will be displayed, and the 

word “error” will appear next to the slave’s IP address in the slave list. That 

machine will remain offline for any further rendering jobs unless you reset 

it directly at the machine itself. Resets cannot be performed remotely.

Note If a machine actually crashes, or the power goes out while a machine is rendering, 

Renderama can recover once the machine is rebooted.

9.1 Configuring Renderama

Renderama consists of two applications, Renderama and Renderama Slave. 

The Renderama application acts as a master, and directs all the Renderama 

Slaves. The Slaves then transfer the output back to Renderama, where it 

stitches them all together.

Important EIAS Animator and the Renderama master application must be run from 

the same machine. The machine that is running the Renderama master 

application cannot be shut down until the current rendering job is com-

pleted, or the job will be suspended. If you desire unattended network 

rendering, you will need to manually copy your EIAS Animator project file 

and associated model and texture files to the master machine, launch EIAS 

Animator on that machine, and follow the steps outlined in “Network Ren-

dering Job Management” on page 293.

By default Renderama will recognize the machine where it is installed as a 

possible rendering candidate, called “local”. If you have a multiple 
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machine network, and want to render on other machines, they must be 

added to the list.

Adding a slave rendering machine to Renderama:

1. Launch the Renderama application. It is located in the EIAS Animator 
directory

2. Once Renderama starts up, the control window as shown in Figure 9.1 
will appear

3. Click the Add Slave button

Figure 9.1 — Initial Renderama Interface with Add Slave Highlighted

Add Slave
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After clicking the Add Slave button, a dialog appears to enter the 

Slave’s IP address. Enter the address and click OK

After the new IP address is added, the new slave will appear in the Ren-

derama window. The small circle icon next to the name indicates that you 

will allow this machine to be available to render.

Note A machine called “local” will always appear in the slave list. This is the machine 

that the Renderama application was launched on. You may wish not to use the local 

machine as part of network rendering.

Important The Slave machines must have a directory with Camera, Renderama Slave, 

and the EI Sockets, EI Resources and EI Shader directories installed. Ren-

derama will not transfer sockets or shaders, instead, it looks locally. 

The Renderama Slave application must be running in order for a rendering 

machine to be accessed by the Renderama Master. EIAS will not launch the 

Renderama Slave or Renderama Master applications. You must do this 

yourself. On network rendering machines, it is a good practice to place an 

Figure 9.2 — Add Slave IP Address Dialog

Figure 9.3 — Renderama with a Slave Added
EIAS Animator        291



Chapter 9  Network Rendering with Renderama — Configuration
alias or shortcut of the Renderama Slave to launch when the computer 

boots. This will allow for seamless operation, as well as better error recov-

ery.

Using Specific Port Numbers

You may set a port number in addition to the IP address when configuring 

your slaves. To configure the port number of a slave, launch Renderama 

Slave and choose File Menu > Set Port Number. A dialog box will appear. 

Enter in a 16-bit port number (0-65535). If another application currently 

running is using that port, you will be asked to choose a different port 

number. After changing the port number you must quit and restart the 

slave.

The default port number is 1616. If you do not choose a port number, Ren-

derama Slave will run on this port.

Since the slaves can now have any port number you choose, Renderama 

itself now has the ability to specify a port number in addition to the IP 

address for the slaves.

To include a port number when specifying the IP address of a slave in Ren-

derama, append “:port number” to the end of the address. For example, 

192.168.1.106:5432  This would be IP address 192.168.1.106 and port num-

Figure 9.4 — Renderama Slave Port
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ber 5432. Renderama will now show both the IP addresses and the port 

numbers in its list of slaves.

If you do not add a port number to the IP address, Renderama will use the 

default, 1616.

9.2 Network Rendering Job Management

Once the Renderama master application is configured, and the slave 

machines are properly installed, up and running, you can begin to use Ren-

derama for network rendering. The first thing that you must do is to set up 

your EIAS Animator project for network rendering.

Creating a Renderama network rendering job:

1. Launch the EIAS Animator application
2. Load the desired project into EIAS Animator
3. Choose Render>Render Settings from the main menu bar
4. Select the Network tab in the Render Information Window

Figure 9.5 — Renderama — Entering IP and Port
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The network rendering tab will appear.

5. Click on the Enable Network Rendering check box
6. Enter the name of the rendering job
7. Click on the Go button

A save file dialog will appear, prompting you to choose the final ani-

mation file and the directory in which the file will be placed. Rendering 

control files will then be written from EIAS Animator, and supplied to 

the Renderama application. Normal operation will then be returned to 

EIAS Animator.

Once you have created a network rendering job for Renderama, you must 

then activate the job. 

Note EIAS Animator will not automatically switch to Renderama for network render-

ing. You must do that manually.

To activate a rendering job in Renderama:

1. Launch the Renderama application
2. From the job list, choose the desired job name. There may be more than 

Figure 9.6 — Render Window with Network Tab Selected
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one job name

3. Make sure that the job is active, as indicated by the shaded circle icon 
to the left of the job name. If the circle is not present, the job will not be 
processed.

4. Select the Go button at the top of the window.

Once you select the Go button, Renderama will begin to transfer files to 

the slave rendering nodes on the network. 

The status section at the bottom of the window will provide current Ren-

derama system information. Slave machine status will be presented to the 

right of the slave machine in the slave list. As the rendering job progresses, 

Renderama will report any necessary information in the status section.

The jobs can also be removed by highlighting them and clicking remove.

Error Recovery

In the event that one or all of the Renderama applications fail, or the ren-

dering computers fail, Renderama will pick up where it left off after every-

thing is reset.

Figure 9.7 — Job List in the Renderama Window
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How to Get the Best Results from Renderama

As mentioned previously, Renderama is a simple-minded application, 

intentionally so. It is designed to make good use of a multi-machine render 

farm. Under certain conditions, using Renderama can be a matter of dimin-

ishing returns. Due to some overhead operations, Renderama is less effi-

cient when you have less than three slave machines in your render farm. 

That does not mean that you shouldn’t use Renderama in render farms 

with less than three machines, but that larger jobs (longer movies) will 

show more of a benefit in using Renderama than smaller jobs will.

As Renderama requires an individual control file for every frame, the con-

trol file write process can take noticably longer in EIAS Animator than writ-

ing out a single control file for direct rendering. To insure that a job is 

successfully completed, Renderama performs certain housekeeping rou-

tines which can also impact your overall render times. 

9.3 Renderama Tips

• You must make sure that Renderama slaves are active in order to suc-
cessfully launch a rendering job.

• If you have installed any new shaders or plug-ins on your Renderama 
master machine, make sure that you place copies of them in the EI 
Shaders and EI Sockets folders on the Slave machines.

• Some plug-ins use supporting files, such as textures. Make sure that 
these are located inside the EI Sockets folder on the slave machines as 
well.

• If networks use substandard network cables, switches, hubs, or has a 
lot of traffic, this will impede network rendering performance, or even 
make it impossible to complete a job.

• If you are doing a local (batch) rendering, make sure the enable button 
next the word “local” is activated.
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• On the Macintosh, make sure that Ethernet is the chosen Connect Via: 
option in the TCP/IP control panel. Neither Appletalk, PPP or any 
other connection method will work.

9.4 Multiprocessor Slave Rendering

By specifying unique port numbers Renderama can communicate with 

more than one copy of Renderama Slave. This means it is possible to run 

multiple copies of Camera simultaneously on a slave, each rendering a sin-

gle frame on its own processor. Is your slave a dual-processor Mac or PC? 

You can render two frames at once.

First a bit about the terms we use to describe network rendering. There are 

two network rendering applications, Renderama (the master), and Ren-

derama Slave. Renderama distributes jobs to copies of Renderama Slave on 

the network. In addition, Renderama can act in “Local Mode”. This means 

Renderama can also distribute frames to a copy of Camera located in the 

same directory as itself. A Slave installation consists of a folder containing a 

copy of Camera, the EI Sockets folder, EI Shaders folder, EI Resources 

folder, Renderama Slave application and the .rsrc files (PC) and EI Shared 

Memory Lib.bundle file (Mac). 

To set up your slaves, make a copy of the slave folder for each processor. If 

you are going to be running a batch job, you will need only one copy of the 

slave (see “Multiprocessor Batch Rendering” below).

We recommend that the slave folders be a the same level of the file system 

hierarchy. Please do not put one slave folder inside another or in the same 

folder as the Renderama Master. 
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Launch the copies of Renderama Slave in the folders and give them each a 

unique port number. Quit and restart the Renderama Slaves. On the master, 

launch Renderama and add an entry for each slave’s IP:port. When you 

render, the master will treat each slave as an independent computer and 

will send control files and support files to each. A separate copy of Camera 

will be launched to render each frame.

9.5 Multiprocessor Batch Rendering

It is now possible to render in local mode and simultaneously use a slave 

on a dual-processor computer. This requires that you have two processors 

and enough memory for two copies of Camera, one copy of Renderama 

Slave, and one copy of Renderama.

You will have two folders on your computer, one containing the original 

Animator installation (for local mode rendering) and the other will be a 

slave installation. Do not install the Slave folder inside the Animator folder.

Launch Renderama Slave in the Slave folder and give it a different port 

number than the Slave in the EIAS Animator folder has. 

Note It is important that the port number of the Renderama Slave be different because, 

even though you aren’t using the Renderama Slave in the Animator folder, Ren-

derama will look at the preferences for Renderama Slave and communicate in Local 

mode using the set port number.

Launch Renderama in the Animator folder, add a new slave with the IP of 

the computer you are using and the port number of the Slave you just cre-

ated.
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With Local mode and the Slave enabled in Renderama, two copies of Cam-

era will now be launched when a job begins.

9.6 Subframe Still Rendering

You can now split up stills into pieces, send them to different slaves and 

have them stitched back into a single image. Renderama does this all for 

you.

The Render Control window, Info tab now has a new item, Frame Strip 

Total. This edit box tells Renderama how many pieces (strips) to divide up 

the single frame render job into. The default is 1, which means the image 

won’t be divided at all. That is, a single frame will be sent Renderama. A 

value of 2 will divide up the frame into 2 pieces. A value of 5 will divide up 

the frame into 5 pieces. And so on.

The frames are divided up horizontally, sent to each slave and then reas-

sembled into a single, finished image. 

This feature was designed to aid those doing very high resolution print 

work and extremely complex raytraced stills.

Figure 9.7 — Render Control Window — Network Tab
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9.7 Plugin and Shader Subfolders

Please make sure that, in every folder that you use Renderama Slave, the EI 

Sockets folder and the EI Shaders folder do not contain any subfolders. 

Camera does not automatically search subfolders when running in Slave 

mode. This restriction does not apply to the folder that you run the Ren-

derama master from. 

9.8 Manual Stitching

The File Menu of Renderama contains a command, Stitch... This command 

can be used to stitch together an incomplete rendering. Issue the stitch 

command and then choose the folder with the unstitched Image files. You 

will be asked for a filename to save the final Image file to and the frame rate 

of the animation. The frame rate is stored with the Renderama Job. Since 

you are stitching outside of the normal job process, you must supply the 

proper frame rate.
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Radiosity

10.0 Introduction

The Radiosity Engine calculates the distribution of light energy within a 

scene. First the amount of light directly striking each surface is determined. 

Then, in subsequent steps, or iterations, the diffusely reflected light hitting 

each surface from all other surfaces in the scene is calculated. This process 

is repeated until one of two conditions are met — all of the light except a 

very small amount (the “error”) has been accounted for in the entire scene 

or a prescribed number of iterations have been completed. 

The accumulated light value is stored at each vertex in the scene. If these 

values differ by more than a certain amount between two adjacent vertices 

on a face, that face is subdivided.

As you can imagine, scenes with large numbers of light sources and mil-

lions of polygons will cause the Engine to generate exponentially large 

numbers of new polygons. Achieving a solution in a practical amount of 

time is best accomplished through approximation.

The Radiosity Engine provides two different methods to compute the light 

distribution. The Hierarchical method uses various approximations to dra-

matically reduce the time required to reach a solution, but in doing so, may 

introduce visible artifacts. It also has severe memory restrictions that keep 

it from handling all but the smallest scenes. The Progressive method is very 

robust, and handles nearly any scene without artifacts, but it relies on 

many more calculations, and therefore, takes more time to reach a solution.
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10.1 Overview

The Radiosity Engine is a separate application (named Radiosity) that runs 

when you want to calculate or recalculate a radiosity lighting solution. It is 

used before rendering with Camera takes place. Therefore, it has no ani-

mateable parameters.

The basic approach is to choose which lights and groups in your scene to 

calculate, pick a solution method, adjust the settings, and then tell the 

Engine to begin. The Engine calculates the light distribution, subdivides 

the groups into larger numbers of polygons, and then writes out a FACT 

file (the radiosity solution FACT file). Animator will tell Camera to use the 

groups in the new FACT file instead of the original ones when rendering. 

Stored in this FACT file along with the polygons are radiosity color verti-

ces. These are displayed as luminance in both Animator and Camera. 

Since the radiosity color appears as luminance, you can add regular Phong 

lighting on top of it. This means you can choose to use the Engine to calcu-

late the overall, “ambient”, lighting in your scene and still add detail lights 

(spotlights, tube lights, etc.) as well. This allows a hybrid approach for get-

ting the warm feel of the Engine without forcing you to calculate every bit 

of light in the scene using it. 

Figure 10.0 — Radiosity Application Icon
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The Engine considers three types of light sources: Phong lights (radial, 

spotlight and parallel light), any FACT group in the scene that you want to 

emit light, and a Phong light that uses an external FACT model to define its 

shape.

Note Do not assign a plugin object (e.g. Ubershape sphere) as a light source The Radios-

ity engine will not receive the proper geometry and error will result.

The last two choices are virtually the same. Assigning a FACT model to a 

Phong light lets you use the lights convenient reference control when aim-

ing and positioning the emitter.

You can disable the display of the Radiosity colors on a group-by-group 

basis using the “Display Radiosity” check-box in the Display tab of the 

Group Info window. This defaults on (displays the colors). 

Note As with most check boxes, right mouse clicking (Ctrl-clicking on Macintosh) will 

bring up a menu that allows you to change the settings for all or a selection of 

project groups.

Figure 10.1 — Group Info Window, Display Tab
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10.2 Setting Up Geometry and Lights

Geometry can receive light, emit light, or be completely invisible to the 

Radiosity Engine. Two parameters have been added to the Material Info 

window, Diffuse tab for controlling the amount of light emitted and 

reflected by geometry during radiosity calculations.

Energy Reflection. For those groups that receive light this parameter con-

trols how much energy reflects to other objects in the scene.   The Engine 

works by first distributing light to polygons directly visible to it. Then 

those polygons distribute a portion of that light to polygons visible to 

them. The process is repeated until most of the light has been distributed. 

Energy Reflection controls how much light is passed on from the group to 

other groups in the scene. Range of values [0 - 1]. Most objects in real life 

fall into the range of .35 to .85. Few are less than .15.

Radiosity Intensity. For those groups designated as light sources this 

parameter controls how much light is emitted. Range of values [0 - 40000].

Light sources (Radial, Spot, and Parallel) can be designated as light emit-

ters for the Engine. The Radiosity tab has been added to the Light Info win-

dow to control the behavior of these lights. 

Figure 10.2 — Material Info Widow, Diffuse Settings
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Radiosity Intensity. This controls how much light is emitted. Essentially 

the light intensity of the light source.   Range of values [0 - 40000].

The Engine emits light from a surface. Phong light sources don’t have a 

surface, therefore the Engine provides two ways of creating a surface for 

the light.

Use Size. This radio button tells the Engine to use the light size parameter 

in the Properties tab of the Light Info window to create a virtual object for 

the emission of light.

Note Do not forget to set the size when using Phong lights for Radiosity. If you do, the 

Engine will arbitrarily set the size to 1.0. This will be unlikely to yield the results 

you desire.

Figure 10.3 — Light Info Window, Radiosity Tab
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Use File. This radio button tells the Engine to use an external FACT file as a 

light emitter. Selection of this option brings up an open-file dialog box for 

the selection of a FACT file from your file system.

Once the FACT file has loaded, you will see a wireframe representation of it 

in the View windows. The light controls (rotation, translation, reference) 

will position the light and its FACT emitter in the scene.

If the FACT file contains multiple groups, all groups will be merged into a 

single emitter object.

The color of the Phong light itself, as set in the Properties Tab of the Light 

Info window, will be the emitted color.

Enable Geometry. This is a quick way to turn off and on the use of an exter-

nal light emitter. If instead you change the state of the radio buttons from 

Use File to Use Size, the scale information and the reference to the external 

FACT file will be lost. 

Emit Both Sides. Tells the Engine to emit light from both sides of the FACT 

object. 

Scale. Allows you to scale the size of the FACT emitter.

Inherit. Causes the FACT emitter to be scaled by the parents of the Phong 

light. This allows the Phong light to inherit scale from the project hierarchy.

Open... Allows you to select a different FACT file as an emitter.
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10.3 Radiosity Controls

The Radiosity setting dialog box is brought using the Render menu at the 

top of the screen. It contains all of the controls to vary the behavior of the 

engine, the list of lights and objects the engine will consider and the but-

tons used to initiate the solution and to update the scene with the solution 

once the engine has completed its task.

 

Go. Pressing this button launches the Radiosity Engine beginning the solu-

tion process. 

Update. When the Engine completes its calculations, the Update button 

highlights. Pressing the button updates the radiosity solution. You will 

then see the results in the View windows (the windows must be in Hard-

Figure 10.4 — Radiosity Settings Dialog
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ware mode). If the Automatic/Manual radio button is in Automatic mode, 

you won’t have to press this button. Animator will update the solution for 

you.

Control Tab

Display/Render Solution. This tells Animator to use the computed solu-

tion when drawing groups in the four View windows (the windows must 

be in Hardware mode) and when rendering to Camera.

Allow Lighting of Solution. When this button is on, all lights in the scene 

are treated as Phong lights. Their lighting is added to any existing radiosity 

solution. This applies to what is displayed in the four View windows and 

what is sent to Camera for rendering.

Turning this button off disables every Phong light in the scene. The only 

lighting displayed and rendered is that computed by the Radiosity Engine.

Job Name. This is the name of the FACT file (radiosity solution file) that the 

Radiosity Engine will use to store the modified groups and their radiosity 

color vertices. There is only one of these files per project. By default, this file 

is stored in the same folder as the project file.

Folder... Lets you choose which folder in which to store the radiosity solu-

tion FACT file. 

Default. Causes the radiosity solution FACT file to be stored in the same 

folder as the project file.
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Find... Lets you search for the radiosity solution FACT file. Useful if you 

have move the project to another computer and Animator can’t locate the 

file.

Time. Controls how often Animator checks to see if the Engine has com-

pleted its solution. Only applies when the Automatic/Manual radio button 

is in Automatic mode.

Automatic/Manual. Controls how the solution is updated after the Engine 

begins running. In Manual mode, you must hit the Update button to see 

the solution. In Automatic mode, Animator checks periodically to see if a 

solution has been completed and then updates the solution when it detects 

that the Engine is done. 

Synchronize. This insures that the solution being used is the current solu-

tion.

Reset. Deletes all the radiosity information from the project. Deletes the 

radiosity solution FACT file.

Message Box. This section of the dialog box contains status messages about 

the last solution calculated.
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Solution Tab

Default. Resets the contents of the Solution tab back to their factory 

defaults.

Method. This pull-down menu lets you select either the Hierarchical or 

Progressive solution methods.

Time Limit. Complex scenes may take a long time to solve, especially 

when using the Progressive method. In a production setting, there may be a 

limited amount of time to run the solution, and it is desirable to take the 

best solution achievable during that time. The maximum time a calculation 

is allowed to run is controlled by entering the desired number of seconds. 

When the solution is not complete, but this time is met, a final pass will be 

run and the solution will be output. Range of values [0 - 84000].

Figure 10.5 — Radiosity Settings, Solution Tab
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Iterations. Applies only to the Hierarchical method. This value determines 

the number of times to cycle through the solution process— each time suc-

cessively lowering error values until the Minimum Energy Level is met. 

Higher values provide better results but take more time. If the scene 

appears too dark, or there is not enough inter-patch reflection present, the 

number of Iterations should be increased. If the scene isn’t intended to 

have much indirect illumination, a lower value will be sufficient. Range of 

values [1-100]

Polygon Offset. The Radiosity Engine functions more efficiently if there is 

a small gap introduced between the sides of each two-sided polygon. The 

size of this gap is controlled by the Polygon Offset. This value should be as 

high as possible without causing visual artifacts in the solution. Range of 

values [0 - 1].

Color Strength. If a white polygon is placed near a red one, the white poly-

gon will appear slightly red due to the diffuse light reflected from the red 

polygon. This called color bleed. The Color Strength setting acts as a multi-

plier in the color bleed calculation. A value of 1 allows full color bleed 

between polygons. A value of 0 allows no bleed at all. Range of values [0 - 

1]. 

Visibility Precision A polygon will only directly receive energy from poly-

gons visible to it. There are two ways that visibility can be determined. 1x1 

casts a single ray between the center of each polygon. 4x4 casts sixteen rays 

between the polygons. This is more accurate but takes longer to calculate.

Visibility Tolerance. Often, one polygon is only partially visible to another. 

When this happens, the Engine determines the degree of partial visibility 

and, depending on how the Visibility Error value is set, may subdivide the 

polygons. The effects of this setting are most apparent along shadow 
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boundaries. If shadow edges appear ragged or are ignored altogether, this 

setting should be decreased. Note that decreasing this value will cause 

more polygons to be subdivided increasing the amount of time required to 

reach a solution. Range of values [0 - 1].

Final Subdivisions. When the solution is complete and the radiosity val-

ues are distributed to all of the polygons, the Final Density controls how 

much additional subdivision will take place. Additional subdivision can 

improve the quality of shadows in the solution. If blocky shadows are the 

only complaint, increasing the Final Subdivision Density is a good 

approach. Otherwise, adjusting the Refinement Level would be a better 

first choice.

Source Density. Often scenes contain large polygons that will likely be sub-

divided several times as the solution is calculated. If these large polygons 

are divided into smaller polygons before the Engine begins calculating, the 

solution is often reached more efficiently. The Subdivision Density value is 

the degree to which this initial subdivision will occur for emitters. Increas-

ing the value will increase the number of polygons subdivided. Range of 

values [0 - 100].

Receiver Density. Often scenes contain large polygons that will likely be 

subdivided several times as the solution is calculated. If these large poly-

gons are divided into smaller polygons before the Engine begins calculat-

ing, the solution is often reached more efficiently. The Subdivision Density 

value is the degree to which this initial subdivision will occur for receivers. 

Increasing the value will increase the number of polygons subdivided. 

Range of values [0 - 100].

Proximity Compensation. When two polygons intersect or are in close 

proximity to each other, the solution becomes more computationally inten-
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sive. There is a trade-off between the quality of the solution and the time 

consumed estimating the light transport between the polygons. Increasing 

the Proximity Compensation value improves the quality of the solution but 

increases the calculation time. 

Resolution Level. The higher this value is set to, the larger the size of the 

polygons considered by the Engine. When the Resolution Level is set too 

high, blockiness will result because small details are being ignored by the 

Engine. Range of values [0 - 40].

Refinement Level. This is the most significant variable for controlling the 

quality of the solution. The Engine works to meet this value when charac-

terizing the transport of light energy throughout the scene. It affects the 

quality of shadows and how well the overall transport is approximated. If 

the solution is blotchy or artifacts are visible, raising the Refinement Level 

may resolve the issue, although performance will suffer.   Range of values 

[0 - 40]

Minimum Energy Level. Regardless of how long the Engine calculates, 

there will always be some amount of light energy left to distribute. The 

Engine stops calculating when the amount of energy left to distribute 

reaches this value. Lowering this value will increase the quality of the 

resulting scene, particularly when a scene is dim to begin with. Perfor-

mance will improve with higher Minimum Energy Levels. Range of values 

[0 - 1]
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Light and Objects Tabs

You tell the Engine which objects and lights to use by adding them to the 

lists contained in these tabs. 

To make a group part of the radiosity scene, select it in the Project window 

or one of the View windows. Then click on the Add button in the Objects 

Tab.

You add lights to the radiosity scene in a similar way. Since geometry can 

act as a light, you can click on a group or a light in the Project window or 

one of the View windows and then click on the Add button in the Light 

Tab.

Figure 10.6 — Radiosity Settings, Objects Tab
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10.4 Polygon Quality

The direction a polygon faces is critically important in determining the 

overall radiosity solution. If a light is facing away from a surface, it will not 

directly illuminate that surface. Similarly, the direction a polygon faces is 

significant when determining whether any of the energy reflected from it 

reaches other surfaces.

Depending on whether the “Cull Backfaces” check-box is turned on in the 

Group Info window, the Engine will treat polygons as one-sided or two-

sided. Two-sided polygons emit and received light from both sides. In the 

Engine the polygon will be turned into two polygons facing back to back.

Therefore, turning off “Cull Backfaces” can double the number of polygons 

that the Engine must solve for.

Objects with complex polygons are currently not handled. Please break up 

complex polygons into quads and tris. Objects that are poorly tessellated, 

i.e. objects that have long thin triangles and strange, inset regions, may not 

be solved for properly by the Engine. While perfect, regular tessellation is 

not required, please try to provide well-tessellated geometry.

Polygons with holes aren’t handled and may lead to visual artifacts, usu-

ally triangular-shaped areas that have a different radiosity intensity. These 

polygons must be broken up in your architectural modeler before export-

ing to FACT.

10.5 Radiosity Engine Interface

The engine has a simple status display that gives information about the 

solution being computed. It has two status bars at the bottom that track the 

progress of the engine. The lower bar indicates the particular part of the 
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solution the engine is working on (visibility testing, ray casting, etc.) The 

upper bar indicates the progress of that part. In Figure 10.7 below, the Visi-

bility Calculations are half-way complete.

When the engine completes its solution, it quits automatically. You can quit 

it ahead of time by using the Abort or Quit commands under the File menu. 

There are also options to Pause the solution (or continue again) and to hide 

or show the status display.

Figure 10.7 — Radiosity Engine Status Display
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10.6 Putting It All Together

Here are the basic steps required to create an animation using the Radiosity 

Engine and Camera:

• Open your project file and choose the groups that will receive light 
directly (from light sources) and indirectly (reflected from objects in the 
scene).

• Add those groups to the Objects tab in the Radiosity Settings dialog.
• Choose the groups and the Phong lights that will be acting as light 

emitters and add them to the Light tab in the Radiosity Settings dialog.
• Set the Size parameter of the Phong lights (that don’t have attached 

FACT files) in the Light Info window.
• Set the Radiosity Intensity of the Phong lights in the Radiosity tab of 

the Light Info window
• For the Groups that act as emitters, set the Radiosity Intensity value in 

the Diffuse tab of the Material Info window.
• Go to the Radiosity Setting dialog, Control tab and choose either Hier-

archical or Progressive.
• Hit the Go button in the Radiosity Settings dialog. The Engine will 

launch and begin computing a radiosity solution.
• When the Engine is done, hit the Update button in the Radiosity Set-

tings dialog. You will now see the solution in the Four View windows 
(the windows must be in Hardware mode). 

• Render a snapshot to Camera.
• At this point you can adjust the Radiosity settings, add Phong lights 

and rerender to Camera or recompute the radiosity solution and hit the 
Update button again.
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10.7 A Few Extra Notes

Animator stores the radiosity data as color vertices in the FACT file. A bit 

flag tells Animator and Camera if the color vertices are to be used as regu-

lar color (the kind Amorphium Pro paints on) or as radiosity info. When 

used as radiosity info, the color is applied to the ambient channel of the 

group. There are three conclusions you can draw from this:

1. A group can't have both color vertices and radiosity vertices at the same 

time.

2. The Ambient controls in the Material Info window can be used to reduce 

(but not increase) the radiosity intensity or tint its color. These controls can 

be animated for flickering light effects.

3. Plugins scan access the radiosity vertices the same way they access the 

color vertices of the model...since its stored in the same place.
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Selection Sets

11.1 Introduction

Although this chapter is deceptively short, it discusses a seemingly simple 

part of EIAS that grows in importance with the complexity of the project: 

Selection. Just as image-editing and illustration applications have multiple 

methods of selecting elements based on their attributes, then acting on 

them in ways unique to the selection process, we have widened the scope 

of how selections are made in EIAS Animator — of how they are used to 

organize a project, and how they can be used to create special effects.

To move an object or access the material attributes of a group, you must 

first select the object or group. This is done by clicking once on the object, 

either in the world views or Project Window, or by dragging a rectangle 

around one or more groups. To facilitate selections which are larger in 

scope, the Select menu allows you to select models and groups by a variety 

of methods.

The Select Menu has a selection type, By Set. A set is simply a defined col-

lection of groups from within a project. The By Set menu option allows you 

to edit selection sets, or select items in the project that already belong to an 

existing set. The hierarchical menu below By Set initially contains a single 

entry, Edit Sets. As sets are created their names will appear in this space.

Selection sets are used for light inclusion/exclusion lists, glow layers, Cam-

era maps, and, of course, typical selections. Selection sets will come in very 

handy as you work with EIAS Animator.
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11.2 Select by Set

Sets have four uses in EIAS. 

• To select groups of items within the project
• To include or exclude groups from a light’s illumination
• To control the glow radius and glow intensity for a set of models
• To control which objects receive projections from Camera Maps.

To create a selection set:

1. Choose Select>By Set>Edit.
2. The Sets window, show below in the illustration “Selection Sets Win-

dow” on page 321, opens.
3. In the Selection Sets column, click Add. When prompted, create a name 

for your set.

The name of the selection set will be appended to the Select>By Set menu.

Figure 11.0 — Select Menu
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The Selection Sets Window
Selection

Sets

The left column, Selection Sets, contains the names of all existing sets. Once 

you create your set its name will appear in this column. New sets can be 

created and old sets can be deleted using the Add and Remove buttons. 

The Sort pull down gives you the option of viewing the list of sets alpha-

betically or in their creation order.

Members The right column, Members, shows the members of the set that is high-

lighted in the left column. To add members to an existing set, go to the 

Project window and highlight the names of the groups to be added. Then 

return to the Selection Sets window. 

In the left column, highlight the set name to which you wish to add the 

objects and click on the add button on the right side of the dialog box. 

Members of sets or whole sets can be removed by highlighting the item and 

clicking on the remove button.

Figure 11.1 — Selection Sets Window

Grow
Region
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Find Tools

Find, Find Again... and Find All... can be used to search the names of 

objects in the Project window for a particular alphanumeric sequence. It’s a 

handy way to locate a particular object when your project grows to a very 

large size.
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Using and Animating Groups

12.1 Introduction

In EIAS Animator, geometry that is animated and rendered are referred to 

as groups. Typically, a single group corresponds to a single layer or object 

within a model file. Groups can exist as independent entities, or within a 

hierarchy. Groups can be translated (moved, rotated and scaled), deformed, 

have its materials animated, and so on. Groups can be imported from other 

programs (into the native ElectricImage FACT format) or be created by a 

variety of plug-in programs. A group can have as many as 250 or more ani-

mation channels, many of which can be individually enabled or disabled 

(others by the class of animation channel). Each channel can be controlled 

independently by you. All of the channels can be placed into the function 

curve editor for animating, or you can pick individual channels.

Each group can contain an unlimited amount of points, lines and polygons 

and texture maps. There are no limits to the amount of groups that you can 

have within a project, memory permitting.

To import a FACT model into a project:

1. Choose Object>Import Object...

2. Select the Model name from the file list
3. Double click or press the Add button
4. Click the Done button when finished

The model will now appear in the world view windows, and the file name 

of the model will appear in the Model File section of the Project Window. 

The model’s groups will appear in the group section of the Project Window.
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Model formats from other programs can be imported into EIAS Animator. 

Several popular formats are supported.

To import a foreign model format into a project:

1. Choose Object>Import Object...

2. Select the Model name from the file list
3. Double click or press the Add button
4. Click the Done button when finished

The model will now appear in the world view windows, and the file name 

of the model will appear in the Model File section of the Project Window. 

The model’s groups will appear in the group section of the Project Window.

As mentioned previously, groups can exist individually, or as part of a hier-

archy. Hierarchies enable complex motions to be created, using groups 

linked in “chains” or “trees.” Hierarchies are also required if you wish to 

animate your groups with inverse kinematics.

12.2 Importing 3D Text

In addition to adding and importing models into EIAS Animator, you can 

also create font models from Adobe® PostScript® Type 1 fonts or Apple® 

TrueType™ fonts. The font outlines are converted into polygons, and 

depending upon your choices, extruded into 3D and even bevelled.

To add 3D text into a project:

1. Choose Object>Add 3D Text...

2. Select a Font from the file list (a font does not need to be installed in the 
system in order for it to be converted into 3D — the fonts can reside on 
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any disk)
3. Type in the font letters that you desire in the text box
4. Click OK (The 3D Font Options dialog box opens)
5. Set the extrusion height and bevels and element colors (if desired)
6. Click the OK
7. Save the font model

The font model will now appear in the world view windows, and the file 

name of the model will appear in the Model File section of the Project Win-

dow. The model’s groups will appear in the group section of the Project 

Window.

Bevel Size

This edit box contains a value that sets the size of the bevel (the default is 0 

for no bevel). The value of the bevel size is in units relative to the other val-

ues in the dialog box. A negative value will bevel inside the original fount 

outline, and a positive value will bevel outside the original outline.

Figure 12.0 — 3D Font Options
EIAS Animator        325



Chapter 12  Using and Animating Groups — Importing 3D Text
Bevel Angle

This edit box contains a value that works in conjunction with the Bevel 

Size edit box to set the degree to which the bevel will occur on the font, as 

viewed from the side.

The default is 45°; an angle smaller than 45° will cause the bevel to recede 

towards the center of the model (as viewed from the side); an angle larger 

than 45° will cause the bevel to advance away from the center (as viewed 

from the side).

Fillet Sides

This edit box contains a value that creates a rounded bevel. You can add a 

rounded edge to the font instead of an angled bevel by increasing the value 

in the Fillet Sides edit box to a value larger than zero. The value determines 

how many segments are to be used in the fillet. For a good, rounded 

appearance, a value of 6 to 8 is sufficient.

Note Filleting adds many polygons to the model and increasing the amount of time it 

takes to create the 3D object.

Create Back Bevel

This check-box option, when enabled, creates a font model with back facing 

bevels as well as front facing bevels.

Reverse Back Bevel

This check-box option, when enabled, reverses the angle of the back bevel 

so that it is opposite the front bevel. This can result in a “stepped”, pyra-

mid-like bevel or fillet.
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Default (Character Grouping)

Causes the 3D test to be created in a hierarchy with the extruded sides as 

the parent group to the front face, back face, front bevel and back bevel.

Similar Sides

Causes similar faces of all characters in the font model to be grouped 

together, such as both bevels in one group and both faces in another group.

Whole Characters

Causes all faces of individual characters in the font model to be grouped 

together as single groups.

Smooth Angle

This edit box contains a value that determines the angle at which a hard 

edge appears between polygons when using the Fix Smooth Shading 

option.

This feature works by comparing the angle of the polygon to the angle of 

the polygon next to it. If the angle is greater than the value in the Smooth 

Angle edit box, the polygon will shade as a hard edge. If the angle is less 

than the value in the Max Angle edit box, the edge will smooth shade.

Fix Smooth Shading

This check-box option, when enabled, creates hard edges when smooth 

shading a model.

Max Angle

This edit box contains a value that determines whether the font outlines are 

sampled in a course or smooth fashion. The default angle is 4°, meaning 
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that the outline will be sampled so that there is no angle greater than 4° 

along the edge of the resulting model, providing a fairly smooth text. The 

larger the angle, the courser the text. If the font you are working with has 

very shallow curves, a smaller Max Angle is advised, but be aware that this 

will create a far greater number of polygons.

Extrusion Size

This edit box contains a value that gives a font depth. The default distance 

for the extrusion is 30 units. To make the resulting text flat (2D), set the 

value in the Extrude edit box to 0.

12.3 Group Info Window

Like all other object classes in EIAS Animator, groups have an information 

window associated with them that allow you to control a variety of 

options. The group info window contains basic non-material attributes for 

the group (such as position, rotation, scale, and so on), as well as an access 

point to the group’s material record. The Group Info Window is divided 

into conveniently organized folder tabs, each containing the controls and 

functions indicated by the name of the tab. To access the contents of a tab, 

just click on it.
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The group info window is divided into the tab section, Material ball icon, 

and configuration check boxes. The four folder tabs are:

• X-Form (Transformation)
• Shading
• Shadow
• Info
• Display

Figure 12.1 — Group Info Window

Figure 12.2 — Material Ball
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Base Options

On the left side of the window you will see either two or four options, 

depending on what type of object it is. They are not linked under a folder 

tab, and remain visible at all times.

Show Extent Box

This check box toggles on and off the display of group bounding boxes in 

the 3D views.

The Material Ball

The material ball shows shading properties that are set for the current 

group (it is does not show texture maps or procedural shaders.)

The following two options will only appear if the group’s geometry is generated by 

an active plug-in.

The Plug in Button

When a group is comprised of data generated by a plug-in, clicking this 

button will open the plugin’s configuration window. 

Live Plug in

This checkbox toggles on and off the active recalculation of a plugin’s 

parameters when the time thumb is moved (a great time saver.) 

For example, if you have a Mr. Nitro group in your project, every time you 

move the time thumb Mr. Nitro will recalculate the position of the group’s 

fragments.   A particle system will do exactly the same thing. Unchecking 

Live Plug-in will disable this calculation, removing the need for you to type 

Alt-Period (Command-Period) to prevent recalculation.
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The X-Form Tab

The X-Form (Transformation) Tab contains spaces which contain X, Y, and 

Z values for the three geometric transform values of a group: 

• Position
• Rotation
• Scale
• Auto Edit Y Z
• Animated Visibility

Position. Displays the position data at the current scene time.

Rotation. Displays the rotation data at the current scene time.

Scale. Displays the scale data at the current scene time.

Auto Edit Y Z. When on, the scale value entered in X will automatically be 

copied to Y and Z. This is a simple way to enforce non-uniform Scaling.

Animated Visibility. Animator has always supported two methods of con-

trolling object visibility. The Visibility check box and the Visibility Channel. 

Figure 12.3 — X-Form Tab
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The check box can be used to turn off the object (and the object’s children if 

they are set to inherit visibility) over the entire duration of the project. 

When this check box is turned off, the object disappears from the view win-

dows.

Visibility Channel can be animated. You can put the Project window into 

Frame Mode and change the entries to/from On/Off. During rendering, 

the object (and the object’s children if they are set to inherit visibility) will 

only be seen if the channel is set to On for the frame being rendered. 

Note Unlike the check box, using the Visibility Channel to prevent an object from ren-

dering does not remove it from the View Windows.

Animator allows you access to the Visibility Channel directly through the 

Group Info window, X-form tab and the Light Info window, X-form tab. A 

new section, “Animated Visibility” has been added. This is the only check 

box in Animator that animates. You can use it as a convenient way to access 

the Project window’s Visibility Channel. 

Figure 12.4 — Project Window — Frame Mode 

Visibility
Check Box

Visibility
Channel
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In the position section, you will see a popup menu where you can select 

Implicit or Explicit keyframe interpolation. The following section will 

explain the differences in these two types of interpolation. Following this 

section we will continue with the explanation of the Group Info Window.

Implicit and Explicit Interpolation

All vectorized quantities in EIAS Animator (position, reference, center, etc.) 

have an extra pulldown menu in their info windows. This pulldown con-

trols whether the quantity is Implicitly or Explicitly translated. Explicit 

translation allows separate control in our curve editor for each of the three 

components (X,Y,Z).

To make an object’s Translation explicit:

1. Open the Group Info window for a given object. Make sure that the X-
Form window is in the foreground.

2. Change the translation of the particular Transformation characteristic 
from Implicit to Explicit.

The illustration below shows the Position translation being changed to 

Explicit.

The translation value for the object’s position is now explicit. Repeat these 

steps for any other value to change its transformation.

Figure 12.5 — Changing Implicit to Explicit
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The Shading Tab

The shading tab contains attributes which let you specify the shading 

behavior of the group. 

The Shading tab is divided into seven sections:

• Shading Pop up Menu
• Sampling Pop up Menu
• Fog Section
• Reflection Section 
• Line Section
• Blur Section
• Color Section
• Geometry Section
• Texture Section

Figure 12.6 — Shading Tab
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Shading Pop Up Menu

The Shading pop up menu allows you to set the rendering level for the 

group. The items offered in the menu are the same as the choices offered in 

the Camera pop up menu found in the Render tab of the Render Informa-

tion Window. The items offered and their definitions are covered on 

page 250.

Sampling Pop Up Menu

The Sampling pop up menu allows you to set the level of sampling, or anti-

aliasing, that the group will receive. If you choose the option labeled 

“default,” then the group will be sampled at the level set in the Anti-Alias 

tab in the Render Information Window. If you choose a sampling level 

other than “default,” the object will be sampled up to the level of sampling 

that you have selected. The actual level of sampling the object receives is 

again dependent upon the sampling level settings in the Anti-Alias tab of 

the Render Information Window. If you choose a level in the Anti-Alias tab 

that is lower than the level that you have chosen for the object, the level of 

sampling will be limited to the setting in the Render Information Window. 

If you choose a sampling level that is lower than the setting in the Render 

Information Window, then the level of sampling will not extend further 

than the sampling level set in the Shading tab of the group. For more infor-

mation and definitions of the other choices in the menu, please refer to 

page 273.
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Fog Section

Fog Enable

This check box enables the group to be affected by any of the global fog set-

tings in the World Info Window’s Fog Tab. When this box is unchecked, 

the object will not be affected.

Reflection Section

The items in this section are pertinent only when automatic reflections such 

as mirror or environment maps are used somewhere in the scene. They are 

otherwise ignored.

Cast No Reflection

Enable this check box if you don’t want the group to cast a reflection onto 

another group. 

Reflection Object Only

Checking this box will force the group to not render in the scene, but other 

objects will be able to see it in their reflections.

Line Section

The attributes in this section affect wireframe shading options only. They 

do not affect the cell/outline shader settings found in the geometry tab of 

the Material Editor. 
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Shade Lines

When a group’s shading popup is set to wireframe, this check box enables 

the material attributes assigned to the group to actually shade the wire-

frames of the group. Very cool.

Line Size (pixel)

Use this value to set the line thickness in pixels for wireframe shading. A 

value of 0.0 will use the global line thickness settings in the Render Infor-

mation Window instead.

Motion Blur Section

Blur Mode Popup

There are three options for motion blur for every group:

• None
• Point /Line
• Motion Vector

None. No blur is used for the group (default)

Point/Line. This blur option should be used if you wish to blur groups con-

taining points and lines. The line size value is also used by this option 

when active.

Motion Vector . A very high quality fast motion blur that most closely 

approximates real photographic motion blur. This setting is the best to use 

in about 90% of the cases you will come across. At times, the effect does 

break (such as a fan inside a cage). At those times, you can set the Motion 
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Vector setting at the group level, and choose both the Frame Multisample 

(set the sample value to 2 and increase as necessary) and Motion Vector set-

tings (use the default) in the Render Information Window. The combination 

of these two blurs can usually satisfy all but the most ardent critics!

Color Section

Smooth Across Faces

Enables the shading of the group to smoothly blend across the faces that 

make up the group’s shape. If you want to see the individual faces defined, 

disable this check box.

Color Blend

Blends the color of the vertexes of the group together. Typically, the ver-

texes of a group are a single color, rendering this option useless. However, 

you can create some nifty special effects if you have the ability to color indi-

vidual polygons (most modelers do) and use this feature. For example, you 

can create a tail cone of a jet with black colored polygons around the edge 

of the cone closest to the outlet, and the color the polygons around the sec-

tion closest to the body gray. Enable this checkbox and shade. See how the 

colors blend together? For added realism in this example, don’t color all of 

the polygons black around the outlet, leave some gray. It looks even better 

now. This is basically a throwback to the old CGI days, before texture map-

ping was common.

Vertex Transparency

Certain plug-ins are able to set transparency values for geometry on a poly-

gon by polygon basis. This will be very useful for plug-ins that simulate 
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fire and other such effects. This type of transparency will be used by the 

render if this is checked.

Glow Object Only

This option will not shade the group, but will allow its glow settings to be 

used by the renderer. When combined with particle systems, for example, 

what you essentially end up with are “fuzzy particles.”

Geometry Section

This section contains controls which directly affect the group’s geometry 

during the rendering process.

Cull Backfaces

Removes back facing polygons (those not seen by the camera) so that they 

are not shaded at render time. This speeds up rendering (didn’t think we 

could get any faster?) and is great for eliminating the double specular effect 

present with transparent objects.

Reverse Normals

You can reverse the normals of a group with this option enabled. Unlike 

most rendering engines, EIAS Animator understands that polygons have 

two sides regardless of the normals for the polygons and will shade the 

model accordingly. You can turn the group inside out with this feature, or 

better yet, combine it with the Cull Back faces option. Try this: add a model 

(don’t use the standard shapes plug in with this feature) of a sphere and 

enable both of these features. When you render, you will see the inside of 

the back of the sphere. Combine this with edges set to transparent and you 

will have yourself the beginnings of a planet atmosphere!
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Texture

When groups contain UV information, you have the option of using that 

information to apply texture maps.

Use UV space. This check box will enable the UV space feature.

Wrap Horizontal. This option will allow the UV space to wrap in the hori-

zontal axis. This will prevent a visible seam from appearing.

Wrap Vertical. This option will allow the UV space to wrap in the vertical 

axis. This will prevent a visible seam from appearing.

Shadow Tab

The shadow tab controls the shadow casting properties of the group. There 

are five check boxes in the tab:

• Cast Shadow
• Receive Shadow
• High Precision Shadow
• Generate Shadow Mask
• Shadow Object Only

Figure 12.7 — Shadow Tab
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Cast Shadow. Enables the group to cast a shadow onto other groups. 

Defaults On.

Receive Shadow. Enables the group to receive shadows from other groups. 

Defaults On.

High Precision Shadow. Improves the quality of the shadows that fall 

upon this group. Defaults Off, because it is usually not needed. If you do 

not like the way a shadow appears as it falls upon this group, high preci-

sion shadow’s alternative filtering method might improve the look of it.

Generate Shadow Mask. Creates a “shadow cutter” using this group. The 

group effectively becomes a mask wherever a shadow from another group 

would fall upon it. The sections of the group outside of the shadow would 

be rendered with a value of zero (black) in the alpha channel of the image. 

You can use this to assist in realistic compositing of rendered objects into 

real world scenes, and so forth. Use the diffuse color channel to determine 

the color of the “shadow” that this group becomes. Defaults to Off.

Shadow Object Only. Forces the group to be rendered only during the 

shadow pass, not during the final render. With this feature you can create 

low resolution shadow casting groups to make things render even faster! 

Defaults to Off.
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The Info Tab

This tab stores information about the group’s creation date, the amount of 

points, lines and polygons in the group, and the extent of the group’s vol-

ume.

Figure 12.8 — Info Tab
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The Strength Tab

This is where the strength maps that control the behavior of the skinning 
engine are applied and managed. In addition the strength painting inter-
face is accessed in this tab. For detailed information on the Strength Tab See 
“Strength Maps” on page 569.

Figure 12.9 — Strength Tab
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The Display Tab

This tab controls the display of the group in the 3D view windows. It is 

composed of three controls:

• Display Mode Popup Menu
• Display (limited) Polygons
• Display Texture
• Shade Texture
• Display Radiosity

Display Mode Popup Menu. The Display Mode popup menu allows you 

to choose the level of shading that will be used. 

Display (limited) Polygons. The display every Nth edit box allows you to 

set an amount of polygons to display that is less than the total number of 

polygons in the group. 

Display Texture. The display texture check box will shade the group with 

the top-most diffuse map visible.

Figure 12.10 — Display Tab
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Shade Texture. Causes the lighting to be taken into account when display-

ing textured objects in the World View windows. works with both the Soft-

ware and Hardware engines.

Note OpenGL blends the surface color (diffuse color) with the shaded color. To avoid 

unwanted coloration in the view windows, make sure your textured objects have a 

white diffuse color.

Display Radiosity. Causes the radiosity vertices to be displayed on the 

group. For information about radiosity, see “Radiosity” on page 301.

12.4 Motion Data Import/Export

EIAS imports motion capture data from three different file formats and 

exports it to four. The three import formats support group names for the 

models that will receive the motion data. If groups with matching names 

are found in the project, the data be added to those groups. If not, Animator 

will offer you the opportunity to create a model using effectors instead.

All data is imported as custom frame data. Make sure that groups receiving 

imported data have animation enabled.

.bvh. The BioVision Hierarchical format, .bvh, is the preferred format for 

importing motion data. It includes a header that accurately describes the 

model hierarchy. by using this format you insure that the lengths of the 

links between groups will be taken into account when the data is imported.

.bva. The BioVision Flat format, .bva, should only be used for groups that 

are not in a hierarchy.
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.obm. The Electric Image Motion format, .obm, is designed to exchange 

camera motion data between different animation programs or between 

EIAS Animator and a motion control rig. This format can accept group 

names with spaces in them. The .bvh and .bva formats do not.

.ma. This Maya format is used by Animator to send camera motion data to 

Adobe After Effects. You can only export camera motion to this format. 

Import is not supported.

Using the Motion Data Import Feature

The Motion Data Import feature is available through the Animation > 

Import Motion... submenu. There is no need to select (highlight) groups 

before issues the command. Animator compares the group names in the 

header of the motion data file to those in the project and adds the data to 

the matching groups.

Figure 12.11 — Motion Import Dialog
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Offset Filter. Adds an offset to the position data during import.

Rotation Filter. Adds an offset to the rotation data during import.

Motion Samples:Time. Displays the duration of each sample (one over the 

number of samples per second).

Motion Samples:Total. Displays the number of samples present in the 

motion capture file.

Start. Controls which sample to begin with when the data is imported.

Rotation Order. Enables a change in the rotation order, either the groups 

rotation order or the order in the capture file.

Change Rotation Order. Changes the rotation order of the groups to force 

them to conform to the rotation order in the capture file.

Process Motion Data. Changes the rotation order in the capture file to con-

form to the current groups’ rotation order.

Convert Right To Left System. Modifies the coordinate system of the 

imported data so it corresponds to the ‘handedness’ used by EIAS Anima-

tor.

Using the Motion Data Export Feature

The Motion Data Export feature is available through the Animation > 

Export Motion... submenu. Select (highlight) the groups you wish to export 

motion from before issuing the command.
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Selected with Children. Motion data is written out for the selected groups 

and all groups linked to them. This option is only available for the .bva and 

.bvh formats

Selected Only. Motion data is written out for the selected groups only.

Frame Range. Selects the range of frames for which motion is exported.

Output CR/LF to End of Line. Alternate line termination for systems 

requiring CR/LF at the end of each line.

Numeric Precision. Selects how many digits to the right of the decimal to 

export.

Use Object’s Rotation Order. Uses the rotation order of each object when 

writing out the file. The default is to use YXZ as the rotation order for all 

groups. Option not available when exporting .ma files.

Figure 12.12 — Motion Export Dialog
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Filter Object’s Rotation Order. Alters the rotation order on export to the 

pull-down menu setting next to this option. Option not available when 

exporting .ma files.

Reference are exported as. Objects with reference vectors (cameras, spot-

lights, etc.) are exported using the rotation order specified. Option not 

available when exporting .ma files.

Output Field-Of View for cameras. Causes the FOV to be written out 

when cameras are exported to the .obm format. 

Output Scale Factors. Causes scale information to be written out for effec-

tors, groups, smoke objects and IK handles.s

ASCII Motion Version. This edit box contains the version number that will 

be written into the header of the .ma file. This option only available when 

exporting to .ma. 
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Function Curve Editor

13.0 Introduction

The Function Curve Editor is a powerful feature which lets you graphically 

create, edit and apply animation information to virtually any parameter in 

a scene. Function curve editors have formed the basis of some of the most 

powerful character animation software anywhere.

What is a Function Curve Editor?

The Function Curve Editor is a window which allows animators to graphi-

cally control animation data in the form of a curve which represents 

changes in time and data values. All animation channels can be edited with 

a function curve, with the exception of color.

The Benefits of Using the Curve Editor

The art of animation involves many subtleties. Good animators know that 

to add those subtleties can be an exercise in tedium. The function curve edi-

tor is intended to make that task easier. By being able to edit the curve as it 

enters and exits a keyframe, the animator has more control over each key-

frame, leading to more control to the overall animation and the realism of 

the shot. At the very least, using the Function Curve Editor will assist the 

animator in creating complex motion using fewer keyframes, saving time 

in the process.
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Accessing the Curve Editor

There are two ways to open the Function Curve Editor:

• Choose Animation>Function Curve Editor

• Type command or control ‘.

The Function Curve Editor opens.

13.1 The Function Curve Editor Anatomy

The Function Curve Editor is divided into three sections:

• Graph Window
• Channel List
• Tool Bar

Graph Window. The graph window contains the function curves that 

graph the actual channel data, the time line, and the data scale. The time 

line is displayed at the top of the window area. It is the same time line in 

the project window, and functions indentically. The data scale displays data 

values which change depending upon the window magnification. The 

combination of the time scale and data scale is used to plot the channel 

curves.

Channel List. To the left of the graph window is the channel list. The chan-

nel list is where all of the loaded channels are displayed. Each channel is 

represented by individual curves. The channel list is covered in detail on 

page 356.
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Tool Bar. Above the channel list and the graph window is the tool bar. The 

tool bar contains icons which are used to control the display of the function 

curve editor, the display of elements within the editor, and the loading and 

saving of channel envelopes. The Tool bar is covered in detail on page 358.

Initially, there won't be any channels loaded into the Editor. Channels are 

loaded by two methods:

• From the project window, by double-clicking on the animation channel 
names in the particular object that you want to work with.

• Using the Key Channel Loader described in the Tool bar section of this 
document.

You can load in as many channels as you like from as many different 

groups as you like. Virtually any animation channel, except RGB color, can 

be loaded into the editor.

Figure 13.1 — Function Curve Editor (with channel data)
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13.2 The Graph Window

The graph window is used as an interactive display to modify the effects 

between two or more keyframes. Through the use of the graph window, 

keyframes may be added and deleted, as well as modified. Acceleration/

Decceleration and Velocity are optionally plotted as well, depending upon 

toggles set in the tool bar. See “The Tool bar” on page 358 for more information.

The active channel curve is drawn in white. All other curves are drawn in 

the color next to the channel name. (See “To set the curve color:” on page 357.)

Time and data ranges can be selected by dragging in the areas to the right 

and bottom of the graph window. These ranges are indicated by darker 

gray regions in the graph window background. The display of these 

regions can be toggled by clicking on the time and data range icons in the 

tool bar. See “Time Range” on page 363 and “Data Range” on page 363.

There are a variety of commands and shortcuts available in the Graph Win-

dow.

Figure 13.2 — Graph Window
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The Tab Key. Can be used to restrict the axial movement of the keyframes. 

Tab once to restrict in X, tab again to restrict to Y, tab again to restrict diago-

nally, tab again to restore free movement. 

Command Clicking. Command clicking on a key will break or mend the 

control handles.

Option Clicking. Option-clicking (or option-clicking and dragging) will 

add a new key to the point on the curve on which you clicked.

Shift Clicking. Shift clicking or marquee selecting a group of keys will 

allow the keys to be dragged together.

Control-Drag. Holding down the control key as you drag a key will inter-

actively scale the curve (requires that a time range be selected first).

Keypath Drag. Drag the curve between two keys to drag both keys. This 

allows you to drag a section of the curve.

Dragging the Window. Hold the space bar down to drag the entire Graph 

Window.

Toggle Linear. Command-Control clicking on a key will toggle the linear 

buttons in the Key Channel Dialog box for that key.

Cut and Paste. Cutting and pasting sections of the curve requires that a 

time range be selected first.
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13.3 Channel List

The channel list contains all of the loaded channels in the function curve 

editor. Each curve in the graph window corresponds to one item in the 

channel list. All channels added to the list are added to the bottom. The list 

cannot be reordered. The black circle to the left of each channel name con-

trols the display of the curve for that channel. Clicking on the curve will 

change the visibility of the curve (the circle will turn transparent when the 

curve is not drawn.)

Command Click adjusts 

slope of handles

Option Click adds new 

keyframe

Shift Click selects multiple keys

Figure 13.3 — Keyboard Shortcuts
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The channel list display area can be resized by dragging the right edge next 

to the scroll bar left or right (the cursor will change as indicated below.)

Each channel in the list has a separate color to plot its curve in the graph 

window. The color swatch next to the name of the channel is used to set the 

curve color.

To set the curve color:

1. Click on the color swatch for the desired channel.
2. Choose a new color from the color picker.
3. Click the OK button to accept the new color.

The new curve color will now be set.

The selected channel will always draw its curve, regardless of the channel’s 

visibility setting in the channel list.Double clicking the channel name in the 

list will bring the Key Channel Window for that item forward. 

The loading and saving of channel envelope information is controlled by 

icons in the tool bar. 

Figure 13.4 — Channel List
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13.4 The Tool bar

To effectively edit motion and time data, some special tools are required. 

The Function Curve Editor comes with its own set of tools which are used 

to edit data splines, load motion data, and various other tools to manipu-

late the motion data. The following sections will detail the function of each 

Tool icon and it’s menu items.

Add Folder

Add Folder will create a folder in which to place your channel data. You 

can organize your data easily by using folders. 

To add a folder to the channel list:

1. Click on the Add Folder icon in the tool bar

The folder will appear at the bottom of the list.

It is typically best to name the folder the by group name, and place chan-

nels that are specific to that group in the folder, thereby drawing a logical 

connection between the two.

To rename a folder:

1. Select the folder name
2. Press the enter key

The text will change to indicate that you can now edit the text

3. Type the new name for the folder.

Figure 13.5 — Function Curve Editor Tool bar
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4. Press enter to accept the change.

You can nest folders within folders, and drag and drop the order of folders 

in the list. You can also hide or reveal folder contents with the display icon 

next to the folder.

To remove a folder from the channel list:

1. Select the folder
2. Press the delete key

Note The contents within the folder will be deleted along with the folder.

Edit Mode

Edit mode has three options:

• Edit Curve Data
• Edit Time Range
• Edit Data Range

Edit Curve Data. This is the default edit mode for the function curve edi-

tor. This mode allows the normal editing of curve data.

Edit Time Range. This mode will allow you to set the range of time in 

which you will be editing. Setting a time range makes data management 

easier. The cursor will change to indicate that you are in time edit range.

Edit Data Range. This mode will allow you to set the range of values that 

you will be editing. This helps you to control the way that data is displayed 

in the editor. The cursor will change to indicate that you are in data range 

edit mode.
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Envelope

Envelope allows you to load values into and save data out from curves 

described in the Graph Editor (See the Graph Editor section below.)   These 

curve files are called “envelopes.” Envelopes may be loaded or saved 

across the entire time range or across a selected range of time.

One of the benefits of using a computer is that it can do the repetitive work 

for you. You can easily load motion data from motion capture device data 

files, other groups or function curves from another EIAS Animator project. 

By saving and loading envelopes from other channels, you can reuse exist-

ing motion data and customize it for your current animation project. This 

works very well when doing repetitive motion, such as animating a set of 

humming bird wings, a trail of ants taking over a picnic, or matching blink-

ing light patterns.

Clicking on the Load icon brings up a drop down menu with four choices:

• Load to Replace All...
• Load to Insert Into Time Selection
• Save All...
• Save Within Time Selection

Load To Replace All. This menu choice will replace all of the keys with a 

previously saved channel envelope. Selecting this menu choice will present 

the standard Macintosh file open dialog from which you can select an enve-

lope file. Envelope files can be saved from other channels or motion capture 

data files. 

Load to Insert Into Time Selection. Using this option will replace the 

selected time frame with the saved data envelope. If the inserted envelope 

is larger than the selection area, keys outside the selection area are scaled to 
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allow for the inserted envelope. Inserting an envelope works as if a slice of 

time is being inserted at the selection area. If the selection area is the same 

size in time as the envelope, keys outside the selection are unaffected. If the 

envelope is smaller than the selection area, keys following the selection 

area are shifted to an earlier time in the time line.

Save All. Use the Save All function to save all keys in the selected function 

curve. This effectively saves an entire channel as an envelope which can be 

loaded at a later time

Save Within Time Selection. Using this option, you can save all keys 

located within a selected range to an envelope file.

Key Channel Loader

As its name suggests, the Key Channel Loader is used to add key channels 

into the Curve Editor. Select the object(s) in the Project Window, then use 

this tool load in all of or a selected group of animation channels. Once 

loaded, the channels are displayed in the channel list. The circles to the left 

of the channel names may be used to turn off the display of the channel in 

the graph window. Channel may be removed from the editor by selecting 

them in the channel list and hitting the delete key or by using the clear 

under the edit menu.

All. All channels for the selected object(s) are added to the key path editor. 

Depending on the selected object, there may be as few as 7 or as many as 30 

or more channels added to the editor via this option.

Custom. Loads the channel selected using the Custom... view option in the 

project window.
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Specific. Using the Specific option, you can import channels of selected 

types only. This option works well when you only need to edit a single 

attribute on many objects, such as the visibility property. Since some 

attributes have interrelated channels, those too will be loaded. For exam-

ple, loading the Material type will load as many as 22 channels, while the 

Transform type will load 9 and the visibility type only one.

Make folder. When this check box is on, a folder will be created in the 

channel list and all channels placed into it. The object name in the project 

window will be used to name the folder.

Color Preferences

Use to set the default color for curves displayed in the graph window of the 

Curve Editor. Clicking on this option invokes a dialog box with editor 

attributes accompanied by a color bar for customizing the color used for 

each attribute. You may use any color combination which is comfortable for 

Figure 13.6 — F-Curve Editor — Add Channels dialog
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you, although selecting non-contrasting colors may make it difficult to dis-

tinguish between editor attributes.

Graph Display Element Control

This pulldown changes the on/off settings of the last nine controls repre-

sented in the tool bar. Since, these nine controls can be turned off or on by 

clicking on them, this particular tool is redundant and will likely be 

removed.

Grid. Displays a horizontal and vertical grid.

Ruler. Toggles the visibility of the time and range scales.

All Curves. Toggles whether the selected channel or all channels are dis-

played.

Velocity. Displays the velocity graph.

Acceleration. Displays the acceleration path.

Snap Undo. Displays the Snap Undo path.

Current Time . Displays the current time marker.

Time Range. Displays the time ruler.

Data Range. Displays the data ruler.

Grid Options

This menu controls the grid. Both the spacing of the visual grid and the 

snapping grid are controlled here. To activate snapping, make sure that the 

caps lock key is set.
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Key Channel Window

The Key Channel window is used to set the curve type for each channel, 

and the beginning. You can also manage individual keyframes through the 

key list. Get to know this window well, as it will offer you the ability to fine 

tune your function curves, and get the most out of your animation efforts.

The Motion Type Menu

The motion type menu determines the type of spline curve used to calcu-

late the interpolation of the data in the channel. There are four different 

curve types:

• Linear
• Natural Cubic
• Hermite
• F-Curve 

Linear. Straight line between the keys, no interpolation.

Figure 13.7 — Key Channel Window
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Natural Cubic. B-Spline interpolation, no controls. Use where you want 

automatic smoothing.

Hermite. More versatile than Natural Cubic. The whole curve won't 

change when one key is adjusted.

F-Curve. Contains control handles for fine adjustment. This will give the 

best control and is similar to Bezier curves.

The Left & Right Extension Menus

The beginning and ends of function curves can have a variety of behaviors. 

This allows you to create repetitive motions quickly and easily, and has the 

added value of transmitting any changes to the carried over curve sections, 

if desired.

Hold. The hold option maintains the value of the starting or ending point 

of the curve.

Repeat. This option will cause the entire curve to repeat itself in a cycle.

Oscillate. The Oscillate option will make the curve repeat itself in a mirror-

image fashion.

Accumulate. The Accumulate option will make the curve repeat in a cycle 

but in each cycle, the data from the previous cycle is added on.

The Key List Subsection

Individual channel keys are displayed in the keylist to the lower left of the 

Key Channel window. Keyframe attributes are displayed when a particular 

keyframe is selected in the list. There are several attributes that are control-

lable on a keyframe by keyframe basis:
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• Time
• Value
• Spline-specific controls

Time and Value Edit Boxes. You can change the time or value of the 

selected keyframe. Enabling the Hold Value check box will force the value 

of the slope between the selected keyframe and the next keyframe be main-

tained until the next keyframe: no interpolation will occur. This will appear 

as a flat line until just before the next keyframe in the Function Curve Edi-

tor.

Spline Specific Fields. This section displays different controls depending 

upon the spline selected in the Motion Type popup menu:

• Linear
• Natural Cubic
• Hermite
• F-Curve

Linear. There are no additional controls for the Linear Motion Type.

Figure 13.8 — Keyframe List
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Natural Cubic. There are no additional controls for the Natural Cubic 

Motion Type.

Hermite. There are controls for the Tension, Bias, Continuity attributes of 

the acceleration and velocity of the curve. You can type the values in 

directly, or hold down the T, B, or C keys (lower case is fine) and dragging. 

You will see the acceleration and velocity curves change as you adjust the 

value. You will also clearly see changes in the actual motion path drawn in 

the world view windows. You can linearize the values by checking the Lin-

ear button.

F Curve. Controls for the keyframe vectors will appear if the Motion Type 

is set to F-Curve. The keyframe vectors are the little “teeter bars” that 

appear at each keyframe. There are separate vectors for the left and right 

side of the keyframe. You can set the vector angles by clicking and drag-

ging on the vectors, or by typing values directly into the edit boxes. In 

addition, you can linearize the spline segment by enabling the Linear but-

ton. When the beginning or ending keyframes are selected, on the left or 

right vector will be displayed.

There are also two check boxes for slope control, which affect the shape of 

the curve, and how the curve is interpolated through its control points:

Continuous Slope. Causes the curve to be smoothed along both sides of 

the control point equally.

Automatic Slope. Causes the curve's adjoining slopes to be adjusted for 

smoothness.

Editor Display Scale. The Editor Display Scale box allows you to scale 

individual curves so that they can be displayed together in the Editor. For 
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example, lets say you have a X motion curve that runs from 0.0 to 4444 over 

4 seconds and you also have a roll channel that goes from 0.0 to 5 degrees 

over the same 4 seconds. Using the Editor Display Scale you can set the 

scale of the X motion to 1.0 and the roll to 889. In this way, both curves will 

be visible in the Curve Editor and the same time. The Editor Display value 

for each channel is listed as a percentage after the channel name in the 

channel list.

Snap

When a data or time range is edited within the Function Curve Editor, the 

original path becomes the Snap value. The Snap command stores the 

present position of a curve in memory. This allows you to display the origi-

nal path while you make changes to it. You can make adjustments to a 

function curve and revert back by clicking the Unsnap option or saving the 

new curve as the snap value (or new original) by clicking the Snap option.

Range

Ranges are highlighted sections of the Graph Window. The tools in this 

menu allow you to select a time or data range and to operate on sections of 

a curve within the range.

The range itself is created by dragging in the white band just below (time 

range) or just to the right (data range) of the curve editor. The Time Range 

and Enable Range buttons must be on for the range to be displayed (see 

below). 

Set Ranges… Brings up a dialog box that allows you to type in values to 

create the range instead of dragging the range at the right or bottom of the 

Graph Window.
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Fit to Range. Scales the curve to fit within the selected time range.

Fit to Data Range. Scales the curve to fit within the selected data range.

Move to Beginning. Move an entire channel’s keyframes to start at the 

beginning of the project time.

Reverse Time. Reverses the order of keyframes reversing the animation.

Reverse Data. Reverse keyframes to reverse data values

Key Time Range. Converts the extension portion of the curve in the 

selected time range to keyframes.

Fit Curve To Data in Time Range. This option fits a curve to custom key-

frame data with a tolerance setting. The original custom data is deleted. 

You can use this setting to turn motion capture data into motion curves.

Grid Enable

This button toggles the display of the grid in the graph window.

Time Scale Enable

This button toggles the display of the time scale, the value scale, and the 

time thumb control. The time thumb display mode (seconds, timecode, 

frames) can be changed by option-clicking on the control.

All Paths

When this button is off, only the channel highlighted in the channel list is 

displayed in the graph window.
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Velocity Display

Toggles the display of the velocity curve. The velocity curve is updated as 

you make changes to the channel curve.

Acceleration Enable

Toggles the display of the acceleration curve. The acceleration curve is 

updated as you change the channel curve.

Current Time

Toggles the vertical time line that crosses through the editing field.

Time Range

Toggles the display of the selected time range. The Time Range is chosen by 

dragging in the white region just below the Graph Window. Copying and 

pasting takes place inside the chosen Time Range.

Data Range

Toggles the display of the selected data range. The Data Range is chosen by 

dragging in the white region just to the right of the Graph Window.

Automatic Channel Scaling

In previous versions of ElectricImage, when you added channels to the 

Function Curve Editor, you had to manually adjust the panning controls to 

see the selected curve. (Because of the differences in values, curves for dif-

ferent channels can be in drastically different positions on the graph.) Now, 

selecting a channel in the editor causes the curve to be placed within the 
370       EIAS Animator    



Chapter 13  Function Curve Editor — Anatomy
center of the graph window (note that view scale is unchanged.) To change 

the behavior of this feature, you can use the “Automatically Scale Graph” 

preference in the Preference Widow: Keypath Editor > Automatically 

Scale Graph. 

Interactive View Scaling

You can interactively scale the graph window of the function curve editor 

by clicking on any zoom icon, and then dragging. The direction that you 

drag will affect the zoom. Remember that there are two zoom factors for 

the graph editor (time and value) which can be independently controlled. 

Work with this for a couple of minutes to get the hang of it.
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Project Window

14.0 Introduction

The Project window is the heart of animating in EIAS Animator. This single 

window offers the control of virtually every parameter in your project, in 

time line form or spreadsheet form. It is in this window that you set the ani-

mation mode in which to view and edit a project, and where you can 

observe and animate all of the attributes within the project file.

Some animators love the project window, while others loathe it. While 

there are certain operations that can only be performed in the project win-

dow, whether or not you need to use them is up to your method of work-

ing. There are definitely easier tools to use if you so prefer, such as: the 

function curve editor for animating everything in motion curve form; the 

morph editor for morphing and facial animation (the function curve editor 

works great for this as well); the time palette for setting the scene time; and 

the various menus for controlling the various attributes of an object or 

series of objects.

The project window includes many useful tools which can make the task of 

using it much easier. There are tools to limit the amount of data presented, 

so that you are not overwhelmed by larger projects. There are tools to con-

trol the way that data is listed in the window, so that you can find what you 

want to edit quickly. There are also tools which allow you to animate 

almost exclusively from the project window itself. Take some to read 

through this chapter, and learn about the tools that the project window 

offers you. Afterwards, use this chapter as a reference to keep you up to 

speed on the project window. You will find that once you get to know it, the 

project window will be a very valuable tool indeed.
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The project window is very complex, due to the fact that it is the single 

repository of all information in your project. Every project attribute is listed 

in the project window, typically in hierarchical fashion (although you can 

control this). As your animation projects get more complicated, the data 

presented in the project window will grow. Be sure to read about the useful 

tools that the project window offers to assist in handling copious amounts 

of data.

Project Concepts

The project window is an environment of its own which exists in the over-

all EIAS Animator environment. As such, there are several discussions that 

this chapter will focus on:

• tools which you can animate
• tools which can help you animate
• tools to help you organize your scene
• tools which help you control your work environment

Tools Which You Can Animate

EIAS Animator allows you to animate almost any attribute of any object in 

your scene. These attributes are called “animation channels.” Animation 

channels contain the animation data that is used to drive your animated 

content. Animation channels contain either keyframe and/or frame data, 

and can be viewed in time line or spreadsheet form. Individual cells of a 

spreadsheet equate to either a single frame or single field of data for an 

attribute. Sections “Animation Channels” on page 385 and “Editing Cell 

Contents” on page 399 covers what you can animate, and the methods in 

which you can edit your data.
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Tools Which Help You Animate

EIAS Animator can be used to literally create a “universe” As such, things 

can get a little busy. To help you manage this, there are several tools offered 

in the project window which allow you to hide the parts of the project that 

you aren’t’ dealing with at any given time. The sections “Project Window 

Anatomy” on page 377 and “Project Editing Modes” on page 390 describe 

the architecture of the project window, and its contents, as well as how to 

work within the various editing modes offered.

Tools to Help You Organize Your Scene

Organizing large amounts of data can always be a pain. The project win-

dow can be configured to let you navigate through your projects more eas-

ily, and to help organize and structure the files and objects that you deal 

with. Sections “Project Window Anatomy” on page 377 and “The Tool Bar” 

on page 408 offers insight into organizing your projects and managing 

scene data.

Tools Which Help You Control Your Environment

Lastly, the overall environment in which you work can be set up to allow 

you a more efficient work experience. Tool offerings let you control the 

frames per second of your project, the amount of time which your project 

represents, and the methods in which the project window displays the con-

tents of your project. The section “Project Window Anatomy” on page 377 

will help you to better work within the project window environment.

The topical sections mentioned above will cover the many functions that 

you can control with the project window. Here is a list of the topics that are 

covered in the sections:
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• Showing and hiding groups, (page 410)
• Showing and hiding animation channels, (page 385)
• Activating and deactivating animation channels, (page 386)
• Controlling the visibility of objects in the scene, (page 379)
• Locking and unlocking objects in the scene, (page 379)
• Setting the project window edit mode, (page 390)
• Editing animation and timing data, (page 388)
• Naming and renaming objects, (page 381)
• Creating and editing hierarchies, (page 381)
• Editing scene timing, (page 415)
• Setting the current scene time, (page 390)
• Setting the scene frames per second value, (page 378)
• Assigning channels to the function curve editor, (page 419)
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14.1 Project Window Anatomy

At any time, the project window can be opened by the either of the follow-

ing methods:

• From the main menu bar, choose Windows>Project Window

• command (Mac) or control (PC) “l”

Once opened, the project window will appear as illustrated in Figure 14.1.

Figure 14.1 — Project Window Anatomy (time mode displayed)
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The project window structure is divided into several areas which are used 

for controlling animation channels, setting window and time view 

attributes, and other scene properties. Those areas are:

• Frames per second (FPS) popup menu
• Value/name edit field
• Edit mode popup menu
• Tool bar
• Object/channel enable/disable flags panel
• Object/channel name panel
• Channel data panel

Frames Per Second Popup Menu

The FPS pop-up menu is used to select the number of frames per second to 

be calculated and rendered.

Along with duration, FPS determines the total number of frames for the 

animation (i.e., if the duration is 10 seconds, selecting 30 FPS calculates and 

renders 301 frames—frame 0 plus 300 frames).

The menu choices are:

Custom… This option opens a dialog box that enables you to specify a 

number other than the NTSC (30 FPS), PAL (25 FPS) or motion picture (24 

FPS) standards.

Figure 14.2 — Custom frames per second dialog box
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The frames/second edit field is where you can enter a real number (num-

bers with decimals) to specify the recording/projection speed you need to 

work in. The interlace check box will properly set up your project file for 

video interlace, allowing you to animated per field.

NTSC: 30. This option uses the NTSC video standard of 30 FPS.

NTSC: 30i. This option uses the NTSC video standard of 30 FPS, but with 

interlacing. Each frame is split into two fields, so that in Keyframe and 

Frame modes the data panel will show frames as 0a, 0b, 1a, 1b, 2a, 2b, etc.

PAL: 25. This option uses the PAL video standard of 25 FPS.

PAL: 25i. This option uses the PAL video standard of 25 FPS, but with 

interlacing. Each frame is split into two fields, so that in Keyframe and 

Frame modes the data panel will show frames as 0a, 0b, 1a, 1b, 2a, 2b, etc.

Film: 24. This option uses the motion picture standard of 24 FPS.

The Flag Panel

Located down the left side of the Project window, this panel, as shown in 

Figure 14.1, shows flags indicating the status of an object’s visibility and 

selection locking.

The status can be changed by clicking on the appropriate icon:

• Clicking the visibility control toggles the visibility of the object. Invisi-
ble objects are not rendered, but animation information will be passed 
to their children (if so hierarchically structured).

• Clicking the selection lock prevents the object from being selected in 
the World View windows. It may still be selected in the Project win-
dow, however.
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Pressing the Option key while clicking either of these controls will toggle the status 

of both the group you are clicking and any groups hierarchically linked below it.

The Object/Channel Name Panel

Located to the right of the flag panel, the Object/Channel Name panel, as 

shown in Figure 14.1, displays a list of all of the objects and channels in the 

project. The object/channel name panel can be used to perform the follow-

ing operations:

• Selecting objects in the scene
• Accessing the object’s information window
• Rename objects in the list
• Creating a hierarchy
• Breaking a hierarchy
• Show or hide children of objects
• Show or hide object data channels

The appearance of an object’s children (groups hierarchically linked below 

the parent group) in the Object Name panel can be toggled on and off by 

pressing command (Mac) or control (PC) “h”.

To select objects in the project window list. Objects can be selected by 

clicking on their icons or on their names. 

Object Info

Window

The object info window displays pertinent information about an object at 

the current scene time. It is commonly used to set, shading attributes, mate-

rial attributes, motion data, and scene display settings for the object.

To access the object’s info window. There are two ways to access an 

object’s info window from the object name panel:

• Double-click on the object
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• Select the object, and choose Object>Group Info (command or control 
“i”)

Naming objects is important to help organize your projects. Naming 

objects clearly (and concisely!) will make finding objects in the project win-

dow easier, and help other animators working with you to understand 

your scene layout more quickly.

To rename an object in the project window:

1. Click on the object’s name in the object panel.

The object is selected and the object’s name is put into the edit box, 

highlighted for editing.

2. Type a new name for the object.
3. Press Return.

The new name replaces the previous name in the object panel.

Hierarchy A hierarchy is a collection of related objects, arranged in a tree-like fashion. 

Parent objects contain children objects. Children objects can contain grand-

children objects, and so on. Hierarchy allows for very complex motion to be 

animated with relative ease, or to effectively mimic real life motions of real 

things.

To assign a hierarchy of objects:

1. Select the objects that are to be made children
2. Choose Hierarchy>Parent from the menu bar, or choose the Parent 

icon from the project window tool bar
3. Select the parent object

The resulting hierarchy will be displayed as a tree in the project window.
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To remove an object from a hierarchy:

1. Select the objects that you wish to remove from the hierarchy
2. Choose Hierarchy>Unparent from the menu bar, or choose the Unpar-

ent icon from the project window tool bar

The objects chosen to be unparented will be displayed as such in the object 

list, with no attachments.

The object/channel name panel contains a list of all of the objects in the 

project. You can control the visibility of the object’s hierarchy and anima-

tion channels in this panel. You can show or hide the hierarchy from the 

location of a specific object to the end of the tree by a single key command. 

It is necessary to understand the display of hierarchy in the project window, as ani-

mation channels are attached to objects. If an object is hidden relative to its place in 

the hierarchy, its animation channels will be hidden as well.

To hide the hierarchy of objects attached to the current object:

1. Make sure the project window is open and active
2. Select the desired object
3. Depress command (Mac) or control (PC) “h” (for “hide”)

All of the objects attached to the hierarchy from the location of the object 

downward along the tree will be hidden. A small, downward-pointing red 

arrow will be added to the object icon, indicating that there are hidden 

items attached to it.
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To show a hidden hierarchy:

1. Make sure the project window is open and active
2. Locate the desired hierarchy to unhide
3. Select the object
4. Depress command (Mac) or control (PC) “h” (for “hide”)

The attached hierarchy will be revealed, up to the point that the next hier-

archy was hidden. If nested hierarchies have been hidden, you will need to 

reveal them one at a time.

The Data Panel

Located to the right of the object panel, the channel data panel contains the 

data (attributes) for objects in the project. In all editing modes other than 

Time, the data cells in this panel can be edited.

Displaying Data Channels. When the Project window is first opened, the 

data channels are not displayed. Each object in the object panel can be 

opened up to list its data channels in much the same manner as folders in 

the Finder can be opened up to list their files.

You can also use the Open/Close pop-up menu in the Project window’s pop-up 

menu palette to open and close the display of selected attributes.

When the list becomes longer than the height of the window, you can then 

scroll the window’s contents with the window’s scroll bar.
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Resizing and Scrolling the Display

All panels are resizable by moving the cursor to a vertical edge of a panel, 

clicking on it, and dragging that edge to its new location.

• If the size of the panel becomes too small, the edge will snap to the 
nearest edge of the next panel or window.

• If the size of the panel is too large, the edge stays at the outermost posi-
tion indicating the panel’s maximum size.

The following controls are also available for scrolling the display:

• The horizontal scroll bar in the Object Name panel can be used if the 
names extend beyond the panel’s edges.

• In Frame and Keyframe modes, the horizontal scroll bar in the Object 
Data panel can be used if there are more cells to be displayed beyond 
the right edge of the window.

• In Time mode, the horizontal scroll bar is used to show more key 
frames in the time line, if any.

• All panels can be scrolled vertically with the vertical scroll bar.
• In Time mode, the zoom controls in the lower right corner of the win-

dow can be used to zoom the window. Holding down the Option key 
while clicking either zoom control centers the time display between the 
start and stop times of the project.
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14.2 Animation Channels

Animation channels are containers which hold all of the animation data in 

a project. Each object in a scene has its own unique set of animation chan-

nels. If the data in an animation channel changes over the time span of the 

project, the object is said to be animated. 

Animation channels can be:

• Displayed or hidden
• Activated or deactivated
• Selected or deselected entirely or in part
• Edited numerically

Displaying Animation Channels

Each object entry in the panel list is preceded by a “display channel” icon. 

This icon is similar to icons used by file browsers in popular operating sys-

tems. The icon appears as an arrowhead. When the arrowhead is pointing 

to the right, more data is available by turning it down. 

Channels are available regardless of whether or not they are set to be animated. 

Therefore, the display channel icon will always appear next to an object, regardless 

of the object’s animation channel settings.

To display an animation channel of an object:

1. Make sure the project window is open and active
2. Locate the desired object
3. Click on the display channel icon to show the animation channels for 

the object.
4. For hierarchically-organized channels, follow the above steps until you 

arrive at the desired channel
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Activating and Deactivating Animation Channels

Each object can have potentially hundreds of animation channels, which 

can get somewhat difficult to manage, especially if a scene has hundreds of 

objects. A solution to this problem is to limit the amount of animation chan-

nels that are active in a project.

EIAS Animator defaults all animation channels to OFF. This is important, as you 

will need to activate animation channels for objects that you intend to animate. 

You can change this behavior to default all animation channels to ON in the 

Edit>Preferences>Keyframe tab.

Channels can be activated from the group or channel level, however, if you 

activate a particular channel without also activating the group, the anima-

tion data will be ignored. This behavior allows you to easily disable a chan-

nel while retaining the animation record for the channel.

To activate an animation channel for an object or model group:

1. Open the project window 
2. Locate the object in the name/channel panel
3. Click on the animation flag in the flag panel to the left of the name

The animation record for the object will be activated, as indicated by the 

green arrow. To disable the animation record for the object, just click on the 

animation flag again. The channel will be disabled, as indicated by the gray 

arrow.

To activate the animation record for a specific channel attribute:

1. Follow the previous instructions
2. Open the object channel by clicking on the turndown icon next to the 

object name. 
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A list of channels for the object will be displayed. Some channels will 

contain additional turndown icons. Navigate through the list until you 

arrive at the channel that you wish to animate.

3. Once the channel is located, click on the animation flag to the left of the 
channel name

The channel animation record will be activated, as indicated by the green 

arrow. To disable the animation record for the channel, just click on the ani-

mation flag again. It will turn gray to indicated that the record has been dis-

carded.

Selecting Animation Channels

Animation channels can be selected and deselected in their entirety in any 

one of the three spreadsheet-based edit modes. You would typically select 

an entire channel for the purposes of:

• Recalculating the channel data (if a numerical process was applied that 
needed replacement)

• Adding a special function to the channel data, such as a repeat or cycle 
behavior

To select an entire animation channel:

1. Make sure that the project window is open and active
2. Set the project window edit mode to keyframe
3. Select the desired object
4. Click on the display channel icon to show the animation channels
5. Located the desired channel in the list
6. Command (Mac) or control (PC) click in a cell of the animation channel
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The entire channel will be selected. You can then apply any of several func-

tions or values to the data within the channel. To deselect the channel, just 

click in another cell in the project window.

Editing Animation Channel Data

In any of the three “spreadsheet views” of the project window (keyframe, 

frame and index), you can directly edit the contents of an animation chan-

nel. This feature is included more as a “power user” feature than as a fea-

ture that you would typically need to use.

In the spreadsheet views, data is presented numerically in each cell of the 

spreadsheet. The frame number for each cell is at the top of row of the 

spreadsheet, and the current frame will be highlighted to indicate its selec-

tion.Bold text cells represent key frames, normal text cells represent frames, 

and underline text cells represent custom frames.

Direct values can be typed into the cells, and depending upon the edit 

mode that you have chosen, key frames, frames or custom frames will 

result.

To edit animation data in a spreadsheet cell:

1. Click in the data cell to be edited.

The cell is selected and the cell’s data is put into the value edit field.

2. Type a new value for the cell.
3. Press Return.

The value you typed in the value edit field replaces the previous value in 

the data cell.
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To advance to another cell in the spreadsheet:

1. Click in the data cell to be edited.

The cell is selected and the cell’s data is put into the value edit field.

2. Press the arrow key to advance one cell in that direction

The selection focus will advance to a new cell in the direction of the 

depressed arrow key. The previous cell will be deselected.

You can select a range of cells, and move the entire range focus to another 

area of the spreadsheet in a similar fashion.

To move the focus of a series of selected cells:

1. Select a series of data cells to be edited.

All of the cells are selected, and the first cell is activated for numeric 

entry. This is indicated by outlining the cell border and placing its 

value in the name/value edit field.

2. Press the arrow key to advance one cell in that direction

The selection focus will advance to a new series of cells in the direction 

of the depressed arrow key. The previous cells will be deselected. To 

continue advancing, press the arrow key again.
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14.3 Project Editing Modes

Editing modes determine how your data is presented in the project win-

dow. Three edit modes are spreadsheet-based, with a column of editable 

data for each frame in the project (Keyframe and Frame modes show all 

frames; Index mode shows only the key frames, listed in order of creation). 

The default mode is a time line style representation, which presents key 

frames as diamonds in the window data panel. Which edit mode you work 

with depends upon you, but certain functions such as numeric editing 

require a spreadsheet-based edit mode. The editing mode is selected with 

the editing mode pop-up menu, as shown in Figure 14.1.

There are four editing mode choices are:

• Time Mode 
• Keyframe Mode 
• Frame Mode 
• Index Mode 

Time Mode

The default view is Time mode. In Time mode, the Project window is used 

to set the duration of the animation and the timing of individual events. In 

Time mode, the Project window appears as in Figure 14.3. In this mode, the 

data panel represents key frames as diamonds and interpolated time (time 

between key frames) as bars. A time scale is drawn above the data panel, 

and a time thumb represents the current time (or frame, depending upon 

which display option is set.)
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The display of the project window in time mode is unique to any other 

project window edit mode. It consists of:

• The time thumb
• The time scale
• Active time range

Time Thumb. The time thumb is used to set the current time of the scene. 

To set the time at which events occur in the animation, drag the time thumb 

across the time scale. The current time value in the readout box changes as 

the time thumb is dragged.

You can change the time display of the time thumb from seconds (the 

default) to SMPTE time code, or frames. You can also snap to frames or key 

frames.

Figure 14.3 — Project window in Time Mode view

Time ScaleTime Thumb 
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The time thumb has a contextual menu that can be brought up by Right-

Clicking on it (Ctrl-Click on Macintosh). This menu can be used to modify 

the time display or alter Time Markers.

Time Scale. The time scale is drawn above the data panel. It represents 

time in seconds, regardless of the display that the time thumb is set to. 

Active Time Range. The active time range is displayed in the time scale. 

The active range is bracketed by two markers, one representing the start 

time of the project, and one the end time of the project. The range between 

these markers is the range that is rendered by default when the render 

command is given. 

The start time marker (drawn in green), which appears in the time scale, 

indicates the start time of the project (it defaults to time 0). The project’s 

start time can be changed by clicking and dragging this icon to the left or 

right. The time thumb will snap to the marker.

The end time marker (drawn in red), which also appears in the time scale, 

indicates the stop time, or duration, of the animation (it defaults to 10 sec-

onds). The animation’s stop time can be changed by clicking and dragging 

this icon to the left or right.

Time mode operation allows you to:

• Change the scene time
• Create key frames
• Select Key frames
• Change keyframe timing
• Change sequence timing
• Scale sequence timing
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Changing the Scene Time. To change the scene time of the project in time 

mode, drag the time thumb to the left (smaller time values) or to the right 

(larger time values). Use the time display icon in the project window tool 

bar to change the display of the time scale (seconds, time code, frames). The 

time thumb control will display the current scene time.

Creating Key frames. Key frames are automatically created any time you 

change the current time in the Project window (by dragging the time selec-

tor) and then set an event, such as changing the position of a model, or 

adjusting the color of a light.

Selecting Key frames. Key frames can be selected by clicking on them. You 

can press the shift key to select more than one keyframe. To select a region 

of key frames, drag a rectangle around the region. Selected key frames are 

drawn in red. Selected keyframe sequences are drawn in dark blue.

Changing Keyframe Timing. To change the time for a keyframe, click and 

drag the keyframe to the desired time. If you have a selection of key 

frames, you can change their location in the time line as well by dragging.

Changing Sequence Timing. A sequence is a series of key frames which 

are connected by a bar. To change the timing of a sequence of key frames, 

click in any portion of the bar that is connecting the key frames in the 

sequence, and drag to the desired time.

Scaling Sequence Timing. You can compress or expand the timing of a 

series of key frames or sequences by pressing the control key as you drag 

the mouse to the left or right.
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Keyframe Mode

Keyframe mode displays all events occurring in the project by key frames 

and interpolated frames, as shown in Figure 14.4. Instead of a time scale, a 

frame scale is drawn above the data panel. To differentiate between the two 

types of frames, key frames are drawn in bold text, and interpolated frames 

are drawn in normal text. If animation channels are collapsed, the cell data 

is not displayed. Instead, a key symbol is drawn in the frame column to 

represent that key frames are present for the channel. To view the keyframe 

data, use the display channel icon.

In keyframe mode, you can:

• Set the current frame
• Add new key frames
• Remove key frames
• Edit the contents of keyframe cells

Figure 14.4 — Project window in Keyframe mode

Frame Scale
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Setting the Current Frame. Instead of a time scale to set the current time 

(as is the case in Time mode), you are presented with a frame scale to select 

the current frame (in Figure 14.4, frame 75 is selected). To set the current 

frame, click on the frame number in the frame list row.

Adding a Keyframe. To add a keyframe in keyframe view, click on a cell 

and enter a new value. The keyframe will be set, as indicated by the value 

in the cell being drawn in bold, and a key symbol being drawn in the root 

channel row of the animation channel record.

Removing a Keyframe. To remove a keyframe in keyframe view, select the 

desired keyframe cell and choose Animation>Delete Keyframe. The key-

frame will be removed, and replaced by an interpolated frame. The value 

of the interpolated frame will most likely be different that the keyframe 

value that you deleted.

Editing the Contents of Keyframe Cells. To edit keyframe values in key-

frame view, click in a data cell, and then enter the new value in the edit box. 

If you make a change or addition to a channel that does not contain a key-

frame, a new keyframe is automatically added at that position.

Frame Mode

In Frame mode, the Project window displays all events occurring in the 

project as actual frame values. Unlike Keyframe mode, editing a frame’s 

data in Frame mode changes the value for that frame only—no key frames 

are created and no interpolation will occur; you would be creating data that 

deviates from the key frames you have created and the frames interpolated 

from those key frames. This feature can be thus be used to create inten-

tional “glitches” in the animation. (If you need to, you can always reinter-

polate the frame list by selecting the range of frames and choosing 
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Recalculate Frames from the Keyframe menu, or Recalculate All Frames for 

all frames.)

Changed frame values are underlined in the data cell, and the underline 

remains in the cell if you switch back to Keyframe mode.

In frame mode you can:

• Set the current frame
• Edit frame values (creating custom frames)
• Resetting a frame’s value (removing a custom frame)

Setting the Current Frame. To set the current frame, click on the desired 

frame number in the frame scale. Use the scroll bars at the bottom of the 

window to scroll beyond the frames displayed.

Editing Frame Values. Editing frame values directly will create a custom 

frame. A custom frame is a frame which was not created by interpolation of 

two key frames. A custom frame is drawn as underlined text.

Figure 14.5 — Project window in Frame mode view
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Resetting a Frame’s Value. To reset a frame’s value so that it conforms to 

the interpolation curve, select the frame and choose Animation>Recalcu-

late Frame. The frame’s value will be reset, and the frame will be drawn in 

plain text to indicate the change.

Key Index Mode

In Key Index mode, as illustrated in Figure 14.6, the Project window dis-

plays key frames only, by the order in which they were created for each 

object. 

Instead of a time scale or frame scale, a keyframe index scale is displayed 

above the data panel. This scale represents the order of creation of key 

frames for the channels only. There is no interrelationship of time between 

channels that is maintained in this view.

In key index mode, you can:

• Select the current key index

Figure 14.6 — Project Window in Key Index Mode view
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• Edit keyframe values 
• Display a keyframe in the list

Selecting the Current Key Index. The current index is set by clicking the 

appropriate value in the index scale at the top of the data panel. The time 

values for the key frames are not displayed in this mode.

Editing Keyframe Values. To edit keyframe values in the index list, select 

the keyframe. Its value will be placed in the value edit field. Enter a new 

value to override the previous value.

Displaying an Keyframe in the Index List. To display a keyframe in the 

index list, click on the desired keyframe. Only that keyframe value will be 

displayed. Keyframe values for other channels will not be in sync. It is for 

this reason that Keyframe Index mode should not be used for animating, 

but rather, just quickly checking keyframe data.
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14.4 Editing Cell Contents

From time to time, you may wish to create a particular behavior for a 

motion channel, such as an up and down value for a rotation axis that 

could be used for a wing flap. Or, you may wish to fill the contents of a cell 

over a period of time with a particular value. In fact, there are several filters 

or actions that you can apply directly to the contents of a cell:

• Fill Cell with Value 
• Blend Cell Contents
• Cycle Cell Contents

Filling Cells with Specific Values

The paint bucket icon in the project window tool bar offers a pop-up menu 

(used in Keyframe, Frame or Index modes) that fills the data cells in a range 

of selected frames with a specified constant value. It can also be used to 

invert, scale and offset the values in the selected range frames.

The following options are available under the paint bucket icon:

• Fill Selected
• Fill Constant
• Invert
• Scale
• Offset
• Randomize
• Jolt
• Spring
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Fill Selected. This option fills the selected range of frames with the data 

from the first (left-most frame) in the selection of frames. For example, 

selecting frames 1 through 5 and choosing this option would fill frames 2 

through 5 with the data from frame 1.

Fill Constant… This option opens a dialog box that enables you to specify 

a value that will fill the selected range of frames.

Invert. This option inverts the data in the selected range of frames (positive 

values become negative, and vice versa).

Scale… This option opens a dialog box that enables you to specify a factor 

by which the data in the selected range of frames will be scaled.

Offset… This option opens a dialog box that enables you to specify a value 

by which the data in the selected range of frames will be offset.

Randomize... The randomize function opens a dialog box that enables you 

to randomly change the data in an animation channel. The randomize dia-

log contains three edit items:

• Range Edit Box
• Seed Edit Box
• Relative Check Box

Figure 14.7 — Randomize dialog box
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The range edit box contains a +/- value. Therefore, 5 would yield random 

numbers between -5 and +5. These numbers are added to the current value 

of each highlighted data cell.

The seed edit box contains an initialization value for the random number 

generator. If you find patterns in the random numbers applied, you can 

alter the seed to improve the randomization.

The relative check box, when enabled, causes the Random Range value to 

become a percentage value. The current value of each highlighted data cell 

will be increased or decreased by a random percentage.

Jolt... The jolt function creates an initial shock, followed by a decay. This 

can be used to simulate a camera hitting a small bump as it rolls along the 

road, for example, or perhaps being hit by flak or debris. The jolt dialog box 

contains five edit items and a graphic display of the effect to be applied to 

the data channel:

• Amplitude
• Frequency
• Decay
• Relative
• Reverse
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The amplitude box contains a value that controls the maximum and mini-

mum points on the waveform.

The frequency edit box contains a value that controls the number of com-

plete cycles in the entire waveform.

The decay edit box contains a value that controls the slope of the entire 

waveform.

The relative check box, when enabled, allows the amplitude to be treated as 

a percentage. At the maximum point on the waveform, the value of the 

data cell will be increased by the percent entered in the Amplitude edit box.

The reverse check box, when enabled, inverts the entire waveform.

Spring... The spring function opens a dialog box which lets you imprint a 

wave form which you specify on the data in a selected series of cells.

Because this command adds and subtracts from the current value of the 

data cell, multiple applications of Spring can be used with different fre-

Figure 14.8 — Jolt dialog box
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quencies and amplitudes to create “white noise.” There are nine edit items 

in the dialog, as well as a graphic display of the result to be applied:

• Amplitude Edit Box
• Frequency Edit Box
• Phase Edit Box
• Relative Check Box
• Reverse Check Box
• Decay Edit Box
• Decay Interval Edit Box
• Attack Edit Box
• Attack Interval

Figure 14.9 — Spring dialog box
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The amplitude edit box contains a value that controls the maximum and 

minimum points on the waveform.

The frequency edit box contains a value that controls the number of com-

plete cycles in the entire waveform.

The phase edit box contains a value that shifts the starting point of the 

waveform. Phase may also be changed interactively by dragging the wave-

form in the curve window.

The relative check box, when enabled, allows the amplitude to be treated as 

a percentage. At the maximum point on the waveform, the value of the 

data cell will be increased by the percent entered in the Amplitude edit box.

The reverse check box, when enabled, inverts the entire waveform.

The decay edit box contains a value that controls the slope of the waveform 

from the Decay Interval Bar to the end of the curve.

The decay interval edit box contains a value that controls the length of the 

decay. The decay interval may also be changed interactively by dragging 

the Decay Interval Bar in the curve window.

The attack edit box contains a value that controls the slope of the waveform 

from its beginning to the Attack Interval Bar.

The attack interval edit box contains a value that controls the length of the 

attack. The attack interval may also be changed interactively by dragging 

the Attack Interval Bar in the curve window.
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Blending the Contents of Cells

The gray ramp (blend) icon in the project window tool bar offers a pop-up 

menu (used in Keyframe, Frame or Index modes) that controls the blending 

of data across a range of selected frames (page 388), in order to “smooth” 

the data values in those frames in either a linear or curved fashion. This 

operation is very useful if you wish to smooth out rough moves, or create 

some kind of transition to Project window data values.

Blended frames are custom frames, denoted in the Project window by underlined 

text. Custom frames need to be reevaluated when changed, and that recalculation 

will occur when the animation is previewed, rendered or saved (or when recalcu-

lated manually).

The two types of cell blending offered are:

• Blend Linear
• Blend Curve

Blend Linear. This option uses a linear method of interpolating the data.

Blend Curve. This option uses a curve method of interpolating the data.

Cycling the Contents of Cells

The bent arrow icon in the project window tool bar offers a pop-up menu 

(used in Keyframe, Frame or Index modes) which controls the cycling of 

data across a range of selected frames, causing a sequence to repeat cycli-

cally until the end of the animation. This operation is very useful for repet-

itive motion, such as a 5° rotation on a wheel, or the flapping wings of a 

butterfly. It can be used to increment motion as well.
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Cycled frames are custom frames, denoted in the Project window by 

underlined text. Custom frames need to be reevaluated when changed, and 

that recalculation will occur when the animation is previewed, rendered or 

saved (or when recalculated manually).

The following options are available:

• Repeat
• Oscillate
• Offset Repeat

Repeat. This option repeats the selected sequence of frames until the end of 

the animation. For example, repeating frames 1 through 5 would repeat the 

values from frames 1 through 5 starting with frame 6 and continuing until 

the end of the animation (i.e., the new sequence of frames would be 1, 2, 3, 

4, 5, 1, 2, 3, 4, 5, 1, 2, 3, 4, 5, etc.).

When repeating within a range of key frames, select all frame cells with the range 

except the very last keyframe. This will ensure a smooth transition between repeat 

cycles.

Oscillate. This option oscillates the data from the selected sequence of 

frames until the end of the animation. For example, oscillating frames 1 

through 5 would take the values from frames 1 through 5 and repeat them 

in an oscillating sequence starting with frame 6 and continuing until the 

end of the animation (i.e., the new sequence of frames would be 1, 2, 3, 4, 5, 

4, 3, 2, 1, 2, 3, 4, 5, etc.).

When oscillate repeating within a range of key frames, select all frame cells with 

the range except the very last keyframe. This will ensure a smooth transition 

between repeat cycles.
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Offset Repeat. This option repeats and incrementally adds the values from 

the selected sequence of frames until the end of the animation. For exam-

ple, offset repeating frames 1 through 5 would both repeat and add the 

incremental change in values from frames 1 through 5 starting with frame 6 

and continuing until the end of the animation (i.e., the new sequence of 

frames would be 1, 2, 3, 4, 5, 5+1, 5+2, 5+3, 5+4, 5+5, 5+5+1, 5+5+2, 5+5+3, 

5+5+4, 5+5+5, etc.).

When offset repeating within a range of key frames, select all frame cells with the 

range including the very last keyframe. This is different than the previous choices 

due to the fact that offset is always adding the value and offset to the previous 

frame.
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14.5 The Tool Bar

The project window tool bar is located at the top of the project window. It is 

actually two separate tool bars, one containing tools which control the basic 

environmental settings of the project window (plus a few cell editing tools) 

and one which contains additional tools for dealing with hierarchy and ani-

mation data.

Clicking on the icon in the palette opens a pop-up menu, and some icons 

change to indicate the particular menu choice. The pop-up menus, from left 

to right, are:

Project Window List View Control

This pop-up menu is used to control the display of objects in the project 

window. The window can be viewed in a number of ways as discussed 

below. The menu choices are:

• Flat
• Hierarchy
• By Name

View List

Snap

Time Display

Custom View

Channel Display

Cell Size

Fill Cells...

Blend Cells

Cycle Cells

Render Timing

Object Labels

Figure 14.10 — Primary tool bar
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• By Label
• By Material
• By Model File
• By Complexity
• By Master Light

Flat. This option shows a flat listing of objects in order of creation.

Hierarchy. This option (the default) shows objects in hierarchical order. 

Children are indented from the parent to show their relationship.

By Name.  This option lists all objects in the project alphabetically.

By Label. This option lists all objects in the project by the color assigned to 

them with the label tool, which also resides in the project window tool bar. 

Objects without labels will be listed at the end, in alphabetical order.

By Material. This option lists all objects children of the master materials 

that they subscribe to. Objects that do not subscribe to master materials are 

put at the end of the list in alphabetical order. 

By Model File. This option lists all objects as children of the model files to 

which they belong (model files defined as disk files in the operating sys-

tem.) All other objects not associated with disk-based model files will be 

put at the end of the list in alphabetical order.

By Complexity. This option orders the list of objects by the amount of poly-

gons stored in the file. Objects with more polygons are listed ahead of 

objects with less polygons. Objects without polygons are put at the end of 

the list, and sorted by alphabetical order.
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By Master Light. This option lists all lights as children of the master lights 

that they subscribe to. Lights that do not subscribe to master materials, as 

well as objects which cannot, are put at the end of the list in alphabetical 

order. 

Snap

This pop-up menu (valid in Time mode only) controls whether or not the 

time thumb will snap to a frame or keyframe when it is dragged to a new 

position. The menu choices are:

None. This option turns off the snap to frame function.

Snap to Frame. This option (the default) causes the Time Selector to snap to 

a frame when it is dragged to a new position.

Snap to Keyframe. This option causes the Time Selector to snap to a key-

frame when it is dragged to a new position.

Custom View

This pop-up menu is used to control what data is displayed in the Project 

window. The menu choices are:

All. This option (the default) shows all data in the project file.

Custom… This option opens a dialog box, as shown in Figure 14.11, that 

enables you to specify which data for which object class to display.
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To use the custom view dialog to control channels displayed in the 

project window:

1. Choose the object type to configure from the object list.
2. Select the channels to be displayed in the channel list (shift-click to 

select more than one), or click All to select all attributes from the list 
(clicking None de-selects any selected attributes).

3. Either click OK or press Return.

Position. This option shows only data for the position of objects.

Rotation. This option shows only data for the rotation of objects.

Scale. This option shows only data for the scale of objects.

Color. This option shows only data for the color of objects.

Visibility. This option will show only the visibility channel for objects in 

the scene.

Figure 14.11 — Custom view dialog

Object list Channel List
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Transform. This option will display transformation data only (position, 

rotation, scale) for each object in the scene.

Auto frames. This option will show only the auto frame channels (attach, 

track, auto-rotate) for each object in the scene.

Channel Display

This pop-up menu is used to open or close the different levels of animation 

channel data in the Project window’s data panel. The menu choices are:

Open Root. This option opens data cells for all roots.

Open Selected Root. This option opens data cells for selected roots.

Open Animated. This option opens data cells for all animated values.

Open Selected Animated. This option opens data cells for selected ani-

mated values.

Open All. This option opens all data cells.

Open Selected All. This option opens all data cells for selected objects.

Close All. This option closes all data cells.

Close Selected All. This option closes all data cells for selected objects.

Show/Hide Children. This option toggles display of a parent object’s chil-

dren (command or control “h”, for “hide”).

Hide Selected. This option will hide the selected objects from the project 

window list. The objects will remain visible in the world views and camera 

views.
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Hide Unselected. This option will hide unselected objects in the project 

window. The objects will remain visible in the world views and camera 

views.

Hide by Type. This option will hide objects by type. These types are:

• Cameras
• Lights
• Groups
• Effectors
• Sounds
• World object
• Material objects
• Model Files
• IK Handles
• Smoke objects

Show Selected. This option will unhide previously hidden, but still 

selected, objects.

Show Unselected. This option will unhide unselected objects previously 

hidden.

Show by Type. This option will unhide objects by type that have been pre-

viously hidden. These types are:

• Cameras
• Lights
• Groups
• Effectors
• Sounds
• World object
• Material objects
EIAS Animator        413



Chapter 14  Project Window — Tool Bar
• Model Files
• IK Handles
• Smoke objects

Cell Size

This pop-up menu is used to change the size (width and height) of the key 

and frame cells. The column width edit field will set the width of all of the 

column in pixels. The row height edit field will set the height of all of the 

rows in pixels. The default button will reset the column width and row 

height to factory settings.

Fill Cells

The descriptions for the fill cells popup menu can be found in the section 

“Editing Animation Channel Data” on page 388.

Cycle Cells

The descriptions for the cycle cells popup menu can be found in the section 

“Editing Animation Channel Data” on page 388.

Figure 14.12 — Cell size dialog
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Render

This pop-up menu is used to specify the frames that are to be rendered.

The menu choices are:

• All Frames
• Range of Frames
• Current Frame
• Every Nth Frame

All Frames. This option (the default) renders all frames in the animation.

Range of Frames. This option opens a dialog box for entering the specific 

start and stop frame numbers to be rendered.

Current Frame. This option will set the rendering engine to render only the 

current frame. Previews will also show only the current frame.

Every Nth Frame… This option opens a dialog box for entering the specific 

nth frames to be rendered (i.e., every 2nd frame, every 3rd frame, etc.)

Object Labels

This tool allows you to set named, colored labels for any object listed in the 

project window object/channel panel. The edit option in the menu will 

allow you to change the name of each label. Up to nineteen labels can be 

applied.
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Sound

This tool plays the selected sound track object. If a portion of the sound 

track is selected, only that portion will play. 

Deformation Editor

This tool opens the deformation editor window for the selected group.

Material Editor

This tool opens the material editor window for the selected group. 

Joint Editor

This tool opens the joint editor window for the selected group. 

Figure 14.13 — Secondary tool bar
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Modify Axis

Brings up the Modify Axis window for the selected object. 

Skin Editor

This tool opens the skin editor window for the selected group.

Constraint Editor

This tool opens the constraint editor window for the selected group.

Link to Parent

This tool allows you to choose a new parent for the currently selected 

object. If many objects are selected, the new parent will apply to all the 

selected objects. To cancel the operation, press the command-period keys.

Unlink from Parent

This tool removes parentage from all selected objects.

Subscribe to Master Material

This tool will subscribe a group to a master material that has been previ-

ously loaded into the project, or previously created from the material 

record of another group.

Cancel Master Material

This tool will remove a group from a particular master material.
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Park Object Data

This tool will reset the object data channels to 0.0, without changing the 

actual object orientation, position, scale, and so forth. Use this tool when 

you need to have the object’s coordinate space set to other than the one that 

it was created with.

Subscribe to Master Light

This tool is used to form a Master Light subscription. This tool does not cre-

ate a hierarchical relationship. Use the parent tool for that operation if 

needed.

Cancel Master Light

This option will remove a subscriber light from a master light.

14.6 Scrubbing

Scrubbing the view windows with the time thumb is an effective way to 

preview the animation in your scene. Hold down the Alt key (Option key 

on Macintosh) while dragging the time thumb to see all View windows 

update as you drag. Hold down the Alt and Shift keys (Shift-Option on 

Macintosh) while dragging the time thumb to see just the Camera view 

window update as you drag.

This feature works with the time thumbs found in the Project window, 

Time palette, and F-Curve editor. It does not work in the Morph window.
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14.7 Assigning Channels to the Function Curve Editor

The function curve editor is used to edit motion data in curve form. You 

will likely find that the editing methods employed by the function curve 

editor or more intuitive than the numeric data presented by the project 

window. In order to edit curves in the function curve editor, the data chan-

nels must be sent over to it. That is done in the project window.

To send motion curve data to the function curve editor from the project 

window:

1. Open the project window
2. Locate the object to be edited by the function curve editor
3. Open the display channel icons, so that the animation channels are dis-

played.
4. Double-click on the channel that you want to send to the editor.

If you choose an implicit motion channel (that is, a motion channel 

which is a composite channel of x, y and z motion attributes presented 

as a single channel), you will see the following dialog:

This dialog is used to either include or exclude velocity channels when 

sending the animation data to the function curve editor. 

Figure 14.14 — Key channel velocity dialog
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Answering “yes” will remove velocity controls for the yaw, pitch, roll 

and scale channels. Answering “no” will leave the velocity controls 

intact for those channels. A velocity channel will always be added to 

the curve editor for position.

5. Choose the dialog option that best suits your needs

To see the results, you will need to open the function curve editor.
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14.8 Reordering Items In the Project Window

You can drag objects up and down in the Project window to change the 

order they are listed or their parent/child relationships. Reordering is sup-

ported when the Project View is set to Hierarchy, Master Material, Master 

Light, Name, Label, FACT Model File, or Complexity.

Reordering

Drag the selected objects until your mouse is over the ICON of the target 

object. The objects you are dragging will be placed above the target object. 

To place the objects below, hold down the control key before you begin 

dragging. A black arrow pointing to the right and an underline indicates 

you are reordering.

Figure 14.15 — Placing Top Cube Between Second and Third Cube
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Linking

Drag the objects until your mouse is over the NAME of the new parent. A 

black arrow pointing down and an underline indicates you are linking.

Figure 14.16 — Linking Selected Cube to Last Cube
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Unlinking

Drag the objects into the area to the left of the object list (the area with the 

visibility check box, lock box and animation enable) and release the mouse 

button. The objects will be unlinked and move to the top of the hierarchy. 

Please note that to if you wish to move a child to a particular place at the 

top level of the hierarchy, that this is two separate operations. You must 

unlink and then reorder.

Figure 14.17 — UnLinking Selected Cube
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Time Markers

15.0 Introduction

Time Markers are small, yellow tags that you place along the time line to 

help keep track of important events in your project. In addition, these 

Markers can aid in navigating to different points in the project as described 

in the sections below.

 

A name can be added to each Marker to help you keep track of key events, 

changes you have made to the project, or any sudden bursts of inspiration 

you want to record. These names will pop-up, just as tool tips do, when 

you roll over the Time Marker.

Figure 15.0 — Time Markers

Time Markers Time Thumb
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15.1 Adding Time Markers

Markers are added using the Add Marker.... command under the Time 

View menu in the Project window. New Markers are added to the project at 

the current time, i.e. at the point in time where the time thumb currently 

resides.

You can also add a marker by, right mouse-clicking on the Time Thumb 

(Ctrl-click on the Macintosh). A menu will pop-up allowing you to add a 

new Time Marker. This works with the Time Thumbs in the Project win-

dow, Time palette and F-Curve editor. 

After adding the Marker, you will be invited to provide a name for the 

Marker. Names show up as tool-tips when you place the mouse pointer 

over the Marker. 

Figure 15.1 — Add Marker
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Markers are numbered 0-9 sequentially as you add them to the project. You 

may add Markers beyond number 9, but they all show up in the time line 

as “+”.  The “+” symbol is used instead of two or three digit numbers to 

minimize the amount of space taken up by the Markers in the time line.

You can drag Time Markers to any position along the time line just as you 

would drag the Time Thumb.

Markers are displayed where ever a time line is present. They are shown in 

the Project window, F-Curve editor, and the Time palette. 

Figure 15.2 — Marker Tool Tip
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15.2 Deleting and Renaming Markers

Hold down the Control key (Right Mouse button click on the PC) and click 

on a Time Marker to bring up its contextual menu. The menu will allow 

you to delete the Marker, delete all the Markers in your project, change the 

Marker’s name, or Lock/Unlock the Marker. Locking a marker keeps it 

from being dragged along the timeline.

15.3 Navigating Using Time Markers

Clicking on a Time Marker will cause the current time (Time Thumb) to 

jump to that Marker.

The first 10 Time Markers (0-9) each have their own shortcut key. Just hit 

the number on your keyboard or keypad and the Time Thumb will jump to 

the corresponding Marker. Use the “+” and “-” keys on your keyboard or 

keypad to jump forwards or backwards one Marker.

Note These shortcuts will not work if the key-focus is set to a numeric or text edit box.
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15.4 Time Marker Editor

The Time Marker Editor (Animation menu > Time Marker Editor) contains 

tools to manage markers and for selecting and copying keyframes based on 

their location between Markers. This copying functionality can be useful in 

copying character ‘poses’.

The editor displays a list of all the markers in your project. More than one 

marker can be selected in the list, and this multiple-selection ability is 

important when using the features described below.

Goto. Causes the Time Thumb to jump to the selected marker.

Select Keyframes. Select two markers from the list and then click on this 

button. In the Project window, for every selected object, all keyframes that 

lie between the Markers will be highlighted in blue. If no objects are cur-

rently selected, the keyframes for every object in the scene that lie between 

the Markers will be selected.

Copy Keyframes. Select two markers from the list and then click on this 

button. For each object currently selected, all keyframes that lie between 

Figure 15.3 — Time Marker Editor
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the markers will be copied to the current position of the Time Thumb. If no 

objects are currently selected, every keyframe in your scene will be copied.

Time. When a single Marker is selected, the time the marker is set to is dis-

played.

Start/Stop/Frames. When more than one Marker is selected, the start time, 

stop time and number of frames that lie between the Markers are dis-

played.
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Materials and Texture Maps

16.1 Introduction

In this chapter we will discuss the Materials and Texture Map features in 

EIAS Animator. Materials are what the rendering engine uses to give shad-

ing and detail to a group. Textures are a component of Materials. 

Note Procedural Shaders are also a component of Materials, but are covered in the Proce-

dural Shaders chapter.

Great effort has been spent conforming to industry standard material terms 

and behavior wherever possible. This was done to allow you to take advan-

tage of the myriads of books and publications which cover the topics of 3D 

which are now available, and to make EIAS even easier to use than ever 

before.

16.2 Overview of Features

The following highlights will give you an idea of the Materials and Texture 

Map capabilities of EIAS Animator. 

• Master Materials (materials that groups can subscribe to)
• Materials Can Be Saved To Disk
• Industry Standard Material Controls
• Easy to Use Interface Design
• Displacement Maps
• Clipping Maps
• Procedural Shaders
• Unlimited Texture Maps
• Precise Texture Mapping Controls
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16.3 Materials Defined

Materials are a collection of shading attributes, called channels, that you 

create and apply to a group (or groups.) Materials can also contain texture 

maps and procedural shaders. You can apply materials from saved material 

files on disk, from materials created in the Material Editor, or from Master 

Materials. 

Master Materials

Master Materials are visible in the Project Window, and can have many 

groups linked to them. Master Materials will replace all of the attributes of 

the groups linked to them (an exception to this rule applies to locked 

maps.) You will still have to tweak the texture map alignment to fit each 

particular group for the best results, unless the groups are similar in shape. 

You can have as many Master Materials as you wish in a project. To add a 

Master Material to a project, choose Material > Add Master Material. You 

will now see the Material at the top of the item list in the Project Window.

Groups must be linked to Master Materials in order to use them. You can 

link as many groups as you like to an individual Master Material. A group 

may be linked to only one Master Material in a scene.

To link a group to a master material:

1. Select the group (or groups) that you wish to link to the Master Mate-
rial.

2. Click on the Link Material icon in the Project Window tool bar.
3. Click on the desired Master Material in the Project Window List.
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The selected groups are now linked to the Master Material. You can con-

firm this by setting the Project Window display icon to “By Material.” The 

Project Window display will change to show the groups that are linked to 

the Master Materials displayed as children to the Master Material.

16.4 Accessing the Material Editor

In order to create or edit a material or Master Material, you need to get to 

the Material Editor. There are four ways to access the Material Editor:

• Select the Group, and click the Material Editor icon in the Project Win-
dow

• Command double click on a Group in any window
• With the Group Info Window open, click on the Material Ball icon
• Double click a Master Material in the Project Window

The Material Editor

There are two variants of the Material Editor, one for group materials, and 

one for Master Materials. 
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The primary difference between the Group Material Editor and the Master 

Material Editor are the material management buttons, located above the 

tab area and displayed in the Info tab. The following discussion applies to 

both window variations.

Figure 16.0 — Master Material Editor — Info Tab
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All of the material channels have separate tabs, with each tab containing 

the controls and functions indicated by the name of the tab. To access the 

contents of the tab, just click on it, and the tab will move forward.

Above the tabs you see the material ball icon to the left. The material name 

edit field is just to the right of that. Below are the Load and Save Material 

buttons, and below them is the Create New Master button. To the right of 

the buttons is the Material Statistics section, which illustrates the makeup 

of the material.

The material ball icon shows a live preview of the settings of the various 

material channels. To copy a material, select the Material Ball Icon and 

Figure 16.1 — Group Material Editor
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choose Copy. To paste a new material into this material record, select the 

Material ball icon, and choose paste. (You can change the background color 

of the material ball icon by option clicking in the background of the icon, 

and choosing the preferred background display pattern or color.)

Loading and Saving Materials

One of the most powerful new features is the ability to create a material 

and save it to disk to be called up any time it is needed. The material is 

saved to a directory within your EIAS Animator directory called “EI Mate-

rial.” The saved material contains the settings of the various material chan-

nels (diffuse, specular, etc.), as well as, external references to texture maps 

and procedural shaders.

For saving and load materials using the Material palette please see “Material Pal-

ette” on page 510

To load a material:

1. In the Info tab, Click the Load button
2. Choose a material from the directory
3. Double click the material or click the open button

The material is now applied to the group. Groups can only have one mate-

rial assigned to them, whether you assign a material to a specific group, or 

whether you assign a group to a master material.

To save a material:

1. In the Info tab, Make sure that the material is named
2. Click the Save button

The material is then added to the EI Material directory. EIAS Animator 

does not provide any indication that the material has been saved. To check 
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this you can save it again, if you like. When you do, you will then be asked 

if you wish to replace the material (indicating that it was previously saved.)

16.5 Creating New Master Materials

You can create new Master Materials from the Material Editor of a particu-

lar group, or you can add them to a project as described previously. Groups 

can be linked to them with a special material link command described in 

the Master Materials section.

Groups can be passively linked to a Master Material, or they can be “live 

linked.” Passively linked groups will require a manual update to receive 

any changes that are made to the Master Material they are assigned to. Live 

linked groups will be updated immediately upon any change to the Master 

Material they are assigned to.

To create a Master Material:

1. Set up your material
2. Click on the Create New Master button
3. A dialog will appear, prompting you to name the material.

A Master Material version of the material you were editing now appears in 

the Project Window item list. You will note that two new material manage-

ment buttons have now been added to your material, just below the Create 

New Master button: Reload from Master and Update Master.

Figure 16.2 — Material Management Buttons
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Reload From Master

This button appears in groups that are passively linked, not live linked, to a 

Master Material, and reloads the material properties from the Master Mate-

rial. This is useful if you are exploring a change to a material but decide 

you prefer the original.

Update Master

This button appears in groups that are passively linked, not live linked, to a 

Master Material, and replaces the Master Material with the current mate-

rial. Groups that are live linked to the master will be immediately updated.

16.6 Material Interface

The Material Editor presents all material channels in a tab context. This 

makes all of the shading attributes of EIAS Animator very accessible and 

easy to use. It should not take very long to get acclimated to the new inter-

face. To edit a particular channel within a material, just click on its tab. A 

material channel is a shading component, referred to as material channel. 

There are eight material channel tabs:

• Geometry
• Diffuse
• Specular
• Ambient
• Reflectivity
• Transparency
• Luminance/Glow
• Transmission
438       EIAS Animator    



Chapter 16  Materials and Texture Maps — The Geometry Tab
Each channel tab contains the many attributes which are controlled by the 

channel, including texture maps and procedural shaders.

Geometry Tab

The geometry tab contains all of the material channels and attributes which 

affect the apparent geometry of a group and how it is shaded. You can add 

outlines to the group, add bump and displacement maps for more detail, or 

punch actual holes into the group with clipping maps (and shadows do see 

these holes.)

The geometry tab is organized into three basic sections:

• Cel/Outline Shader section
• Bump/Displacement Map list
• Clipping Map list

Figure 16.3 — Geometry Tab
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Cel/Outline Shader Section

In this section you assign color and thickness to polygon outlines, edge out-

lines and silhouette outlines. Used in conjunction with the Cartoon proce-

dural shader, the look of traditional 2D cel animation can be achieved. 

There are three types of line effects:

• Polygon Outlines
• Edge Outlines
• Silhouette Outlines

Polygon Outlines. Activating this setting causes all of the polygons in the 

group to receive an outline. This is similar to wireframe shading, except 

that the polygon will also be shaded.

Edge Outlines. Activating this setting will cause certain edges to be 

defined with lines. As the group or camera is in motion, the definition of 

the edges will change, similar to the effect you see in traditional 2D anima-

tion. The silhouette feature should be active with this feature.

Silhouette Outlines. This setting causes the silhouette of an object to be 

drawn in lines. On occasion, the silhouette is not clearly resolved, so it is 

best to use this feature with the Edge Outline feature enabled.

To activate the particular line effect you wish you must click in the check 

box. You can color the lines by clicking on the color swatch and choosing a 

new color from the color picker. To adjust line thickness, type in a new 

value in the edit box to the right of the line type (values are in pixels.)

Bump/Displacement Maps List

The Bump/Displacement Maps list is where you add maps of these type. 

You can add as many maps as you like to this list. Along with the standard 

bump map, displacement maps are supported. Displacement maps actu-
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ally move the vertexes in the group using the map to determine how much 

displacement is applied. 

With bump maps the illusion of depth or relief can be created such as the 

bark on a section of log. The limitation to bump mapping is that the silhou-

ette or edge of the log is perfectly smooth and the closer to the edge the 

more obvious the cheat. With a displacement map the geometry is actually 

moved, so the edge of the log shows relief as well as the center. It is impor-

tant that there be enough vertex points in the group to achieve a satisfac-

tory effect. It might be necessary to apply the Dicer plug-in to the group to 

achieve best results.

Bump maps and displacement maps can be either a grayscale bitmap 

image or movie file or a procedural shader. Any bitmaps of greater than 256 

colors will be converted to gray scale by the rendering engine to achieve 

the effect. If an alpha channel is present, it can be used to control the bump 

instead.

To add a bump or displacement map

1. Click on the add button next to the bump map list
2. Choose the Map
3. Double click on the map or click on the open button

The map will be added to the list. You can configure the map by double 

clicking on the name of the map in the map list.

Controls for the strength of the bump and displacement are found under 

the Special Tab in the Texture Info Window, and these controls can be ani-

mated. Setting Bump Factor to 0 will disable the bump calculation. Setting 

Displacement to 0 will disable the displacement calculations. The values 

can be negative.
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Clipping Maps List

The clipping maps list is where you add clipping maps to your group. You 

can add any amount of clipping maps or procedures to this list. Similar to 

transparency maps, clipping maps are a quick and efficient way of cutting 

holes into a group. Unlike a transparency map, the clipped region is anti-

aliased independent of resolution. Zooming in close, the clipped object will 

still exhibit very clean edges. Clipping maps actually remove geometry, so 

they will create appropriate shadows. 

Clipping maps can be either a grayscale bitmap image or movie file or a 

procedural shader. Any bitmaps of greater than 256 colors will be con-

verted to gray scale by the rendering engine to achieve the effect. If an 

alpha channel is present, it can be used to control the clipping instead.

To add a clipping map

1. Click the Add button next to the Clipping Map list
2. Select the map or procedural from the dialog
3. Double click the map, or click the open button

The Clip factor edit box is found in the Texture Info Window under the spe-

cial tab, and controls the strength of the clipping map, where 0 is fully 

transparent and 1 is fully opaque. 

Clip Factor of 0 is a special mode that produces soft clip edges as the cam-

era gets close to the map. If you are not happy with the behavior of the clip 

map with 0 as the clipping factor, try setting it to 0.01 instead.

Solid/Dissolved Slider

This slider is another way to control transparency.
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Diffuse Tab

The diffuse tab contains all of the material channels and attributes which 

affect the diffuse channel of a group. The diffuse channel is where color is 

applied, and you will note that there is no longer a surface color attribute. 

The diffuse tab is organized into two basic sections:

• Diffuse parameters
• Diffuse Maps list

The diffuse parameters section contains a color swatch, slider bars for con-

trolling the amount of energy transmitted by the group, the falloff of that 

energy, and the mask opacity for the group. There is also a checkbox that 

allows you to use the original polygon colors of the group (some modeling 

programs let you assign unique colors to individual polygons, which you may 

want to keep.)

Figure 16.4 — The Diffuse Tab
EIAS Animator        443



Chapter 16  Materials and Texture Maps — The Diffuse Tab
Color Swatch

To choose a diffuse color, click on the swatch and pick a new color from the 

color picker. 

Use Polygon Color

This check box forces the renderer to use the color assigned to the individ-

ual polygons of the group when it was created. Assigning a color to the 

group with the swatch will ignore all of the polygon colors in the group. 

You can revert back to the original color of the group with this checkbox.

Amount

Use this slider to darken the group’s color. The slider bar will use the color 

in the swatch (or the polygon colors if Use Polygon Color is active) as top 

end of the range (brighter). You can also type in a value in the Amount edit 

box. The Amount slider is a nifty way of keeping your diffuse color intact 

while adjusting the brightness levels of the group. 

Falloff

Falloff was formerly called Shading Dropoff, and sets transition value from 

fully shaded to not shaded. Larger objects to have sharper falloff values 

(such as planets, where.25 is a good falloff value.) Smaller objects should 

have falloff values closer to 1.0.

Some sliders will accept values of greater than 1.0, or less than zero. You can adjust 

the value by typing in the value that you wish in the edit box to the right of the 

slider. Falloff is one of the attributes that allow this.
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Mask

This slider affects the alpha channel for the group (often called a Mask or 

Matte) in the final render. This feature can be used in conjunction with a 

compositing effects. If you want the group to appear normally in the scene, 

then leave the value at 0.0 (opaque on the slider.) If you want the group to 

act as a cutter, removing its shape from the scene, then set the value of the 

mask attribute to 1.0 (transparent on the slider). When this setting is any-

thing more than 0.0, a true hole will be left behind if the group is obscuring 

another object.

Diffuse Maps list

The diffuse maps list is where you add color maps, procedural shaders, or 

diffuse value maps. You can put as many maps as you like in this list. Maps 

can be single frames or movie files, and can be any bit depth desired.

To add a diffuse map to the list:

1. Click the Add button next to the Diffuse Map list
2. Select a map or procedural shader from the file list
3. Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click 

on the map name in the list. To reorder the map in the list, just drag it to its 

new location. 
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The Specular Tab

The specular tab contains all of the material channels and attributes which 

affect how the various specular attributes of a group will shade. The specu-

lar tab is organized into two basic sections:

• Specular Attributes
• Specular Map List

 

The Specular Attributes section contains a color swatch, slider bars for con-

trolling the amount of specularity, gloss, size and falloff, and a diffuse bias 

check box.

Color Swatch

The color swatch is used to set the color of the specular highlight. To choose 

a color, click on the swatch and pick a new color from the color picker. This 

setting is ignored if the Diffuse Bias setting is active.

Figure 16.5 — The Specular Tab
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Diffuse Bias

This check box forces the specular color to be equal to the diffuse color. The 

color of the highlight is added to the diffuse color, making the highlight 

brighter than the surrounding area. This is analogous to the way that high-

lights work in the real world, and defaults to on (which ignores the color in 

the color swatch.)

Amount

The Amount slider controls the brightness of the specular highlights that 

appear on the group. A value of 0 turns off the highlight. 

Gloss

The gloss slider adds a gloss or sheen to your group. It imitates what the 

group would look like if it were a bit reflective, removing color from the 

surface around the highlight. It can create an odd look, so you might want 

to use this sparingly.

Size

Controls the size of the highlight on the group. The smaller the number, the 

larger the highlight. Values of greater than 1.0 can be typed into the Size 

edit box.

Some sliders will accept values of greater than 1.0, or less than zero. You can adjust 

the value by typing in the value that you wish in the edit box to the right of the 

slider. Specular size is one of the attributes that allow this.
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Falloff

Controls the sharpness of the highlight. Larger numbers give a sharper, 

more abrupt transition, and smaller values produce a smoother and less 

defined highlight.

Specular Maps List

A specular map controls the area in which the specular highlight is visible 

on a group, as well as the value (brightness) of the highlight or the color of 

the highlight. Specular value maps can be either a grayscale image or 

movie file or procedural shader. Any bitmaps greater than 256 shades will 

be converted to gray scale by the renderer for specular value maps. If an 

alpha channel is present, it can be used to control the specular instead of 

the RGB channel. 

To add a specular map to the list:

1. Click the Add button next to the Specular Map list
2. Select a map or procedural shader from the file list
3. Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click 

on the map name in the list. To reorder the map in the list, just drag it to its 

new location.
448       EIAS Animator    



Chapter 16  Materials and Texture Maps — The Ambient Tab
The Ambient Tab

The ambient tab contains all of the material channels and attributes which 

affect the ambient shading characteristics of the group.  Ambient is a simu-

lation of ambient fill light, and you can make the ambient take a different 

color cast than the diffuse channel.

There are two basic sections to the ambient tab:

• Ambient Attributes
• Ambient Map List

The ambient attributes section contains a color swatch and a slider bar.

Color Swatch

Controls the color cast of the ambient fill light on the group. To change the 

color, click on the color swatch and pick a new color from the color picker.

Figure 16.6 — The Ambient Tab
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Amount

Controls how the group responds to ambient light. Larger numbers will 

make the group appear to have more fill color, and be a little less defined. 

Higher fill values would be appropriate for objects in sunlight. Lower fill 

values would be more appropriate for night time or deep space shots.

Ambient Map List

Ambient maps can affect the color of the ambient effect, the value of the 

effect, and the areas of the group that receive the ambient effect. You can 

have as many ambient maps as you like in the material. An ambient map 

can be an image or movie file or a procedural shader.

To add an ambient map to the list

1. Click on the Add button next to the Ambient Map List
2. Select the map
3. Double click the map, or click the Open button

The map is now added to the list.To configure the map, double click on the 

map name in the list. To reorder the map in the list, just drag it to its new 

location.

The Reflectivity Tab

 The reflectivity tab consists of two sub tabs. Main Options contains all of 

the Phong material channels and attributes which affect how and what the 

group will reflect. There are four main sections to the Main Options sub 

tab:

• Reflectivity Configuration (How much the Group Reflects)
• Reflection Configuration (What the Group Reflects)
• Reflectivity and Reflection Map Lists
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• Raytrace Enabler

Both the Reflectivity Configuration section and the Reflection Configura-

tion section are comprised of additional subsections.

The Reflectivity section resides within the left side of the tab, and the 

Reflection section resides on the right side of the tab.

Reflectivity Configuration Section

The reflectivity configuration section contains the basic reflectivity controls 

and specialized edge attenuation controls.    

Amount

The Amount slider is used to control overall reflectivity amount of the 

material. The valid ranges are 0.0 to 1.0.

Figure 16.7 — The Reflectivity Tab - Main Options
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Color Swatch

The color swatch tints the group’s reflection. It is disabled if the Reflection 

Bias checkbox is enabled.

Reflection Bias

This check box forces the reflected color to be equal to the diffuse color. The 

reflection is then added to the group by whatever percentage is set in the 

Amount attribute. This is more realistic than setting the color of the reflec-

tion manually, and defaults to on. 

Edge Control (Attenuation) Section

Edge control allows you to attenuate the reflection across the surface of the 

group (this is also called the Fresnel effect.) Objects in the real world tend to 

reflect more intensely towards the edge, and less so towards the center as 

seen from the viewer’s point of view. 

To illustrate this effect, set the reflectivity amount to.5, edge amount to 1.0 and fal-

loff amount to 1.0. Note that the center of the material ball shows no reflection, but 

the edges are quite reflective.

Amount

The amount value controls the amount of reflection along the edge of the 

group. It is factored into the overall reflection amount. This value is unused 

if the edge falloff amount is set to 0.0.

Falloff 

The Falloff value controls how the reflection will fall off towards the center 

of the group. The higher the number, the less reflection you will see at the 
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center of the group. This value is not considered if the Edge Amount value 

is 0.0.

To the right of the edit boxes is a graph area, which shows the relationship 

of the Edge Amount and Falloff values. With the Edge Amount set to 1.0, 

and the Edge Falloff set to 0.0, the graph will appear as a white square (the 

default.) This indicates that the reflection will appear evenly across the sur-

face of the group. As you adjust the relationships between the two values, 

you will see the graph change to reflect the new values.

Reflectivity Maps List

A reflectivity map controls how the group will reflect any reflection maps 

assigned to it in the Reflection Map section. It can also control what areas of 

the group receive a reflection, and how much of it. Any bitmap image, 

movie or procedural shader can be used as a reflectivity map.

To add a reflectivity map to the list:

1. Click the Add button next to the Reflectivity Map list
2. Select the map or procedural shader from the file list
3. Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click 

on the map name in the list. To reorder the map in the list, just drag it to the 

new location. 

Reflection Map Configuration Section

Reflection maps are what the group is actually reflecting. Reflection maps 

can be bitmaps, either still or movie files. Procedural shaders cannot be 

used for reflection maps. Reflection maps can also be automatically gener-

ated by EIAS Animator. These are called mirror maps, which are flat, and 
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environmental maps, which are cubic. The controls for the automatic maps 

are in the Environment Reflection subsection.
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In the main Reflection Map Configuration section, there are three check 

boxes:

• Use Global Maps
• Use Bitmap Reflection
• Use Environmental Reflection

Any or all of these settings can be selected at any time. Each map has an 

amount slider that allow maps to be less than full intensity. This allows 

reflections to be added together, say global maps with bitmap reflections. 

The effect is additive, which may not be desired.

Global Maps. This check box enables the reflection maps applied under 

the World Info Window located in the Project Window as a reflections for 

the group. This setting allows as many groups as you wish to use the same 

reflection. This map can also function as a “default” reflection map, remov-

ing the need to physically assign a reflection map to the group.

Bitmap Reflection. This check box enables the group to reflect maps from 

the reflection map list.

Environment Reflection. This check box enables any of the selected Envi-

ronment Reflections specified in the Environment Reflection subsection.

Environment Reflection Subsection

There are three choices in the subsection:

• None
• Mirror
• Environment

None. No map is selected. This is the default condition.
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Mirror. Mirror maps are flat, and automatically render an exact mirror 

reflection, relative to the established mirror plane. You control the mirror 

plane through the Configure… button in the subsection. It is necessary to 

establish a plane to guarantee expected results. 

Environment. Environment maps are cubic reflection maps that are auto-

matically created by the rendering engine. The rendering engine creates six 

images representing the faces of the cube. These images then form the basis 

of the reflections on the group. You can control the resolution of the envi-

ronment map with the Configure… button. The resolution settings are in 

an edit box available under the Projection tab.

Note Environmental reflections and mirror reflections can add up rendering time if you 

use alot of them. In that case, you are better off choosing raytraced reflections. It 

takes six complete renderings of your scene to create just one environment reflec-

tion map.

To save render time, you can set an automatic environment map to calcu-

late its reflection only once. This setting is available through the Config-

ure… button, in the Filter tab.

Note Do not turn on the Use Raytrace check-box if you are using Mirror or Environ-

ment maps. These maps are created using multiple Phong renderings of the scene 

and cannot be used with the raytracer.

Reflection Map List

The reflection map list is where you add the bitmap images or movies that 

you wish the group to reflect. 
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To add a reflection map to the Reflection Map List

1. Click on the Add button next to the Reflection Map list
2. Select a map from the file list
3. Double click the map, or press the Open button.

The reflection map is added to the list. To configure the map, double click 

on the map name in the list. To reorder the map in the list, just drag it to its 

new location. 

Cubic Reflection Maps

These are six-frame animations that get applied to your group as a single, 

six-sided reflection map. One frame is applied to each side of your group. 

The frames must be stored within the animation in the following order:

4. Front
5. Back
6. Left
7. Right
8. Top
9. Bottom

Cubic Reflections are a bitmap reflection mode and can be chosen in the 

Texture Info window, Projection tab, Map Type pull-down. They are avail-

able for both the Reflection and Reflectivity channels.
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Reflection Mode

The settings of this pull down menu control the behavior of ray traced 

reflections.

None. This is the default. No ray trace reflections will be created.

Normal. Reflections will be ray traced. 

Note Do not set the mode to Normal if you are using bitmap or world list reflection 

maps. The renderer can either render or raytrace a reflection. It cannot do both on a 

single object. You can still use Reflectivity maps to control the amount of raytrace 

reflection on each part of the object. 

Note Do not set the mode to Normal if you are using Mirror or Environment maps. 

These maps are created using multiple Phong renderings of the scene and cannot be 

used with the raytracer.

Occlusion. Reflection maps have been around for a long time. Used in 

place of raytraced reflections, reflection maps are much faster, but not accu-

rate, as they are merely a simulation of reflectivity. Raytraced reflections are 

very accurate, but require long render times, and filtering costs can be pro-

hibitive. One method which provides the benefits of both is Reflection Map 

Occlusion. Essentially, reflection maps show a reflection everywhere on a 

reflected object, which is not accurate. Occluded reflection maps place the 

reflected map image only where it would be physically possible to see a 

reflection in the first place. Imagine looking at the reflection of a car door. In 

the real world, you would not see a reflection of the sky where a reflection 

of the rear view mirror would be. That is the operative principle here. In 

this example, a sky reflection map would not appear where the reflection of 

the mirror would be, instead, you would see no reflection of the map at all 

in the mirror area.
458       EIAS Animator    



Chapter 16  Materials and Texture Maps — The Reflectivity Tab
This method is not as accurate as a fully raytraced reflection, but then 

again, it is not nearly as time consuming either, and produces great results.

Occlusion works with Environment and Mirror reflections as well as reflec-

tion maps.

Raytrace Options

This sub tab contains the controls for raytracing and caustics. The raytrac-

ing options are available when the Raytrace Mode pull-down (see “Reflec-

tion Mode” on page 458). The Caustics options are always available.

Reflection Blur

Surfaces are not always perfectly smooth, and rough surfaces create blurry 

reflections. To simulate this effect, EIAS supports the ability to blur ray-

Figure 16.8 — The Reflectivity Tab - Raytrace Options
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traced reflections. You can add blur to the entire object using a slider or add 

a reflectivity texture map to control which parts of your group are blurred. 

Please note that reflection blur can increase the amount of time it takes to 

raytrace the scene. The blur requires many more rays to be cast than would 

otherwise be necessary.

Amount.  This controls the amount of overall blur. The value range from 

0.0 to 1.0. This value is ignored if you add Reflection Blur Maps.

Samples.  Number of extra rays that are cast. The most useful range of val-

ues is from 4 to 8. More samples mean a higher rendering time. If you 

lower the blur angle below 5 degrees, you can reduce the Samples to 4 

without suffering any loss of image quality.

Blur Angle.  Controls the intensity of the blur. In other words it controls 

how far the rays spread out as they blur.

Grain.  Turning this checkbox on will cause noise to be added into the blur. 

This has the effect of ‘roughening’ the look of the blur.

Reflection Blur Maps.  These can be added to control blur on specific parts 

of the group. The Amount slider is ignored if any Reflection Blur Maps are 

added. For the map, black is no blur and white is maximum blur.
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Figure 16.9 — Reflection Blur Sample - Varying Blur Angle

Angle = 1.0                         Angle = 5.0

Angle = 20.0                      Angle = 45.0

Figure 16.10 — Reflection Blur Sample - Grain

Grain Off                                                   Grain On
EIAS Animator        461



Chapter 16  Materials and Texture Maps — The Reflectivity Tab
Reflection Caustics Control

This section controls how the group sends and receives reflection caustics. 

Using Caustics is discussed more fully in the chapter on lights. See “Caus-

tics Tab” on page 220.

Cast. Sets the intensity of the Caustic cast by the object. Slider defaults to a 

range of 0 to 1.0 but values larger than 1.0 can be set. 

Color Chip and Diffuse Bias.  You can add a color to the reflected caustic 

by choosing one from the color picker (click on the color chip) or you can 

use the diffuse color by turning on the Diffuse Bias check box.

Factor. This can be used to increase the precision of the Caustics. But you 

will have to increase the Photon Density in the Light Info window as well. 

This will increase rendering time.

Falloff. A power multiplier factor for the Reflection Caustics. It is analo-

gous to the Factor control found in the Diffuse tab.

Receive. Controls weather the group receives Caustic Reflections from 

itself or from other objects. By default all groups receive Caustics. You can 

prevent a group from receiving by setting this slider to 0.
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The Transparency Tab

The transparency tab contains two sub tabs, Main Options and Raytrace 

Options. The Main Options sub tab contains all of the material settings and 

attributes which affect the phong transparency of the group. The Raytrace 

Options sub tab contains the controls for caustics.

Please note that the specular highlight and reflection calculations for the group are 

not affected by the transparency settings. If you wish to lessen their impact on a 

transparent group, you will need to adjust these values separately.

The Main Options sub tab contains four sections:

• Transparency Attributes section
• Edge Characteristic section
• Transparency Map list
• Transparency Edge Map list

Figure 16.11 — The Transparency Tab - Main Options
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Transparency Attributes Section

Use Raytrace

Transparencies can be either Raytraced or Phong based. Raytraced trans-

parencies are more accurate and show light bending through an object. For 

example a glass of water bends the light as you look through it, making 

objects look distorted when viewed through the water.

Index of Refraction

This is the amount of refraction (bending of the light) that occurs when the 

Use Raytrace check box is on. 0.0 is considered vacuum so no light would 

bend. Higher numbers would create more distortion. Water is about 1.3, 

Diamond is 2.2.

Attributes

The transparency attributes section contains controls for setting the actual 

transparency of the group. The slider bar controls the amount of transpar-

ency. The three buttons to the right of the slider control the type of trans-

parency applied to the group:

• Filter
• Color Filter
• EI Filter

Filter. Filtered transparency groups are mathematically “averaged” into 

the scene, meaning that they do not change the appearance of any groups 

that fall behind them, with the exception of dimming the brightness values 

of those groups by the value set for the transparency. This effect does not 

reflect how transparent objects behave in the real world, and tends to be 

used primarily for special effects. 
464       EIAS Animator    



Chapter 16  Materials and Texture Maps — The Transparency Tab
Color Filter. Color filter transparencies are either subtracted from the scene 

or added to the scene, depending upon which choices you make in the fil-

ter mode subsection. (The filter mode subsection is visible only if this option is 

selected.) 

The filter mode subsection is divided into two areas:

• Filter Mode
• Filter Color

Filter Mode. Filter Mode determines the method by which the transpar-

ency will be applied to the scene. 

Subtractive transparencies most accurately mimic the effect of transparent 

objects in the real world. Groups which pass behind a subtractively trans-

parent group will be tinted to color of the transparent group, as the color of 

the transparent group is subtracted from whatever is behind it. 

Additive transparencies are typically used for special effects purposes, 

such as glowing balls of energy and so forth. Groups which pass behind 

additive transparent groups will appear brighter, as the color of the trans-

parent group is added to whatever is behind it.

Filter Color. Filter color is used to determine the color that will be used for 

the filter effect. 

The Use Surface Color option will use the Diffuse channel and all attributes 

assigned to it for the filtering process set by the Filter Mode switch. This is 

the most realistic setting, and the default.

Figure 16.12 — Filter Mode Subsection
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The Use Custom Color option will use the color in the swatch next to the 

item as the filtering color. It will ignore all of the attributes in the Diffuse 

channel. To change the color of the swatch, click on it and pick a new color 

from the color picker.

EI Filter. This setting is included for project file compatibility with previ-

ous versions of ElectricImage. The color filter transparency method offers 

far more control and ease of use than this method. Consider ignoring this 

method when you are creating new projects from scratch.

When this option is selected, the EI Filter options subsection appears. It 

consists of two items:

• Use Surface Color
• Use Custom Color

Use Surface Color

This option will use the diffuse channel and all attributes associated with it 

as the filtering process for the transparency. 

Use Custom Color

This option will use the color in the swatch as the filter color. This is analo-

gous to the methods used by previous versions of ElectricImage. To change 

the color in the swatch, click on it and pick a new color from the color 

picker.

Figure 16.13 — EI Filter Options
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Transparency Map List

Transparency maps can be applied to modify the amount of transparency 

or to modify the color of the transparency. You can have both types of maps 

in the list. Maps can be bitmap images and movie files, or procedural shad-

ers. 

To add a transparency map to the list:

1. Click on the Add button next to the transparency map list
2. Choose a map from the file list
3. Double click on the map, or press the Open button

The map is added to the list. To configure the map, double click on the map 

name in the list. To reorder the map in the list, just drag the map to its new 

location.

Edge Characteristic Section

The items in this section control the effect of the edge of an group, regard-

less if the group is set to be transparent or opaque.   For transparent groups, 

you can adjust the opacity of the edge, and the falloff when the edge gets 

more opaque. For opaque groups, you can adjust when the edge of the 

object becomes more transparent. 

A notable difference between EIAS Animator and previous versions is that the 

Edge Color value has been removed. Instead, the edge color is derived from the color 

of the diffuse channel. If a colorless transparent glass look is desired, set the trans-

parency method to color filter, select subtractive, and the custom color option. Click 

on the color swatch to set a new color, perhaps a lighter variant (close to white) of 

the diffuse color selected (remember, we are using that value to give the edge some 

color.) Because you have selected the subtractive transparency mode, the white will 
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be removed, leaving no color contamination behind, as more saturated colors will 

do. This will give a result equivalent to earlier versions of ElectricImage.

There are two sliders which affect the look of the edge:

• Amount
• Falloff

The Edge Characteristic sliders work similarly to the Edge Reflection slid-

ers.The type of effect achieved is determined by the three edge control but-

tons described following the Amount/Falloff discussion.

Amount. This slider determines the amount of edge transparency or opac-

ity applied to the group. The falloff value (described below) must be set to 

a value other than 0.0 to see the effects of this slider. The range of this slider 

is 0.0 to 1.0.

Falloff. This slider determines how the edge will intrude into the body of 

the group. The Edge Amount slider must have a value other than 0.0 to see 

the effect. This slider has an infinite upper range, however, you may find 

numbers greater than 5 of no useful effect.

Edge Graph

To the right of the sliders and edit boxes is the edge graph, which shows the 

relationship of the Amount and Falloff parameters in graphic form. It 

updates in real-time as these values are edited. You will note that the more 

white area in the graph, the more powerful the defined edge will be, as rep-

resented in the material ball. The curvature plotted in the graph represents 

the actual mathematical function plotted by the values in Amount and Fal-

loff
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Edge Control Buttons

There are three radio buttons which control the treatment of the edge of the 

group:

• Normal
• Opaque
• Transparent

Normal. No edge characteristic is applied. The transparency effect is car-

ried evenly through the group. This often yields a group with less defini-

tion, and is considered less realistic for transparencies.

Opaque. The edges of the group will be opaque, using the parameters set 

by the Amount and Falloff sliders. For transparent objects, this option 

yields the most realistic results, with the Amount and Falloff values set to 

your preference.

Transparent. The edges of the group will be transparent, using the parame-

ters set by the Amount and Falloff sliders. Opaque objects can be made to 

have clear, fluffy edges, and can be used for such things as clouds, cotton 

balls, or planet atmospheres.

Transparency Edge Map List

Transparency edge maps work the same as the transparency maps and can 

affect the value or color of the transparency at the edge of the group.

To add a transparency edge map to the list:

1. Click on the Add button next to the transparency edge map list
2. Choose a map from the file list
3. Double click on the map, or press the Open button
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The map is added to the list. To configure the map, double click on the map 

name in the list. To reorder the map in the list, just drag the map to its new 

location.

Raytrace Options

The controls in this tab are for refraction caustics. Using Caustics is dis-

cussed more fully in the chapter on lights. See “Caustics Tab” on page 220.

Cast. Sets the intensity of the Caustic cast by the object. Slider defaults to a 

range of 0 to 1.0 but values larger than 1.0 can be set. 

Figure 16.14 — The Transparency Tab - Raytrace Options
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Factor. This can be used to increase the precision of the Caustics. But you 

will have to increase the Photon Density in the Light Info window as well. 

This will increase rendering time.

Falloff. A power multiplier factor for the Reflection Caustics. It is analo-

gous to the Factor control found in the Diffuse tab.

Volume Reflections. A When on the caustics engine will create additional 

photons to simulate internal reflections that take place inside transparent 

objects.

Receive. Controls weather the group receives Caustic Reflections from 

itself or from other objects. By default all groups receive Caustics. You can 

prevent a group from receiving by setting this slider to 0.

Note that a transparent object will receive caustics if its Use Raytrace check 

box is turned on. When the checkbox is on, the Receive slider is ignored.
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The Luminance/Glow Tab

The luminance/glow tab contains all of the material channels and 

attributes which affect the luminosity and glow effects that a group can 

have applied to it. 

 

The luminance/glow tab is divided into four sections:

• Luminance Color
• Glow Color
• Luminance Map List
• Glow Map list

Luminance Color. The luminance value controls the group’s self illumina-

tion. (This value does not actually cause the group to emit light, but rather 

glow like an LED would glow.) The slider controls the amount of self illu-

mination of the group, using either the color in the color swatch, or the dif-

fuse shading channel of the group. Texture maps can also be used to control 

the luminescence of the group. 

Figure 16.15 — The Luminance/Glow Tab
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• Use Color Button

The use color button will cause the group to luminesce with the color in the 

color swatch. The change the color in the swatch, click on it and pick the 

color from the color picker.

• Use Shading Button

The use shading button will cause the group to luminesce with the values 

found in the diffuse channel.

Luminance Map . Luminance maps can be either value maps or color 

maps. In the case of grayscale the white areas of the map will illuminate to 

white and black areas will not illuminate. In the case of a color map the illu-

mination will possess the colors of the map.

To add a map to the luminance map list:

1. Click the Add button next to the map
2. Select a map from the file list
3. Double click the map, or press the Open button.

The map will now be added to the list. To configure the map, double click 

on the map name in the list. To reorder the map in the list, just drag the 

map to the new location. 

Glow Color. The glow effect causes groups to apparently emit a glowing 

area around the group. The glow is a compositing effect added at the end of 

each rendered frame (and as such the effects of the glow settings are not 

represented in the material ball icon.) Glowing groups will not effect the 

appearance of other groups in the scene. 
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Setting up glows properly requires the following procedure:

1. Setting the glow attribute in the group’s material
2. Assigning the group to a selection set
3. Adding a the selection set to the glow layer tab in the Render Informa-

tion Window
4. Set up the glow layer

Setting the Glow Attribute in the Group’s Material

In the Glow Color section, you can control the amount that an object will 

glow, the color or shading of the glow, and whether the group will actually 

glow, or have a glare on the brighter areas of the group (which you can con-

trol.)

Glow. The Glow radio button will use the color swatch as the glow color. 

The value of the glow is set by the Glow Amount slider. To change the color 

in the color swatch, click on the swatch and pick a color with the color 

picker. The actual area of glow is determined by the attributes of the Glow 

Layer, found in the Glow Layer tab of the Render Information Window. If 

the group is not part of a selection set contained within a Glow Layer, then 

the group will not appear to glow in the rendering.

Glare. The glare button will use the diffuse channel to create a glare around 

the group. The amount slider determines the brightness cutoff for the glare. 

Typically, a fairly subtle cutoff is desired, as glares tend to be less overpow-

ering than glow effects. 50% is a good value for the brightness cutoff to 

begin with. You can have the entire group “radiate” by setting the slider to 

0.0. This makes the group appear to be heavily over-exposed, depending 

upon the settings in the glow layer to which the group’s selection set is 

assigned.
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Any pixels which fall within the specified tolerance set by the Glow 

Amount attribute will be blurred by the amount specified in the Glow 

Radius attribute of the Glow Layer, and then added back onto the scene by 

the amount specified in the Intensity attribute of the Glow Layer to which it 

is assigned. Glow Radius values of 50 pixels or greater, plus a Glow Inten-

sity of 1.5 will give you a good starting point for a nice glare effect (as 

shown in the illustration.)

The actual area of the glare is determined by the attributes of the Glow 

Layer, found in the Glow Layer tab of the Render Information Window. If 

the group is not part of a selection set contained within a Glow Layer, then 

the group will not glare in the rendering.

To assign the Group to a Selection Set:

1. Select the group
2. Choose Select>By Set>Edit Sets

3. Click the Add button in the Selection Sets section of the window that 
appears

4. Type in the name of the set and hit return
5. Select the name of the set that now appears in the list
6. Click the Add button in the members section of the window

Figure 16.16 — Teapot without glare on the left, Teapot with glare on the right
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7. Close the window

All of the selected groups will now be part of that named selection set.

Add the Selection Set to a Glow Layer:

1. Open the Render Information Window (Render>Render Settings…)
2. Select the Glow Layer tab
3. Click the Add button in the Glow Layer Section
4. Type in Glow Layer name in the edit field and hit return
5. Select the Glow Layer in the list
6. Click the Add button in the Glow Layer Member section
7. Select the desired selection set from the list that appears, and click the 

Add button

Figure 16.17 — Edit Selection Sets Window
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The selection set is now added to the glow layer.

Set Up the Glow Layer

1. Select a Glow Layer from the Glow Layer List
2. Type in a value for the Glow Radius in pixels
3. Type in a value for Glow Intensity

The smaller the pixel number in the Glow Radius edit box, the more 

defined and brighter the glow will appear. Larger values in the Glow 

Radius edit box might require an adjustment to the Glow Intensity value to 

achieve the desired effect (larger intensity values for a stronger glow, 

smaller intensity values for a weaker glow.) Glow effects will typically be 2 

or greater in intensity, while Glare effects will probably not be brighter than 

1.5, but feel free to experiment.

The previous steps cover typical glow and glare usage.

Figure 16.18 — Glow Layer Tab of Render Information Window
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Glow Color Maps List

Glow maps can be applied to control the amount of glow, and to control the 

color of the glow. Glow maps can be a bitmap image or movie file, or a pro-

cedural shader. You can have as many glow maps as you like.

To add a map to the glow color maps list:

1. Click the Add button next to the glow color maps list
2. Select a map from the file list
3. Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click 

on the name of the map in the list. To reorder the map, just drag the name 

to the desired location in the list.
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The Transmission Tab

 The transmission tab contains all of the material channels and attributes 

which affect the transmission characteristics of the group. Some objects in 

the real world can allow light to go through them to a degree. This effect 

can be seen of you were to hold up a leaf to the sun. You would notice the 

spidery vein network as darker shapes, and the thinner parts of the leaf 

would appear brighter. The transmission channel lets you correctly repro-

duce this phenomena.

The transmission tab is divided into three sections:

• Transmission Color Section
• Transmission Edge Control Section
• Transmission Maps List
• Edge Transmission Maps List

Figure 16.19 — The Transmission Tab
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Transmission Color

This attribute determines the transmission amount and color. The best 

transmission color is white, as it will conform to the color of the group and 

any maps, plus the lightsource. 

Edge Control Subsection

Transmission edge control works the same as with edge transparency 

allowing you to build less translucent edges to curved groups the way they 

would appear in the real world.

Edge Amount

Controls the transmissiveness of the edge. The Edge Falloff slider must 

have a value other than 0.0 to see the effect.

Edge Falloff

This slider determines how the edge will intrude into the body of the 

group. The Edge Amount slider must have a value other than 0.0 to see the 

effect.

Edge Graph

To the right of the sliders and edit boxes is the edge graph, which shows the 

relationship of the Amount and Falloff parameters in graphic form. It 

updates in real-time as these values are edited.

Transmission Maps List

Transmission maps are used to control the value and color of the transmis-

sion. Transmission maps can be a bitmap image or movie file, or a proce-
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dural shader. After a map is assigned, the slider no longer has any effect as 

all the transmission information is derived from the value of the map.

The best way to achieve a natural look is to assign a standard color map 

under the Diffuse tab and then a grayscale transmission map under the 

Transmission Tab.

To add a map to the transmission map list:

1. Click the Add button next to the transmission maps list
2. Select a map from the file list
3. Double click the map, or press the Open button

The map is now added to the list. To configure the map, double click on the 

name of the map in the list. To reorder the map, select the name and drag it 

to the desired location.

Edge Transmission Map List

Edge transmission maps are used to control the value and color of the edge 

of the group. Edge transmission maps can be a bitmap image or movie file, 

or a procedural shader. After a map is assigned, the slider no longer has 

any effect, as all the transmission information is derived from the value of 

the map.

To add a map to the edge transmission map list:

1. Click the Add button next to the edge transmission maps list
2. Select a map from the file list
3. Double click the map, or press the Open button

The map is now added to the list. To configure the map, double click on the 

name of the map in the list. To reorder the map, select the name and drag it 

to the desired location.
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16.7 Using Texture Maps

EIAS Animator supports an unlimited number of texture maps per group. 

Texture maps are an integral component of a material. Texture maps do dif-

ferent things, depending upon the tab and map list in which they reside. 

The same map can be used in many different channels, and each channel 

can have an unlimited amount of maps as well.

All of this power can come at a price if you are not frugal with your map manage-

ment. Be careful not to waste maps and map memory. If you just need a grayscale 

value for a bump map, then you would be wasting over 1 MB of RAM (for a typi-

cal map) if that same map also had RGB channels associated with it (and was 

unused elsewhere).

Map placement controls are included that allow face to face precision of 

map placement. Multiframe maps can be easily controlled with start and 

stop times and stop ranges. Most of the map functions described in this sec-

tion can also pertain to procedural shaders, in EIAS Animator.

Map Types

Texture maps can be in EIAS’s native Image format (.img) or in any format 

supported by QuickTime, including BMP, TIFF, TGA, JPEG, MPEG, etc. 

Animated files can also be used as textures. Animated texture maps are 

supported automatically when a QuickTime or Image movie is selected.

Texture Sequences

You can use a folder containing a series of sequentially numbered files as 

an animated texture map. Once you click the Add button in the Material 

Info window to add a texture map, an Open File dialog box opens. Inside 

the box is a check box, “Use Multi-File frames”. Turn on this check box and 

then select any one of the sequentially numbered texture frames. Animator 
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will include the map in texture list and substitute the “#” symbol for the 

number to indicate an animated texture sequence has been applied. 

Sequence names in the form of “NAME ####.YYY” are supported where 

NAME is the texture name, #### is a number, and YYY is the file exten-

sion. Sequence names in the form of NAME.XXXX are not supported. On 

all operating systems the texture sequence names must end in a file exten-

sion.

Animator will use the first numbered file in the folder as the first frame of 

the animation regardless of which of the texture maps in the sequence you 

select,. To begin the sequence on a different frame, use the map playback 

controls (See “Map Playback Controls” on page 495.)

Map Lists

Maps are managed within map lists. Each material channel contains a map 

list where appropriate. Map lists are a jumping off point to map configura-

tion and management.

Map Order

Map order is very important, as some effects may not be obvious if maps 

are out of order. Fortunately, reordering maps within a channel is easy — 

just drag the maps in whatever order you wish.

Map Alpha Channels

Alpha channels now take on a more specific meaning in EIAS Animator, 

both to make the process of using texture maps easier, and to conform to 

industry standards. There are essentially three ways to use an alpha chan-

nel within a texture map:
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• Ignored
• As Value
• As Mask

The Way Texture Maps Work

Maps add into the list from the top. Think of the list being stacked on top of 

the group. The map at the top of the list is the uppermost one, while the 

map at the bottom is innermost, nearest the actual surface of the group. The 

maps can be reordered by dragging them up or down in the list. 

The circle next to each map is a checkbox that can be used to enable or dis-

able the map. This feature is very useful while developing new materials. 

The empty space next to the circle is the map lock toggle. This can be set to 

prevent this map from being over-written by a Master Material assigned to 

the group.

Texture maps can be copied and pasted from one map list to another. To 

copy the map, highlight the map, select Copy Texture from the Edit menu. 

To paste the map, select the list you want paste it into by clicking some-

where in the list box. The list box will show that it has been selected with a 

thick black outline. Use the Paste Texture command from the Edit menu to 

complete the operation.

Figure 16.20 — Diffuse map list box
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To configure the texture map, double-click on the name of the map in the 

list box. The Texture Info Window will open. This window displays the 

group to be textured and the map projection (on the right) and has a series 

of tabs and buttons for controlling texture scaling, tiling, etc. (on the left).

Map Alignment Buttons

Figure 16.21 — Texture Info Window

Drag
Texture

Select Polygons

Fit to Selected polygons

Align to Surface
Surface Editor
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There are five map alignment buttons at the upper left of the window assist 

in map placement. These buttons are:

• Drag Texture
• Select Polygons
• Fit to Selected Polygons
• Align to Surface 
• Surface Editor

Drag Texture. This (default) button allows you to move the map projection 

around in the window for proper placement on your model. Drag left or 

right at the edges of the projection to scale the map. Hold down the control 

key and drag to rotate the map.

Select Polygons. This button is used to select polygons by clicking on indi-

viduals or drag a rectangle for multiples. Shift click to add or remove poly-

gons within the selection.

Ctrl-Clicking (Option-Clicking on Macintosh) on the Select Polygons but-

ton brings up a color picker that lets you change the color of selected poly-

gons.

Fit to Selected Polygons. This button sets texture projection to the extent of 

the polygons selected with the Polygon Selection Button. There is a pull-

down menu that is brought up by clicking on this button with the Ctrl-Key 

(Option-Key on Macintosh) held down. It brings up the following options:

These options are designed to assist you when positioning cylin-

drical and spherical maps. Note that the button must be active in 

order for these options to be effective.
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Align to South Pole. Choosing this option will align the south 

pole of the spherical or cylindrical mapping primitive with what-

ever point you select on the model.

Align to North Pole. Choosing this option will align the north 

pole of the spherical or cylindrical mapping primitive with what-

ever point you select on the model.

Align to Equator Front. Choosing this option will align the side 

of the spherical or cylindrical mapping primitive opposite the 

seam to whatever point you select on the model.

Align to Equator Seam. Choosing this option will align the seam 

of the spherical or cylindrical mapping primitive opposite the 

seam to whatever point you select on the model.

Align to Surface. This button sets map plane any polygon, regardless of 

the polygons you may have already selected with the Select Polygons tool. 

Unlike the Fit to Selected tool, the size and aspect ratio of the map is main-

tained with this tool. Align Map Plane is a very powerful feature for align-

ing the map projection icon to tricky curved surfaces. This feature is also 

available while in Move mode by Command-clicking on a polygon.

Surface Editor. This button brings up a list of texture maps applied to the 

current group and allows you navigate to any of them. Alt-Clicking   

(Option-Clicking on the Macintosh) opens up the Material Info window.
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Map Alignment Tab

The alignment tab contains the position and rotation information for the 

texture map. The map alignment tab is divided into three sections:

• Alignment Radio Buttons
• Position Information
• Rotation Information

The Alignment Radio Buttons 

These buttons provide a straightforward way of aligning the texture map:

• User
• Middle
• Front
• Back
• Top
• Bottom
• Left
• Right
• Polygons 

Figure 16.22 — Map Alignment Tab
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These projections will align and scale the map along the axis noted by the 

radio button. They are used to set the initial map alignment. You can use 

the map alignment buttons to more precisely locate the map to the group.

Position Information

The position information section contains X,Y, and Z readouts for map 

position, as well as a popup menu to control the motion path interpolation 

method for the map position channel. You can change the map position by 

dragging, or by typing values into the edit boxes.

Rotation Information

The rotation information section contains X,Y, and Z readouts for map rota-

tion, as well as a popup menu to control the motion path interpolation 

method for the map rotation channel. You can change the map rotation by 

rotation tools and keyboard shortcuts, or by typing values into the edit 

boxes. 

World Coordinates Checkbox

When this checkbox enabled, the map will reside in world space instead of 

local space. Effectively, the map becomes fixed in space at the coordinates 

specified (you can always animate its position, of course), and the group 

would then be perceived as moving through it’s map if the group were 

moved. 
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Map Projection Tab

The projection tab is used to determine the type of mapping primitive that 

the map will project, as well as the tiling method and map scale. There are 

four types of map tiling:

• None
• Hold
• Repeat
• Mirror

None. Disables mirroring of the map on the specified map axis. Choosing 

None for both axes will cause the map to be displayed only where you 

positioned it, nowhere else. You can choose this option along with another 

to constrain a map to hold, mirror, or repeat along a single axis.

Hold. Applies the colors found at the map edges outside of the map area. 

The map will appear once as positioned, with the border colors of the map 

extending beyond the map rectangle, covering the object.

Repeat. Repeats the map along the specified axis. Choosing Repeat for both 

axes will cause the map to repeat continuously, depending upon the scale 

of the map relative to the group.

Mirror. Mirrors the map along the specified axis. Choosing Mirror for both 

axes will cause the map to flip flop about both axes.

Disable UV

This option is available when “Use UV Space” has been turned on in the 

Group Info window. Checking it prevents UV’s from being used for the 

map. This allows the UV space to be used for some maps but not others.
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Map Type Popup Menu

Map projections use simple primitives to process and align the texture map 

for rendering. There are four types of map projections:

• Flat
• Cylindrical
• Spherical
• Cubic

Pick the projection which most closely matches the shape of the group.

Flat. This option (the default) is best used for flat or flattish objects. If 

applied to a non-flat-object, the texture will streak along the sides of the 

object as it is projected onto all surfaces of the group.

The rectangle in the display represents the map and consists three arrows, 

one pointing to the top of the map (Y axis), one pointing out to the side of 

the map (X axis) and the other pointing out from the center of the map (Z 

axis.)

Figure 16.23 — Map Projection Tab
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The flat projection scale defaults to the group’s extents. The scales of the 

projection are visible in the X Scale, Y Scale, and Z Scale edit boxes and can 

be changed by typing new values into the edit boxes.

Cylindrical. This option projects a cylindrical image around the group.

A cylinder is oriented around the center of the object, with an arrow point-

ing towards the top of the cylinder, and a line indicating where the seam 

will be. This is the best mapping type to use if the object is roughly cylindri-

cal.

Cylindrical map types have three projection alignment controls, wrap 

angle, height and radius. The wrap angle controls the longitude projection, 

and the height factor controls the latitude projection of the cylinder. The 

wrap angle axis allows angles from 0˚ to 360˚. The default is 180˚. The 

height factor allows a real number factor, with 1 being the default size. The 

radius represents the radius of the cylinder, and defaults to fitting from the 

center of the group to the edge extent of the group.

Spherical. Spherical mapping warps the bitmap into a spherical shape, and 

then projects the map onto the group. A sphere primitive is centered 

around the group, with a line running along the sphere. This line is where 

the seam of the map will occur, and also points to the top of the map. An 

arrow runs from the center of the primitive to the top of the sphere. This is 

the best mapping type if the object is roughly spherical.

The spherical texture type has four separate projection alignment controls, 

wrap angle, band angle, band angle start, and radius. The wrap angle con-

trols the longitude projection, and the band angle controls the latitude pro-

jection. The wrap angle axis is a circular axis allowing angles of 0˚ to 360˚.
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The band angle axis is half circular, allowing for angles of 0˚ to 180˚. The 

band angle start determines where the band angle will begin. The band 

angle is centered on the sphere by default. The radius represents the radius 

of the sphere, and defaults to fitting from the center of the group to the 

edge extent of the group.

Cubic. The front face of the cube will have an “x” through the center, much 

like the flat type. There will also be three lines indicating the top (Y axis), 

front (Z axis) and side (X axis) of the map.

When this map is used with a cube-shaped group, all sides should project 

onto the group with minimal distortion. If this mapping type is applied to a 

curved group, the edges of the cubic map will be seen, appearing like a 

seam. Seaming also occurs when the projection is not properly aligned to a 

cube-shaped object.

The front face is the active face, which determines the overall mapping 

characteristics of the selected group. Use the active face to correctly scale 

the texture to the group, as well as to correctly orient the projection to the 

group’s coordinate space.

Map Scale Edit Boxes

The map scale edit boxes can be used to fine tune the scale and fit of the 

map on the group. There are separate values for X, Y, and Z axes.
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Image Map Tab

The image map tab contains thumbnails of the RGB and Alpha channels of 

an image map, some statistics about the map, the map cropping rectangle, 

a Replace Map button, and movie playback information for multi-frame 

map files.

RGB and Alpha Thumbnails

The RGB and Alpha thumbnails give you a quick visual reminder of the 

contents of the map channels. If you click on the thumbnail, a larger image 

will appear in the view window to the right of the tab. If you double click 

on the image in the view window, the actual image will be displayed in a 

separate image display window.

Replace Image Button

Allows you to replace the current texture file without losing the placement, 

scaling, and other settings.

Figure 16.24 — Image Map Tab
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Cropping Edit Boxes

These coordinate boxes allow you to crop the texture map to any size or 

portion of the map you wish to use. You can crop interactively by first click-

ing on the RGB or Alpha windows, to bring up the image in the texture 

window, and then drag the crawling ants border.

Map Playback Controls

These controls will appear whenever you have selected a mutli-frame map 

as a texture. You can adjust the end behavior, at what frame the movie will 

start, how many frames to play back, and the playback rate.

End Condition Popup Menu

This controls how the movie will behave when the end of the file is 

reached. There are three choices:

• Repeat
• Oscillate
• Hold

Repeat. Repeats the movie when the end of the file is reached.

Oscillate. Cycles back and forth through the movie when the end of the file 

is reached.

Figure 16.25 — Map Playback Controls
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Hold. Holds the movie at the last frame when the end of the file is reached.

• Start Frame

The first frame of the animated texture to be used. The first frame of the 

animated texture is considered frame 1 not frame 0. Choosing a value other 

than one will cause the animated texture to begin at that frame. Combined 

with the Frame Range edit box, you can choose to render just a section of 

the animated texture map.

• Frame Range

This value sets the number of frames to use for the animated texture map. 

When combined with the Start Frame value, this feature can be used to ren-

der just a section of the animated texture map. The default value is 0, which 

causes all frames in the animated texture map to be used.

• Frame Rate

Controls the number of animated texture frames to increment for every 

frame of the output animation. The default is 1.0. Smaller numbers will 

speed up the apparent playback of the texture when viewed at speed. 

Larger numbers will make the texture appear to be slower. Extremely large 

numbers will make the texture appear to be “step framed.” You can fine 

tune the playback by using real numbers (numbers with decimals.)
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Map Filter Tab

The map filter tab contains the image filtering and map strength controls 

for the texture map. This tab also is used to select how the different RGB 

and Alpha channels will be processed. The filter tab is divided into several 

sections:

• Map Filter Check Boxes
• Map Quality Edit Boxes
• Map Strength Slider
• Use Channel Popup
• RGB Channel Configuration
• Alpha Channel Configuration
• Texture Falloff

Map Filter Check Boxes

These check boxes enable map filtering, and the Negative Z function. There 

are a total of four check boxes:

• Interpolate

Figure 16.26 — Map Filter Tab
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• Anti-Alias
• Negative Z
• Calculate Once (automatic reflections only)

Interpolate. Interpolation filters the map as it is applied to the model. It 

cuts down on aliasing, but can also soften the image (especially as the map 

grows larger than 1.0 in scale.) Disabling this feature will sharpen the map, 

but doing so is not recommended.

Anti-Alias. Texture anti-aliasing is another form of map filtering. With this 

option enabled, the map is effectively anti-aliased twice, first, during the 

stage in which the map is applied, then, as the entire image is anti-aliased. 

This can cause a loss of high frequency detail in the map, which some con-

sider objectionable. Disabling this feature will cause some aliasing, but the 

overall image anti-aliasing might hide the artifacts. Use at your discretion.

Negative Z. Causes the texture map to be projected along both the positive 

and negative Z axis. The map will be projected along only the positive Z 

axis if this checkbox is off. As an example, imagine a flat map placed on a 

nearly flat disk. If the Negative Z checkbox is on, the map will appear on 

both sides of the disk. If the checkbox is off it will appear only on the front 

side.

Calculate Once. Causes a mirror or environmental reflection map to be 

rendered only once in the animation. This feature can save much rendering 

time, although it must be used wisely, as the reflection will not update after 

the first frame.
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Map Quality Edit Boxes

These edit boxes offer even more control over the quality of the texture. 

There are two values to do so:

• Blur
• Samples

Blur. Allows you to degrade the map sharpness. This tool is useful for blur-

ring a bump map that is too sharp and not giving you a clean bump, or tak-

ing the edge off of a reflection that might appear too busy otherwise.

Samples. Controls the quality of the map. For the most part, 5 samples will 

yield acceptable results. If you wish to improve the quality of your maps 

even more, just increase this value. Higher values will increase rendering 

time, however.

Map Strength Slider

This slider controls the amount of affect the current texture has on the 

group. Use this slider when you have multiple texture maps on one group 

to mix together several maps. This value can be animated to cause maps to 

fade in/out over time. The value can be greater than 1.0. 

Use Channel Popup Menu

This popup is used to specify what image map channels you wish to use 

and for what purpose. You can choose RGB, Alpha or both and then specify 

if you want it used as color or as value and if you want to invert it. There 

are three choices:

• RGB Only
• Alpha Only
• RGB + Alpha
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RGB Only. Uses the RGB channel only for the map. The options field 

changes when this item is selected, offering you the ability to use the map 

as a color map, or as a value map (in which case the map will be automati-

cally converted to gray scale.) There is also a button to the invert the map.

Alpha Only. Uses the alpha (mask) channel only for the map. The options 

field changes to the invert map button, allowing you to reverse the alpha 

channel.

RGB + Alpha. Uses both the RGB and Alpha channels. When this option is 

selected, the options field displays configuration sections for both the RGB 

and alpha channels, which allow you to modify the behavior of these two 

channels. These configuration sections are described in detail below.

RGB Channel Configuration

There are four items in the RGB channel configuration section:

• As Color
• As Value
• Invert
• BlendMode:

As Color. This option sets the RGB channel to be used as color only. The 

color of the map will be passed through to whatever shading channel the 

map is applied to (note that some channels, such as Bump/Displace and 

Clipping, do not use RGB colors.)

As Value. This option uses the RGB colors as values (think of it as an auto-

matic gray scale map conversion.) Effectively, the RGB channel can be used 

to drive value-based effects, such as bump and displacement maps, clip 

maps, transparency value maps, and so on.
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Invert. This option negates the colors of the RGB channel. The map can still 

be used either As Color or As Value. This option often prevents a quick trip 

to Photoshop!

BlendMode. This menu allows you to better control how texture maps and 

shader affect what is beneath them as they are rendered. If a single map is 

applied, the mode selection will affect how the map is applied to the sur-

face of the group itself. If the texture or shader is applied on top of another 

map or shader, the blend mode selection will affect just that item directly 

underneath it. The blend mode functions in the same manner as blend 

mode for layers in Adobe Photoshop.

Blend Modes can be used only on images which contain data in the RGB 

channel. They cannot be used for the alpha channel of the map.

Please see your Photoshop manual for a detailed description of each Blend-

ing Mode.

Figure 16.27 — Blend Modes
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Alpha Channel Configuration

There are three items in the Alpha channel configuration section:

• Ignore
• As Mask
• Invert

Ignore. Ignores the alpha channel altogether.

As Mask. This option enables the alpha channel to be used as a mask. 

Invert. This option negates the colors of the alpha channel.

Falloff

Texture Falloff allows a texture to “fade away” towards the edges of a 

group by a user-controlled amount. This allows you to cause the detail of a 

texture to blend away over a distance. It also allows pseudo color ramps to 

be easily created (ramping form the falloff texture to the surface attribute 

underneath).

The texture will always falloff from the center of the group outwards in all 

directions. The falloff values presented are in actual object units. As an 

example, if a plane object is 200 by 200 units, and you wish the texture to 

falloff at the edges, you could type in 100 for all three texture axes (remem-

ber to divide the size of the group in half, as falloff is calculated from the 

center of the object).

In a sense, texture falloff works like an alpha edge mask.
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Special Tab

Depending upon the type of map, this tab may be empty or may contain 

controls for bump/displacement maps, as well as a button to bring up the 

procedural shaders dialog box.

Bump Factor. Sets the amount of Bump for the texture map. This edit box 

will only appear when the map has been applied to the Bump/Displace-

ment channel.

Displacement. Sets the amount of Displacement for the texture map. This 

edit box will only appear when the map has been applied to the Bump/

Displacement channel.

Clip Factor. Sets the amount of Clipping for the texture map. This edit box 

will only appear when the map has been applied to the Clip channel.

Procedural. Opens the Procedural Shader dialog box. This box has all of 

the options specific to the shader in use. This button only appears when the 

applied map is a procedural shader.

Figure 16.28 — Special Tab
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First Visible Frame. The value in this box (defaults to 0) determines when 

the texture (still or animated) or shader first appears in the scene. This fea-

ture is especially useful for animated textures. You can control when the 

sequence of animated frames first begins ‘playing’ in the scene.

16.8 Drag and Drop Textures and Shaders

You can drag and drop the texture or shaders to another channel, copying 

the item and its Texture Info window parameters as well.

Hold down the Alt-Key (Option-Key on Macintosh) and click/hold on the 

texture, drag the texture up to one of the tabs (this will cause the tab to 

come forward), then drop the texture into the Texture List Box of your 

choosing.

Shaders can also be dragged into the Variance List in the Shader Variance 

editor (discussed below) in the same way.

16.9 Shader Variance Editor

The Shader Variance editor, Material Palette > Shader Variance Editor, 

gives you the ability to save different shader settings under unique names. 

A shader’s dialog box can be brought up, changes made to the settings, and 

then this configuration can be saved and used over and over again.

Variances are stored in the EI Shaders folder. There is one “.var” file for 

each shader. Don’t forget to copy these files when you move your software 

to a different computer.
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The editor contains a scrollable list of all the shaders in the EI Shaders 

folder on the left hand side. To scroll the list, drag in it while holding down 

the Spacebar. Hold down Shift-Spacebar to drag faster.

Letting the mouse linger over a shader will bring up a tool tip containing 

the shader’s name.

Click on a shader to highlight it. This brings up a list of it’s variances on the 

right-hand side. In the example shown in Figure 16.29, the Bricks shader 

has been selected and three variances are shown in the Variance List.

Double-click on the variance to bring up its unique dialog box. Any 

changes you make in this dialog box are saved with the variance.

Figure 16.29 — Shader Variance Editor
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If you hold down the Control-key (Command-key on Macintosh) and drag 

your mouse on a shader, the light source will move across the surface of the 

shader.

Add. This button adds a new variance entry for the highlighted shader. 

Once you have added the entry, you can double-click on it to open the 

shader dialog box.

Del. This button deletes the entry highlighted in the Variance List.

Merge. Merges the selected .var file into the editor. This allows you to 

exchange shader variances with colleagues.

Rename. This button renames the entry highlighted in the Variance List.

Display. This pull-down menu controls how the variance entries are laid 

out in the list. Tile lays them out in a matrix pattern (in rows and columns). 

List lays them out in one vertical column.

Minimize. This check box shrinks the variance entries down to the same 

size as the shaders in the Shader List on the left-hand side of the editor.

Drag and Drop Shader Variances

Shaders (both those in the scrollable list and the variances) can be dragged 

from the Shader editor directly into a Material Info window, Texture List 

box. Several variances can be shift-selected and all dragged at once. In this 

way, the Shader editor can be used to manage all of your shaders and their 

variances. Alternately, you can use the new Shader Palette (discussed 

below) to move shaders into the Material Info window.
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Shaders can be dragged from the Material Info window, Texture List box 

into the Shader Variance palette. To do this, hold down the Alt-Key 

(Option-Key on Macintosh) and click/hold on the shader drag the shader 

to the Variance list and let go of the mouse button. You will then be asked 

to name the variance.

16.10Shader Palette

 The Shader palette, Material Menu > Shader Palette, is a handy way to 

view your entire catalog of shaders and to drag them into the Material Info 

window. To scroll the list, drag in it while holding down the Spacebar. Hold 

down Shift-Spacebar to drag faster.

The palette gives you access to all of the shaders in their default modes and 

to all of the variances you have created using the Shader Variance editor. To 

Figure 16.30 — Shader Palette —Tile Layout
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view the list of variances for a shader, Right-click (Ctrl-click on Macintosh) 

on the shader. A menu will pop up containing the list of variances and the 

original shader, “Default”. Choosing a variance will cause it to be dis-

played in the palette.

If you hold down the Control-key (Command-key on Macintosh) and drag 

your mouse on a shader, the light source will move across the surface of the 

shader.

Layout Menu

Right-clicking (Ctrl-clicking on Macintosh) in the title bar brings up the lay-

out menu for the Shader palette. These controls vary the appearance of the 

palette.

View By List. In this mode, the palette is laid out in one long vertical list 

with the names of the shaders shown to the right. Clicking on the option 

button (upper right hand corner of palette) acts as minimize/maximize 

window.

View By Tile. Shown in Figure 16.30, the palette is laid out in rows and col-

umns of shaders. Clicking on the option button (upper right hand corner of 

palette) acts as minimize/maximize window.

Figure 16.31 — Layout Menu
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View By Strip. In this mode, the palette is laid out in one long list with the 

names of the shaders shown underneath. Clicking on the option button 

(upper right hand corner of palette) switches the palette from a horizontal 

to vertical layout.

Small Icon/Large Icon. When switched to Small Icon mode, the names of 

the shaders are not displayed. Letting your mouse linger over a shader will 

bring up a tool tip with its name.

Drag and Drop Shaders

Shaders can be dragged from the Shader editor directly into a Material Info 

window, Texture List box. Several shaders can be shift-selected and all 

dragged at once.

Shader Subfolders

Subfolders are supported in the EI Shaders folder. Storing your shaders in 

subfolders (along with their .rsc and .var files) allows you to logically orga-

nize your shaders by functionality. Simply create a new subfolder in the EI 

Shaders folder and drag the .shd, .rsc and .var file into the subfolder. The 

Shader Variance editor and Shader Palette will display the subfolders just 

like in the Material palette. See “Material Palette — Strip Layout” on 

page 510.
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16.11Material Palette

The Material palette, Material Menu > Material Palette, provides control 

over the materials stored in the EI Material folder. You can drag materials 

from the palette onto the shader ball in the Group Info and Material Info 

windows. To scroll the list, drag in it while holding down the Spacebar. 

Hold down Shift-Spacebar to drag faster.

The palette contains materials, subfolders (blue), and the containing folder 

(purple). These correspond to the materials files (“.mtr”), and folders in 

your EI Material folder. Double-clicking on a subfolder will cause the pal-

ette to display the contents of that folder. Double-clicking on the containing 

folder will take you up one level in the folder hierarchy.

In the example shown in Figure 16.32, the contents of a folder called, “Best 

Materials” are shown. This folder contains two materials, “Gold” and 

“Materialx” and three subfolders, “Cartoon”, “Construction” and “Fabric”. 

The folder, “Best Materials”, is in the EI Material folder.

Figure 16.32 — Material Palette — Strip Layout
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Note The Material palette does not act as a Master Material. If you update the library 

entry, the objects that you have previously copied the material to will not update. 

Please use the Material palette in conjunction with the Master Materials to achieve 

this behavior.

Layout Menu

Right-clicking (Ctrl-clicking on Macintosh) in the title bar brings up the lay-

out menu for the Material palette. These controls vary the appearance of 

the palette.

View By List. In this mode, the palette is laid out in one long vertical list 

with the names of the materials shown to the right. Clicking on the option 

button (upper right hand corner of palette) acts as minimize/maximize 

window.

View By Tile. Shown in Figure 16.30, the palette is laid out in rows and col-

umns of shaders. Clicking on the option button (upper right hand corner of 

palette) acts as minimize/maximize window.

Figure 16.33 — Layout Menu
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View By Strip. In this mode, the palette is laid out in one long list with the 

names of the materials shown underneath. Clicking on the option button 

(upper right hand corner of palette) switches the palette from a horizontal 

to vertical layout.

Small Icon/Large Icon. When switched to Small Icon mode, the names of 

the materials are not displayed. Letting your mouse linger over a material 

will bring up a tool tip with its name.

Drag and Drop Materials

Materials can be dragged from the palette and dropped onto the shader 

ball in the Group info or Material Info windows. This will replace all tex-

tures, shaders, and material settings that were originally present. 

You can put a material into the Material palette by dragging from the 

shader ball in the Material Info window and dropping the material onto the 

palette or into one of the subfolders shown in the palette. You will be asked 

to name the material. If the material name already exists, you will be asked 

if you wish to replace the original.
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Using Effectors

17.0 Introduction

Effectors are invisible null objects that models, cameras, and lights in a 

scene can be linked to. Any transformation, rotation, scale, or deformation 

applied to the effector will be passed on to the groups that are linked to it. 

Using effectors allows you to control complex animation's by layering 

motion characteristics into separate control objects. The following chapter 

will explain the use of effectors of all kinds, and describe the layout of the 

effector window.

Adding Effectors to a Scene

1. Choose Object > Add Null. 
2. The cursor will change to an arrow with a cube next to it.
3. Click in any view window to set the effector in the scene.

If, after issuing Object > Add Null, you click on a group name in the 

Project window, the null that is created will have extents matching those of 

the group you clicked on.
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17.1 The Effector Info Window

An effector’s characteristics are controlled by the settings in the Effector 

Info Window. This window is very similar to the Group Info window for 

model geometry. It is divided into three specific sections, each marked by a 

folder tab.

• X-Form
• Special
• Bone Action

X-Form (Transformation) Tab

The X-form tab in the effector info window is similar to the x-form tab for 

other objects in a scene. There are three rows of data cells that allow the 

input of values:

• Position
• Rotation
• Scale

Figure 17.1 — The Effector Info window with the X-form tab displayed
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Position. This row of data cells allows the input of X, Y, and Z position val-

ues for the effector. The “Key” pull-down menu offers a choice of 

“Implicit” or “Explicit” keyframe recording.

Implicit. Will create a velocity curve for the key frames. 

Explicit. Will create f-curves for the key frames.

Rotation. This row of data cells allows the input of X, Y, and Z rotation val-

ues for the effector.

Scale. This row of data cells allows the input of X, Y, and Z scale values for 

the effector.

Auto Edit Y Z. When on, the scale value entered in X will automatically be 

copied to Y and Z. This is a simple way to enforce non-uniform Scaling.

Special Tab

Figure 17.2 — The Effector Info window with the Special tab displayed
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The Special tab contains editable fields that affect how different types of 

effectors display in a scene. This tab is used for Box Effectors, Joints, and 

Bones only.

The Style pull down menu in the effector info window offers a choice of 

how you want to display an effector. The standard effector display styles 

are Cross and Box. There are also a special class of effectors called Joints 

and Bones that create pre-built hierarchies. Whichever display method is 

chosen, keep in mind that an effector represents a single point in space, and 

is transformed in relation to that point.

The Effector Style Menu

Box. Choosing Box from the style drop down menu will display a cube in 

the scene. An extra check box called Show Extent will become available 

right below the Style drop down menu.

Extents are essentially the lines that join to create the cube. They display the 

outer limits of the space occupied by the effector. Unchecking this box will 

disable the display of the cube, leaving only its center of rotation visible in 

the scene.

 

The defining characteristic of a box effector is that it can be resized. This 

makes the box effector display perfect for scaling and deformations, as well 

as surrounding groups of linked objects.

Figure 17.3 — A box effector showing extents
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Special Tab Options

Selecting Box from the style pull down in the Effector Info window will 

cause the Special tab to display two options:

• Origin 
• Size

These options only affect the way the effector displays.

Origin. The Origin defines the point in space that the boxes extents are 

drawn from. The origin displays as a small cross. In the picture below, the 

Origin is represented by the black circle and the black crossed lines at the 

center of the effector.

Size. The Size defines the size of the box effectors extents in world units. 

Don't confuse size with scale (found in the X-Form tab). If you scale a box 

effector, you will scale all objects attached to it. Changing extent size affects 

only the box display. You can, for instance, change these values to make a 

box effector larger in order to surround the groups that are linked to it.

The size and origin boxes work together to control the overall size and 

positioning of the effector in space. When a change is made to the size val-

ues, the boxes extents will change in relation to the origin point. To keep 

the origin exactly in the center of the box the values in the origin fields need 

to be a negative half of the value in the size fields.

Figure 17.4 — The Origin and Size value boxes
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For instance, if you change a boxes size from 1.0 on x, y, and z to 100 you 

would need to change the origin to -50 on x, y, and z to keep the point from 

which the box is drawn even with the boxes center point.

Cross. Choosing Cross from the style menu will display a small target 

shaped circle.

 

The defining characteristic of the cross effector display type is that it can't 

be resized. This makes the cross effector ideal for large scenes that require 

constant zooming in and out.   Regardless of how far in or out you zoom, 

the cross effector will remain the same size, and thus be easy to select and 

manipulate.

Special Tab Options

There are no editable attributes displayed in the special menu for a cross 

effector.

Joint. Choosing Joint from the style drop down menu will display a Skele-

ton Effector Joint Vector in the scene.

Figure 17.5 — A cross effector
518       EIAS Animator   



Chapter 17  Using Effectors — Style Menu
 

A joint displays as a long, toothpick shaped object, that is pointy on one 

end and round on the other. The center of a joint effector is displayed 

where the horizontal and vertical vector lines cross. Joint effectors are used 

to create skeletal hierarchies. To create a linked chain of bone effectors use 

the Character > Create Bones command. The Objects created will be bones. 

Change the style to Joint to use the Joint Effectors.

Special Tab Options

Selecting the joint display method enables a row of size data cells in the 

special tab.

These values can be modified to change the length of the Joints vector. 

Because skeleton joints always orient with the Z-axis running the length of 

the vector, the only value that needs to be changed is the Z data field. 

Bone. Choosing Bone from the style drop down menu will display a Bone 

Effector Joint Vector in the scene. 

Figure 17.6 — Joint effector

Figure 17.7 — The Size boxes
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A bone displays as a long, toothpick shaped object, that is pointy on one 

end and pyramid shaped on the other. The center of a bone effector is dis-

played where the horizontal and vertical vector lines cross. Bone effectors 

are used to deform object meshes. To create a bone effector chain use the 

Character > Create bones command.

When a bone display style is chosen, several new items become available in 

the effector info window.

 

Bone Color

The bone color displays the color the bone will appear in when it is dese-

lected. This color can be changed by clicking on the color tab and choosing 

a new color from the color picker.

Bone Highlight

The bone highlight color displays the color the bone will appear in when it 

is selected. This color can be changed by clicking on the color tab and 

choosing a new color from the color picker.

Set Rest

Rotating a bone into the desired position and pressing the “Set Rest” but-

ton will tell the bone what position to stay in when it is at rest.

Figure 17.8 — Options in the window when Bone is selected
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Set Bias

Resets the current rotation values of the bone to 0,0,0. Bones have a default 

Z orientation, which can interfere with imported data, such as motion cap-

ture data. This feature lets you position the bone, and then “zero it out.” 

This is similar to indexing a servo motor or motion control axis on a robotic 

camera system.

Special Tab Options

Selecting the bone display method enables several options in the special 

palette. These options are specific to how a bone deforms a mesh. 

Bones

Bones are a special class of effectors that can be used to create pre-linked 

hierarchies. Bones both display with a ball at the joint pivots and a pyramid 

“bone” in between.

Figure 17.9 — The Special Menu options for Bone
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Bone chains can be used to create complex hierarchies that geometry can be 

linked to. By allowing an underlying hierarchy of effectors to control a 

complex model, you gain the freedom to manipulate, or replace geometry 

without the necessity of re-defining all of your joint parameters.

Bone Effectors are also used to create chains that can deform an object’s 

mesh. They can be used to create smooth skeletal deformations in situa-

tions where you can’t work with a jointed model.

Adding Bones:

1. Choose the Character menu and pick Create Bones.

2. Click in any window to set the root of the chain (double click to set the 
root for a bone), 

3. Click a second time to set the length of the vector. 
4. Continue clicking in this fashion to create a linked chain of any length.
5. To end the creation of a chain type command or control “.”.

Bone Orientation

The Z-Axis of a bone is always oriented parallel to the length bone vector. 

This has the potential to cause confusion if you don’t look for it.

For instance if you draw a bone in the front view window, starting at the 

top and moving to the bottom, you would expect the z-rotation tool to 

Figure 17.10 — Bone Effector
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rotate the effector like the hand on a clock. However, you will find this isn’t 

the case because the Z-axis is aligned with the world's Y-axis.

17.2 Why use an Effector?

Often times an animation requires “layering” of motion. You may need to 

translate or rotate an object in several different ways to achieve the desired 

animated results. The only problem is that an object has only one set of data 

channels. Once the rotation channels are filled, for instance, they can't be 

changed without erasing the previous values. You can, however, link to a 

second object to create a second set of rotations that will happen on top of 

the rotations that have already occurred in the local data channels. EFFEC-

TORS allow you to gain control of your animation by separating transforma-

tions into easily addressable layers.

One classic example of this is a moon orbiting a planet. You want the moon 

to rotate about its local center point, but you also want it to orbit around 

the planets center point. You create a rotation of the moon on the Y-axis so it 

spins. But now you have to give the moon a second Y-axis rotation charac-

teristic that orbits it around the planet. The only way to do this is to link the 

moon to an effector that is positioned over the center of the planet. By rotat-

ing the effector on Y you can create two y-rotations for the moon!

Another example would be creating a swarm of bees. You would want to 

individually animate each bee so it flies in a slightly different manner, but 

you would also want all the bees in the swarm moving forward at a similar 

rate. You could animate each bee's forward motion individually. Each time 

you change one bee in the swarms forward accelerations, however, you 

would have to re-animate the rest of the swarm to follow. A better way to 

control the swarm would be to link each bee in the swarm to an effector 

that pulls them forward as a group. This would allow you individual con-
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trol over each bee (as long as the link type is set to free), but move them all 

forward at the same rate.

If you're working on a complex animation task and having difficulty 

achieving the desired results, ask yourself “Could an effector help me 

here?”
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The Joint Editor

18.0 Introduction

Through the Joint Editor, you determine transformation behavior, rotation 

order, link type, rotation orientation, movement constraints, inherited 

transform behavior, and joint attributes. It is wise to take the time to work 

with these attributes to get the most from bones deformations and inverse 

kinematics.

A pivot point is the location on the group in which rotations occur. It is also 

the point of origin for scaling operations, and translation (movement). A 

pivot point is visible for each group in all of the world windows.

The pivot point and the group center are almost always located in the same 

position. The group center can be offset from the pivot point by typing in a 

new value in the Group Info Window. Doing so is ill advised, and can cause 

some unwieldy animation behavior.

The pivot point defaults to the center of the group. You can use the Joint 

Editor to place the pivot point at some other location. You can even set the 

pivot point to be well outside of the group’s extents, if need be.

There are four ways to access the Joint Editor:

• Select a group and choose the Joint Editor icon from the Tools palette
• Select a group and choose Hierarchy>Joint Editor

• Select a group and choose the Joint Editor Icon from the Project Win-
dow

• Hold down the Command & Option keys (PC -Control & Alt keys) and 
double click on a group.
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18.1 Joint Editor Anatomy

The Joint Editor can be positioned to your preference. It can also be resized 

by clicking on the lower right hand corner and dragging. It is context sensi-

tive — the contents of the window will change to reflect the currently 

selected group. It can display the linkage information for one group at a 

time. The window is divided into three sections:

• Group Preview Pane
• Pop Up Menu Section
• Tab Section

Group Preview Pane

The group preview pane allows the pivot point for an object to be interac-

tively positioned by clicking and dragging. Unlike the world windows, the 

pivot point representation in the Joint Editor is that of a large red cross hair, 

called a gnome. The gnome displays the X, Y, and Z coordinate position 

and orientation for the joint. Where these vectors meet represents the center 

of the pivot point. 

Figure 18.1 — The Joint Editor
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The detail to which an object is drawn in the group preview window is con-

trolled by the settings in the Drawing Preferences Box, under Edit>Prefer-

ences, Drawing Tab. Also, the shader ball icon can be set to control 

drawing, by holding down the option (PC- MSWindow) key and clicking 

on the icon, then choosing the desired drawing level from the pop up menu 

list.

The group preview window view can be manipulated in the same way 

world view windows are. Clicking on the zoom button will bring an object 

closer or farther from the view window. Option-clicking (PC- Alt-clicking) 

on the zoom icons will fit the group into the view. Clicking on the view 

pop-up will change the angle from which the object is viewed.

The gnome can be positioned by clicking and dragging on it in any ortho-

graphic view.   The gnome cannot be interactively dragged when the view 

is set to skew, but it can be interactively rotated.
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+Z

+Y

-Y

Pivot Point Center

Figure 18.2 — Pivot Point Gnome
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18.2 Pop Up Menu Section

The pop up menu section at the top of the Joint Editor contain settings that 

will affect joints the same way regardless of what information is entered in 

the tabs. There are three menus:

• Transform Menu
• Rotation Order Menu
• Link Type Menu

Transform Menu. Rotations are susceptible to a distortion known as 

“shearing” when non-uniform scaling is applied to groups within a hierar-

chy. The transform menu lets you choose how the phenomenon will be 

addressed, on a group by group basis (each group can have a separate set-

ting). The transform menu offers two options:

• Classic
• Standard

Standard. To avoid the shearing phenomenon, this option allows ElectricI-

mage EIAS to compensate by processing scaling operations so that the 

shearing phenomenon does not occur. This is the default method.

Classic. This method bypasses any compensation for the shearing effect. 

You can use this option if you are not applying non-uniform scaling to any 

groups in the hierarchy without any ill effects. If you do notice shearing, 

switch to the Standard method. This option is called classic because other 

programs on the market use this method (even though it is less sophisti-

cated.)

Rotation Order Menu. Object rotation order determines how rotations will 

be processed. Each rotation axis is processed one at a time. Ultimately, one 
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of the three axes will nullify one of the other axes. For example, a rotation 

applied to Y and Z may produce the same result, even though they are 

clearly different axes. This is called “gimbal lock.” Choosing a different 

rotation order can alleviate the problem.

The default is ZXY. This means that Z rotations will be calculated first, fol-

lowed by X, and finally by Y axis rotation calculations. For many animation 

situations the default settings will work just fine.

A good rule of thumb for assigning rotation order is to calculate the axes in 

a descending order of stability. Think about how you're object is moving, 

and decide which axis is most important to creating the desired motion. 

Which axis is second most important, and which is the least important. 

The last six choices in the Rotation Order pull-down have a fourth coordi-

nate inside parentheses. This coordinate controls the last rotation in the 

order. For instance, XYX(z) indicates an X rotation, then a Y rotation, and a 

second X rotation that is controlled by the Z coordinate channel.

Note An alternative method for dealing with gimbal lock is to assign separate effectors 

for each axis of rotation, and parenting the group to these effectors. Set up each 

effector so that it can only rotate on a single axis, which prevents gimbal lock alto-

gether.

Link Type Menu. The Link Type pull-down menu contains pre-configured 

link types that can be applied to an objects pivot point. Use this pull-down 

menu to set a basic set of position and rotation limits for a joint. The link 

type chosen will create global rotation and position limits that will override 

specific values entered in the limits sub-palette, by locking specific X, Y, 

and Z channels.
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There are eleven menu options in the Link Type Menu:

• Custom…
• Free
• Ball Planar
• Cylinder Planar
• Planar
• Socket
• Cylinder
• Universal
• Slide
• Pin
• Lock

Custom. The custom option opens a dialogue box that allows specific rota-

tion and position parameters to be locked or unlocked for a group. Parame-

ters with check marks next to them are completely disabled. For instance, a 

check mark next to Lock Y Position will disable an objects ability to move 

on the Y-axis.

The Custom link type can be used to see what kind of position and rotation 

limits are created by the other pre-defined link types. Just pick one of the 

link types, like socket, and then choose Custom. The Custom Joint dialogue 

will pop-up with the limits that a socket link uses already checked off.

Free. This link type allows an object total freedom to move and rotate on all 

axes. Free is the default link type for root objects in any chain. Because this 

joint type is free to move and rotate on all axis, the values in the limits sub-

palette will override it.

Ball Planar. This link type locks the Y position channel only.
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Cylinder Planar. This link type locks the Y position channel and the X rota-

tion channel.

Planar. This link type locks the Y position channel and the X and Z rotation 

channels.

Socket. This link type locks the X, Y, and Z position channels.

Cylinder. This link type locks the X and Y position channels and the X and 

Y Rotation Channels.

Universal. This link type locks the X, Y, and Z position channels and the X 

rotation channel.

Slide. This link type locks the X and Y position channels and the X, Y, and 

Z rotation channels.

Pin. This link type locks the X, Y, and Z position channels, and the X and Y 

rotation channels.

Lock. This link type locks all position and rotation channels.

18.3 Folder Tab Section

All of the specific local controls for a group’s pivot point can be set in the 

folder tabs of the Joint Editor. There are three folder tabs in this section:

• X-form (Transformation)
• Inherit
• Limits
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The X-Form Tab

The X-form tab controls the position and orientation of the gnome, and 

thus the pivot point for an object. Values entered in these fields will cause 

the gnome to be re-positioned in the group preview pane.

Link Alignment Position

This pull-down controls the position of the groups pivot point in relation to 

its geometric bounds. The different choices will place the gnome in that 

position relative to the group.

There are a total of seven items in this menu:

• Middle
• Front
• Back
• Top
• Bottom
• Left
• Right

Figure 18.3 — The Transformation window
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Middle. The default for all objects, positions the pivot point exactly in the 

center of the object.

Front. This option positions the pivot point with the groups front.

Back. This option positions the pivot point with the groups back.

Top. This option positions the pivot point with the groups top.

Bottom. This option positions the pivot point with the groups bottom.

Left. This option positions the pivot point with the groups left side.

Right. This option positions the pivot point with the groups right side.

Link Alignment Orientation

This pull-down controls the orientation of the groups pivot point. Chang-

ing the link alignment orientation changes the orientation of the X, Y, and Z 

axes of the pivot point. Changing the Link Alignment Orientation will 

change the direction that the object rotates.

The results of changing the Link Alignment Orientation can be seen in the 

group preview pane by watching the changes in the gnome orientation as 

different options are chosen.

There are three choices in the Link Alignment Menu:

• Z is Z
• Z is X
• Z is Y

Z is Z. The default option maintains the objects initial link coordinates.

Z is X. This option will swap the group's Z and Z coordinates so that the Z 

coordinate becomes the X coordinate.
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Z is Y. This option swaps the group's Z and Y coordinates so that the Z 

coordinate becomes the Y coordinate.

Position Section

This area contains data cells for the X, Y, and Z position of the pivot point. 

Entering values in this field will update the position of the gnome in the 

group preview window.

Rotation Section

This area contains the data cells for the X, Y, and Z rotation of the pivot 

point. Entering values in this field will update the orientation of the gnome 

in the group preview window.

Parental Offset Section

This area contains data cells for the X, Y, and Z parental offset values of the 

pivot point. The parental offset is the distance between the pivot point of 

the parent object, and the pivot point of the child object. Changing the val-

ues in the Parental Offset data cells changes the distance between the pivot 

point of the child and the pivot point of the parent, it does not change the 

position of the pivot point in relation to the object. Changing the parental 

offset value will cause an object to move closer too, or farther away from its 

parent.
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The Inherit Tab

The inherit tab controls which transformations performed on the parent 

will be passed on to the child in a hierarchy. To enable an attribute check its 

box, to disable an attribute uncheck its box.  

By default rotation and position information are passed from the parent to 

the child. When a parent object is transformed or rotated, its child will be 

transformed or rotated accordingly. If the position and rotation checkboxes 

were unchecked, the child would not react at all to the parents movements.

The default preferences for the inherit options can be changed by choosing 

Edit>Preferences, Import & Data tab. The Import & Data tab contains an 

identical set of attributes to the inherit palette. Checking attributes in the 

Import Preferences dialogue will make those settings the default for all 

newly created hierarchies.

Inherit Position

This check box option, when enabled, links the position of the child group 

to the position of its parent group. When the parent is moved in X, Y, or Z 

space, the child will be moved with it.

Figure 18.4 — The Inherit Tab
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Inherit Rotation

This check box option, when enabled, links the rotation of the child group 

to the rotation of its parent group. When the parent is rotated in X, Y, or Z 

space, the child will be rotated with it.

Inherit Scale

This check box option, when enabled, links the scale of the child group to 

the scale of its parent group. When the parent is scaled in X, Y, or Z space, 

the child will be scaled with it.

Inherit Visibility

This check box option, when enabled, links the visibility of the child to the 

visibility of its parent. When the parent's visibility is off, the child's visibil-

ity will be off.

Inherit Deformation

This check-box option, when enabled, will include the child with a defor-

mation applied to the parent. The deformation region for the parent must 

be adjusted to include the child object within the deformation region for 

this option to be effective. This is a very powerful feature that will allow 

you to deform an entire hierarchy as if it were one object.

Note Linking a child to an animated parent can cause the child to animate in undesirable 

ways. This occurs because a rotation is pre-calculated for the child. The motion 

path of the child is modified which can cause it to ‘fly off into outer space’.

You can avoid this behavior by turning off Inherit Rotation in the Joint Editor for 

the child prior to linking it to its new parent. No pre-rotation calculation will be 

performed and the original motion path will be kept. After the linking has been 

done, the Rotation Inheritance can be turned back on
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The (Joint) Limits Tab

Joint limits allow you to set up your hierarchy chains to behave in a realis-

tic manner, using a variety of natural forces and limited ranges of freedom. 

You can also create joint libraries to make the creation of complex hierarchy 

chains easier. 

The limits tab consists of the following items: 

• Rotation Tab
• Stiffness Tab
• Viscosity Tab
• Position Tab

The Rotation Sub-Tab

The rotation sub tab allows joint rotation limits to be set for X, Y, and Z 

rotation. There are four items in the tab:

• Enable Limits Check box
• Minimum Section
• Center Section
• Maximum Section

Figure 18.5 — The Limits Tab
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Minimum Section. This row of data cells contains values, in degrees, for 

the minimum angle a joint can rotate.

Center Section. This row of data cells contains the values, in degrees, for 

the angles at which the joint wants to be naturally positioned at rest. This 

value is used to help smooth the transition between the minimum and 

maximum rotation limits. Instead of rotating between the maximum and 

minimum, the joint motion curve will arc through the center limit first.

Maximum Section. This row of data cells contains values, in degrees, for 

the maximum amount a joint can rotate.

Use Current Value Arrows

Each data cell in the rotation limits sub-palette has a small arrow that, 

when clicked on, will bring up a Use current value box. Selecting this 

option will update the current rotation value of the joint into the data cell. 

This allows rotation limits to be set interactively by rotating a joint with the 

rotate tools, and transferring the value of the rotation into a limits data cell. 

The Joint Editor is non-modal, so you can easily jump back and forth 

between world view windows and the limits palette to make use of this 

feature.

EIAS Animator knows to put the highest value in the maximum box, and 

the smallest value in the minimum box. This means you can click on the 

Figure 18.6 — The Rotation sub-tab
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Maximum or Minimum use current value arrow and the proper values will 

be inserted where they belong. For instance, if you try to put a negative X 

value in the maximum box, and a positive X value in the minimum box, 

ElectricImage EIAS will automatically “flip-flop” the two values so the pos-

itive value is in the Maximum box and the negative value is in the Mini-

mum box. 

There is an additional current value choice in the drop-down menu for the 

center data cells called Use center of limits. Selecting this option will divide 

between the minimum and maximum limits and enter the result in the data 

cell. Note that in some cases the center of limits may not be where you want 

the joint to be when it is at rest. In those cases manually rotate the joint into 

the resting position and select the “use current values” option.

The Stiffness Sub-Tab

The stiffness sub-tab can be used to control the amount of pull required to 

move a joint through its X, Y, and Z rotation. The higher the values in these 

fields the harder the pull required to move the joint. The end result is that 

joints with a smaller stiffness setting will move farther, faster, than joints 

with a high stiffness setting. 

An example would be a human leg. The thigh bone should move slower 

than the shin bone. Setting a higher stiffness for the thigh would mimic this 

Figure 18.7 — The Stiffness Sub-Tab
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motion. The Enable check box, when checked, makes the stiffness settings 

active.

The Viscosity Sub-Tab

The viscosity sub-tab can be used to control the viscosity, or apparent fric-

tion, of a joints X, Y, and Z rotation. The higher the values in these fields, 

the more friction the joint will appear to experience as it rotates. Very high 

values will make the joint appear to catch and release as it rotates. Click the 

Enable box to activate viscosity.

An example would be a rusty door hinge. The rust would cause more fric-

tion, and thus cause the joint to move in an un-smooth fashion. To recreate 

this you would apply a high amount of viscosity to the hinge joint.

The Position Sub-Tab

The position sub-palette allows joint position limits to be set for the X, Y, 

and Z axes. These limits control how close, or far, a group can move from 

Figure 18.8 — The Viscosity Sub-Tab
540       EIAS Animator   



Chapter 18  The Joint Editor — Position Sub-Tab
its parent. The enable limits check box, when checked, makes the position 

limits active. 

There are two sections in the Position Sub-Tab:

• Minimum
• Maximum

Minimum. This row of data cells contains the minimum X, Y, and Z posi-

tion values for the groups joint.

Maximum. This row of data cells contains the maximum X, Y, and Z posi-

tion values for the groups joint.

Each data cell has a drop-down menu arrow that, when selected, will input 

the current position of the joint into the field.

18.4 Working in the Joint Editor

Because the Joint Editor offers a wide variety of tabs and input fields, it's 

helpful to develop a standard procedure when creating joints. Like any 

complex task, it's best to start with the basics and work your way to the 

specifics. A basic procedure might go something like this:

1. Choose a pre-defined link type from the Link Type pull-down menu.
2. Select the X-Form Palette and choose a link alignment position for the 

pivot point. (If one applies)

Figure 18.9 — The Position Sub-Tab
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3. Interactively drag the gnome into position in the group preview win-
dow. Tweak the values in the X-form palette if needed.

4. Set Joint rotation and position limits in the Rotation and Position sub-
palettes.

5. Test your joint to make sure it's working properly.
6. Set Stiffness, Viscosity, and Gravity settings only if they're needed.
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Constraints

19.0 Introduction

The constraint system in EIU allows you to animate position, rotation, 

scale, or the pole-vector (IK handles) using the position, rotation, or scale of 

other objects. The object that is constrained is called the “constraint object”. 

The objects doing the constraining are called, “targets”. One constraint 

object may be constrained by many targets. The influence of each target is 

controlled by a floating-point value called, “weight”. This value is used to 

compute a weighted average of the desired constraint. This final value is 

called the “target point”. If all targets have equal weight, the target point is 

a simple average between them. A higher weight value relative to the other 

weights increases the influence of a target, while a lower weight value rela-

tive to the other weights decreases the influence of a target. A value of zero 

effectively removes the target's influence from the constraint. All weight 

values can be animated, which allows you to change the constraint over 

time, effectively creating animations without changing the position, rota-

tion, or scale channels of the constraint object.

The new constraint system replaces the Look-At and Auto-Bank features 

that were included in the older versions of the ElectricImage™ Animation 

System. Unlike the older method, which required pre-computation of 

Auto-Frames, the new system is real-time and interactive. For example, if 

your camera is constrained to look at an object, you will see the camera 

rotate in the View windows as you drag the object around the scene. 
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19.1 Applying Constraints

Constraints are added to an object via the Constraint menu. Select the Con-

straint Object and then choose one of the available constraint types from 

the Constraint menu. A dialog box will come up letting you know that you 

are about to replace any animation data with the constraint. Click away this 

reminder and you are then prompted to choose the target(s). Targets are 

selected by clicking on them in the Project or View windows. The selection 

process is terminated by hitting the Escape key or Command-. (Macintosh). 

If the constraint type is inappropriate for the object, that type will be 

grayed out in the menu. If the constraint conflicts with another constraint, 

for example, aim conflicts with either Auto Look or Rotate, you will be 

notified and no constraint will be added.

Figure 19.0 — Constraint Menu
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Once constraints have been applied to an object, the Constraint Editor dia-

log box may be brought up by first selecting the constraint object and then 

choosing Constraint Editor from the Constraint menu. The dialog has a 

“Type” pull-down menu with a list of constraint types that have been 

applied to the object. Each type has an associated list of targets in the “Tar-

get” area of the dialog box. All the constraints allow you to change the 

Weight of each target (select the target from the list and then change the 

Weight value) and to delete the target. You may also disable the constraint 

engine for the constraint type by turning off the Enable Constraint Engine 

check-box.

The Constraint Editor also has a Modify region that lets you disable the 

constraint’s effect on individual axes. Targets may be deleted using the 

Delete button. If all targets for a particular constraint are deleted then the 

constraint itself is deleted.

Figure 19.1 — Constraint Editor
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19.2 Constraint Types

Auto Look The Auto Look constraint causes the constraint object to point toward the 

targets and can blend in rotation/reference data from the constraint object 

itself. This constraint replaces the look-at feature in 3.0 EIAS and earlier 

versions of EIAS. To enable Auto Look, select a constraint object, and then 

select the targets to look at. One of the targets can include the constraint 

object itself, which indicates to the engine to use the constraint object’s 

rotation/reference animation channels as part of the weighted solution.

While the constraint is in force, the rotation/reference channel values in the 

Group Info window of the constraint object cannot be altered. It is neces-

sary to turn off the engine temporarily to allow the editing of the con-

strained channels. The “Enable Constraint Engine” button in the Constraint 

Editor dialog box can be used to do this. Turning it off will revert the 

object’s rotation/reference back to its animation channel values.

As with all targets, the rotation/reference channel has a weight associated 

with it, allowing you to smoothly blend the various look-at points and ani-

mation values for the desired rotation/reference orientation.

Auto Bank Auto Bank allows an object’s orientation to be animated while the object is 

moving along a curved path. This constraint replaces the auto bank feature 

in EIAS 3.0 and earlier versions of EIAS.

To enable Auto Bank, select the object, and then select a null object (any 

effector in the scene) as a target. It actually doesn’t matter what object you 

choose since the target isn’t used by the constraint system. The weight of 

the selected target is used to blend the Auto Bank rotation with the rotation 

in the animation channel of the constraint object.
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The “Enable Auto Roll” button adds a “roll” into the banking based on the 

gravity vector length. The tighter the curve, the more pronounced the roll. 

The larger the gravity length, the less pronounced the roll. The gravity 

direction has no effect.

The orientation is computed by looking back and ahead a certain amount 

of time. Looking ahead in time allows you to “anticipate” an orientation 

change on the curvature of the path. Looking back in time allows you to 

“ride out” an orientation change. Looking ahead in time is called Anticipa-

tion and is entered in seconds. Looking back in time is called Backtrack and 

is also entered in seconds.

Figure 19.2 — Constraint Editor-Auto Bank
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Aim Aim is a multi-purpose aiming constraint that allows you to specify which 

direction to aim at and to set an up-direction to keep the object upright. The 

aim vector is the main vector to aim the constraint object toward. It is possi-

ble to aim the object in directions other than the main three axis x, y, or z. 

The local up-vector keeps the object upright in its local space, while the glo-

bal up-vector keeps the object upright in its global space. 

The global up-vector is a reference vector for the local up-vector. When the 

aim vector aligns with the target, the local up vector tries to align itself as 

close to the global up-vector as possible.

Position The Position constraint moves the constraint object to the target point. The 

target point is the weighted average of the target centers. An optional X,Y,Z 

offset can be included. This offset is applied to the computed target point.

Figure 19.3 — Constraint Editor-Aim Constraint
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Rotate The Rotate constraint rotates the constraint object in global space as the 

result of the weighted average of the global rotations of its target(s).

Scale The Scale constraint scales the constraint object based on the weighted 

average of the scales of the targets. Either local or global scales are used 

based on the check-box in the Constraint Editor. 

Normal The Normal constraint keeps the constraint object oriented normal (per-

pendicular) to the target. This constraint is different than the others in that 

the Constraint Object must be linked to another group and that group is 

animated, not the Constraint Object. The simplest way of achieving this is 

to link the Constraint Object to an effector. Create a Normal Constraint 

between the Constraint Object and the target. As you drag the effector over 

the target, the Constraint Object will move with the effector and rotate to 

remain normal to the target.

While computing the constraint, there is a choice of point search methods. 

The “Every Vertex” method is the slowest and will use all vertices in the 

target to find the closest point between the constraint object and the target. 

Use it if the target has non-shared vertices. The “Closest Vertex” method is 

the fastest and will use the closest vertex to find the closest point on the tar-

get. Use it if the target has all vertices shared.
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Geometry The Geometry constraint keeps the constraint object at the position of the 

target point and normal (perpendicular) to the target point. The target 

point is the point on the target that is closest to the constraint object. The 

target must be a geometric mesh (a group). The constraint system will only 

use one target at a time. If you have added multiple targets, the one with 

the largest strength will be used. 

This constraint is different than the others in that the Constraint Object 

must be linked to another group and that group is animated, not the Con-

straint Object. The simplest way of achieving this is to link the Constraint 

Object to an effector. Create a Geometry Constraint between the Constraint 

Object and the target. As you drag the effector over the target, the Con-

straint Object will move to stay fixed to the target.

Figure 19.4 — Constraint Editor-Normal Constraint
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While the Normal constraint will only use the target’s computed surface 

normal to affect the orientation of the constraint object, the Geometry con-

straint will use the computed surface normal AND surface point to com-

pute the orientation and position of the constraint object. Since both will 

clash with the rotation/reference channel, use the Geometry constraint if 

you desire both normal and position constraint.

The surface normal at the target point can be the target orientation so that 

the aim vector of the constraint object aligns with the normal vector.

Pole

Vector

The Pole Vector constraint rotates the Pole Vector toward the target point. 

The target point is the weighted average of the position of all of the targets. 

19.3 Circular Dependencies

EIAS Animator will prevent you from creating conditions that allow circu-

lar dependencies. For instance, create a new project and then add a sphere 

and a cube. Now constrain the sphere to the cube’s position (sphere is con-

straint object, cube is target). Animator will no longer allow you to link the 

cube to the sphere in a parent/child hierarchy. Why? Because the sphere is 

getting its position from the cube via the constraint. If the cube were a child 

of the sphere, then, through inheritance, the cube would be getting its posi-

tion from the sphere. A cycle would then be created and Animator 

wouldn’t know how to resolve the correct position of the objects.
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Inverse Kinematics

20.0 Introduction

Inverse Kinematics (IK for short) is the process of computing the rotations 

and positions of the parents in a hierarchy given the position and rotation 

of the children. The term “Inverse” comes from this method of solving the 

hierarchy from the bottom-up. Traditional, forward kinematics, computes 

the position and rotation of the children by inheritance from the parents 

(top-down).

IK is a more direct method of animation for characters when you want to 

position the end of a hierarchical branch (called a “chain”) and have the 

other parts of the branch follow naturally. With IK, you can drag a charac-

ter’s hand to the door knob and the forearm and upper arm will follow. 

Figure 20.0 — Arm Chain
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EIAS Animator allows you to apply a controller, called an “IK Handle”, to 

chains. Once applied, the handle is used to manipulate the chain. Moving 

the handle causes the IK engine to solve for the position and rotation of the 

members of the chain. 

20.1 Creating an IK Handle

An IK Handle is created by selecting the bones to be controlled by the Han-

dle in the Project window or one of the View windows and then choosing 

Add IK Handle from the Character menu. Instead of choosing all the bones 

in the chain, you may choose only the last one. In this case, the IK Handle 

created will control all the bones from the end of the chain up to the top of 

the branch (the chain must contain at least two elements or no IK Handle 

will be added).

Once added, the IK Handle will appear in the Project window and in the 

View windows. 

Figure 20.1 — Arm Chain with IK Handle
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In the View windows, the IK Handle is represented by a green plus sign. 

The first and last bone being controlled by the Handle is indicated by a 

Handle Vector. Optionally, two other IK Handle sub-controllers can be 

shown, the Twist (oval shape) and the Pole Vector (line ending in small 

cube). These sub-controllers are discussed below.

The IK Handle is added to the bottom of the Project window and given a 

unique number to differentiate it from existing handles.

Multiple IK Handles can be added to a chain but the Handle Vectors may not over-

lap. In the arm example, Figure 20.1, you could add a Handle from the shoulder to 

the wrist and then a second handle from the wrist to the joint end. But you could 

not add a second handle from the elbow to the joint end. Overlapping control is not 

permitted. If you attempt to do so, Animator will not add the Handle.

20.2 IK Handle Info Window

Double-clicking on the IK Handle in either the Project window or View 

windows brings up the IK Handle Info window. Like all other object 

classes in EIAS Animator, the IK Handle has an info window that controls 

basic attributes such as position, rotation, etc. The IK Handle Info window 

is divided into three tabs:

• X-Form
• Properties
• Chain

Figure 20.2 — IK Handle in Project Window
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On the left side of the window you will see three check-boxes. 

Enable

This check box (defaults on) allows you to disable the IK Handle. The Han-

dle won’t disappear from the View windows, but the IK engine will no 

longer be called when the handle is moved.

Show Twist

This check box (defaults off) causes the circular -shaped twist controller to 

be displayed in the View windows.

Show Pole Vector

This check box (defaults off) causes the Pole Vector controller to be dis-

played in the View windows.

X-Form Tab

The X-Form tab contains the edit boxes that control position, rotation, and 

scale for the IK Handle. 

Figure 20.3 — IK Handle Info Window
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Properties Tab

As depicted in Figure 20.3, this tab has all the controls for the IK engine. 

Including those for the type of IK engine (called a solver) and the current 

settings for the Pole Vector and twist.

Set Preferred Angle

There is an angle for each joint that the solver tends to move toward. This is 

called the Preferred Angle. Initially this angle is set equal to the rotation 

values in your chain at the time the IK Handle is applied. Pressing the Set 

Preferred Angle button resets the preferred angles to the current rotation 

values in your chain.

Why is a preferred angle needed? Imagine a chain made up of four bones 

in the shape of a “W” with the IK Handle at the top-right end of the chain. 

Pulling the handle to the far right would stretch the “W” shape out into a 

straight line. As you drag the Handle back to the left, it would be nice if the 

chain slowly took on its original “W” shape again. The IK engine is, in fact, 

able to do this by remembering the preferred angle for each of the joints in 

the chain.   

The preferred angle determines the preferred configuration of the IK chain 

and makes the IK solution predictable. Choosing the right preferred angle 

can also avoid singularity conditions. These conditions occur when you 

pick the fully extended position as the preferred angle for a chain. 

Note When creating a chain (building the arms of a character for instance), it is best to 

add the bones such that there is a angle less than 180 degrees between the joints. 

Creating bones in a perfectly “straight line” can lead to singularity conditions 

because the preferred angle is initially set to the angle of bone creation.
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Solver

There are three different mathematical engines (solvers) you can choose 

from to determine the optimal behavior of each IK Handle in your project. 

Pseudo The Pseudo solver solves an approximated linear system in a small interval 

and then integrates the results. This solver is more accurate than the Mini-

mizer, but slower. 

If you are using joints with rotation limits, the Pseudo solver may never 

reach the goal after it runs out of its time interval. This makes the Pseudo 

solver slow when using rotation limits. Therefore, we suggest using the 

Minimizer solver when rotation limits are involved.

Minimizer The Minimizer is implemented using a conjugate gradient method. It uses 

a recurrence formula to generate a series of mutually conjugate search 

directions and moves along the search directions to minimize the measure 

function of the chain configuration. 

The Minimizer solver efficiently handles joints with rotation limits and is 

superior to the Pseudo solver when rotation limits are used.

2-Bone The 2-Bone solver is the fastest of the three solvers but only works on the 

first two bones in the chain. It is ideal for arms, legs, and other bone pairs. 

Do not use it with chains that contain more than 2 bones. It does not offer 

high-accuracy when rotation limits are used.

Position Goal

This check-box tells the solver that its goal is to move the chain end to the 

same position as the IK Handle. This is the default.
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Orientation Goal

This check-box tells the solver to match the orientation of the chain end to 

the orientation of the IK Handle. Only the Minimizer solver uses this 

option. Orientation can be confusing since the solver may rightly decide 

that the solution has been reached before the chain has been dragged to the 

position of the handle. The Minimize solver creates a balance between the 

position goal and the orientation goal when both check-boxes are on.

The solver will not do anything if both Position Goal and Orientation Goal are 

turned off.

Chain Plane

There is an imaginary plane that runs through the joints in your chain. This 

plane is used by the engine to compute the orientation of the chain. Specifi-

cally, the Plane controls the twist of the chain. The IK engine has two con-

trollers, the Pole Vector and Twist, that allow you to control the overall 

orientation of the Chain Plane, and thus, the orientation of the chain. In 

EIAS, the IK engine uses the first two bones in the chain to create the plane.

Pole Vector

The Pole Vector is shown in the View windows as a green line that begins at 

the location of the IK Handle and terminates in a tiny box. You can drag 

this vector in the View windows to alter the overall orientation of the IK 

Plane.

Note that if the Pole Vector crosses the Handle Vector or becomes opposite 

to it during posing or animation, the entire chain can suddenly flip 180 

degrees around the Handle Vector. Take care to orient the Pole Vector to 

prevent this flipping behavior.
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Twist

The Twist controller allows you to rotate the entire chain about the Handle 

vector. The controller defaults to 0.0 degrees and indicates that by its black 

color. As you drag your mouse around the controller, the twist value will 

increase and the controller will become green to indicate the twist value.

 

Figure 20.4 — Pole Vector

Pole Vector

Handle Vector

Handle

Figure 20.5 — Twist

Twist Control
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Chain Tab

The Chain tab contains the list of bones that are under the control of the IK 

Handle. The list is not interactive, it is for reference only.

20.3 Using IK on Models

The sections above discuss the use of IK Handles with bone chains. EIAS 

allows you to use IK Handles on model groups directly. This is useful if 

your character is mechanically jointed. A good example of this is a robot. 

The geometry data for a robot is not a single skin but is instead a series of 

separate, jointed model groups. 

Once your groups have been organized into a character hierarchy, you can 

select model chains and apply IK Handles to them just as you would with 

bone chains.

You will need to use the Joint Editor (Hierarchy > Joint Editor) to set the 

link points for each of the groups in the chain (found in the X-Form tab). 

When creating a bone chain, this is done automatically. For model chains, it 

must be done manually. 

20.4 Go To Rest Position

The Character Menu contains the Go To Rest Position tool. Select an IK 

Handle in your project, then choose this menu item. The rotation of the 

bones being controlled by the IK Handle will be reset to their rest orienta-

tions.
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Skin and Bones

21.0 Introduction

EIAS includes a skinning engine that automatically deforms the geometry 

of your character (the “skin”) as you move your character’s bones.

The new skinning engine improves on the old method in both speed and 

ease of use. Restrictions such as the bones being the children of the skin and 

adding bones-style deformations have been eliminated.

Skinning is now a dependency. That is, a relationship outside the hierarchy 

is created between the bones and the skin (geometry). This means that the 

bone chains driving the skin cannot be dependent on the geometry in any 

other way. Therefore, BONES CANNOT BE CHILDREN of the skin. 

There is one exception to this rule. Bones used with the old-style bones 

deformation system can and must still be children of the geometry. 

Figure 21.0 — Skin With Bones

Single Skin

Bones
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21.1 Bones

Bones are a type of effector designed to give geometry motion and defor-

mation. They are linked together in short hierarchies, called bone chains or 

skeleton chains. 

For information on adding bones to your scene, see The Animator 3.0 Man-

ual, Chapter 13, “Using Effectors”  and “Bones” on page 674.

When using bones with the skinning engine, the options in the Bone Info 

window are valid with a few exceptions. Bone length, influence region, and 

strength are not animated values. At the time of the skin binding, the cur-

rent values will be used and further changes will be ignored. Also note that 

“Rest” Position has no meaning anymore. The minimum and maximum 

influence values for bones will still have effect and may be useful in influ-

encing the “folding” of the skin.

Note Animator version 4.0 has removed the “skeleton effector”. This was an 

alternate effector type that could be used to manipulate the position of 

geometry but not alter its shape. Bones fulfill both of these purposes, and in 

addition, IK Handles can now work directly on model chains. See “Using 

IK on Models” on page 561

Split Bone

A new command has been added to the Character Menu, “Split Bone” 

(Character > Split Bone). This command divides the selected bone into two 
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separate bones, maintaining the hierarchy. The new bone is inserted as a 

child of the original bone and children of the original bone become children 

of the new bone. Split Bone can be used after you have created your skele-

ton to give a particular chain more definition and control. For example, let 

us say your character’s spine has 3 bones and you decide that the character 

needs to bend in a very flexible way. Splitting the bones would now give 

you 6 bones in the spine without having to go to the trouble of manually 

rebuilding the skeleton.

Bone Strength Tab 

This tab lists the strength maps that the bone is associated with. See 

“Strength Maps” on page 569 for more information. The list is in the form 

of map name, followed by the skin name in parenthesis. The button next to 

the list entry may be used to temporarily remove the bone from its associa-

tion with a particular strength map. The “Del” button permanently deletes 

entries from the list.

Figure 21.1 — Bone Strength Tab

Skin
Name

Map
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21.2 Binding the Skin

Binding is the process of creating a dependency relationship between a 

group of bones, the “skeleton”, and the skin (geometry). 

When building the skeleton, place it in the center of your skin. When you 

are ready bind the bones to the skin, these spatial relationships will be pre-

served throughout the animation. Changing the initial relationship will 

involve detaching the skin from the bones and then re-binding the skin 

geometry to the bones.

Skin binding is accomplished in one of two ways:

1. Select any bone in a skeleton chain and use the “Bind Skin To Skeleton” 
in the Character menu (Character > Bind Skin to Skeleton) to bind the 
ENTIRE bone chain to the geometry group.

2. Select one or more bones and use the “Bind Skin To Selected” in the 
Character menu (Character > Bind Skin To Selected) to bind only the 
SELECTED bones to the geometry group.

You can add more bones to the skin at any time by selecting the bone(s) and 

then using Character > Bind Skin To Selected. Also, a bone or a chain may 

be bound to more than one skin at a time. This is important when your 

character is made up of multiple geometry groups. 

Once bones have been bound to a skin, the skin can no longer be translated, 

rotated, or scaled directly. These functions must be performed on the bones 

(or the controllers and IK handles you have added to assist in moving the 

bones). The bones give rise to both the movement and deformation of the 
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skin. Morphing, deformations, materials, and any other surface-modifying 

features can still be applied directly to the skin.

Note Skinning will work several times faster on FACT geometry than on geometry cre-

ated by plug-ins. This is because the skinning engine caches data to prevent recom-

putation at every frame. This isn’t possible with plug-ins because they can change 

the number and order of vertices every frame.

21.3 The Skin Editor

The behavior of the skinning engine can be adjusted for each skin in your 

project using the Skin Editor. Select the skin with skinning options you 

wish to examine and choose “Skin Editor” from the Character menu (Char-

acter > Skin Editor). 

The bottom half of the Skin Editor contains the bone list. The “All” tab 

shows the list of the bones bound to the skin. The “Del” button can be used 

to unbind selected bones from the skin.

The “Active” tab shows the list of the bones that actually influence the skin. 

Even though a bone is bound to the skin, it can be deactivated by turning 

off the “Activate” button in the Bone Info window. Bones with this button 

turned off will not be shown in this list. 
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Weight Minimum

The Minimum weight allows you to specify the minimum influence a bone 

has on a vertex. If the computed weight falls below this threshold, the bone 

will not influence the vertex. This is a time versus accuracy control. Smaller 

numbers will improve the accuracy of the skin engine but at the cost of 

slower performance. 

Falloff

The distance Falloff Power allows you to “tighten” or “loosen” the influ-

ence of the bones based on the distance between the skin’s vertices and the 

bones. The lower the falloff power, the “softer” the influence becomes. A 

“linear” falloff allows the vertex to pull away from the bone while a 

“Power of 32" falloff grips the vertex very tightly to the bone.

Figure 21.2 — Skin Editor
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Bone Maximum

The Bone Maximum edit box contains the maximum number of bones that 

can influence each vertex in the skin. A value of 0 does not allow any influ-

ence, hence no skinning deformation at all. A value of 1 only allows the 

closest bone to influence the vertex, thus producing folds which are very 

angular and tend to penetrate the skin, while higher values produce more 

pleasing folds but at a somewhat slower performance.

Note If you notice that vertices in your skin are being left behind (separating) as you 

move the bones, try reducing the Weight Minimum and increasing the Bone Max-

imum.

 

21.4 Strength Maps

Strength maps allow you to fine tune the effect of a bone's influence on the 

skin. Strength is a relationship between a particular vertex in the skin and 

any number of bones. The skin may have many of these strength maps, 

each of which controls how much influence one bone has over another at a 

particular point on the skin. Each bone can be associated with a single map 

per skin (but a bone may be bound to more than one skin). 
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Strength maps are a property of the skin and are added, removed, and con-

trolled using the “Strength” tab in the Group Info window. There are two 

kinds of strength maps; Painted maps that you paint directly on the skin, 

and Texture maps that are applied using the normal material tools.

Add as Paint

Clicking on the “Add as Paint” button creates a new vertex Paint map. You 

are asked to give the paint map a name. The named map appears in the 

Strength List. Double-clicking on the paint map in the Strength List allows 

you to rename the map.

Figure 21.3 — Group Info Window—Strength Tab

Strength
List
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Duplicate Paint

Makes a copy of the highlighted Strength map in the Strength List. This is a 

great way to experiment with changes to your Strength maps without 

changing them permanently. Select the map, duplicate it, then turn off the 

original using the blue enable button to the left of the map in the Strength 

List. You can now experiment with the copy without losing the original.

Add as Map

This brings up a texture get-file dialog box. You choose the texture map and 

it appears in the Strength List. Double-Clicking on the texture map in the 

Strength List brings up the Texture Info window. This window is used to 

position the map on the skin. The Texture map will automatically set the 

strength at each vertex based on the luminance value of the texture pixels.

Note Only the first frame of an animated texture map will be used.

Remove

The Remove button deletes the highlighted map from the Strength List.

View

Places the View windows into the strength map display mode. For texture 

strength maps the color of maximum strength may be chosen. The View 

palette pops up that allows the display color of maximum influence (100%) 

to be changed. Minimum influence (0%) is always shown as black. The 

color is displayed on the skin in the view windows as long as the palette is 

open. For painted maps, the Paint palette pops up and interactive painting 

on the skin may take place.
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Note The View windows must be in OpenGL mode (the hardware engine must be in use) 

and set to Flat, Gouraud, or Phong to see the strength.

 Attach Bones

Associates the bones selected in the Project window or View windows with 

the map highlighted in the Strength List.

Select Bones

Selects the bones in the Project window and View windows that are associ-

ated with the map highlighted in the Strength List. This is a quick way to 

see which bones are associated with a particular strength map.

21.5 Painting

When using a Paint map, you can interactively paint the skin using the 

built-in paint tool. To bring up the tool, select the Paint map from the 

Strength List and click on the “View” button. The Paint palette pops up and 

the skin’s color is changed to show the strength at each vertex. The color 

will be shown on the skin in the View windows until the Paint palette is 

closed.

 Shortcut The W key can be used to temporarily turn off the paint colors while you 

are in paint mode.

Note The View windows must be in OpenGL mode and set to Flat, Gouraud, or Phong 

to see the strength.
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Color (Hue Angle)

Changes the color of maximum influence (100%). Minimum influence (0%) 

is always shown as black. This doesn’t alter the behavior of the skin it is 

just a color preference.

Strength (Percentage)

Sets the value for the paint brush (0 to 100 percent). 0 percent means that 

the bones associated with the skin do not affect the skin at all. 100 percent 

means that the bones have full influence on the skin. Keep in mind that the 

final computed strength for any vertex on the skin is the weighted average 

of all the bones. 

Shortcut Hold down the Control key and right mouse button (Control and Com-

mand keys on Mac), then drag the mouse right or left.

Brush Size (Pixels)

The Brush Size sets the radius of the brush in pixels. The brush cursor is 

shown as a circle in the View windows. 

Shortcut Hold down the right mouse button (Control Key on Mac) and drag the 

mouse right or left.

Figure 21.4 — Paint Palette
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Cull Vertex

The Cull Vertex check-box, when on, causes the brush to modify only the 

vertices visible in the View window in which you paint. When off, the 

brush paints straight though the skin to the polygons behind. If you are 

painting the left ear in the Side View window, the right ear will also be 

painted.

Feathered

Feathered modifies the vertex strength by the distance of the vertex to the 

brush center (cursor) and its value. This causes the strength to fall off as it 

moves from the center of the brush outward.

Invert

The “Invert” button inverts all of the strength values in the strength map. 

Setting 100% to 0% and vice-versa.

Fill

Brings up a dialog box that allows you to set every vertex in the map to a 

specified value.

Process Skin While Painting

When on, the skinning engine is called as you paint. This gives you con-

stant feedback on the effect your painting is having on the skin deforma-

tion. The multitude of calculations required to provide this feedback is 

significant. You may wish to turn this option off to increase the speed of 

painting.
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Note If you see whole polygons turning a different color as you brush instead of nicely 

blended vertex colors, your OpenGL card or driver does not support the standard 

Vertex Blending feature. See your OpenGL card’s specification for more informa-

tion on this feature.
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Using Sound in Animator

22.0 Introduction

You can add sound to Animator for the purpose of synchronizing the 

sound to your animation. Animator supports sound file formats through 

QuickTime. Supported formats include WAV and AIFF. 

Add a soundtrack using the Object Menu > Import Sound... command. 

Once added, the soundtrack with its waveform will be displayed in the 

project window.

When you write out a preview animation file to QuickTime, the 

soundtracks in your project are written as well. This feature is not available 

when writing out preview files to the Image file format. Image does not 

support sound.

22.1 Sound Info Window

The Sound Info window, as shown below, contains controls for playing the 

selected soundtrack, along with settings for the selected soundtrack’s start 

time in the project. It also contains settings for selections of the soundtrack 

and the creation and maintenance of cues (small sections of the 

soundtrack).
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To open the Sound Info window, select the soundtrack in the Project win-

dow, then choose Sound Info from the Object menu (or double-click on the 

soundtrack icon in the Project window).

Play

This button, when clicked, plays the soundtrack. While the soundtrack is 

playing, the button changes to read Stop.

Pause

This button, when clicked, pauses the soundtrack during play. while the 

soundtrack is paused, the button changes to read Continue.

Loop

This check-box, when enabled, causes the soundtrack to loop continuously 

during playback. It can be clicked on and off during playback.

Volume

This edit box and slider bar sets the volume of playback. It defaults to full 

volume (100). If you do not hear the sound during playback and there is a 

Figure 22.0 — Sound Info Window
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visible waveform shown in the Project window, check the settings of your 

computer’s OS-level sound control panel.

Rate

This edit box and slider bar sets the playback rate of the soundtrack. It 

defaults to full speed (100) and can be slowed down.

Duration Time

Displays the overall length of the soundtrack in seconds.

Starting Time

This edit box contains a value for the time in the project at which the sound 

starts.

Selection Start Time

This edit box contains a value for the time in the project at which the 

selected portion of the soundtrack starts.

A portion (selection) of the soundtrack can be selected in the Project win-

dow by clicking and dragging inside the waveform of the track. By default, 

the selection will appear to be cyan in color.

Selection Stop Time

This edit box contains a value for the time in the project at which the 

selected portion of the soundtrack stops.
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Sound Cues

The Cues tab contains controls for creating and managing sound cues. 

These are segments of the soundtrack that can be recalled and located at 

any time. When you create a cue, the cue’s duration in the soundtrack’s 

waveform will be shown in red.

Cue List

This box contains a list of cues created by selected a portion of the 

soundtrack and clicking the Add button. Double-clicking on the cue in the 

Cue List will put the cue in the selection region of the soundtrack. Clicking 

on the Play button will now just play the cue.

Add

This button is used to add a selected portion of the soundtrack to the cue 

list.

Delete

This button is used to deleted the cue selected in the cue list.

Figure 22.0 — Sound Info Window Cues Tab

Cue List

Notes
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Time

This edit box contains the value for the start time of the selected cue.

Duration

This edit box contains the value, in seconds, for the length of the selected 

cue.

Notes

This edit box can be used to annotate the selected cue.

Recording Sound

If you computer has a microphone or another sound input device, you can 

record your own soundtracks and add them to your Animator projects.

To record a soundtrack, choose Record Sound... under the Object menu. A 

dialog box will appear.

Figure 22.0 — Sound Recording
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Record

Start recording sound. 

Stop

Ends the sound recording. The Play and Save buttons will become active.

Pause

Pause the recording. 

Play

Play back the recording. This button becomes available when sound has 

been recorded.

Save

Saves the recorded sound to disk and adds it as a track in your project.
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Facial Animation

23.0 Introduction to the Morph Window

One of the most powerful features for character animation is morphing. 

There are effectively two types of morphing techniques — simple target 

morphing and weighted target morphing. EIAS Animator offers the 

weighted target method, as it is superior for facial animation. This chapter 

will concentrate on using the Morph Window for Facial Animation.

Morphing creates in-between models from a source model and one or more 

target models. The source model is typically a “neutral” version of the 

model, and the target models are versions of the model in various poses or 

expressions. In simple target morphing, the models may not even need to 

depict the same object. A plate could morph into an apple, for example.

Morphing requires that models contain the same number of points and 

polygons, and that they are stored in the same order. For example, the poly-

gons which make up a nose for the source model must directly map to the 

polygons which make up the nose in the target model. If these polygons do 

not correspond, very strange results will occur. 

The Morph Window is just one part of the character animation equation. In 

addition, bones, effectors, and inverse kinematics round out the tools that 

are typically used to create great character animation.

23.1 Creating Models for Morphing

It is best to start with the source model, and use it to create your target 

poses. There are a variety of ways to create both the source and target mod-

els, depending upon the modeling software that you choose to use. You can 
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even use the BONES feature in EIAS Animator to create target models from 

your source model.

To create the new poses or expressions that you need, you drag the points 

of the polygons to create the new shape. This can be a tedious and labori-

ous process, but when done well, the results are worth every second. 

Note 3D animator and reviewer George Maestri has written a very thorough 

treatise on character animation, which includes a variety of illustrations 

that are typically used for facial morphing. Published by New Riders, it’s 

called, “Digital Character Animation II: Essential Techniques” (New Riders 

Publishing— ISBN: 1562059300). It retails for approximately $40.00 at Ama-

zon.com— not cheap, but it will save you an incredible amount of time and 

effort!

23.2 Using the Morph Window in EIAS Animator

Once you have created the necessary target models, its then time to load 

the models into EIAS Animator so that they can be morphed. Morph model 

targets are not added into an EIAS Animator project as other models are. 

Instead, they are added through the Morph tool. All models in the project, 

whether or not they are used for morphing, are listed in the project win-

dow, above the group list (in the default project window display). Let’s 

load a model and have a look around the Morph Window.

To add a morph source model into EIAS Animator:

1. Add the source or anchor model to the project as a normal object file.
2. Be sure that the animation channel is enabled (Animation>Enable 

Animation).
3. Select the source model.
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4. Click on the MORPH BUTTON in the Project Window. 

The following window will appear.

The name of the source model will appear in the Morph Anchor section, to 

the top left. The model that will be morphed is drawn in the view area to 

the right of the window. 

The Morph Window is divided into sections:

• Morph Anchor
• Target Match Popup Menu
• Reload Target Data Button
• Morph Group
• Morph Target
• Keyframe/Timeline Slider
• Viewing Area

Figure 23.0 — Morph Window with targets
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Morph Anchor Section

The morph anchor is the base or source model. The morphing engine will 

actually use this model to create all of the poses and expressions specified 

by you in the Morph Window. The name of the anchor file is listed here.

Target Match Popup Menu

The target match popup menu tells the morph engine how to treat the 

morph target groups. There are five menu options to choose from, depend-

ing upon the desired treatment of the targets:

• First
• Full Match
• Index Only
• Name Only
• Geometry Only

First. This option will use the first group in the target model as the mor-

phing target. If you only have single groups in your morph models, use 

this option.

Full Match. This is the default option. Group names, number of coordi-

nates and group index order must all match in order for this option to have 

expected results. Properly constructed morph targets should conform to 

this recommendation.

Index Only. Group order must match in order for the morphing to work 

properly with this option selected. In other words, given a group named 

“foo” in both the source and target models, each occurrence of group “foo” 

in the target models must match the order in which group “foo” occurs in 

the source (anchor) model. No other restrictions are active with this option 

selected.
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Name Only. This option morphs only across group names contained 

within the source (anchor) model. All other groups will be ignored.

Geometry Only. This option ignores group names, or group order, and 

addresses each polygon vertex in the order in which it is stored within the 

model file. In this case, each vertex in the source model must be in the same 

order in the target models. This should be the case in any event.

Reload Target Data Button

This button will allow you to replace morph targets while retaining the ani-

mation channel data for the target. This is useful for fine tuning poses, or 

substituting higher resolution morph targets.

Morph Group 

Morph target models are placed within morph groups. You can have as 

many morph groups as necessary. Morph groups are used to organize your 

morph targets into logical collections. As you can imagine, some morphing 

projects can get pretty complex. The morph groups will help to better man-

age the complexity.

For example, if you have many different models which describe mouth 

movement, you may wish to place all of those targets into a morph group 

called “mouth.”

To add a Morph Group:

1. Click the Add Morph Group button.
2. A dialog will appear, asking you to name the group.
3. Click OK to clear the dialog.
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The morph group is created, and added to the Current Morph Group 

popup menu. Any morph targets that you add will always be added to the 

morph group indicated by the Current Morph Group menu.

Morph Target Section

As mentioned previously, the morph target models are effectively the 

extremes of the variety of poses or expressions that you will be using in the 

morphing process. Morph targets are contained within morph groups for 

easier management of model and morph data. Morph targets are added to 

the current selection displayed in the Current Morph Group Menu.

To Add Morph Targets:

1. In the Morph Target section, click the Add button.
2. A file dialog will appear, listed model files.
3. Select and add the desired target files.
4. When complete, press the done button in the dialog.

The target files are now displayed in the morph target area. Along with the 

actual file names, slider bars, edit and check boxes are also displayed in the 

Morph Target Section. The default state of a target slider is the center of the 

slider. A morph can actually operate in the positive or negative. The check-

box to the right of the target name enables or disables the target from being 

used in the morph process.

In addition to the actual Morph targets, there are three buttons and one 

menu in the Morph Target Section:

• Add
• Del(ete)
• Add Blend To Curve Editor
• Default Morph Blend Menu
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Add . This button allows you to add morph targets to the selected Morph 

Group.

Delete. This button allows you to remove the selected morph target from 

the morph target list.

Add Blend to Curve Editor. This button will manual force an update to the 

animation of the selected morph target to the function curve editor for fine 

tuning. In addition to the manual button presented here, at the bottom of 

the Morph Target section is a checkbox that will automatically send data to 

the function curve editor, if activated.

Default Morph Blend Menu. This menu allows you to choose the interpo-

lation method for the morph targets. The interpolation method will appear 

in the function curve editor as the appropriate spline type. There are four 

options:

• Linear (Default)
• Natural Cubic
• Hermite
• F-Curve

Linear (Default). This option directly blends one morph target to another. 

This option produces rather mechanical results.

Natural Cubic. This option uses a natural spline to interpolate one morph 

target to another. Splines tend to produce a more realistic result than linear 

interpolation. This curve type offers no modification options in the func-

tion curve editor.

Hermite. This option uses hermite splines to interpolate one morph target 

to another. Hermite splines offer additional Tension, Bias, and Continuity 

control over the spline curve interpolation. These attributes can be adjusted 
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in the FUNCTION CURVE EDITOR by selecting either the T, B, or C keys and 

dragging the mouse with the KEYFRAME selected in the editor.

F-Curve. This option uses function curves to interpolate one morph target 

to another. Function curves offer a very realistic result, and additional con-

trol in the FUNCTION CURVE EDITOR.

Keyframe/Timeline Slider

This slider sets the project time, so that the morphing action desired occurs 

at the time you specify. You can either drag the slider to the desired frame 

number, or manually enter the frame number in the edit section. 

To the left of the frame display field are the playback controls. These con-

trols are illustrated in the following diagram:

Figure 23.1 — Keyframe/Time line Slider with Playback Controls

Play Backwards Play Forwards

Step Back Step Forward
Play/Pause

Figure 23.2 — Playback Controls
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Play/Pause. Starts playback of the morph animation. All of the other play-

back controls require that Play be on in order to work.

Step Forward. Will cause the animation to step forward one frame.

Step Backward. Will cause the animation to step backward one frame.

Play Forward. Will cause the animation to play forward.

Play Backward. Will cause the animation to play backward.

View Area Section

This is where you can view the results of your morphing choreography. 

The default display is wireframe for speed, however, you can also display 

this window as phong shaded, by option clicking on the SHADER BALL icon 

in the upper section of the window.

23.3 Making Morphs

We have covered the Morph Window, and the process of adding a morph 

source model and its targets in the previous sections in this chapter. Now 

we are going to concentrate on creating actual morph animations.

The Morph Window is best used as a facial morphing system (although 

you can animate anything you care to morph with it). Each morph target 

has a slider that lets you blend the target with the source. The range of each 

slider is negative target to positive target, with the center, 0, being null (the 

source would be the result if all of the sliders set to zero. Typically, your 

morph target poses (the models that you create for the pose positions) will 

be the positive end of the scroll bar (value 1.0). The negative values (value -

1.0) are the opposite of the positive poses, and are derived by determining 

the change of the target model from the source model, and then negating 
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that value. This gives you the benefit of not having to create minimum and 

maximum ranges.

Note All of the morph targets are weighted and averaged together to form the final object 

for that frame. You can change the interpolation method for the best results. See the 

section entitled “Default Morph Blend Menu” on page 589.

The mechanics of the morphing process requires that you do two basic 

things:

• Set the current frame
• Move the sliders for the desired look for that frame

Tip Regular people tend to act pretty straight forward, and are usually not 

overly dramatic. Animators learned long ago that presenting such real 

world people makes a rather mundane performance. They learned that by 

exaggerating the performance somewhat, the performance becomes much 

more interesting. The typical purpose of character animation is to entertain, 

or sell by entertaining. A few extra movements, some obvious thought 

implied to the character perhaps, can go a long way. It can also go over-

board as well, and earn the curse of being “over animated,” especially if 

true to life subjects are being presented. 

Two of the greatest tools that you can use to your success are timing and 

characterization. Timing let’s you present the character effectively, making 

the most by doing the least. Simply stated, but not simply achieved. Some 

of the world’s best comedians are also the best at timing (knowing when 

and when not to tell a joke, give a look, and so on.) Timing for an animation 

is a learned art, and it takes patience to develop the skill. 

Characterization is effectively the soul of the character that you are endeav-

oring to create. Since the characters you are animating aren’t real, it is your 
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job to impose a sense of reality to them. In this way they can seem real, or at 

least real enough, so that the audience can accept them, and enjoy the per-

formance.

Typically, this involves imparting a sense of thought to the character, giving 

its actions a sense of deliberateness. Making the character appear to think 

and ponder, as well as react and emote, are all ways of imparting a soul to 

it. Some performances might be pantomime, others might use heavy dia-

log. Some might be theatrical, others might be subtle. 

Note In addition to the Maestri book, there is another must have reference has 

been written by two of the “nine old men” from Disney’s golden age: “The 

Illusion of Life,” By Frank Thomas and Ollie Johnston. It is available 

through Amazon.com, and retails for about $60.00. This book presents a 

remarkable history of Disney’s best animation, and is an excellent treatise 

on animating characters.

23.4 Timing
Typically, animation is keyframed every 8th frame. Cycles tend to happen 

in eight frames, gross mouth positions for dialogs on eight frames, and so 

on. Essentially derived at for film speeds of 24 frames per second, eight 

frames evenly divides a second into three even chunks. Video animation is 

29.997 frames per second, but you might find that ten frames can be just a 

tad too long (its up to you.)

You should put a keyframe where ever you think necessary (some anima-

tors have keyframes on almost every frame!) but the 8 frame technique is a 

good rule of thumb.
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To set keyframes in the Morph Window:

1. Move the keyframe slider into position
2. Adjust the morph target slider bars for the proper expression

The view area will update to the new pose. Keep adding new key frames 

every 8 or so frames as needed.

To playback the animation:

1. Click the Play/Pause button
2. Click the button again to stop

23.5 Working with Sync Sound

One of the most powerful character animation tools is sound. The great 

thing about sync sound and dialog is that the timing is built in. All an ani-

mator has to do is match up lip positions (and add some emotion, of course 

— acting!)

To animate with sync sound in the Morph Window, you use the sync sound 

display in the Project Window. The Keyframe slider in the Morph Window 

will stay in sync with the overall project time slider. By positioning the 

Project and Morph Windows relative to each other so that you can see the 

full Morph Window, and the sync sound track in the Project Window, sync 

sound is very straight forward to accomplish. To check your animation, 

create a preview in EIAS Animator in Quicktime format. When the quick-

time file plays back, you will be able to immediately see the in sync results 

of your work. 
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Sync dialog is actually fairly easy to animate to, and with a little practice 

the waveforms become very easy to read. As an assistant, you can use the 

Cue feature to break up the waveforms and annotate them from the Sound 

Info Window. A few minutes of work here will make sync dialog a snap. 

Typically, creating a separate cue for every spoken word should be enough. 

You can then use the cue playback feature to get a feel for the mouth posi-

tions required to sync. Then, all you do is match the mouth positions to the 

sound. The previous illustration shows how to organize your windows so 

that you can see the waveform and morph window at the same time.

Figure 23.3 — Typical Sync Sound Window Setup
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It’s a good idea to concentrate on matching the mouth movements in one 

pass through, and then layer in the emotional content in additional pass 

throughs. If you try to animate every aspect of the performance at once, 

things can get real confusing. Animating in passes is actually faster in the 

long run, and tends to yield better work.

23.6 Working with Morph Curves in the Function Curve Editor

The Morph Window is great for creating the expressions and emotions that 

you want to put into your character. The function curve editor is the better 

tool for tweaking timings of those expressions and emotions. Why? The 

Function Curve Editor presents morphing as curves, showing how the 

inter-relationships of the morph targets are working. Subtle changes can be 

made in the editor that would be rather tedious to try in the Morph Win-

dow. With a little practice you might even prefer to animate your morphs 

in the Function Curve Editor. It is also easy to match non-morph animation 

in your project with morph animation in the function curve editor.

note You can also adjust timings in the project window, by dragging the keyframe dia-

monds to new desired locations.

Figure 23.4 — Sound Info Window Cue List
596       EIAS Animator    



Chapter 23  Facial Animation — Morphs and Materials
To copy a morph “blend” into the function curve editor, select the morph 

targets that you would like to edit, and click on the Add Blend to Function 

Curve Editor button. The blend will now be presented as a linear curve in 

the editor.

The morph target channel is presented to the left of the window. Select the 

channel, and the curve changes to white in the editor. Double click on the 

channel, and you can change the curve to any supported type. You can use 

all of the tools available in the function curve editor to tweak or enhance 

your animation.

23.7 Morphs and Materials

When rendering morph models, only the material settings in the anchor 

model will be used. Material morphing is not supported. Therefore, you 

need to assign all shading attributes to the anchor model. The groups listed 

in the project window when you select by model are the groups for the 

anchor model — the groups for the target models are not presented in the 

list. 

You can still animate the materials used in the anchor model as expected. If 

you do not want to animate your materials, disable the animation flag on 

Figure 23.5 — Function Curve Editor with Morph Blend Curves
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the material and texture channels in the project window, under the appro-

priate group name. This will prevent unwanted artifacts from occurring.
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Deformations

24.0 Introduction to Deformations

Deformations allow you to bend, twist and otherwise distort groups in a 

variety of different ways. A basic tool for 3D character animation, deforma-

tions will enable you to impart “life” into a character, “bend steel with your 

bare hands” (apologies to the Superguy!), and so on. When used in con-

junction with morphing, all of these deformation tools provide everything 

you need to create fantastic character animation. 

In this chapter we'll discover just what a deformation is, how to use it, the 

differences between each deformation type offered in EIAS and some tips 

on their use.

What is a Deformation?

A deformation region allows you to squash, stretch, twist, bend, shear or 

wobble any group (including its children) in any manner you see fit. You 

can have one deformation action on a group, or you can have many. Any 

deformation is animateable, which means you can make that can of tomato 

soup do the Macarena if your heart desires. When you combine different 

animated deformations into one object, often times the flexibility offered is 

amazing.
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Deformations in EIAS

In EIAS, deformations are applied to groups through the use of regions. A 

deformation region is similar to a group’s cubic extent at first, but you can 

adjust the area of a region to suit your needs. You can assign as many defor-

mation regions as you like to a group. The reasons for doing so are up to 

you, and are typically done for either more precise control or data manage-

ment (too many deformations in a single region can sometimes get a little 

complex to follow.)

Actual deformations are assign to a specific region. You can have as many 

deformations as you like in a region, and they can be of any supported 

type. The effect that a deformation will have on a group is dependent upon 

both the order of the deformations in the region’s deformation list, and the 

order of the actual regions in the region list. In both cases, the lists are pro-

cessed top to bottom. You can think of this as a simple hierarchy.
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24.1 Using Deformations

The discussion below is based on deforming a simple “hot dog” model as 

seen in Figure 24.1. This model consists of an UberShape capsule with a 

pair of funny glasses linked to it. The project is called “HotDogD4M” and 

can be found on the EIAS Content CD.

Figure 24.1 — the Hot Dog object

To Apply a Deformation

1. Select the group, by either clicking on it in the world views or selecting 

its name in the Project window.

2. Open the Group Deformation Window. There are three ways you can do 

this:

• Select it from the Tools menu
• Click the small Deformations icon in the top row of the Project win-

dow.
• Click the Deformations icon in the Tool bar.
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The Group Deformation window opens:

Figure 24.2 — Deformation window for the Hot Dog group

Now we will take a look at this dialog and break down its individual parts:

• Deformation Control Section
• Region/Deformation Section
• Region Control Section
• Show Region Buttons
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Deformation Control Section

The deformation section consists of the type menu, the options button, the 

Angle/Amount/Strength edit box, Along Axis and Deform Axis check 

boxes. This section is where you choose and control the deformation.

 

Figure 24.3 — Deformation control section of the Deformation Window

Type

This pop-up menu contains all the different types of deformations available 

to you. This is where you select what kind of deformation you'd like to use. 

We'll discuss the different kinds of deformations later in the chapter.

Options

Clicking this button brings up options specific to the type of deformation 

selected. Each deformation type has different options available to it, so 

depending on what type of deformation you've chosen with the Type pop-

up, you will get a different dialog each time you select the Options button. 

We'll discuss the options for each type of deformation individually when 

we discuss each later in the chapter.
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Strength% (or Scale or Angle)

This is where you enter the amount of deformation to be applied to the 

group. To animate a deformation, you simply change the value in this box 

over time, by either directly entering a number or by adjusting it via the 

rocker buttons to the right of the window. Another way to change this 

value is by directly manipulating the deformation region in the World 

views by clicking and dragging on the selected group. You will see the 

group update in the world view windows as you drag. Just about any 

deformation available may be interactively set this way.

One thing to note about this box is that its label will change, depending 

upon which type of deformation you chose. For Twist, Shear and Bend, it 

will change to Angle; for Scale, Taper or Bulge deformations, it will read 

Percentage; and for Stretch and Bezier deformations it will read Strength.

Direction

These three radial buttons determine what axis or axes the deformation is 

calculated along. 

Deform 

These check boxes determine what direction the deformation will occur 

towards. These check boxes are dependent upon what axis you chose to 

deform along in the Along Axis setting.

Using a bend deformation on the Hot Dog as an example, let’s look at how 

these two settings work together.
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24.2 Deformation Examples

Deform X along Y 

If you choose to bend the hot dog along its Y axis (Direction setting is Y), 

you can deform the object on it’s X and/or Z axes. 

  

Figure 24.4 — Y direction deformation along the X axis

Keeping the direction along which the deformation takes place set to Y, a 

deform along the X axis will make the object bend to the left or to the right, 

depending on the value assigned to Angle. Looking at the front view win-

dow, positive X is to the right, and negative X is to the left. Because we have 

a bend angle of 45 degrees (positive,) the object bends to the right.
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Figure 24.5 — 45˚ X Axis Bend Along Y
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Deform Z along Y 

If you choose to deform only the Z axis, you'll see that when you bend your 

hot dog it will bow forward or arc its back.

Figure 24.6 — Y direction deformation along the Z axis

This is because the deformation is moving the polygons toward either the 

positive or negative Z along the Z axis. Because we have a negative value 

for our Angle, the Hot Dog will bend towards negative Z, which is to the 

left when looking at the side view window.
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Figure 24.7 — -45˚ Z Axis Bend Along Y
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Deform X and Z along Y 

If you choose to deform in both X and Z axes (both check boxes selected,) 

then the hot dog will appear to bend in all directions, like forward to the 

right, backward to the left, etc. 

Figure 24.8 — Y direction deformation along the X and Z axes

The illustration entitled “-45˚ X and Z Axis Bend Along Y” show the Hot 

Dog bending to the forward left. This is because our X deformation is caus-

ing it to bend to the left along the positive X axis, and our Z deformation is 

causing it to bend forward along the negative Z axis.
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Figure 24.9 — -45˚ X and Z Axis Bend Along Y

Show Regions

As mentioned previously, regions are the extents within which actual 

deformations are applied to the group. 

Figure 24.10 — The Show Regions check boxes

Show All Regions

By checking the All Regions box you can show every region not currently 

selected in the Region list (located in the upper right of the Group Defor-

mation Window) as a cyan colored line. The difference with this cyan line 

vs. the faded purple line of the Ghost Region is that the cyan line of All 
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Regions actually deforms the extent box of the region to show just how 

much that region has deformed.

Comparing the Ghost region to All Regions gives you an idea of how com-

plex things are, and is a good way of finding problems and solving them. If 

you have 3 or 4 deformations and want to know how deformed any of the 

other regions are, simply check the All Regions box and every deformation 

region will show up as a cyan line, with any deformation effects applied to 

the cyan extents box. This is also extremely helpful when you have differ-

ent regions in different parts of a group and don't want your regions to 

overlap. By checking All Regions you can be sure that your new regions 

don't overlap and accidentally interfere with any previously placed 

regions.

Ghost Regions are shown as a faded purple box delineating the original 

extents of the deformation region. No matter how much you deform an 

object, the Ghost Region will always retain the original shape of the defor-

mation region to show you the original position of the region.

Compute Normal for Display

This option causes the deformation engine to compute accurate normals for 

display in the World View windows. The overall effect is an improvement 

in the drawing quality. The cost is a performance penalty of three to one.
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Compute Deformation while dragging

This option causes the deformation engine to calculate while you are drag-

ging object in the scene. In highly complex scenes, you may wish to disable 

this feature to improve drawing performance and interactivity.

Region/Deformation Section

This section contains tools and lists for creating and managing regions and 

deformations. As mentioned previously, deformations are contained within 

a region that is assigned to a group. You can have as many regions as you 

like, and as many deformations within a region as you like.

Figure 24.11 — The Region/Deformation lists of the Deformation Window

This section covers the following items:

• Region List
• Deformation List
• The Del Buttons
• The Add Buttons
• The Enable Buttons

Enable Button Enable Button
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The Region List

This is the area in which all your deformation regions are listed. They are 

order dependent, processing from top to bottom. You may drag any region 

up or down in this list to change the sequence in which a deformation is 

applied. It is sometimes necessary to adjust the order of regions (and/or 

their deformations) for very complex multi-deformation effects.

The Deformation List

This section lists all the different deformation types associated with a par-

ticular Region. You may change this setting via the Type pop-up menu. The 

currently selected deformation type for TheBend is Bend.

To Change the Deformation Type

Click on the Type pull-down menu (in the Deformation control section) 

and change the deformation type from Bend to Scale.

Figure 24.12 — The Deformation Type popup menu

Notice that the Deformation list has updated to show that you have 

changed the deformation type to Scale. You'll also note that the Angle box 

has changed its name to Scale%, which is the animateable value for a scale 

deformation.
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Figure 24.13 — The Deformation window with the region set to Scale

The Del Button

You can delete a region or deformation by highlighting it and pressing the 

Del button. Once something is deleted in this fashion, the information 

applied to the disposed region is lost. Immediately invoking the Undo 

command will restore the region/deformation and its information.

The New Buttons

Under both the Region list and the Deformation list you will see a button 

labelled New. Clicking this button will create a new region or deform, 

depending on which button is clicked. All new regions are created with 

Bulge deformations by default.
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The Enable Buttons

The small blue buttons to the left of the Region and Deformation names can 

be used to turn off individual Regions or Deformations. This feature can be 

very useful as you build up complex deforms. Often it is easier to layer in a 

new deform with the existing deforms disabled.

To Rename a Region or Deformation

Regions or Deformations can be easily renamed. Both are renamed in 

exactly the same manner. To illustrate this we will now rename “Region 1” 

to something else.

1. Double-click on “Region 1” in the Region list box.

2. Type in “Hot Dog Bend” as a new name for the region.

The Deform Region is now renamed.
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To Add a Region or Deformation

1. Click the New button under the Region list and name the new region 

Twister.

Figure 24.14 — The Twister group is created

Note that the default deformation type for the new Region is Bulge. Since 

we already have a Bend, let's make this a Twist deformation. 

2. Make sure that the Twister region is highlighted in the Region list. 

Change the deformation region to Twist
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The Region Section

This section gives you precise numerical control over regions, and the 

space that they occupy. You can use the edit boxes to adjust the area of the 

region, or to limit the effectiveness of a region.

Figure 24.15 — The Region section of the Deformation window

The Region Section contains four separate items, each containing a space 

for X, Y, and Z values:

• Position
• Rotation
• Minimum
• Maximum
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Position

These edit boxes allow you to set the position of the deformation region rel-

ative to the group it is applied to. This setting may be adjusted by any of 

three methods:

• Direct entering of numeric values
• Direct manipulation in the world view windows

Figure 24.16 — The Position edit boxes

This setting is animateable over time. Each of the three coordinates is avail-

able, so the deformation region may be anywhere in world space. The 

default 0,0,0 positions the deformation region at the center point of the 

group it is applied to. All measurements are in world units, and are mea-

sured from the center point of the group being deformed.
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Animating the Position of a Deformation Region

The ability to animate the position of the region is useful if you need a 

deformation to shift from one part of the group to another. Lets make our 

hot dog pass through a “distortion field.”

1. In the Region list, select the Twister region. In the Y Position box, type in 

a value of -10 (please note that the capsule created for this demonstration 

was 9 units long).

The Twist deformation has now shifted directly below the Hot Dog group.

 

Figure 24.17 — The Twister region directly below the Hot Dog

2. Now we will create our “Distortion Field. Give the Twist deformation an 

angle of 90˚ along the Y axis. This will give the Twister region a 90˚ twist 

along the Y axis. 
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Keep an eye on the Hot Dog as you make your change. While there is no 

change in the shape of the Hot Dog itself, notice that it has turned to its left. 

Figure 24.18 — The Twister region at 90˚, with the Hot Dog turned to the left

3. In the areas titled Minimum and Maximum, click and activate the check 

boxes next to the Y value. The Hot Dog group is now oriented correctly. 

(Why this worked will be explained in detail later in the chapter.) 

 

Figure 24.19 — The Region section with the Y values checked
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Your Side View window should look like the following:

Figure 24.20 — The correct Side view window

4. Open your Project window, and move the time thumb to 1 second.

5. In the Deformation window, enter a value of 10 into the Y Position field 

for the Twister region. A keyframe is created in the Project window for the 

Hot Dog group.

The region is now directly above the Hot Dog group.
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Figure 24.21 — The deform region above the Hot Dog Group

6. Again, it looks like nothing has happened to the Hot Dog. To see the 

effect of the steps we just performed, click the preview icon in the bottom 

left of the Camera View window to preview the animation.
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Figure 24.22 — The group is deformed as the region passes through it

As the deformation region changes it's position up the Y axis it applies its 

deformation to the Hot Dog group.

Rotation

Figure 24.23 — The Rotation boxes
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The Rotation section enables you to set the rotation value of a deformation 

region relative to the group to which it is applied to. This setting may be 

adjusted by any of three methods:

• Direct entering of numeric values
• Direct manipulation in the world view windows

Like Position, this setting is animateable over time. Each of the three rota-

tion axes is available, so the deformation region may be rotated at any 

angle. All rotations are measured in degrees. Rotating the group to which a 

deformation region is applied does not affect these rotation values; they are 

only affected by direct rotation of the region itself.

Animating a Region’s Rotation

The following exercise will show you how to animate the rotation values of 

a deformation region:

• Clear Rotation Values to 0.0
• Deform the X axis of TheBend along the Y axis using a value of 45˚
• Move the time thumb in the Project Window to 1 second
• In the Deformation Window, and enter the value 360 in the Y Rotation 

field. 
• Preview your animation

Watch the Bend deformation rotate over time to produce a twirling effect, 

making our Hot Dog look like he’s doing stretching exercises. 
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Figure 24.24 — The Hot Dog is animated

Rotation of regions also comes in handy when you want to bend an object 

in one direction, but when you apply the deformation it’s bending from the 

other direction.

Let’s say you wanted to bend our hot dog so that his bottom end moved 

instead of his top end, making him look like he’s kicking instead of bow-

ing. The following steps will demonstrate this technique to you:

• Clear Rotation Values to 0.0
• Rotate TheBend deformation region 180 degrees on the Z or X axis at 

time 0 (essentially flipping it upside-down)
• Deform the X axis of TheBend along the Y axis using a value of 45˚ (as 

before)
• Preview your animation
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Figure 24.25 — The deformation region rotated 180˚ on the X axis

The deformation is now applied to the opposite end of the group. The bot-

tom of the Hot Dog now flips around in a circle, like it’s dancing.

Minimum & Maximum

Each region can have a limited range of effectiveness. The edit boxes in this 

section (along with their associated check boxes) will enable this control.

Figure 24.26 — The Minimum and Maximum boxes
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The Minimum and Maximum boxes are for setting the size of the deforma-

tion region relative to the group they are applied to. The numbers that ini-

tially appear in these fields represent the extents size of the group the 

region is applied to. These setting may be adjusted by the following meth-

ods:

• Direct entering of numeric values
• By the up and down buttons located next to each value.

If you like, refer back to the exercise on Animating the Position of a Defor-

mation Region. Remember when we put the 90˚ rotation on the deform 

region and the Hot Dog group rotated 90˚ to the left, even though it wasn’t 

actually within the deform region? When we enabled the check-boxes next 

to the Y Minimum and Y Maximum fields, we limited the effect that the 

Deformation Region had on the geometry to the values contained in the 

check-boxes. In this instance, these values represented the Y extents of the 

Hot Dog group. As such, the deformation did not take place until the 

deform region actually entered the space occupied by the extents of the 

group.
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Adjusting the Minimum and Maximum

The following exercise will demonstrate further the use of the Minimum 

and Maximum values.

• Activate the ghost region
• Set all region position and rotation values to 0.0
• Deform TheBend with an X axis Angle value of 0˚, along Y.
• Enter the value -1.4 in all the Minimum boxes and 1.9 in all the Maxi-

mum boxes

The region box changes size to reflect the new values entered.

Figure 24.27 — Before and After the Minimum and Maximum values are 
applied
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Bend the group to see the effects of limiting the effective range of the 

region:

• Select Bend in The Bend Region
• Enter an Angle value of 90˚

             

Figure 24.28 — The 90˚bend with the full region and the newly defined region

See how the Hot Dog now has a tighter bend with a smaller arc? Before we 

were calculating the bend along the whole length of the hot dog; now the 

bend only occurs within the area defined by the region.

Let’s change the height of the Region along the Y axis:

• Increase the Y Maximum to 10

 The deformation itself is still 90, but the range of the bend is expanding 

along the Y axis as the region itself expands along the Y axis.
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Figure 24.29 — The 90˚bend expands as the Y deform area increases

Let’s see what happens when we reset the limits on the region:

• Set your Y Maximum back to 1.9
• Enable the check boxes next to Y Minimum and Y Maximum.

Figure 24.30 — The 90˚bend with Y Minimum and Maximum off and on
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The hot dog is standing straight up except that the area directly within the 

bend region is all bent out of shape. What the check boxes did was tell the 

program not to include any polygons outside of the box to receive the 

effects of the bend.   While this doesn’t look so great in this example, you 

can easily see the difference that the Minimum and Maximum check-boxes 

make.

This feature is very useful if you need to have something deform in only in 

one part of a group while not affecting anything else in the group. This is 

extremely helpful for keeping different deformation regions from interfer-

ing with each other.

24.3 Types of Deformations

There are 14 different types of deformations in Animator. They are:

• Scale
• Shear
• Twist
• Taper
• Bend
• Bulge
• Linear Wave
• Circular Wave
• Stretch
• Bezier
• Bezier II
• Bones
• Circular Wave II
• Runwave
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Below you will find a description of each type of deformation and an exam-

ple illustrating its use. To duplicate these examples make your Deform 

Window settings the same as those provided in the example, creating and 

deleting Deformation Regions as necessary.

Scale

This type of deformation affects the scale of the group. The amount of scal-

ing applied is measure in percentage. You do not need to determine what 

axis the deform is along in the Along Axis area since Scale affects all axes 

selected in the Deform Axis check boxes. To designate the axis or axes 

along which the Scale will occur, click the appropriate check box in the 

Deform Axis area.

There are no options available for the Scale deformation type.

Below is an example of a scale deformation applied to the X and Z axes of 

the hot dog and limited with the Minimum and Maximum settings.
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Figure 24.31 — The Scale deformation 

Shear

This deformation will Shear (or offset) a group along an the axis defined in 

the Deform Axis check boxes. You may choose to shear a group along any 

axis by selecting that axis in the Along Axis area. 

Shearing can best be described as slanting an object in a particular direc-

tion. This slanting is more defined and uniform than the Bend deformation, 

resulting in a harsher effect than bending gives.

There are no options for the Shear deformation that can be accessed via the 

Options button.

Here is an example of a Shear deformation applied to the Hot Dog.
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Figure 24.32 — The Shear deformation set to 30˚

Twist

The Twist deformation allows, as its name would suggest, for the twisting 

of a group. Twisting can best be defined as rotation along a defined axis 

where one end of the deformation region rotates clockwise and the oppo-

site end rotates counterclockwise. The amount of deformation is deter-

mined by the degree value in the Angle box.

There are no option available for twist deformations.

Twists are generally set up to affect both axes that are not used to calculate 

the deformation. For example, if you calculate a twist along the Y axis, it 

can be used to deform either the X, the Z or both the X & Z axes. Experi-

ment with setting Deform Axis to either one or the other remaining axes of 

a deformation to see the varying possible results. 
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Note: Since our Hot Dog group is essentially a long, skinny, Y-oriented 

object, we will use another object to better illustrate the Twist deformation. 

Simply turn off visibility for the Hot Dog group and enable visibility for the 

Box group.

Figure 24.33 — The Twist deformation

Taper

The Taper deformation allows a group to be tapered. Tapering can be 

described as reducing or increasing the dimensions of an object on one end 

of the deformation region. This dimension change can occur along one or 

two axes. The amount of tapering is determined by the value in the Per-

centage field.
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If the value in the Percentage field is -100%, the group will Taper to a flat 

edge along whichever Deform Axis is not selected. The group will taper to 

a point if the Deform Axis check boxes indicate that two axes are selected.

Figure 24.34 — -100% X axis Taper deformation
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Figure 24.35 — -100% X and Y axis Taper deformation

If the value in the Percentage field is 100%, the group will double in size on 

the end of the deformation region effected.

Figure 24.36 — 100% X and Y axis Taper deformation

Taper Options

The Taper deformation has a Fillet Taper option, which is accessible 

through the Options button in the Group Deformation window. The Fillet 

Taper option may be applied to either the beginning, the end or both ends 

of the region.
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Figure 24.37 — The Taper options window

Filleting a taper causes a smooth transition between the taper deformation 

and the unaffected polygons. This can be seen if the deformation region is 

reduced to be smaller than the size of the group as a whole. Without Fillet 

Taper enabled, the edges of the deformation region (where the deformation 

begins to effect the group,) will appear to have hard, clean edge. With Fillet 

Taper enabled this edge is rounded and has a softer transition from the area 

not deformed into the area being deformed.

Figure 24.38 — Front view of a Taper with no Fillet options selected
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Note the hard edges at the boundaries of the taper region. If this is objec-

tionable, activating the “At Beginning” option can remedy this.

Figure 24.39 — Front view of a Taper with beginning Fillet options selected 

At Beginning causes the deformation to be blended into the surrounding 

polygons, changing the shape dramatically.

Figure 24.40 — Front view of a Taper with beginning and ending Fillet options 
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With both the At Beginning and At End options selected, we see a smooth 

transition into the deformation at both ends.

Bend

The bend deformation is used to bend a group. The bend occurs along the 

axis set in the Along Axis check boxes and deforms in the direction as 

determined in the Deform Axis check boxes. The deformation amount cor-

responds with the value in the Angle field.

The bend deformation has a Bend from Center option available via the 

Options button.

 

Figure 24.41 — The Bend Options dialog

Selecting this option changes the center radii of the bend arc from the edge 

of the deformation group and places it at the midpoint of the deformation 

region.

If you apply the Bend from Center option to a Y axis bend deformation, 

both ends of the hot dog will bend away from center, rather than having 

one end “locked down” while the other bends away.
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Front View of a 90 degree Bend deformation with Bend from Center dis-

abled.

Note how only one end bends away from the group’s center line...

 

Figure 24.42 — Bend from Center Disabled (default setting)

Front View of a 90 degree Bend deformation with Bend from Center 

enabled. Note how both ends bend away from the group’s center line...
EIAS Animator        641



Chapter 24  Deformations — Bulge
 

Figure 24.43 — Bend from Center Enabled

If a Bend deformation is used in tandem with other types of deformations, 

and these different deformation regions overlap, it is best to place the bend 

deformation region last in the Region list, so as to apply the Bend deforma-

tion to the other deformations in the list. this will help to avoid some 

unwanted or unpredictable results that may occur if vertices that are to be 

deformed by another region if they are bent first.

Bulge

The bulge deformation allows a group to have it’s dimensions increased or 

decreased on two axes from the center of the Bulge deformation region. 

The amount of dimension deformation is correspondent to the Bulge% 

value. A positive Bulge% value will expand the groups dimensions away 

from the center of the bulge region, whereas a negative Bulge% value will 
642       EIAS Animator    



Chapter 24  Deformations — Bulge
draw the dimensions of the group inward toward the center of the bulge 

region.

If you set the Bulge% value to 75, our hot dog will look like a fat knock-

wurst. If you set the Bulge% value to -75, the hot dog will look more like a 

smoothly rounded hourglass. Bulge deformation with a Bulge% value of 

75. Notice how the vertices are “pushed out” from the center of the region.

 

Figure 24.44 — Bulge Out 75%

Bulge deformation with a Bulge% value of -75. See how the vertices are 

“pulled in” toward the center of the region.
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Figure 24.45 — Bulge in, -75%

The bulge deformation has a Filleted Bulge option available via the 

Options button. Similar to the Fillet Taper, the Filleted Bulge allows the 

edges of the deformation region to be made rounded, rather than the 

default hard edge when this option is disabled. Unlike the Fillet Taper, 

however, the Filleted Bulge has no setting for filleting the beginning or end 

of the region. this is because the Bulge deformation has no beginning nor 

end, but effects the group from the center of the region.

 

Figure 24.46 — Bulge Option Dialog
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A Bulge region with Filleted Bulge option enabled. Note how the deforma-

tion eases in and is rounded.

Figure 24.47 — Filleted Bulge Option Enabled

Linear Wave

The Linear Wave deformation deforms the vertices of the group along a 

sine wave that passes along the axis delineated in the Along Axis radial 

button settings. The crest and trough of the Linear Wave are deformed in 

the direction delineated in the Deform Axis check boxes. The degree of 

deformation corresponds to the setting in the Amplitude field. The higher 

the Amplitude, the more “wavy” the deformation. The lower the Ampli-

tude, the less “wavy” the deformation. The Amplitude is a measurement of 

world units. If the Amplitude value is set to 1, then the linear wave crest 

deformation will offset the centerline of the Along Axis by 1 unit in the 
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direction of the Deform Axis setting. The example below is of a Linear 

Wave deformation calculated along the Y axis and deforming the X axis, to 

an amplitude value of 1. Note how the center point of the along axis (in this 

case, the Y axis) is offset by 1 unit, as shown in the ruler ticks.

Figure 24.48 — Linear Wave Deformation

If you’re having difficulty understanding the Linear Wave, think of an 

ocean. The waves of an ocean are traveling along an axis. If the ocean is like 

any other body of water, the waves travel in a horizontal direction. This 

would mean they are Along the X axis (the horizontal axis). Now, the high 

part of an ocean wave is called it’s crest. The low part of a wave is called it’s 

trough. The waves of an ocean go up and down as they travel horizontally. 

This would mean that the ocean waves are deforming the water’s Y axis 

(hence the up and down of the wave). If the waves of an ocean traveled 

horizontally (along the X axis) but deformed side to side (deforming the Z 

axis instead of the Y axis,) then the waves of the ocean would wiggle like a 
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snake instead of going up and down. If you want higher wave crests and 

lower wave troughs, you need to increase the Amplitude. 

The Linear Wave deformation has a Phase and a sin curve selector option 

available via the Options button. To choose a simple sine wave, select the 

radial button next to Sin. This is the default. To select a Cosine wave, select 

the radial button next to the 1- Cos. A cosine wave will have two crests to 

the sine wave’s one. 

The Phase option allows you to choose where along the sine wave you 

wish the deformation to start. Every sine wave has a phase value. The 

default value for the beginning of a wave is 0. As you travel along the 

length of the wave, the phase value increases or decreases, depending on 

the direction you travel. If you travel along a sine wave to the right, the 

phase value increases. If you travel along a sine wave to the left, the phase 

value decreases. Phase is the measurement of where you are along the 

length of the wave. If you need your Linear Wave deformation to begin it’s 

deformation at some point other than the 0 point of the wave, you can 

change the value in the Phase field of the Options dialog. The line drawing 

of the curve will update to reflect the value you have entered. Look at the 

examples below to see the differences that can be achieved via a change in 

the Phase value. Note the curve feedback in the Options dialog, and how 

that variance affects the group deformation. This area is one where explora-

tion and experimentation is best tried.
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Figure 24.49 — Linear Wave Option Dialog

Figure 24.50 — Phase set to 75

By animating the Phase value over time you can achieve interesting results, 

and with some work can animate convincing seaweed flowing in ocean 

currents, by adjusting nothing more than the Phase value over time.
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If you want more than the 2 waves given by the sin or cosine wave, you can 

adjust the Waves field value in the Options dialog to suit your tastes.

Circular Wave

This deformation type allows you to create waves or ripples similar to 

those found when a stone is thrown into a pond. The waves move outward 

from the center of the region in a circular pattern. The amplitude (e.g.: crest 

and trough) of the wave move along the Deform Axis, as set in the Deform 

Axis check boxes. The height of the wave, or intensity of amplitude, are 

determined by the actual height of the circular wave deformation region in 

the axis determined as the Along Axis. Below is an example of how the 

region height affects the wave height...

Figure 24.51 — Wave Height is Dependent upon Height of Deformation Region
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Figure 24.52 — Camera View with same settings as previous figure

In other words, if your Deform Axis is X, the waves will move outward 

horizontally. If the Deform Axis is set to Z, the same will occur, since these 

waves are circular and move in all directions on these two axes. If your 

Along Axis is Y, the waves will act like ocean waves/pond ripples and will 

have the appearance of having height. To adjust this height, adjust the 

actual height of the deformation region. 

 Here is a close up of the deformation region. Note the relation between 

wave height and the height of the deformation region.... 
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Figure 24.53 — Close-up of Circular Wave Region

To determine how much of the group is influenced by the circular wave’s 

deformation region, you may change the value in the Outer Radius field. 

The Outer Radius is a measurement of percentage of coverage. A setting of 

100 will allow 100% of the region to influence the group. A setting of 50 will 

only allow half of the region to influence the groups deformation. This set-

ting may be animateable over time to produce a rippling effect. An object 

may start with an Outer Radius of 0, which will not allow any of the region 

to deform the group. By setting the Outer Radius to 100 at a later time, the 

impression of a stone being thrown into a still pond may be achieved, with 

expanding concentric waves resulting. 

The circular wave deformation has a number of Rings option available via 

the Options button. To increase the number of waves, simply change the 

value in this dialog. This value may be animated over time to produce 

expanding rings effects. 
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Figure 24.54 — Circular Wave Options Dialog

You may also combine several Circular Wave deformation regions to 

achieve even more interesting wave effects. For the random wave pattern 

found in a pool on a breezy day, you may add a number of regions of vary-

ing size, outer diameter and wave height settings. Also, rain drops falling 

onto a puddle may be achieved by adding many smaller regions to the 

puddle group, and animating the regions outer diameter, as well as it’s 

wave height to give the impression of small, short rippling effects common 

to rain drops. Combined with proper water material properties, this effect 

can be stunning. Here is an example of how combining several Circular 

Wave deformation groups can be applied...
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Figure 24.55 — Multiple Circular Wave Deforms

Stretch

The stretch deformation allows you to grab a region of vertices and pull, 

move, rotate or scale them in any direction while remaining attached to the 

remaining unselected vertices of the group outside of the stretch region. 

The Stretch deformation is best used when the deformation region is 

smaller than the entire group. If the entire group lies within the region of 

the Stretch deformation, nothing will appear to happen when the Stretch 

region is moved, rotated, etc. except that the whole group moves. To grab 

this section of vertices, you must “capture” them. To capture the vertices 

for deformation, you must access the Capture Vertexes button via the 

Options button. When your region of desired deformation is set, you must 

click the Capture Vertexes button to enable deforming the object. 
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Think of your group as a piece of taffy. Now, holding this taffy in your 

hand, grab one end of it with your fingers. Now, pull that section away 

from the rest of the taffy glob. It remains attached, but deformed. It is 

stretched. This is basically how the stretch deformation works. You define 

how much “taffy” (e.g.: vertices) your grab by the size of the deformation 

region. You close your fingers around the taffy you wish to pull by captur-

ing the vertices (e.g.: Capture Vertexes) and you pull by moving the defor-

mation region with your mouse, or by entering values in the position or 

rotation fields.

The best way to understand the Stretch deformation is to see it in action. 

Follow this example:

• Add a new region to the list
• Choose the Stretch Deformation type
• Activate the Ghost Region
• Adjust the deformation region at the bottom of the group only
• Choose the Options button
• Select the Capture Vertexes button (this tells the computer that you 

ware ready to start pulling this group into or out of shape.)
• Grab the region with your mouse and pull it as you see fit. 

You may also rotate the region via the Rotation values for the region as 

found in the Group Deformation window
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Figure 24.56 — Stretch Deformation

If the stretching seems too harsh or edgy, you may adjust the Blend Factor 

in the Options dialog. Increasing the Blend Factor reduces the harshness of 

the stretching. A higher Blend Factor will allow the stretch region to affect a 

wider area of vertices outside of the actual stretch deformation region. 

 

Stretch with Blend Factor at 5
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You may limit the stretching to affect only vertices along the X, Y or Z axes. 

This means that if you only enable the X axis, that no matter how hard you 

try to move the region on the Y axis, the region will not be allowed to move 

in that direction until you enable the Y axis in the Deform Axis check boxes. 

You’ll also note that the Along Axis radial buttons are disabled. This is 

because the Stretch deformation doesn’t calculate along an axis, but is 

determined by the size of the region of captured vertices, as well as the 

Blend Factor, regardless of axis. You may also pre-define your stretch 

region’s position and animate it’s Strength% over time to slowly deform 

your group without having to set keyframes for the position or rotation of 

the stretch region. Only adjust the Strength% over time. The result is simi-

lar to that of a magnet pulling the vertices out of shape over time.

Bezier 

One of the most powerful tools for character animation within Animator is 

the Bezier deformation. A Bezier deformation allows for a very fluid defor-

mation of the group by it’s Along Axis and in the direction as determined 

by the Deform Axis check boxes. The main controls for the bezier deforma-

tion are its control arms and anchor points. The control arms behave in a 

manner very similar to bones, but have some pronounced differences from 

bones. Think of the control arms as puppeteering rods built inside of the 

group. By moving the puppeteering rods, you change the shape of the 

group. The control arms appear as indigo colored lines that run along the 

length of the Bezier region as defined in the Along Axis radial buttons. The 

control arms may be animated to produce the effect of bending, twisting, 

stretching, squashing and arcing the group as influenced by the control 

arm. The deformation occurs along the axis that the control arms are paral-
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lel to. To define which axis the control arms are parallel to, set this axis in 

the Along Axis radial buttons. 

 

Figure 24.57 — Along Axis set to Y

 

Figure 24.58 — Along Axis set to the X
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Figure 24.59 — Along Axis set to the Z

Each control arm has three controlling points on it. The Anchor point, the 

Control point and the Spin point. All three points may be animated sepa-

rately by grabbing them and moving them with the mouse, or they may be 

moved as a group by grabbing the control arm itself and moving it. Grab-

bing the control arm itself and moving the Anchor, Control and Spin points 

all at once produces a result similar to that of the Stretch deformation.

The Anchor point is the black dot at the base of a control arm that is closest 

to the center of the deformation region. This is the center of rotation for the 

entire control arm. When the control arm is moved, it seems to pivot and 

rotate around this point.

The Control point is the black dot at the very end of the control arm and is 

located at the boundary of the Bezier region. To move the control arm but 

not affect the Anchor point, grab and move the Control point. This will 

deform the vertices as influenced within the region. 
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The Spin point is the point attached to a small spur control arm that 

emerges from the Control point and is perpendicular to the Control arm. 

The Spin point allows you to spin the top of the Bezier region for twisting 

the group. The center of rotation for the Spin point is the Control point, 

where the center of rotation for the Control point is the Anchor point. The 

Anchor point has no center of rotation and cannot be rotated. The Anchor 

point may be moved. Moving the Anchor point effects the rest of the con-

trol arm’s effects of deformation. 

 

Figure 24.60 — Moving the Control Point

Moving the Control point only causes the group to deform along the curve 

produced between the two points. (Note that the curve is not actually 

drawn.) You can drag the control point to any position, as with any bezier 

spline.
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Figure 24.61 — Moving the Anchor Point

Moving the Anchor point is equivalent to changing the endpoints of the 

bezier spline. This is useful for making a character lead or “telegraph” the 

intended direction of travel (or perhaps for making a great Axl Rose imper-

sonation!)
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Figure 24.62 — Moving the Spin Point

Moving the spin point will twist the group along the spline direction, with 

the majority of the twist occurring at the location of the spin point.

Figure 24.63 — Spin Rotation from the Side

The figure above shows the spin from another direction. Again, notice how 

the twist effect is more pronounced around the spin control point.
EIAS Animator        661



Chapter 24  Deformations — Bezier
 

Figure 24.64 — Dragging the Control Arm

You can also just drag the entire control arm, which will offset the end-

point, keeping the trajectory of the control arm intact. In the example 

above, the shape is starting to deform back to it’s original orientation.
662       EIAS Animator    



Chapter 24  Deformations — Bezier
Figure 24.65 — Bending and Twisting a Bezier

Bezier deformations, used in tandem with each other, can produce power-

fully flexible deformations. One can animate the fingers of a hand with a 

combination of Bezier deformation regions. One important tip to keep in 

mind when combining more than one Bezier region on a group is to limit 

the influence of the region’s deformation. This is done via the check boxes 

next to the Maximum and Minimum fields in the lower right of the Group 

Deformation window.

Figure 24.66 — Limited Bezier Region and it’s effects

Like any deformation, you can have multiple bezier deformations on a 

group. When doing so, it is best to assign a new region, so you can change 

the focus area of the bezier effect, as shown in the illustration, “Limited 

Bezier Region and it’s effects” on page 663.
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The hot dog has two bezier regions on it. You’ll note that when the lower-

most Control point of the upper region is moved, it moves the whole bot-

tom of the group. This may or may not be desirable.

You can limit the influence of that region by checking it’s Y Minimum limit 

box, and thus limit the influence of this region to only those vertices with a 

Y position value greater than the Minimum Y as set in the field.

Figure 24.67 — Limited Region Bezier Deformations

Now the lower bezier region’s upper Control point is moved. Note the very 

unpleasant deformation results (illustration on page 665). This looks pretty 

ugly. That’s because the upper deformation region has already had it’s 

deforming effects applied. By deforming the lower region, we magnify, or 

multiply in combination that effect, so that what we see is the result of the 

two regions affecting the same vertices twice.
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Figure 24.68 — Problem associated with limiting Y Minimum

This can be corrected by limiting this region’s Y Maximum influence. Do 

this by checking the check box next to the Y Maximum field in the Group 

Deformation window.

Observe how the deformations Maximum Y influence is constrained to 

those vertices within the actual Bezier region itself in the following illustra-

tion. The undesirable kink can be removed by insuring the regions are close 

but not overlapping. 
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Figure 24.69 — Not Perfect, but Getting There (Min and Max limited)

If you need to have greater control over the location of your Anchor, Con-

trol or Spin points, you may obtain their location, relative to the group’s 

object space, by clicking the Options button. In the dialog you will see 

fields for entering numeric values to adjust the positions of these points. 

This dialog is especially helpful for duplicating point positions. If you need 

to return an Anchor, Control or Spin point to a previously keyframed posi-

tion, you can obtain that location information in this Options window for 

later reference. Also in the Options dialog you will note a Reset Points but-

ton. Clicking this button will reset all the Anchor, Control and Spin points 

to their default position relative to the deformation region. This is helpful if 

your deformation gets out of hand or you need to return to the default 

position after animating a deformation.
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Figure 24.70 — Bezier Options Dialog

Also within the Options dialog you will see a check box marked Curve 

Continuity. This is useful for overriding the default results of the Bezier 

deformation. By default, when a group is deformed using a Bezier defor-

mation, pinching is minimized. However, you may have undesired results 

because the continuity, or the continuing, of the curve of the group’s verti-

ces as they cross the bezier region boundaries may not be smooth. 

The illustration “Bezier example without continuity applied”is an indica-

tion that the Curve Continuity option for a Bezier region is necessary. 

The hot dog is not maintaining it’s volume as it deforms, violating one of 

the primary laws of squash and stretch, a common cartoon technique. To 

remedy this, activate the Curve Continuity option in the dialog.
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Figure 24.71 — Bezier example without continuity applied

Similar to the Stretch deformation, you may preset the amount of bezier 

deformation and simply animate it’s Strength% over time to give a very 

complex magnet effect.

Bezier II

Bezier II behaves in every way similar to the Bezier deformation, but 

allows greater flexibility in the ability to add extra control arms on the inte-

rior of the deformation region. Up to four control arms may be had with a 

Bezier II deformation type. The Bezier II deformation deforms exactly the 

way a Bezier deformation does relative to the Deform Axis and Along Axis 

settings. 
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In the following illustration, note how the control arms are arranged within 

the boundaries of the Bezier II region.

Figure 24.72 — Bezier II default condition

To determine the number of control arms a Bezier II deformation may have, 

you must access the control arm dialog via the Options button. You may 

also turn off the visibility of the Anchor, Control and Spin points of each of 

the control arms. In the Options dialog you may also select what type of 

curve you wish to use. By clicking the left curve type, it is similar to select-

ing a non-continuous curve. By selecting the right curve type it is similar to 

selecting a Continuous curve in bezier deformations. The text below the 

curve types will update to give information about the choice of curve you 

have made. Also, the Bezier II Options dialog has a Reset Curve button. 

This behaves in a similar way to the Reset Points button in the Bezier defor-

mation options dialog. This will set all the Anchor, Control & Spin points 

for all control arms to their default position.
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Figure 24.73 — Bezier II Options Dialog

Like the Bezier deformation you may move any or all of the Anchor, Con-

trol or Spin points of each control arm. Again, either by individually select-

ing and moving each point or by grabbing the control arm as a whole. Since 

we covered how the end control arms work within the section discussing 

the Bezier deformation, let us take a closer look at the interior control arms 

of the Bezier II deformation.

The interior control arms acts more as “rockers”, while the end most con-

trol arms behave like puppeteering rods similar to the way they behave in 

the Bezier deformation type. The interior control arms each have two Con-

trol points to their one Anchor point. This allows them to “rock” back and 

forth, with their center of rotation being the center Anchor point of the con-

trol arm.

Note in this illustration how this combination of “rocking” the interior con-

trol arms can produce a complex “wavy effect.”
670       EIAS Animator    



Chapter 24  Deformations — Bezier II
Figure 24.74 — Tilted Control Arms

In the following illustration, observe how you can move the Anchor and 

Control points for each interior control arm by dragging the Anchor points. 

The relation of the Control and Anchor points to one another remains the 

same, however the relation of the interior control arms to the group 

changes. This technique is very powerful for complex muscle movements 

and internal shape distortions commonly found in character animation.
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Figure 24.75 — Offset Control Arms

By combining moving the Anchor points and adjusting the Control points 

for each interior control arm, you can achieve very complex deformation 

effects.

Figure 24.76 — Hoo, Baby, I Like it Like That!
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Again, as with regular Bezier deformations, you may use a series of Bezier 

II deformations in tandem on a single group to achieve even more complex 

deformations. Remember to use the limit influence check boxes next to the 

Minimum and Maximum fields to keep these multiple regions under con-

trol. However, there comes a point of diminishing control with multiple 

Bezier II deformation regions.

Example of a multiple Bezier II deformation region combo. The more you 

add, the more difficult it becomes to get predictable results using Bezier II 

deformations.

Figure 24.77 — Now things are getting a little out of hand
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Bones

Bones are used to perform “free-form” deformations, with fewer limita-

tions than the other deformation types. Bones can be linked together to 

form a deformation chain, imparting an incredible amount of control over a 

group. With bones, you can deform “single skin” objects such as characters 

or animals as if there were being moved by their own skeletal system (in 

fact, they are!) You can even use bones to create “morph targets” for facial 

expression morphing. In all, bones are quite handy.

Bones can also be a bit picky. Bones act like little magnets, pushing and 

pulling on groups, sometimes destroying them if used with wild abandon. 

Deforming a group with bones almost always means there will be more 

than one bone parented to a group. That means that they will compete with 

each other, unless you limit their ranges of influence.

Prepping

the Model
Like any other deformation, bones require a model that is properly meshed 

in order to provide the best results. You can use the Dicer plug-in to mesh 

the model if necessary.

Figure 24.78 — Low Resolution and high Resolution Models with Bones
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The Dicer plug-in will regenerate the model quite often. Since it is unlikely that 

you will want to change the resolution of the model over time (the reason why 

Dicer regenerates) it is best to save the model as a new file once you have the proper 

resolution.

You can use low resolution proxies to speed up the interaction process 

when working with bones. Just make sure that the low resolution model is 

volumetrically similar to the final target model. You can parent both mod-

els to a null effector, with the same cubic extent as the models, and then 

make the working model or final model visible.

Adding

Bones
There are two ways to add bones to your project:

• From the File Menu (File>Add>Type>Bones)
• From the Object Palette (Bones Icon)

Bones are added as a chain until you stop the process by choosing com-

mand-period. The length of the bone is dictated by the distance between 

each mouse click. In effect, you can actually draw the skeleton on top of the 

desired model in the world views.

A typical skeleton is comprised of several link chains. The main chain would be the 

body, including the spine and neck. The extremities would each be a separate chain. 

When reproducing a bones chain, it is best to create each extremity as a separate 

chain, and then create the final hierarchy with the parenting tools available in the 

Project Window. This will enable you to maximize bone usage with inverse kine-

matics.
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Associat-

ing Bones

to a Group

In order for bones to affect the shape of a group, three steps must first be 

undertaken. Like other types of deformations in this chapter, bones must 

be attached to a deformation region. See the section “Creating Deformation 

Regions.” It is a good idea to create a unique deformation region for bones, 

to separate them from other deformations. This is necessary because bones 

can exist in only one region per group, and that region needs to cover the 

entire extent of the group in a default position. 

Remember that regions are order sensitive, and you might want to have the 

Region containing the bones deformation be at the top of the list. Either 

before or after you create a deformation region for the bones chain

Before you parent a bones chain to a group, you must first set up the chain 

so that the linkages of each bone provide the appropriate type of con-

strained motion. (See the chapter entitled “Group Linkage Window” for more 

information on configuring and constraining joints.) 

To associ-

ate bones

with a

group:

• Make sure that the previous recommendations have been followed
• Select the first bone in the chain from the project window
• Click on the Parent tool icon in the project window
• Select the group name in the project window that you want to deform 

with bones

Assuming that all of the steps have been followed, the bone chain is now 

attached to the desired group.
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Moving the

Bones

Around

Now that you have created a bones chain, deformation region, set up the 

joint constraints, and parented the bones to a group, you are ready to test 

your work. You can use either forward or inverse kinematics to move a 

bone chain. Each produces a different result. (For more information on For-

ward and Inverse Kinematics, see the chapter entitled, “Using Effectors.”) 

As you move the bones chain and interact with it, you will likely decide to 

adjust the values and parameters of the bones for the effect that you want 

to achieve. To do this, you must configure each bone separately through the 

Bone Info Window. 

To access

the Bone

Info Win-

dow:

• Select the bone 
• Double click or choose File>Get Info…

The Bone Info Window will appear.

Bone Info Window

The Bone Info Window contains a series of buttons and tabs for configuring 

the bone, and animating it. As a bone is an effector in Animator, in addition 

to a deformation type, we will only cover the controls which are related to 

bones deformations in this chapter. For an explanation of the other controls, see 

the chapter “Using Effectors.”
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Figure 24.79 — Bone Info Window

This chapter will cover the controls in the two tabbed sections: For more 

information see “Skin and Bones” on page 563.

• Bones X-Form Tab
• Bones Special Tab

Bones X-Form Tab
This tab contains the transformation information for a bone. The informa-

tion in this tab is equivalent for the other effector types, and is covered in 

detail in the Using Effector chapter.
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Figure 24.80 — Bones X-Form Tab

Bones Special Tab

This tab contains controls for adjusting and setting bones characteristics.

Figure 24.81 — Bones Special Tab
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The tab is divided into five sections:

• General Section
• Range Section
• Rotation Bias Section
• Strength Section
• Magnet Section

General

Section

This section contains the active check box, which determines whether or 

not the bones effects will be applied to the group, and the bone length edit 

box. Bone length is set at the time that you create the bone, but you are free 

to edit the length of the bone at any time with this control. Bone length is a 

factor in the strength of the bone.

Range

Section

The range section contains four items which control the effective range of 

the bone, and how its energy will be applied to the group through the bone:

• Limited Range Check Box
• Minimum Range Edit Box
• Maximum Range Edit Box
• Fall Off Popup Menu

Limited

Range

Check Box

This check box activates the bone’s ability to limit its influence. The num-

bers in the Minimum and Maximum range edit boxes are used when this 

feature is active. If this feature is not active, the bone’s effective influence 

will apply throughout the deformation region for the bone, on the group to 

which the bone is attached.
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When this option is active, the actual range of the bone will be drawn in the 

world view windows around the bone itself. The minimum value will not 

be drawn if it’s value is 0.0, otherwise it will be drawn in dashed lines. The 

maximum value will be drawn (if it’s value is not 0.0) in unbroken lines.

Minimum

Range Edit

Box

This edit box specifies the minimum area of effectiveness for the bone. A 

value of 0.0 (the default value) will begin to dissipate the energy of the 

bone immediately, until the maximum range value is encountered, using 

the method specified in the Falloff menu. 

Minimum values can be greater than zero. In this instance, the strength of 

the effect is applied from the center of the bone until it encounters this 

boundary, at which point the energy will begin to fall off as specified in the 

Falloff menu.

If you encounter a severe amount of distortion on your model, try setting 

the minimum value to be larger than 0.0. Combined with the Maximum 

range value, you can get very precise control over the deformation area.

Maximum

Range Edit

Box

The edit box specifies the maximum are of influence for the bone. Any part 

of the group which falls outside of this area will not be directly effected by 

the bone. This option is valid only when the limited strength check box for 

the bone is active.

Falloff

Menu

The falloff menu determines the energy transition from the Minimum to 

the Maximum range of the bone. The following methods are available:
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• Ease
• Linear
• Power (of) 2
• Power (of) 4
• Power (of) 8
• Power (of) 16
Each of these methods affect the visual quality of the transition. Ease is typ-

ically the best method, and the default. You may wish to experiment with 

the other methods as well to suit your taste.

Rotation

Bias Sec-

tion

Bones have a default direction of influence, which can cause problems for 

certain types of data, such as motion capture data. This type of data is typi-

cally not “indexed” with any accuracy. That is to say, there is no rational 

frame of reference to begin mapping the motion capture data, as it is typi-

cally stored as a series of offset values. This section enables you to “recon-

figure” the bone to more closely match the first frame of data in the capture 

file.

The edit boxes are used to “zero out” the bone. Position the bone to the 

desired beginning position and click the Set Bias button to do so.

Strength

Section

Bones have the strongest effect on points closest to them, or those within 

the bones limited range (assuming that option is active.) You may wish to 

add bones which counteract the effect of other bones for more precise mesh 

control. Typically, these bones would not be independently animated, as 
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their intended function would be to suppress unwanted distortions from 

becoming pronounced.

Overlapping areas of bone influence can produce points which are under 

the control of more than one bone. When that occurs, the strength of each 

bone will have an effect as well. Sometimes this will be of use to you, such 

as the case mentioned in the paragraph above. At other times, it might be a 

hindrance. This can be avoided to a degree by limiting the bones area of 

influence.

As bones can be set to different strengths, the bone with the higher strength 

value will exert more influence over points than bones with lower values. 

All of the bones affecting the points will exert some influence, however. 

Bones with equal strengths will tend to cancel each other out if pulling in 

opposing directions.

The Strength by Length check box will use the length of the bone to calcu-

late its influence over the group. The strength edit box is used to set a direct 

amount of strength for the bone, taking all of the bones contained within 

the chain into consideration for the overall effect on a group. Bones with 

strengths that are greater than their neighbors will exert more influence, 

however the neighbors will still have some “pull,” so to speak.

Magnet

Section

By default, bones grab the objects they are assigned to and hang on to 

them. If you drag the bone, the geometry will move with it. Magnets do not 

grab the geometry. As you move a magnet, the geometry stays fixed. This 

feature can be used to create a variety of distinct effects including rippling 
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muscles and cloth. Magnets can be used as attractors or repulsors of geom-

etry.

The Magnet checkbox enables this alternate bone behavior. The Amount 

edit box allows you to directly control the strength of the magnet. Both pos-

itive and negative numbers are allowed so you can push or pull.

Figure 24.82 — Single Magnet Above a Plane a) Positive Amount  b) Negative

Just as with all other bones, the object being deformed must have a defor-

mation region and the bones must be linked to that object.

a b
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Circular Wave II

This deformation type is much like the original Circular Wave deformation 

discussed on page 649, but it has many more options. This section will 

cover the options unique to the Circular Wave II deformation.

Figure 24.83 — Circular Wave II Options

Just as with the original Circular Wave deformation, Rings controls the 

number of rings generated. Height can be used to override the region set-

ting. If this number is zero, the setting in the region section of the Deforma-

tion Control window will be used instead.

Size and Space control the relative width of the rings and the spaces 

between them. The units of Size and Rings are in radii of the deformation. 

Therefore a value of 1 represents half the width of the entire deformation.

Fade Start and End allow you create waves that fade with distance from the 

center of the deformation. The units of Start and End are in radii of the 

deformation. Therefore a value of 1 represents half the width of the entire 

deformation.
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Runwave

This deformation type is designed to generate simple ocean water effects 

using a simple noise generator. The noise is used to deform the polygons of 

your group.When used in close up views, Runwave can do a pretty good 

job simulating the surface of the ocean.

Figure 24.84 — Runwave Applied to a Plane. Amplitude 100

A sample project has been provided with EIAS to illustrate the capabilities 

of the Runwave deformation.
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Runwave has a series of options that can be used to vary the noise parame-

ters. 

Figure 24.85 — Runwave Options

Density is the approximate number of waves in the deformation region. 

Octaves sets the amount of noise detail created. Higher values for Octaves 

will create sharper, steeper wavelets.Dropoff can be used to dramatically 

increase the height of the wavelets. Larger numbers create smaller waves. 

Smaller numbers (numbers between 0 and 1) create larger waves.

Wave Offset moves the wave a set distance in scene units. Movements 

along the deformation axis cause ‘boiling’ effects. 

Wave Scale can be used to shape the wave using uniform or non-uniform 

scaling. Keep in mind that scaling the waves up in size can actually smooth 

out the deform. Since the individual wavelets get larger, the overall effect is 

to smooth out the surface leaving larger, undulating waves.
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24.4 Tips On Using Deformations

Use Defor-

mation

Scale only

if Deform-

ing a

Group

Do not scale the group or it’s children via the Group Info window. Scaling 

groups before applying deformations is just asking for trouble, especially if 

your are deforming a group and it’s linked children. The greater the vari-

ance from the default scale of the parent (e.g.: x1.0, y1.0, z1.0), the greater 

the distortion of deformed linked children. If you need to scale a parent 

and children group before adding a deformation, then use a Scale deforma-

tion. Make sure the Scale deformation is the first region listed in the Region 

list in the Group Deformation window. This will allow Animator to apply 

the Scale deformation first to the group and it’s children, followed by any 

other deformations. One drawback to this is that if you need to Scale 

deform your group and children by a large amount, it becomes difficult to 

see the actual Scale region in the world views. The Scale region remains the 

size of the group before it was scaled, while as the group is scaled, it 

becomes larger or smaller. Note in the example below how the Ghost 

Region of the Scale deformation stays the same size, while the group itself, 

scaled by 100%, grows larger. In this example, this is fine, but try scaling a 

group by 1000% and you can see why you may not want this.
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Turn Off

inherit

Deforma-

tion or

Child

Groups

will

Deform too

If you want to deform an object, but simply want it’s linked children to 

move along with the faces, not actually be distorted themselves, then make 

sure the linked children have Inherit Deformation disabled in their Group 

Link window. This is the best setting for having hands follow a body, or in 

the case of our hot dog, having the glasses follow the deforming hot dog 

without getting all twisted up themselves.

On the

Other

Hand, That

May Be

What You

Want

If you desire the children of a group to deform in a similar manner as its 

parent, then make sure the Inherit Deformations option is enabled in the 

children’s Group Link window. This is most useful for eyelids that deform 

along the eye as they blink, or for clothes that you wish to squash and 

stretch with a character as they bend or move. This way the children objects 

will not intersect with the parent as it deforms.

Make Sure

Your Mod-

els Are

Meshed

Groups that don’t seem to deform very well may need to have their mesh 

density increased. Deformations will only move polygons as a whole. 

Deformations cannot bend a polygon itself. So if your deformation seems 

“choppy” or doesn’t seem to bend smoothly, try increasing the polygon 

density of the deforming group. You can either do this by adjusting this in 

your modeler, or by parenting the group to be deformed to a Dicer! object. 

The best way to handle parenting to a Dicer! is to add the Dicer! object 

(File>Add>Socket>Dicer!), to the project, then link the group to it. Then 

export the Dicer! object with the group linked to it as a fact. Re-import the 

Dicer! object into the project. Discard the linked group and rename the 

Dicer! in the Project window to the name of the group. What this does is 

force Animator to recognize the Dicer! group as having more polygons. 
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This is helpful when it comes time to render because at render time all 

Dicer! objects need to be recalculated for each frame. But a high density 

mesh is just read like any other model.

Rotations

Can Get

Tricky

If you need a group to rotate, but don’t want the deformation to rotate with 

it, then counter rotate the deformation. Look at the SewerSnake.Project on 

the EIAS CD-ROM. Note how the bend deformation region doesn't go 

twirling around at the bottom of the sewer snake as it rotates? This is 

because the rotation of the sewer snake is offset by a similar counter rota-

tion of the deformation region. This gives the appearance of the deforma-

tion region not moving, when in fact it is actually rotating -1 degree for 

every degree of rotation of the group it deforms.

Camera View of SewerSnake.Project illustrating counter rotation of defor-

mation regions. The head of the sewer snake rotates along with the other 

parts of the sewer snake as it rotates on its Y axis.
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Figure 24.86 — Counter Rotation of Regions will Compensate Strange 
Results

Multiple

Groups

can give

More Con-

trol

You can use a combination of groups to achieve even more complex ani-

mated deformation effects by applying the deformation of one group to 

another as it passes through the first group. Look at the SewerSnake-

2.Project on the EIAS CD-ROM. The parent Standard Shape, a cylinder, has 

a 90 degree Bend deformation applied to it. The child, the sewer snake, has 

Inherit Deformation enabled in its Group Link window. As the sewer snake 

is animated to intersect with the parent cylinder, it inherits the 90 degree 

bend that its parent has. This technique is very useful for showing complex 

organic mechanisms in action.
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Camera View of SewerSnake-2.Project illustrating inherited deformations 

to achieve complex animated deformation effects.

Figure 24.87 — Child Group Passes through Parent Region

Copy and

Paste

You can copy and paste deformations between objects. Select the deforma-

tion in the deformation list and choose Copy under the Edit menu. Go to 

another object, make sure it has a deformation region, and paste the defor-

mation using Paste under the Edit menu.
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Shockwave (.w3d) Export

25.0 Introduction

You can now export your scene to the Macromedia Shockwave (.w3d) file 

format. This is an authoring format designed to be used by Shockwave 

applications such as Macromedia Director. It is not a web-ready file format. 

You cannot take these files and add them directly to a web page.

25.1 Exporting

The Shockwave exporter is invoked by pulling down the Render menu and 

selecting “Shockwave Settings...”. The Shockwave Information dialog box 

will pop up. This dialog box allows you to change compression factors and 

naming conventions for geometry and textures. The Go button writes the 

Shockwave file to disk.

Figure 25.0 — Shockwave Information
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Control Tab

The Control tab contains options that allow you to optimize the export pro-

cess for speed and file size.

Normal. This option allows you to specify whether to use the vertex nor-
mals, already present in the models, or have the exporter calculate normals 
based on an angle you specify. 

If you select “Use Vertex”, the vertex normals are used. This results in a 

faster export and a more accurate representation of the models in your 

scene.

The “Use Edge Angle” option allows you to select the breaking angle 

(angle at which to break the polygon and create a hard edge) manually. 

This will create a more efficient, but less accurate, model. This option 

greatly increases the time it takes to export the file.

Compression. The Compression section allows you to tell the exporter how 

to compress the data to achieve a more space-efficient and bandwidth-effi-

cient representation. A value of 0.0 is the highest compression achievable, 

while a value of 1.0 is the lowest. 

High compression ratios may be more efficient, but if too high, may intro-

duce artifacts. For geometry compression, this means dropped polygon 

faces, and for animation, this means non-smooth motion (pronounced jit-

ter). It is up to you to find the best trade-off between accuracy and effi-

ciency in selecting these values. 

We have found that the best results are obtained when building a scene 

with relatively large scene units. That is, don’t expect models with very 
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small extents to export efficiently. Try and maintain overall scene dimen-

sions in the hundreds or thousands.

Output. This section enables you to restrict the kind of objects that are 

included in the output file. By default, the correct camera, all lights, all 

models, the first diffuse texture for each group are exported along with 

their animation data. Bones are exported as an attribute of the groups and 

are not controlled separately.

Plugin As Geometry will cause plugins that generate polygons to be writ-

ten out as geometry. If this check-box is off, the plug-ins will be written out 

as nulls. Plug-ins that modify their polygons over time (particle systems, 

blobby generators, etc.) will have the geometry at the current time written 

out for all frames of the .W3D file.

Texture. This section allows you to specify the maximum resolution (in pix-

els) for the textures being exported. If you select a custom size, please make 

sure you enter a power of 2 (16, 32, 64, 128, 256, etc.).

Name Styles Tab

This tab gives you control over the naming conventions of the various 

nodes in the Shockwave scene file. You will most likely use the Lingo lan-

guage to add your own touches to the finished presentation, so the naming 

options give you an opportunity to define your own style of naming the 

nodes.
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Shockwave requires that each node has a unique name. EIAS will enforce 

this by adding a “_#”, where # is a number, to the object’s name if that 

name has already been used. In addition, each type of node (view, light, 

group, etc.) is specifically named using the name styles, where “*” denotes 

the unique object name that this node belongs to. For example, if you 

export a group called “Sphere”, its Motion name (“*_motion”) will be 

“Sphere_motion”, while its Material name (“*_material”) will be 

“Sphere_material”. 

The exported camera will be written using a view node and the name 

defaults to “DefaultView”. This allows you to immediately see the view 

when you import the Shockwave scene into your favorite Shockwave 

authoring application. If you change the name, you will have to write a 

Lingo script in your authoring application to view it.

Output Name Log. Causes a text file to be written out that contains the 

names of all the objects exported to .w3d. The file name will be the same as 

the name you chose for the .w3d file with the .txt extension added.

Figure 25.1 — Name Styles Tab
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25.2 Export Restrictions

The.w3d is a compact, web format. As such, it has a series of restrictions on 

material complexity, object size., and animation parameters. Please read the 

following sections carefully before using the exporter.

Animation

The following animation attributes cannot be exported: Morphing, Defor-

mation, Visibility, Material. In addition, the only light parameters that can 

be written are translation, rotation and scale. Light intensity and color can-

not be animated.

Geometry

Points, lines and color vertices will not be exported. Shockwave is a com-

pact representation of a 3D scene that is meant to be transmitted using low-

bandwidth internet connections. Any attempt to use large polygon-count 

models (>10000) will slow down or break the exporter. We suggest keeping 

your objects under 1000 polygons.

Note Amorphium Pro has some very nice tools for reducing the polygon count 

of models. Check out our web site for more information.

Materials

The following material attributes will be exported: Diffuse color, Specular 

color, Specular size, Luminance. In addition, the “Use Polygon Color” but-

ton in the Diffuse tab is supported if textures are not in use.
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Textures

Only one texture per group will be exported. The texture to be exported 

will be the texture at the top of the diffuse texture list. Or rather, the first 

texture in the list with its enable button turned on.

All mapping modes are supported (flat, cylindrical, spherical, cubic). The 

texture’s RGB and Alpha channels are supported. The inverse RGB button 

setting will be exported. The normal blend mode will always be used. 

Other blend modes will be ignored. 

The Repeat and None texture tiling modes are supported, but the X direc-

tion value will be used for Y. Shockwave does not allow separate control of 

each tiling axis. 

When choosing the none tiling setting, the geometry not covered by the 

texture will be colored according to the diffuse color. The “Use Polygon 

Color” (in the diffuse tab) button will have no effect.

Camera

Only the current camera will be written out. The current Camera is the one 

selected for viewing in the Camera View window.
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GlobeCaster and GrangerFX

26.0 Introduction

The GlobeCaster is a hardware video production tool originally made by 

Play, Inc. and now made by GlobalStreams. The GlobeCaster is famous for 

its real time video effects. Until today, however, much of the power of the 

GlobeCaster was inaccessible to video designers. Many of the effects which 

made the GlobeCaster famous could not be produced with the tools that 

shipped with the system. EIAS can render to the file format supported by 

the GlobeCaster hardware effects engine (.tfx) and to a format supported 

by the GrangerFX plug-ins (.vfx) for Adobe After Effects and Premiere Pro.

The GrangerFX plug-ins are included with Electric Image EIAS so every-

one can take advantage of them by rendering to the .vfx file format. The 

GlobeCaster output format (.tfx) is reserved for those users who own the 

GlobeCaster hardware.

Using EIAS and either the GlobeCaster or the GrangerFX plug-ins, design-

ers can now create packages of effects that create a consistent look for tele-

vision shows, DVDs, and other broadcast quality video production 

projects.

26.1 GrangerFX Plug-Ins

The GrangerFX plug-ins were created to allow Trinity/GlobeCaster effects 

to be used with other products such as Adobe After Effects and Premiere 

Pro. The plug-ins still use some of the terminology from the Trinity. The 

plug-ins can use up to three input video streams. These video streams are 
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named Program, Preview and Aux.  When switching live video, a producer 

is looking at a row of monitors, one for each camera or graphics input. The 

Program monitor displays the video that is currently being seen by the 

viewers. The Preview monitor shows the video that the producer is about 

to switch to. The Aux monitor may contain graphics or another video 

source that the producer wishes to use for a transition, a video inset or 

some other purpose. The producer can choose a transition to use when 

switching from Program to Preview. The producer can also load an effect to 

use over the Program video such as a lower third title or an over the shoul-

der graphic.

The original Trinity hardware was a large box that contained slots for 

optional cards. A special card named the Warp Engine was used to warp a 

live video channel. Up to three Warp Engines could be loaded into a single 

Trinity. The Trinity’s ability to play an effect depended upon whether it had 

sufficient hardware resources.

The GrangerFX plug-ins have no special hardware requirements but still 

describe effect files by the elements they contain. For example, if an effect 

has two video panes flying around the screen over a graphic background, it 

is described as a “Dual Source Warp with Graphics”.

26.2 Rendering an Effect

The GlobeCaster and GrangerFX output formats are selected in the Render 

tab of the Render Information window. You can open the Render Informa-

tion window by choosing Render Settings… from the Render menu at the 

top of the screen. Click on the Format: pop-up menu and choose either 

GlobeCaster... or GrangerFX... as your output file format.
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When you choose the GlobeCaster or GrangerFX format, a dialog box will 

open containing all of the effect options.

Note You can not use Renderama to render out .vfx or .tfx file. Renderama can not stitch 

together these files formats.

Figure 26.0 — Render Information Window – Render Tab
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The Effect: pop-up menu selects the among the eleven possible effect 

modes. These are described in “Effect Modes” on page 706.

The Warp Source 1: pop-up menu chooses between Program or Preview as 

the source video to apply to the warp. This is available so that either the 

program or the preview video can be warped during the effect. The other 

channel is placed in the background behind the warp. Normally the pre-

view stream is warped as it flies onto the screen to cover the program 

video. Sometimes it is necessary to swap the video streams at the beginning 

of an effect. The Mr. Nitro explosion effect, for example, must shatter the 

Figure 26.1 — Effects Options Dialog

Figure 26.2 — Effect Pop-Up Menu
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program video stream to reveal the preview video stream in the back-

ground.

The option to pick between program and preview warp video sources is 

only available for the following effect modes: Single Source Video Warp, 

Wipe with Video Warp & Graphics, Chroma Key Warp, Chroma Key Warp 

and Graphics.

The Curve Fit Precision value sets the precision of the curve fit algorithm 

used to generate the effect file. It is a floating point value in fractions of a 

pixel. The default is 0.0625 or 1/16th of a pixel. If your effect files are too 

large or play back too slowly, you could try increasing this precision value. 

Values greater than 0.5 are not recommended because they could create vis-

ible artifacts in the animation.

The Transition box, when checked, tells the GlobeCaster or GrangerFX 

plug-ins to swap the program and preview video sources after the effect 

has been played. Most effects are transitions. They allow a video producer 

creative choices other than a simple cut to get from one stream of video to 

Figure 26.3 — Warp Source 1 Pop-Up Menu

Figure 26.4 — Curve Fit Edit Box
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another. Other types of effects do not switch video, lower thirds for exam-

ple. A lower third is typically a title that appears in the lower third portion 

of the video.

The Enable Pause option (used only by the GlobeCaster) will pause on a 

selected Pause Field, part way through the effect. An example of this fea-

ture is an “over-the-shoulder” video inset. The first part of the effect would 

fly the video inset into the top-left corner of the frame and stop on the 

pause field. The second part of the effect would fly the video inset out of 

frame again. During production, the producer could begin playing a clip in 

the preview channel and then trigger the over-the-shoulder effect. The 

effect will pause with the video inset in frame. Before the clip ends, the pro-

ducer would continue the effect so that the video inset would fly off the 

screen again.

The Enable Loop option (used only by the GlobeCaster) is used to mark a 

portion of the effect for looping. The Start Field: and End Field: values 

specify the range of fields that will be looped. An example of this feature is 

an animated “lower third” graphic. An effect could be created that would 

fly the lower third onto the screen, animate a spinning globe within the 

Figure 26.5 — Transition Check Box

Figure 26.6 — Enable Pause Check Box
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lower third graphic and then fly the lower third back off the screen again.   

During production, the lower third effect would continue to loop until the 

producer decides to continue the effect to completion.

26.3 Applying Video To Your Models

You will be adding stand-in textures (proxies) to your models in EIAS Ani-

mator. These proxies represent the video channels of the GlobeCaster. The 

GlobeCaster or GrangerFX plug-ins will replacing these textures with 

actual video. This section covers the different texture proxies and how they 

are used in EIAS Animator.

Textures

In order to create video warp effects, the animator must specify where and 

how the live video streams are to be projected onto model surfaces. This is 

done by applying one of the video source stand-in image files as a texture 

map or a camera projection map. These stand-in image files are named 

$Program$, $Preview$ and $Aux1$. They are applied like any other texture 

or projection map and support all projection features including cropping 

and tiling. They must only be applied to the Diffuse material channel. 

Applying the video streams to other channels will not work correctly. 

When rendering the effect, the surfaces mapped with video will appear to 

Figure 26.7 — Enable Pause Check Box
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be black in Camera’s preview window. The GlobeCaster or GrangerFX 

plug-ins will replace these black areas with live video.

It is important that the correct stand-in be used for the selected effect mode. 

If you are rendering a Single Source Video Warp and have selected Pro-

gram as your video source, you must apply $Program$ as the map. If you 

select Preview as your video source, you must apply $Preview$ as the tex-

ture map.

Wipe with Graphic Overlay effect projects must use the stand-in image file 

$MainAlpha$ to specify which portions of the video frame will display the 

preview video stream.

When creating PAL GlobeCaster or GrangerFX effects, you should use the 

PAL resolution stand-in files. These are named $Program$ PAL, $Preview$ 

PAL, $Aux1$ PAL and $MainAlpha$ PAL respectively.

26.4 Effect Modes

There are eleven effect modes:

• Wipe
• Graphic Overlay
• Wipe with Graphic Overlay
• Single Source Video Warp
• Dual Source Video Warp
• Three Source Video Warp
• Single Source Warp with Graphics
• Dual Source Warp with Graphics
• Wipe with Video Warp & Graphics
• Chroma Key Warp
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• Chroma Key Warp and Graphics

Wipe

Wipes are used to create custom dissolve style transitions. A classic dis-

solve transition simply fades out the program video stream while fading in 

the preview video stream. A wipe is an animated alpha mask. When the 

effect is played, areas of the screen where the mask is black will display the 

program video stream. Areas of the screen where the mask is white will 

display the preview video stream. Areas where the mask is some gray 

value will contain a mix of program and preview video. On the first frame 

of a wipe transition, all of the pixels of the mask are black. On the last 

frame, all of the pixels are white. 

A simple dissolve would be produced by filling the entire mask with a con-

stant value for each frame. The value would increase linearly from black to 

white in every frame of the transition.

An example of a more interesting wipe is demonstrated by the Clock Wipe 

demonstration project. The Clock Wipe effect is an animated pie wedge. 

The pie wedge gets wider every frame as if the hand of a clock were sweep-

ing the preview video into the frame.

The Wipe mode wipes preview over program. The area where the alpha is 

white will be preview, the area where the alpha is black will be program. 

These video channels are added in by the GlobeCaster and GrangerFX plu-

gins. No video stand-ins ($Program$, etc.) are used in Wipe projects.
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Graphic Overlay

Graphic overlays are used to place static or animated graphics over the 

program video. Overlays are not typically used for transitions. Overlays 

can be animated and may contain pause frames or loops.

One common type of graphic overlay is the lower third title. Another 

would be a credit roll at the end of a television program. Many cable TV 

networks also use animated “bugs”. A bug is a small logo that will appear 

in the corner of the video for a short period of time to remind the viewer 

which channel they are watching and to discourage content from being 

copied by video pirates.

No video stand-ins ($Program$, etc.) are used in Graphic Overlay projects.

Wipe with Graphic Overlay

This mode combines the Wipe and Graphic Overlay modes together. A 

wipe controls how much of the program or preview video is seen at each 

pixel while animated graphics are overlaid on top. This mode can be used 

to spice up wipes with graphic content. One of the famous GlobeCaster 

effects is a band of fire that burns up the program video leaving preview 

video in its wake.

The $MainAlpha$ stand-in file needs to be used with this mode. An object 

must be added that has $MainAlpha$ as a texture. Wherever that object is 

visible, the Preview channel will be seen. Wherever it is not visible, pro-

gram is visible. Over the top of the whole thing, the graphic content is dis-

played.
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Single Source Video Warp

Single source video warps are used to create a wide variety of flying video 

effects. These effects can be as simple as sliding preview onto the screen or 

as complex as a Mr. Nitro explosion that shatters the program video into 

hundreds of shards that reveal preview video as they fall away. Either pro-

gram or preview can be used for the warped video. The other video source 

will appear in the background. 

You apply either $Preview$ or $Program$ based on the selection you make 

in the Effect Settings dialog box, WarpSource 1 pull down menu. The chan-

nel you didn’t select will be put in the background by the GlobeCaster or 

GrangerFX plug-ins.

Dual Source Video Warp

It may be necessary to make a transition appear during an effect or to move 

both program and preview video during an effect. Dual source video 

warps are used to perform complex transition animations. An example is 

the Infinite Zoom effect in which program is zoomed up towards the 

viewer, a dissolve occurs in the middle of the animation to reveal the pre-

view video falling away from the viewer and back into place again.

If you are using a GlobeCaster, you must have two warp engines installed 

to use this effect.

For this effect, you never apply $Program$ because the GlobeCaster and 

the GrangerFX plug-ins will always place the program channel in the back-

ground. But you will be applying the  $Preview$ and $Aux1$ stand-ins. 

These are the two warp channels that will be used by the GlobeCaster and 

GrangerFX plug-ins.
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Three Source Video Warp

The GlobeCaster can support more than just two video inputs. In some rare 

occasions, a third video source may be needed for a video effect. An exam-

ple would be two small inset video streams overlaid on top of a third larger 

video stream. This would allow a “head to head” debate between two peo-

ple while a third person moderates. For this mode, it is important that no 

piece of background be left unfilled by video because garbage could appear 

in the undefined background areas and aliasing (stair-stepping) could 

occur along the edges.

If you are using a GlobeCaster, you must have two warp engines installed 

to use this effect.

For this mode, you will apply the $Program$, $Preview$, and $Aux1$ 

video stand-ins. You should set up the effect so the background is not visi-

ble at all.

Single Source Warp with Graphics

This mode allows the full power of EIAS to be harnessed to create fantastic 

looking effects. In a simplistic sense, this is just a single source video warp 

combined with a graphic overlay. However, EIAS is able seamlessly to 

combine the video warp and graphics to produce an effect with real-time 

ray-tracing, detailed models and realistic lighting.

Single source Warp with Graphics is only used for non-transitional effects. 

The Preview video channel will NOT appear in the empty areas. Only a 

black screen will appear in those areas.

An example of this effect mode is the Pile of Spheres demonstration effect. 

In this effect, a pile of glass spheres rotates in front of the program video. 
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The live video appears to be refracting realistically through the glass 

spheres. Highlights are visible on the surface of the glass spheres. The 

project has a series of transparent spheres in front of a single plane acting as 

a video stand in that has $Program$ mapped to it.

This mode always uses $Program$ as the video stand-in.

Dual Source Warp with Graphics

This mode can produce fully rendered effects with two video sources. An 

example is the Sports Night effect in which alternating bands of program 

and preview video swirl around a gold football trophy and the words 

Sports Night appear. Both video sources can be seen reflecting in the sur-

faces of the trophy.

If you are using a GlobeCaster, you must have two warp engines installed 

to use this effect.

The Preview video channel will NOT appear in the empty areas. Only a 

black screen will appear in those areas.

This mode always uses $Program$ and $Preview$ as the video stand-ins.

Wipe with Video Warp & Graphics

This mode allows a fully rendered wipe effect to be created. Program or 

preview video can be selected for the video warp. The background is filled 

with the other channel just like the Single Source Video Warp mode. 

This mode supports 3D graphic elements in the scene and warping of 

objects that have $Program$ or $Preview$ applied to them. 
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Chroma Key Warp

This mode works like the Single Source Video Warp mode except that 

chroma key is enabled for the warped video source. The background will 

be visible through areas of the warped video that are keyed out. The 

chroma key values are setup by the producer at the time of production. The 

warp can be used to scale, rotate, position or fly the chroma keyed video 

source over the background video. This effect mode can be used to create 

virtual sets. The animator can create masking objects that remove portions 

of the chroma key video to create the illusion that the talent is standing 

behind an object in the background video.

You apply either $Preview$ or $Program$ based on the selection you make 

in the Effect Settings dialog box, WarpSource 1 pull down menu. The chan-

nel you didn’t select will be put in the background by the GlobeCaster or 

GrangerFX plug-ins.

Chroma Key Warp and Graphics

This mode combines the Chroma Key Warp mode above with fully ren-

dered foreground elements. This can be used to create reflective objects that 

reflect the talent in the chroma key video or transparent objects that refract 

the talent. For a complete animated virtual set, the animator must also cre-

ate a perfectly matched background animation. When combined, with the 

foreground effect, this allows the animator to create virtual camera moves 

on the virtual set and the chroma keyed talent standing within it.

You apply either $Preview$ or $Program$ based on the selection you make 

in the Effect Settings dialog box, WarpSource 1 pull down menu. The chan-

nel you didn’t select will be put in the background by the GlobeCaster or 

GrangerFX plug-ins.
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26.5 Render Settings

The GrangerFX files are very flexible. Interlacing and a broadcast industry 

standard resolution and frame rate are not required.

The GlobeCaster effect files must be created at the resolution and frame 

rate that is supported by the GlobeCaster hardware as follows.

In the Resolution tab of the Render Information window, select either 

GlobeCaster-NTSC 720 x 486 or GlobeCaster-PAL 720 x 576 from the Reso-

lution: pop-up menu; depending on whether you are creating an effect for a 

NTSC or PAL GlobeCaster.

In the Timing tab of the Render Information panel, select NTSC: 30i from 

the FPS: pop-up menu for NTSC rendering or PAL: 25i for PAL.

In the Resolution tab of the Render Information panel, set the Pixel Ratio 

value to 0.9 for NTSC or 1.1 for PAL. This will prevent rendered objects 

appearing stretched or squeezed when the effect is played. 

The pixel aspect ratio is set automatically by EIAS when the GlobeCaster NTSC or 

PAL resolutions are selected.

The GrangerFX files are much more flexible. Interlacing and a fixed resolu-

tion are not required.

Pinned Video

It is important that the first and/or last frame of a transition effect match 

the program and/or preview video precisely. If you wish to create an effect 

in which the program video appears to fly off the screen, the video mapped 
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to the polygon in the first frame must exactly match the position and scale 

of the program video stream so that no undesirable shift is perceived by the 

viewer when the effect begins to play. Each corner of the mapped polygon 

must be pinned to the corners of the video frame. The stand-in texture must 

also be scaled to fit the polygon perfectly. This is referred to as Pinned 

Video.

There are two ways to perfectly create perfectly pinned video. The first way 

is to texture map a single polygon that fits perfectly inside the camera view. 

The second way is to use a camera projection map. The later method is doc-

umented in the Camera Map Tutorial. Most effects using video warps can 

be produced with the texture map approach. The camera projection map 

approach is more difficult to set up but can be used to project pinned video 

onto curved surfaces or portions of larger models.

26.6 Tutorial: Creating a Pinned Video Plane – NTSC

These are the steps required to create a pinned video polygon for an NTSC 

GlobeCaster or GrangerFX plug-in effect.

1. Create a new project. Set the render settings as described in“Render Set-

tings” on page 713 (NTSC Settings).

2. Use the UberShape plug-in to create a single polygon Plane 720x486 in 

the XY Plane. If you plan to deform the video plane, increase the EI Divi-

sions and Camera Divisions to a larger number like 40. Click the OK button 

to create the plane
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3. Double-click on the new group in the Project window to open the Group 

Info window and set the group’s X Scale to 0.9. This is done to compensate 

for the 0.9 pixel aspect ratio of NTSC GlobeCaster and GrangerFX effects.

Figure 26.8 — Creating a Video Plane with the UberShape Plug-in

Figure 26.9 — Scaling The Plane
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4. Click on the material ball in the Group Info window to display the 

group’s Material window. Click on the color chip (rectangle) to open the 

color picker and change the Diffuse color to black.

5. Click on the Luminance tab in the Material window and set the mode to 

Shade and the amount to 100%. This will prevent the polygons that receive 

the video from being illuminated or shaded

Figure 26.10 — Set the Diffuse Color to Black

Figure 26.11 — Luminance Tab
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Steps 6-9 replace with UberShape plug-in with a FACT model. Using a 

FACT model reduces rendering time as the plug-in must be generated algo-

rithmically every frame of the effect.

6. Select the group in the Project window and rename it to:NTSC Video 

Plane.

7. With the plane still highlighted in the Project window, select the 

Export… command from the Object menu at the top of the screen and 

choose the Native FACT format from the sub-menu. Name the new model 

file NTSC Video Plane.

8. Clear the plug-in group from the project file by selecting it and using the 

Clear command in the Edit menu.

9. Use the Import Object... command in the Object menu to add the NTSC 

Video Plane model to the project. Click the cancel button to exit the file 

picker.

10. Double-click on the NTSC Video Plane group in the Project window to 

open its Group Info window. Click on the material ball to open the group’s 

Material window. Click on the Add button under Diffuse Maps. Select the 

$Program$ image file. This is just an all white 720x486 24 bit single frame 

Figure 26.12 — Rename the Plane
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image file named $Program$. This file acts as the stand-in for the program 

video channel.

By default, texture maps are automatically fit to the groups they are applied to. 

11. Close the Material panel and Object Info window. Double-click on Cam-

era 1 in the Project Window. Set the Camera Z position to -972.  972 is two 

times the height of the group (486).

The default focal length of the camera is 2.0 and the field of view is calculated verti-

cally. 

Figure 26.13 — Adding the Program Video Stand-In

Figure 26.14 — Setting the Camera’s Z-Position
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12. The Camera View should now show the video plane perfectly fitting to 

the window. If you were to render and play the effect, you should not see 

any shift in the program video when it starts.

26.7 Tutorial: Creating a Pinned Video Plane – PAL

These are the steps required to create a pinned video polygon for a PAL-

GlobeCaster or GrangerFX effect.

1. Create a new project. Set the render settings as described in “Render Set-

tings” on page 713 (PAL Settings).

2. Use the UberShape plug-in to create a single polygon Plane 720x576 in 

the XY Plane. If you plan to deform the video plane, increase the EI Divi-

sions and Camera Divisions to a larger number like 40. Click the OK button 

to create the plane.

Figure 26.15 — Camera View Window
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3. Double-click on the new group in the Project window to open the Group 

Info window and set the group’s X Scale to 1.0667. This is done to compen-

sate for the 1.0667 pixel aspect ratio of PAL GlobeCaster and GrangerFX 

effects.

Figure 26.16 — Creating a Video Plane with the UberShape Plug-in

Figure 26.17 — Scaling the Plane
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4. Click on the material ball in the Group Info window to display the 

group’s Material window. Click on the color chip (rectangle) to open the 

color picker and change the Diffuse color to black.

5. Click on the Luminance tab in the Material window and set the mode to 

Shade and the amount to 100%. This will prevent the polygons that receive 

the video from being illuminated or shaded,

Figure 26.18 — Set the Diffuse Color to Black

Figure 26.19 — Luminance Tab
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Steps 6-9 replace with UberShape plug-in with a FACT model. Using a 

FACT model reduces rendering time as the plug-in must be generated algo-

rithmically every frame of the effect.

6. Select the group in the Project window and rename it to: PAL Video 

Plane.

7. With the plane still highlighted in the Project window, select the 

Export… command from the Object menu at the top of the screen and 

choose the Native FACT format from the sub-menu. Name the new model 

file PAL Video Plane.

8. Clear the plug-in group from the project file by selecting it and using the 

Clear command in the Edit menu.

9. Use the Import Object... command in the Object menu to add the PAL 

Video Plane model to the project. Click the cancel button to exit the file 

picker.

10. Double-click on the PAL Video Plane group in the Project window to 

open its Group Info window. Click on the material ball to open the group’s 

Material window. Click on the Add button under Diffuse Maps. Select the 

“$Program$ PAL.img” file. This is just an all white 720x576 24-bit single 

Figure 26.20 — Rename the Plane
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frame image file named $Program$ PAL. This file acts as the stand-in for 

the program video channel.

By default, texture maps are automatically fit to the groups they are applied to.

11. Close the Material panel and Object Info window. Double-click on Cam-

era 1 in the Project Window. Set the Camera Z position to -1152.  1152 is two 

times the height of the group (576).

The default focal length of the camera is 2.0 and the field of view is calculated verti-

cally.

Figure 26.21 — Adding the Program Video Stand-In

Figure 26.22 — Setting the Camera’s Z-Position
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12. The Camera View window should now show the video plane perfectly 

fitting to the window. If you were to render and play the effect, you should 

not see any shift in the program video when it starts.

26.8 Cropping Video

The GlobeCaster and GrangerFX plug-ins digitize the entire video frame. 

Many video sources, such as analog video cameras, have some amount of 

garbage around the edge of the video frame. This garbage is not seen on 

television because the edges of the video are hidden beneath the bezel 

around the edge of the glass tube. Unfortunately, the garbage around the 

edge of the video frame will become visible if your video warp shrinks as it 

flies on or off the screen. To compensate for this problem, you must crop 

the edges of your video map.

There are several ways to crop the video stand-in while keeping it pinned. 

The most obvious way is to use the Cropping settings in the Image tab of 

Figure 26.23 — Camera View Window
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the stand-in Texture Info window. This will cause the cropped edges of the 

video to be mirrored.

A better method is to create a soft edged cropping mask in Photoshop. This 

mask image is then applied to the video plane’s Clipping Maps under the 

Geometry tab of the group’s Material window.

Perhaps the easiest approach is to adjust the size of the video plane itself in 

Step 2 of the Pinned Video Plane Tutorial. You can reduce the size of the 

video plane by 12 pixels in both X and Y so that it is 708x468 (for NTSC) or 

708 x  564(for PAL). This will crop into each edge of the video plane by ten 

pixels. After you apply the $Program$ stand-in texture map in Step 10 (see 

page 22 NTSC or page 27 PAL), double click the map in the Diffuse maps 

list to open its Texture Info window. Set the X Scale, Y Scale and Z Scale to 

1.0. This will cause the video to go off the edges of the video plane but 

remain pinned to the screen. The rest of the steps in the tutorial should be 

followed exactly including setting the camera’s Z position to -972 in Step 

11.
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It is recommended that cropping not be performed on effect frames in which the 

video must pinned. This is usually at the first and/or last frame of a transition. You 

can accomplish this by having an un-cropped video plane object that is only visible 

when the effect is pinned. The cropped video plane object would be visible on all 

other frames. You can use EIAS Animator’s animated visibility feature to do this.

26.9 16:9 Effects

The GlobeCaster is capable of producing video in the wide screen 16:9 

aspect ratio and the GrangerFX plug-ins can also process 16:9 video. This 

aspect ratio is currently used to produce DVD content as well as some high 

definition video production. The GlobeCaster still produces video at the 

standard NTSC resolution of 720x486 or the PAL resolution of 720x576 but 

when played back, it is stretched to fill a 16:9 aspect ratio monitor.

Figure 26.24 — Setting the Scale of the Map
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All that is required to generate a NTSC 16:9 effect in EIAS is that the Pixel 

Ratio value in the Resolution tab of the Render Information window must 

be set to 1.2. This will have the effect of squeezing all of the objects in the 

camera view to simulate a wide angle camera. If you wish to create a 

pinned video plane, change the X Scale of the video plane to 1.2 in Step 3 of 

the tutorial (see page 19) to match the rendered pixel aspect ratio.

PAL 16:9 effects can be generated by setting the Pixel Ratio value to 1.4222. 

For a pinned video plane, you would also need to change the X Scale of the 

video plane to 1.4222 in Step 3 of the tutorial.

26.10Limitations of Rendered Effects

In a perfect world, every feature of EIAS could be used without any sort of 

restriction to create GlobeCaster and GrangerFX effects. Unfortunately, 

there are a few restrictions and limitations you need to be aware of.

One Warp at a Time

A single warp effect can only modify the refraction or reflection of a pixel, 

not both. If you want to combine reflection and refraction, you must use a 

dual source warp. 

For example, to create a ‘bug’  in the lower right hand corner of the video 

that refracts the video and is partially reflective, you would use two planes. 

One would be placed in front of the camera (with $Preview$ as its texture) 

and would be placed behind the camera (with $Aux1$ as its texture). A 

small 3D object (the bug) would be placed between the camera and the 

front plane. The bug’s material properties would include both ray traced 

reflection (it would reflect the plane behind the camera) and ray traced 
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transparency (the camera will see through the bug to the front video plane). 

The output render mode will be Dual Source Video Warp. In the Globe-

Caster or GrangerFX plugins, set up the video sources so that Preview and 

Aux are coming from the same source.

Overly Complex Effects

EIAS can produce some pretty amazing GlobeCaster effects in which live 

video is refracted through transparent objects or reflected off mirrored 

objects. When a bump map is applied to these surfaces, the refracted or 

reflected video will become scattered. This will make the video warp very 

large and exceed the ability of the GlobeCaster’s effect engine and the 

GrangerFX plug-ins to process the effect in real time. This will prevent the 

effect from playing back correctly. You may see tearing in the effect or it 

could freeze part way through with garbage on the screen. It is recom-

mended that you use smooth surfaces for ray traced video effects and try to 

limit the number of ray bounces in the scene. If you are in doubt that the 

effect will work correctly, try rendering a short test to see if it will play back 

correctly on the GlobeCaster or in the GrangerFX plug-ins. Simple ray 

traced video effects tend to look better. The Pile of Spheres effect is an 

excellent example of a simple ray traced video effect with smooth surfaced 

objects.

It is also possible to exceed the processing power of the GlobeCaster’s 

effect engine by tiling a video source onto a plane so that hundreds of cop-

ies of the video are visible in the frame.

If you think you are close to the limit, you can try reducing the Curve Fit 

Precision in the Effect Settings panel. This will cut down on the size of the 

effect.
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YUV, Highlights, Transparencies and Lens Flares

One of the big limitations of GlobeCaster and GrangerFX effects is that only 

white highlights and lens flares can be rendered correctly. This is due to the 

fact that the GlobeCaster works in a YUV color space instead of the RGB 

color space that Camera works in. Two YUV colors cannot be added 

together the way two RGB colors can be. This means that colored high-

lights or lens flares look awful when they appear over a video surface.

In addition, one YUV color cannot be used to filter another YUV color. This 

means that a transparent object cannot be used to tint a live video surface 

behind it. You also should not try to illuminate your video surface with a 

colored light source.

The good news is that white highlights (specular), lens flares and glowing 

lights should work fine and add greatly to the production value of an 

effect. The Page Peel Tutorial demonstrates great looking white highlights 

on a video surface.

Motion Blur, Object Glow, Mirror and Environment Maps

GlobeCaster and GrangerFX video warps can only be processed during the 

main rendering pass. Any video sources that appear in pre-processed mir-

ror and environment maps will not work correctly. For this reason, the use 

of mirror and environment maps should be avoided in GlobeCaster and 

GrangerFX effect projects. Ray traced reflection works great and looks fan-

tastic so this is the right way to go if you want reflective objects. You can 

use static reflection maps; however it is not recommend that colored reflec-

tion maps be used with video surfaces for the reasons mentioned in the sec-

tion above.
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The Motion Blur and Object Glow features require post processing. These 

features cannot know what colors will be present in the live video stream 

when the effect is rendered so they are not compatible with GlobeCaster 

and GrangerFX effects. Do not enable these features.

Picons

Automatic picon creation is not currently supported by EIAS. The picons 

for the rendered effects will appear as random noise when accessed by the 

GlobeCaster or GrangerFX plug ins. You can create your own picon for the 

effect by following these steps (Windows only):

1.Load your effect into the GlobeCaster by double-clicking its picon.

2.Position the T-Bar on the frame of the effect you wish to use as the picon.

3.Right click on the FX Picon just above and to the right of the T-Bar.

4.Select Properties. The property panel will open for the loaded effect. 

5.Click the Set Picon button. The FX Picon will update to the current frame.

6.Click the Save Over Original File button. Your new picon will appear in 

the bin.

26.11Loading and Playing Effects

The GlobeCaster organizes all of its files into bins. Each bin is just a folder 

on your hard drive. The root bins folder is inside your main GlobeCaster 

folder on your hard drive. It is recommended that you create your own bin 

within the FX bin to contain the effects you render. You can then either ren-

der your effect directly into this bin or copy and paste it into the bin when it 
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is complete. When your effect has finished rendering, you can run the 

GlobeCaster Switcher, open your bin and double-click the effect to load it. 

Hit the spacebar or drag the T-Bar control to play your effect. Remember to 

unload your effects periodically or you will run out of memory. To do this, 

right-click on the FX pane and select Unload All effects.

The GrangerFX plug-ins use a series of folders to organize all effect files. 

For more information see the GrangerFX manual.
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Transporter

27.0 Introduction

Transporter is a standalone application that is designed to translate 3D 

geometry from one file format to another. Transporter runs on Mac OS 9, 

OS X and under Windows.

27.1 Import Model Settings

After launching Transporter, the Import Model Settings dialog will open. 

This is where you make decisions about how Transporter will process the 

imported model file.

 

Figure 27.0 — Transporter Import Model Settings
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Format:  Transporter can import models in 29 different file formats.

Set the format pull down menu before bringing in the file or leave it set to 

Automatic if you want Transporter to look inside the file and determine its 

format.

Combine Multiple Groups Into One Group:  Turn on this check box to 

merge all the groups in the file into a single group.

Combine Duplicate Polygons:  When this check box is on during import, 

the file is searched for polygons that occupy the exact same space. This can 

be a useful feature if the model is exhibiting rendering anomalies.

Combine Coordinates:  This feature is used to ensure that polygons which 

share edges also share vertices. You can also use this feature to seal vertices, 

Figure 27.1 — Import File Formats
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that is, to weld points together that fall within the tolerance shown in the 

Distance edit box to the right of the check box. 

Fix Smooth Shading:  This determines the angle at which a hard edge 

appears between polygons. This feature is often called the “Shading 

Angle”. If the angle is greater than the value in the Angle edit box, the poly-

gon will shade as a hard edge. If the angle is less than the value in the 

Angle edit box, the edge will smooth shade. 

Fix Cone Point Shading:  When turned on, the apex of cones is adjusted so 

that cones and cone-like shapes will shade correctly (if not enabled, seams 

can appear). If your data contains one or more cone-like entities, you may 

wish to turn this option on. Most models do not need this option so it 

defaults off.

Flat Complex Polygons:  This can prevent shading artifacts from appear-

ing in models that have more than for vertices per polygon.

Normals:  You can use the normals that are in the file (Leave Unchanged) 

or ask Transporter to recompute all normals (Force Normal Recalculation).

Merge Co-Planar Polygons:  This causes Transporter to sort through the 

polygons in the file, locating all co-planar polygons (polygons which lie on 

the same plane) and fuse them together, forming one complex polygon. 

The Max. Deviation Angle edit box will tell Transporter what tolerance to 

use when determining whether or not polygons are co-planar.

Match Colors:  When on, polygons with different colors will not be merged 

when using the Merge Co-Planar Polygons option.

Match Edges:  When on, both ends of an edge must share points before the 

two polygons will be merged. When off, two polygons will be merged if 

they share only one point and part of one edge.
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Merge Co-Incident Edges:  This forces edges which fall into the tolerance 

indicated in the Max. Polygon deviation angle edit box to merge. For exam-

ple, a polygon with three points in a row on a straight edge would lose the 

middle point.

Process File(s):  Click on this button to display a file dialog box. You can 

choose one or more files to import. 

27.2 Export Settings

After the model is imported, the Export Model Settings dialog box opens. 

This window displays the model in 3D, has statistics about the model and 

has a variety of options you can use when exporting the model file.

Figure 27.2 — Transporter Export Model Settings
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3D View:  This part of the Export Dialog displays the model using 

OpenGL. The same shortcuts that work in Animator’s Camera View win-

dow for orbiting, panning and zooming work in the 3D View. In addition to 

these, there are some shortcuts specific to Transporter. 

Press the W key to alternate the display between Gouraud, Flat and Wire-

frame shading. Press the N key to alternate between display of Vertex Nor-

mals, Polygon Normals and no normal display.

Model Statistics:  This area of the dialog displays basic information about 

the model after it has been processed using the import settings.

Modify Coordinates (X<->Y, etc.):  These options will re-orient the model 

data. Not by changing the view window’s orientation but by changing the 

model data. X<->Y stands for “Exchange the X and Y axis”. 

AutoCAD DXF data often comes in to Transporter with the rear of the 

model pointing forwards, and the right and left sides swapped. to correct 

this, you click on the Negate X and Negate Z buttons.

Invert Normals:  Clicking this button will reverse the direction of the 

model’s normals. This is useful if the model appears backwards or “inside 

out” in the display window
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Format:  This sets the file format that will be used when the model is 

exported. There are 14 different file formats to choose from.

Display Breakup:  This shows the process used to break up complex poly-

gons as the file is exported. Transporter will stop and beep if it runs into 

any problems breaking up complex polygons. It will then wait for you to 

hit the spacebar before continuing

Note: This is a legacy feature and is not recommended. 

Display Breakup:  Transporter will wait for a mouse click to advance the 

breakup process on a polygon-by-polygon basis. This feature is only active 

if the Display Breakup check box is on.

Note: This is a legacy feature and is not recommended.

Output Points:  Allows the saved model file to contain points not associ-

ated with polygons. When off, point data is not exported. Turn this feature 

on if you are trying to process particle data or any other form of point 

cloud.

Output Lines:  Allows the saved model file to contain lines. When off, lines 

are not exported.

Figure 27.3 — Transporter Export Formats
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Output Polygons:  Allows polygons to be exported. This is rarely turned 

off, but you might wish to if you need to filter polygons out of a model file 

containing a point cloud.

Output Vertices as Points:  Generates points at every vertex contained 

within the model file. This can be used to turn a polygon model into a point 

cloud. 

Output Edges as Lines:  This adds lines to the model file at the edges of all 

of the polygons. It could be used to simulate grill work around transparent 

objects. Also, if you were to turn off all other output options but this one, 

the result would be a true wireframe representation of the model. Since two 

lines will be generated whenever two polygons share an edge, the wire-

frame can be simplified by re-importing the model with the Combine Poly-

gons option turned on.

Breakup Concave Polygons:  This option forces polygons that are concave 

to be broken into a series of smaller, convex polygons. Since Camera can 

only render convex polygons, this feature can be used to fix polygons that 

don’t seem to render correctly.

Side Limit:  Sets the maximum number of edges or sides of the exported 

polygons. If you enter 0, the maximum number of sides supported by the 

export format chosen will be used.

Export Model:  Opens the save file dialog box which begins the model 

export process.
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27.3 Transporter Preferences

Transporter’s preferences can be opened by choosing Preferences... from 

the main menu. 

Model Buffer Size (bytes):  This controls how much memory that Trans-

porter will allocate under OS X and Windows. Valid numbers are between 

10000000 (10MB) and 2000000000 (2GB). 

Figure 27.4 — Transporter Preferences
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3DMF Tessellation Options

Override Tessellation Settings:  3DMF models can contain information 

describing how they should be tessellated (broken up into polygons). 

Enabling this feature causes Transporter to replace these built-in settings 

with either the Fixed or Adaptive settings below.

Fixed Tessellation:  This option breaks up the surfaces evenly by the num-

ber of steps show in the U and V edit boxes. If the model does not seem to 

have enough polygons when you export it, you can increase the mesh den-

sity by increasing the value of U and V.

Adaptive Tessellation:  This option breaks up the surfaces according to 

their curvature, providing more polygons in the curved portions of the sur-

face and less in the flat portions. If the breakup seems to be creating too few 

polygons or if the object’s curvature does not seem to be preserved, make 

the value in the Tolerance edit box smaller.

Alias Sketch Import Option

Surface Edges:  This edit box contains the number of edges to use when 

breaking up splines and patches imported from an Alias Sketch file.

DXF Import Options

Build Groups From Layers:  AutoCAD organizes drawings in layers. Each 

layer has a separate color assigned to it. Elements in layers can also have 

different colors other than the layer color. Layers can also contain blocks. 

Blocks are user-defined containers which hold any element type that can be 

created in AutoCAD. Since Transporter follows the Autodesk guidelines 

for DXF, the default settings function as if the DXF file to be imported was 
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created by AutoCAD. Therefore, since the comparable EIAS FACT file 

structure for an AutoCAD layer is the group, Build Groups From Layers is 

the default setting.

Build Groups From Blocks:  AutoCAD allows you to create block struc-

tures in a drawing file. Normally, when Transporter reads the DXF file and 

creates the FACT file, blocks are added to the layers in which they were 

inserted when the drawing was created within the AutoCAD program. 

However, some programs do not follow the Autodesk convention when it 

comes to assigning blocks and layers. Instead, these programs create the 

group structure out of blocks rather than layers. Choose this option if you 

wish to create FACT file groups from blocks instead of layers.

Note that any layer information will be discarded if this option is selected, 

and any unblocked entities in the DXF file will be added to a single group.

Build Groups From Colors:  Any entity in AutoCAD can have a unique 

color. AutoCAD supports 256 different entity colors. You can use these col-

ors to create separate groups within the exported file. Since AutoCAD itself 

provides enough versatility for object grouping and creation, you would 

probably not wish to use this option when importing DXF file that were 

created with AutoCAD itself. However, some programs which output DXF 

files may have a limited group capability, but allow many colors. This 

option lets you take advantage of this situation and will treat entities with 

separate colors as separate groups.

Note that no layer or block information will be considered if this option is 

selected.

Convert Polylines to Lines:  All polylines in the DXF file will be converted 

to lines.
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Convert Polylines to Polygons:  Converts any polylines in the DXF file 

into polygons. In AutoCAD, polylines are not used to describe actual sur-

faces. Instead, they may be used as boundaries from which surfaces can be 

created using any number of surface entities. Older versions of AutoCAD 

couldn’t support polygons with more than four sides. Some programs 

wrote out more complex polygons as a series of polylines as a way of over-

coming this limitation.

Convert Polylines to Automatic:  When this is selected, Transporter will 

automatically decide convert polylines to either lines or polygons based on 

compatibility with the output format you have chosen. 

Exchange Y and Z Coordinates:  This corrects for the difference in the 

coordinate space between AutoCAD and EIAS. 

DXF Export Options

Text Format:  DXF is a text file format. Each line can be terminated with 

either a Carriage Return (CR) or and Carriage Return (CR) and a Line Feed 

(LF). Most applications can handle either termination, but some do not and 

the Text Format options can be used to choose a specific termination tech-

nique.

Output Polygons as 3DFACE:  Polygons will be written to the DXF file 

using the 3DFACE entity type.

Output Polygons as POLYLINE:  Polygons will be written to the DXF file 
using muti-sided POLYLINE entities. Although this is not strictly “legal” in 
AutoCAD, many other 3D programs use this technique to store complex 
polygons. 
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Output Polygons as Poly Mesh:  Polygons will be written to the DXF file 

using the Poly Mesh entity type.

Decimal Digits:  This edit box controls how many digits to the right of the 

decimal place are written into the output file.

Exchange Y and Z Coordinates:  This corrects for the difference in the 

coordinate space between AutoCAD and EIAS. 

Model View Key Settings

If you are not satisfied with the shortcut keys used in the 3D View window, 

you can change them here. Use the check boxes and pull down menus to 

set any key combinations you desire.
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Shaders

28.0 Introduction

Procedural shaders are little “C” or “C++” language programs which EIAS 

Camera can use to shaded pixels with a variety of effects. Well written 

shaders are typically very fast and efficient.

Shaders can be added to any material channel you choose (diffuse, specu-

lar, etc.) they will affect this channel and may optionally affect several oth-

ers as well (shaders do not perform displacements at this time.) Most often, 

you will add the shader to the diffuse channel. Shaders are located in the EI 

Shaders folder, in the same directory that EIAS Animator is installed.

The shaders have animation parameters. The numeric entry boxes and the 

colors can be animated to create some very striking effects. (As an example, 

add the Cammo shader to a teapot and animate the Density value over 

time). Note — Changes you make in these interfaces are made at the current 

project time. To prevent unwanted texture animation, disable the animation flag 

for the texture map item for the group in the Project Window.

A shader is added to a material channel using the add button in the Mate-

rial Info Window. Once added, you can double-click on the shader to bring 

up its Texture Info Window. Under the Special Tab you will find two new 

buttons: Procedural... and Save Procedural as... The Procedural button 

brings up the interfaces shown in the rest of this chapter. The Save Proce-

dural As button saves a copy of the procedural with the current settings as 

default. This means you can create a shader with unique set of parameters 

that you like and save it out with those parameters imbedded in it. 
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Some procedural shaders are designed to work as 2D projections, others as 

3D projections. Those that work in 2D will appear to stretch along the 

depth of the projection. Also, some shaders are not anti-aliased within the 

shader. You can increase the group sampling to 2x2 to compensate.

Working with Procedural Shaders

All of the interfaces presented for each shader are simple dialog boxes, list-

ing parameters and values, plus a shader preview area. The preview area 

fits within the face of the cubic projection that EIAS Animator supplies for 

procedural shaders. Whatever you see in your preview, will be what you 

see in the area occupied by the face of the cube, with one caveat: the cubic 

projection must be equilateral, that is, the scales of the X, Y, and Z axes 

must be the same. If not, the procedural will appear distorted by the 

amount of the scale values. The position of the shader is also influenced by 

the position of the cubic projection icon. You can use this to fine tune proce-

dural placement if necessary.

You can also adjust the “lighting” in the shader preview area by clicking 

the location in the preview area that you would like to see the light shine 

on the preview (it defaults to the top right of the preview area.) This can 

Figure 28.0 — Relationship of Preview Area to Cubic Projection Icon
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help you to get a better feel for the look of the shader before you render. 

Some shaders can generate holes in surfaces. The preview area will show a 

non-rendering checkerboard in that case.

You can set color values to alpha 0.0 to use the diffuse color of the group for 

that component, instead of the color swatch. Some shaders, such as Ran-

dom Dots, do this automatically.

In addition to the procedural shaders that come with EIAS, our web site 

has a comprehensive list of shaders available from 3rd parties.
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Anisotropic
This shader allows you to specify a non-circular shaped highlight. It will 

even let you define different layers of highlights, so that you can easily sim-

ulate things such as a car paint finish, which is actually a color coat of paint 

(which has a grain, and therefore a highlight direction and shape that is not 

circular) underneath a clear coat (which has a more conventional high-

light.) In addition to multiple layers, you can also choose preset patterns 

which mimic that way that bare metal is finished with machine tooling. The 

results of this shader are quite stunning, and fast, too. 

This shader affects only the Specular channel regardless of which channel it 

is placed into.

Figure 28.1 — Anisotropic Shader Interface
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First and Second Anisotropic Layer Options

Pattern. There are several anisotropic patterns to choose from: None, Lin-

ear, Radial, Square, Scalloped, and Braided. Each of these options will show 

in the preview window of the shader interface.

Size. This is the size of the pattern. You may want to make the square, scal-

loped or braided patterns different sizes depending on the size of your 

objects.

Center. This is the center of the pattern, which can be moved to a different 

location.

Color Each layer has a separate color option. They are for the color of the 

anisotropic pattern or separate specular highlight.

Isotropic Layer

In this layer, you can choose the color of an extra specular highlights, as 

well as what kind.

Blinn. A blinn highlight is similar, except that the shape of the highlights 

take into account the light hitting the surface more accurately.

Phong. A phong highlight will look round and bright like those you might 

see on a billiard ball.
EIAS Animator        749



Chapter 28  Shaders — Bricks
Bricks
This 2D shader creates a brick pattern on any group it is added to. 

Apply only to the Diffuse Channel. Will affect the Diffuse, Bump, and Spec-

ular Channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Brick Width. The width of each brick. A value of 1.0 will yield bricks as 

wide as preview window.

Brick Height . The height of each brick. A value of 1.0 will yield bricks as 

high as preview window.

Mortar Thickness . The width and height of the mortar that separates the 

brick.

Mortar Depth. The mortar is an inset procedural bump. This controls how 

deep it is.

Figure 28.2 — Bricks Shader Interface
750       EIAS Animator   



Chapter 28  Shaders — Bricks
Row Vary. Controls brick alignment. If set to 0.0, the alignment between 

alternate rows of bricks will be perfect.

Jagged. Larger numbers than the default will cause extreme variation of 

the height and length of the bricks in a wave like fashion.

Brick Pit Frequency. The bricks themselves have a rough surface due to a 

procedural bump. This value controls the number of pits on each brick sur-

face. Useful values are between.001 and.009.

Brick Pit Depth. Controls the depth of the pits on the surface of the bricks. 

Useful values are between.01 and.0001.

Mortar Pit Frequency. The mortar also has a rough surface due to a proce-

dural bump. Useful values are between.0001 and.0009.

Mortar Pit Depth. Controls the depth of the pits in the mortar. Useful val-

ues are between.0001 and.0009.

Brick Vary . This controls the color variation of the bricks. Useful values 

are between 0 and 1.

Brick Color. The RGB color of the bricks.

Mortar Color. The RGB color of the mortar.

Ks. The Specular value for the Bricks and Mortar. 0 is no specular, 1 is max-

imum specular.
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Bump Array
This 3D shader creates an array of dimples. Could be used for the surface of 

a golf ball or for metal floor plating. It is also useful for creating a pattern of 

round holes in an object, like the lid of the original Star Trek communicator. 

Apply the shader to the Transparency Channel with a Density of 10.0 and 

the Bump Color set to black. 

Will affect the channel in which it is applied and the Bump/Diffuse Chan-

nel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Hex Grid. Realigns the bumps in a hexagonal pattern. It defaults to on.

Radius. Controls the radius of the bumps. 

Spacing. Controls the distance between each bump. This number can be set 

small to cause the bumps to overlap.

Bump Blend. Distance over which the bumps blend together. Smoothes 

over transitions when the bumps overlap.

Figure 28.3 — Bump Array Shader
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Bump Strength. Controls the magnitude of the bump, how deep or high it 

is. Can be positive or negative.

Bump Color. The RGB color of the bumped area.

Surface Color. Sets the RGB value of the surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.
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Bumpy Noise
This 3D shader creates a bumpy, noisy pattern. Could be used for alien 

flesh. 

Will affect the channel it is applied to and Bump Channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Bump Strength. Controls the magnitude of the bumps on the surface. Use-

ful range is -5.0 to 5.0

Color Threshold. Changes where the color blend begins between Bump 

Color and Surface Color. 0.5 is right in the middle of the bump, 1.0 is right 

at the top of bump.

Color Range. Controls the variation in color between the lowest and high-

est points on the surface. Useful range is between 0 and 10.

Bump Color.  The RGB color of the bumped area.

Surface Color.  Sets the RGB value of the surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.

Figure 28.4 — Bump Noise Shader
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Cammo
This is a camouflage 3D shader and is loosely patterned after the standard 

US “Woodland” pattern. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Surface Color. Sets the RGB value of the underlying surface. The three 

Cammo regions are applied on to of this surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead. There are three different regions added on top of the 

surface color. They each have the following controls.

Scale. Controls the size of the pieces that make up the region.

Level. Controls how much of the Surface color shows through the region. 

0.0 allows all of the surface color to show through. 1.0 allows none at all.

Color. RGB color of the region.

Figure 28.5 — Cammo Shader
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Cel Look
This shader is neither a 2D or 3D shader, but rather an illumination shader 

which gives a cartoon-like appearance to the groups it is applied to. The 

defaults have been picked to work well. You may wish to try it, as is, before 

changing any of the values in the interface. The shader will automatically 

pick up the diffuse color of the object. Therefore, you don’t have to change 

the color values in the shader for each object you use it with. 

Apply to the Diffuse Channel, will affect Diffuse and Specular.

Highlight. If this option is on, the highlight (specular) is operated on by the 

shader.

Specular Range Min/Max. Specular is always in the range of 0 to 1. 0 is no 

specular, 1 is 100% specular. As the object is shaded, pixels with a specular 

value below the Min get no specular highlight at all. Pixels greater than the 

Max get the color in the specular channel of the group after being pro-

cessed by the Brightness and Saturation values. Between the Min and Max, 

the color is ramped.

Figure 28.6 — Cel Shader
756       EIAS Animator   



Chapter 28  Shaders — Cel Look
Brightness. Varies the brightness of the computed highlight.

Saturation. Varies the saturation of the computed highlight.

Color. When on, the color chosen using the swatch is used instead of the 

group’s specular color.

Zones. Sets the number of different colors that will be used to shade the 

group. 

Diffuse Range Min/Max. If the brightness of the pixel being shaded falls 

into this range, the objects diffuse color is multiplied by the Brightness 

value and applied. If the brightness falls in between ranges (as in the case 

of 0.42, using the numbers in the illustration), the color is ramped.

Brightness. The factor by which the diffuse color is multiplied to yield the 

final pixel color.

Color. If the brightness of the pixel being shaded falls into Min/Max range 

for this Zone, the object’s diffuse color is replaced by this color.

Account for Light Colors. If this option is on, the highlight and the diffuse 

colors of the shader are effected by scene lighting, otherwise the colors of 

the group will match the swatches in the shader.
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Checker Board
This shader can be either 2D or 3D, and places a checkerboard pattern on 

the surface of the group. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Color1&2. RGB color of the alternating squares.

3D Checker. Makes the procedural act as a solid shader. The checkerboard 

pattern will repeat throughout the group.

Figure 28.7 — Checker Board Shader
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Clouds
This 3D shader creates a cloud-like fractal pattern. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Cloud Threshold. Controls how many cloud puffs are present. Useful 

range is 2.0 to 0.0.

Cloud Range . Controls the density of the clouds. Useful range is 10.0 to 0.0

Cloud Color. RGB color of the clouds.

Sky Color. RGB color of the area not covered by clouds.

Figure 28.8 — Clouds Shader
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Color Noise
This 3D shader creates a psychedelic color pattern, similar to tye-dye. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Figure 28.9 — Color Noise Shader
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Contour
This shader creates a grid pattern on the object. The grid lines themselves 

have explicit control for visibility. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out (seeing more of the grid), smaller to zooming in 

(seeing less of the grid). The default is 1.0.

Line Thickness. Sets the thickness of the grid lines. The default is 0.2 

Smaller numbers produce thinner lines.

X,Y,Z Contours. These check boxes give you explicit controls over the visi-

bility of each of the axis lines. 

X,Y,Z. Offsets the grid pattern in the direction specified. Very useful when 

the 3D Grid check box is on as you might find the Z position of the grid 

leaves you right in the middle of a line.

Grid Color. Sets the RGB color of the lines.

Figure 28.10 — Contour Shader Interface
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Surface Color. Sets the RGB value of the underlying surface. You can set 

the alpha to 0.0 to let the object’s diffuse color, or the next texture map in 

the diffuse list, come through instead.
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Crumple
This 3D shader creates a bumpy pattern on an object very similar to crum-

pled aluminum foil. 

Will affect the channel in which it is applied and Bump channels.This shader 

is not anti-aliased, so use additional group sampling as needed.

Noise Level. Controls how many iterations of noise are computed for the 

shader. Each successive iteration is half the size of the previous one. More 

Levels require more rendering time.

Noise Scale. Sets the height at which the High Color is drawn. 

Noise Factor. Each successive level of noise gets smaller by this amount.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Bump Scale. Sets the magnitude of the bump. Can be negated to invert the 

crumple effect.

Bump Factor. At each successive level of noise is computed the bumps get 

smaller by this amount.

Figure 28.11 — Crumple Shader
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Animation. Animates the noise pattern over time. A value of 1.0 moves the 

noise 1 unit of the preview square per second. This can be used to create 

animated water effects. Try doing this by animating the Z value for the 

shader applied to a flat plane.

High Color. Sets the RGB value of the surface at the top of the bumps. You 

can set the alpha to 0.0 to let the object’s diffuse color, or the next texture 

map in the diffuse list, come through instead.

Low Color. Sets the RGB value of the surface at the bottom of the bumps. 

You can set the alpha to 0.0 to let the object’s diffuse color, or the next tex-

ture map in the diffuse list, come through instead.
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Crust
This 3D shader creates a series of high, flat ledges. 

Will affect the channel in which it is applied and Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Coverage. Controls the region that the Crust Color covers. 0.0 yields no 

Crust Color. 1.0 will cause the Crust Color to cover the entire procedural.

Ledge Level. Controls how far the ledges spread out across the surface of 

the crust.

Ledge Width. Sets the widths of the ledges.

Bump Strength. Sets the magnitude of the bump for the ledges. Values can 

be either positive or negative.

Crust Color. Sets the RGB value of the ledges.

Surface Color. Sets the RGB value of the surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.

Figure 28.12 — Crust Shader
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Cyclone
This 3D shader creates a vortex pattern. The effect is quite startling when 

applied to the Transparency Channel. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Cyclone Radius. The radius of the main body of the swirling vortex. This 

value manages the apparent “strength” of the vortex. The default value of 

is 1.0, giving a decent looking vortex. Smaller numbers will impart less 

energy to the vortex, effectively weakening it. A value of 0.0 will look like 

smoke, rather than a cyclone. Likewise, values of over 5.0 will have a simi-

lar effect.

Eye Radius. The radius of the eye at the center of the vortex. 0.5 corre-

sponds to the width of the preview window.

Twist. Sets the number of revolutions the vortex makes within the width of 

the preview window

Figure 28.13 — Cyclone Shader
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Scale. Sets the magnitude of the amount of clouds created in the vortex. 

Small changes in this value can vary the look of the effect significantly.

Offset. Can be used to make the overall effect more misty.

Omega. Increases the choppiness of the clouds. Useful range is between 0.0 

to 1.0, with 1.0 being more choppy than 0.0.

Octaves. Controls the detail of the noise function. Useful range is 1 to 8.

Contrast. Lower numbers decrease the contrast between Color1 and 

Color2.

S Noise. A noise seed. Can be used to vary the look of the cyclone. 

D Noise. A noise seed. Can be used to vary the look of the cyclone.

Color1. Sets the RGB value of the region not part of the swirling vortex.

Color2. Sets the RGB value of the clouds in the vortex.
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Dots
This 3D shader makes a grid of dots on the surface of the object. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, adding more dots, smaller to zooming in, 

removing dots. The default is 1.0.

Dot Diameter. Diameter of the dots. A diameter of 1.0 fills the preview 

window at a density of 1.0. 

Fuzzy Edge Width. Sets a region around the dot to blur slightly. Makes a 

nicer transition from the surface to the dots.

Dot Color. The RGB color of the dots.

Surface Color. Sets the RGB value of the surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.

Figure 28.14 — Dots Shader
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Eroded
This 3D shader puts dents and holes in the surface of an object. (The shader 

uses a black and white checker pattern in the preview area to denote actual 

holes that will be visible through the material — the pattern does not ren-

der.) 

Will affect the channel in which it is applied and the Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Bump Strength. The magnitude of the bump applied to the dented por-

tions of the surface. Can be a negative number.

Erode Holes. When on, holes are actually cut through the surface. When 

off, areas that represent holes are shaded with the Hole Color.

Hole Min. The surface of the object is represented by a value of 0 to 1. 

Where 0 is the bottom of the deepest hole. Hole min sets the range over 

which holes occur on the object. In the default case, holes appear between 

0.3 and 0.4

Hole Max. The surface of the object is represented by a value of 0 to 1. 

Where 1 is the top of the surface. Hole max sets the range over which holes 

Figure 28.15 — Eroded Shader
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occur on the object. In the default case, holes won’t appear between 0.4 and 

1.0. Between 0.3 and 0.4 there is a ramp wherein the surface transitions 

nicely into the hole.

Hole Color. RGB value of the color applied to the holes when the Erode 

Holes flag is off.

Surface Color. Sets the RGB value of the surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.
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Flame
This 3D shader creates a fire-like color pattern. You may want to re-align 

the cubic projection icon to bottom or top, as the preview shader is present-

ing the flames to you in that orientation. (This shader does not animate the 

flame effect.) 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Distortion. Scales the combination of all noise functions. Larger numbers 

will yield many smaller regions of flame. Useful values are in the range of 0 

to 1.

Chaos Scale. Scales the color temperature of the shader. Larger numbers 

are hotter.

Figure 28.16 — Flame Shader
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Chaos Offset. Increases the color temperature of the shader (default is 0.0.) 

Larger numbers are hotter. Numbers over 1.5 tend to “burn out” the shader 

and are not very useful.

Flame Height. If set to 0.0 (the default), this shader behaves as a 2D shader. 

If a height is provided, the colors will vary as the height of the object 

changes. Apply to the top of a cube and enter in a height value. When you 

render the side of the cube, you will see the colors creeping up.

Flame Amplitude. Scales the flame temperature based on the height.

Lacunarity. Sets the gaps (dark areas) between the regions of flame in the 

preview window. By setting the colors of the coolest regions to Alpha 0.0 in 

the color picker, you can see the group’s diffuse color through the gaps.

S Noise Scale. Acts as a noise seed to vary the look of the flame.

D Noise Scale. Acts as a noise seed to vary the look of the flame.

Octaves. Sets the fractal complexity of the shader. Useful values range 

between 1 and 7.

Colors. Sets the number of colors, from the list of colors on the left, to use 

when creating the procedural effect.
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Fractal Noise
This 3D shader creates a fractal-based noise pattern. 

Will affect the channel in which it is applied and the Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Noise Level. Controls the complexity of the noise. Useful range is 0 to 8

Noise Factor. Higher numbers produce a rougher surface, smaller number 

a smoother surface.

Bump Strength.  Sets the magnitude of the bump. Can be negated.

Bump Factor. With each successive noise level calculation, bumps get 

smaller by this factor.

Sharpen Bumps. Takes the highest point and makes it rougher, takes the 

lowest point and makes it softer. Good for making the bumps nice and 

craggy.

Color Factor. Sets the point where the shader switches from the High Color 

to the Low Color. Higher numbers will completely eliminate the Low 

Color.

Figure 28.17 — Fractal Noise Shader
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Sharpness. Larger numbers increase the contrast between the High and 

Low Colors

High Color. Sets the RGB value of the surface at the top of the bumps. You 

can set the alpha to 0.0 to let the object’s diffuse color, or the next texture 

map in the diffuse list, come through instead.

Low Color. Sets the RGB value of the surface at the bottom of the bumps. 

You can set the alpha to 0.0 to let the object’s diffuse color, or the next tex-

ture map in the diffuse list, come through instead.
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Gooch
This shader renders an object with a hue and value shift rather than tradi-

tional phong shading. This produces a more “illustration” style of shading. 

This look is very useful for technical illustrations and produces an artistic, 

rather than photo-realistic, representation of the object. The user can con-

trol the cool and warm colors of the shading, as well as how the shading 

threshold will behave. 

This shader affects the Diffuse, Specular and Reflectivity channels. Apply is 

to the Diffuse channel.

Cool Color. The cool color of a gooch shaded model, is a color that is not 

highlighted with a specular hit or is in shadow.

Warm Color. The warm color of a gooch shaded model, is a color that is 

highlighted with a specular hit, or with bright lighting.

Alpha. Alpha is the prominence of the object color and Beta is the strength 

of the color shift.

Beta. Beta is the strength of the color shift.

Figure 28.18 — Gooch Shader
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Granite
This 3D shader creates a granite rock appearance. 

Apply this shader only to the Diffuse Channel. Will affect the Diffuse and 

Specular Channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.\

ks1. The Specular value for the region colored by Color1. 1.0 is max, 0.0 is 

no specular

ks2. The Specular value for the region colored by Color2. 1.0 is max, 0.0 is 

no specular

Color1. The RGB value for the underlying color of the granite rock.

Color2.  The RGB value for the colored pieces that mix in with the granite 

rock.

Figure 28.19 — Granite Shader
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Grid
This shader creates a 2D or 3D grid of lines. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out (seeing more of the grid), smaller to zooming in 

(seeing less of the grid). The default is 1.0.

3D Grid. Makes the shader work in 3D space. 

X,Y,Z. Offsets the grid pattern in the direction specified. Very useful when 

the 3D Grid check box is on as you might find the Z position of the grid 

leaves you right in the middle of a line.

Line Thickness. Sets the thickness of the grid lines. The default is.2 Smaller 

numbers produce thinner lines.

Grid Color. Sets the RGB color of the lines.

Surface Color. Sets the RGB value of the underlying surface. You can set 

the alpha to 0.0 to let the object’s diffuse color, or the next texture map in 

the diffuse list, come through instead.

Figure 28.20 — Grid Shader
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Hex Tile
This 2D shader creates a hexagonal pattern of terra cotta tiles. Perfect for 

your patio or mud room. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Tile Radius. Sets the size of the tiles. 1.0 represents one full tile in the pre-

view window.

Mortar Width. Sets the width of the mortar between the tiles. Useful range 

is 0.0 to 0.3

Tile Vary. Allows subtle variations in the color of the tiles. Useful range is 

0.0 to 1.0

Scuffing. Sets the darkness of the scuff marks on the surface of the tiles. 

Useful range is 0.0 to 5.0

Figure 28.21 — Hex Tile Shader
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Stains. Creates separate stained areas using the Scuff color. Useful range is 

0.0 to 5.0

Stain Frequency. Controls the size of the stained areas. Larger numbers 

create smaller stains.

Scuff Frequency. Controls the size of the scuff marks. Larger numbers cre-

ate smaller marks.

Tile Color. Sets the RGB value of the tiles

Mortar Color. Sets the RGB value of the mortar between the tiles.

Scuff Color. Sets the RGB value of the scuff marks on top of the tile.
EIAS Animator        779



Chapter 28  Shaders — Marble
Marble
This 3D shader creates a marble-line surface for rocks, pillars, temples, etc. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Frequencies. Controls the number of separate veins that appear in the mar-

ble. The default is 8 and you can see 8 distinct black veins running through 

the marble in the preview window.

Turbulence. Sets the waviness of the veins. Larger numbers yield more 

waviness.

Noise Factor. Affects the variation of the veins along their length. Useful 

values are in the range of 0.0 to 1.0

Vein Spacing. Controls the distance from one vein to the next.

Vein Sharpness. Controls the sharpness and apparent width of the veins.

Figure 28.22 — Marble Shader
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Colors. Controls how many of the colors on the left side of the interface are 

used to shade the marble. (Color number 1 defaults to alpha 0.0, allowing the 

diffuse color of the group to show through.)
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Oren-Nayer
The Oren-Nayer shader is rough surface BRDF shader which more accu-

rately shades surfaces which scatter a lot of light, such as unglazed ceram-

ics fabric, terra-cotta, suede, clay, human skin and so on. It can add a 

softness and richness that typical phong shading lacks. 

This shader affects the Diffuse, Specular, and Reflection Channels only. 

Apply only to the diffuse channel.

Roughness. This option basically sets how bumpy or porous an object is. 

For example skin, is a smooth surface but close inspection shows micro-

scopic ridges all over the surface, so it’s roughness is fairly high. On the 

other hand, a glass object, or glossy painted surface is extremely smooth, so 

it’s roughness is very low.

Specular. Like the specular section for the anisotropic shader the option for 

a Phong or Blinn type highlight can be chosen.

Figure 28.23 — Oren-Nayer Shader
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Pearl
This shader produces a “pearlescent” sheen on an object. Simulating effects 

like mother of pearl or pearl coats of paint are accomplished with this 

shader. It works by allowing the user to adjust the reflected red, green and 

blue wavelengths of light coming from an illuminated object with this 

shader applied. A noise factor can also be applied. 

This shader affects Diffuse, Specular and Reflection channels only. Apply 

only to the Diffuse channel.

Wavelength. This shader allows you to assign Red, Green and Blue wave-

lengths to apply to the object. A very small margin of color from each of 

these wavelengths is then applied to the model.

Noise Factor. This is a control for the amount of deviation from the wave-

lengths assigned. A higher number will have a greater variety of colors.

Figure 28.24 — Pearl Shader
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Plank
This 3D shader creates a nice parquet-style wood pattern. Can be used to 

great effect on the floors of entry halls or on dance floors. Biases the specu-

lar highlight with the parquet pattern as well. Can also be used to simulate 

hardwood flooring.

Apply only to the Diffuse Channel. Will affect the Diffuse, Bump, and Spec-

ular channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Parquet Tile. Creates the parquet pattern of tiled wood. If off, long planks 

are created instead; perfect for hardwood floors.

Planks Per Tile. Number of individual wood slats that make up each tile.

Plank Length. Sets the length of the planks when the Parquet Tile flag is 

turned off.

Figure 28.25 — Plank Shader
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Plank Width. Sets the width of the tiles when the Parquet Tile flag is on. If 

the flag is off, it sets the width of the individual planks.

Groove Width. Sets the width of the grooves that separate the tiles from 

one another and the grooves that separate the planks within the tiles from 

one another.

Ring Scale. Larger number create more, tighter grain patterns in the 

planks.

Grain Scale. Larger number cause the grain patters to be thicker.

Plank Vary. Cause color variation in the individual planks. Useful range of 

values is 0.0 to 2.0.

Grainy. Sets the amount of grain in each plank. Larger numbers give you 

smaller grain.

Wavy. Larger numbers make the grain more wavy.

Light Wood. Sets The RGB color of the lightly colored planks.

Dark Wood. Sets The RGB color of the darkly colored planks.

Groove Color. Sets The RGB color of the grooves between the planks and 

tiles.

ks. Sets the specular for each of the areas. 0.0 is no specular. 1.0 is maxi-

mum specular.
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Random Dots
This 3D shader creates a pattern of randomly colored dots. Perfect for that 

summer dress. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in. Defaults to 1.0.

Dot Types. This value controls which of the 10 different dots are supported 

will be used by the shader, from top to bottom of the list as presented in the 

window.

Dot Color. Sets the color of each dot

Dot Size. Sets the maximum size of each dot. There is random variation in 

the size from the maximum down. 

Figure 28.26 — Random Dots
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Rust
This 3D shader creates a rusted surface pattern. The surface appears thick 

with areas eroded down to holes. 

Apply only to the Diffuse Channel. Will affect the Diffuse and Bump chan-

nels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Paint Level. Controls how deep into the surface the paint reaches.

Paint Bump. Sets the magnitude of the bumps on the painted surface. 

Paint Color. Sets the RGB value of the surface. You can set the alpha to 0.0 

to allow the underlying color or map to come through instead.

Rust Level. Sets the amount of the surface affected by the rust. 1.0 is all 

rusty, 0.0 is no rust at all.

Rust Bumps. Sets the magnitude of the bumps on the rusty surface.

Rust Color. Sets the RGB value of the rusted area.

Figure 28.27 — Rust Shader
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Hole Level. Sets the amount of the surface that becomes holes. 1.0 is all 

hole, 0.0 is no holes.
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Stucco
This 3D shader creates a stucco pattern using bumps. Great for adding a 

slight variation to interior and exterior walls. 

Will affect the channel in which it is applied and Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Sharpness. Controls the smoothness of the bumps. Smaller numbers are 

smoother, larger numbers sharper. Useful range is 0 to 10.0

Bump Strength. Sets the magnitude of the Bump. Can be positive or nega-

tive.

Color Factor. Controls the blend, and therefore the spread, of the Bump 

Color into the Surface Color. Larger numbers correspond to a larger spread.

Bump Color. Sets the RGB value of the bumps.

Surface Color. Sets the RGB value of the surface You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.

Figure 28.28 — Stucco Shader
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Thin Film
The Thin Film Shader is designed to provide the effects of a film-like coat-

ing above a surface. The most obvious examples would be the soap bubble, 

or oily puddle, however some new sunglass lenses also exhibit this same 

effect.

 This shader effects Diffuse and Reflection channels only. Apply it to the 

Diffuse channel.

Max Thickness. This option sets the thickness of the ‘film’ simulated by the 

shader. It is measured in angstroms, which is a very small unit of measure, 

one hundred millionth of a centimeter.

Wavelengths. The options for wavelengths are Red, Green and Blue set-

tings. A small band of color will then be used from each setting of the 

wavelengths.

Figure 28.29 — Thin Film Shader
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Refraction. This setting will allow the shader to have refraction inside its 

small space. This is different than refraction on of the object itself, as it is 

only affecting the thickness assigned to the shader.

Offset. The Offset option moves the shader through 3D space. Can offset 

the pattern on the model. 

Random. The Random function sets the random variable seed that controls 

the look of the pattern
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Veins
This 3D shader creates a series of polygonal shapes separated by grooves. 

Could be used for alien skin or even the surface of a cobblestone walkway. 

Will affect the Channel in which it is applied and Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Coverage. Controls the region that the Vein colors covers. 0.0 yields no Vein 

Color. 1.0 will cause the Vein Color to cover the entire procedural.

Ledge Level. Controls the height that the shapes rise above the veins

Ledge Width. Controls the width of the shapes

Bump Strength. The magnitude of the bump. Can be negative to cause the 

veins to rise above the shapes.

Vein Color. Sets the RGB value of the veins.

Surface Color. Sets the RGB value of the surface You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.

Figure 28.30 — Veins
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Waves
This 2D shader creates a pattern that can be used to simulate ripple effects. 

You can animate the waves, flowing outward at a rate controlled by the 

Wave Frequency. 

Affects the channel it is applied to and Bump channels.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Wave Source. Sets the number of sources that generate the waves. More 

sources give rise to complex interference patterns

Wave Range. Sets the distance between Wave Sources.

Wave Length.  Distance between the wave crests.

Wave Frequency. Number of units the rings move outward per second.

Bump Strength. The magnitude of the bump. Can be negative invert the 

wave.

Wave color. Sets the RGB value of the wave crests.

Figure 28.31 — Waves Shader
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Surface Color. Sets the RGB value of the surface You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.
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Wisp
This 3D shader creates a series of lightly drawn lines, as if a calligraphy pen 

had been used to draw on the surface. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Coverage. Sets the region that the Wisp Color covers. 0.0 yields no Wisp 

Color. 1.0 will cause the Wisp Color to cover the entire procedural.

Ledge Level. Larger numbers increase the number of lines that are drawn

Ledge Width. Smaller numbers increase the thickness of each line.

Wave Color. Sets the RGB value of the lines.

Surface Color.  Sets the RGB value of the surface You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead.

Figure 28.32 — Wisp Shader
EIAS Animator        795



Chapter 28  Shaders — Wood
Wood
This 3D shader creates a basic wood-like appearance. 

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Frequencies. Controls the number of separate grains that appear in the 

wood.

Turbulence. Sets the waviness of the grain. Larger numbers yield more 

waviness.

Noise Factor. Affects the variation of the grain along their length. Useful 

values are in the range of 0.0 to 1.0

Vein Spacing. Controls the distance from one vein to the next.

Vein Min. Controls the minimum width of the veins.

Vein Max. Controls the maximum width of the veins.

Figure 28.33 — Wood Shader
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Colors. Controls how many of the colors on the left side of the interface are 

used to shade the wood.
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NPR Shader Lite
This is a shader for Non-Photorealistic Rendering (NPR). It can be applied 

object by object or scene-wide using a camera map.

Paint. Use this menu to choose where the shader adds color. 

Shadow: Shader adds to the shadowed areas of objects.

Light: Shader adds color to the lit areas of objects.

None: Shader adds no color.

Figure 28.34 — NPR Shader Lite
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Type. Use this pull down menu to change the paint mode.

3Dlines: The shader will use lines to define the objects. These 3D lines, 

as opposed to the 2Dlines, will change their orientation based on the 

object’s shape. The line’s inclination can be controlled using the Direc-

tion parameters “nx”, “ny” and “nz”. The line size will change accord-

ing to the shadow-light gradient.

2Dlines: The shader will use lines to define the objects. The lines will 

not adapt to the object’s shape. The lines inclination can be controlled 

using the Direction parameters “nx”, “ny” and “nz”. The line size will 

change according to the shadow-light gradient.

Plain: The shader will place a plain color over the area to colorize. This 

mode is similar to a cartoon style.

Figure 28.35 — Shadow (L) and Light(R) Settings

Figure 28.36 — 3DLines(L) and 2DLines(R) Types
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Ink: The shader will place a plain color, but using a noise as an opacity 

modifier. This gives the illusion of wet zones on the canvas. The main 

“density” of this noise is also controlled by the Density parameter.

Pointillism: The shader will paint small dots. The dot’s density can be 

controlled using the Thickness parameter. Greater values create a 

denser dotted pattern and lower values a less dense pattern. The pat-

tern will also change based on the shadow-light gradient.

Charcoal Strokes: This paint type will simulate charcoal strokes. The 

charcoal lines will adapt to the object’s shape.

Figure 28.37 — Plain (L) and Ink(R) Types

Figure 28.38 — Pointillism (L) and Charcoalt(R) Types
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Density: Use this parameter to scale the whole shader at once. 

Pencil Control
Thickness:  The size of the stroke

CutOff:  How the pencil acts over the shadow-light area gradient. When 

using it with Shadow Mode, lower values will tend to paint less on light 

areas, while higher values will tend to invade light zones and paint on 

them. The reverse effect will take place when using Light Mode.

Threshold:  The threshold of the strokes changing along the shadow-light 

gradient areas.

Scale: Used to scale the whole effect. It will change the way the CutOff and 
the Threshold look.

Direction:  Use these three parameters to change the direction of 3Dlines, 

2Dlines and Charcoal Strokes. You can think of nx, ny and nz as vector 

directions in 3D space to change the direction of the strokes.

Pencil Color

Use:  This pull down menu presents different options to colorize the 

strokes:

Color: The Color Picker will be used to colorize the strokes.

Texture: The object’s texture colors will be used to colorize the strokes

Hue Agent: This mode will take the Hue of the Color Picker, while 

applying the Saturation and Value of the underlying object’s texture. 
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This mode allows you to use the Saturation and Value of a texture 

while painting with a plain color. It creates wonderful effects.

SV Agent: This mode will take the Saturation and Value of the Color 

Picker, while the Hue will be taken from the underlying object’s tex-

ture.

Light’s Color: This mode will use the color of the light sources used in 

the scene to paint.

Opacity:  The opacity of the stroke. Use this control to simulate the “pres-

sure” of a pencil on a canvas.

Blend:  Choose a blend mode for the whole shader effect.

Apply To

Use these controls to choose which render features you want to be used for 

the NPR rendering.

Diffuse C:  Choose the amount of Diffuse Color used in the rendering. 

From 0 to 1.0

Figure 28.39 — Color Using SV Agent
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Diffuse V:  Choose the amount of Diffuse Value used in the rendering. 

From 0 to 1.0

Specular:  Choose the amount of Specular used in the rendering. From 0 to 

1.0

Reflection:  Choose the amount of Reflection used in the rendering. From 0 

to 1.0

Luminance:  Choose the amount of Luminance used in the rendering. 

From 0 to 1.0

Background Controls
Use: This pull down menu will let you choose how the background is col-
orized. You have two options, Color and Texture. Color will use the 
selected color in the Color Picker, while Texture will use the underlying 
object’s texture. 

Silhouette controls

Use this group of controls to create a silhouette outline for the objects.

A Note about the silhouette: Use this feature with caution. The silhouette 

generated by the NPR shader will not look good on flat objects, like flat 

planes or cubes. However, it can look very good on curved objects.

Amount:  The amount of silhouette to draw. Note that the size will change 

depending on the object’s position and orientation; what could be good for 

some effects, may not suitable for others.
EIAS Animator        803



Chapter 28  Shaders — NPR Shader Lite
Use Menu:  This menu will let you choose how the silhouette is colorized. 

You have two options. Color and Texture. Color will use the selected color 

in the Color Picker, while Texture will use the underlying object’s texture.

Blend:  Choose a blend mode for the silhouette.

Opacity:  The opacity of the silhouette. 
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SpKiller
This shader is used to control the size and amount of the specular high-

lights that appear on the back side of ray traced transparent objects. 

Without it, a simple solid glass sphere, for example, will look like a shell or 

a skin made of glass because there will be a specular highlight created on 

the inside back face giving a hollow appearance.

Apply this shader to the diffuse channel.

Amount. Controls the intensity of the specular that appears on the back 

side of ray traced transparent objects.

Size. Controls the size of the specular that appears on the back side of ray 

traced transparent objects.

This shader modifies the behavior of ray traced transparencies. Phong 

transparencies will not be affected.

If multiple ray traced transparencies are in your scene, then please specify a 

refraction index greater 1.0 for all groups where SpKiller is applied. Other-

wise the front side will be affected in areas where transparent objects over-

lap.

Figure 28.40 — SpKiller Interface
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Gradient
This shader is used to create colored gradients. The gradient can vary 

between two to twelve colors. This shader can be applied to any material 

channel and will affect only the channel it is applied to.

Gradient Bar and Color Keys. The Gradient Bar displays the ramping col-

ors. The individual Color Keys can be dragged back and forth to adjust the 

ramp. Add a new Color Key by clicking in the Gradient Bar. Delete a Color 

Key by dragging it outside the bar (the last two keys cannot be deleted). 

Double click on the Color Key or just under it to open the color picker and 

edit the color assigned to the Key.

Amount. Acts as a multiplier to control the intensity of the gradient.

Smooth. Controls the smoothness of the color ramp.

Figure 28.41 — Gradient Interface

Gradient Bar
Color Key
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Source. This pull down menu controls the orientation of the shader on the 

surface of the object.

Texture X, Y, Z. The selected texture axis is used. 

View Edge. The direction perpendicular to the camera plane is used.

All Lights. An average of all lights is used.

Nth Light. The direction of the specified light is used. The Nth value of 

1 corresponds to the first light in the project.

Diffuse Bias. Multiplies the final color by the diffuse color. If the shader 

has been applied to the diffuse channel and another texture is below it in 

the texture list, then the color of that texture is used.

Figure 28.42 — Gradient Source—X, Y, Z

Figure 28.43 — Gradient Source—View Edge, All Lights, Nth Light
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Ignore Light(s) Intensity. This feature is useful when the shader is applied 

to the luminance channel. It causes the shader to use only the lights direc-

tion as an input. The lights’ intensities and colors are ignored.

Range Options. Simple control for the way the shader tiles over the surface 

of the object it is applied to.

Load and Save. You can save and load settings for the Gradient shader to 

disk.
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SimpleWave
SimpleWave is an auto-animated shader that produces an attenuated finite 

continuous wave. The wave continues flowing endlessly, attenuating until 

it reaches the maximum attenuation distance. It is also a reactive shader 

that outputs color, bump and displacement. Why a shader version of the 

Wave Deformation? Beyond personal tastes or the reactive ability that is 

more related to the shading realm, the shader version provides one simple 

advantage over the Deformations:  Depending on the situation, it does not 

need displacement and can work only with bump, thus saving lots of 

geometry and rendering time. There is also a second reason:  one can use a 

single-poly plane generated by Ubershape in Animator, and the same plane 

can be high-resolution in Camera. 

Figure 28.44 — Simple Wave Interface
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Size and Origin. These edit boxes set the size of the wave and its starting 

point in scene units. By making X and Y different, you can create ellipsoidal 

waves. 

These two parameters are closely related. Changing the Size of the Wave 

will affect also where the center is, because the shader changes the global 

density to allow the wave to be deformed. Even though this is not a big 

deal, take it into account when planning your animations. 

Note that you can set the origin of the wave “outside” the object on which 

the SimpleWave is applied. In this case, you will not see the waves origin, 

but get waves only. This is good when you want to place a bit of movement 

on your liquid, but you do not want a visible wave.

In the same way, if you make an ellipsoidal wave outside of the object, you 

will have the feeling of a more planar than circular wave.

Att. distance. The distance at which the waves will completely disappear.

Wave Force. The Force of the wave. It is a multiplier that will affect the 

wave’s color and bump.

Wave Speed. The speed of the wave. The default value is 1.0. Higher values 

will make the wave move faster, while lower values will make the wave 

move slower. A value of 0 will “freeze” the wave.

Bump. The amount of bump the wave generates.

Displacement. The amount of displacement of the wave: Use it with cau-

tion. Usually low values like 0.1 or similar are enough to get a good effect. 

Also, remember to have a high enough tessellation in order to get a good 

smooth displacement. 
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Colors. Clicking here opens the color picker. You can choose two different 

colors that will alternate on the surface of the wave.

Color Slide. Use this parameter to “slide” the color mix across the wave. 

This is very useful when you use the SimpleWave shader with other reac-

tive shaders and you intend to exactly place the colors.

Color Output.  This is a way to have the shader in the Diffuse channel to 

make reactive bumping without adding colors.

Reactive Controls

Bump. Choose what value of the underlying colors will be used to change 

bump 

Displacement. This feature has not been implemented yet.

Colors. Choose what value of the underlying colors will be used to place 

colors. 

Tips

You can layer as many SimpleWave shaders with different settings as you 

want. The colors, bumps and displacements will mix (Set up a alpha 0 

value for the color you want to make disappear, or just use a Blend Mode).

If you own 3rd party reactive shaders you can create amazing effects.

By changing X and Y Size, and the wave’s origin, one can get lots of differ-

ent wave effects.

Animate the Attenuation Distance to get even more special effects.

Try to apply the shader to a 3d object with some added displacement.
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LonelyWave
The LonelyWave Shader creates a finite non-continuous looping wave. As 

opposed to the SimpleWave shader, in LonelyWave you can decide when 

the wave starts, and also the exact number of ripples that the entire effect 

will have. When the wave is completed it will start again. The shader is 

also reactive, and produces color, bump and displacement.

Size and Origin. These edit boxes set the size of the wave and its starting 

point in scene units. By making X and Y different, you can create ellipsoidal 

waves. 

These two parameters are closely related. Changing the Size of the Wave 

will affect also where the center is, because the shader changes the global 

density to allow the wave to be deformed. Even though this is not a big 

deal, take it into account when planning your animations. 

Figure 28.45 — LonelyWave Interface
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Note that you can set the origin of the wave “outside” the object on which 

the SimpleWave is applied. In this case, you will not see the waves origin, 

but get waves only. This is good when you want to place a bit of movement 

on your liquid, but you do not want a visible wave.

In the same way, if you make an ellipsoidal wave outside of the object, you 

will have the feeling of a more planar than circular wave.

Att. distance. The distance at which the waves will completely disappear.

Wave Force. The Force of the wave. It is a multiplier that will affect the 

wave’s color and bump.

Wave Speed. The speed of the wave. The default value is 1.0. Higher values 

will make the wave move faster, while lower values will make the wave 

move slower. A value of 0 will “freeze” the wave.

Bump. The amount of bump the wave generates.

Displacement. The amount of displacement of the wave: Use it with cau-

tion. Usually low values like 0.1 or similar are enough to get a good effect. 

Also, remember to have a high enough tessellation in order to get a good 

smooth displacement. 

Colors. Clicking here opens the color picker. You can choose two different 

colors that will alternate on the surface of the wave.

Color Slide. Use this parameter to “slide” the color mix across the wave. 

This is very useful when you use the SimpleWave shader with other reac-

tive shaders and you intend to exactly place the colors.

Color Output.  This is a way to have the shader in the Diffuse channel to 

make reactive bumping without adding colors.
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Wave Starts at.  Choose the time when the first wave will be generated.

Number of Waves.  The number of ripples generated per wave.

Preview Time.  Set the desired time to see how the wave has evolved at 

that time. This control has no effect on the render, but only acts inside the 

shader interface.

Reactive Controls

Bump. Choose what value of the underlying colors will be used to change 

bump 

Displacement. This feature has not been implemented yet.

Colors. Choose what value of the underlying colors will be used to place 

colors. 
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Cammo2
This is a advanced version of the original Cammo shader. It can create a 

larger variety of camouflage patterns.

Will affect only the channel in which it is applied. Will not work if placed in 

the bump channel.

Density. Sets the Scale of the shader on the group. Larger numbers are 

equivalent to zooming out, smaller to zooming in.

Surface Color. Sets the RGB value of the underlying surface. The three 

Cammo regions are applied on to of this surface. You can set the alpha to 

0.0 to let the object’s diffuse color, or the next texture map in the diffuse list, 

come through instead. There are three different regions added on top of the 

surface color. They each have the following controls.

Scale. Controls the size of the pieces that make up the region.

Figure 28.46 — Cammo2 Shader
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Level. Controls how much of the Surface color shows through the region. 

0.0 allows all of the surface color to show through. 1.0 allows none at all.

Color. RGB color of the region.

Noise. You can select from four different noise algorithms to vary the pat-

tern.
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Reactive Shaders
Reactive shaders have parameters that are driven externally, usually from 

another shader or a texture. The driver will usually be color, but it can be 

any other kind of information, such as bump or light. Reactive controls 

allow for endless possibilities and for a greater flexibility, and once mas-

tered, you will be able to do a wide range of new things with Animator and 

Camera.

Universe includes the BumpyNoiseR, CrumpleR, ErodedR, FractalNoiseR 

and RustR reactive shaders.

Let’s see a simple example of a reactive shader usage. Take a look at the fol-

lowing rendering.

We are about to do a short tutorial before entering into deeper explanation 

about reactive shaders.

First, we will prepare the “hot zones”. In other words, the areas that will 

“drive” the shader. To do so, we will add the Clouds shader using black 

and 100% red color, as it is shown in the dialog box that follows.

Figure 28.47 — Cuboid - No Shaders Applied
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Rendering the cuboid with the Cloud shader will yield:

By now, we have mapped the cuboid using a single shader and we have 

already set up the reactive zones. The red areas will drive the reactive 

shader giving us the effect we are after. So now, we will apply the Fractal-

NoiseR reactive shader on top of the Clouds shader, as shown in the fol-

lowing Figure.

Figure 28.48 — Cloud Shader

Figure 28.50 — Cuboid with Cloud Shader
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In this way, the FractalNoiseR reactive shader will be able to read the colors 

beneath it, and act accordingly. The reactive controls are off by default. 

Let’s begin by setting up the FractalNoiseR shader without reactive con-

trols so you can compare how the cuboid looks with and without reactive 

controls. Set it up roughly as is shown in the next image: 

Figure 28.52 — Diffuse Texture List

Figure 28.54 — FractalNoiseR Shader
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A quick test rendering will yield the following image.

Now we open the FractalNoiseR shader again and activate the Reactive 

Bump menu. Choose “Red” from the “R. Bump” pop-up menu.

This will cause the shader to place the maximum bump value (what you’ve 

set up in the Bump Strength parameter) ONLY in the areas that are 100% 

Figure 28.56 — FractalNoiseR - No Reactive Parameters

Figure 28.58 — Enable the Reactive Parameter
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red, and progressively decrease the Bump Strength value as the red chan-

nel goes towards zero. Render again we get the following image.

See how the fractal bump generated by FractaNoiseR appears only over the 

underlying 100% red areas. 

Note that you can “choose” where your procedural bumps will appear by 

using another shader, a bitmap texture, or by painting the object with 

Amorphium. Using Amorphium™ to paint your objects with reactive 

shaders in mind will allow you to precisely “paint” the bumps.

Figure 28.60 — FractalNoiseR - With Reactive Parameters

Figure 28.62 — Side-By-Side Comparison
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Texture RGB and HSV 

There are shaders that have unique reactive controls for each parameter, 

and shaders that have global controls. Values can also be subtracted for 

each of the reactive modes. One group of modes works through reading 

RGB channel values of the underlying colors of the object, these are the R, 

G, B , No Red, No Green, and No Blue modes. The other four modes work 

by reading the HSV values of the underlying colors applied to the object. 

These modes are called “Saturated Areas”, “Desaturated Areas”, “High 

Brightness Areas” and “Low Brightness Areas”. 

The RGB group of modes work better when you paint the object with soft-

ware such as Amorphium (or other software that supports the painting of 

the object’s vertices directly), or by painting a texture map in Photoshop™. 

This is because the RGB values can be painted directly and then used to 

drive the reactive shader. 

HSV modes can be used the same way (Just paint black and white), but 

they were designed with scanned texture maps in mind. With texture 

maps, the RGB values of every pixel can have a lot of variation through the 

map, and it is easier to see the visual differences of the texture using other 

methods, such as brightness changes or saturation changes. The HSV reac-

tive modes will read the S and V values and react accordingly. One thing to 

always keep in mind is the nature of texture maps in general. You need to 

understanding how RGB and HSV work. Some texture maps can have a 

type of S or V value through the pixel-map that, combined with any of the 

reactive modes, will not work as expected. A color could be 100% saturated 

but with a very low V value, so visually, you will see a dark color or a com-

pletely black color. If you look at the map you don’t have any way to see 

whether the darker areas have high or low saturation values. Use the HSV 

modes carefully and experiment a little to achieve the best results. 
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Here is an example using a texture map of wood grain.

Apply this wood texture to the diffuse channel. Then make a grayscale ver-

sion of the wood and place it below the color one. We then apply it to the 

cuboid used in the earlier example

However, if now you add a reactive shader (Let’s use FractalNoiseR again) 

above the grayscale image and activate the reactive bump with “Low 

Figure 28.64 — RGB Wood Texture (left) and Grey Scale (right)

Figure 28.66 — Wood Texture on Cuboid
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Brightness Areas”, the bump will be placed only over the darker veins of 

the bump. 

Rendering the cuboid now yields the following image.

Note how the bump is distributed over the lowest brightness values given 

by the grayscale image. The effect is much more subtle and rich than using 

a mere copy of the wood image placed in the bump channel.

Figure 28.68 — Diffuse Texture List

Figure 28.70 — Reactive Texture on Cuboid
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You can place the reactive shaders in any of the material channels. Note 

that if you place the shader in the specular channel, for example, shader 

will not read any specular information from the object’s surface, but 

instead, the shader is reacting by placing bumps (or colors, luminance, or 

whatever it makes) in the same place where Camera places the specular 

brightness. 

Reactive Controls

Following is a brief description of each reactive mode.

None. No reactive effect for the parameter or the shader. 

Red. The user-value is applied where red (RGB) areas are. When the red 

value decreases, the user-value decreases. A red value of 0 means a 0% 

user-value for that parameter. 

Green. The user-value is applied where green (RGB) areas are. When the 

green value decreases, the user-value decreases. A green value of 0 means a 

0% user-value for that parameter. 

Blue. The user-value is applied where blue (RGB) areas are. When the blue 

value decreases, the user-value decreases. A blue value of 0 means a 0% 

user-value for that parameter. 

No Red.  The user-value is applied where non-red (RGB) areas are. When 

the red value decreases, the user-value increases. A red value of 0 means a 

100% user-value for that parameter. 

No Green. The user-value is applied where non-green (RGB) areas are. 

When the green value decreases, the user-value increases. A green value of 

0 means a 100% user-value for that parameter. 
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No Blue. The user-value is applied where non-blue (RGB) areas are. When 

the blue value decreases, the user-value increases. A blue value of 0 means 

a 100% user-value for that parameter. 

Saturated Areas. The user-value is applied where high saturation (HSV) 

areas are. When the S value decreases, the user-value decreases. A S value 

of 0 means a 0% user-value for that parameter. 

Desaturated Areas. The user-value is applied where low saturation (HSV) 

areas are. When the S value increases, the user-value decreases. A S value 

of 0 means a 100% user-value for that parameter. 

High Brightness Areas. The user-value is applied where high brightness 

(HSV) areas are. When the V value decreases, the user-value decreases. A V 

value of 0 means a 0% user-value for that parameter. 

Low Brightness Areas. The user-value is applied where low brightness 

(HSV) areas are. When the V value increases, the user-value decreases. A V 

value of 0 means a 100% user-value for that parameter. 
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Amorphium™  Example 

As seen in the previous sections, reactive shaders are driven by external 

information. We have already seen how they are driven by textures and 

shaders, but there is yet another powerful way to use these shaders. The 

shaders can be driven using vertex colors painted on the model by a pro-

gram such as Amorphium. 

Start with a well tessellated object. Open your object in Amorphium and 

paint it as desired. For our sample we’ve used a simple box with a cylinder 

embedded in it. Take a look at the Amorphium screenshot.

The model is white with black painted on it in various places, notably at the 

intersection of the cube and cylinder.

Figure 28.72 — Amorphium Project
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Next, the model is exported from Amorphium and brought into Animator. 

When rendered, it appears as expected.

We will follow the same procedure as in the previous examples, but using 

what we painted in Amorphium as the reactive driver. First we will set up a 

nice metallic texture using the Clouds shader (You can use any other 

shader present in Universe Animator or any other 3rd party shader that 

you have). This is how our scene looks using the Clouds shader.

Figure 28.74 — Initial Rendering of Painted Object

Figure 28.76 — Painted with Clouds Shader
828       EIAS Animator   



Chapter 28  Shaders — Reactive
Important Note: When using a model with painted vertices, remember to enable the 

“Use Polygon Color” check box in the Material Info window - Diffuse tab.

Now is time to add the reactive shader. We will continue using Fractal-

NoiseR, so please add the FractalNoiseR shader to your scene and drag it 

BELOW the Clouds shader (or below the shader or bitmap you used to tex-

ture your object).

Figure 28.78 — Material Info Window - Diffuse Tab

Figure 28.80 — FractalNoiseR Added
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Set up its parameters similar to the ones found in the next image, and be 

ready to select a reactive parameter for the bump.

For this sample, we will use the “Low Brightness Areas” mode. Note how 

we have painted the object using black and white.

The white color is composed of:

•  Red Channel: 100%
•  Green Channel: 100%
•  Blue Channel: 100%
•  Hue value: (non applicable-all)
•  Saturation Value: 100%
•  Value value: 100%

Figure 28.82 — FractalNoiseR Shader for Cube and Cylinder
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The black color is composed of:

•  Red Channel: 0%
•  Green Channel: 0%
•  Blue Channel: 0%
•  Hue value: (non applicable-all)
•  Saturation Value: from 0% to 100%
•  Value value: 0%

The main areas of the object are painted white, while the areas that we have 

painted are black. The black color can be thought of as “the absence of Red, 

Green and Blue, or as a Value (or Brightness) of 0. So, we can use either 

Non Red, Non Green, Non Blue, or the lowest brightness values in the reac-

tive shader. For simplicity we have chosen “Low Brightness Areas”. 

When you set “Low Brightness Values”, note how now the bump in the 

shader interface suddenly disappears. This is because the shader interface 

uses always pure white as a reactive color, and therefore, when Low Bright-

ness Areas is chosen, the bump actually reacts and disappears. Hit OK, and 

the shader interface will close.

Figure 28.84 — Final Rendered Image
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Plug-ins

29.0 Introduction

Plug-ins are external modules that extend the capabilities of EIAS Anima-

tor and Camera. They create and modify geometry and often have a 

sophisticated array of animateable parameters. They are stored in the EI 

Sockets folder which is in the same folder as animator. 

You can create subfolders inside the EI Sockets folders to organize your 

plugins. Remember to copy both the plugin and it’s resource file. 

Note Slaves do not support subfolders inside the EI Sockets folder.

The following plug-ins ship with EIAS:

• Dicer 
• Mr. Blobby
• Mesh Generator
• Mr. Nitro
• Power Particles Basic
• Pixel Grains
• Flag
• UberShape
• LensFlare
• LightFlare
• Mr. Nitro2

In addition to the plug-ins that come with EIAS, our web site has a compre-

hensive list of plug-ins available from 3rd parties. 
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Dicer
This plug-in increases the polygon density of any group or groups attached 

to it. That is, the number of polygons in the group is increased by dividing 

(or dicing) the group into small polygons. Dicer is therefore very useful 

when combined with Deformations, because groups that contain few poly-

gons and vertices cannot be deformed.

1. Choose Plugin>Dicer!.plm… from the main menu bar.

2. Use the controls of the dialog box to configure the operation to your 
preferences.

3. Either click OK or press Return. The Dicer effect is added to the project 
as a group.

4. Link the group(s) to be diced to the Dicer group.
5. To deform the group(s), apply the deformation to the Dicer group. 

Dicer Controls

Segment Count. This radio button option, the default setting, divides a 

group into equal length segments. The length of each segment is deter-

mined by taking the longest extent dimension (x, y or z) of the group and 

dividing it by the value in the Segment Count edit box.

Figure 29.0 — Dicer! dialog
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Segment Length. This radio button option, when selected, divides a group 

into segments whose length is determined by the value in the Segment 

Length edit box.

Triangulate All Polygons. This check box option, when enabled, uses tri-

angles only (no quadrangles). Use this option if you notice flashing poly-

gons in objects linked to Dicer.

Local Coordinates. This radio button option, the default setting, deter-

mines the length of each segment by the local coordinates of the group as 

displayed in the Group Info window.

Global Coordinates. This radio button option, when selected, determines 

the length of each segment by the global coordinates of the group. These 

can be seen by turning on the rulers in the Top, Front, or Side View win-

dows.

Dice Only While Rendering. This check box prevents dicing from occur-

ring while the object is displayed within EIAS Animator. This improves the 

speed of screen redraw and display.

Auto Update. This check box sets the plugin to update all linked groups 

without having to take any other steps. (?)
EIAS Animator        835



Chapter 29  Plug-ins — Mr. Blobby
Mr. Blobby
This plug-in takes groups that are linked to it and forms spheres (or blobs). 

As multiple blobs get close together, they blend into a single blob.

1. Choose Plugin>Mr. Blobby.plm… from the main menu bar.

2. Use the controls of the dialog box to configure the operation to your 
preferences. For an explanation of these controls, refer to the section 
“Mr. Blobby Controls” (below).

3. Either click OK or press Return.
The Mr. Blobby effect is added to the project as a group.

4. Link the group(s) to be affected to the Mr. Blobby group.

Mr. Blobby Controls

Texture Map Each Blob. Allows a single texture map to be applied to every 

blob. Every blob will receive the same map.

Figure 29.1 — Mr. Blobby dialog
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Texture Map Whole Model. Allows a single texture map to be applied to 

the extent of the entire Mr. Blobby group.

Mesh With Cubes. Creates 4 sided polygons.

Mesh With Tetrahedrons. Creates 3 sided triangles. 

Interpolate Color: RGB. When working with blobs of different colors this 

setting will blend the colors based on the RGB color model. There is a direct 

blend from one color to the next with no transitional hues. A blend from 

Red to Blue would look like mixed paint creating a smooth gradation 

between the two colors.

Interpolate Color: HSV. When working with blobs of different colors this 

setting will blend the colors based on the HSV color model. This causes a 

blend from one color to the next with extra transitional hues appearing. 

The extra hues are created by interpolating through the Hue color spec-

trum when blending between a start and finish color. A blend from Red to 

Blue would look like a rainbow of Red, Orange, Yellow, Green, Cyan and 

Blue.

Generate: Sphere. This is a primitive to be used to set up a texture map. 

Select this option, then use the texture window to map the Mr. Blobby 

group. Only a spherical map will work. The map can be RGBA for bump 

mapping or transparency mapping. When done setting the map change 

Generate: Sphere to Generate: Groups Blobs, or Generate: Facet Blobs. 

When rendered each blob will appear with the texture map applied.

Generate: Torus. This setting puts Mr. Blobby into a special mode in which 

only a torus will be created. No other Mr. Blobby functions will work.
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Generate: Three Spheres. This setting puts Mr. Blobby into a special mode 

in which only three spheres will be created. No other Mr. Blobby functions 

will work.

Generate: Group Blobs. This setting will take each group linked to the 

Mr. Blobby plug-in and make it a blob. It uses the bounding box size to 

determine blob size. This option allows you to control the movement of 

each individual blob by first animating a set of placeholder groups and 

then linking them to the Mr. Blobby group. This option also allows you to 

control the size of individual blobs by letting you animate the Scale of each 

placeholder group. This option also allows you to control the color of indi-

vidual blobs by letting you animate the Color of each placeholder group.

Generate: Vertex Blobs. This setting will take each vertex of a group linked 

to the Mr. Blobby plug-in and make it a blob. If you use a model, it will 

place a blob at each vertex of the model.If you use a particle generator, it 

will place a blob at each vertex emitted by the generator.The size of each 

vertex blob is set with the Vertex Blob Size entry box.The color of the vertex 

blobs are set with the surface color settings for the particle system group. If 

you want to use the color boxes inside the particle system plug-in to 

change blob colors over time, you must use the Generate: Facet Blobs 

option.

Generate: Facet Blobs. This setting will take each polygon of a group 

linked to the Mr. Blobby plug-in and make it a blob. If you use a model, it 

will substitute a blob for each polygon of the model.If you use a particle 

generator, it will place a blob at each vertex emitted by the generator. If you 

use Mr. Nitro, it will substitute a blob for each fragment generated by 

Mr. Nitro. The size of each facet blob is based on a combination of the size 

of the facets in the model, and the setting in the Facet Blob Scale entry 

box.The color of the facet blobs are based on the original model, or set with 
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the surface color settings in the group info window, or based on colors set 

in the Mr. Nitro or Particle plug-ins, or based on a texture map applied to 

the Mr. Blobby group.

Blob Threshold. Affects how attractive the blobs are to each other. A 

higher value will cause multiple blobs to join.

Vertex Blob Size. This sets the size of the blobs using World Coordinate 

units. All vertex blobs are the same size.

Facet Blob Scale. This sets the size of the blob as a percentage of the size of 

the polygon the blob is based on. A setting of 1 will create a blob that will 

totally encompass the bounding area of the polygon. (1 is equal to 100% of 

bounding area.) A setting of.5 will create a blob half the size of the total 

bounding region. A model with facets of differing sizes will produce blobs 

of differing sizes.

Mesh Resolution: EI. This sets the resolution of the surface mesh for dis-

play within EI. A setting of 3 to 5 will create a usable mesh for setting up 

animation.Be careful to test the effects of a higher Mesh Resolution. If you 

are working to get a specific look, be aware that the shape of the surface 

will change when you render at higher resolution.

Mesh Resolution: Camera. This sets the resolution of the surface mesh for 

rendering within Camera. A setting of 15 to 20 will create a fairly tight sur-

face.

Usage Notes

• All blobs are spherical. You cannot make them ellipsoidal, and you can-
not change their region of influence on an individual basis.

• In order for blobs to react to each other they must be generated by the 
same Mr. Blobby group.
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• Mr. Blobby settings do not animate and do not set key frames.
• Blobs do not understand rotation, as such it does no good to animate 

the rotation of Group Blobs because the blob won't pick up the rotation 
angles.

• Blob size is based on the bounding box size. If you rotate a group it's 
bounding box is likely to change size resulting in a blob that grows and 
shrinks.

• Plug-ins pass their data down the project hierarchy. Try linking a stan-
dard shape to a Mr. Nitro and then link that Mr. Nitro to a Mr. Blobby 
(in Generate: Facet Blobs mode). As the standard shape explodes, Mr. 
Blobby will convert the fragments into blobs.

• The blobs are recreated at every frame. Large numbers of blobs (such as 
those created by Mr. Nitro or a Particle system) may add huge numbers 
of polygons to your project. Remember, a single facet created in a 
Mr. Nitro explosion might be turned into 200 polygons by Mr. Blobby.
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Mesh Generator
This tool adds the Mesh Generator to the project. The Mesh Generator is 

used to animate various shape transformations, primarily a plane into a 

sphere (or vice versa).

1. Choose Plugin>Mesh.plm… from the main menu bar.

2. Use the controls of the dialog box to configure the mesh to your prefer-
ences. For an explanation of these controls, refer to the section “Mesh 
Generator Controls (see below).

3. Either click OK or press Return.

Mesh Generator Controls

Mesh Type. This pop-up menu provides a choice of five different animated 

mesh objects. The menu choices are:

• Flat
• Sine Wave
• Breathing Cylinder
• Screw Thread
• Sphere Wrap

Figure 29.2 — Mesh dialog
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Flat. This option creates a flat, two-dimensional mesh grid.

Sine Wave. This option creates a mesh object containing animated circular 

waves.

Breathing Cylinder. This option creates a cylinder that expands and con-

tracts as if breathing.

Screw Thread. This option creates an object that simulates a screw thread 

which reverses its threads inwards and outwards over time.

Sphere Wrap. This option (the default) creates an object that transforms 

itself from a plane into a sphere (and back again).

U Points. This edit box contains a value for the number of horizontal grid 

segments.

V Points. This edit box contains a value for the number of vertical grid seg-

ments.

Loop Time. This edit box contains a value in seconds for the amount of 

time it will take for one complete transformation. In the case of a Sphere 

Wrap, for example, the loop time would be the amount of time it will take 

for the plane to transform into a sphere (before transforming back into a 

plane).

X, Y and Z Scale. These edit boxes contain values for the scale of the object 

along the X, Y and Z axes. For a Sine Wave object, you can use the Y Scale 

value to control the height of the waves.

Once the object is added to the project, this dialog box can be reopened to modify 

your preferences. To do so, open the Group Info window for the object and click the 

Plugin… button.
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Mr. Nitro
This tool adds the Mr. Nitro special effect to the project. Mr. Nitro is used to 

animate realistic explosions of models.

1. Choose Plugin>Mr. Nitro.plm… from the main menu bar.

2. Use the controls of the dialog box to configure the blast to your prefer-
ences. For an explanation of these controls, refer to the section “Mr. 
Nitro Controls (see below).

3. Either click OK or press Return.
4. Parent the group(s) to be exploded to the Mr. Nitro object.

Mr. Nitro Controls

Ground Zero. These edit boxes contain values for the X, Y and Z coordi-

nates of the blast’s origin, or “ground zero.” This is the point from which 

the shock wave of the blast originates, emanating in all directions. By posi-

Figure 29.3 — Mr. Nitro dialog
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tioning ground zero farther away from the group(s) to be exploded, you 

can create more of a “wall-shaped” shockwave.

To position and configure the blast to your requirements, you should first check the 

coordinates and size of the group(s) to be blasted in their respective Group Info 

windows. You can then set Mr. Nitro’s values accordingly.

Gravity Direction & Force. These edit boxes contain values for the direc-

tion and force of gravity which will affect the manner and speed in which 

the blast fragments fall. The ± edit boxes enable you to impart a variability 

to each value so that some fragments are more affected by gravity than oth-

ers.

Blast Time. This edit box contains a value for the time in the project at 

which the shock wave will commence. A negative value will result in the 

shock wave originating prior to the start of the animation.

You will need to use a negative blast time value when ground zero is far 

away from the group(s) to be exploded—otherwise the moment of impact 

will occur long into the animation. For the blast to occur in the first frame 

of the animation, blast time should be set according to the following for-

mula:

Blast Time = - distance from Ground Zero to group ÷ Speed

For example, if ground zero is a distance of 1000 from the group and the 

blast speed (see Speed edit box, below) is 10, blast time would be -1000 ÷ 

10, or -100 seconds.

Air Resistance. This edit box contains a value for the amount of air resis-

tance which will affect the manner in which the blast fragments fall. The 

higher the value, the more air resistance slowing the fragments.
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Dissolve. This edit box contains a value for the amount of time in seconds 

for blast fragments to dissolve after being hit by the shockwave. A value of 

0 (the default) prevents fragments from dissolving.

Outer Blast. These edit boxes control the speed, rotation, turbulence and 

force of the initial shockwave of the blast. An explosion can have two 

shockwaves, the outer blast (first) and the inner blast (second).

%. This edit box contains the percentage value for the outer blast (initial 

shockwave). It defaults to 100, so that there is only the outer blast. To create 

two shockwaves, assign a value less than 100% to the outer blast and the 

Inner Blast% edit box will be adjusted accordingly (so that they add up to 

100%).

Speed. This edit box contains a value for the speed (distance per second) of 

the shockwave. When used in conjunction with the Blast Time value (see 

above), this value can control the moment when the shockwave hits the 

group(s).

Rotation. This edit box contains a value in degrees for the maximum 

amount of rotation of the flying blast fragments. Fragments rotate around 

random axes.

Turbulence. This edit box contains a value for the amount of air turbulence 

which will affect the manner in which the blast fragments rotate. With a 

value of zero, fragments rotate around their centers. A value other than 

zero will cause fragments to rotate off-axis.

Force. This edit box contains a value for the force of the shockwave. The 

greater the force, the faster the fragment will move in the direction of the 

shockwave. A force of 1.0 will cause fragments to move at the same speed 
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as the shockwave. The ± edit boxes enable you to impart a variability to the 

value so that some fragments fly faster than others.

Fragment Size. These edit boxes contain size values for the smallest and 

largest blast fragments, relative to the size of the exploding group. To have 

all fragments of approximately the same size, enter the same value in both 

the Smallest and Largest edit boxes.

Setting a minimum size value that is too small will generate a very large number of 

fragments, which will take too long to generate and may also cause you to run out 

of memory. As a starting point for the minimum size, try using a value that is 1/10 

the longest dimension of the group; for the maximum size, use a value that is twice 

the minimum size.

Fragment Shape. These edit boxes contain values for the percentage of 

fragments that are to be triangles versus quadrangles. The default is 50% 

for each. Changing one value will adjust the other value accordingly (to 

add up to 100%).

Fragment Color. This check box, when enabled, allows you to assign a 

color to the blast fragments, overriding the surface color setting of the 

group. The color of the blast fragments can be animated over time through 

the use of the Age Color buttons, discussed below.

Age Color. These buttons invoke the Color Picker to enable you to set dif-

ferent colors for the blast fragments at different stages of the blast. The age 

values are all in seconds and can be edited.You can change the color of the 

fragments before they are hit by the shockwave by setting the first age 

value to less than zero.
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Once the Mr. Nitro object is added to the project, this dialog box can be reopened to 

modify your preferences. To do so, open the Group Info window for the Mr. Nitro 

object and click the Plugin… button.
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Power Particles Basic
This tool adds the Particle Generator to the project. The Particle Generator 

is used to animate special effects such as sparks, jets of fire, and fountains 

or streams of water.

1. Choose Plugin>PowerParticlesBasic.plm… from the main menu bar.

2. Use the controls of the dialog box to configure the particle stream to 
your preferences. For an explanation of these controls, refer to the sec-
tion “Power Particles Basic Controls (see below).

3. Either click OK or press Return.

This plugin offers previews so that you can predict how the particles will 

behave over time without having to render. Previews are in OpenGL for 

maximum speed.

Figure 29.4 — Power Particle Basic dialog
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EIAS Animator Preview

Previews in EIAS Animator can be viewed either as emitted particles or as 

a direction arrow. Particle previews can also be set to display a percentage 

of particles you want to see. For fast Previews in EIAS Animator, we recom-

mend running with 1/10th or less particles than you want to see in the ren-

derings.

Interface Controls

Power Particles introduces some new and unique controls that are dis-

cussed in this section.

OpenGL Preview Buttons

Orbit. This button allows you to move the view point around the particle 

stream. Changing the view in Power Particles does not affect the camera 

position in EIAS Animator.

Dolly. This lets you slide the view point closer or farther away from the 

particle system.

Orientation. This allows you to choose between Top, Side, Front or Per-

spective views. 

Note Orbit only applies to the Perspective view.

Figure 29.5 — OpenGL Preview Buttons
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Continuous/Loop. The loop button allows you to see the system from its 

start frame to its end frame. Then it starts over. (Animation of the plug-in is 

not shown). Continuous shows the system emitting its particles with no 

reference to start and end time. In other words, it just keeps going and 

going forever or until you close the interface.

Stop, Pause and Play. These work just like standard CD type controls to 

control the plug-in preview of the particle system. 

Background color . The last item is the background color setup icon. Click 

the color swatch to change the background color.

Shortcuts

• Tab/Shift-Tab: Move between virtual sliders within a tab.
• Cntrl-Z, Cntrl-X: to change the increment of a virtual slider.
• Cntrl-Q, Cntrl-W: to move to another tab.

Slider Buttons

Notice the arrows on the button. This icon indicates that the button is a new 

“Virtual Slider”. To use this function, press the button (the arrow changes 

to yellow to indicate it’s active), then click and hold the mouse button in 

the OpenGL screen and slide it right and left. Notice the values in that 

parameter change. Also note: Under the OpenGL Screen are Min, Max, and 

Inc. Min and Max show the minimum and maximum values allowed for a 

given “slideable” parameter. Inc. shows the increment used when changing 

the slider. The increment can be changed by using cntrl-Z and cntrl-X. 

Slider increments will increase or decrease by a factor of ten.

Figure 29.6 — An Interactive Slider Button
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Emitter Tab

This tab allows you to select between Point, Line, and Volume type emit-

ters.

Point. Select this option if you want objects to be emitted from a point. 

Line. Select this option if you want objects to be emitted from a line. Set 

Line Length to the length in EIAS Animator world units of the emission 

line. Any number greater than or equal to 0 can be entered. A line length of 

0 has the same function as emitting from a point.

Volume. Select this option if you want objects to be emitted from a volu-

metric region. Set the X, Y and Z values to determine the volume in which 

Figure 29.7 — Emitter Tab

Figure 29.8 — Emitter Pull-down
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the particles will be emitted. Volume emission is always centered around 

the Power Particles center point locator in EIAS Animator.

Start Time. Set this parameter to the time in seconds from the beginning of 

the animation that you want particles to start emitting. The frame that cor-

responds to this time will be the first frame in the animation in which parti-

cles are emitted.

End Time. Set this parameter to the time in seconds from the beginning of 

the animation that you want particles to stop emitting. This parameter only 

controls the time at which particles stop emitting; emitted particles will still 

be present in the animation until they either reach the end of their life span 

or the end of the animation, whichever occurs first. The frame that corre-

sponds to this time will be the last frame in which particles are emitted. 

When Start Time is set to the same time as End Time, particles will be emit-

ted on the one frame that corresponds to this time.

Maximum Particles. Set this parameter to the maximum number of parti-

cles you want to exist at any particular time during the animation. Power 

Particles will continue to emit the specified Rate Per Second until the maxi-

mum number of particles is reached. After this threshold is reached, new 

particles will be emitted only to replace particles whose lifetime has 

expired. The maximum number of particles also greatly influences the 

amount of memory used by the plug-in. Previews and rendering run most 

efficiently if you set Maximum Particles very close to the desired maximum 

number of particles you want in the animation.

Emission Deviation. Set this parameter to the angle in degrees that you 

want particles to deviate from their initial direction vector. Valid values are 

from 0.0 to 360.0. At 0.0, particles will all be emitted in the direction that the 

emitter arrow points in the EIAS Animator user interface. At 360.0, parti-
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cles will be emitted in all directions from the direction of the emitter. Values 

between 0.0 and 360.0 deviate the emission direction accordingly.

Particles Tab

Initial Speed. Set this parameter to the initial speed of an emitted particle. 

If you want to vary the initial speed of emitted particles, enter a number in 

the ± edit box (or use the virtual slider). 

Maximum Speed. Set this parameter to the maximum speed for all emitted 

particles. This function is used to constrain the speed of the particles. If no 

constraint is needed the default setting will normally not interfere with 

particle speed.

Figure 29.9 — Particles Tab
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Rate Per Second. Set this parameter to the number of particles you want 

created during each second of the animation. If you want to vary the num-

ber of particles created per second, enter a number in the ± edit box. 

Lifespan. Set this parameter to the length of time in seconds you want 

emitted particles to appear in the animation. If you want to vary the life-

time of emitted particles, enter a number in the ± edit box.

Set Particle Colors. Click this button to change the colors of emitted parti-

cles.

Particle Colors

Color Bar. The color bar at the very top of the screen shows the selected 

colors as they will appear over the lifetime of the particle. It displays from 

left to right the starting color through the ending color, in sequence. The 

two down arrows indicate which of the colors are displayed in the five 

color display icons below the color bar.

Color display icons. The color display icons below the color bar show the 

five colors available. The selection indicator around a color icon indicates 

which one of the five color settings is currently selected. You modify a 

color’s settings by first selecting its color display icon and then select the 

color using the color picker. On the screen shown, color 1 is selected.

Number of colors. You are allowed between 1 and 5 colors.

Figure 29.10 — Color Bar
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Dynamics Tab

Enable Air Resistance

Check this box if you want the emitted particles to react to air resistance. 

Drag Coefficient. Air resistance corresponds to the drag coefficient of the 

particle. Since the air resistance force depends on the velocity of the parti-

cles, this parameter needs to be adjusted to match the scale of any particu-

lar animation. The faster the particles move (large Initial Speed), the 

smaller the number you want for this parameter.   Numbers between 0.0 

and 1.0 are not uncommon; it all depends on the scale of the animation in 

EIAS Animator. 

Figure 29.11 — Dynamics Tab
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Enable Gravity

Set this parameter to the acceleration due to gravity you want applied to 

emitted particles. Gravity is an acceleration which is applied to particles in 

the X, Y, or Z direction. Positive values result in accelerating particles in a 

positive X, Y, or Z direction.

X Direction. Set this parameter to the acceleration due to gravity you want 

applied to emitted particles in the X direction. Positive values result in 

accelerating particles in a positive X direction.

Y Direction. Set this parameter to the acceleration due to gravity you want 

applied to emitted particles in the Y direction. Positive values result in 

accelerating particles in a positive Y direction.

Z Direction. Set this parameter to the acceleration due to gravity you want 

applied to emitted particles in the Z direction. Positive values result in 

accelerating particles in a positive Z direction.

Enable Bounce

Check this box if you want emitted particles to bounce off the Y-Plane. 

Y-Plane. Power Particles Basic offers collision with a designated altitude 

only. This is set by entering a Y value where you want the invisible Y-Plane 

to intersect the Y axis.

Elasticity. Set this parameter to the amount of bounce you want to give to 

emitted particles. Use the following values as a guide to specify bounce 

behaviors:
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Value Behavior

0 Emitted particles stick to the Y-Plane, no bounce

<1 Emitted particles lose speed with each bounce

=1 Emitted particles maintain the same speed with each bounce

>1 Emitted particles gain speed with each successive bounce

Friction. Like elasticity this setting changes how the particles bounce. This 

setting alters the horizontal distance a particle travels after a bounce. A set-

ting of zero will give the particle no horizontal distance. A setting of one 

will give the particle its normal calculated horizontal bounce distance 

based upon the elasticity and the velocity.

Preferences Tab

Figure 29.12 — Preferences Tab
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Show Emission Direction Only. Check this button to show the initial 

speed and direction of emission. This is shown graphically with the use of 

an arrow. The length of the arrow denotes the initial velocity value and the 

direction of the arrow shows the direction the emitter is pointing. 

Show Emitted Particles. Check this button to display emitted particles. 

This is the default setting.

Limit Emission to _____% of the object. Allows you to set the percentage 

of emitted particles to be seen in the EIAS Animator Interface. Camera will 

render 100% of the emitted particles.

Preview Folder. Specifies the name of the folder in which the preview files 

are stored. The preview folder is placed in the folder where EIAS Animator 

is located. This folder must be available to Camera during rendering of 

stills. If this folder is available to Camera during rendering, the Camera 

temp file needed by Power Particles will be stored here also. Power Parti-

cles does not delete these folders. These folders can be deleted at any time 

from the EIAS Animator directory. 

Disable Grid. Check this box to hide the grid from the preview screen.

Disable Axis References. Check this box to hide the Axis reference letters 

from the preview screen.
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Pixel Grains
“X-Men”, the movie, Inspired the creation of this plugin. An effect involved 

the characters of the movie planning their attack strategy and they create a 

3D grain like replica of NY City region consisting of millions of little tiny 

primitives that are rearranged based on animated height maps. The effect 

was originally created on a high end workstation. We developed the same 

sort of power available for a desktop computer. 

This model plugin uses EIAS IMAGE (format) files, single or multi-frame 

to generate models inside of EIAS. Each pixel with non-zero gray level will 

make a primitive be created. A variety of built-in primitives are offered. 

The shape is scaled according to the gray level value of the pixel. Animated 

gray maps create animated grains of pixels, hence the name Pixel Grains. 

Memory Allocation

This plugin can require a lot of memory. It can handle images of size 2K by 

2K and so needs at least 60 MB (this is in addition to what EIAS and Cam-

era are using) just to allocate buffers. Also, depending on the number of 

Figure 29.13 — Pixel Grains Sample, image courtesy of Wombat Interactive
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actual non-zero gray pixels, and the type of primitive, more memory may 

be needed. Typically 150MB for a 256*256 map is not unusual. Both EI and 

camera will need to have additional RAM.

Pixel Element Shapes

Choose the shape of the primitive you want to be created for each pixel 

from this menu.

Plane. A flat rectangle

Cube. A 5-sided primitive (no base)

Rounded Cube. A cube with rounded edges (9 quads)

Cylinder. 6 sided cylinder with a covered top. (8 quads)

Rounded Cylinder. A cylinder with rounded top (14 quads)

Cone. A 6 sided cone 

Figure 29.14 — Pixel Grains Interface
860       EIAS Animator   



Chapter 29  Plug-ins — Pixel Grains
Custom. A group that is child of the plugin, modeled with Y-up and unit 

size in X and Z with base center at the origin. Keep in mind, the included 

primitives are severely optimized, custom objects might not be, so more 

RAM would be needed.

Scaling Factor

Each primitive is a unit size in x and z. Scaling factors in X and Z can be 

used to make the elements larger or smaller than the pixel square. This 

allows for creating overlapping or non-overlapping elements.

The above two will let you change the size of the pixel primitive itself, 

without scaling the spacing between them.

Element Scale X. Scale factor in X

Element Scale Z. Scale factor in Z

Mesh Scale X. Scale of the entire model in X

Mesh Scale Y. Scale of the entire model in Y

Mesh Scale Z. Scale of the entire model in Z

Mesh Scale is just the same as if you scaled the Pixel Grains plugin in the 

Group Info Window.

Image/Movie Filename. Name of the image/ movie file to be used. This 

file must be EIAS IMAGE format file and MUST be in the EI Sockets folder. 

The Change File button lets you select a new file, and will let you change 

the folder, BUT, you must only select files from the EI Sockets folder. This is 

being done to allow for files to be found if Renderama is being used to ren-

der on the slave machines.
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Start At frame #. The frame index of animation at which Pixel Grains start 

to generate geometry.

Stop At Frame #. The frame index of the animation at which Pixel Grains 

stops generating geometry.

Zero Value. Typically a zero gray value is taken to be the zero height field. 

If you want to take some other gray level as the virtual zero, that gray level 

value is entered here. 
862       EIAS Animator   



Chapter 29  Plug-ins — Flag
Flag
Flag is a small plug-in that generates a rectangular flag, and deforms 

(makes it look like it’s waving) it using dynamics. This will mimic a flag in 

a windy area. There are separate controls for amount of wind, direction, 

locks.

Mesh Resolution. This determines how many polygons the constructed 

Flag geometry will have.

Count. Count controls how fast time is running in the simulation. A higher 

number means faster flag movement. If you would like the simulation to 

begin before the animation in your scene, drag Flag’s initial keyframe 

before 0.

Friction. Friction is how stiff the fabric of the flag is. A higher number 

would make it appear that the flag is made of a thicker material.

Wind X/Y/Z. This is the direction of the wind. 

Strength. Strength measure the speed of the wind. Higher numbers will 

make it appear that the wind is blowing harder.

Figure 29.15 — Flag Interface
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Locks. The locks check boxes are basically where the flag would be tied 

down. By default the top and bottom left boxes are checking, making it 

appear that the flag is attached to a pole (pole would be separate geometry) 

at the top and bottom left of the flag.
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UberShape
UberShape is a plugin that creates an enormous variety of objects. These 

objects can be used for animation, texturing, and rendering. There are 

many custom controls used for each type of shape too.

Shape Type. This pull down menu allow to choose between the different 

types of shapes each with it’s own options. The shape settings area is where 

the options for each object is selected, the shapes include:

• Plane
• Cube
• Cylinder/Disc
• Cone, Sphere
• Torus
• Tube Ring

Figure 29.16 — UberShape Interface with Plane Selected

Shape
Preview
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• Capsule
• Teapot
• Rock
• Geodesic
• Uniform Polyhedron

Auto Name. When this option is checked, a Plane will be named “Plane” in 

the project window. Similarly, a teapot will be named “Teapot” and so on. If 

you would like to instead name the objects yourself, uncheck the Auto 

name option.

Smooth. The smooth option will look smooth when rendered as Phong or 

higher. Sometimes you might want more of a faceted look, if so, uncheck 

this option.

Create UVs. UV coordinates aid in texturing. This plugin will make UV 

coordinates for the group if wanted. This can aid in texturing when apply-

ing UV maps.

Shape Preview. This box will show an example of what the object selected 

may look like when generated. This is especially useful when choosing a 

polyhedron shape.

Show Faces. The show faces check box is there primarily to uncheck if ren-

dering for only Sticks and Balls.

Sticks. Sticks colors the edges of each polygon a separate color. It can be set 

to Lines which is a separate color, or to Cylinders, which will create cylin-

ders as the polygonal edges. There is also options for divisions for EIAS 

and Camera. This is for a lower resolution in the view screens than while 

rendering. The sticks option can also be turned off as it is by default.
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Balls. Balls will put a point, line or sphere at each of the vertices of the 

object created. There are several orientation options for the spheres also. 

The balls have options for divisions in both EIAS and Camera.

Shape Settings

Each different type of object that UberShape has its own options. In general 

though many are used in common.

Dimension. These include, Length, Width, Height, and Radius. Each of 

these affect the dimensions of the standard shape.

Orientation. These are X, Y, and Z rotational values. These can be set here 

at the initial creation of the object, or later in the group info window’s rota-

tional values.

Divisions/Subdivisions. The density of the mesh created is controlled by 

setting the EI and Camera divisions settings. If you plan on deforming an 

object, sometimes a higher division setting is needed for a smooth result.

Cap Ends. Some of the shapes (Cylinder/Disc, Cone, Capsule) have this 

option to have its ends covered or open, or to have just one side covered.

Detail Level. Some shapes (Rock, Teapot) use detail level to affect how 

dense the mesh is created.

Random Seed. Rocks use a random seed to allow the rock to look more 

natural. If adding several rocks, changing the random seed in each, will 

make the rocks look more unique.

Buckyball. Buckyball is a geodesic made up of pentagons and hexagons. It 

was named after Buckminster Fuller who did most of the early research on 
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geodesic structures. Since Buckyballs don't have triangles, you can't gener-

ate faces. This feature is only available as part of a Geodesic.

Class 1/Class 2 Geodesic. These are slightly different variations of the 

polygon layouts. Class 2 is a denser mesh and is a little bit smoother.
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LensFlare
The LensFlare plugin is a post-processing plugin that adds a lens flare 

effect over the top of the rendered image. Flares are assigned to individual 

lights using the Flare tab of the Light Info window.

Lens Type. This pop-up menu provides a choice of two types of lenses: 50-

100mm and 35mm Prime. Each produces a different type of flare with dif-

ferent sets of ring and streak elements.

Spherical/Anamorphic.  These radio buttons provide a choice between cir-

cular and oval rings.

Rotation. This edit box contains a value in degrees for the angle of rotation 

of the streaks. This control can be used to simulate the spinning of a lens.

Aspect Ratio. This edit box is used in conjunction with Anamorphic 
lenses. It alters the oblateness of the flare.

Figure 29.17 — LensFlare Interface
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Ring Scale. This edit box contains a value for the overall scale of the flare’s 

ring elements. It defaults to 1 for standard-size rings. The higher the value, 

the larger the rings.

Ring Intensity. This edit box contains a value for the overall brightness of 

the flare’s ring elements. It defaults to 1. the higher the value, the brighter 

the rings.

Ring Contrast. This edit box contains a value for the contrast in the flare’s 

ring elements. It defaults to 1. The higher the value, the higher the contrast.

Remove Ring Tint. This check-box, when enabled, changes all of the flare’s 

ring elements to gray scale. This option makes them easier to color with the 

Origin Glow, Outer Glow, Halo, and Lens Reflections color buttons. This 

options defaults off.

Origin Glow. This check box, when enabled, creates a glowing ball at the 

flare’s origin. It defaults on. The adjacent color button opens the color 

picker to adjust the color of this element. The color defaults to white.

Outer Glow. This check box, when enabled, creates a glowing ring around 

the flare’s Origin Glow. It defaults on. The adjacent color button opens the 

color picker to adjust the color of this element. The color defaults to white.

Halo Ring. This check box, when enabled, creates a halo around the flare’s 

Origin Glow. It defaults on. The adjacent color button opens the color 

picker to adjust the color of this element. The color defaults to white.

Reflections. This check box, when enabled, creates lens reflections. It 

defaults on. The adjacent color button opens the color picker to adjust the 

color of this element. The color defaults to white.
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Streak Scale. This edit box contains a value for the scale of the flare’s streak 

elements. It defaults to 1. The higher the value, the longer the streaks.

Streak Intensity. This edit box contains a value for the overall brightness of 

the flare’s streak elements. It defaults to 1. The higher the value, the 

brighter the streaks.

Streak Contrast. This edit box contains a value for the contrast in the flare’s 

streak elements. It defaults to 1. The higher the value, the higher the con-

trast.

Remove Streak Tint. This check-box, when enabled, changes all of the 

flare’s streak elements to gray scale. This option makes them easier to color 

with the Streaks color button. It defaults off.

Streaks. This check-box, when enabled, creates the flare’s streaks. It 

defaults on. The adjacent color button opens the color picker to adjust the 

color of this element. The color defaults to white.

Use Light Size. This check-box, when enabled, causes the Light Size in the 

Light Info window, Properties tab to be used for both the lens flare obscura-

tion size and the lens flare’s glow radius.

Use Light Intensity. This check-box, when enabled, causes the intensity of 

value set in the Light Info window, Properties tab to determine the overall 

brightness of the flare.

Use Light Rotation. This check-box, when enabled, rotates the lens flare 

rings and streaks in 2D to match the light source rotation as shown in the 

Light Info window, X-form tab. When the light is linked to another object, 

the lens flare will be rotated by the combination of the light and the object. 

In addition, the Camera’s roll value will affect the light rotation angle.
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LightFlare
The LightFlare plugin is a post-processing plugin that adds a lens flare 

effect over the top of the rendered image. Flares are assigned to individual 

lights using the Flare tab of the Light Info window.

Use Light Size. This check-box, when enabled, causes the Light Size in the 

Light Info window, Properties tab to be used for both the lens flare obscura-

tion size and the lens flare’s glow radius.

Anamorphic Distort. This check-box, when enabled, causes a flattening of 

the flare. The edit box controls how flat the flare becomes.

Flare Intensity. This Edit box controls the overall brightness of the entire 

flare.

Flare Dissolve. Causes the flare to become transparent. The higher the 

value, the more transparent.

Figure 29.18 — LightFlare Interface
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Use Central Glow. This check box, when enabled, creates a glowing ball at 

the flare’s origin.

Use Red Outer Glow. This creates a soft, red glow around the Central 

Glow. It is only available if Central Glow is enabled.

Use Central Ring. This check box, when enabled, creates a halo around the 

flare’s Central Glow.

Ring Size. Controls the size of the Central Ring. 

Ring Color. Brings up a color picker that changes the color of the Central 

Ring.

Star Filter. This pop-up menu enables streak patterns that emanate from 

the center of the flare. The filter supports both major and minor streaks. e.g. 

“6+6 Point” means six major streaks and six minor streaks.

Star Rotation. This edit box controls the rotation of the streaks. Only the 

streaks are rotated with this option. 

Lens Reflection. This check box, when enabled, creates lens reflections.

Anamorphic Streak. This check-box, when enabled, creates a flat, blue 

streak that runs horizontally through the center of the lens flare. 

Off Screen Streaks. This check-box, when enabled, allows the lens flare to 

be seen even when it moves outside the field-of-view of the camera. The 

Enable Offscreen check-box must be turned on in the Flare tab of the Light 

Info window as well.

Random Streaks. This check-box, when enabled, creates a large number of 

small streaks that center on the flare’s origin.
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Streak Density. This edit box controls the number of Random Streaks cre-

ated when the Random Streaks check-box is on.

Streak Intensity. This edit box controls the brightness of the Random 

Streaks.

Streak Sharpness. This edit box controls the contrast of the Random 

Streaks. Lower values blur the streaks.
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Mr. Nitro2
This tool adds the Mr. Nitro2 special effect to the project. Mr. Nitro2 is used 

to animate realistic explosions of models. Mr. Nitro2 is an enhanced version 

of Mr. Nitro. It includes support for strength maps, polygon extrusion, and 

a separate simulation timing system. 

1. Choose Plugin>Mr. Nitro2.plm… from the main menu bar.

2. Use the controls of the dialog box to configure the blast to your prefer-
ences. For an explanation of these controls, refer to the section “Mr. 
Nitro Controls (see below).

3. Either click OK or press Return.
4. Parent the group(s) to be exploded to the Mr. Nitro2 object.

Figure 29.19 — Mr. Nitro2 Interface
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Mr. Nitro2 Blast Waves Controls

Blast Time. This edit box contains a value for the time in the project at 

which the shock wave will commence. A negative value will result in the 

shock wave originating prior to the start of the animation.

You will need to use a negative blast time value when ground zero is far 

away from the group(s) to be exploded—otherwise the moment of impact 

will occur long into the animation. For the blast to occur in the first frame 

of the animation, blast time should be set according to the following for-

mula:

Blast Time = - distance from Ground Zero to group ÷ Speed

For example, if ground zero is a distance of 1000 from the group and the 

blast speed (see Speed edit box, below) is 10, blast time would be -1000 ÷ 

10, or -100 seconds.

Use Strength Map. Turning on this check box makes use of the first 

Strength Map of each group to apply a mass factor to the exploded poly-

gons. Where the strength map is 100%, the polygons receive the full force of 

the blast wave. Where the strength map is 0%, the polygons are frozen and 

unaffected by the blast wave. Sub-polygons created by the plugin receive 

an interpolated strength from the initial polygon.

This feature allows you to create interesting effects such as blowing holes in 

a model without having to create a separate model for the region to be 

exploded.

Use Manual Timing. When this is turned on, the absolute simulation time 

as specified by the Simulation Time animation channel is used instead of 

the project's animation timing. This mode allows you to speed up or slow 

down or even freeze the explosion.
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Simulation Time. Used with the Use Manual Timing check box. This is the 

absolute simulation time at the current frame of the animation. You can use 

this setting to set keyframes for the Simulation Time animation channel in 

the Project window. This means you can run the simulation backwards 

while the animation runs forwards. Or you can run the simulation at a 

varying rate of speed. For instance, at scene time 0.0, you could set the sim-

ulation time to 0.50. At scene time 1.0, you could set it to -0.50. The explo-

sion would begin normally but would start running backwards at scene 

time 1.0.

Ground Zero Position. These edit boxes contain values for the X, Y and Z 

coordinates of the blast’s origin, or “ground zero.” This is the point from 

which the shock wave of the blast originates, emanating in all directions. 

By positioning ground zero farther away from the group(s) to be exploded, 

you can create more of a “wall-shaped” shockwave.

To position and configure the blast to your requirements, you should first check the 

coordinates and size of the group(s) to be blasted in their respective Group Info 

windows. You can then set Mr. Nitro2’s values accordingly.

Outer Blast and Inner Blast. These edit boxes control the speed, rotation, 

turbulence and force of the initial shockwave of the blast. An explosion can 

have two shockwaves, the outer blast (first) and the inner blast (second).

%. This edit box contains the percentage value for the outer blast (initial 

shockwave). It defaults to 100, so that there is only the outer blast. To create 

two shockwaves, assign a value less than 100% to the outer blast and the 

Inner Blast% edit box will be adjusted accordingly (so that they add up to 

100%).
EIAS Animator        877



Chapter 29  Plug-ins — Mr. Nitro2
Speed. This edit box contains a value for the speed (distance per second) of 

the shockwave. When used in conjunction with the Blast Time value (see 

above), this value can control the moment when the shockwave hits the 

group(s).

Rotation. This edit box contains a value in degrees for the maximum 

amount of rotation of the flying blast fragments. Fragments rotate around 

random axes.

Turbulence. This edit box contains a value for the amount of air turbulence 

which will affect the manner in which the blast fragments rotate. With a 

value of zero, fragments rotate around their centers. A value other than 

zero will cause fragments to rotate off-axis.

Force. This edit box contains a value for the force of the shockwave. The 

greater the force, the faster the fragment will move in the direction of the 

shockwave. A force of 1.0 will cause fragments to move at the same speed 

as the shockwave. The ± edit boxes enable you to impart a variability to the 

value so that some fragments fly faster than others.
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Mr. Nitro2 External Forces Controls

Gravity Direction & Force. These edit boxes contain values for the direc-

tion and force of gravity which will affect the manner and speed in which 

the blast fragments fall. The ± edit boxes enable you to impart a variability 

to each value so that some fragments are more affected by gravity than oth-

ers.

Ground Level. A value for the Y axis coordinate of an invisible ground 

plane below which blast fragments disappear as they fall 

Air Resistance. This edit box contains a value for the amount of air resis-

tance which will affect the manner in which the blast fragments fall. The 

higher the value, the more air resistance slowing the fragments. 

Figure 29.20 — Mr. Nitro2 – External Forces
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Dissolve: This edit box contains a value for the amount of time in seconds 

for blast fragments to dissolve after being hit by the shockwave. A value of 

0 (the default) prevents fragments from dissolving. 

Mr. Nitro2 Fragment Settings Controls

Fragment Size. these edit boxes contain size values for the smallest and 

largest blast fragments, relative to the size of the exploding group. To have 

all fragments of approximately the same size, enter the same value in both 

the Smallest and Largest edit boxes.

Setting a minimum size value that is too small will generate a very large number of 

fragments, which will take too long to generate and may also cause you to run out 

of memory. As a starting point for the minimum size, try using a value that is 1/10 

the longest dimension of the group; for the maximum size, use a value that is twice 

the minimum size.

Fragment Shape. These edit boxes contain values for the percentage of 

fragments that are to be triangles versus quadrangles. The default is 50% 

Figure 29.21 — Mr. Nitro2 – Fragment Settings
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for each. Changing one value will adjust the other value accordingly (to 

add up to 100%).

Extrusion Depth. This setting applies an extrusion to each of the exploded 

fragments. The size or depth of the extrusion is in world units. When set to 

0.0, no extrusion is applied.

Fragment Color. This check box, when enabled, allows you to assign a 

color to the blast fragments, overriding the surface color setting of the 

group. The color of the blast fragments can be animated over time through 

the use of the Age Color buttons, discussed below.

Age Color. These buttons invoke the Color Picker to enable you to set dif-

ferent colors for the blast fragments at different stages of the blast. The age 

values are all in seconds and can be edited.You can change the color of the 

fragments before they are hit by the shockwave by setting the first age 

value to less than zero.
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 Preferences

30.0 Introduction

To bring up the Animator preferences dialog box, from the system menu, 

choose Edit>Preferences... While running OS X, choose EIAS Anima-

tor>Preferences... 

The OK button closes the preferences dialog box accepting any changes 

you might have made. The Cancel button closes the preferences dialog box 

without making any changes. Reset changes all preference items back to 

their default (factory) values.

30.1 Keyframe Tab

The Keyframe tab contains settings that control the way that channel ani-

mation is handled for new and existing objects.

 

Figure 30.0 — Preference Window-Keyframe Tab
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Maximum Velocity Deviation. This is a control for the velocity calculation. 

The higher the deviation the less accurate it becomes, but gets computed 

faster. The lower value produces a more accurate velocity, but computes 

slower.

Maximum Key Tolerance. This value allows control over how close the 

global time can be to a keyframe to consider the keyframe highlighted for 

modification.

Automatically Scale Graph. This option causes the F-Curve editor to auto-

matically scale to the selected curve.

Disable Keyframe creation when changing the channel value. A ren-

dered sequence, like a scene in a movie.

Default to Animating when creating new Objects. Causes the green, 

enable-animation arrow to default to the on position in the Project window 

for all objects added to the scene.

Disable Velocity when creating new channels. Prevents velocity chan-

nels from being created for objects added to the scene.

Create New Channels using: Sets the default interpolation type for anima-

tion channels. Choices are Linear, Natural Cubic, Hermite, and F-Curve.

When creating Objects set channels to: Allows control over the default 

key type that is set in the Group Info window, X-form tab for both the 

object and its reference. The choices are Implicit and Explicit.
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30.2 Drawing Tab

The Drawing tab contains settings that control OpenGL, software drawing, 

and mouse interaction.

Mode. Sets the default drawing level for the View windows. Choices are 

None, Point, Outline, Wireframe, Point Shaded, Outline Shaded, Wire-

frame Shaded, Gouraud Shaded, and Phong Shaded.

Note Phong shading is only available when the Software Engine is enabled. Gouraud is 

the highest shading level available when using the Hardware Engine. 

Engine. Sets the default drawing engine for the View windows. Choices are 

Hardware (OpenGL) or Software (Animator’s internal drawing engine).

Draw Extents. Causes extent boxes to be drawn around all objects in the 

scene. Extents are cubes that surround groups and show the maximum 

dimension of the object in X, Y, and Z. 

Figure 30.1 — Preference Window-Drawing Tab
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Cull Backfaces. Polygons that are not facing the view are removed before 

the View window is drawn. This will improve drawing speed.

The four settings above may be overridden for each individual window using the 

blue, Shader Mode, ball in the lower right-hand corner of the World View win-

dows.

Incremental Update. Allows a subset of the polygons to be drawn window 

by window until all windows are updated. This feature dramatically 

improves interactive drawing performance by allowing you to interrupt a 

window refresh by selecting or dragging an object. 

Enable Backstore. Under Mac OS 9, this feature keeps a copy of the draw-

ing windows stored in memory. This removes the need to rerender the 

drawing windows when they are covered/uncovered by a dialog box.

Show Render Polygons. Displays subpolygons in the view windows. 

Use Texture Previews. Enables the display of textures on objects in the 

View windows.

Use Camera Light Only. Prevents scene lights from being used to render 

the View windows except a single, imaginary light placed at the camera 

position. This feature is useful if you have more than 8 lights being used in 

the scene. OpenGL can only render with 8 lights per pass. If you have more 

than 8 lights, each view window must be rendered more than once for final 

display.

Drawing Preset. Handy presets for items in the Drawing tab. As your 

project gets larger and more complex, drawing interactivity will be 

improved by moving from the settings in Small Project to Large Project.
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Show aspect when recording. Shows the proper picture you would get 

while rendering when a pixel aspect ratio other than 1 is set in the Render 

Control window.

Update while dragging objects. When off the Camera View window won’t 

interactively update when you drag objects in the other View windows. 

Since only one window has to be drawn interactively, this greatly speeds 

up drawing performance.

Frame Index Start. Sets the frame number that is used to begin a new ani-

mation. Common settings are 0 and 1.

Activate view window. Causes World View windows to be activated when 

they are clicked in.

Selection Mode. When set to Toggle, objects are unselected when they are 

clicked on a second time. When set to Standard, objects already selected 

stay selected when clicked on a second time.

Mouse Drag. A time in seconds for the time interval between the moment 

when camera dragging stops and the window is redrawn. This allows the 

extent boxes displayed to remain for the time specified before full drawing 

begins.

Keyboard Entry. Time in seconds for the time interval between the 

moment when key entry stops and the image is redrawn in the View win-

dows. 

IK Convergence. Time in seconds to wait for an IK solver to converge on a 

solution. Higher numbers will make for a more accurate solution but at 

reduced interactive performance.
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Draw Update. Fine tunes the Incremental Update system. Smaller values 

cause the drawing interrupts to occur more frequently while dragging.

Fractional Digits. Number of digits to the right of the decimal that are 

shown in edit boxes.

Point Size. Windows only. Sets the font point size of the text in Animator 

dialog boxes.

Note For large projects, in the Preferences, Drawing tab, use “Large “Project” 

mode, set “Mouse Drag” to 0.1 and “Draw Update” to 0.5. All drawing is 

interruptible when “Incremental Update” is turned on. Incremental Update 

is recommended when working on large projects.

30.3 Grid & Scale Tab

The Grid & Scale tab contains settings that control the snapping parame-

ters, grid color, grid density, ruler bars, and scene size.

Figure 30.2 — Preference Window-Grid & Scale Tab
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Non-Perspective Grid. Sets the origin in world space, the scale of the 

Major and Minor grid lines, and the colors of the Origin axis, Major grid 

lines and Minor grid lines. 

Pixel Limit. Value that specifies, in pixels, how close two parallel grid lines 

can be drawn in the World View windows. This feature can help avoid the 

situation where all grid lines touch each other or are being drawn on top of 

each other, resulting in a solid background. More dense or sparse grid spac-

ing can therefore be set by changing the pixel limit. A larger pixel limit also 

means faster grid updates because there are fewer lines to draw. Pixel Limit 

does not apply to the Camera View window because there are no two pro-

jected lines that are parallel in perspective space.

Prospective Grid. Size of the grid shown in the Camera View window.

Snapping Grid. The origin and scale of the invisible grid to which objects 

are snapped to when snapping is enabled.

Ruler Bar Subdivisions and Minimum Divisions. Sets the number of 

Subdivisions (number of minor lines between major lines) and the Mini-

mum Divisions (major lines shown in the View windows).

Ruler Bar Style. Sets the ruler bar style. Choices are None (suppresses sub-

division lines), Flat (shows major lines and subdivision lies at the same 

height), Half (raised subdivision line half-way between major lines), Quar-

ter (three raised subdivision lines between major lines), Two’s (every other 

subdivision line is raised). 

Start windows with rulers. Sets automatic display of rulers in the World 

View windows when a new project is started.
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Minimum Z. Sets the distance out from the camera for which information 

in the Camera View window is clipped away (also known as the “hither 

clipping plane”). 

World Size Automatic and User. These values are used to precompute the 

hither and yon values for OpenGL display. In the automatic case, all objects 

including extents, key paths and handles, and other displayable attributes 

are used to compute the global extent of a scene. In the user case, the values 

are keyed into the edit boxes are used. 

30.4 Field Chart Tab

The Field Chart tab contains settings that control the use of line aids in the 

Camera View. You can control the display of particular elements when a 

new project is created and the color that those elements are drawn with (in 

new or existing projects).

 

Grid. This check box turns on the field grid which appears in the Camera 

View window.

Figure 30.3 — Preference Window-Field Chart Tab
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Title Safe. This check box turns on a frame within which is considered to 

be the safe area to display titles (with no risk of cropping).

Action Safe. This check box turns on a frame within which is considered to 

be the safe are to display action (with no risk of cropping).

Cross Lines. This check box turns on a pair of crossed lines in the center of 

the Camera View window.

Hatch Lines. This check box turns on a pair of diagonal crossed lines in the 

center of the Camera View window.

Field divisions. This edit box contains the number of divisions in the field. 

The default is 12 (for a standard 12 field chart). 

Field Proportion. Controls the proportional spacing of the grid lines. The 

default is Both which yields spacing proportional to the X/Y aspect ratio. 

Horizontal and Vertical create even grid lines regardless of the X/Y aspect 

ratio. The Field Division value is enforced on the selected direction and the 

other direction is best-fit.

Color Buttons. The color buttons to the left of each check box are used to 

select a color for that element of the chart. Setting a different color for each 

element provides added clarity when multiple elements are enabled.
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30.5 Preview & Render Tab

The Preview & Render tab contains settings that control the way the live 

previews work in the Camera View window and offers several choices for 

altering the behavior of the Camera rendering application.

Output to. Changes the where previews are written for the current project 

and all new projects that are created subsequently. Choices are Screen (pre-

view in the Camera View window), Image (write the preview out to an 

Image file), and QuickTime (write the preview out to a QuickTime movie).

Detail. Changes the rendering level for previews for the current project and 

all new projects that are created subsequently. The Choices are the same as 

for Mode on page 885.

Background. Controls how background images are treated during pre-

views for the current project and all new projects. Choices are None (do not 

display background images during previews), Still (show the first frame of 

Figure 30.4 — Preference Window-Preview & Render
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the background throughout the preview), and Increment (show the proper 

background frame for each frame of the preview). 

Drop Frames. When on, frames may be skipped during preview to main-

tain the project frame rate. 

Play Back Immediately. When on, previews that were written to disk are 

immediately played back upon completion.

Show Render Status Windows. When a snapshot rendering is taking 

place, this option tells Camera to display its status windows.

Put Render in background. Animator will launch Camera but put it into 

the background so it isn’t visible.

Make Image permanent. When this option is on, Animator saves all of the 

snapshot images in the EI Snapshots folder. When off, Animator deletes all 

files in the folder when it is quit.

Data Folder. Tells Camera where to store its temporary files during render-

ing. Camera creates a variety of temporary folders for motion blur, glow, 

procedural reflections, etc. 

Choices are:

•  Image - Store the data in the folder where the rendered image file is 
being rendered
•  Camera - Store the data in the same folder where the Camera appli-
cation resides.
•  Project - This option stores the data in the folder where the project 
file resides.
•  Custom - Opens a directory dialog box in which a a folder on a local 
hard drive may be specified.
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Shadow Folder. Tells Camera where to store Z-Buffer shadow files during 

rendering. The choices are the same as those for Data Folder above.

Transparency Layers. Sets the maximum number of transparency levels 

used by Camera during Phong rendering. This value does not affect ray 

traced transparency.

Input Gamma. Sets the gamma value that Camera uses when processing 

texture maps.

30.6 Color Tab

The Color tab contains settings that control the color of a variety of ele-

ments in the work environment (Project window, World and Camera View 

windows, etc.).

 

Foreground. Sets the color for the extra widgets available to the Camera 

and Light icons (FOV, Spotlight radius, etc.). 

Figure 30.5 — Preference Window-Field Chart Tab
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Background. Sets the color for the background in the World View and 

Camera View windows. 

Camera View. Sets the color for the holdout region. The region outside the 

rendered area but still visible semi-transparently in the Camera View win-

dow. 

Ruler Foreground. Sets the color of the numbers and hatch marks on the 

rulers.

Ruler Background. Sets the color of the semi-transparent background 

behind the rulers.

Key. Sets the color of the keyframe markers in the World View and Camera 

View windows.

Handle. Sets the color of the handles on the Bezier spline motion controls 

in the World View and Camera View windows.

Frame Tick. Sets the color of frame indicators on the motion paths as 

drawn in the World View and Camera View windows.

Element Path. Sets the color of the group’s motion path as shown in the 

World View and Camera View windows.

Reference Path. Sets the color of the group’s reference path as shown in the 

World View and Camera View windows.

Extent. Sets the color of the extent boxes drawn in the World View and 

Camera View windows.

Vertex. Sets the color of vertices (groups that consist of separate point) 

drawn in the World View and Camera View windows.
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Crop. Sets the color of the cropping region drawn in the Camera View win-

dow.

30.7 Import & Data Tab

The Import & Data tab contains settings that affect the settings on objects 

and scenes when they are first brought into Animator. 

Object Tab

The items in the Object tab control the inherit settings for groups that are 

brought into the project. These items are found in the Joint/Link window 

for each group.

Inherit Position. Causes a parent group’s position values to be passed on 

to its children. 

Figure 30.6 — Import & Data - Object Tab
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Inherit Rotation. Causes a parent group’s rotation values to be passed on 

to its children.

Inherit Scale. Causes a parent group’s scale values to be passed on to its 

children. 

Inherit Visibility. Causes a parent group’s visibility status to pass to its 

children. 

Inherit Deformation. Causes deformations performed on a parent group 

to affect its children. 

Project Tab

The items in the Project tab control options for reading and writing of the 

project file.

Store Display Data. The contents and status of the View windows are 

stored in the project file.

Figure 30.7 — Import & Data - Project Tab
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Store Project Window Content. The contents and status of the Project win-

dow is stored in the project file.

Skip Stored Project Colors. Keeps the colors (foreground, background, 

keypath, etc.) stored in a project file from overriding the colors set in the 

Color preferences.

Update Texture Frame Size and Total. When a project is read in, the 

parameters of animated texture maps and backgrounds are verified.

Bone Tab

These two parameters set the defaults for the bone color as shown in the 

Bone Info window.

Default Color Value. A multiplier that is used to brighten or darken the 

overall color of the bones.

Figure 30.8 — Import & Data - Bone Tab
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Highlight Color Default. Sets the default color for bones as shown when 

they are selected. 

Group Tab

These three parameters set the defaults for the group’s display and texture 

settings as shown in the Group Info window.

Draw Geometry as. Sets the default shading level for groups as displayed 

in the World View and Camera View windows. 

Display Texture. Controls whether or not groups display their texture in 

the World View and Camera View windows.

Use UV Space. Sets new groups to use their UV space for texture mapping. 

The Choices are the same as for Mode on page 885.

Figure 30.9 — Import & Data - Group Tab
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Texture Tab

This parameter set the tiling default for the group’s texture as shown in the 

Texture Info window.

Tiling. Sets the default tiling method for new texture maps added to the 

project. Choices are None, Hold, Repeat, and Mirror. See “Map Projection 

Tab” on page 490 for more information.

Figure 30.10 — Import & Data - Texture Tab
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Socket Tab

A single parameter is provided to control the management of memory 

usage by plug-ins.

Display List Cache. The Animator can store the information generated by 

plug-ins in RAM (faster), or it continually read and write it from Disk 

(slower but uses less memory). This is a global setting affecting all plug-ins 

in the project.

Figure 30.11 — Import & Data - Socket Tab
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Lightwave Tab

These three parameters set the defaults for the group’s display and texture 

settings as shown in the Group Info window.

Import Blur as. Converts Lightwave’s blur settings to either Motion Vector 

Blur or Multi-Frame blur. 

Multi-Frames. Sets the number of blur frames if the Multi-Frame blur set-

ting above has been chosen.

Allow Morphing. Enables the importation of morph data from Lightwave 

projects. 

Content Directory. Allows Animator to use the same directory structure as 

Lightwave when importing lightwave project files. Usually this is the direc-

tory entitled “Newtek”. 

Figure 30.12 — Import & Data - LightWave Tab
902       EIAS Animator   



Chapter 30  Preferences — Import & Data - Skin Tab
Skin Tab

These three parameters set the defaults for skin behavior on newly skinned 

objects as shown in the Skin editor.

Weight Minimum. Sets the minimum influence a bone has on a vertex. If 

the computed weight falls below this threshold, the bone will not influence 

the vertex. The checkbox enables/disables the minimum weight computa-

tion. 

Weight Falloff. Sets the falloff distance that is used to “tighten” or “loosen” 

the influence of the bones based on the distance between the skin’s vertices 

and the bones.

Bone Maximum. Sets the maximum number of bones that can influence 

each vertex in the skin.

Figure 30.13 — Import & Data - Skin Tab
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30.8 Viewer Tab

These preference settings control the default behavior of the View Image 

command (available under the File Menu). 

Color Display. This pop-up menu sets the color channel of the image to be 

displayed. Choices are RGB, Red, Green, Blue, and Alpha.

Premultiply Alpha. This option, when enabled, multiplies the alpha chan-

nel into the RGB channel.

Display Components in Gray. Causes a grayscale display when the Red, 

Green, or Blue color channels are selected from the Color Display pop-up 

menu.

Change Background Color. This option, along with the color button to its 

right, allows the selection of a color that will be used to override the back-

ground color of the image.

Figure 30.14 — Preference Window-Viewer
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Select Display Monitor. Selects the monitor for displaying the image file 

(in multi-monitor configurations).

Display Tool Tips. Enables the display of help text that pops-up over icons 

in the Animator.

30.9  Kinematics Tab

The Kinematics tab contains parameters that control the overall behavior of 

the IK system.

Solver. Sets the default solver type for new IK chains as shown in the IK 

Handle Info window, Properties tab. Choices are Pseudo, Minimizer, and 2-

bone.

Figure 30.15 — Preference Window-Kinematics
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Constraint Multipliers. These edit boxes contain values that establish the 

relative importance of Position, Orientation, Stiffness, Viscosity, and Grav-

ity when computing the IK solution. The higher the value for an attribute, 

the greater importance is placed on it.
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Macintosh Shortcut Keys

World View Window Shortcuts

Press Key Mouse Action Result

R None Switches tool to rotate

S None Switches tool to scale

T None Switches tool to Translate

] None Zoom out front window

[ None Zoom in front window

= Click in View window Fit window to world

F Click in View window Fit window to world

Shift-F Click in View window Fit selected objects to world

Option Drag rectangle in View 
window

Fit window to selected 
region

Cmd-Spacebar Click and drag in View 
window

Zoom window interactively

Spacebar Click and drag in View 
window

Pan window 

Spacebar-X Click and drag in View 
window

Pan window horizontally

Spacebar-Y Click and drag in View 
window

Pan window vertically

Ctrl Click and drag an object Rotate object freely

0-9 keys None Change time to Time Marker

Option-1-6 keys None Switch window view
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Arrow Keys None Moves selected objects one 
pixel

Shift-Arrow Keys None Moves selected objects ten 
pixels

Ctrl Click and drag camera Vector-constrained 
translation

Ctrl Click on Preview button Bring up options for Preview

Ctrl Click on Shade Mode button Shade window at highest 
level

Cmd Double click on group Open Material Info window

Cmd-Option Double click on group Open Link/Joint Info window

Cmd-Ctrl Double click on group Open Deformation window

Ctrl-Option Double click on plug-in Open plug-in options dialog 
box

Cmd Double click on light Select light color

Ctrl Click and drag Bezier handle Move handle along its vector

Cmd-Option Click and drag Bezier handle Break Bezier handle

Cmd Click and drag Bezier handle Realign Bezier Handle

World View Window Shortcuts

Press Key Mouse Action Result
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Camera View Window Shortcuts

Press Key Mouse Action Result

Ctrl Click on Rotoscope button Bring up Rotoscope options

Ctrl Click on Preview button Bring up Preview options

Ctrl Click on Fieldchart button Bring up Fieldchart options

Spacebar Click and drag in window Track the camera or light

Spacebar-X Click and drag in window Track the camera or light 
horizontally

Spacebar-Y Click and drag in window Track the camera or light 
vertically

Cmd-Spacebar Click and drag in window Orbit the camera or light

O Click and drag in window Orbit the camera or light

Opt-Spacebar Click and drag in window Pan the camera or light

Ctrl-Spacebar Click and drag in window Dolly the camera or light

Shift-Spacebar Click and drag in window Zoom the camera (FOV)

V Click and drag in window Change rise/fall/shift

Cmd Double Click on group Open Material Info window

Cmd-Option Double Click on group Open Link/Joint window

Cmd-Ctrl Double Click on group Open Deformation window

Ctrl-Option Double Click on plug-in Open plug-in options dialog

Cmd Double Click on light Select light color

Ctrl Click and drag Bezier handle Move handle along its vector

Cmd-Option Click and drag Bezier handle Break Bezier handle

Cmd Click and drag Bezier handle Realign Bezier Handle
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Project Window Shortcuts

Press Key Mouse Action Result

Option Click on Zoom button Fit time line to window

Option Click on Flags (visibility, lock 
and animation)

Toggle elements from click 
position to bottom

Cmd-Option Click on Flags (visibility, lock 
and animation)

Toggle object and its 
children

Cmd Double click on group Open Material Info window

Cmd-Option Double click on group Open Link/Joint Info window

Cmd-Ctrl Double click on group Open Deformation window

Ctrl-Option Double click on plug-in Open plug-in options dialog

Cmd Double click on light Select light color

Cmd Double click on sound icon Play/Stop selected sound

Cmd Click in data cell Select all data cells in row

Shift Click in data cell Select row and columns from 
last selection to new

Cmd-Shift Click in data cell Include/Exclude whole 
row(s) in selection

Shift-Up-Arrow Click in data cell Include/Exclude row above

Shift-Down-
Arrow

Click in data cell Include/Exclude row below

Shift-Left-Arrow Click in data cell Include/Exclude row to left
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Shift-Right-
Arrow

Click in data cell Include/Exclude row to right

Cmd Click and drag time line Select keyframe scale region

Ctrl Drag selected keyframes Interactive keyframe scaling

Option Drag selected keyframes Duplicate keyframes

Shift Click individual keyframes Select multiple keyframes

Shift Click and drag soundtrack Include/Exclude cue time

Option Drag Time Thumb Scrub (preview animation)

Shift-Option Drag Time Thumb Scrub Camera View only

Ctrl Click on Time Thumb Time Thumb options menu

Cmd-Left-Arrow None Move Time Thumb one 
frame back

Cmd-Right-
Arrow

None Move Time Thumb one 
frame forward

Shift-Cmd-Left-
Arrow

None Move Time Thumb ten 
frames back

Shift-Cmd-
Right-Arrow

None Move Time Thumb ten 
frames forward

0-9 keys None Change time to Time Marker

+/- keys None Increment/decrement time 
to Time Marker

Project Window Shortcuts

Press Key Mouse Action Result
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Info Windows (Group, Light, Camera, Texture, Joint, Bone)

Press Key Mouse Action Result

Ctrl Click on any check-box Pull-down menu that copies 
settings to other objects

None Click and drag color chips Copy color to other objects

Material Info Window Shortcuts

Press Key Mouse Action Result

None Click on Material Ball Highlight material for copy 
and pasting

None Click and drag color chips Copy color to other objects

Cmd Click on Material Ball Change background pattern

Ctrl Click on Falloff Sliders Change slider range
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Texture Info Window Shortcuts

Press Key Mouse Action Result

R None Switch tool to rotate

T None Switch tool to translate

F Click in window Fit window to world

Spacebar Click and drag in window Pan window

Spacebar-X Click and drag in window Pan window horizontally

Spacebar-Y Click and drag in window Pan window vertically

Opt Drag rectangle in window Fit window to selected 
region

Cmd-Spacebar Click and drag in window Zoom window interactively

O Click and drag in window Orbit the view

Cmd-Shift-
Spacebar

Click and drag in window Orbit the view

Opt Click on object Highlight one polygon

Shift-Opt Click on object Add/Remove polygon to/
from list

Cmd Drag texture Drag texture orthogonal to 
surface
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Chapter 31  Macintosh Shortcut Keys
None Click and drag on green dots 
at texture proxy outer edge

Scale the texture

Opt Click on Source Editor button Open Material Info window

Joint/Link Window Shortcuts

Press Key Mouse Action Result

R None Switch tool to rotate

T None Switch tool to translate

F Click in window Fit window to world

Spacebar Click and drag in window Pan window

Spacebar-X Click and drag in window Pan window horizontally

Spacebar-Y Click and drag in window Pan window vertically

Opt Drag rectangle in window Fit window to selected 
region

Cmd-Spacebar Click and drag in window Zoom window interactively

O Click and drag in window Orbit the view

Cmd-Shift-
Spacebar

Click and drag in window Orbit the view

Texture Info Window Shortcuts

Press Key Mouse Action Result
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Miscellaneous Shortcuts

Press Key Mouse Action Result

Caps Lock None Toggles Grid Locking

Home None Fit window to world

F-Curve Editor Shortcuts

Press Key Mouse Action Result

Option Drag region Zoom to region

Option Click zoom button Fit selected curve to window

Spacebar Drag in window Pan window

Shift Drag region Add keyframes within region 
to selection

Tab None Toggles keyframe drag 
constraint direction

Option Click on selected curve Add keyframe to curve

Cmd Click on Bezier handle Toggle break/mend Bezier

Ctrl Drag keyframe(s) Scale keyframes in region

Cmd-Ctrl Click on keyframe Toggle linear on or off
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Object Menu (Hold down Ctrl key while selecting)

Mouse Action Result

Range Export Option Export multiple FACT’s, one per 
frame. Useful for exporting 

deformations

Plug-in Menu (Hold down Ctrl key while selecting)

Mouse Action Result

Choose About Plug-in Open plug-in’s “About Box”

Animation Menu (Hold down Ctrl key while selecting)

Mouse Action Result

Choose Reset F-Curve Editor Resets position and size of F-Curve 
Editor
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Chapter 31  Macintosh Shortcut Keys
Select Menu (Hold down Ctrl key while selecting)

Mouse Action Result

Choose All + Locked Selects all objects, even if locked

Choose Select by Hierarchy>Parent Selects all ancestors

Choose Select by 
Hierarchy>Children

Selects all offspring
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Chapter 32  Windows Shortcut Keys
Windows Shortcut Keys

World View Window Shortcuts

Press Key Mouse Action Result

R None Switches tool to rotate

S None Switches tool to scale

T None Switches tool to Translate

] None Zoom out front window

[ None Zoom in front window

= Click in View window Fit window to world

F Click in View window Fit window to world

Shift-F Click in View window Fit selected objects to world

Alt Drag rectangle in View 
window

Fit window to selected 
region

Ctrl-Spacebar Click and drag in View 
window

Zoom window interactively

Spacebar Click and drag in View 
window

Pan window 

Spacebar-X Click and drag in View 
window

Pan window horizontally

Spacebar-Y Click and drag in View 
window

Pan window vertically

0-9 keys None Change time to Time Marker

Alt-1-6 keys None Switch window view
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Chapter 32  Windows Shortcut Keys
Arrow Keys None Moves selected objects one 
pixel

Shift-Arrow Keys None Moves selected objects ten 
pixels

None Right-Click and drag camera Vector-constrained 
translation

None Right-Click on Preview 
button

Bring up options for Preview

None Right-Click on Shade Mode 
button

Shade window at highest 
level

Ctrl Double click on group Open Material Info window

Ctrl-Alt Double click on group Open Link/Joint Info window

Ctrl Double click on light Select light color

None Right-Click and drag Bezier 
handle

Move handle along its vector

Ctrl-Alt Click and drag Bezier handle Break Bezier handle

Ctrl Click and drag Bezier handle Realign Bezier Handle

World View Window Shortcuts

Press Key Mouse Action Result
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Camera View Window Shortcuts

Press Key Mouse Action Result

None Right-Click on Rotoscope 
button

Bring up Rotoscope options

None Right-Click on Preview 
button

Bring up Preview options

None Right-Click on Fieldchart 
button

Bring up Fieldchart options

Spacebar Click and drag in window Track the camera or light

Spacebar-X Click and drag in window Track the camera or light 
horizontally

Spacebar-Y Click and drag in window Track the camera or light 
vertically

Ctrl-Spacebar Click and drag in window Orbit the camera or light

O Click and drag in window Orbit the camera or light

Alt-Spacebar Click and drag in window Pan the camera or light

Shift-Spacebar Click and drag in window Zoom the camera (FOV)

V Click and drag in window Change rise/fall/shift

Ctrl Double Click on group Open Material Info window

Ctrl-Alt Double Click on group Open Link/Joint window

Ctrl Double Click on light Select light color

Ctrl Click and drag Bezier handle Move handle along its vector

Ctrl-Alt Click and drag Bezier handle Break Bezier handle

Ctrl Click and drag Bezier handle Realign Bezier Handle
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Chapter 32  Windows Shortcut Keys
Project Window Shortcuts

Press Key Mouse Action Result

Alt Click on Zoom button Fit time line to window

Alt Click on Flags (visibility, lock 
and animation)

Toggle elements from click 
position to bottom

Ctrl-Alt Click on Flags (visibility, lock 
and animation)

Toggle object and its 
children

Ctrl Double click on group Open Material Info window

Ctrl-Alt Double click on group Open Link/Joint Info window

Ctrl Double click on light Select light color

Ctrl Double click on sound icon Play/Stop selected sound

Ctrl Click in data cell Select all data cells in row

Shift Click in data cell Select row and columns from 
last selection to new

Ctrl-Shift Click in data cell Include/Exclude whole 
row(s) in selection

Shift-Up-Arrow Click in data cell Include/Exclude row above

Shift-Down-
Arrow

Click in data cell Include/Exclude row below

Shift-Left-Arrow Click in data cell Include/Exclude row to left

Shift-Right-
Arrow

Click in data cell Include/Exclude row to right

Ctrl Click and drag time line Select keyframe scale region
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Chapter 32  Windows Shortcut Keys
None Right mouse-Drag selected 
keyframes

Interactive keyframe scaling

Alt Drag selected keyframes Duplicate keyframes

Shift Click individual keyframes Select multiple keyframes

Shift Click and drag soundtrack Include/Exclude cue time

Alt Drag Time Thumb Scrub (preview animation)

Shift-Alt Drag Time Thumb Scrub Camera View only

None Right-Click on Time Thumb Time Thumb options menu

Ctrl-Left-Arrow None Move Time Thumb one 
frame back

Ctrl-Right-Arrow None Move Time Thumb one 
frame forward

Shift-Ctrl-Left-
Arrow

None Move Time Thumb ten 
frames back

Shift-Ctrl-Right-
Arrow

None Move Time Thumb ten 
frames forward

0-9 keys None Change time to Time Marker

+/- keys None Increment/decrement time 
to Time Marker

Project Window Shortcuts

Press Key Mouse Action Result
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Chapter 32  Windows Shortcut Keys
Info Windows (Group, Light, Camera, Texture, Joint, Bone)

Press Key Mouse Action Result

None Right-Click on any check-box Pull-down menu that copies 
settings to other objects

None Click and drag color chips Copy color to other objects

Material Info Window Shortcuts

Press Key Mouse Action Result

None Click on Material Ball Highlight material for copy 
and pasting

None Click and drag color chips Copy color to other objects

Ctrl Click on Material Ball Change background pattern

None Click on Falloff Sliders Change slider range
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Texture Info Window Shortcuts

Press Key Mouse Action Result

R None Switch tool to rotate

T None Switch tool to translate

F Click in window Fit window to world

Spacebar Click and drag in window Pan window

Spacebar-X Click and drag in window Pan window horizontally

Spacebar-Y Click and drag in window Pan window vertically

Alt Drag rectangle in window Fit window to selected 
region

Ctrl-Spacebar Click and drag in window Zoom window interactively

O Click and drag in window Orbit the view

Ctrl-Shift-
Spacebar

Click and drag in window Orbit the view

Alt Click on object Highlight one polygon

Shift-alt Click on object Add/Remove polygon to/
from list

Ctrl Drag texture Drag texture orthogonal to 
surface
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Chapter 32  Windows Shortcut Keys
None Click and drag on green dots 
at texture proxy outer edge

Scale the texture

Alt Click on Source Editor button Open Material Info window

Joint/Link Window Shortcuts

Press Key Mouse Action Result

R None Switch tool to rotate

T None Switch tool to translate

F Click in window Fit window to world

Spacebar Click and drag in window Pan window

Spacebar-X Click and drag in window Pan window horizontally

Spacebar-Y Click and drag in window Pan window vertically

Alt Drag rectangle in window Fit window to selected 
region

Ctrl-Spacebar Click and drag in window Zoom window interactively

O Click and drag in window Orbit the view

Ctrl-Shift-
Spacebar

Click and drag in window Orbit the view

Texture Info Window Shortcuts

Press Key Mouse Action Result
926       EIAS Animator   



Chapter 32  Windows Shortcut Keys
Miscellaneous Shortcuts

Press Key Mouse Action Result

Caps Lock None Toggles Grid Locking

Home None Fit window to world

F-Curve Editor Shortcuts

Press Key Mouse Action Result

Alt Drag region Zoom to region

Alt Click zoom button Fit selected curve to window

Spacebar Drag in window Pan window

Shift Drag region Add keyframes within region 
to selection

Tab None Toggles keyframe drag 
constraint direction

Alt Click on selected curve Add keyframe to curve

Ctrl Click on Bezier handle Toggle break/mend Bezier

None Right Mouse Drag 
keyframe(s)

Scale keyframes in region
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Chapter 32  Windows Shortcut Keys
Object Menu (Hold down Alt key while selecting)

Mouse Action Result

Range Export Option Export multiple FACT’s, one per 
frame. Useful for exporting 

deformations

Plug-in Menu (Hold down Alt key while selecting)

Mouse Action Result

Choose About Plug-in Open plug-in’s “About Box”

Animation Menu (Hold down Alt key while selecting)

Mouse Action Result

Choose Reset F-Curve Editor Resets position and size of F-Curve 
Editor
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Chapter 32  Windows Shortcut Keys
Select Menu (Hold down Alt key while selecting)

Mouse Action Result

Choose All + Locked Selects all objects, even if locked

Choose Select by Hierarchy>Parent Selects all ancestors

Choose Select by 
Hierarchy>Children

Selects all offspring
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Appendix A: Before Calling Tech Support

A.0 Introduction

We receive many, many calls during the course of the day. Some people 

have questions about making EIAS work. But many of the calls we receive 

deal with customers' ability to diagnose system problems. Often, the only 

thing Technical Support can do is walk you through some basic Trouble-

shooting methods. This is the process of elimination that you should learn 

if you are going to have any success using a computer loaded with the 

power of 3D software. (You could also call it the “scientific method”.) This 

information is vital to successfully use EIAS.

Do Not Wait Until the Last Minute

This is a very common scenario: A customer is on a deadline. He or she has 

a problem using the product, and spends hours upon hours of valuable 

(billable) time trying to figure what's wrong. Then, at the last minute, the 

customer calls us with this problem that needs to be solved because the 

deadline is fast approaching. 

This is a case where Tech Support personnel would rather have you call 

them earlier than later. Many times the problem can be resolved quicker 

because we tend to know where the problems already are located and 

might be able to point you at a solution that you may have missed or a 

work around that we may have already posted.
EIAS Animator 931



  Appendix A
Unexpected Behavior: Bug or Feature?

Have you ever attempted to use a feature you were unfamiliar with and 

didn't know how to use? Perhaps you had an opinion about how a feature 

should operate? But for some reason, this feature doesn't work like you 

envisioned? In this case, it's probably best to just call us and we'll do our 

best to tell you if what you are experiencing is a bug or a feature.

A.1 Crashing, Freezing, and/or Error Messages?

The information in this section applies to the Macintosh version of ElectricImage 

EIAS only.

If you experience any crashing, freezes or error messages which prevent 

program operation, we need you to help us to help you, and take steps to 

find out what the problem is before you call Tech Support. Please follow 

the suggestions outlined in the following sections, and call us with your 

results.

Zap P-RAM

Zapping the P-RAM clears system parameter memory. System parameter 

memory is used by the Macintosh to set overall operational parameters. 

Zapping P-RAM will cause you to reset certain system settings, such as 

mouse speed.

How do I do this properly?   Just restart your computer, and immediately 

hold down the following keys:    Command - Option - P - R. Keep holding 

until the machine makes the restart  noise another 3 times.)
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Rebuild the Desktop

Rebuilding the desktop cleans up the Finder directory of files and Icons 

(similar to the Windows Registry.) Sometimes, newer versions of the oper-

ating system will do this automatically. 

How  do I do this properly?  Just restart your computer, and immediately 

hold down the following keys: Command - Option. Keep holding until the 

machine asks  you if you want to rebuild the desktop for your Hard Drive. 

At this time  you can release the keys, and click OK in the dialog window. 

Note Often, this  process is best done directly after zapping P-RAM. When fin-

ished zapping P-RAM, just hold down the Command - Option keys as nor-

mal.

Run Norton Utilities Disk Doctor 

Norton Utilities Disk Doctor is a utility program offered by Symantec that 

cleans up disk errors and miscellaneous b-tree errors.  See the documenta-

tion that comes with Norton. Use the latest version please.

Restart with Minimal Extensions

Extensions are small utility programs which add functionality to the oper-

ating system. Extensions can from Apple, or third parties. Sometimes, these 

extensions can interfere with the normal operation of the EIAS applica-

tions. If you are running into difficulty operating the software, it is a good 

idea to reduce the amount of extensions that you are running to an absolute 

minimum.

The Extension Manager will let you create different sets of extensions to 

use for just this purpose. When reducing your extensions, make sure that 
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you include the following extensions, as the EIAS applications require 

these extensions to operate properly: 

• Carbon Lib 1.1.1 or greater
• Open GL 1.1 or greater
• Quickdraw 3D extensions (all)
• QuickTime 3.0 or greater
• QuickTime PowerPlug
• USB extension (if your Mac has a USB port)

Hardware Keys

ElectricImage EIAS supports two different types of hardware keys on the 

Macintosh: one for the older ADB bus, and one for the newer USB bus. 

EIAS prefers the newer USB bus, as it is more reliable and faster than the 

older ABD bus. If you decide to upgrade to a newer Macintosh that uses 

the USB bus, call the sales department to order an upgrade key.

Many customers end up collecting a rather large amount of hardware keys. 

This can sometimes cause problems with program operation. When this 

occurs, run only with the ElectricImage EIAS hardware key.

If you think you may have a malfunctioning hardware key, here is a test to 

determine if that is indeed the case. Before we begin the test, run through 

the procedures listed in section the section entitled “Crashing, Freezing, 

and/or Error Messages?” on page 932. You may find that one of those pro-

cedures may work for you. If that is not the case, proceed with the follow-

ing:

• Make an alias of EIAS Animator and put it in the “Startup Items” 
folder in your  “System” folder. 

• Shutdown your computer. 
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• Remove everything from your USB bus except for the EIAS hardware 
key.

• Boot up your computer 

 If EIAS Animator launches, then the hardware key is not the problem. You 

should try some of the other isolation techniques listed in these pages. If 

EIAS Animator does NOT launch, you likely have a dead hardware key 

and should contact us immediately.

A.2 Hard Disk Drivers

ElectricImage EIAS makes extensive use of disk drives, especially for long 

animations. EIAS can create and copy very large files, which can sometimes 

cause difficulties when the disk drives are in less than top form. It is imper-

ative that your disk drives are functioning normally. 

The primary issue for disk drives is to make certain that the drivers you are 

using are compatible with your system software. To determine this, find 

the program “Drive Setup” on your System Disk, and update Drivers just  

to make certain. Be sure to read any warnings regarding drivers vs. operat-

ing system compatibility before changing any drivers. Normally, current 

drivers are available from the manufacturers’ websites.

A.3 Viruses

Viruses are programs designed to invade and attack your computer. 

Viruses can sometimes be benign, more of a prank than anything, but often 

they are malicious, and designed to destroy. If you notice that EIAS or other 

programs that you are using are not working properly, check your system 

for viruses, trojan horses, etc. Most commercial virus checking programs 
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should handle this just fine. Make sure you have the latest version of the 

program, and that it is compatible with your operating system version.

A.4 Corrupted Project Files

If you think that a feature is not working correctly, it's time to create a New 

file and try the feature with the barest of circumstances. Let’s look at the 

following example to see how to do that:

Let’s say that you have just added a new object file to that project that you 

have been working on for the past three days. Suddenly, the program will 

not let you add a texture map to that object. Instead of panicking, attempt 

to determine why you are having the problem. 

Create a new project with an Uber Shape and apply your texture there. If 

the texture can be added to the uberShape object, then chances are you may 

just be experiencing user error. In this case, you should go back to the 

Materials and Textures section in the EIAS Animator documentation, and 

review the process of adding a texture map to an object. If that doesn’t 

work, here are a few more things to think about:

• Check to see that something else is not setup properly and is perhaps 
affecting this feature

• Be sure that you are accurately mimicking the setup that your problem 
project has.

• Your project may have become corrupted 

This is over-simplifying the case, but the point is to make your new project 

as simple as possible and isolate the feature from all the other things going 

on in your real work project. This will help you (and us) to determine 

where the problem actually lies. 
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Corrupt projects don’t happen often, but they can happen. There are too 

many outside factors on modern computers to completely guard against 

such hazards. Here are some suggestions to help prevent projects from 

becoming corrupted.

• Save project files frequently
• Backup model files and texture maps
• Backup project files at least once a day (or more, if your system seems 

unstable)
• Make sure that your disk drives are in good working order
• Make sure that you operating system is stable
• Don’t use extensions that you don’t need

If a project ever becomes corrupted, there is little that can be done to restore 

it. Therefore, it is imperative that you follow the guidelines set forth in this 

document, and keep your computer in good working order.

A.5 Missing “Resources”?

EIAS applications use resources which enable the program to function. 

These resources are kept in folders called “EI Resources” for EIAS Anima-

tor. Inside, there will be files called “EIASKey” which is required, and 

should remain inside those folders. The “EI Resources” folder should 

reside inside the same folder that contains the “EIAS Animator” applica-

tion.

A.6 When All Else Fails

Should all of the previous actions fail to return your program to normal 

operation, try these last few recommendations (in order!):
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• Delete the preference files for EIAS Animator. This file is located in Sys-
tem: Preferences.

• Re-install EIAS
• Install EIAS on a different computer

Create a Minimized Project

One of the best ways to diagnose a problem is to create a minimized project 

that exhibits the problem behavior. There are two good ways to create a 

minimized project:

• Create a duplicate of the problem project, and remove items one at a 
time until you have isolated the offending element

• Create a duplicate project and turn off items one at a time, and note any 
differences in the results that you are getting

Once you have isolated the element which causes the problem, send us 

your project. We can go over it with you to determine a work around, or to 

log the problem as a bug so that it can be fixed in a follow-up version.

Some Tips on Creating that Minimized Project

Once you have created a duplicate of the project, remove any items that 

don't have any bearing on your problem. Turn off that big model with the 

100MB texture map. Does the problem occur? If yes, then you can delete 

that model from your project. If no, then leave it in. Repeat this process 

until you get your project down to the barest of circumstances that make 

the problem occur. Continue with the following procedure:

1. Once you have the problem isolated, Save the project. 
2. Choose File>Collect Files from the main menu bar and save your 

project, support models and textures to a unique folder location sepa-
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rate from the project files you have in progress. 

This is the best way of placing your support files with the project and 

quickly sending them to us. Now you are ready to compress the files to 

e-mail.

A.7 Send Us Your Project When We Request It

Be prepared to send us a project which exhibits the problem that you are 

experiencing. if you are involved in a production and cannot send us work 

product, make sure to send us a duplicate project which does not fall under 

that restriction. If you cannot, we can sign the appropriate NDAs to protect 

your work. Regardless, we cannot fix what we cannot see, so please, when 

we request you to send in your project, please do so promptly. We can only 

help you if you let us do so.

Prepping Your Files

Whatever you use for file compression, please make it a self-extracting 

archive, if possible. We may not have the application that will read your 

compressed file. And even if we do, we may not have the latest version. 

After making the self extracting archive, you should also BinHex your file, 

which is a process that converts your file to a binary file. This makes your 

file much less susceptible to corruption as it travels across the internet via 

e-mail. BinHex utilities (shareware and freeware) are available at many 

sites on the internet. Also, popular products like “Stuffit Deluxe” come 

with binhex translators.

Now, attach the compressed, and BinHexed file to your e-mail and send it 

to us at: Support@ElectricImage.com or the e-mail address we give to you 

on the phone.
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Symbols

.ban 166

.bva 345, 348

.bvh 345, 348

.ma 86, 346, 348–349

.obm 346, 349

.rz3 166

.w3d 697

Numerics

2D3 166

3D Text 324

adding into project

Importing 3D Models

Adding 3D text 324

Bevel Angle 63, 326, 580

Bevel Size 325, 578

Create Back Bevel 326

Default (Character Grouping) 327

Extrusion Size 328, 580

Fillet Sides 326

Fix Smooth Shading 327

Max Angle 327

PostScript® Type 1 324

Reverse Back Bevel 326

Similar Sides 327, 580

Smooth Angle 327

TrueType™ 324

Whole Characters 327

3D View 737

3DMF 741

A

Action Safe 68

Active Time Range 392

End Time marker 392

Start Time marker 392

Adaptive Tessellation 741

Add as Map 571

Add as Paint 570

Adding a Key Frame 395

adding FACT models 323

Adding lights to a project 170

Age color buttons

In Mr. Nitro™ dialog box 846, 881

Alias Sketch 741

Align to Equator Front 487

Align to Equator Seam 487

Align to North Pole 487

Align to South Pole 487

Allow Lighting of Solution 308

Ambient 236

Ambient Tab 449

Ambient Map List 450

Amount 450

Color Swatch 449

Amorphium 827

Amount 444

Animated Visibility 331

Animation Channels 385

Displaying an object’s channel 385



Editing Cell data in Project Window 388

Editing Channel Data 388

Advance to another cell 389

move the focus of selected cells 389

Enabling (activating) 386

Enabling a specific record 386

Selecting Animation Channels 387

Selecting an entire channel 387

Anisotropic Shader 748

Anti Aliasing

Sampling Levels Menu 273

16x16 (and higher) 274

1x1 273

2x2 273

4x4 273

Anti-Alias Tab 271

Anti-Aliasing

Adaptive Sampling

Threshold 274

Anti-Alias Tab 271

Anti-Aliasing Menu 271

Adaptive Sampling 271

None 271

Oversampling 272

Levels Menu 272

16x16 (and higher) 272

4x4 272

8x8 272

Anticipate 547

aspect ratio 123

Aspect Ratio Menu 260

16mm option 264

35mm Full 264

35mm option 264

65mm option 264

70mm option 264

Computer option 263

Custom option 263

IMAX option 264

Super 16mm 264

Super 8mm option 263

TechniScope option 264

VistaVision option 264

Attach Bones 572

Auto Edit Y Z 331

Auto Roll 547

Automatic/Manual 309

B

Backdrop Tab 238

Background 63, 892

Background Color 237

Backtrack 547

Bind Skin To Selected 566

Bind Skin to Skeleton 566

Binding 566

Blend Curve 405

Blend Linear 405

Blending Cell Contents 405

BlendMode 501

Blur Angle 460

Bone List 567

Bone Maximum 569

Bone Strength 565

Bones 554, 564

Boujou 166



Breakup Concave Polygons 739

Breathing Cylinder option

In Mesh Type pop-up menu

In Mesh Generator dialog box 842

Bricks Shader 750

Brush Size 573

Buffer Size edit box

In Light Info window 187

Build Groups From Blocks 742

Build Groups From Colors 742

Build Groups From Layers 741

Bump Array Shader 752

Bump/Displacement Maps List 440

Bumpy Noise Shader 754

C

Calculate Shadow Only Once option

In Light Info window 187

Camera

Adding to Scene 100

Camera Information Window 103

Camera Display Options 105

Show Angle 105

Show Fog 105

Show Map 106

Show Roto 106

Show Stereo 106

FOV tab

Depth of Field section 115

Distance popup menu 117

By Channel 117

By Reference 117

Enable Focus check box 115

Focus distance edit box 117

f-stop edit box 116

Multi-frame pixel offset 117

Focal length section 110

Field of view edit box 112

Focal length edit box 111

Focal mode popup menu 112

Diagonal focal mode 113

Horizontal focal mode 113

Vertical focal mode 113

Resolution section 122

Shutter Angle section 113

Enable Shutter angle edit box 114

Enable Shutter check box 114

View section 118

General Camera Settings 104

Projection tab 138

Map list and controls 140

Adding a map to the list 141

Apply Map As menu 141

Ambient 143

Bump/Displace 143

Clip 143

Diffuse 143

Glow 144

Luminance 144

Reflection 143

Reflectivity 143

Specular 143

Transmission 144

Transparency 143

Apply To menu 144–146

ApplyTo menu



All 145

None 145

Set list 145

Removing a map from the list 141

Roto/comp tab 123

background map list 125

Adding an image to the list 125

Removing an image to the list 125

Foreground map list 126

Adding an image to the list 126

Removing an image to the list 126

Properties tab 131

Camera view section 131

Display mode popup menu 132

Alpha Only 132

RGB + Alpha 132

RGB + Color 133

RGB Only 132

Show in camera view check box 132

Sync with camera view check box
132

Image Tiling Section 133

Anti-alias check box 133

Axis Tile menus

Hold 133

Mirror 133

None 133

Repeat 133

Blur edit box 134

Invert Alpha check box 134

Invert RGB check box 134

Opacity edit box 134

Samples edit box 134

Render roto/comp check box 124

X-form tab 128

Position edit boxes 129

Scale edit boxes 129

Align popup menu 130

Both 130

Horizontal only 130

Vertical only 130

Stereo tab 135

Convergence popup menu 136

By Channel 136

By Reference 136

In Infinity 137

Enable check box 136

Render popup menu 137

Left & Right 137

Left Only 137

Normal 137

Right Only 137

Stereo convergence edit box 136

Stereo separation edit box 136

Virtual 106

X-form tab 107

Camera Section 107

Changing Values in Frame Mode 108

Changing Values in Index Mode 108

Changing Values in Keyframe and Time 
Modes 109

Implicit and explicit values 109

Reference Section 107

Roll Control 107

Roll, Pitch, Yaw Section 107

Looking through 103



Reference Point

Translating (moving) 102

Translating (moving and rotating) 101

Camera Anatomy 99

Camera Body 100

Reference Point 100

View Vector 100

Camera FOV Tab 110

Camera Information Window 103

Camera Display Options 105

Color 106

Show Angle 105

Show Fog 105

Show Map 106

Show Roto 106

Show Stereo 106

FOV tab

Depth of Field section 115

Distance popup menu 117

By Channel 117

By Reference 117

Enable Focus check box 115

Focus distance edit box 117

f-stop edit box 116

Multi-frame pixel offset 117

Focal length section 110

Field of view edit box 112

Focal length edit box 111

Focal mode popup menu 112

Diagonal focal mode 113

Horizontal focal mode 113

Vertical focal mode 113

Resolution section 122

Shutter Angle section 113

Enable Shutter angle edit box 114

Enable Shutter check box 114

View section 118

General Camera Settings 104

Projection tab 138

Map list and Controls 140

Adding a map to the list 141

Apply Map As menu 141

Ambient 143

Bump/Displace 143

Clip 143

Diffuse 143

Glow 144

Luminance 144

Reflection 143

Reflectivity 143

Specular 143

Transmission 144

Transparency 143

Apply To menu 144–146

All 145

None 145

Set List 145

Removing a map from the list 141

Roto/comp tab 123

Background map list 125

Adding an image to the list 125

Removing an image to the list 125

Foreground map list 126

Adding an image to the list 126

Removing an image to the list 126

Properties tab 131



Camera view section 131

Display mode popup menu 132

Alpha Only 132

RGB + Alpha 132

RGB + Color 133

RGB Only 132

Show in camera view check box 132

Sync with camera view check box 132

Image Tiling Section 133

Anti-alias check box 133

Axis Tile menus

Hold 133

Mirror 133

None 133

Repeat 133

Blur edit box 134

Invert Alpha check box 134

Invert RGB check box 134

Opacity edit box 134

Samples edit box 134

Render roto/comp check box 124

X-form tab 128

Align popup menu 130

Both 130

Horizontal only 130

Vertical only 130

Position edit boxes 129

Scale edit boxes 129

Stereo tab 135

Convergence popup menu 136

By Channel 136

By Reference 136

In Infinity 137

Enable check box 136

Render popup menu 137

Left & Right 137

Left Only 137

Normal 137

Right Only 137

Stereo convergence edit box 136

Stereo separation edit box 136

X-form tab 107

Camera Section 107

Changing Values in Frame Mode 108

Changing Values in Index Mode 108

Changing Values in Keyframe and Time 
Modes 109

Implicit and explicit values 109

Reference Section 107

Roll Control 107

Roll, Pitch, Yaw Section 107

Camera lights 179

Dropoff edit box 180

Dropoff enable check box 180

Camera Map 138

camera map 123

Camera memory usage 2

Camera View 70

Camera View Window 66

Camera X-Form Tab 108

Camera, looking through 103

Cammo Shader 755

Cammo2 815

Cast Shadow 341

Caustics 218, 220

Caustics Tab



Control Distance 221

Generate Caustics Map 221

Photon Density 221

Cel Look Shader 756

Cel/Outline Shader Section 440

Cell data

Editing In Project Window 389

In Project window

Editing 389

Cell Size 414

Center Weight 57

Chain Plane 559

Changing Key Frame timing 393

Changing Scene Time 393

Changing Sequence timing 393

Channel Display 412

Close All 412

Close Selected All 412

Hide By Type 413

Hide Selected 412

Hide Unselected 413

Open All 412

Open Animated 412

Open Selected Animated 412

Open Selected Root 412

Show By Type 413

Show Selected 413

Show Unselected 413

Show/Hide Children 412

Channels

see Data channels

Checker Board Shader 758

Circular Dependencies 551

Classic environment 58

Clipping Maps List 442

Closest Vertex 549

Clouds Shader 759

Color 573

Color Noise Shader 760

Color Pick Dragging 56

Color Section 338

Color Strength 311

Color Swatch 444

Combine Coordinates 734

Combine Duplicate Polygons 734

Combine Multiple Groups 734

Constraint

Geometry 550

Pole Vector 551

Constraint Editor 417, 545

Constraints 543

Aim 548

Auto Bank 546

Auto Look 546

Normal 549

Position 548

Rotate 549

Scale 549

Contour Shader 761

Convert Polylines to Automatic 743

Convert Polylines to Lines 742

Convert Polylines to Polygons 743

Creating Key Frames 393

Creating New Master Materials 437

Cropped Size 67

Cross Line 68



Crumple Shader 763

Crust Shader 765

Cubic Environment 55

Cubic QuickTime VR 55

Cue 580, 596

Cue List 580

Cull Backfaces 339

Cull Vertex 574

current frame 158

Cycle Cells 414

Cycling Cell Contents 405

Offset Repeat 407

Oscillate 406

Repeat 406

Cyclone Shader 766

D

Data channels

Displaying in Project Window 383

Decimal Digits 744

Default 308, 310

Deformation Editor 416

Deformations

Add a Region or Deformation 616

Adding Bones 675

Along Axis 604

Animating a Region’s Rotation 624

Applying Deformations 39, 601

Associating Bones to a Group 676

Bend 640

Bezier 656

Bezier II 668

Bone Info Window 677

Bones 674

Bones Special Tab 679

Bones X-Form Tab 678

Bulge 642

Circular Wave 649

Circular Wave II 685

Deform Axis 604

Deform X along Y 605

Deform X and Z along Y 609

Deform Z along Y 606

Deformation section 603

Enable Buttons 615

Falloff Menu 681

General Section 680

Group Deformation Window 601

Limited Range Check Box 680

Linear Wave 645

Magnet Section 683

Maximum Range Edit Box 681

Minimum & Maximum 626

Minimum Range Edit Box 681

Moving the Bones Around 677

New Buttons 614

Options 603

Position 618

Prepping the Model 674

Range Section 680

Region Section 617

Region/Deformation Section 612

Rename a Region or Deformation 615

Rotation Bias Section 682

Runwave 686

Scale 632



Shear 633

Strength Section 682

Strength% (or Scale or Angle) 604

Stretch 653

Taper 635

Taper Options 637

Trash Can 614

Twist 634

Type 603

Types of Deformations 631

Detail 63

Dicer 834

Diffuse Maps list 445

Diffuse Tab 443

Disable UV 490

Display Breakup 738

Display/Render Solution 308

Dissolve edit box

In Mr. Nitro™ dialog box 845

Dolly 69

Dome Illuminator 223

Draft Mode 267

Drop Frames 63

Duplicate Paint 571

Duplicating lights 170

DXF Export 743

DXF Import 741

E

Edge Outlines 440

Edit Sets 319

Editing a Key Frame cell 395

Editing Cell Contents

Filling Cells with Values 399

Fill Constant... option 400

Fill Selected option 400

Invert option 400

Jolt... option 401

Offset... option 400

Randomize... option 400

Scale option 400

Spring... option 402

Editing modes

Selecting in Project window 390

Effectors 513

Bone Effectors 522

Effector Info Window 514

Effector Information Window

Special tab 516

Effector Style Menu 516

Bone 519

Bone Color 520

Bone Highlight 520

Set Bias 521

Set Rest 520

Special Tab Options 521

Box 516

Special Tab Options 517

Origin 517

Size 517

Cross 518

Special Tab Options 518

Joint 518

Special Tab Options 519

X-form Tab 514

Explicit 515



Implicit 515

Position 515

Rotation 515

Scale 515

Effector Style Menu 516

Explicit 515

Implicit 515

Origin 517

Rotation 515

Scale 515

Size 517

Skeleton Joints 522

Special Tab Options 517

X-form Tab 514

Emit Both Sides 306

Enable Gel 227

Enable Geometry. 306

Enable Glow option

In Light Info window 202

Enable Ray option

In Light Info window 200

Enable Resolution 122

Enable Shadow option

In Light Info window 187

End Time marker 392

Energy Reflection 304

Eroded Shader 769

Every Vertex 549

Exchange Y and Z Coordinates 743–744

Export Format 738

Export Model 739

Export Object 76

F

Falloff 444, 502, 568

Feathered 574

Field of view edit box 112

Fieldchart 68

Fill 574

Fill Cells 414

Final Subdivisions 312

Find 322

Find Again... 322

Find All... 322

Find... 309

Fisheye 228

Fix Cone Point Shading 735

Fix Smooth Shading 735

Fixed Tessellation 741

Flag 863

Flare Tab 183

Flat Complex Polygons 735

Flat option

In Mesh Type pop-up menu

In Mesh Generator dialog box 842

Flat Shading 251

Focal length edit box 111

Focal mode popup menu 112

Diagonal focal mode 113

Horizontal focal mode 113

Vertical focal mode 113

Fog 233

Fog lights

Setting inside color 202

Fog Section 334

Fog To Menu 234



Fog/Ambient/BG Tab 232

Folder... 308

Force edit box

In Mr. Nitro™ dialog box 845, 878

Format Menu 254

Environment 256

Image option 255

PICT option 256

Planar Z-Depth 256

QuickTime option 255

Spherical Z-Depth 256

Forward Kinematics 553

Fractal Noise Shader 773

Fragment Shape edit boxes

In Mr. Nitro™ dialog box 846, 880

Frame Boxes 162–163

Frame mode

Editing Frame Values 396

Resetting a Frame’s Value 397

Setting the Current Frame 396

Freeze

See Park Object Data

Full Range 57

Full Size 67

Function Curve Editor 351

Acceleration 363

Acceleration Enable 370

Accumulate 365

All 361

All Curves 363

All Path 369

Assigning Channels from Project Window 
419

Automatic Slope 367

Channel List 352, 357

Color Preferences 362

Command Clicking 355

Continuous Slope 367

Control-Drag 355

Current Time 363, 370

curve color 357

Custom 361

Cut and Paste 355

Data Range 363, 370

Dragging the Window 355

Editor Display Scale 367

F Curve 367

F-Curve 365

Fit Curve To Data in Time Range 369

Fit to Data Range 369

Fit to Range 369

Graph Display Element Control 363

Graph Window 352, 354

Grid 363

Grid Enable 369

Grid Options 363

Hermite 365, 367

Hold 365

Implicit and Explicit Translation 352

Key Channel Loader 361

Key Channel Window 364

Key Time Range 369

Keypath Drag 355

Linear 364, 366

Load to Insert Into Time Selection 360

Load To Replace All 360



Make Folder 362

Move to Beginning 369

Natural Cubic 365, 367

Oscillate 365

Range 368

Repeat 365

Reverse Data 369

Reverse Time 369

Ruler 363

Save All 361

Save Within Time Selection 361

Set Ranges… 368

Shift Clicking 355

Snap 368

Snap Undo 363

Specific 362

Spline Specific Fields 366

Tab Key 355

The Key List Subsection 365

The Motion Type Menu 364

Time and Value Edit Boxes 366

Time Range 363, 370

Time Scale Enable 369

Toggle Linear 355

Tool Bar 353

Tool bar 358

Velocity 363

G

Gamma 57

Gel 227

Generate Shadow Mask 341

Geometry Section 339

Geometry Tab 439

Global Reflection Tab 242

Globecaster 699

Glow Layer Members List 244

Glow Layer Tab 243

Glow Configuration Section 245

Glow Intensity 245

Glow Layer List 244

Glow lights

Setting inside color 202

Glow Object Only 339

Glow Radius 245

Glow Tab 195

Creating Glow Effects 198

Configuring lights 198

Light Rays 200

Volume shadows 199

Enable Glow 196

Enable Glow Blend 196

Enable Ray 197

Factor 197

Glows

Glow Tab 195

Inner and outer radius 197

Inside Glow Color 197

Intensity 197

Interpolate RGB 196

Invert Glow & Fog 196

Outside Glow Color 197

Ray Factor 197

Ray Sample 198

Smoke Selector 198

Volume falloff 196



Glows

Creating 198

Configuring lights 198

Light Rays 200

Volume shadows 199

Enable Glow 196

Enable Glow Blend 196

Enable Ray 197

Factor 197

Inner and outer radius 197

Inside Glow Color 197

Intensity 197

Interpolate RGB 196

Invert Glow & Fog 196

Outside Glow Color 197

Ray Factor 197

Ray Sample 198

Smoke Selector 198

Volume falloff 196

Go 307

Go To Rest Position 561

Gooch Shader 775

Gouraud Shading 251

Gradient 806

Grain 460

GrangerFX 699

Granite Shader 776

Gravity 547

Gravity Direction & Force edit boxes

In Mr. Nitro™ dialog box 844, 879–880

Grid 65, 68

Grid Shader 777

Ground 240

Ground Zero edit boxes

In Mr. Nitro™ dialog box 843, 877

Group Info Window 328

Group Information Window

Motion Blur Section 337

Shading tab

Line Section 336

X-Form tab 331

Group Linkage

See Joint Editor

H

Hatch Line 68

Hex Tile Shader 778

Hierarchical method 301

High Precision Shadow 341

horizon 239

Hue Angle 573

I

IK Handle 554

Illumination lists 181

Enabling/Disabling 181

Illuminator 223

Illuminator Gel 227

Image Menu 252

256 Colors 254

256 Shades 253

BW Dithered 253

BW Filled 253

BW Lines 253

BW Summation 253

Millions of Colors 254



Millions+Alpha 254

Thousands of Colors 254

Image Resolution Menu 265

Implicit and Explicit Interpolation 333

Import Object 76

Importing 3D Models

adding FACT models 323

foreign model formats 324

Index of Refraction 464

Info Tab 342

Inherit 306

Inner Blast edit boxes

In Mr. Nitro™ dialog box 845, 877

Inside Color button

In Light Info window 202

Interlace Even 138

Interlace Odd 138

Inverse Kinematics 553

Invert 574

Iterations 311

J

Job Name 308

Joint Editor 416

Group Preview Pane 526

Inherit Tab 535

Inherit Deformation 536

Inherit Position 535

Inherit Rotation 536

Inherit Scale 536

Inherit Visibility 536

Limits Tab 537

Position Sub-Tab 541

Rotation sub-tab 538

Center Section 538

Maximum Section 538

Minimum Section 538

Use Current Value Arrows 538

Stiffness Sub-Tab 539

Maximum 541

Minimum 541

Viscosity Sub-Tab 540

Link Type Menu 529

Ball Planar 530

Custom 530

Cylinder 531

Cylinder Planar 531

Free 530

Lock 531

Pin 531

Planar 531

Slide 531

Socket 531

Universal 531

Pivot Point Gnome 527

Rotation Order Menu 528

Transform Menu 528

Classic 528

Standard 528

X-form Tab 532

Link Alignment Orientation 533

Z is X 533

Z is Y 534

Z is Z 533

Link Alignment Position 532

Back 533



Bottom 533

Front 533

Left 533

Middle 533

Right 533

Top 533

Parental Offset Section 534

Position Section 534

Rotation Section 534

K

Key Index mode 397

Displaying a Key Frame 398

Editing Key Frame Values 398

Selecting the Current Key Index 398

Keyframe mode 394

Adding a Key Frame 395

Editing a Key Frame cell 395

Setting the Current Frame 395

L

Lens Flares 183

Enable Background 184

Enable Cone Obscuration 184

Enable Distance cueing 184

Enable Fog cueing 185

Enable Instensity cueing 185

Enable Object Obscuration 184

Enable Offscreen flare elements 184

Flare Selection popup menu 184

Plug-in options button 184

LensFlare 869

Light color button

In Light Info window 177

Light Display options

Show Angle 172

Show Dropoff 172

Show Flare 173

Show Flare Dropoff 173

Show Fog and Glow radius 173

Show Illumination 173

Show Size 173

Show Volume Dropoff 174

Light Info Window 171

Light Info window

Buffer Size edit box 187

Calculate Shadow Only Once option 187

Enable Glow option 202

Enable Shadow option 187

Inside Color button 202

Light color button 177

Outside Buffer Area in Shadow option 187

Light Information Window

Anatomy 170

Light Display options 172

Show Angle 172

Show Dropoff 172

Show Flare 173

Show Flare Dropoff 173

Show Fog and Glow radius 173

Show Light Size 173

Show Volume Dropoff 174

Properties tab 177

Common attributes 177

Enable Highlight check box 179

Enable Illumination check box 179



Intensity edit box 177

light color swatch 177

Size edit box 177

Volume Dropoff edit box 178

X-form tab 174

Implicit and explicit values 176

Light Section 175

Reference Section 175

Roll Control 175–176

Roll, Pitch, Yaw Section 175

Values in Frame mode 175

Values in Index mode 175

Values in keyframe and Time modes 176

Fog tab 201

Enable Ray 202

Inner and outer radius 203

Intensity 203

Interpolate RGB 202

Invert Glow & Fog 202

Outside fog color 202

Ray Factor 203

Ray Sample 203

Smoke Selector 203

Volume falloff 202

Projection Map tab 204

Crop tab 210

Info tab 209

Properties tab 206

Anti-alias check box 209

Blur edit box 208

Interpolate check box 209

Invert Alpha check box 209

Invert RGB check box 209

Samples edit box 208

Tiling Popup Menus 207

Hold 207

Mirror 208

None 207

Repeat 208

X-form tab 205

Alignment menu

Fit outer cone 205

Fit within inner cone 206

Fit within outer cone 206

Fit without inner cone 206

Fit without outer cone 206

Light Rays 200

Light rays

Enable Ray option 200

Light Types 168

Ambient light 169

Camera light 168

Parallel light 168

Radial light 168

Spot light 169

Tube light 169

Light X-form tab 174

Implicit and explicit values 176

Light Section 175

Properties tab 177

Common attributes 177

Enable Highlight check box 179

Enable Illumination check box 179

Intensity edit box 177

Light color swatch 177

Size edit box 177



Volume Dropoff edit box 178

Reference Section 175

Roll Control 175–176

Roll, Pitch, Yaw Section 175

Values in Frame mode 175

Values in Index mode 175

Values in Keyframe and Time modes 176

LightFlare 872

Lightprobe 55

Lightprobe Bottom 228

Lightprobe Top 228

Lights

Adding lights to a project 170

Caustics tab 220

Duplicating lights 170

Enabling glow lights 202

Enabling shadows from 187

Fog Light

Volume Shadows 204

Fog tab 201

Enable Ray 202

Inner and outer radius 203

Intensity 203

Interpolate RGB 202

Invert Glow & Fog 202

Outside fog color 202

Ray Factor 203

Ray Sample 203

Smoke Selector 203

Volume falloff 202

Glow Tab 195

Creating Glow Effects 198

Configuring lights 198

Light Rays 200

Volume shadows 199

Enable Glow 196

Enable Glow Blend 196

Enable Ray 197

Factor 197

Inner and outer radius 197

Inside Glow Color 197

Intensity 197

Interpolate RGB 196

Invert Glow & Fog 196

Outside Glow Color 197

Ray Factor 197

Ray Sample 198

Smoke Selector 198

Volume falloff 196

Illumination Lists 181

Enabling/Disabling 181

Light Information Window

Flare tab 183

Enable Background 184

Enable Cone Obscuration 184

Enable Distance cueing 184

Enable fog cueing 185

Enable Intensity cueing 185

Enable Object Obscuration 184

Enable Offscreen flare elements 184

Flare Selection popup menu 184

Plug-in options button 184

Master Light tab 216

Inherit attributes 217

Inherit caustics 218

Inherit color 217



Inherit dropoff 217

Inherit flare 218

Inherit fog 217

Inherit glow 217

Inherit intensity 217

Inherit projection 218

Inherit shadow 217

Inherit visibility 217

Master Lights

adding a subscriber light 219

Creating a master light 218

viewing the master light hierarchy 219

Projection Map tab 204

Crop tab 210

Info tab 209

Properties tab 206

Anti-alias check box 209

Blur edit box 208

Interpolate check box 209

Invert Alpha check box 209

Invert RGB check box 209

Samples edit box 208

Tiling Popup Menus 207

Hold 207

Mirror 208

None 207

Repeat 208

X-form tab 205

Alignment menu

Fit outer cone 205

Fit within inner cone 206

Fit within outer cone 206

Fit without inner cone 206

Fit without outer cone 206

Projection Maps

Adding Maps 210

Adding Maps with volume shadows 210

Setting color 177

Shadows 185

Depth buffer type 185

Raytraced

Shadow tab

Soft shadow section

Optimize shadow generation 191

Raytraced Shadow tab

Enable shadow 189

Raytraced type 185, 189

Special Lighting Effects 191

Fog 192

Glows 191

Projector Light Effects 193

Smoke Effects 193

Volume Shadows 192

Link to Parent 417

Loading and Saving Materials 436

locked 158

LonelyWave 812

Longitude/Latitude 55

Looking through the Camera 103

Luminance/Glow Tab

Glare 474

Glow Color Maps List 478

Glow Color Section 473

Luminance Color Section 472

Luminance Map List 473

Use Color Button 473



Use Shading Button 473

M

Macromedia 693

Magnets 683

Magnifier tool 163

Map Visible Surface Only

Buffer Size 146

Calculate Buffer Once 146

Map Visible Surfaces Only 145

Marble 780

Mask 445

Master 149

Master Lights 216

adding a subscriber light 219

Creating a master light 218

Master Light tab

Inherit attributes 217

Inherit caustics 218

Inherit color 217

Inherit dropoff 217

Inherit flare 218

Inherit fog 217

Inherit glow 217

Inherit intensity 217

Inherit projection 218

Inherit shadow 217

Inherit visibility 217

viewing the master light hierarchy 219

Master Materials 432

Match Colors 735

Match Edges 735

Match Look 165

Match Look button 161

Match Move 149

Filter Tab

Filter Cycles 161

Filter Type 161

Match Roll 161

Use Filter 160

Master

Add/Del Master 150

Display 151

Enable 151

Match 151

Pixel Aspect 150

Start/Stop 151

Target Editor

Color Background 156

Color Channels 155

Image Information 155

Smooth Target Tracks 156

Standard Mode 156

Toggle Track Label 158

Toggle Track Path 157

Toggle Track Search Region 158

Toggle Track Template 158

Track Options 157

Track Targets 156

Zoom 156

Targets

Add/Del 152

Change Name 152

Reset 2D 153

Search Radius 153

Template Size 153



Track Options

Default Template Size 157

Method 157

Pixels 157

Size 157

X/Y Axis 157

Match Move button 165

MatchMover 166

Material Editor 416

Material Palette 510

Small Icon/Large Icon 512

View By List 511

View By Strip 512

View By Tile 511

Maya 86

Merge Co-Incident Edges 736

Merge Co-Planar Polygons 735

Mesh Generator 841

Mesh Generator plug-in

Mesh Generator dialog box

Mesh Type pop-up menu 841

Breathing Cylinder option 842

Flat option 842

Screw Thread option 842

Sine Wave option 842

Sphere Wrap option 842

Options 841

Selecting a breathing cylinder 842

Selecting a flat mesh grid 842

Selecting a plane-to-sphere animation 842

Selecting a screw thread animation 842

Selecting animated circular waves 842

Mesh Type pop-up menu

In Mesh Generator dialog box 841

Message Box 309

Method 310

Mid Range 57

Minimum Energy Level 313

Minimum Z 890

Model Buffer Size 740

Model Statistics 737

Model View Key Settings 744

Modify Axis 417

Modify Coordinates 737

Morph 583, 599

Morph Window 583, 599

Add Blend to Curve Editor 589

Add Morph Group 587

Add Morph Source 584

Add Morph Targets 588

Creating Models for Morphing 583

F-Curve 590

First 586

Full Match 586

Geometry Only 587

Hermite 589

Index Only 586

Keyframe/Timeline Slider 590

Linear (Default) 589

Making Morphs 591

Morph Anchor Section 586

Morph Group Section 587

Morph Target Section 588

Name Only 587

Natural Cubic 589

Play Backward 591



Play Forward 591

Play/Pause 591

Reload Target Data Button 587

Step Backward 591

Step Forward 591

Target Match Popup Menu 586

View Area Section 591

Working with Sync Sound 594

Motion Blur Tab 275

Blur Frames 277

Blur Intensity 277

Blur Noise 277

Motion Vector 278

Multi-Frame 279

Point/Line Blurring 278

Shutter Angle 276

Motion Export

ASCII Motion Version 349

Filter Object’s Rotation Order 349

Frame Range 348

Numeric Precision 348

Output CR/LF 348

Output FOV for cameras 349

Output Scale Factors 349

Reference are exported as 349

Selected Only 348

Selected with Children 348

Use Object’s Rotation Order 348

Motion Import

Change Rotation Order 347

Convert Right to Left 347

Motion Samples Time 347

Motion Samples Total 347

Offset Filter 347

Process Motion Data 347

Rotation Filter 347

Rotation Order 347

Start 347

Motion Vector Blur 337

Move 119

Mr. Blobby 836

Mr. Nitro 843

Mr. Nitro™ plug-in

Mr. Nitro™ dialog box

Age color buttons 846, 881

Dissolve edit box 845

Force edit box 845, 878

Fragment Shape edit boxes 846, 880

Gravity Direction & Force edit boxes 844, 
879–880

Ground Zero edit boxes 843, 877

Inner Blast edit boxes 845, 877

Rotation edit box 845, 878

Speed edit box 845, 878

Setting fragment color over time 846, 881

Setting fragment dissolve time 845

Setting fragment rotation 845, 878

Setting fragment shape 846, 880

Setting secondary shockwave 845, 877

Setting shockwave direction and force 844, 
879–880

Setting shockwave force 845, 878

Setting shockwave origin 843, 877

Setting shockwave speed 845, 878

Mr. Nitro2 875–876, 879–880

Multiprocessor 297–298



N

Nadir 240

Network Rendering Tab 284

NPR Shader Lite 798

NTSC 379

O

Object Labels 415

Occlusion 458

Open Root option

Open/Close options

In Project window 412

Open Selected All option

Open/Close options

In Project window 412

Open... 306

Orbit 69

Oren-Nayer Shader 782

Orientation Goal 559

OS X 58

Output 62

Output Edges as Lines 739

Output Lines 738

Output Points 738

Output Polygons 739

Output Polygons as 3DFACE 743

Output Polygons as Poly Mesh 744

Output Polygons as POLYLINE 743

Output Vertices as Points 739

Outside Buffer Area in Shadow option

In Light Info window 187

Override Tessellation Settings 741

P

Paint Brush 573

Paint Palette 572

Painting 572

PAL 379

Pan 61, 69

Park Object Data 418

Paths 65

Pearl Shader 783

Phong lighting 302

Phong Shading 252

Pixel Aspect 161

Pixel Grains 859

Plank Shader 784

Playback Immediately 63

Plugin As Geometry 695

Point/Line Motion Blur 337

Pole Vector 555, 559

Polygon Offset 311

Polygon Outlines 440

Position Goal 558

Power Particles Basic 848

Preferences

Cancel Button 883

Color Tab

Background 895

Camera View 895

Crop 896

Element Path 895

Extent 895

Foreground 894

Frame Tick 895

Handle 895



Key 895

Reference Path 895

Ruler Background 895

Ruler Froeground 895

Vertex 895

Drawing Tab

Activate view window 887

Cull Backfaces 886

Draw Extents 885

Draw Update 888

Drawing Preset 886

Enable Backstore 886

Engine 885

Fractional Digits 888

Frame Index Start 887

IK Convergence 887
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